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INTRODUCTION TO EFT SERVER™ AND  
EFT SERVER ENTERPRISE™ 

More than just a managed file transfer (MFT) server, EFT Server extends beyond standard MFT servers to allow you 

to connect with any industry-standard file-transfer client with a robust security architecture for meeting business 

and regulatory requirements, ensuring that encrypted transactions occur only with the appropriate entities, and 

that data confidentiality and integrity are preserved during transport and storage. Its modular form makes it 

affordable by allowing you to purchase just the functionality you need and add more advanced features as your 

business needs change.  

EFT Server is offered in a basic edition and EFT Server Enterprise™. The basic edition is built on the same code as 

the Enterprise edition, with Enterprise-specific features disabled, but visible so that you can see features that you 

might want to add later. All module features are available during the trial period for both basic and Enterprise 

editions and are clearly identified as Enterprise or module features that require licensing and activation separate 

from the basic edition.  
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EFT Server™ and EFT Server Enterprise™ each provide:  

 Data Protection and Encryption - The Server protects intellectual property, trade secrets, and customer 

files transferred over the Internet using secure protocols including FTPS (SSL/TLS), SFTP (SSH2), and 

HTTP/S (SSL). 

 Guaranteed Delivery and Data Integrity - The Server extends the industry standard FTP protocol with 

strong reliability features, including post transmission integrity verification, mid-file recovery, and 

automatic restart. 

 Tracking and Auditing - Secure data delivery requires strong audit trails for tracking and non-repudiation. 

The Server provides industry standard logging (W3C, NCSA, Microsoft IIS Extended), e-mail notification of 

completed transactions, and digital certificates for proof of identity. 

 Programmatic Interface - The Server can be controlled through its Administrator interface or through its 

Component Object Model (COM) interface. The COM API is a programmatic interface that lets you control 

the Server from your own custom applications using any COM-enabled programming language. 

 Accelerated Transfers - The Server supports multi-part (segmented) transfers for faster delivery of large 

files over large geographical distances. Multi-part transfers require the use of compatible clients such as 

CuteFTP Professional. 

 Life-Cycle Management - The Server helps you quickly and efficiently manage users, temporary accounts, 

and expired or compromised public-keys or certificates. 

 Authentication and Authorization - The Server supports password, public-key, or one-time-password 

authentication. User profiles can be managed internally or externally through NTLM, Active Directory 

(AD), or ODBC data sources. 

 User and Group Management - Manage system resources including bandwidth, folder access, file types, 

and more using granular or Site-wide controls provided for user and group management. Visually manage 

folder permissions via the Windows Explorer-like Virtual File System (VFS). Inherit or override permissions, 

grant administrative, guest, or anonymous permissions, or deny access altogether. Manage client 

connections with real-time monitoring and on-the-spot disconnection of users. Administrators can force 

users to reset their passwords upon initial login, require complex passwords, remove/disable inactive 

accounts automatically.  

 Specify SSL ciphers and version levels - The Server provides administrators the ability to specify 

symmetric key cipher(s) and the ordering of those ciphers for establishing SSL sessions. The Server 

validates inbound SSL sessions and allows or denies connections based on specified or approved ciphers.  

EFT Server Enterprise™ provides each of the features of EFT Server™, plus: 

 SFTP (SSH), HTTPS, and PGP modules included 

 LDAP authentication  

 SSL certificate-only authentication 

 Delegated administration for user-only, Site-only, or Server-only management 

 ARM support for Oracle database (with optional ARM module; available in EFT Server Enterprise)  

 DMZ Gateway multi-site configuration (with optional DMZ Gateway)  

 AS2 support (with optional AS2 module)  

http://www.globalscape.com/cuteftppro/
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The available modules include:  

HTTPS: (Included in the Enterprise edition.) The HTTPS add-on module allows you to set up a secure connection to 

anyone in minutes using any Web browser. The HTTPS module adds the HTTPS protocol to the Server, enabling you 

to support secure browser-based transfers without having to install a Web server. HTTPS encrypts the session data 

using the SSL (Secure Socket Layer) protocol, which provides protection from eavesdroppers and man-in-the-

middle attacks.  

SFTP: (Included in the Enterprise edition.) SFTP is a subset of the popular SSH protocol and is a platform 

independent, secure transfer protocol. SFTP provides a single connection port for easy firewall navigation, 

password and public key authentication, and strong data encryption, to prevent login, data, and session 

information from being intercepted and/or modified in transit. The SFTP module enables the Server to 

authenticate and transfer data securely with SFTP-ready FTP clients, such as CuteFTP Professional. 

AS2: (Available in EFT Server Enterprise) The AS2 (Applicability Statement 2) specification supports the exchange 

of structured business data securely on top of the HTTP or HTTP/S protocol. 

OpenPGP: The Server employs industry-standard OpenPGP (based on the open source implementation of Pretty 

Good Privacy) technology to safeguard data at rest. The OpenPGP data encryption or decryption process is 

directed by Event Rules that specify how data files are treated in a particular context. The Server uses OpenPGP to 

encrypt uploaded data and the off-load capabilities of the Server to move the file to another location. 

High Security Module (HS): The High Security (HS) module achieves or exceeds security practices mandated by PCI-

DSS, HIPAA, and Sarbanes-Oxley for data transfer, access, and storage. The HS module protects data in transit by 

enforcing the use of secure protocols, strong ciphers and encryption keys, and maintaining strict password policies. 

The HS module also includes the following features: 

 Protect sensitive information. The Federal Information Processing Standard (FIPS) Publication 140-2 

specifies the security requirements of cryptographic modules. EFT Server supports operation with the FIPS 

140-2 Validated GlobalSCAPE Cryptographic Module (GSCM) for inbound SSL/TLS and certificate 

generation.  

 Password expiration - Expire passwords for user accounts automatically, configure the Server to send 

expiration e-mails, and provide a password reset Web page.  

 Redirect HTTP to HTTPS automatically for secure connections. 

 Hide or disable non-allowed SSL ciphers, key lengths, anonymous accounts, and so on. 

 Securely delete or purge a file by writing over the initial data using encrypted and/or pseudorandom data 

(also known as data wiping). 

Auditing and Reporting Module (ARM): The Auditing and Reporting module captures all of the transactions passing 

through the Server. You can query the data and create/view reports from within the Server's Administrator 

console. A new database is created when upgrading to version 6. (The basic version does not offer support for 

Oracle databases.) 

Web Transfer Client (WTC): The Web Transfer Client (WTC) deploys automatically upon client connection to the 

Server and can be used by any trading partner using virtually any Web browser that supports Java and DHTML. 

(Limited to 5 concurrent users in the basic edition.) 

Secure Ad Hoc Transfer (SAT): The Secure Ad Hoc Transfer (SAT) module allows you to exchange files without the 

problems associated with having to manually create temporary FTP accounts, the size limitations and security 

issues of regular e-mail, or the time delays and high costs of overnight and physical shipments. (Neither edition is 

compatible with prior versions of the Secure Ad Hoc Transfer module.) 

http://www.globalscape.com/cuteftppro/
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DMZ Gateway: Used in combination with the Server to create a multi-tier security solution for data storage and 

retrieval. The DMZ Gateway resides at the edge of the network, brokering data between the Server residing behind 

your corporate firewall and your clients in the outside world. (Multiple-Site configuration only available in 

Enterprise edition.) 

Advanced Workflow Engine: (Available in EFT Server Enterprise) Similar to EFT Server's Commands, EFT Server's 

Advanced Workflows add additional automation capabilities, allowing you to add scripting and variables to Tasks, 

then add these reusable Tasks to Event Rules. A Task is a series of steps that can perform file transfers, batch data 

processing, application testing, and so on, set to run automatically when started by some event.  

GETTING STARTED WITH EFT SERVER™ ADMINISTRATION 

We have made every attempt to organize this user guide in the order in which you will need to refer to the topics 

as you install and configure the Server, Sites, Settings Templates, Users, Groups, Commands, Event Rules, and add-

on modules. The table of contents is organized in the same order as the tree in the Administrator interface. 

Refer to the following topics to get started: 

 For details of how to use this help file and the self-help resources available online, refer to Getting Help . 

 For a detailed description of EFT Server, refer to Introduction to EFT Server. 

 For details of what is new in this version of EFT Server, refer to What's New? 

 For a detailed comparison of EFT Server and EFT Server Enterprise, refer to EFT Server Feature 

Comparison. 

To become familiar with the Server and its add-on modules, read each of the topics in this user guide, then follow 

the procedures in Installing and Activating the Software. If you have already installed the software, continue with 

Configuring EFT Server, and the remaining procedures in the order they appear in this user guide. 

This user guide provides the following information: 

 Installing and Activating the Software. This section includes information regarding installing EFT Server, 

setting Windows system services, release notes, and upgrading and activating the Server and add-on 

modules. 

 Configuring EFT Server. This section helps you make your first connection to the Server, and provides 

information regarding the Administrative  Interface, Protocols and Security, user authentication, starting 

and stopping the Server, configuring remote administration, configuring the Server's SMTP connections, 

creating and managing EFT Server administrators, and various other procedures related to configuring the 

way in which clients connect to EFT Server. 

 Configuring Sites. This section provides information regarding creating and managing connections to EFT 

Server. 

 Configuring Settings Templates and Users. This section provides information regarding creating and 

managing users and Settings Templates (to control access to the Server resources), configuring Protocols, 

Network Usage Options, and Password and Account Security Options. 

 Configuring Groups. This section provides information for creating and managing Groups, which set user 

virtual file system (VFS) permissions to folders.  

 Virtual File System. This section provides information about the Server's Virtual File System (VFS), which 

allows you to grant access to files and folders on your system based on user and Group permissions.  
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 Commands, Advanced Workflows, and Event Rules. These sections provide information regarding defining 

Commands and Workflows to use with Event Rules to run executables, batch files, and scripts 

automatically when specific events occur in the Server, and information regarding how to specify that an 

action is to occur when an event takes place and/or a condition is present. (e.g., send an e-mail when a 

file is uploaded). 

 The OpenPGP Module. This section provides information regarding creating and managing OpenPGP key 

pairs to safeguard data at rest. 

 AS2 Module. This section provides information regarding configuring and using the Server's AS2 

(Applicability Statement 2) module to exchange structured business data securely using the HTTP or 

HTTP/S protocol.  

 High Security Module. This section provides information regarding configuring the Server for use with the 

HS module for high security and/or compliance with the Payment Card Industry Data Security Standard. 

 Auditing and Reporting Module (ARM). This section provides information regarding using the Auditing and 

Reporting module to generate predefined and custom reports of the Server activities. 

 DMZ Gateway. This section provides information regarding configuring and managing DMZ Gateway 

Server to provide secured communications with the Server behind intranet firewalls without requiring any 

inbound firewall holes between the internal network and the DMZ. 

 Secure Ad Hoc Transfer Module. This section provides information regarding configuring the Secure Ad 

Hoc Transfer module to allow internal users to send and receive large e-mail file attachments to recipients 

outside of your organization quickly, reliably, and securely, all without having to manually create or 

maintain FTP accounts on the Server. 

 Web Transfer Client. This section provides information regarding configuring the browser-based file 

transfer client that allows users to transfer files to/from a Server using a connected Web browser. 

 GlobalSCAPE Server COM API. This section provides information regarding the programmatic interface 

that allows you to control the Server from your own custom applications using any COM-enabled 

programming language 

 Getting Help. This section provides information regarding how to use this help file and how to access 

online customer support services. 

 Registrations and Licenses. This section provides information regarding registrations and licenses for the 

product, including the End-User License Agreement (EULA). 
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WHAT'S NEW IN EFT SERVER™? 

GlobalSCAPE® EFT Server™, version 6, combines the robust security features and extensibility of EFT Server with 

the simplicity and ease of use of Secure FTP Server. EFT Server is now offered in a basic and an Enterprise edition, 

with modules available so that you can extend EFT Server's functionality as you need it. Certain new features 

below are available only in EFT Server Enterprise and/or only with the modules. Refer to EFT Server Feature 

Comparison for a detailed list of the different features available in the basic and Enterprise editions and each of 

the modules. 

x64 OS support - EFT Server Enterprise is now supported on Windows 2003 and 2008 64-bit operating systems (in 

addition to Windows 32-bit operating systems). For a full list of requirements, refer to System Requirements. 

Trial version support - As in prior versions, all functionality and modules are available during the trial; in EFT Server 

6, you do not have to register the trial version. It is ready to go as soon as it is installed. The trial allows you to 

install, configure, and test EFT Server on a development system so that you can determine which modules and 

features you will need to purchase for your production system. Purchasing add-on features and modules requires 

no further installation. The features/modules are activated depending on the license that you use to activate the 

product. Adding new features later only requires that you purchase a new license to activate that feature in the 

product. 

Installation Wizard - EFT Server's improved installation wizard is used to install EFT Server, the Administrator 

Interface, DMZ Gateway, Secure Ad Hoc Transfer, the Auditing and Reporting database, and each of the other 

modules. The wizard can walk you through configuring auditing and reporting on your existing SQL or Oracle 

database (Oracle connectivity available in EFT Server Enterprise), upgrading an existing EFT Server Auditing and 

Reporting database, or installing a new database with SQL Server Express. The wizard detects whether previous 

installations exist, and allows you to create a new, fresh installation in a different location, or upgrade your existing 

installation. (Refer to Upgrading the Software for details of available upgrade paths.) 

Migration wizard - When you are ready to move the Server from development to production, in EFT Server 

Enterprise edition you can use the Migration wizard to gather the necessary files, then package them into one 

easy-to-transport file. The wizard can recreate the entire folder structure and settings automatically or you can run 

it in manual mode and verify every setting as you step through the wizard. The wizard can also be used for routine 

backups or backing up in preparation for major changes or for disaster recovery. A Backup Server Configuration 

Rule is created and enabled by default when EFT Server Enterprise is installed. This rule automatically backs up the 

Server's configuration every day at midnight, saves the .bak archive to C:\Documents and Settings\All 

Users\Application Data\EFT Server Enterprise\Backup, and then cleans up any .bak files older than 30 days. The 

location and cleanup schedule are editable and you can disable the rule if you prefer to backup manually. 

Administrator Interface - EFT Server's Administrator Interface has been reorganized and updated. 

 Every dialog box, tab, and wizard overhauled  

 Exposes various existing real-time statistics to Administrator interface main pages and added new 
statistics. 

 Indicates % disk space used in disk quota management 

 Remembers last VFS folder selected while navigating the server 

 Provides ability to create and display ultra long group names 

 Exposes http error messages so they can be edited  

 Exposes login credentials and expiration e-mail messages so they can be edited  

 Writes to Windows event log when Web Transfer Client connections exceed available licenses 
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 Multiple prompts added/removed/updated to prevent destructive behavior 

 Fixed complex password creation so that non-alpha chars are not used 

 E-mail notification dialog overhauled; browser for users using quick search function 

 Multiple interface enhancements to the Web Transfer Client 

FIPS-Certified Libraries - Previously only available in Secure FTP Server - FIPS edition, EFT Server's High Security 

module now provides FIPS-certified libraries for SSH and SSL connections. EFT Server 6 with the HS module allows 

you to turn on/off FIPS modes. If you already have Secure FTP Server - FIPS, you can upgrade for free to EFT Server 

(base) with the HS module to provide the same, but improved, functionality.  

Server Administrators - A new administrator role, User Administrator, has all of the privileges of the Change 

Password administrator, but can also create new users. The User Administrator is not allowed to see or edit 

Settings Templates, but is able to change passwords, disable users, or create more users. 

Default Paths - You can now change the default location of EFT Server's configuration file.  

Default Server messages - You can configure default Server messages for the password reset reminder/required 

messages and the user login credentials message.  

Server local time - EFT Server provides the option to switch between UTC/GMT and local server time for the 

timestamps returned for FTP/S and HTTP/S directory listings.  

Home Folder - The Create New User wizard now permits the designation of a home folder other than the one 

inherited, including variable support for dynamically named home folders. 

User Disk Quota - The user Disk Quota fields now show quota values in megabytes and a percentage value for disk 

space free/remaining. 

SQL Server Express - EFT Server now comes packaged with SQL Server express for development testing. It is 

recommended that you connect to a SQL Server or Oracle database for production. (Oracle connectivity available 

in EFT Server Enterprise), 

Oracle database connectivity - EFT Server Enterprise can audit to an Oracle database in addition to SQL. 

Custom Commands - You can now create custom Commands "on the fly" from within Event Rules, and you can 

select variables to use in the Command from within an Execute Command dialog box.  

Event Rule Download and Copy/Move Action wizards - New wizards for defining the Download Action and the 

Copy/Move Action in Event Rules take the guesswork out of defining these very complex Actions. The Download 

Action is now available with more Event triggers. The destination folder can now be within the VFS or anywhere on 

the physical system or network drive. 

Event Rule Builder interface updates - The Event Rules Rule Builder interface is updated with more intuitive icons, 

informational prompts, and logic to prevent errors such as infinite loops. 

Send E-mail Action Address Browser - The E-mail Action template now has To, Cc, Bcc buttons that launch a Select 

Names dialog box to display, search, and select from all names and e-mail address pairs stored on the Server. You 

can also override the From value and send to multiple To recipients. 

Auditing of Administrator Changes - All changes to EFT Server made by any administrators are now fully audited to 

the Auditing and Reporting database. A new report displays administrator activities. 

Secure Ad Hoc Transfer Module Reports - The Auditing and Reporting Module now provides 5 new reports of SAT 

module events. Refer to Descriptions of Preconfigured Reports for details. 
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New OpenPGP library - With a new OpenPGP library, EFT Server allows you to view/edit more PGP options, 

including: 

 Signing options (same file, same file ascii armored, separate file, separate file ascii armored) 

 Hashing algorithm used for signing 

 Creation of Self Decrypting Archives 

 Compression on/off and levels 

 Debug log on/off and levels 

 Choice of cipher during key creation 

 Key type, including RSA Legacy 

SFTP OpenSSH - An updated SSH library now supports import and creation of OpenSSH style keys, key generation, 

and display of the Server’s public key.  

Ban IP address on invalid account - EFT Server improves on prior logic for connecting clients to count invalid login 

attempts when a non-existing username is provided.  

Advanced Workflow Engine - The Advanced Workflow Engine extends the capabilities of EFT Server Enterprise 

Event Rules to perform complex actions automatically when a specific event occurs. You can use Automated 

Workflows to design scripts, batch files, macros, or any other code-intensive process using an easy drag-and-drop 

interface. 

DMZ Gateway Multiple Site - DMZ Gateway is now available (with EFT Server Enterprise only) in a multiple-Site 

version, allowing you to configure DMZ Gateway Enterprise to listen at the same IP address to one or more Sites 

on EFT Server. (Refer to the DMZ Gateway documentation for more about what's new in DMZ Gateway.) 

PCI DSS 1.2 Support - EFT Server’s High Security Module (HSM) has been updated to comply with the latest 

Payment Card Industry Data Security Standard version 1.2, including a change that affected 8.5.5 (disable/removal 

of inactive accounts), 8.5.11 (password complexity), and also 3.4 (one-way hashes based on strong cryptography), 

affecting the creation of SSL certificate signatures to use SHA-1 instead of the MD5 hashing algorithm.  

Plain HTTP Interface Updated and Customizable - The base HTTP/S landing page is updated to support column 

view, graphical images for actions, and file listing. HTTP/S index page is now completely user-modifiable, 

facilitating branding to your corporate look and feel.  

General Changes - Multiple AS2 usability and bug fixes, backwards compatibility with Secure FTP Server 3 and EFT 

Server 5 versions (easily upgrade from either version to EFT 6); password reset and password complexity are now 

part of the core Server feature set. 

For a detailed matrix of the features and functions available in the basic and Enterprise editions, refer to the 

feature comparison. 
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EFT SERVER™ FEATURE COMPARISON 

GlobalSCAPE® EFT Server™ v6 is available in a Basic and an Enterprise edition. Certain features and modules are 

available only in the Enterprise edition. During the evaluation period, all module functionality is enabled and visible 

in the administrator interface. After the trial expires, the functions and modules that are enabled and visible 

depend on the license purchased. (Web Services, X64 bit support, Oracle support, multi-Site DMZ Gateway, and 

AS2 are available only in the Enterprise edition.) 

The tables below compare the features available in the basic edition to the Enterprise edition. Certain features 

require the activation of one or more of the following modules, as indicated by the superscript number(s) next to 

"Optional." For example, Optional6,7 indicates that the feature requires the High Security and Auditing and 

Reporting modules. 

1. SFTP 

2. HTTP/S 

3. OpenPGP Encryption/Decryption 

4. Secure Ad Hoc Transfer 

5. Web Transfer Client (Requires HTTP/S module; the basic edition is limited to maximum of 5 concurrent 

users) 

6. High Security module (Requires ARM) 

7. Auditing and Reporting (ARM)  (Oracle support available in Enterprise edition only) 

8. DMZ Gateway (Multi-Site and outbound proxy support in Enterprise edition only) 

9. AS2 (available in Enterprise edition only; requires ARM and HTTP modules) 

SFTP (SSH) Basic Enterprise 

SFTP (SSH2) Optional1 Included 

SFTP key manager Optional1 Included 

Strong encryption (AES-256) Included Included 

Configurable SSH-protoversion-softwareversion Not Available Included 

SFTP public key authentication Optional1 Included 

SFTP public key list authentication Not Available Included 

FIPS-certified and validated SFTP cryptographic library Optional 6 Optional 6 

 

SSL (FTPS) Basic Enterprise 

SSL (explicit and implicit) SSLv2, 3, and TLS Included Included 

SSL key manager Included Included 

FIPS-certified and validated SSL cryptographic library Optional 6,7 Optional 6,7 

Specify SSL ciphers Included Included 

Specify SSL version levels Included Included 

IP address and PASV port overrides Included Included 

Mutual SSL authentication (client certificate authentication) Included Included 

SSL certificate-only authentication (no password) Not Available Included 

Hiding/disabling of non-allowed ciphers, key lengths, anonymous accounts, etc. Optional 6,7 Optional 6,7 
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HTTP/S Basic Enterprise 

HTTPS Optional 2 Included 

HTTP/S Web Transfer Client (Java Applet) Optional 2,5 Optional 5 

HTTP- to-HTTPS auto-redirect Optional 2,6 Optional 6,7 

AS2 (applicability statement 2) Not Available Optional 2,7,9 

 

FTP Basic Enterprise 

Checkpoint restart (resume) Included Included 

MODE Z compression support Included Included 

File Integrity Checking (XCRC) Included Included 

Customizable connection banner messages Included Included 

 

Password Rules Basic Enterprise 

User-initiated password reset Included Included 

Forced reset on initial login Included Included 

Expire password on certain date Optional 6,7 Optional 6,7 

Set expiration reminder (e-mail, banner) Optional 6,7 Optional 6,7 

Password reset Web page Optional 6,7 Optional 6,7 

Password reuse (users and administrators) Included Included 

Disallow reuse (password history) Included Included 

Password complexity (for administrators), 
 including: 

 Special chars 

 Numeric chars 

 Minimum chars 

 Lower case 

 Upper case 

 No repeating chars 

 No chars from username 

 No chars from dictionary file 

Included Included 
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General Security Basic Enterprise 

Disable account after invalid login attempts Included Included 

Temporarily disable invalid login accounts Included Included 

Lock out account after invalid login attempts Included Included 

Set account expiration date Included Included 

Disable account after <n> days of inactivity Included Included 

Remove account after <n> days of inactivity Included Included 

Hide/modify login banners Included Included 

IP address ban list for Site-wide access Included Included 

IP address ban list for remote administrators Included Included 

IP address ban list for on a per user basis Included Included 

Block Site-to-Site transfers Included Included 

File type (extension) ban list Included Included 

Monitor and report on PCI DSS violations Optional 6,7 Optional 6,7 

Limit number of logins, number of connections, 
     file size, transfer speed, and user disk quota Included Included 

Protection against Denial of Service (DoS) attacks Included Included 

 

Data Security on Disk Basic Enterprise 

Data sanitization (wiping) Not Available Optional 6,7 

Streaming repository encryption (EFS) Not Available Optional 6,7  

PGP encrypt/decrypt Optional 3 Optional 3 

Digital certificates Included Included 

Strong encryption (AES-256) Included Included 

 

DMZ Security Basic Enterprise 

Secure DMZ Gateway outbound /proxy Not Available Optional 8 
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Administration Basic Enterprise 

Silent (unattended installs) Included Included 

Proprietary (GlobalSCAPE) authentication database Included Included 

Authenticate users through connection to ODBC Database Included Included 

Authenticate users through connection to NTLM Included Included 

Authenticate users through connection to Active Directory Included Included 

Authenticate users through connection to LDAP server Not Available Included 

Active-passive clustering Included Included 

Remote administration Included Included 

Secure remote administration (SSL) Included Included 

Windows Explorer-like file system view Included Included 

Command line administration interface Included Included 

COM API administration Limited Included 

Multiple administrator support Included Included 

Delegated administrator, per Site Not Available Included 

Delegated administrator granular permissions Not Available Included 

Root folder point to SAN or NAS Included Included 

E-mail notifications Included Included 

 

Auditing and Reporting Basic Enterprise 

Flat file logging Included Included 

Real-time user monitoring w/kick user Included Included 

Database-driven auditing of all Server transactions Optional 7 Optional 7 

Complete customizable reporting solution Optional 7 Optional 7 

Administrator action logging Not Available Optional 7 

Connection to Oracle database Not Available Optional 7 

 

Integration and Workflow Basic Enterprise 

Web Services Interface Not Available Included 

Run programs via FTP "SITE" commands Included Included 

Clone (copy) Event Rules Included Included 

Multipart transfers Included Included 

Automatic restart of incomplete file transfers Included Included 

Advanced Workflow tasks (AWE module) Not Available Included 
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Event Triggers Basic Enterprise 

User login failed Included Included 

User login/logout Included Included 

User account created Included Included 

User password change Included Included 

File upload/download success Included Included 

File upload/download success verified (XCRC) Included Included 

File upload/download failed Included Included 

File renamed, deleted, moved Included Included 

Folder created, deleted, moved Included Included 

Quota limit reached Included Included 

Recurring timer (scheduled) event Not Available Included 

Service/Site started/stopped Included Included 

Monitor folder for changes (hot folder) Not Available Included 

 

Event Actions Basic Enterprise 

Send e-mail notifications Included Included 

Launch external programs Included Included 

Offload (copy/move) files using built-in client Not Available Included 

Download files using built-in client Not Available Included 

Offload/download through DMZ Gateway, Proxy, or Socks Not Available Included 

Clean-up old data Not Available Included 

Generate report (PDF, HTML) Optional 7 Optional 7 

Context variables pass-through to actions Included Included 

Run multiple actions on trigger Included Included 

IF conditional statements Included Included 

ELSE conditional statements Not Available Included 

Compound conditional statements Included Included 

Logical Operators (AND, OR, and NOT) Included Included 

Failed action conditional logic Included Included 

AS2 send Action Not Available Optional 9 

OpenPGP Action Not Available Included 

Backup server configuration to folder Not Available Included 
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Resource Management Basic Enterprise 

Automated file maintenance Included Included 

Centralized account management Included Included 

Settings Templates (set once and apply to many) Included Included 

Permission groups Included Included 

User and group permissions for Server access Included Included 

User home directory as root Included Included 

Set storage limit (disk quota) Included Included 

Set bandwidth limit (transfer quota) Included Included 

Set max connection limit Included Included 

Set max connection per IP limit Included Included 

Set max connections for same user account name Included Included 

Set max concurrent socket connections Included Included 

Set max uploads per session Included Included 

Set max downloads per session Included Included 

Create virtual folders and map to UNC Included Included 

Provide anonymous access  Included Included 
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STEP 1: INSTALLING AND ACTIVATING THE SOFTWARE 

The topics below provide information regarding installing and activating EFT Server, and configuring EFT Server on 

your network. 

EFT SERVER™ DEPLOYMENT SCENARIOS 

You have several options for how you configure EFT Server in your network architecture. Some common 

deployment scenarios are described below. If none of these scenarios exactly meets your needs, GlobalSCAPE's 

Professional Services team can work with you to design a custom architecture, assist with installation and initial 

configuration, and help you create custom scripting, Event Rules, Commands, and external user databases.  

EFT Server™ in the Demilitarized Zone (DMZ) 

In the most basic deployment scenario, both end users and business partners (clients) communicate with EFT 

Server as it resides in your organization's demilitarized zone (DMZ). All authentication directory service quests and 

data storage occur inside the DMZ.  

EFT Server can be configured to forward all received data to the back-end network to mitigate the risks associated 

with storing it in the DMZ. This architecture, commonly known as store and forward, means that data only resides 

in the DMZ temporarily before it is offloaded to a back-end system for processing or storage. This store-and-

forward architecture requires a hole to be punched through the firewall in west-to-east fashion,  a deviation from 

security best practices. This architecture is the one most commonly employed by competitors to GlobalSCAPE’s 

Server solution. 

EFT Server™ and DMZ Gateway Deployment 

The ideal security solution is to implement a two-tier architecture comprised of the Server deployed behind the 

corporate firewall and the DMZ Gateway deployed inside the demilitarized zone. This setup is known as a 

streaming or pass-through configuration.  

Hybrid Configuration 1: Server-to-Server Deployment 

Various hybrid approaches exist consisting of multiple servers in a variety of configurations for different business 

use cases. Take for example a scenario in which the majority of traffic is outbound push with occasional in-bound 

pull, initiated by an automated script or batch process. In this scenario, data is generated behind the corporate 

firewall, then forwarded from one the Server to another the Server that resides in the DMZ for client pick-up, or 

directly from the back-end server to a destination server residing at the partner’s location.  

 

The business need for placing the Server in the DMZ often stems from the need to pre- or post-process 
data as it moves through the DMZ, such as performing an anti-virus scan or an encryption procedure.  

Hybrid Configuration 2: Two EFT Servers and a DMZ Gateway 

In this hybrid deployment scenario, a client-initiated push and/or pull transaction is brokered through DMZ 

Gateway, and outbound push transactions are initiated by the Server, either from within the corporate firewall or 

from a Server residing in the DMZ. In this example, the partner is equipped with a file transfer server to service 

outbound push operations initiated by the Server. 

Two EFT Servers and Two DMZ Gateways in a Server Cluster 

In the architecture illustrated below, 2 EFT Servers and 2 DMZ Gateway Servers in a server cluster meet business 

continuity requirements requiring the duplication of servers to provide a fail-over cluster. 

http://www.globalscape.com/support/professional_services.aspx
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SYSTEM REQUIREMENTS 

The GlobalSCAPE Quality Assurance team tests our products with a variety of operating systems, software, and 

hardware. It is possible for EFT Server to function with other operating systems, software, and hardware than 

those listed below, but is only tested and approved for use with the following: 

 Windows XP Professional, Windows Server 2003, Windows Server 2008 (Standard, Enterprise, and 

Datacenter editions) x86-64 

 

For EFT Server basic edition, a registry key can be used for 64-bit support. The key will be 
unnecessary in an upcoming release. 

 3.5 GB RAM (More RAM could be required for high-density, non-EDI file transfers over the AS2 protocol. 

AS2 transfers can use up to 40% of the Server's RAM for concurrent file transfers.) 

 1024x768 resolution or higher display (for the Administrator Interface)  

 Microsoft® ActiveX Data Objects (ADO) (for Auditing and Reporting)  

 SQL Server Express, SQL Server, or Oracle for Auditing and Reporting; (Oracle for Enterprise edition only; 

refer to System Requirements for Using an Oracle Database for detailed system requirements.). The 

installer includes SQL Express 2005 SP2, which requires .NET 2.0, Internet Explorer 6, and IIS 5. (Refer to 

http://technet.microsoft.com/en-us/library/ms143506(SQL.90).aspx  for SQL Server Express system 

requirements.)  

 Microsoft .NET Framework 2.0 or greater (for AS2 and AWE modules); .NET 3.5 required for Secure Ad 

Hoc Transfer (SAT) Module (For details of SAT system requirements, refer to "Secure Ad Hoc Transfer 

Module System Requirements" in the Secure Ad Hoc Transfer module help documentation.) 

 EFT Server and DMZ Gateway must be installed on separate computers (For details of DMZ Gateway 

system requirements, refer to "System Requirements for DMZ Gateway" in the DMZ Gateway help 

documentation.) 

 If EFT Server will be monitoring SAMBA network shares, version 3.0.25 of Samba is required. 

For information regarding system requirements for DMZ Gateway and the Secure Ad Hoc Transfer module, refer to 

their documentation. 

 

The Server service runs under a user account, which must have full administrative rights to the folder in which 
you install the Server. With administrative rights, the service can save all your settings. If the service does not 
have administrative rights, you will lose settings and user accounts whenever you restart the Server service 
and you will need to reset permissions on the computer on which the Server service is running. 

SYSTEM REQUIREMENTS FOR USING AN ORACLE DATABASE 

(Oracle connectivity available in EFT Server Enterprise™) EFT Server 6 uses the Oracle OLE DB provider to access 

the database. The 11g version was used in development and testing, which supports Oracle 9.2 and greater. For 

more information, refer to the following Oracle links: 

http://www.oracle.com/technology/tech/windows/ole_db/index.html  

http://www.oracle.com/technology/docs/tech/windows/ole_db/index.html  

http://technet.microsoft.com/en-us/library/ms143506(SQL.90).aspx
http://www.oracle.com/technology/tech/windows/ole_db/index.html
http://www.oracle.com/technology/docs/tech/windows/ole_db/index.html
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The following items are required on a system to use Oracle Provider for OLE DB: 

 Windows Operating System: 

o 32-bit: Windows Vista (Business, Enterprise, and Ultimate Editions), Windows Server 2003, 

Windows Server 2003 R2, Windows 2000 or Windows XP Professional Edition. 

o 64 bit: Windows Vista x64 (Business, Enterprise, and Ultimate Editions), Windows Server 2003 

x64, Windows Server 2003 R2 x64, or Windows XP x64. 

o 64-bit: Windows Server 2003 for Itanium-based systems. 

 Access to an Oracle Database (Oracle 9.2 or later) 

 Oracle Client release 11.1 or later and Oracle Net Services (included with Oracle Provider for OLE DB 

installation). 

 Redistributable files provided with Microsoft Data Access Components (MDAC) 2.1 or higher are required 

by the provider. These files are available at the Microsoft Web site: http://www.microsoft.com/data/ 

 Oracle Services for Microsoft Transaction Server release 11.1 or higher. This is required for consumers 

using Microsoft Transaction Server (MTS) or COM+. 

There are 8i and 9 OLE DB providers that should work, but avoid the 10g version. Provider was changed from 

OraOLEDB.Oracle.1 to MSDAORA.1 due to Oracle Bug #4518457. For more information, refer to 

http://forums.oracle.com/forums/thread.jspa?messageID=1499744. 

http://www.microsoft.com/data/
http://forums.oracle.com/forums/thread.jspa?messageID=1499744
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EFT SERVER SPECIFICATIONS 

This document is intended as a quick reference to various specifications for EFT Server. The information is provided 

in detail in the applicable procedures. 

Item Description 

Server's Windows user 
account  

The Server service runs under a user account, which must have full administrative 
rights to the folder in which you install the Server. With administrative rights, the 
service can save all your settings. If the service does not have administrative rights, 
you will lose settings and user accounts whenever you restart the Server service, 
and you will need to reset permissions on the computer where the Server service is 
running. 

Protocols allowed  FTP/S (SSL/TLS), SFTP (SSH2), HTTP/S, and AS2 

Authentication types  GlobalSCAPE, AD/NTLM, LDAP, ODBC 

Log formats  W3C, Microsoft IIS, and NCSA 

SSL Certificate Key 
lengths supported  

Key lengths supported: 1024, 2048, 3072, and 4096 bits  

Server-created SSL 
certificates  

x.509 base-64 standard DER encoded 

Allowed OpenSSL 
ciphers  

Name in EFT Server Cipher 
List 

OpenSSL Name Enabled by 
default 

AES 256 bit AES256-SHA Yes 

Camellia 256 bit CAMELLIA256-
SHA 

Yes 

3DES 168 bit DES-CBC3-SHA Yes 

AES 128 bit AES128-SHA Yes 

IDEA 128 bit IDEA-CBC-SHA> Yes 

RC4 128 bit RC4-MD5 Yes 

Export (40-56 bit) EXP No 
 

Allowed SSL versions  TLS 1.0, SSL 2.0, or SSL 3.0 

Hashing algorithms 
supported 

 Haval  

 MD2  

 MD4 

 MD 5  

 RIPE-MD  

 SHA –1  

 SHA-Double  

 Tiger  

OpenPGP version OpenPGP is a standard and has no version. The Server adheres to the OpenPGP 
standard and is RFC 2440 compliant.  

 

  

http://www.ietf.org/rfc/rfc2440.txt
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BEST PRACTICES FOR CONFIGURATION AND VALIDATION 

Below is a collection of suggestions and guidelines for installing, configuring, and deploying the Server and/or DMZ 

Gateway software in a production environment. 

Development Lab Environment 

As with any mission-critical software or hardware, it is recommended that a testing, validation, development, or 

usability lab be established to provide a "sandbox" into which the Server and DMZ Gateway Server software can be 

deployed. This initial deployment allows for validation of the interoperability with other dependent components as 

well the validation of expected usage scenarios. 

The lab environment should emulate (if not duplicate) the production environment at a network topography and 

application level. To do this, a clear vision of the production network and the proposed deployment of the Server 

and DMZ Gateway must exist. Typical deployments of the Server and DMZ Gateway consist of many other 

components from the enterprise, including Active Directory Server, SQL Server, SMTP Server, and a storage system 

such as a SAN. For DMZ Gateway, a firewall such as Microsoft ISA might be applicable. Finally, some deployments 

also include Microsoft Clustering, in which case various components are replicated to provide clustered resources. 

For increased business continuity and risk mitigation, you should use the development lab environment as the 

starting point for any configuration changes in the system. That is, make the change in development and validate it 

prior to making the change in production. 

 

A good testing tool is CuteFTP Professional. 

 

Configuration Validation  

The installation and configuration of the Server in either a lab or production environment should be validated by 

the Server administrators/operators to ensure that the functions are working as expected. Use the checklist below 

to validate key items for a Server and DMZ Gateway deployment. 

Service 

 

Make sure that the GlobalSCAPE Server service is started on the computer.  

 

Make sure that the service is listening on the expected IP:PORT socket addresses on the Server. (To view 
the listening sockets, use "netstat -ona" from a command line or an application such as PrcView or 
TcpView.)  

 

Check the Event Viewer log to ensure that there are no errors in the Application log related to the Server 
or DMZ Gateway Server. 

 

Confirm that the Administrator shows the status of the system when it is launched and connected to the 
Server.  

Server User Management  

 

For each Site on the Server, ensure that the expected user accounts exist.  

 

To ensure that authentication is working as expected, attempt to log in to the Server as a user account on 
the system (using any protocol). 

 

To confirm permissions for the user account are working as expected, attempt a file transfer. 

  

http://www.globalscape.com/cuteftppro/
http://www.cnet.com.au/downloads/0%2c239030384%2c10610163s%2c00.htm
http://www.cnet.com.au/downloads/0%2c239030384%2c10652554s%2c00.htm
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Protocol/Network  

 

For each protocol enabled on the Server, attempt a connection directly to the Server using a client that 
supports that protocol. 

 

For each protocol enabled through DMZ Gateway, attempt a connection to the appropriate DMZ Gateway 
IP:PORT and confirm that this route works as expected.  

Auditing/Logging  

 

View the audit traces generated by the validation steps above.  

 

Confirm that the Auditing and Reporting module database has been populated with appropriate data (using 
either the Server Reporting interface or direct access to the SQL Server being used).  

 

Confirm that the text log files generated by the Server have been populated with the appropriate data.  

Event Rules/Workflow 

Each customer has a unique set of Event Rule/workflow requirements, but these are the general validation steps. 
Confirm the following are working as expected:  

 

E-mail notifications. Test e-mail notifications by triggering an Event Rule that has an e-mail 
notification Action to confirm that Event Rules fire and that the SMTP configuration  is correct.  

 

PGP operations. Confirm that OpenPGP keys are configured properly.  

 

Move/Copy/Download actions. Initiate Event Rules that perform remote file uploads/copies/download so 
that connectivity originating from the Server to a remote system is properly configured. In this step, also 
confirm that a log file is generated that audits outbound connection information (a "cl*.log" file in the 
designated Server Log File location).  

 

Custom Commands. The Server is responsible for triggering those external commands, so that is what 
should be validated with respect to the Server. Any actions carried out by those external tools should be 
validated independently. Confirm that a "CMDOUT.LOG" file is generated in the Server installation folder as 
the result of an invoked Custom Command.  

 

Folder Monitor Rules. Ensure that the Event Rules are properly enabled and responsive to files added to the 
folder being monitored. 

Cluster/Failover Testing  

 

For cluster deployments, the failover and failback operations of the cluster should be confirmed. After a 
failover/failback, confirm that the newly active server behaves properly; that is, the failover is transparent 
and the configuration/operation is as expected. This can be summarized by the prior set of tests operating 
against the newly active node in the cluster.  

Load Testing  

 

If you expect high volumes of traffic or back-end processing within the Server, you should verify that the 
resource utilization levels on the Server are within acceptable tolerances. There are numerous load-testing 
tools available, ranging from simple batch files running command-line FTP to highly complex synthetic 
transaction generators. GlobalSCAPE's Quality Assurance team performs load testing of our servers as part 
of our standard validation process for releasing software and can provide guidance and/or tools to assist in 
load testing.  

Numerous other features can be validated within the Server. The above set represents the key elements that are 

most often used and are the most critical to successful operation in a production environment. 

Prescriptive Guidance for Maintenance 

The following are guidelines for maintaining the good health of a Server and DMZ Gateway deployment, and 

reducing long-term costs of maintenance and operation.  
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Configuration Backup - For disaster recovery and business continuity, it is important to keep backups of the Server 

and DMZ Gateway configuration. Backing up the configuration can be accomplished with a variety of tools such as 

Symantec Backup Exec, Ghost / VMWare to make images of the system, GlobalSCAPE Continuous Data Protection 

(CDP), or even a simple script file.  

Database Backup and Truncation - If you are using the Auditing and Reporting module (ARM), the SQL Server to 

which the audit records are stored should include the Server ARM tables as part of the typical database 

maintenance plan. This includes proper monitoring of the tables and transaction logs, backing up the data and 

having a retention policy to archive (or purge) old data.  

Restarting Services - Given the facility of the Microsoft Cluster in failing over and failing back while providing high 

resource availability, it is recommended that you design a maintenance schedule in which the Server service is 

cycled at least once per quarter to once per month. Failing over to the backup node, restarting the service, then 

failing back and restarting the other node would suffice in re-establishing a baseline state of the Server service to 

ensure optimal health.  

Data Archival and Retention - It is suggested that a policy be put in place and enforced by which old data is 

periodically archived and/or purged, because no disk is limitless and performance can degenerate as more files are 

added to the Server. Therefore, a storage management policy should include regular inspection of available hard 

disk space and health (error count, fragmentation, etc.) as well as archiving and/or purging user data and Server 

Log Files (CMDOUT.log found in the application folder, and all other logs found in the Log folder specified at the 

Server level in the Server).  

Performance Counter Monitoring - DMZ Gateway Server provides a Performance Counter object to the computer 

on which it is installed. This object provides a standard Windows mechanism to view activity through DMZ 

Gateway and, in general, assess the fundamental health of the system as a whole. It is recommended that the 

enterprise operations practices include monitoring the key performance counters (automatically is preferred) by 

adding the "Gateway" performance object to Microsoft's Perfmon, and monitoring items such as "Active Sites" 

(indicates up/down state of the Server through DMZ Gateway) and "Active Client Connections" (indicates activity 

through the DMZ Gateway to the Server).  

Event Log Alerting - The Server will log error conditions to the standard Windows Event Viewer. It is recommended 

that the operations team for an enterprise include the Server error checks in their monitoring techniques, looking 

for an ERROR event generated with a source of "EFT Server" or "GlobalSCAPE Gateway" service.  

Procedure for Cold Standby Setup 

Below are few recommendations for achieving a backup server image that is ready to be turned on quickly and 

accept "real" traffic. 

 

In all situations, if we are copying a configuration file from one system to another, care must be taken 
with hardware-specific resources, such as IP addresses, physical paths/partitions, and so on. If possible, it 
is recommended that the Server configuration use the generic "All Incoming" IP Address for incoming 
socket connections so that differences in computer IP addresses do not prevent proper operation of the 
system if the Cold Standby comes online. 
 
Furthermore, we must take care with the connections and IP-access restriction lists between the Server 
and DMZ Gateway. If the DMZ Gateway is configured to allow only one the Server IP address to connect to 
it, then the Cold Standby server must have the same IP address to connect; alternately, the DMZ Gateway 
IP access list must include all possible IP addresses (possibly a Class C subnet) so that multiple servers from 
the approved network segment may connect. 

Virtualization Software - A great solution from a cost- and resource-saving standpoint, it is also quite easy to 

manage due to the "software" nature of the solution. The approach would be to create an image within a Virtual 

system (using a tool such as VMWare or Microsoft Virtual PC) by installing and activating the Server or DMZ 
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Gateway software. Once this is done, the steps required to bring the system online include first copying the 

configuration files (which were backed up using a process described above), then bringing the virtual image online 

and starting the service.  

System Backup Software - Another quick and easy option is to create a disk or system image of a configured the 

Server or DMZ Gateway (using a product such as Norton Ghost); when a Cold standby needs to be "stood up" and 

made hot, the image can be installed on a computer, backup configuration copied, and the service started.  

Periodic Backup to Cold Standby Machine - If resources permit, the quickest way to get a "Cold" computer to 

become "Hot" is to have a computer dedicated to this function. It should have the Server and/or DMZ Gateway 

installed and activated, but the service should be stopped. A process to copy the configuration periodically from 

the "Hot" server to the "Cold" server would keep the two in synch, and if the "Hot" system goes down, the "Cold" 

system can simply start the service.  

INSTALLING THE SERVER, ADMINISTRATOR, AND MODULES 

The EFT Server installer is used to install EFT Server, DMZ Gateway, and Secure Ad Hoc Transfer module. Each of 

the other modules, Auditing and Reporting Module (ARM), Advanced Workflow Engine, AS2 module, High Security 

module, OpenPGP module, and the Web Transfer Client, is installed with EFT Server and available during the 30-

day trial. To activate the modules after the evaluation period, you must purchase a serial number specific to each 

module.  

 

Although it uses the same installer, the DMZ Gateway Server cannot run on the same computer as EFT Server. 
If you attempt to install DMZ Gateway on the same computer as EFT Server, a warning message appears. 
Click Abort and install DMZ Gateway on a separate computer.  

If you are upgrading from a previous version of the Server, refer to Upgrading the Server. 

 

If you are using Windows 2000 for your Server installation and will be using ARM, you must update MDAC 
prior to installation. You can find the latest update at http://msdn.microsoft.com/data/ref/mdac/downloads. 
This does not apply to Windows XP or Windows 2003, as they come with a newer version of MDAC that is 
compliant.  

Before installing the software, refer to System Requirements, and read the entire procedure below. If you are 

upgrading, refer to Upgrading the Software. 

 

After you have installed the system on a test computer and are now ready to move it to a production 
environment, refer to Backing Up or Restoring Server Configuration (Enterprise) or Copying Server 
Configuration to Several Computers if you want to keep the test environment's Server, Site, and user 
configuration settings. Otherwise, install as usual on the production system. 

To install EFT Server, Administrator, and modules (except for DMZ Gateway and Secure Ad Hoc Transfer) 

1. Close all unnecessary applications so that the installer can update system files without rebooting the 

computer. 

2. Start the installer, then click Next.  

 If this is a fresh installation, the Choose an installer page appears. (Illustrations below show EFT 

Server Enterprise installation; the procedure is the same for EFT Server basic edition.) 

http://msdn.microsoft.com/data/ref/mdac/downloads/
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o Click the list and then, depending on which edition of EFT Server you downloaded, click 

GlobalSCAPE EFT Server or GlobalSCAPE EFT Server Enterprise. (The EFT Server and EFT 

Server Enterprise installers will also install each of the modules EXCEPT for DMZ Gateway 

and Secure Ad Hoc Transfer.) 

 If you are upgrading or reinstalling, the version detected page appears. 

 

o To upgrade an existing installation, click Repair. After you click Next, the existing files 

are updated. 

o To install or uninstall specific components, click Modify. This allows you to choose 

components to install (Server, Admin interface, and/or Auditing and Reporting). 
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o To install a fresh installation, including a new configuration file, click New Install. This 

option assumes that you do not want to keep the existing configuration. If you want to 

keep your existing configuration, you should install in a new location. Or refer to Backing 

Up or Restoring Server Configuration BEFORE INSTALLING if you want to keep an 

existing version 6.x configuration. 

3. Click Next. The Welcome page appears. 

 

4. Read the Welcome page, then click Next. The License Agreement page appears. 

 

5. Read the license agreement, then click I agree to accept it. (Clicking Cancel aborts the installation.) The 

Choose Install Location page appears. 
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6. The default installation location appears in the Destination Folder box. Leave the default or click Browse 

to specify a different folder, then click Next. The Choose Components page appears. 

 

7. When you install the Server, you must also install the EFT Admin Interface. After you have installed the 

Server and Administrator Interface on one computer, you can install the Administrator Interface on other 

computers for remote administration.  

 To install only the Administrator Interface, clear the EFT Server and Auditing and Reporting 

check boxes. (The EFT Admin Interface check box will still be gray, but it will install.) 

 If you do not want to install a database, clear the Auditing and Reporting check box. 

The Choose Start Menu Folder page appears. 
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8. Click Next. The administration account configuration page appears. 

 

9. Create a user name and password for the administrator account for connecting to the Server from the 

Administrator. Both the username and password are case sensitive and must be between 1 and 20 

characters. 

 

Remember your user name and password; you need them to connect to the Server. If you later forget 
your password, refer to Forgetting the Server Administrator Password. 

10. Click Next.  

 If you did not select the Auditing and Reporting check box, skip to step 18.  

 If you selected the Auditing and Reporting check box, the database setup page appears.  
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11. Specify the type of database that EFT Server is to connect to: 

 Install SQL Server Express 2005 (the default) 

 Use existing SQL Server (Server, Express, MSDE) - After you provide connection information here 

and on the next page, the installer tests the connection. If the connection fails, you can go back 

and verify the information or continue without configuring the connection. 

 Use existing Oracle database - (Available only in EFT Server Enterprise) After you provide 

connection information here and on the next page, the installer tests the connection. If the 

connection fails, you can go back and verify the information or continue without configuring the 

connection. 

 

You must define a complex password in order to complete installation. 

12. Specify the database name (EFTDB by default) and login credentials that EFT Server is to use to connect to 

the database. 

13. Click Next. The database address and database administrator login credentials page appears.  
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14. Specify the database host address or instance name and the credentials used by the database 

administrator to administer the database. 

 

The password must meet SQL Server password policy requirements. 

15. Click Next. If you chose to install SQL Server Express, the SQL Server installer starts. 

 

The installer installs the options that you selected, then the Installation Complete page appears. 

http://msdn.microsoft.com/en-us/library/ms161959.aspx
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16. Click Next. A page appears allowing you to start the Server, create an Administrator Interface shortcut on 

the desktop, open the Administrator Interface, and/or view the EFT Server version history. 

 

 The Start the EFT Server Service check box is selected by default. Clear the check box if you do 

not want to start the Service yet. The service is configured to start automatically when the 

computer starts. If you do not want the service to start automatically, you will have to configure 

it to start manually in the Windows Services dialog box. 

 The Start  Administrator Interface check box is selected by default. If you do not want to open 

the Administrator, clear the check box. The Administrator is used to configure the Server. You 

can also open the Administrator by clicking the Start menu. 

 An Administrator Interface shortcut is created on the desktop by default. If you do not want to 

create a shortcut, clear the check box. 
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 If you want to read the release notes, select the Show Version History (Readme) check box. If 

you want to read it later, the file, notes.txt, is stored in the EFT Server installation directory.  

17. Click Finish. If the Launch Administrator Interface check box was selected, the Login wizard appears.   

 

18. Leave This computer selected, then click Next. The EFT Server Administrator Login page appears. 
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19. In the Username and Password boxes, provide the login credentials that you created during installation, 

then click Connect. The Welcome page appears. 

20. Do one of the following: 

 If you are evaluating the software, click Start Trial, then follow the procedures to configure the 

Server. 

 If you have purchased a license, click Activate Now, then follow the procedures for activating the 

software. 

Next Steps:  

1. Activate the Software  

2. Set Windows System Services   

 

The Server service runs under a user account, which must have full administrative rights to the folder 
in which you install the Server. With administrative rights, the Server service can save all your 
settings. If the service does not have administrative rights, you will lose settings and user accounts 
whenever you restart the Server service, and you will need to reset permissions on the computer 
on which the Server service is running. 

 

 

If you are using Microsoft IIS, refer to Running the Server and Microsoft IIS on the Same Computer. 
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ACTIVATING THE SOFTWARE (SERVER AND ADD-ON MODULES) 

When the trial period has expired, all remote connections are disallowed. The Continue Trial button changes to 

Developer Mode and remains in this state until the Server is activated or uninstalled. To allow you to continue 

evaluating EFT Server functionality after trial expiration, EFT Server blocks all incoming client IP addresses other 

than the localhost from connecting to the Server, either as an administrator or as a client (using FTP/S, SFTP, or 

HTTP/S protocols). All outgoing (offload/download) requests from the Server's Event Rules are also blocked to any 

IP address other than localhost. Therefore, when the trial period is over, no external IP addresses can connect to 

the Server, nor can the Server connect to any external IP addresses.  

You must activate the software with a serial number. Each of the modules are available during the Server trial and 

must be activated separately. 

To activate online, you must be connected to the Internet, and activation must be performed through the 

Administrator on the Server computer. You cannot activate through a remote installation of the Administrator. 

You can also e-mail the manual activation information to GlobalSCAPE Technical Support. GlobalSCAPE will confirm 

your activation and send you a .reg file. You can send the e-mail from any computer with Internet access, and then 

transfer the .reg file to the computer on which you are installing the software. 

 If you are moving a Server from one computer to another, contact the GlobalSCAPE customer service 
team or your account manager so that we can adjust your account on our activation server. Activation on 
the new computer will not be possible until the adjustment is made. 

 If you are upgrading EFT Server residing in a clustered environment, refer to Installing the Server in a 
Cluster, and contact GlobalSCAPE technical support for assistance, if necessary. 

 If the Server is installed on Windows 2003, log in to the Server as a user with an account having 
administrator privileges instead of "Local System" privileges to write the .reg file to the registry.  

To activate the Server and/or add-on modules via the Internet 

1. Start the Administrator and provide your Server administrator credentials (created at installation). 

 If this is your first time attempting to connect, you are prompted to enter a serial number or start the 
trial. If you click Activate Now, the Registration Wizard appears. 

 If you previously connected in developer mode, on the main menu click Help, then click the product 
you want to activate: 

o Activate EFT Server (or EFT Server Enterprise) 

o Activate Web Transfer Client  

o Activate High Security Module 

o Activate AWE Module 

o Activate Auditing & Reporting Module 

o Activate OpenPGP Module 

o Activate AS2 Module 

The Registration Wizard appears. 

2. In the Serial Number field, provide your serial number, then click Next. In the Name field, provide your name 
and/or your company name, then click Next. Only the Name field is required; all others are optional. Your 
information is used for account verification if you call for support, so the more information you provide here, 
the easier it is for Support to locate your account.  

 

If a firewall or a proxy server is in use, your network administrator should ensure that outbound port 80 is 
open during the registration process. 



Installing and Activating the Software 

53 

3. You should receive a message confirming activation. Click OK. Activation is complete. (If registration fails, 
try entering your serial number again, or you might need to configure an HTTP proxy.) 

If you have any problems with registration, visit GlobalSCAPE Customer Support, at 
http://www.globalscape.com/support/customerservice.aspx.  

INSTALLING OR UPGRADING EFT SERVER IN A CLUSTER 

EFT Server can be installed in an active-passive cluster to achieve high availability through failover clustering. 

 Separate instructions are provided below for installing and upgrading EFT Server in a cluster. 

INSTALLING EFT SERVER IN A CLUSTER CONFIGURATION 

 

Before you add EFT Server to your cluster, you must setup your cluster manager. Please consult your cluster 
manager vendor’s documentation for further assistance. 

If you require assistance installing and configuring a cluster, GlobalSCAPE Professional Services group can assist you. 

To install an EFT Server version 6 or later in a cluster configuration: 

 

Step Owner 

 

1. Setup Microsoft Clustering Services (MSCS), Symantec’s Veritas Cluster Server, or other 
cluster manager according to your cluster manager vendor’s documentation. 

 

 

2. Make sure the first node has access to the shared resource drive (and is the cluster group 
owner). 

 

 

3. Run the EFT Server installer on the cluster group owner.  

 

4. On the Choose install type page, click Part of a cluster, then click Next. When the 
confirmation prompt appears, click Yes. 

 

 

5. Specify the installation location on your local physical drive, then click Next.  

 

6. Specify the shared resource drive when prompted for the configuration data location.  
 
Note: If you cannot browse to the shared drive, then the resources are not being seen by the 
cluster. If so, CANCEL the installation, verify the shared resource drive can be accessed on the 
node you are installing on, and restart the installation process. 

 

 

7. A prompt appears asking "Is this the first node in the cluster?" Do one of the following: 

 Click Yes if this is the first node in the cluster.  

 Click No if you already installed EFT Server on the first node and you are now installing 

EFT Server on the second node. 

 

 

8. Follow the prompts in the wizard to create the admin account, install the ARM database, etc.  
If this is the first node, on the final page of the installer, ensure that the Start the EFT Server 
Enterprise service check box is NOT selected, and then click Finish. 

 

 

9. Ensure that the EFT Server service is set to Manual, not Automatic (Start > Run > 
services.msc).  

 

 

10. Now make the second node the cluster group owner (so that it has access to the resource 
drive). 

 

 

11. Repeat steps 3 – 8 on the second node.  

 

12. On the final page of the installer, ensure all check boxes are selected, then click Finish.  

 

13. Configure EFT Server and license the product and any add-on modules.   

 

14. Once you have configured EFT Server to your liking, make the first node the cluster the group 
owner, then license EFT Server and any add-on modules in that node. (Notice that EFT Server 
on the first (primary) node picks up all configuration done to the second node in step 13, 
because the nodes share the configuration files.)  

 

http://www.globalscape.com/support/customerservice.aspx
http://www.globalscape.com/products/pro_services.aspx
file:///D:/WorkFolder/Technical%20Writing/EFT%20Server/EFT6/Source/configuring_eft_server.htm
file:///D:/WorkFolder/Technical%20Writing/EFT%20Server/EFT6/Source/activatingthesoftware.htm
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UPGRADING EFT SERVER IN AN EXISTING CLUSTER 

 

 These steps are valid only if upgrading from EFT 6.x to EFT 6.2 or greater.  

 Only upgrade during a maintenance window, as the upgrade process will bring all services offline!  

 All steps must be performed on the Active node! 

To upgrade an EFT Server version 6 or later that is already installed in a cluster configuration: 

 

Step Owner 

 

1. Verify your EFT Server administrator credentials by logging in to EFT Server as a Server-level 
administrator.  

 

 

2. Verify your SQL or Oracle auditing and reporting (ARM) database owner login credentials. 
Disregard if using Windows authentication for the database connection. 

 

 

3. Log in to the EFT Server administration interface and run the Backup Server Configuration 

tool to backup EFT Server’s configuration folder located on the shared resource drive. 
(Available in EFT Server Enterprise only.) 

 

 

4. Copy the entire EFT Server configuration folder directory located on the shared resource drive 
to a safe location.  

 

 5. Backup your EFT Server auditing and reporting database. (Strongly recommended.)  

 

6. Open the 3rd-party cluster administrator tool (such as MSCS) and take the EFT Server 
Enterprise resource offline. 

 

 

7. Start the latest EFT Server installer on the cluster group owner (Active node).  

 

8. On the Prior version detected page, click Upgrade cluster, then click Yes to confirm that 

you have read the cluster documentation. 
 

  If a .NET warning prompt appears and you are NOT using AS2 or AWE modules, click OK 

to dismiss the message . 

 

 

9. A prompt appears asking "Is this the first node in the cluster?" Do one of the following: 

 Click Yes if you are upgrading  the first node in the cluster.  

 Click No if you already upgraded the first node and are now going through the steps again 

for the second or Nth node. 

 

 

10. Verify that the installation Destination Folder matches the current program install directory, 
typically C:\Program Files\GlobalSCAPE\EFT Server Enterprise.  

 If you are upgrading from EFT Server version 6.0, you will be prompted for the 
Configuration Data Location. You must specify the correct folder where your 

configuration data is located, usually on the shared drive.  
 
Note: If you cannot browse to the shared drive then you are likely attempting an 
upgrade on the passive node. If so, CANCEL the installation and start again on 
the Active node.  

 

 

11. On the Auditing and Reporting database configuration page, click Configure Auditing 
and Reporting (most likely) or skip if auditing is not being used (rare). 

 

 

12. Click Use existing SQL Server or Use existing Oracle database, as appropriate, then click 
Next. 

 

 

13. Provide your database credentials if using SQL or Oracle authentication, otherwise click 
Windows authentication. Click Test to verify your database connection. 

Note: Do not proceed with the installation if you are unable to validate your database 

connection. Contact GlobalSCAPE support or your database administrator for further 

assistance. 

 

http://www.globalscape.com/support/techsupport.aspx
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Step Owner 

 

14. On the final page of the installer, ensure that the Start the EFT Server Enterprise service 
check box is NOT selected, then click Finish. 

 

 

15. Ensure that the EFT Server service is set to Manual, not Automatic (Start > Run > 
services.msc). 

 

 

16. Use the 3rd-party's cluster administrator’s Move Group function to change ownership of the 

cluster group to the second node. The second node is now the Active node.  
 

 17. Repeat step 7-15 above on the new Active node (formerly passive node), making sure to click 

No in step 9 when the prompt asks  "Is this the first node in the cluster?" You will not be 

prompted to upgrade the database for the second node.  

 

 

18. Once the second node has been upgraded, use the 3rd-party cluster administrator to bring the 
EFT Server resource back online. 

 

UPGRADING THE SOFTWARE 

Before upgrading, contact the Sales team to obtain a new registration serial number or to determine your 

eligibility for an upgrade. 

You can upgrade from: 

 EFT Server version 5.x to EFT Server Enterprise version 6 (EFT Server version 5.x is not upgradable to EFT 
Server basic version 6) 

 EFT Server basic version 6 to EFT Server Enterprise version 6 

 Secure FTP Server version 3 to EFT Server basic or Enterprise version 6 

 If you have purchased a license for Secure FTP Server - FIPS, you can upgrade for free to EFT Server (base) 
with the HS module 

 Upgrading from versions of EFT Server prior to version 5.x is not supported. 

 Upgrading from versions of Secure FTP Server prior to version 3.x is not supported. 

When the EFT Server service starts, it looks for a .cfg file. If the .cfg file is not found, corrupted, or not compatible, 

EFT Server creates a new .cfg file in the default location. If the .cfg file is corrupted or the wrong version, the bad 

.cfg file is backed up and an error is written to the Event log. 

If you are upgrading or updating the Server or any of its modules, use the upgrade procedure below. The upgrade 

or update process does not reset or otherwise affect the Server configuration or user settings. It is a good idea to 

read the Release Notes before you begin. 

 

Important Pre-Installation Information: 

 If you want to test or verify an update prior to introduction into your production environment, do not use 
your production serial number for testing purposes. 

 If you are adding a Server add-on module, you may receive a new activation serial number. If so, then it 
may be necessary to activate the software when you start it for the first time.  

 It is very important that the Secure Ad Hoc Transfer (SAT) module use the same version of the 
SFTPCOMInterface.dll used by the Server to which SAT is connecting. Upgrading the Server might require 
also updating the SFTPCOMInterface.dll for the SAT module. Refer to the Secure Ad Hoc Transfer help for 
details. 

 If you are upgrading in a clustered environment, refer to Upgrading the Server in a Cluster or contact 
GlobalSCAPE support  for assistance. 

 If you are moving a Server from one computer to another, contact the GlobalSCAPE customer service team 
or your account manager so that we can adjust your account on our activation and registration server. 
Activation on the new computer will not be possible until the adjustment is made. 

http://www.globalscape.com/eft/contactsales.aspx
http://www.globalscape.com/support/
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To upgrade the software 

1. Document the administrator user name and password for the existing product. If you are also upgrading 

the database files, you will need the ARM database name, username, and password. 

2. Close the Administrator interface and stop the EFT Server service and the DMZ Gateway service, if it is 

installed on the same computer as EFT Server. 

3. As a precaution, back up the existing installation directories and any other files you may have installed 

elsewhere. The default installation paths are C:\Program Files\GlobalSCAPE\Secure FTP Server\ and 

C:\Program Files\GlobalSCAPE\EFT Server\. 

4. Launch the installer. The installer will detect an existing installation of Secure FTP Server or EFT Server. 

 

5. Do one of the following:  

 Choose New installation if you want to create a new installation.  

 Choose Upgrade if you want to upgrade the existing configuration and copy your existing Sites, 

users, etc. to the new installation.  

6. Click Next.  

 If are upgrading Secure FTP Server, a confirmation prompt appears. Secure FTP Server must be 

uninstalled before installing EFT Server. Click Yes to proceed. After Secure FTP Server is removed, 

a prompt appears. Click OK. 

7. Click Next and follow the prompts in the wizard or refer to Installing the Server, Administrator, and 

Modules for the remainder of the installation. 

8. If the installer finds MSDE installed, you will be asked to upgrade the database to SQL Server Express, or 

point to a different database. 

9. When the wizard is finished, restart the Server services. The EFT Server service Log On as account will be 

set to Local System account by default. You can edit this in the service's Properties dialog box, on the Log 

on tab. (Start > Run > services.msc.) 
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If the Server and DMZ Gateway are both installed, both Server services should be restarted, even if only one 
Server is updated. 
 
If the Server and the Secure Ad Hoc Transfer module are installed on the same computer, then the upgrade 
process for the Server will also upgrade any files required by SAT. For example, the COM object is registered on 
the computer by the Server and used by SAT; however, the IIS service must be restarted so that ASP.NET (hosted 
by the aspnet_wp.exe process) will release any references to the existing COM object and reload the new one. 

You can do so in the Windows Services dialog box, or open a Windows command prompt and type iisreset.  

If you need additional information or help, visit GlobalSCAPE's Support Center at 

http://www.globalscape.com/support.  

 

MODIFYING OR REPAIRING THE INSTALLATION 

After you have installed EFT Server, you might later want to install other features, such as the Administrator 

interface or the Auditing and Reporting module. Or, if you accidentally deleted or edited necessary program files, 

you can repair the installation.  

To modify or repair the software 

1. Launch the installer. The installer will detect an existing installation of Secure FTP Server or EFT Server. 

 

2. Do one of the following: 

 To upgrade the existing installation, click Repair.  

 To install or uninstall specific components, click Modify. 

 To install a fresh installation, including a new configuration file, click New Install. 

3. Click Next and follow the instructions in the wizard. Refer to Installing the Server, Administrator, and 

Modules, if necessary. 

http://www.globalscape.com/support
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4. If you chose Modify, on the Components page, select the check boxes of components you want to install 

and clear the check boxes of components you want to remove. If you clear the check box of an installed 

component, it will be uninstalled! 

5. When the wizard is finished, restart the Server services. The EFT Server service Log On as account will be 

set to Local System account by default. You can edit this in the service's Properties dialog box, on the Log 

on tab. (Start > Run > services.msc.) 

If you need additional information or help, visit GlobalSCAPE's Support Center at 

http://www.globalscape.com/support. 

UNINSTALLING THE SOFTWARE 

Uninstalling EFT Server removes everything installed in the Program Files/GlobalSCAPE folder (but not that folder). 

It does not uninstall configuration files, Oracle or SQL Server tables, Reports, or Backup files in C:\Documents and 

Settings\All Users\Application Data\GlobalSCAPE\EFT Server Enterprise.  

To remove EFT Server 

1. Click Start > Programs > GlobalSCAPE > EFT Server (or EFT Server Enterprise) > Uninstall EFT Server (or 
EFT Server Enterprise). The Uninstall wizard appears. 

 

2. Click Uninstall. 

3. After the program files are removed, the Uninstallation Complete page appears. 

http://www.globalscape.com/support
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4. Click Close.  

 

Your license information remains in the Windows Registry, should you decided to reinstall. 

 

SETTING WINDOWS SYSTEM SERVICES 

The topics below provide the procedures for configuring EFT Server as a Windows service. 

ALLOWING THE EFT SERVER SERVICE ADMINISTRATIVE RIGHTS 

The EFT Server service must have full administrative rights to the folder in which you install EFT Server and to the 

location in which the users' home folders are stored. With administrative rights, the service can save all of your 

settings. If the service does not have administrative rights, you will lose settings and user accounts whenever you 

restart the EFT Server service, and you will need to reset permissions on the computer on which the Server service 

is running. After it is installed, EFT Server has access to local folders and files. To run the Server as a service with 

permissions to the network and mapped drives, you must create an NT account for EFT Server, assign the 

GlobalSCAPE EFT Server service to the account, and log EFT Server on as a service. Security policies should allow for 

user accounts to log in locally.  

 

If you are using AD Authentication, refer to Local Security Policy Setting when Using Active Directory 
Authentication for more information about configuring EFT Server on an AD network. Consult with your AD 
network administrator for assistance, if necessary. 

After you have installed EFT Server, created a Windows account for EFT Server, and assigned permissions to the 

account, you need to edit the service itself so that it will not run as a "System Account" (the default account 

choice). Running the service as System Account poses the potential hazard of giving users complete access to your 

system. 
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CREATING A WINDOWS USER ACCOUNT FOR EFT SERVER 

To create a user account in Windows XP Professional or Windows 2000 

1. After you install EFT Server, open the Computer Management console. (e.g., on the Desktop, right-click 

My Computer, then click Manage.) 

2. Expand the Local users and groups node, right-click Users, then click New User. The New User dialog box 

appears. 

 

 

3. Create the EFT Server user account (e.g., EFTUser), click Create, then click Close. 

4. Close the Computer Management console. 

5. In Administrative Tools, click Local Security Policy. The Local Security Settings dialog box appears. 

 

 

6. Expand the Local Policies node, then click User Rights Assignment. 
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7. In the right pane, in the Policy column, double-click Act as part of the operating system. The Properties 

dialog box appears.  

 
 

8. Click Add user or Group. The Select Users or Groups dialog box appears.  

 

 

9. Select the new user you just added (e.g., EFTServer), click Add, then click OK. 

10. If necessary, assign permissions for this user account in Windows. 

11. Assign EFT Server to the new user account and log EFT Server on as a service. 

SET WINDOWS NT PERMISSIONS FOR EFT SERVER 

After you have created a new Windows user account for EFT Server, use Windows' permissions to set the 

permissions for folders, files, or drives for the account. Permissions should be as restrictive as possible while still 

allowing EFT Server enough permissions to run.  
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Using Windows NT’s permissions, set the permissions for files or drives of this user to be as restrictive as possible, 

while still allowing EFT Server to run. After carefully determining which files and network folders your users will 

need to access, gradually increase the permissions. 

 

Using NT Authentication, user permissions override EFT Server's permissions. For example, if EFT Server has 
read-only access to folder1, but user John Doe has read and write permissions to folder1, John Doe has those 
same permissions when he accesses folder1 through EFT Server. 

Windows NT permissions can be edited through the Security tab in the Properties of a file or folder. On the 

Security tab, select Permissions to display and edit the permissions for the object. The appearance of this dialog 

box is slightly different for files and directories, but in both cases, the following permissions can be granted to 

users or groups:  

 R (Read) 

 W (Write) 

 D (Delete) 

 P (Edit permissions) 

 O (Take ownership)

Keep in mind that you have the option to grant or withhold read and write permissions. Read-only permissions are 

the most secure, because they allow users to access a file, but not to change it. For example, most users will need 

limited read access to the Windows folders (C, WinNT); however, most FTP Servers will not need any access to 

these directories at all.  

In addition to the individual permissions, Windows NT permissions also provide access levels that are simply pre-

built sets of the existing permissions. Typically, you assign an access level to a user rather than granting individual 

permissions. One such access level is called "No Access," which does not contain any permissions.  

T o view and edit the permissions for a folder or file 

1. In Windows Explorer, right-click the file or folder, then click Properties. 

2. On the Security tab, click Permissions. The appearance of this dialog box is slightly different for files and 

directories and for different versions of Windows (W2K, XP, etc.). 

For more information about setting permissions to folders and files, refer to the Windows Help documentation for 

your specific operating system. (e.g., click Start > Help and Support, then search on keyword permission.)  

ASSIGNING THE SERVICE TO A WINDOWS USER ACCOUNT 

To assign the service to a Windows user account 

1. Open the Windows Services dialog box.  

2. Right-click GlobalSCAPE EFTServer, then click Properties.   

3. Follow the Windows Operating System procedures for selecting an account under which the service will 

run. 

LOGGING EFT SERVER ON AS A SERVICE 

 

The log on as a service permission is granted automatically in Windows XP Professional, 2003, and 2000. 

Follow the instructions below based on your operating system, or refer to the Microsoft Help pages. (Click Start, 

then click Help and Support.)  



Installing and Activating the Software 

63 

Windows XP Professional, Windows 2003, and Windows 2000  

1. In Administrative Tools, click Local Security Policy. The Local Security Settings dialog box appears. 

2. In the left pane, expand the Local Policies node, then click User Rights Assignment. The Policy name and 

Security Setting appear in the right pane. 

 

 

3. In the right pane, double-click Log on as a service. The Log on as a service Properties dialog box appears. 

 

 

4. Click the user you want to add (e.g., EFTServer), then click OK. 

LOCAL SECURITY POLICY SETTING WHEN USING ACTIVE DIRECTORY AUTHENTICATION 

To use NT/AD authentication, users need "Log On Locally" access (allows a user to log on as if they were at the 

computer's keyboard) to the Server computer on which EFT Server is installed, no matter which kind of computer it 

is or what role it plays on the network, including a domain controller.  

GlobalSCAPE Customer Support recommends creating an AD account with adequate privileges to all of the 

resources (AD query, network shares) required for the site. There is no set formula for the type of account needed, 

because network configurations vary. Some EFT Server customers might pull users across multiple domains and 

might want to restrict that access. Consult with your AD network administrator for assistance, if necessary. 

WINDOWS NT PERMISSION RULES 

To secure your system, GlobalSCAPE recommends that you create a user account for EFT Server and grant 

restrictive permissions to that user account. When you are assigning permissions to individual folders or 
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directories in Windows NT, you may want to reference the following rules. These rules differ somewhat from the 

VFS rules that govern EFT Server permissions. 

The rules below determine the permissions that are ultimately granted to a user in Windows NT: 

1. Explicit denial: All users or groups assigned "No Access" have no access  

 

If the user or a group that the user is in has been assigned "No Access," that user is explicitly prohibited 

from using the file, folder, or drive. No other permissions will change this. 

2. Cumulative permissions: Permissions are combined when a user is not explicitly denied access 

 

If the user is not explicitly denied access, the user's permissions are combined. For example, if user Cal is 

given read and write permissions for Folder1, and Cal is also in a group that is given execute permissions 

for that folder, then Cal will be able to read, write, and execute files in Folder1. 

3. Implicit denial: A user or group that has never been granted any access at all will not be given access 

 

If the user or a group containing the user is not granted any permissions, that user or group will be denied 

access. Access must be specifically granted. 

REGISTRY SETTINGS 

EFT Server stores some of its configuration information in the Windows Registry. EFT Server modifies the system 

registry as needed, and continually references this information during operation.  

To view configurable registry keys, please visit the GlobalSCAPE Knowledge Base at http://kb.globalscape.com. 

 

RUNNING THE SERVER AND MICROSOFT IIS  
ON THE SAME COMPUTER 

By default, the FTP server in Microsoft IIS binds to port 21 on all IP addresses. If you are running IIS FTP server and 

EFT Server on the same computer, you must disable socket pooling for the IIS FTP server.  

To disable socket pooling in IIS FTP server  

In Microsoft IIS, stop the FTP site as described below:  

1. Open a command prompt.  

2. Change directory to C:\InetPub\Adminscripts:  

cd C:\InetPub\Adminscripts 

3. Type CSCRIPT ADSUTIL.VBS SET MSFTPSVC/DisableSocketPooling TRUE then press ENTER.  

You should get the following response: disablesocketpooling : (BOOLEAN) True  

4. Exit the command prompt and restart the FTP site. This should prevent IIS from binding to all IP addresses on 

port 21, freeing up an IP address on port 21 (the default FTP port).   

For more information on Microsoft IIS socket pooling, refer to the following articles:  

http://support.microsoft.com/default.aspx?scid=kb;en-us;259349   

http://support.microsoft.com/default.aspx?scid=kb;EN-US;238131   

http://kb.globalscape.com/
http://support.microsoft.com/default.aspx?scid=kb;en-us;259349
http://support.microsoft.com/default.aspx?scid=kb;EN-US;238131
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The articles linked above discuss the IIS Web server, but the same information applies to the IIS FTP server.  

"UNEXPECTED ERROR 0X8FFE2740 OCCURRED" MESSAGE  
WHEN YOU TRY TO START THE SERVER 

Microsoft IIS uses port 80 for HTTP communication. If you are running the IIS FTP server and EFT Server on the 

same computer, you can do either of the following: 

 In IIS Manager, change the port bindings for the Web site to a port other than port 80.  

 Stop the application that is using port 80, and then start the Web site from IIS Manager.  

For more information, refer to the Microsoft Knowledge Base article #816944. 

http://support.microsoft.com/kb/816944/en-us   

  

http://support.microsoft.com/kb/816944/en-us
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RUNNING A MICROSOFT .NET WEB APPLICATION IN 32-BIT MODE  
IN IIS 6.0 ON A 64-BIT SERVER 

First, you need to configure IIS to run 32-bit Web applications on 64-bit Windows, then you need to register the 

ASP.NET application, then restart the Web publishing service. 

To enable IIS 6.0 to run 32-bit Web applications on 64-bit Windows 

1. Open a command prompt and navigate to the %windir%\Inetpub\AdminScripts directory. 

2. Type the following:  

cscript.exe adsutil.vbs set W3SVC/AppPools/Enable32BitAppOnWin64 "true" 

3. Press ENTER. 

To register the ASP.NET application 

1. Open a command prompt and navigate to the directory that contains the ASP.NET executable. For 

example, type: 
 

cd WINDOWS\Microsoft.NET\Framework\v2.0.50727  

2. Type the following, then press ENTER: 
 

aspnet_regiis.exe -i  

For more information about the ASP.NET IIS Registration Tool (aspnet_regiis.exe), refer to 

http://msdn2.microsoft.com/en-us/library/k6h9cz8h(VS.80).aspx 

Start the World Wide Web Publishing Service 

1. Click Start > Run. The Run dialog box appears. 

2. Type services.msc, then press ENTER. The Services dialog box appears. 

3. In the list of services, right-click World Wide Web Publishing Service, then click Start (or Restart).  

ERROR IN ASP.NET REGISTRATION 

Microsoft .NET Framework 2.0 or greater is required for the AS2 module, Advanced Workflows Engine, and for the 

Secure Ad Hoc Transfer (SAT) module version 1.7.2 and earlier. SAT version 1.7.3 and later requires .NET 

Framework version 3.5. 

 If you do NOT have the .NET framework installed on your system, you can download and install it from the 

Microsoft Developer Network.  

 If you have the framework installed, but IIS still does not show any .NET-related information (such as the 

ASP.NET tab), run the ASP.NET IIS Registration Tool, found in the .NET installation folder (e.g., 

C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727 ). The file is called aspnet_regiis.exe and you must 

pass in a "-i" parameter. 

To run the ASP.NET Registration Tool 

1. At command prompt, change to the directory that contains the executable. For example, type 
 

cd WINDOWS\Microsoft.NET\Framework\v2.0.50727  

http://msdn2.microsoft.com/en-us/library/k6h9cz8h(VS.80).aspx
http://msdn2.microsoft.com/en-us/netframework/default.aspx
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2. Type the following, then press ENTER: 
 

aspnet_regiis.exe -i  

 

ASP.NET is installed and registered. 

For more information about the ASP.NET IIS Registration Tool (aspnet_regiis.exe), refer to 

http://msdn2.microsoft.com/en-us/library/k6h9cz8h(VS.80).aspx.  

EFT SERVER IN THE WINDOWS EVENT VIEWER 

Certain EFT Server events, such as service startup and failure, appear in the Windows Event Viewer 

Application Log. 

 

 Click the Source column header to group the GlobalSCAPE logs together. 

 The Category column displays the component, if applicable, that caused the log to be written. In the 

example above, ARM appears in the Category column. (ARM did not start because it was unable to 

connect to the database.)  
  

http://msdn2.microsoft.com/en-us/library/k6h9cz8h(VS.80).aspx
http://msdn2.microsoft.com/en-us/library/k6h9cz8h(VS.80).aspx
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RELEASE NOTES 

Release notes for the Server are available in the installation directory (by default, C:\Program 

Files\GlobalSCAPE\EFT Server\notes.txt). 

Version history for EFT Server is available online at http://www.globalscape.com/eft/history.aspx. 

Version history for Secure FTP Server is available online at http://www.globalscape.com/gsftps/history.aspx. 

http://www.globalscape.com/eft/history.aspx
http://www.globalscape.com/gsftps/history.aspx
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STEP 2: CONFIGURING EFT SERVER™ 

After you follow the procedures in Installing and Activating the Software, the next step is to log in to the Server via 

the Server interface, called the Administrator Interface, and configure the client connections to the Server. 

When you connect to the Server for the first time, you must configure it on the computer on which the Server 

service is installed. After you have created the local connection and enabled remote connections, you can connect 

to and administer the Server remotely. 

Anytime you connect to the GlobalSCAPE Server service, if no Servers have been defined, the Server Setup wizard 

Welcome page appears. The Server Setup wizard guides you through the Server configuration. The wizard helps 

you configure Server-specific options such as allowing remote administration. After the brief Server Setup wizard 

is completed, you have the option to run the Site Setup wizard to configure a Site, and then the User Setup wizard 

to configure a user.  

You may cancel out of the Server Setup wizard anytime by clicking Cancel or the X in the upper right corner; 

however, any settings made through the wizard are discarded, except for keys/certificates added to the key 

manager (by creating or importing). 

You will need the following information to create and configure a Server: 

 If you are allowing remote administration of the Server and you are using SSL, you need to know the SSL 

settings and have access to the SSL keys and certificates. 

 If you are restricting remote administration to specific IP addresses, you need to know the IP addresses 

and ports. 

 If you are using DMZ Gateway, install and configure DMZ Gateway before creating Servers and Sites. The 

installation and configuration of DMZ Gateway is not required before creating Servers and Sites, but the 

Site setup wizard asks for the DMZ Gateway information. You can configure DMZ Gateway after Site setup 

is complete, and then provide the DMZ Gateway connection information in the Administrator interface. 

To configure the Server 

1. Do one of the following:  

 After installation is complete, the New Administrator Connection wizard appears.  

 If you have already defined a Server and want to create another one, on the main menu click  

File > New Server. The New Administrator Connection wizard appears.  
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2. Do one of the following: 

 Because you must first configure the local connection, leave This computer selected, and specify 

the Label for the local connection. By default, the label is LocalHost. Because LocalHost is a 

very common label, it is a good idea to change the label to something that is easily identifiable in 

error logs, reports, and remote connections. For example, GS_EFTS. You can label the Server 

anything you want; the Server name is not dependent upon the computer name. 

 To connect to a remote EFT Server, first be sure that the remote Server service is running, and 

that it allows remote administration. Then: 

a. Click A remote computer. 

b. In the Label box, provide a name for the remote Server. 

c. In the Host address box, provide the IP address at which the remote Server allows 

connections. 

d. In the Port box, provide the port through which the remote Server allows connections. 

e. Click Next. The Administrator interface should connect to the remote Server and Server 

setup is complete. 

3. Click Next. The Server Setup wizard Welcome page appears.  

 If you are not restoring from a backup (available in version 6 only), click Next.  

 If you are restoring from a backup, click Restore from Backup, then refer to Backing Up or 

Restoring Server Configuration for the procedure. 
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4. Click Next. The FIPS Options page appears. 
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When you enable FIPS mode, the ciphers, keys, and hash lengths and types that are not FIPS approved are 

not available. If a FIPS-approved state cannot be achieved when FIPS is enabled, the Server service is 

stopped and an error is written to the Windows Event Log. 

 To use FIPS for SFTP (SSH2), select the Enable FIPS for SFTP check box. 

 To use FIPS for SSL, select the Enable FIPS for SSL check box. 

A confirmation prompt appears when you select either check box. When you enable FIPS, the EFT 

Server service must be restarted. Click OK to continue with FIPS enabled or click Cancel if you do 

not want to use FIPS and restart the Server service. 

5. Click Next. The Remote Administration page appears. 
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 If you do not want to allow remote administration, clear the check box. 

 If you want to allow remote administration, select the check box and specify the Listening port 

and Home IP address (or All Incoming). For security best practices and compliance with the PCI 

DSS, specify a port other than the default of 1100. 

6. Click Next. If you chose remote administration, the Secure Remote Administration page appears.  
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7. Administrator account credentials are transmitted in plaintext unless SSL is enabled. Organizations 

complying with the PCI DSS are required to use SSL for remote administration. To enable secure remote 

administration, select the Use SSL for secure remote administration check box, then click Next. The SSL 

Certificate Options page appears.  
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8. Do one of the following: 

 In the Certificate and Private Key boxes, click the open icon  to browse for the private key 

pair files.  

 Click Create certificate to create one. Refer to SSL Certificate-Based Login, Creating Certificates, 

Importing a Certificate into the Trusted Certificate Database, and Importing Certificates from 

Microsoft IIS 5 for information regarding certificates. 

9. Click Next. The Limit Remote Administrator IP Addresses page appears. 
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10. You should restrict remote administration to one or more known static IP addresses. You can configure 

this later and allow all IP addresses to connect for now. Otherwise, specify whether to Deny access to all 

remote IP addresses except for those you specify or Grant access to all remote IP addresses except for 

those you specify, then add the IP address exceptions to the list. 

a. Click GRANT access or DENY access, then click Add. The IP Mask dialog box appears. 

 

b. Specify the IP address or range of IP addresses to deny or grant access to the Site. You can use 

wildcards to select ranges of IP addresses. 

 If most IP addresses are allowed access, click granted, then list the exceptions. 

 If most IP addresses are denied access, click denied, then list the exceptions. 

 For example, if you click denied, then specify the range 200.200.100-200.*, all IP addresses are 

denied access, except those in the range 200.200.100.000 to 200.200.200.255. 
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c. Click OK to close the IP Mask dialog box. The IP address/mask appears in the Admin IP addresses 

filter box. 

11. Click Next. The Auditing and Reporting page appears. 

 

12. If you are using Auditing and Reporting, select the Enable auditing check box, then provide the 

information required to connect to the ARM database as described below. Otherwise, skip to the next 

step. (Auditing and reporting is a requirement of the PCI DSS.) 

a. In the Database type area, specify whether you are using SQL Server or Oracle for the auditing 

database. (Oracle available in EFT Server Enterprise only.) 

b. In the Host[\Instance Name] box, type the Server name or IP address. 

 

If you are using SQL Server as the Auditing Database, \InstanceName corresponds to SQL 
Server's notion of named instances, a feature that allows a given computer to run multiple 
instances of the SQL Server Database Service. For more information, please refer to 
http://msdn2.microsoft.com/en-us/library/ms165614.aspx. 

c. In the Username and Password boxes, type the username and password used to connect to the 

database (not the Server credentials). 

d. In the Database Name box, type the name of the database. 

e. In the Audit failure notification e-mail address box, type the e-mail address to which the Server is to 

send database connection error notifications. You can add as many e-mail addresses as needed; 

separate the addresses with a comma or semicolon. The Server uses its global SMTP e-mail settings 

from the SMTP Configuration to send the e-mails. You will configure those settings on the next page.  

http://msdn2.microsoft.com/en-us/library/ms165614.aspx
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f. In the In case of audit database error area, specify an action for the Server to take if there is an error 

with the database. To stop recording data, select Stop auditing. To continue recording data to a file, 

select Audit to folder, and specify the location for the log file. 

 

UNC paths are supported. The GlobalSCAPE Server service must run on a computer that has 
access to the network share, and the full UNC path must be used, that is: 
\\xcvd.forest.intranet.xc\Common_Files, not G:\Common. 

13. Click Next. The specify SMTP Server Settings page appears. 

 

14. In the From e-mail address box, specify the e-mail address for e-mail notifications (such as those triggered 

by Event Rules). This is the address that appears in the From box of e-mails sent by the Server. For 

example, type noreply@serverhost.com. 

15. In the SMTP host address boxes, specify the SMTP server host address and port.  

16. If the SMTP server requires authorization, select the check box and provide the Username and Password. 

17. Click Next. Server Setup is complete.  
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You are offered the option of continuing to the Site Setup wizard, or quitting the wizard, saving the Server 

settings, and configuring the Site(s) later. You must configure at least one Site to service inbound 

connections to the Server.  

18. Click an option, then click Finish. If you chose FIPS mode for SSL and/or SSH, prompts appear explaining 

that EFT Server has entered FIPS mode. Click OK to dismiss the prompts. 

19. If you chose Run the Site Setup wizard now, the Site Setup wizard Welcome page appears.  

20. Refer to Defining Connections to the Server for the procedure for configuring the Site. The procedure 

differs depending on the user authentication type you choose. 

BACKING UP OR RESTORING SERVER CONFIGURATION 

When migrating from a development, staging, or test computer to another computer, you cannot simply copy over 

the Server's configuration files to the new host. In EFT Server Enterprise edition,  you can use the Migration wizard 

to gather each of the necessary files, then package them into one easy-to-transport file. The Migration wizard can 

recreate the entire folder structure and settings automatically or you can run it in manual mode and verify every 

setting as you step through the wizard. 

 

The Migration wizard is not available in EFT Server basic edition. Refer to Copying Server Configuration 
to Several Computers to backup the Server configuration manually. 

The Migration wizard is an interactive tool designed to assist you in the following situations: 

 Performing Disaster Recovery. If the production Site is corrupted and configuration is lost, damaged, or 

destroyed, the wizard can assist you with restoring the Server to a prior working state. 
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 Migrating from staging to production or to new hardware. If you want to move the Server from a staging 

or development box to a production server or have set up a Server with one or more Sites on one 

computer and want to move it to another computer or a different network location, the wizard can assist 

you with gathering all the necessary files for a successful move.  

 

If you are migrating from a test environment to a production environment and do not need to 
keep the test environment's Server, Site, and user configuration settings, you do not need to 
use the Migration wizard. You can just start from scratch, and run the Server, Site, and User 
Setup wizards on the new system. 

 Backing up for disaster mitigation (routine backups, or backup prior to major changes). The wizard can 

backup all necessary configuration if the administrator needs a backup to always be readily available and 

requires automatic backup at least once a day. The Migration wizard can also help if a major change is 

about to be made, such as a new version installation or new hardware changes to the Server computer, 

and you need a mechanism to manually backup the current configuration. The Migration wizard can take 

a snapshot immediately before the major change takes place, in addition to the automatic daily backups. 

The migration fails if there is a mismatch/discrepancy in listening IP addresses, VFS root or structure, 

Authentication Manager settings, DMZ Gateway settings, or database connectivity. 

The Migration wizard backs up the entire Server configuration in an archive file at a path that is accessible to the 

Server service. The following items are backed up: 

 The configuration files 

 All certificates and keys that are pointed to from configuration file 

 Any custom reports 

 All registry overrides (for special settings) 

 The \WTC folder (to capture any Web Transfer Client customization)  

 Entire VFS structure (physical folders recreated only under site root, not those pointed to by virtual 

folders) 

 Any Advanced Workflows created 

The wizard can be initiated manually in the Administrator from the File menu or automatically in Event Rules. In 

EFT Server Enterprise, when you create your first Site, a Timer Rule is created that runs the Backup Server 

Configuration Action once a day at midnight, using all defaults for naming and backup location (\backup\Server 

Configuration Backup [Month] [Day] [Year].bak). The Rule includes a Cleanup Action to delete backup files (*.bak) 

older than 30 days in that same folder. The Backup Server Configuration Rule is enabled by default, but you can 

disable it and edit it as necessary. Refer to Backup Server Configuration Action for details of editing the Backup 

Server Configuration Rule. 

To manually back up Server configuration 

1. On the main menu, click File > Backup Server Configuration.  The standard Save As dialog box for your 

operating system appears. 

2. Specify the location in which to save the backup, then click Open. The configuration is saved and is named 

Server Configuration Backup [Month] [Day] [Year] with a .bak extension. 

3. A "backup successful" message appears. Click OK to dismiss the message.  

 If backup fails, a failure message appears. Restart the Server service, then run the backup again. 
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To restore Server configuration 

You can specify either Automatic Restore to prompt only when the wizard encounters discrepancies or problems 

with restoring, or Manual Restore, which allows you to verify and make changes to settings, as needed. Automatic 

Restore is the default setting. In automatic mode, you are not prompted to verify settings or allowed to change 

them. Review the Manual Restore procedure below for details of the settings that are verified during restore.  

1. Install and activate the product on the target system, if restoring to a different computer, and cancel the 

automatic setup wizard that appears the first time you run the Administrator. 

2. On the main menu, click File > Restore Server Configuration. The Migration Wizard appears. 

3. Click the Open icon  to specify the .bak file to use for restoring Server configuration. 

4. Click Next. The administrator login dialog box appears. 

 

5. Provide the administrator login credentials for the configuration being restored. The Restore Options 

page appears. 
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Automatic Restore 

a. Click Automatic Restore. The Recreate the entire folder structure check box is selected by default. 

Clear this check box if you do not want to recreate the VFS folder structure.  

b. Click Next. The Ready to Restore page appears. Read the information on the page, then click Restore.  

c. After the Server is restored, restart the Server and log in to the Administrator interface. A log appears 

describing the restore process, including file names and paths, and contains any errors encountered 

during restore.  

Manual Restore 

a. Click Manual Restore, then click Next. The Sites to Restore page appears. 

 

b. Select the check boxes of the Site(s) whose settings you want to import and clear the check boxes of 

the Site(s) whose settings you do not want to import, then click Next. The Site Listening IP Address 

Assignment page appears.  
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c. Review the IP address for each Site. If you are restoring a Site to a different IP address, click to edit 

the IP address in the New IP Address Assignment list, then click Next. The Site Authentication 

Manager Settings page appears. 
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d. The authentication database for each Site to be restored appears in the list. In the Settings column, 

click View/Modify if you want to view or change the path where EFT Server will store the user 

database. (You cannot change the type of authentication.)  

 If the Server cannot connect to the Site's authentication provider, an error message appears.  

 

 Click OK to continue as is or click Cancel to modify the authentication provider settings. 

e. Click Next. The Site Root Folder page appears. 

 

f. Review the root folder location for each Site that you are restoring. If necessary, click the open icon 

to specify a different location, then click Next. If the DMZ Gateway is defined and configured in the 

Server that you are restoring, the DMZ Gateway page appears. Otherwise, skip to step 13. 
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g. Review the IP address(es) and port(s) for the DMZ Gateway. Click to edit the IP address or port, if 

different.  

h. Click Next. The Server will test the DMZ Gateway connection and, if successful, the wizard proceeds 

to the next page.  

 If a failure occurs, the wizard displays a warning prompt indicating failure to connect to the DMZ 

Gateway and allowing you to either fix the problem (go back to the previous page to verify the IP 

address and port) or proceed anyway (if the IP address and port are correct, but the DMZ is not 

communicating). 

i. If the Auditing and Reporting module is defined and configured in the Server that you are restoring, 

the Auditing Database Connectivity page appears. Otherwise, skip to step 15. 
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j. Click Test to verify connectivity to Auditing and Reporting Module queue and, if successful, send an 

asynchronous test message to the database. If a connection to the database cannot be made within 5 

seconds, a warning prompt appears. (Verify that the database is available.) 

k. Click Next. Database connectivity is again verified and the Ready to Restore page appears.  
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l. Read the information on the page, then click Restore.  

m. After the restore is complete, restart the Server service. After you restart the Server service and log 

back in via the Administrator Interface, the restore log appears.  

 

n. View the log to review any errors encountered during restore. 
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LOGGING IN TO ADMINISTER EFT SERVER  

Before you can log in to the Server, you must follow the procedures in Server Setup Wizard to create and connect 

to the Server in the Administrator.  

When you open the Administrator, the EFT Server Administrator Login dialog box appears in which you can log in 

to the local or a remote the Server, or create a new remote connection.  

 To connect to the Server on the local computer, type the administrator username and password that you 

created when you installed the Server, then click Connect. 

 To connect to a remote computer, click A remote computer, click the list to select the remote computer, 

type the administrator username and password that you created when you installed the Server, then click 

Connect. (Before you can connect to a remote server, you must configure the Server to allow remote 

administration.) 

 To create a new remote connection, click A remote computer, click New, then refer to the procedure in 

Specifying a New Local or Remote Host. 

If the Administrator is already open and your session has timed out or you want to connect to another the Server 

that is already defined, do one of the following to open the Connect to the Server dialog box and log in: 

 Click the Server in the tree, then click the Connect icon . 

 Click the Server in the tree, click File > Connect to EFT Server. 

 Double-click the Server in the left pane. 

 Click the PLUS SIGN (+) next to the Server node in the tree. 

 

In the Connect to the Server dialog box, type the administrator username and password, then click Connect.  

 

If you encounter an error when trying to connect to the Server, make sure that the GlobalSCAPE Server service 
(cftpstes.exe) is running on the computer to which are trying to connect. 

 If the Trial reminder message appears, click Continue Trial or Activate Now. After you activate EFT Server, 

the Trial reminder no longer appears. 
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LOGGING OUT OF THE SERVER 

The Server incorporates an internal timeout that applies to connections to the Server via the Administrator. A 

warning message and countdown timer appear after 10 minutes of inactivity.  

If you want to log out manually, click the Server, then click the Disconnect icon , or simply close the 

Administrator. (No confirmation message appears.) 

 

If you click File > Close Server Engine, you will stop the GlobalSCAPE Server service and no clients will be able 
to connect to the Server. 

EFT SERVER INTERFACE 

The Administrator Interface is the graphical user interface to the Server. After you install one or more Servers, 

configure clustering services, if used, and configure the Server to run as a Windows service, you then configure the 

connection to the Server in the Administrator. The Server is configured by default to run when the operating 

system boots up. The Administrator Interface is used to connect to the Server and create Server Groups, Servers, 

and Sites, manage user accounts and permissions, set security protocols and commands, configure Event Rules, 

and run reports.  

The Administrator Interface can connect to the Server on either a local or remote computer. You can install the 

Administrator Interface on as many computers as you like, but the Server may only be installed on computers with 

valid Server software licenses. 

To open the Administrator Interface 

 Click the Server shortcut on the Start menu or desktop  (cftpsai.exe).  
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 The left pane of the Administrator displays the Server tab by default. The Server tab provides a tree view 

of the Administrator components that are used to connect to and communicate with the Server (Server 

Groups, Servers, Sites, Settings Templates, Users, Permission Groups, Commands, Event Rules, and 

Gateway). The Report tab, Status tab, and VFS tab provide other views. Click the tabs in the illustration 

above or the links in Related Topics, below, for more information about each tab. 

 The right pane of the Administrator provides tabs that contain the configuration options for the item 

selected in the left pane. For example, when you select a Server in the left pane, the right pane contains 

the configuration options for that Server. 
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SERVER TAB 

The topics below describe the Server tab of the EFT Serve administrator interface. 

The Server employs an inheritance hierarchy to manage its Server, Site, and user settings, and Group permissions. 

The Administrator displays this hierarchy as a navigation tree in the left pane on the Server tab. 

The tree displays each of the Server components that you configure in the Administrator. When you click an item 

in the tree, the available tabs in the right pane change based on your selection. For example, when you click a 

Server (e.g., Local Server) on the Server tab in the left pane, the tabs appear in the right pane for configuring that 

Server. When you click a user on the Server tab in the left pane, the tabs appear in the right pane for configuring 

that user. 

You can create new items and manage items in the tree by right-clicking the tree, or clicking Configuration on the 

main menu. 

 

Server Group is the topmost level and is an organizational function for multiple groups of Servers; you can add 

additional Server Groups. (Do not confuse with Permission Groups, below.) 

Server represents one or more physical file transfer servers (Server engine) running on the local computer or a 

remote system. Refer to Server Setup Wizard for more information. 

Site is similar to a virtual FTP server bound to one or more IP addresses. Multiple Sites (or hosts) are allowed 

within each Server. Configuration of Site-wide settings can be inherited at lower levels (in the Settings Template or 

per user). Each Site contains its own Settings Templates, Users, Groups, Commands, and Event Rules. Refer to 

Configuring Sites for more information. 
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User Settings Templates allow you to apply a setting configuration to an entire group of users. Similar to templates 

or profiles, Settings Templates are a powerful way of organizing users into groupings with predefined settings. The 

Settings Template specified as the default appears in the tree with bolded text. 

Users are individual clients assigned to a Settings Template. Each user can be configured to inherit settings from 

the Settings Template or have specific settings defined for that particular user.  

Groups allow you to define user access permissions to files and folders. Groups are assigned at the Site level. 

Users' access to folders and files are defined by their assigned Group's permissions.  

Commands allow you to configure the Server to run executables, batch files, and scripts automatically when 

specific events occur. You add these commands to Event Rules. 

Advanced Workflows allow you to design frequently used scripts, batch files, macros, or any other code-intensive 

process using an easy drag-and-drop interface and then drop them into an Event Rule. 

Event Rules consist of triggering Events, any optional Conditions affecting the Event Rule, and the resulting 

Actions that are carried out. For details, refer to Introduction to Event Rules. 

Gateway allows you to configure the IP address, port, and protocols used to communicate with the DMZ Gateway. 

GENERAL TAB OF THE SERVER 

The General tab of the Server node displays the Server statistics and is used to specify defaults that are inherited 

by all Sites, Settings Templates, and users, such as the default path for configuration settings, default directory 

listing date stamp setting (local server time or UTC/GMT time), e-mail template, password expiration message, and 

user database refresh interval. You can also stop the Server service on this tab. 
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ADMINISTRATION TAB OF THE SERVER 

The Administration tab of the Server node is used to configure remote connections to the Server, including the 

Administrator interface's IP address and port, SSL certificates, and granting/denying access by IP address, and 

adding, modifying, and removing Server administrator accounts. 

 

 To view the properties of an administrator account, in the Administrator Account Names area, click the 

account.  

 To create a new account, click Add. 

 To manually delete an account, click the account, then click Remove. 

 To automatically remove an account, refer to Removing Inactive Administrator Accounts. 

 To change the password of an account, click the account, then click Modify. 

 To change the password settings, refer to Enforcing Complex Passwords for Administrator Accounts, 

Enforcing Password Reset for Administrator Accounts, and Expiring Administrator Passwords. 

 To lockout an account, refer to Locking Out an Administrator Account after Repeated Incorrect Logins. 
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SECURITY TAB OF THE SERVER 

The Security tab of the Server node is used to specify SSL versions and allowed ciphers for the Server's Sites, and to 

enable FIPS for SSL and/or SSH. 
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LOGS TAB OF THE SERVER 

The Logs tab of the Server node is used to configure the type and location for the Server logs and Auditing and 

Reporting settings. 
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SMTP TAB OF THE SERVER 

The SMTP tab of the Server node is used to specify the SMTP settings that the Server is to use to send e-mail 

notifications. When you create the Server in the Server Setup Wizard, the SMTP Server settings on this tab are 

automatically populated.  

 

If you add names and e-mail addresses to the address book, they are automatically added to e-mail notifications in 

Event Rules. The name and address in the first row appear in the To box of the Edit Mail Template dialog box; 

names and addresses in the other rows are added to the CC box of the Edit Mail Template dialog box.  
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REPORT TAB OF THE ADMINISTRATOR 

The Report tab of the Administrator is the interface to the Auditing and Reporting module (ARM). The Reports tree 

in the left pane lists the predefined GlobalSCAPE Reports and your custom reports. When you select a report in the 

left pane, the right pane updates for you to specify filters and a date range and generate the report. 
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VFS TAB OF THE ADMINISTRATOR 

The VFS tab of the Administrator is the interface to the Server's Virtual File System (VFS), used to grant access to 

files and folders on your system. 

 

The left pane displays the physical folders for the Site and any virtual folders that you have defined. In the right 

pane, you add and remove users and groups and set their permissions. (The default Groups are displayed 

automatically.) The bottom toolbar provides options to create a new virtual or physical folder, and to remove a 

selected folder. 
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STATUS TAB OF THE ADMINISTRATOR 

The Status tab contains nodes for each Server Group, Server, Site, AS2 transactions, and each logged-in user 

account. If you expand the Site node, you can view connection status for the Site, users, and for AS2 transactions. 

The Site node on the Status tab of the Administrator is used to view the status of the Site and logged-in users, such 

as when the Server was started, number of users connected, and so on. You can also forcibly disconnect FTP/SFTP 

users from the Site on this tab. 
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The AS2 Transactions node is used to view the status of attempted AS2 transactions. For details of viewing AS2 

transaction history, refer to AS2 Transaction Auditing and Monitoring. 

 

MAIN MENU AND TOOLBAR 

The main menu and toolbar of the Administrator provide options for configuring and managing Sites, Settings 

Templates, Groups, Commands, Folders, Certificates, and Reports.  

 

Below is a description of each of the main menu options and toolbar icons.  

Menu 
Option 

Sub Menu 
Option 

Tool
bar 
Icon 

Shortcut 
Key 

Description 

File Connect to 
the Server 

 

ALT+F+C Opens the Connect to the Server dialog box in 
which you can log in to the selected the Server. 

 Disconnect 
from the 
Server 

 

ALT+F+D 

 

Disconnects from the Server, but leaves the 
Administrator open. 

 Start Server 
Service 

- ALT+F+I 

 

Starts the EFT Server service. 

 Stop Server 
Service 

- ALT+F+P Stops the EFT Server service. 
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Menu 
Option 

Sub Menu 
Option 

Tool
bar 
Icon 

Shortcut 
Key 

Description 

 Backup Server 
Configuration 

- - Opens a Save As dialog box in which you can 
specify a location to save a *.bak file of the 
current Server configuration. The file name 
defaults to Server Configuration Backup 
<MM/DD/YYYY>.bak in the EFT Server 
installation directory. 

 Restore Server 
Configuration 

- ALT+F+F 

 

Opens the EFT Server Migration Wizard in 
which you specify the *.bak file to restore the 
Server configuration. 

 Start All Sites 
 

ALT+F+A Starts all Sites on a selected Server. Only 
available if one or more Sites are stopped. 

 Stop All Sites 
 

ALT+F+L Stops all Sites on a selected Server. Only 
available if one or more Sites are running. 

 Start Site  ALT+F+T Starts the selected Site. Only available if the 
Site is stopped. 

 Stop Site  ALT+F+O Stops the selected Site. Only available if the 
Site is running. 

 New User 
 

CTRL+U Opens the New User Creation wizard in which 
you can define a new user. 

 New Site - CTRL+N Opens the Site Setup wizard in which you can 
define a new Site. The first page of the wizard 
provides the option of creating a standard Site 
or a HS-enabled Site. 

 New Server - ALT+F+S Opens the New Administrator Connection 
wizard in which you can create a new Server. 

 New Server 
Group 

 ALT+F+G 

 

Opens the Create New Group dialog box in 
which you can define a new Server Group. 

 Kick Selected 
User 

- ALT+F+K Forcibly logs off a selected user. 

 Remove User - 

 
ALT+F+U 

Deletes selected user. 

 Remove Site - ALT+F+R Deletes selected Site. 

 Remove 
Server 

 ALT+F+V Opens a confirmation dialog box asking if you 
want to remove the selected Server. Also 
available when right-clicking a Server. 

 Remove 
Server Group 

- ALT+F+M 

 

Removes selected Server Group; only available 
if you have more than one Server Group 
defined. (WARNING: No confirmation message 
appears!) Also available when right-clicking a 
Server. 



EFT Server™ version 6 

102  

Menu 
Option 

Sub Menu 
Option 

Tool
bar 
Icon 

Shortcut 
Key 

Description 

 Exit 
Administrator 

- ALT+F+E Closes the Administrator. (No confirmation 
appears.) 

Edit Cut - ALT+E+T Deletes selected text and copies it to the 
Clipboard. 

 Copy - ALT+E+C Copies selected text to the Clipboard. 

 Paste - ALT+E+P Pastes text from the Clipboard to a selected 
editable text area in the Administrator. 

 Server Service 
Settings 

- ALT+E+S Opens the Server Service Settings dialog box, 
in which you can view the status of, start, and 
stop the Server service or connect to a 
remote the Server service. 

 Global 
Settings 

- ALT+E+G or 
ALT+F7 

Opens the Server Global Settings dialog box in 
which you can specify prompts and change 
your administrator password. 

View Toolbar - ALT+V+T Displays or hides the toolbar. 

 Status Bar - ALT+V+S Displays or hides the Status bar on the bottom 
of the Administrator. 

 Refresh User 
Database 

 ALT+V+D Connects to the user database and updates the 
Server. For more details, refer to Configuring 
the Server to Automatically Update the 
Authentication Database and Changing the 
User Database Refresh Rate for a Site. 

 Refresh 
 

ALT+V+H 

(or F5) 

Refreshes the display to the last saved state.  

Configuration New User 
 

ALT+C+U 

(or CTRL+U) 

Opens the New User Creation wizard in which 
you can define a new user. 

 New Site - ALT+C+I 

(or CTRL+N) 

Opens the Site Setup wizard in which you can 
define a new Site. The first page of the wizard 
provides the option of creating a standard Site 
or a HS-enabled Site. 

 New Server  ALT+C+S Opens the New Administrator Connection 
wizard in which you can create a new Server. 

 New Settings 
Template 

 

ALT+C+L 

(or CTRL+L) 

Opens the Create New Settings 
Template dialog box in which you can define a 
new Settings Template. 

 New 
Permission 
Group 

 

ALT+C+G 

(or CTRL+G) 

Opens the Create New Group dialog box in 
which can define a new Permission Group. 

 New Server 
Group 

 ALT+C+O Opens the Create New Group dialog box in 
which you can define a new Server Group. 
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Menu 
Option 

Sub Menu 
Option 

Tool
bar 
Icon 

Shortcut 
Key 

Description 

 New 
Command  

 

ALT+C+C 

(or CTRL+M) 

Opens the Custom Command wizard in which 
you can create a custom Command for use in 
Event Rules. 

 New Event 
Rule 

- ALT+C+R Opens the Create New Event Rule dialog box in 
which you can select an event trigger. 

 New Virtual 
Folder 

 

ALT+C+V Opens the Create Folder dialog box in which 
you can provide a name for and create a new 
virtual folder. 

 New Physical 
Folder 

 

ALT+C+W Opens the Create Folder dialog box in which 
you can provide a name for and create a new 
physical folder. 

 Reset 
Subfolders 

- ALT+C+S Available only on the VFS tab, used to reset all 
subfolders of a particular parent folder to 
inherit permissions from that parent. 

 Rename 
Selected 

- ALT+C+M 

(or F2) 

Enables a selected object for renaming. 

 Delete 
Selected 

 

 

ALT+C+D 

(or Delete) 

A confirmation message appears asking if you 
want to delete the selected object.  

 Set Settings 
Template 

 

ALT+C+T Assigns the selected user to a Settings 
Template. 

 Apply Changes 
 

ALT+C+A 

(or F9) 

Updates the Server with any changes. (Same as 
clicking Apply.) 

 Undo Last 
Changes 

 ALT+C+U Reverts to the last applied change. 

Tools Create SSL 
Certificate 

 

ALT+T+C Opens the Create SSL Certificate wizard in 
which you can create a self-signed certificate, 
private key, and certificate request file (.csr). 

 Sign SSL 
Certificate 

 

ALT+T+S Opens the Certificate Signing Utility in which 
you can sign a client's certificate request file 
(.csr). 

 Manage SSL 
Certificates 

 

ALT+T+M Opens the Certificate Manager in which you 
can manage trusted and pending certificates. 

 Create SSH2 
Keys 

- ALT+T+H Opens the SSH2 Public/Private Key pair 
wizard, in which you can create a server or 
client key pair. 

 Manage SSH2 
Keys 

 

ALT+T+K Opens the SSH Key Manager in which you can 
view, rename, create, import, and delete SSH 
Keys. 
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Menu 
Option 

Sub Menu 
Option 

Tool
bar 
Icon 

Shortcut 
Key 

Description 

 Create 
OpenPGP Keys 

- ALT+T+G Opens the OpenPGP Key Generation wizard in 
which you can create the public and private 
keyring pair. 

 Manage 
OpenPGP Keys 

 

ALT+T+Y Opens the Open PGP Keyring manager in which 
you can view, create, import, export, and 
delete OpenPGP Keyrings. 

 OpenPGP 
Keyring 
Settings 

- ALT+T+P Opens the OpenPGP Settings dialog box in 
which you can browse for a select the public 
and private keyring file paths. 

Reports 

 

New Report 
 

ALT+R+N Opens the Create New Report dialog box in 
which you provide a name for the new report. 
After you click OK, the VSReport Designer 
appears in which you can define the new 
report. 

 Edit Report 
 

ALT+R+E Opens the selected report in the VSReport 
designer for you to edit it. 

 Delete Report - ALT+R+D Displays a confirmation message asking you to 
confirm (Yes/No) whether you want to 
delete the selected report. 

 Save Report - - Opens the Save As dialog box in which you can 
name the report and specify where to save it. 
The default location is C:\Program 
Files\GlobalSCAPE\EFT Server. 

 Import Report - 

 

ALT+R+I Opens the Open dialog box in which you can 
browse for a report to import.  

 Export Report - ALT+R+X Opens the Save As dialog box in which you can 
name the report and specify where to save it. 
The default location is C:\Program 
Files\GlobalSCAPE\EFT\Reports. For details of 
exporting reports, refer to Exporting a Report 
in XML Format and Exporting and Publishing a 
Report in the Report Designer. 

 Run PCI DSS 
Compliance 
Report 

- ALT+R+R Generates the Compliance Report in HTML 
format 

Windows Report  - ALT+W+R 

(or ALT+1) 

Opens the Report tab. 

 Status - ALT+W+S 

(or ALT+2) 

Opens the Status tab. 

 VFS - ALT+W+V 

(or ALT+3) 

Opens the VFS tab. 
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Menu 
Option 

Sub Menu 
Option 

Tool
bar 
Icon 

Shortcut 
Key 

Description 

 Server - ALT+W+E 

(or ALT+4) 

Opens the Server tab. 

Help Help Contents - ALT+H+C Opens this Help file. 

 Online 
Knowledge 
Base 

- ALT+H+K Opens the GlobalSCAPE Knowledge Base, 
http://kb.globalscape.com/. 

 Online 
Support 

- ALT+H+S Opens the GlobalSCAPE Help Center Web page, 
http://www.globalscape.com/company/contac
t.aspx. 

 Provide 
Feedback 

- ALT+H+P Opens the GlobalSCAPE Customer Support 
Contact Us page, 
http://www.globalscape.com/company/contac
t.aspx. 

 Activate EFT 
Server  

- ALT+H+S Opens the EFT Server Registration Wizard. 

 Activate Web 
Transfer Client 

- ALT+H+W Opens the EFT Server Registration Wizard. 

 Activate High 
Security 
Module 

 ALT+H+I Opens the EFT Server Registration Wizard. 

 Activate 
Auditing and 
Reporting 
Module 

 ALT+H+D Opens the EFT Server Registration Wizard. 

 Activate 
OpenPGP 
Module 

 ALT+H+O Opens the EFT Server Registration Wizard. 

 Activate AS2 
Module 

- ALT+H+M Opens the EFT Server Registration Wizard. 

 About EFT 
Server 

- ALT+H+A Opens the About dialog box. 

 

KEYBOARD SHORTCUTS 

You can use the common Windows keyboard shortcuts in the Administrator (e.g., CTRL+C to copy, CTRL+V to 

paste, ALT+underlined letter in menu to open the menu). Microsoft Knowledge Base article #126449, 

http://support.microsoft.com/kb/126449, describes each of the keyboard shortcuts that are available in Windows.  

In addition to the standard Windows keyboard shortcuts, the following keyboard shortcuts are available in the 

Administrator: 

http://kb.globalscape.com/
http://www.globalscape.com/company/contact.aspx
http://www.globalscape.com/company/contact.aspx
http://www.globalscape.com/company/contact.aspx
http://www.globalscape.com/company/contact.aspx
http://support.microsoft.com/kb/126449
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Action Key or Key Combination 

Open the Server Global Settings dialog box ALT+F7  

Refresh F5 

Rename a selected object F2 

Create a new Site CTRL+N 

Create a new user CTRL+U 

Create a new Settings Template CTRL+G 

Create a new command CTRL+M 

Delete DEL 

Apply changes to the Server F9 

Open the Report tab ALT+1 

Open the Status tab ALT+2 

Open the VFS tab ALT+3 

Open the Server tab ALT+4 

Expand the File menu ALT+F 

Expand the Edit menu ALT+E 

Expand the View menu ALT+V 

Expand the Configuration menu ALT+C 

Expand the Tools menu ALT+T 

Expand the Reports menu ALT+R 

Expand the Window menu ALT+W 

Expand the Help menu ALT+H 

Close the Administrator ALT+F4, ALT+X 

As in any Windows-compatible application, a button or menu text with an underlined letter has a shortcut key 

associated with that letter.  

For more shortcuts, refer to Main Menu and Toolbar. 

 

STATUS BAR 

The Status bar is displayed across the bottom of the Administrator to indicate whether you are connected to the 

Server, the date and time the Server started, and how many clients (users) are connected to the Server.  

 

"Ready" appears in the lower left area of the Status bar when the application is idle (i.e., no Windows messages 

are being processed at the time). If the Administrator is busy processing information, the "Ready" area of the 

Status bar can be blank. 
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THE ADMINISTRATOR SESSION TIMEOUT 

The Server incorporates an internal timeout that applies to the Administrator connections to the Server. A warning 

message and countdown timer appear after 10 minutes of inactivity.  

 

The timer resets if you click Cancel; otherwise, if no activity occurs, the timer expires, and the Administrator 

disconnects from the Server. Any non-committed changes are discarded. 

 

This is separate from the Enable Timeout value set at the user and Settings Template. 

CONFIGURING LOGIN OR EXIT PROMPTS 

In the Server Global Settings dialog box, you can specify whether you are prompted when you log in to the 

Administrator and/or on exit, and can change your administrator password. 

 If you clear the Don't show this prompt again check box, the prompt will appear again the next time 

someone closes the Administrator. If you leave it selected, it has the same effect as clearing the Prompt 

on administrator exit check box in the Server Global Settings dialog box. (That is, no prompt appears on 

exit.) 

To configure login or exit prompts 

1. On the main menu, click Edit > Global Settings. The Server Global Settings dialog box appears. 

 

2. The Prompt for administrator interface login and password check box is selected by default. Clear the 

check box if you do not want to be prompted for login credentials when the Administrator is opened. 

3. To change the administrator password, click Change Administrator Password. The Create/Edit 

Administrator Account dialog box appears. 

 

 Type or Generate and confirm a new password, then click OK. 
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4. The Prompt on administrator exit is cleared by default. Select the check box if you want a message to 

appear when you close the Administrator to remind you that closing the interface does not stop the 

Server service. 

CLOSING THE ADMINISTRATOR 

The Administrator interface will automatically close your connection after 10 minutes of inactivity, but the Server 

service continues to run in the background. A warning message and countdown timer appear when the connection 

times out.  

When you manually close the Administrator interface, the Exit Administrator confirmation prompt appears. You 

can turn this prompt off for future exits from within the prompt or in the Server Global Settings dialog box. 

To close the Administrator 

1. Do one of the following: 

 In the upper right corner of the Administrator, click the X. 

 On the main menu, click File > Exit Administrator. 

The Exit Administrator dialog box appears. 

 

2. If you do not want the Exit Administrator dialog box to appear when you close the interface, select the 

Don't show this prompt again check box; otherwise, leave it selected. 

3. Click OK. The Administrator interface closes. 

4. To turn the prompt back on, refer to Configuring Login or Exit Prompts. 

VIEWING SERVER STATISTICS 

In the Administrator, you can view the status of the Server in real time, such as number of users connected, 

average speed, and so on.  

To monitor current statistics on the Server  

1. In the Administrator, connect to the Server and click the Server tab.  

2. In the left pane, click the Server node. 

3. In the right pane, click the General tab. The Server's statistics appear in the right pane.  
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 Server status: Displays "Service is started" or "Service is stopped". You can also stop and start the 

Server service on this tab. 

 Start date/time: Displays the date and time that the Server service was last started. 

 Uptime: Displays the length of time that the Server service has been running since it was last 

started. 

 Last modified time: Displays the date and time that the Server was last modified. 

 Last modified by: Displays the username of the user who last modified the Server. 

 Users connected: Displays the number of users who are currently logged in to the Server. 

 Active uploads: Displays the number of uploads in progress. 

 Active downloads: Displays the number downloads in progress. 

 Average speed: Displays the average transfer speed. 

STARTING AND STOPPING THE SERVER 

The Server starts automatically and runs as a Windows system service. If you close the Administrator, the Server 

continues to run in the background as a system service. 

For the procedure for a remote Server, refer to Starting and Stopping the Server Remotely. 
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To stop the Server in the Administrator 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server that you want to start/stop. 

3. In the right pane, click the General tab. 

 

4. Click Stop service, then click Apply. 

5. The Server status indicator turns from green to red. 

To start or stop the Server using the Windows Services dialog box 

1. Click Start > Run. The Run dialog box appears. 

2. In the Open box, type services.msc then press ENTER. The Windows Services dialog box appears. 

3. Right-click the EFT Server service and click Start (or Stop). 

4. Close the Services dialog box. 

To start or stop the Server from the command line 

1. Click Start > Run. The Run dialog box appears. 

2. In the Open box, type cmd or command then pres ENTER. The Windows Command Prompt dialog box 

appears. 
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3. To start the Server, at the prompt type the following command (include the quotation marks): 

Net start "globalscape eft Server"  

5. To stop the Server, at the prompt type the following command (include the quotation marks): 

Net stop "globalscape eft server" 

6. After the service is started or stopped, type Exit (or close the Command Prompt). 

 

 

Any time you run a server, you expose your computer to outside users. The potential exists for exposing files 
and programs on your computer and network to malicious outside users, particularly if the Server is 
compromised.  

Although you can set folder permissions from within the Server Administrator, you can add an extra level of 
protection by establishing a user account for the Server and then limiting folder access through the Server's 
user account permissions. This establishes a stopgap until server/system integrity can be restored if the 
Server is ever compromised. 

To configure the Server to run securely, you should: 

1. Create a user account for the Server  

2. Assign permissions to the Server's user account  

3. Assign the Server to the account 

4. Log the Server on as a service 

5. If necessary, configure the Server's user account to map a virtual folder to a network drive. 

STARTING AND STOPPING THE SERVER REMOTELY 

If you are logged in to the Server from a remote the Administrator, your user name and password are passed on to 

the Windows System Services on the computer running the Server. The account you log on with must have 

administrative rights on that computer to make any changes to the GlobalSCAPE the Server service running on it. 

To start or stop the Server remotely 

1. In the Administrator, click Edit > Server Service Settings. The Server Service Settings dialog box appears.  
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2. In the Connection area, select Administer remote machine. 

3. In the text box, type or paste the IP address of the server you want to administer. 

4. Click Connect to Service Manager. 

5. Click Start service (or Stop service) and close the Server Service Settings dialog box. 

SPECIFYING DEFAULT PATHS 

The Server allows you to change the default the location of some of its configuration files. 

 You can specify the default location for EFT Server's configuration files. Any changes to the file path take 

effect the next time the Server service is started. You should ensure the configuration file exists in the 

new location prior to restarting the service. 

 The default paths for all user- and Server-generated files rely on Windows-recommend paths. 

To specify the file path for configuration files 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server that you want to start/stop. 

3. In the right pane, click the General tab. 

 

4. Under Server configuration settings, provide the file path at which you want to store the Server's 

configuration files. The default path is C:\Documents and Settings\All Users\Application 

Data\Globalscape\EFT Server or \EFT Server Enterprise. 
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5. Click Apply to save the changes on the Server. A message appears indicating that you need to restart the 

Server service for the changes to take effect.  

6. Click OK to dismiss the message, then Restart the Server service. 

SPECIFYING THE DEFAULT TIME STAMP 

You can specify the default time stamp for directory listings to be the local Server time or UTC (Coordinated 

Universal Time)/GMT (Greenwich Mean Time). 

To specify the default time stamp 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server that you want to manage. 

3. In the right pane, click the General tab. 

 

4.  In the Directory listing date stamp settings area, click one of the following: 

 Use local server time 

 Use UTC/GMT time 

5. Click Apply to save the changes on the Server. 
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EDITING THE PASSWORD RESET MESSAGES 

The High Security module provides the option to expire passwords for users. If you do not activate the HS module, 

this feature is disabled after the 30-day trial expires. (Password expiration for administrator accounts is a core 

feature of the Server.)  

The Server allows you to set a reminder to notify users of their pending password expiration up to 30 days prior to 

the password expiration date. You can configure reminder options at the Site level, in the Settings Template, and 

per user, from 0 (no reminder) to 30 days (5 is the default) before expiration. The reminder can be in the form of a 

banner message, e-mail, or both. 

The Server will send an e-mail informing the user of the pending expiration and provides instructions on how to 

change the password for one or possibly all protocols if all of the following are true:  

 the user's password is scheduled to expire 

 the e-mail reminder is enabled 

 the user account has an e-mail addresses associated with it  

A user who typically connects over FTP can login via HTTP/S to change the password.  

The e-mail reminder message contains an editable text file stored in the Server directory, and accepts the Server 

variables (e.g., %days_left%), such as those shown in Event Rules. You can edit the text of the e-mails as 

described in the procedures below, and applies to all Sites, Settings Templates, and user accounts. 

To edit the password reset reminder  

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server node. 

3. In the right pane, click the General tab. 
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4. Next to Password reset reminder message, click the browse icon . Your default text editor, usually 

Notepad, opens with the reminder text. 

 

5. Edit the text as needed, being careful not to delete the variables (%FULL_NAME%, %USERNAME%, 
%DAYS_LEFT%,  

%RESET_PAGE%), then save the file and close the text editor. 

6. Click Apply to save the changes on the Server. 
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To edit the password reset reminder  

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server node. 

3. In the right pane, click the General tab. 

4. Next to Password reset required message, click the browse icon . Your default text editor, usually 

Notepad, opens with the reminder text. 

 

5. Edit the text as needed, being careful not to delete the variables (%FULL_NAME%, %USERNAME%, 

%RESET_PAGE%), then save the file and close the text editor. 

6. Click Apply to save the changes on the Server. 

EDITING THE USER LOGIN CREDENTIALS MESSAGE 

When you create a user, you have the option of sending the user an e-mail that contains the login credentials for 

connecting to EFT Server. You can configure the text of the e-mail at the Server to apply to all users. 

To edit the password reset reminder  

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server node. 

3. In the right pane, click the General tab. 
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4. Next to User login credentials message, click the browse icon . Your default text editor, usually 

Notepad, opens with the reminder text. 

 

5. Edit the text as needed, being careful not to delete the variables (%USER.FULL_NAME%, 

%USER.LOGIN%, %USER.PASSWORD%), then save the file and close the text editor. 

6. Click Apply to save the changes on the Server. 
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CONNECTION PROBLEMS 

If you are having problems connecting to the Server, verify the following information:  

 Your username and password are correct. Each is case sensitive. 

 The Host (the IP address) and port are correct. Refer to Remote Administration. 

 The IP address from which you are trying to connect is allowed to access the Server.  

 The Server service is running. Refer to Starting and Stopping the Server. 

 The network connection is functioning.  

 

If the Server service is not running, you may be able to start the service remotely. 

When files are being transferred with Event Rules (copy, move, or download), if there are connection problems 

(e.g., the network is unavailable), the Server will attempt to establish a connection the number of times specified 

in the Event Rule. When the Server is able to re-establish the connection, it continues to transfer the file from 

where it stopped, even if there are multiple interruptions. There are no retry attempts after a login failure.   

If the network is lost while the Web Transfer Client is transferring files, it waits for a timeout period (30 seconds) 

and then shows a red X for the transfer. The Status in the queue pane indicates that the transfer failed. If you want 

to attempt to transfer the file again, you must login again when the network is available. After the Web Transfer 

Client reconnects, it resumes the transfer from where it stopped.      
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CONFIGURING PROTOCOLS ON THE SERVER 

Protocols are mostly configured at the Site level; however, before configuring SSL on the Site, you must configure 

SSL and FIPS-approved connections at the Server level. 

 

ENABLING SSL ON THE SERVER 

Protocols are mostly configured at the Site level; however, before configuring SSL on the Site, you must configure 

SSL and FIPS-approved connections at the Server level. 

Specify SSL versions and ciphers before enabling SSL connections. SSL connections can be enabled on the Site, 

Setting Template, and per user. Each level inherits the parent-level settings.  

To configure SSL 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server that you want to configure. 

3. In the right pane, click the Security tab. 

4. In the SSL Compatibility area, specify the SSL version to use:  
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 If you want to allow the user to use any compatible SSL version, click Auto Negotiable (selected 

by default).  

 If you want to force a particular version (TLS 1.0, SSL 2.0, or SSL 3.0), select it, and only that 

version will be allowed. If you select Defined, TLS 1.0 is automatically selected, because at least 

one SSL version must be defined. If you attempt to clear the last remaining check box, an error 

message appears to remind you that at least one version must be selected.  

5. In the Select from list box, select the check box of one or more Allowed ciphers to use or manually 

specify the ciphers. At least one cipher must be specified.  

 

Only advanced users should manually specify ciphers. 

6. Click the Priority arrows to arrange the ciphers in top-down priority. If more than one approved cipher is 

specified, and the connecting client has in its list one or more ciphers that are also on the Server’s 

approved list, the Server will select and use the cipher based on ordering (priority) shown in the list box. 

7. In the FTPS Protocol Specific area, check the Allow Clear Command Channel (CCC) for FTPS connections 

and/or Allow unprotected data channel (PROT C) for FTPS connections, as needed. Users that attempt 

CCC or Prot-C must receive the appropriate FTP error code if not permitted by the Server. The client must 

then retry using protected command or data channels to connect. 

8. Click Apply to save the changes to the Server. 

 

 SSL Cipher and Version-allowed settings affect ALL Sites on the Server. 

 PCI DSS requirements mandate use of 128-bit or higher ciphers, and SSLv3, TLS or greater. 

 A Certificate Authority (CA)-signed certificate establishes your validity better than a self-signed 
certificate. 

 For details of SSL when using FIPS mode, refer to FIPS-Compliant Protocols and Ciphers. 
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SSL CERTIFICATES 

The key to understanding how SSL works is to understand the elements that take part in the process. A key 

element of SSL is the SSL certificate. A public-key certificate, usually just called a certificate, is a digitally-signed 

document that ties the value of the public-key to the identity of the server service that holds the corresponding 

private key.  

 

Typically, a certificate contains the following information: 

 The server’s public key value, which the clients use to encrypt a session key (The client and the server use 

the session key to encrypt data). This public-key does not exist as a file, but rather is produced when a 

certificate and private key are created. 

 The server’s identifier information, such as the name, e-mail address, common domain name, and other 

details. 

 The validity period (the time that the certificate is considered valid)  

 Issuer or signer identifier information  

 The digital signature of the issuer, which attests to the validity of the binding between the server public 

key and the organization's identifier information.  

Many certificate types or standards exist, and the Server supports the most common ones. The Server can import 

into its certificate store any client-provided certificate of type PKCS 7 or 12, and the X.509 DER encoded standard. 

For the certificate that the server itself provides (to the connecting client during the SSL handshake), it supports 

X.509 and PKCS #12 only. Note that PKCS #12 embeds both the certificate AND private key into a single file. The 

default type that is created by the Server is x.509 base-64 standard DER encoded. 

Before a certificate can be used for securing connections, it must be created (generated) and signed (or vouched 

for). Certificates can be created directly from the Server, or by a trusted Certificate Authority (CA), which is an 

independent and trustworthy entity responsible for issuing and managing digital certificates, including revocation 

of certificates that are expired or are otherwise unauthorized. Once created, a certificate should be signed. By 

digitally "signing" a newly issued certificate, the signer guarantees the authenticity of the data held in the signee’s 

certificate. The Server can sign its own certificates; however, it is recommended that the certificate be signed by a 

trusted 3rd-party CA.  
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When generating a new certificate, the Server creates a self-signed certificate and a certificate signing request (or 

CSR) file that you can send to a CA for signing and then import into the Server.  

Files created by the Server: 

Private key file (.key) - The private key should never be distributed to anyone. It is used to decrypt the 

session that is encrypted by the public key. 

Certificate request file (.csr) - Each time you create a certificate using the Server, a Certificate request file 

is also created. This file can be signed by the Server's Certificate Signing Utility or sent to intermediate 

certificate authority such as GeoTrust, Verisign (www.verisign.com), or Thawte (www.thawte.com) for 

signing. 

Certificate file (.crt) - This is a self-signed certificate. To obtain a 3rd-party signed certificate, you must 

send the certificate signing request file to a Certificate Authority (CA) such as Verisign, Geotrust, or 

Thawte. The CA in turn will send you a new .crt file with which you can replace your self-signed one. 

SSL CERTIFICATE CHAIN-OF-TRUST 

Trust in a certificate is established when you have a copy of the signing certificate in your certificate store (for 

example, the Server’s store or Internet Explorer's Trusted Root Certification Authority for clients). The certificate 

does not necessarily have to be signed by a root CA; it can be signed by subordinate intermediate CA, as long as 

there is a valid certification path from the signing certificate to a trusted root certificate, meaning that none of the 

certificates in the certification path have been revoked or is expired. 

USING CIPHERS FOR SSL CONNECTIONS WITH THE SERVER 

This section describes the use of ciphers for SSL connections with the Server. For the procedure for configuring SSL 

on the Server, refer to Configuring SSL.  

In the Administrator interface, you can specify symmetric key cipher(s) and the ordering of those ciphers for 

establishing SSL sessions. The Server validates inbound SSL sessions, and allows or denies connections based on 

specified or approved ciphers.  

If FIPS mode is enabled for SSL connections, only FIPS-approved SSL ciphers are available. 

PCI DSS 4.1 states that you should use strong ciphers and protocol versions. On a High Security Site, if you 
attempt to specify weak ciphers and protocol versions or to create a cipher manually, the Server prompts you 
to correct it, or continue with reason.  

When using the GSCM, the Server enforces the use of specific algorithms for FIPS mode. 

The Server provides two choices for specifying ciphers: 

A point-and-click cipher selection list box interface (Option A)  

A more powerful string-based cipher selection interface that uses the parameterized cipher string (Option 

B) for creating an ordered SSL cipher preference list per http://www.openssl.org/docs/apps/ciphers.html.

If Option A is used to specify more than one approved cipher, and the connecting client has in its list one or more 

ciphers that are also on the Server’s approved list, the Server selects and uses the cipher based on ordering 

(priority) shown in the list box.   

http://www.openssl.org/docs/apps/ciphers.html
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If Option B is used, than the cipher negotiation will use the ordering defined by the user in the cipher string (for 

example @strength), or if no ordering was defined, the default ordering. 

Option A Details 

If Select from list is selected (selected by default), the user can choose from a multi-selection list box showing 128-

bit and higher ciphers available from the OpenSSL library. 

The default list, ordering, and enabled/disabled state are shown in the table below.  

Name in the Server Cipher 
List 

OpenSSL 
Name 

Enabled by 
default 

AES 256 bit AES256-SHA Yes 

Camellia 256 bit CAMELLIA256-SHA Yes 

3DES 168 bit DES-CBC3-SHA Yes 

AES 128 bit AES128-SHA Yes 

IDEA 128 bit IDEA-CBC-SHA> Yes 

RC4 128 bit RC4-MD5 Yes 

Export (40-56 bit) EXP No 

At least one check box must be selected. 

Refer to FIPS-Certified Library for SSL Connections for information about ciphers that you can use when FIPS is 

enabled for SSL. 

Option B Details 

The user may optionally enter ciphers in the cipher string field. When Manually specify ciphers is selected, the 

Select from list box is disabled, as the advanced ciphers-string based list takes precedence over ciphers in the 

Select from list box. In the Manually specify ciphers box, type a string that will be passed directly to the SSL 

library. For example: 

ALL:!ADH:RC4+RSA:+SSLv2:@STRENGTH or ALL:!ADH:HIGH:@STRENGTH. 

The Server validates the cipher string against the SSL library once when Apply is clicked or if the user clicks out of 

the Security tab. If the string is faulty, the Server returns an error indicating that it failed and the failure reason, if 

available. 

After the prompt appears and you click OK or Cancel, the prompt closes but does not clear out the cipher in case 

you want to refine it, if needed. Changes cannot be applied until the string is valid or you have reverted to using 

the click/select cipher list rather than the advanced string list. 
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EXPLICIT VERSUS IMPLICIT SSL 

Secure Socket Layer (SSL) was originally created for secure Web browsing. When both a client and server support 

the AUTH SSL command, security is accomplished through a sequence of commands passed between the two 

computers. The FTP protocol definition provides at least two distinct mechanisms by which this sequence is 

initiated: explicit (active) and implicit (passive) security. 

Explicit Security: To establish the SSL link, explicit security requires that the FTP client issue a specific command to 

the FTP server after establishing a connection. The default FTP server port is used. This formal method is 

documented in RFC 2228. 

Implicit Security: Implicit security automatically begins with an SSL connection as soon as the FTP client connects 

to an FTP server. In implicit security, the FTP server defines a specific port for the client (990) to be used for secure 

connections.  

 

Implicit SSL is discussed in various SSL drafts but is not formally adopted in an RFC. For strict compliance to 
standards, use the explicit method. 

Because implicit SSL has a dedicated port strictly used for secure connections, implicit SSL connections require less 

overhead when you establish the session. There are various FTP servers that support this mode, including EFT 

Server, EFT Server, RaidenFTPD, IBackup’s FTP server, and others. 

Think of implicit security as "always on" and explicit security as "turn on." The following diagram contrasts implicit 

and explicit SSL connections.  

 

CREATING SSL CERTIFICATES 

A self-signed certificate contains a public key, information about the owner of the certificate, and the owner's 

signature. It has an associated private key, but it does not verify the origin of the certificate through a third-party 

certificate authority.  

To achieve the highest level of authentication between critical software components, do not use self-signed 

certificates, or use them selectively. 

http://www.ietf.org/rfc/rfc2228.txt
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A certificate on the client must be associated with the Server to initiate an SSL connection. When you are 

administering the Server on the local computer, you can create certificates using the Certificate Creation Wizard 

(Tools > Certificate Creation Wizard) or import your own. There are three types of files associated with an SSL 

certificate key pair: 

 Private key file (.key)- The private key should never be distributed to anyone. It is used to decrypt the 

session, which is encrypted by the public key. 

 Certificate request file (.csr) - Each time you create a certificate using the Server, a Certificate request file 

is also created. This file can be signed by the Server's Certificate Signing Utility or sent to an intermediate 

certificate authority, such as GeoTrust, for signing.  

 Certificate file (.crt) - This is a signed certificate, whether self-signed or signed by an intermediate 

certificate authority. 

For maximum compliance with security standards, you should use a trusted authority-signed SSL certificate. You 

can import certificates or use this wizard to create your own. The private key (.key) and certificate request (.csr) 

files are created at the same time. You are prohibited from creating certificates for the Server while remotely 

administering the Server because this action can create a security breach. Any certificates you create remain on 

the computer on which you created them, unless you take special steps to deliver and associate these files with 

another computer. 

To create an SSL certificate 

1. In the Administrator, connect to the Server, click the Server tab, then do one of the following: 

 On the main menu, click Tools > Create SSL Certificate. 

 On the toolbar, click the New SSL Certificate icon . 

 On the keyboard, press ALT+T+C. 

The Create SSL Certificate wizard appears. 

 

2. In the Certificate name box, specify the name of the certificate that will be generated. 

http://www.verisign.com/
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3. In the Path box, specify the path to the folder in which the certificate is to be saved. The wizard saves the 

.key, .csr, and .crt files in this folder (e.g., C:\Documents and Settings\All Users\Application 

Data\Globalscape\EFT Server or \EFT Server Enterprise). 

 

If you are purchasing a signed certificate from a certificate authority (CA), you usually need to 
forward the contents to the CA. To do this, locate the .csr and open it in a text editor; then you can 
copy and paste the contents. 

4. In the Expiration Date box, specify the date on which the certificate will expire. 

5. In the Passphrase and Confirm passphrase boxes, type the passphrase used to encrypt the private key. 

The passphrase can be any combination of characters or spaces. Do not lose the passphrase; the 

certificate is useless without it. 

6. In the Key Length (in bits) box, specify the key length: 512, 1024, 2048, and 4096 bits. Smaller keys are 

faster, larger keys are more secure.  

 

If you create a certificate with a key length of 4096 bits or greater, the Web Transfer Client will not 
function properly due to its reliance on the Java runtime (JRE), which currently does not support key 
lengths of 4096 bits or greater.  

7. Click Next. The Certificate Information page appears.  

 

Each of the boxes must be completed before continuing. The information you provide is stored in the 

certificate. 

8. In the City/Town box, provide the name of your city, town, or other locality. 

9. In the State/Province box, provide the name of the state or province. 

10. In Organization box, provide the name of your organization, or any other designator. 

11. In the Common Name box, provide the common name or fully qualified domain name, such as 

www.globalscape.com. (Typically, the name or domain name associated with the Site.) 

12. In the E-Mail box, provide your e-mail address in the format username@domain.com. 

13. In the Unit box, type any other information about your organization, such as department name. 

14. In the Country box, provide the 2-letter ISO country code using uppercase letters. 
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15. Click Next. The Certificate Options page appears. 

 

16. If the Associate the certificate to the Site(s) specified below check box is cleared, the wizard saves only 

the certificate files in the folder you previously specified, but does not associate it with any Site. If the 

check box is selected, the wizard associates the certificate to the administration service or Site(s) you 

specify in the Apply certificate to box. 

17. In the Apply certificate to box, specify which components of the Server are affected (Administration 

Service, All Sites, or a specific Site). 

 

Associating a new certificate with a Site requires a restart of the Site, and any active users will be 
disconnected, so it is recommended that you associate certificates when Sites are inactive or 
stopped. 

18. If the Add this certificate to the Trusted Certificate list check box is selected, the wizard adds the 

certificate to the Trusted Certificates database. Use this feature if you are creating certificates for user 

distribution. You can limit the Server access to just the users that have the certificate. You can verify the 

addition to the Trusted Certificate database by clicking Tools > Certificate Manager or, on the toolbar, 

click the Certificate Manager icon . (Refer to The Certificate Manager for more information.) 

19. Click Finish.  

CERTIFICATE CHAINING 

A certificate chain is used to establish a chain of trust from a peer certificate to a trusted CA certificate. Each 

certificate is verified using another certificate, creating a chain of certificates that ends with the root certificate. 

The issuer of a certificate is called a certification authority (CA). The owner of the root certificate is the root 

certification authority. The last certificate in the chain is usually a self-signed certificate.  

EFT Server supports full certificate chains, which is a single file with a combination of all certificates in the chain. 

Usually, you will receive this file from a signing authority. Otherwise, you can create the chain manually, as 

described below, or ask the GlobalSCAPE Technical Support team to create one for you. 

 

http://www.globalscape.com/support/techsupport.aspx
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To create the chain, the general steps include: 

1. You must have the following certificates:  

 Client/server certificate signed with the intermediate CA certificate 

 One (or more) intermediate CA certificates  

 A root CA certificate  

2. Download the OpenSSL command line utility, available free from http://www.openssl.org/.  

3. Run the x509 command on a certificate file, outputting the text version of that file. (Refer to the example 

below.) 

4. Redirect the output into a combined file as a concatenated block of text.  

For example, suppose you created a certificate in the Server called "mycert.crt" (and it has the associated private 

key "mycert.key"), then sent the CSR file ("mycert.csr") to Verisign, who sent you the following: 

 Signed certificate ("mycert_Signed.crt") 

 Intermediate certificate ("Verisign_Intermediate.crt") 

 Root certificate ("Verisign_Root.crt"). 

To combine these into a single file that the Server supports, use the following commands in OpenSSL: 

c:\> openssl x509 -inform PEM -in "mycert_Signed.crt" -text > 

mycert_combined.crt 

c:\> openssl x509 -inform PEM -in "Verisign_Intermediate.crt" -text >> 

mycert_combined.crt  

c:\> openssl x509 -inform PEM -in "Verisign_Root.crt" -text >> 

mycert_combined.crt 

You now have a certificate file that the Server can use to deploy the entire chain. 

 

The way you access the intermediate and root certificates, as well as the format of those certificates, might 
differ between signing authorities.  

 

http://www.openssl.org/
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FEDERAL INFORMATION PROCESSING STANDARD (FIPS) 

The Federal Information Processing Standard (FIPS) Publication 140-2 specifies the security requirements of 

cryptographic modules used to protect sensitive information. When the EFT Server service is started, if FIPS is 

enabled, a message displays which protocols are in use and which of the protocols in use are FIPS compliant. When 

you enable FIPS, the ciphers, key lengths/types, and hash lengths/types that are not FIPS-approved are not 

available, and an initialization routine executes a series of startup tests that set the cryptographic module into a 

FIPS-approved operational state. (Toggling FIPS mode requires that you restart the EFT Server service.) 

If a FIPS-approved state cannot be achieved when FIPS is enabled, all Sites will stop, and an error message appears 

in the Windows Event Log and the EFT Server Administrator interface. After you dismiss the message, the EFT 

Server Administrator interface closes. 

 

If the HS module is not licensed, when the HS module trial expires, EFT Server can no longer operate in 
FIPS mode. 

 You can enable FIPS mode for: 

o inbound SFTP (SSH2)  

o inbound HTTPs/FTPs (SSL) 

o outbound HTTPs/FTPs (SSL) through Event Rules (except when using AWE).  

 FIPS mode does not apply to: 

o outbound client SFTP (SSH2) through Event Rules 

o AWE-based HTTPs/FTPs (SSL)  

o AWE-based SFTP (SSH2) 

o AS2 inbound nor outbound transactions 

FOR FTPS/HTTPS (SSL) CONNECTIONS 

EFT Server supports operation with the FIPS 140-2 Validated GlobalSCAPE Cryptographic Module (GSCM) for 

SSL/TLS and certificate generation. FIPS 140-2 validated GlobalSCAPE Cryptographic Module (GSCM) is based on 

the openssl-fips-1.1.1 FIPS source and the openssl-0.9.7m project. If FIPS is not enabled, the non-FIPS SSL version 

of OpenSSL 0.9.8h is used. 

 

For more information about certification of the GlobalSCAPE Cryptographic Module (GSCM), refer to 
the Module Validation List on the National Institute of Standard and Technology (NIST) Website at 
http://csrc.nist.gov/groups/STM/cmvp/documents/140-1/140val-all.htm#908. The GSCM’s certificate 
number is 908. 

Certificates created in prior versions of the EFT Server or Secure FTP Server (imported certificates that were 

signed using non-FIPS compliant algorithms) will not work in EFT Server version 6 when using FIPS mode. 

(Certificates must use SHA-1.) For details of converting certificates prior to importing them into EFT Server, refer to 

Using OpenSSL to Generate/Convert Keys and Certificates. 

EFT Server uses one of the following three cipher combinations during SSL/TLS negotiation: 

 TLS 1.0 RSA Key Exchange, RSA Authentication, 256 bit AES encryption, and SHA1 HMAC 

 TLS 1.0 RSA Key Exchange, RSA Authentication, 168 bit 3DES encryption, and SHA1 HMAC 

 TLS 1.0 RSA Key Exchange, RSA Authentication, 128 bit AES encryption, and SHA1 HMAC  

http://csrc.nist.gov/groups/STM/cmvp/documents/140-1/140val-all.htm#908
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The use of the SHA1 HMAC is TLS 1.0 specific. By limiting the algorithms, we force use of TLS 1.0 in EFT Server. For 

more info on why FIPS requires TLS 1.0, refer to http://www.mail-archive.com/openssl-

users@openssl.org/msg54318.html. 

The order of preference, as listed above, is provided by EFT Server to the SSL client (e.g., the Administrator 

interface or CuteFTP). During SSL negotiation, the SSL client is allowed to select its preferred combination from this 

list. By default, the SSL client typically picks the highest common denominator. EFT Server allows only these three 

cipher combinations; the algorithms cannot be NULL. FIPS certifies both DSA and RSA for digital signature 

generation and verification, but only allows RSA for key wrapping. Since SSL requires key wrapping, when EFT 

Server is in FIPS mode, only RSA can be used. Per FIPS requirements for RSA key wrapping, the Server enforces a 

minimum key length of 1024 bits and a maximum key length of 4096 bits. 

 

If the Server requires SSL certificates from connected clients, those certificates must also use SHA-1. 

FOR SFTP (SSH) CONNECTIONS 

The Server uses the FIPS-certified version of Crypto++ for inbound SFTP (SSH) connections.  

When the Server service is started, if FIPS is enabled, a message displays which protocols are in use and which of 

the protocols in use are FIPS compliant. When you enable FIPS, the ciphers, key, and hash lengths/types that are 

not FIPS-approved are not available. If a FIPS-approved state cannot be achieved when FIPS is enabled, all Sites will 

stop, and an error is written to the Windows Event Log.  

SSH2 uses the following ciphers: 

 3DES, AES128, and AES256-cbc for symmetric encryption 

 hmac-sha1 for message authentication 

 DSA or RSA 

ENABLING FIPS MODE FOR SSL (HTTPS AND FTPS) CONNECTIONS 

After you enable or disable FIPS mode, you must restart the Server service.  

To enable FIPS mode for SSL Connections 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server on which you want to enable FIPS mode. 

3. In the right pane, click the Security tab. 

4. In the Federal Processing Information Standards (FIPS) area, select the Use FIPS certified library for SSL 

connections check box. 

 

5. Click Apply to save the changes on the Server. 

http://www.mail-archive.com/openssl-users%40openssl.org/msg54318.html
http://www.mail-archive.com/openssl-users%40openssl.org/msg54318.html
http://www.cryptopp.com/#fips
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6. Stop and then restart the Server service. Review the Statistics area of the Server's General tab to verify 

that the service started. 

 If the HS module has expired when you attempt to start a Site on a Server that has FIPS mode 

enabled, an error message appears in the Administrator and the Server sends an error message 

to the Event Log.  

 In Internet Explorer (IE) version 6, TLS mode must be enabled for SSL communications to work. 

(In Internet Explorer, click Tools > Internet Options. Click the Advanced tab. Scroll to the Security 

settings and select the Use TLS 1.0 check box. TLS is enabled by default in IE7.)  

Refer to SSL for information about configuring SSL on the Site. 

ENABLING FIPS MODE FOR SSH (SFTP) CONNECTIONS 

To enable FIPS mode for SSH connections 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server on which you want to enable FIPS mode. 

3. In the right pane, click the Security tab. 

4. In the Federal Processing Information Standards (FIPS) area, select the Use FIPS certified library for SSH 

connections check box. 

 

5. Click Apply to save the changes on the Server. 

6. Stop and then restart the Server service. On the Server's General tab, review the Statistics area to verify 

that the service started. 

 If the HS module has expired when you attempt to start a Site on a Server that has FIPS mode 

enabled, an error message appears in the Administrator and the Server sends an error message 

to the Event Log.  

Refer to SFTP for details of configuring and enabling SFTP (SSH2) on a Site. 

FIPS MODE EVENT MESSAGES 

EFT Server displays FIPS-related messages when switching to/from FIPS modes, starting/restarting the Server or 

Site, making Administrator interface connections, or managing certificates. EFT Server presents messages in the 

Administrator interface and in the Windows Event Log and allows you to correct the error. That is: 

 A FIPS initialization error at Server startup does not stop the EFT Server service. Instead, the service is 
started and listening for administrator connections, but the Sites are stopped so that you can connect, get 
diagnostics, disable FIPS mode, and so on. 
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 An administrator SSL certificate failure at Server startup does not stop EFT Server service immediately. 
Instead, EFT Server starts, but does not accept SSL administrative connections. The administrator is able 
to login locally, get diagnostics, replace the certificate, and so on. 

 An administrator SSL certificate failure after SSL FIPS mode switching does not stop the EFT Server service. 
Instead, EFT Server continues working, but does not accept SSL administrative connections. The 
Administrator can connect to replace the certificate, and so on. 

FIPS MODE MESSAGES IN THE ADMINISTRATOR 

EFT Server displays the following FIPS-related messages in the EFT Server Administrator interface. 

<SITENAME> will be started with the following protocols: FIPS compliant protocols: <FIPSPROTOCOLS> Non-FIPS 

protocols: <NONFIPS> To ensure FIPS compliant operation, please enable only FIPS compliant protocols. 

 

When the Server is in SSL or SSH FIPS mode, this message reports which Site protocols are FIPS-secured and 

which are not each time the Administrator explicitly starts the Site (e.g., clicks Go). 

The EFT Server is stopped: FIPS mode initialization error. All sites and protocols are disabled. 

This warning message appears upon new Administration connections if FIPS fails to initialize. FIPS can fail to 

initialize because the Server could not load the FIPS library or the library self-test failed. When this occurs, 

the Server is stopped and all Sites and protocols are disabled. 

An error occurred while attempting to start EFT Server. FIPS mode initialization error; all sites and protocols 

have been disabled. 

This message appears in the Administrator interface during Server start or restart when FIPS fails to 

initialize. FIPS can fail to initialize because the Server could not load the FIPS library or the library self-test 

failed. When this occurs, the Server is stopped and all Sites and protocols are disabled. 

An error occurred while attempting to start Site ‘<SITE_NAME>. The SSL certificate provided for Site 

‘<SITE_NAME>’ has an improper key length.  FIPS 140-2 mode requires keys between 1024 and 4096 bits 

(inclusive). Please choose a different certificate, or generate a new one that has at least 1024 but no more than 

4096 bits in the public key. 

or, if other certificate error (forbidden algorithms, inconsistent private key, or invalid private key password): 

An error occurred while attempting to start Site ‘<SITE_NAME>’. Could not load SSL certificate. 

This message appears during Site start/restart if a Site uses SSL and its certificate does not meet FIPS 

requirements (e.g. FIPS mode gets turned on and old certificate/key does not pass the FIPS test). The Site is 

stopped. 
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An error occurred while attempting to start Site ‘<SITE_NAME>. The SFTP key provided has an improper key 

length. FIPS 140-2 mode requires keys between 1024 and 4096 bits (inclusive). Please choose a different key, or 

generate a new one that has at least 1024 but no more than 4096 bits in the public key. 

or, if other certificate error (forbidden algorithms, inconsistent private key, or invalid private key password): 

An error occurred while attempting to start Site ‘<SITE_NAME>’. Could not load SFTP certificate. 

This message appears during Site start/restart if a Site uses SFTP and its key does not meet FIPS 

requirements (e.g. FIPS mode gets turned on and old certificate/key does not pass the FIPS test). The Site is 

stopped. 

The Site <SITE_NAME> is not started: [SSL certificate | SFTP key] is too weak and does not meet FIPS 140-2 

requirements. Clients will not be able to connect to the Site. 

or, if other certificate error (forbidden algorithms, inconsistent private key, or invalid private key password): 

The Site <SITE_NAME> is not started: could not load  [SSL certificate | SFTP key]. Clients will not be able to 

connect to the Site. 

This warning message appears during new Administrator interface connections if a Site uses SSL and its 

certificate does not meet FIPS requirements or uses SFTP and its key does not meet FIPS requirements (e.g. 

FIPS mode gets turned on and old certificate/key does not pass the FIPS test). The Site is stopped. 

EFT Server SSL certificate for remote administration is not an approved size (must be at least 1024 but no more 

than 4096 bits). Administrators will not be able to connect to EFT Server remotely. 

or, if other certificate error (forbidden algorithms, inconsistent private key, or invalid private key password): 

EFT Server SSL certificate for remote administration is broken. Administrators will not be able to connect to EFT 

Server remotely. 

This warning message is used in to notify all connected Administrator interfaces if the SSL certificate for 

remote administration does not meet FIPS requirements. Remote administration connections via SSL are 

not accepted. 

EFT Server SSL certificate for remote administration is too weak and does not meet FIPS 140-2 requirements. 

Administrators will not be able to connect to EFT Server remotely. 

or, if other certificate error (forbidden algorithms, inconsistent private key, or invalid private key password): 

EFT Server SSL certificate for remote administration is broken. Administrators will not be able to connect to EFT 

Server remotely. 

This warning message is used during new Administrator interface connections if the SSL certificate for 

remote administration does not meet FIPS requirements. Remote administration connections via SSL are 

not accepted. 

EFT Server [SSL | SSH] subsystem has entered FIPS mode. All new connections over [SSL | SSH] will use EFT 

Server’s FIPS certified cryptographic libraries. 

or, if other certificate error (forbidden algorithms, inconsistent private key, or invalid private key password): 

EFT Server [SSL | SSH] subsystem has exited FIPS mode. All new connections over [SSL | SSH] will use EFT 

Server’s standard (non-FIPS) cryptographic libraries. 

These informational messages appear in the Administrator interface to notify all connected Administrator 

interfaces when an administrator explicitly switches SSL or SSH FIPS mode or FIPS mode is disabled due to 

trial expiration. 
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FIPS MODE EVENTS IN THE EVENT LOG 

EFT Server displays the following FIPS-related events in the Windows Event Log. 

GlobalSCAPE EFT Server - FIPS [SSL|SSH] mode initialization error; all sites and protocols are disabled. 

This error message appears in the Event Log upon EFT Server service start or restart if FIPS fails to initialize. 

FIPS can fail to initialize because the Server could not load the FIPS library or the library self-test failed. 

When this occurs, the Server service is stopped and all Sites and protocols are disabled. 

GlobalSCAPE EFT Server - FIPS mode initialization error for site "<SITE_NAME>": the specified [SFTP key|SSL 

certificate key] is not an approved size (must be at least 1024 but no more than 4096 bits). The site has not been 

started. 

or, if other certificate error (forbidden algorithms, inconsistent private key, or invalid private key password): 

GlobalSCAPE EFT Server - FIPS mode initialization error for site "<SITE_NAME>": the specified [SFTP key|SSL 

certificate] is broken. The site has not been started. 

This message appears during Site start/restart if a Site uses SSL and its certificate does not meet FIPS 

requirements or uses SFTP and its key does not meet FIPS requirements (e.g. FIPS mode gets turned on and 

old certificate/key does not pass the FIPS test). The Site is stopped. 

EFT Server SSL certificate for remote administration is not an approved size (must be at least 1024 but no more 

than 4096 bits). Administrators will not be able to connect to EFT Server remotely. 

or, if other certificate error (forbidden algorithms, inconsistent private key, or invalid private key password): 

EFT Server SSL certificate for remote administration is broken. Administrators will not be able to connect to EFT 

Server remotely. 

This warning message appears in the Event Log if the SSL certificate for remote administration does not 

meet FIPS requirements. Remote administration connections via SSL are not accepted. 

EFT Server [SSL | SSH] subsystem has entered FIPS mode. All new connections over [SSL | SSH] will use EFT 

Server’s FIPS certified cryptographic libraries. 

or, if other certificate error (forbidden algorithms, inconsistent private key, or invalid private key password):  

EFT Server [SSL | SSH] subsystem has exited FIPS mode. All new connections over [SSL | SSH] will use EFT 

Server’s standard (non-FIPS) cryptographic libraries. 

This informational messages appear in the Event Log when an administrator explicitly switches SSL or SSH 

FIPS mode or FIPS mode is disabled due to trial expiration. 

GlobalSCAPE EFT Server - FIPS [SSL|SSH] mode initialized successfully; operating in compliance with FIPS 140-2. 

This informational message appears in the Event Log every time the EFT Server service starts or restarts to 

report its successful FIPS mode initialization. 
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CHANGING THE SERVER LISTENING IP ADDRESS AND PORT 

The Server's listening IP address and port are configured in the Server Setup wizard if you configured it for remote 

administration. You can change the IP address and/or port later, if necessary. For example, you might have initially 

configured the Server to listen on All incoming IP addresses and want to change it to a specific IP address. 

To change the Server's listening IP address and port 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server that you want to manage. 

3. In the right pane, click the Administration tab. 

 

4. In the Server administrator listening IP box, click the list to specify an IP address. The IP addresses 

displayed depend on the configuration of the computer on which the Server is installed. 

5. In the Port box, type the new port number. 

6. Click Apply to save the changes on the Server. 
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BANNING IP ADDRESSES FROM REMOTE ADMINISTRATION 

By default, all IP addresses are granted remote access to the Server. The Server allows you to grant access to only 

one specific IP address or a range of IP addresses, or deny access to one specific address or a range of addresses. 

The Server can control TCP/IP access at the Server, Site, or Settings Template, or per user.  

To grant/deny access by IP Address 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server that you want to configure. 

3. In the right pane, click the Administration tab. 

4. Next to IP ban/access list for remote administration, click Configure. The IP Access/Ban List dialog box 

appears. 

 

The IP Access/Ban List dialog box displays the IP addresses that are granted or denied access to the 

Server.  

5. Click granted access or denied access, then click Add. The IP Mask dialog box appears. 

 

6. Specify the IP address or range of IP addresses to deny or grant access to the Site. You can use wildcards 

to select ranges of IP addresses. 

 If most IP addresses are allowed access, click granted, then list the exceptions. 

 If most IP addresses are denied access, click denied, then list the exceptions. 

 For example, if you click denied, then specify the range 200.200.100-200.*, all IP addresses are 

denied access, except those in the range 200.200.100.000 to 200.200.200.255. 

7. Click OK to close the IP Mask dialog box. The IP address/mask appears in the exceptions list. 
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8. Click OK to close the IP Access/Ban List dialog box. 

9. Click Apply to save the changes on the Server. 

REMOTE ADMINISTRATION 

You can remotely administer the Server from any computer on which the Administrator is installed (with network 

access). If you are using SSL, you must create and/or assign an SSL certificate to use for connections. 

 

Remote administration is not allowed after the trial expires if you do not activate the software. 

Before you can connect from the remote Administrator, you must: 

1. Configure the Server. You must do this locally, on the Server computer. 

2. Configure remote administration, as described below. 

 If you have configured remote administration, but are unable to connect, one or more of the following could be 

preventing the connection: 

 The IP address of the computer on which you are attempting to connect to EFT Server is listed in the 

Remote Administration Ban IP list. 

 Your SSL certificate is expired or invalid. 

 Remote administration has been disabled.  

 The remote administration port value has changed. 

 EFT Server’s IP address has changed since the last login. 

 The firewall settings of the computer on which EFT Server is installed are blocking the connection. 

 There is a version mismatch between your console and the EFT Server service you are trying to 

administer. 

 Other network errors 

To configure the Server for remote administration 

1. Launch the Administrator on the Server computer and connect to the Server you want to configure for 

remote administration. (You cannot setup remote administration remotely.) 

2. In the right pane, select the Administration tab. 



EFT Server™ version 6 

138  

 

3. In the Server administrator listening IP box, specify the IP address that is allowed to connect remotely. 

You can select a specific IP address that is defined on the computer on which the Server is installed or All 

Incoming IP addresses. 

4. In the Port box, specify the port on which the Server listens for connections. 1100 is the default port. For 

security, you should use a different port other than the default. 

5. Select the Allow remote administration check box. A warning message appears advising you to connect 

over SSL for more secure administration. 

 

If you attempt to allow remote administration on a High Security Site, a message appears to warn 
you that this setting violates PCI DSS 2.3, and allows you to continue with reason or disable the 
feature. 

6. Click Yes to set up secure administration or No to administer over a clear (not secure) connection. 

7. To require SSL for remote connections, click the Require SSL for remote administration check box, then 

click Configure. The SSL Certificate Settings dialog box appears.  
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8. Do one of the following: 

 To create a certificate, click Create and follow the prompts in the wizard. (Refer to Creating 

Certificates for details, if necessary.) 

 To use an existing certificate: 

a. In the Certificate box, type the path to the .crt file or click the open icon  to find and 

select it. 

b. In the Private key box, type the path to the .key file or click the open icon  to find 

and select it. 

c. In the Passphrase box, type the passphrase for the certificate pair. 

9. Click OK to close the dialog box. 

10. Click Apply to save the changes on the Server.  

11. Close the Administrator. Make sure that the Server service is still running, then configure the remote 

Administrator using the procedure below. 

To configure the remote Administrator 

1. Launch the Administrator on the remote computer. 

2. In the left pane, select the Server tab. 

3. Specify the Server Group to which you want to add the remote server. 

4. On the File menu, click Add New Server. The Login wizard New Administrator Connection page appears.  
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5. Click A remote computer. 

6. In the Label box, type the name of the Server to which you want to connect. You can call it anything you 

want; it has nothing to do with the Server's computer name. 

7. In the Host address box, type the IP address of the Server computer. 

8. In the Port box, type the port number used by the Server. 

9. Click Next. The EFT Server Administrator Login page appears. 
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10. Click A remote computer, then click its name (the label you gave the Server in step 6) in the box. 

11. In the EFT Server administrator credentials area, provide your Username and Password, then click 

Connect. 

 If connection was successful, the remote Server appears in the tree.  

 If connection was not successful, verify the IP address and port on which the Server listens for 

connections, and be sure SSL is properly configured, if used.  

SPECIFYING A NEW LOCAL OR REMOTE SERVER 

After you have configured the local connection to the Server (that is, a connection on the same computer on which 

the Server is installed), you might want to create a remote connection to remotely administer the Server. Or if you 

have added a new Server, you need to configure the new local host. 

To specify a new local or remote host 

1. Do one of the following to open the New Administrator Connection wizard: 

 In the Administrator Login dialog box that appears when you open the Administrator, click A 

remote computer, then click New.  

 If you are already logged in and want to create a new Server, right-click anywhere in the left 

pane, then click Add New the Server.  
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2. Click one of the following: 

 This computer  

 A Remote computer  

3. In the Label box, type the name of the Server to which you want to connect. 

4. In the Host address box, type the IP address of the Server computer. 

5. In the Port box, type the port number used by the Server. 

6. Click Next. 

 

If you close the wizard before the new connection process is complete, none of your settings are 
saved. 

7. After the new host is created, the Login dialog box appears. Type your username and password, then click 

Connect.  

If you are unable to connect to a remote Server, verify that the remote Server is configured to allow remote 

administration, and that you have provided the correct IP address, port, and login information. 
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CONFIGURING SERVER ADMINISTRATORS 

The topics below provide information regarding creating and managing the Server administrators in the 

Administrator. 

 

Choose a Server administrator username and password that are different than the local administrator 
account of the computer on which the Server is installed, or from which you will remotely connect to the 
Server. 

DELEGATED ADMINISTRATION 

 

If you are upgrading from a version of the Server prior to version 5.1, any legacy "SuperAdmin" accounts are 
converted to "Server Admin" accounts. These accounts will only see the Server node and the Security tab 
when they log in.  

The Server allows you to assign sub administrator accounts that have very specific/granular permissions to manage 

the Server, COM, Site(s), Settings Templates, user accounts, user passwords, and reports. Permissions are assigned 

to sub-administrators via a series of controls on the Server's Security tab.  

For example, suppose you want to give your help-desk people the ability to create user accounts on the Server, but 

you are worried that the help-desk might accidentally make changes to the Server in the process of creating these 

accounts. Furthermore, you do not want the help desk people to manage user accounts that belong to the 

engineering and marketing groups. In this example, delegated administration allows you to create one or more 

sub-administrator accounts that have access ONLY to user accounts management. Using Settings Template 

templates to house marketing, engineering, and other department accounts, you can further limit the sub-

administrators to only those accounts for departments that they are authorized to manage.  

Each of the sub accounts can also be allowed access to COM and or Auditing and Reporting. 

The available sub administrator account types include: 

 Server - Can create, modify, or remove administrator accounts, and can manage Sites, Settings Templates, 

and user accounts. 

 Site - Can manage everything for a specific Site and the Settings Templates on the Site, and can change 

user passwords, but does not have control over the Server. The Site administrator cannot click the Server 

node nor access any of the node's tabs; stop/start the GlobalSCAPE Server service from within the 

Administrator; create, remove, or rename Sites, Servers, or Server Groups; access or modify the Server 

global or applet settings; close the Server engine; or stop/start any Site other than those assigned to the 

Site administrator. 

 Settings Template - (EFT Server Enterprise only) Has full control over the accounts assigned to that 

Setting Level, including the ability to view, add, remove, and modify user accounts, and group assignment; 

can change all Setting Level settings, except for the VFS root path for assigned Setting Levels; can see the 

entire VFS tree, but can only modify the parts of the VFS that belong to root folders that belong to the 

Setting Level to which the account is assigned; can access the General tab on the Server to view statistics; 

can kick and monitor users. They cannot access the Reports tab unless specifically allowed; cannot select 

the Site, Server, or Server Group nodes, nor view the corresponding tabs; cannot access Server settings, 

nor any Setting Level not assigned to their account. They can access the PGP, SFTP, and SSL key manager, 

and create, import, export, and add keys and certificates. They cannot delete keys or certificates.  
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 Change Passwords - (EFT Server Enterprise only) Can enable/disable users and change passwords for 

users in their specified Settings Template(s), but cannot add nor remove users, manage other Settings 

Template(s), manage Sites, nor control the Server. When a Change User Password administrator logs in to 

the Server, only the view below is available.  

 

 

 User - (EFT Server Enterprise only) Has all the privileges of the Change Password administrator, but can 

also create new users. The User administrator is not allowed to see or edit users' settings or Template 

settings, and is limited to change password, disable user, or create more users. 

 

All administrator accounts are treated equally with respect to password expiration, reset, and removal of 
inactive accounts. 

ENFORCING COMPLEX PASSWORDS FOR ADMINISTRATOR ACCOUNTS 

When you create or edit administrator accounts, you can specify that all administrator accounts be required to 

adhere to certain password complexity rules. 

To set complexity settings for administrator accounts 

1. Refer to Adding the Server Administrators or Changing an Administrator Password or Access Rights for the 

procedures for creating or changing an administrator account. 

2. In the Administrator, connect to the Server and click the Server tab. 

3. In the left pane, click the Server to which you want to add an administrator account. 

4. In the right pane, click the Administration tab. 

5. At the bottom of the tab, click Password Policy. The Password Security Settings dialog box appears. 
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6. Select the Enforce strong (complex) passwords check box to ensure that when any administrator creates 

or changes a password for any administrator account, password complexity is enforced. 

7. To specify password complexity settings, click Advanced. The Password Complexity Settings dialog box 

appears. 

 

 

8. In the Minimum password length box, specify the minimum number of characters the password must 

contain. The default is 8 characters. 

9. In the Must contain at least box, specify the number of characters from the following categories the 

password must contain: Uppercase, Lowercase, Numeric (0-9), Non-alphanumeric (e.g., !, #, $, %). Select 

the check boxes for the applicable characters. (Certain non-alphanumeric characters might not be 

available when using a mix of English and non-English language settings and keyboards.) 

10. In the Must not contain boxes, select the check boxes and specify the number of characters from the user 

name and/or number of repeating characters the password must not contain. 

11. In the Dictionary area, select the Must not solely consist of a word in the following dictionary, then 

specify the dictionary file. A default dictionary file is provided in the Server installation directory. 

12. Select the Must not be dictionary word backwards to ensure the password is not a word in the dictionary 

file spelled backward. 

13. Click OK to close the Password Complexity Settings dialog box. 

14. Click OK to close the Password Security Settings dialog box. 

15. Click Apply to save the changes on the Server. 

  

 

If anyone tries to change a strong administrator password to a password that does not meet the 
specifications in the Password Complexity Settings dialog box, an error message appears. 
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ADDING SERVER ADMINISTRATORS 

You can give other users access to the administrative functions of the Server by creating an administration account 

for them in the Administrator. For security and for compliance with the PCI DSS, you should not create more than 

one administrator with full control over the Server. 

To create an administrator account 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server to which you want to add an administrator account. 

3. In the right pane, click the Administration tab. 

4. In the Administrator Access and Permissions area, click Add. The Create/Edit Administrator 

Account dialog box appears. 

 

5. Define a user name for the account. 

6. Define and confirm a password for the account or click Generate to generate a strong password.  

 

Passwords are case-sensitive. 

The new user appears in the Admin account names box. 
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7. In the Administrator type area, click one of the delegate options. If you select Site Admin, Template 

Settings Admin, User Admin, or Change user password, the assignment dialog box appears. (The Site 

assignment dialog box is shown for example.)  

 



EFT Server™ version 6 

148  

8. To assign the Sites or Settings Templates that this account will manage, select one or more items in the 

Available box, then double-click the selection or click Add, then click OK. The assignment appears in the 

Assigned to list.  

9. If you want this account to have administrator access to COM functions, select the COM check box. 

10. If you want this account to have administrator access to generate reports, select the Run reports check 

box. 

11. Configure administrator password security settings (Password Policy). Refer to Enforcing Complex 

Passwords for Admin Accounts for details. 

12. Configure administrator account security settings (Account Policy). Refer to Expiring Administrator 

Passwords and Enforcing Password Reset for Administrator Accounts for details. 

 

The password security and expiration options apply to all administrator accounts defined on this 
Server. 

13. Click Apply to save the changes on the Server. 

CHANGING AN ADMINISTRATOR PASSWORD OR ACCESS RIGHTS 

Anyone with Server administrator rights can modify other administrator accounts in the Administrator. 

To modify an administrator account 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server on which the administrator account is defined. 

3. In the right pane, click the Administration tab. 



Configuring EFT Server 

149 

 

4. In the Admin Account Names list, click the account that you want to change. 

5. Do one or more of the following: 

 To change the password, click Modify. The Create/Edit Administrator Account dialog box 

appears. 

 

a. Define a username for the account. 

b. Define and confirm a password for the account or click Generate to generate a strong 

password.  

 

Passwords are case-sensitive. 

 To change the delegate options, refer to Adding Server Administrators. 
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 To change password security settings, refer to Enforcing Complex Passwords for Administrator 

Accounts, Enforcing Password Reset for Administrator Accounts, and Expiring Administrator 

Passwords. 

 To change account security settings, refer to Removing Inactive Administrator Accounts and 

Locking Out an Administrator Account. 

6. Click Apply to save the changes on the Server.  

ENFORCING PASSWORD HISTORY FOR ADMINISTRATORS 

You can enable the Server to remember the previous passwords of administrator accounts so that administrators 

must create unique passwords.  

To configure administrator accounts to enforce password history 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server you want to configure. 

3. In the right pane, click the Administration tab.  

  

4. Click Password Policy. The Password Security Settings dialog box appears. 
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5. Select the Enforce password history check box, then specify the number of passwords to remember. The 

default is 4. 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 

ENFORCING PASSWORD RESET FOR ADMINISTRATOR ACCOUNTS 

The Server provides the option to force administrators to change their password when they log on. On HS-enabled 

Sites, users are forced to change their passwords on first use.  

You can enable the password reset page while disallowing general access to HTTP or HTTPS. When a new user logs 

in to the Server via the HTTP or HTTPS index page, the Server redirects the user to the reset page. After the user 

creates a new password, they are returned to the index page. 

 

Password initial reset, expiration, and account management features only apply to Sites using GlobalSCAPE 
the Server Authentication and ODBC Authentication. These options are not available if other authentication 
types (AD, LDAP) are used. Password security features all apply at the Server level, not to individual accounts. 
 
The Server cannot ask FTP users to change their password prior to logging in and identifying themselves. The 
Server allows them to login (authenticate), but then prevents any further interaction until they change their 
password.  
 
Refer to Using the High Security Module with the Secure Ad Hoc Transfer Module if you are using a High 
Security Site. 

To configure administrator accounts to enforce password reset 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server you want to configure. 

3. In the right pane, click the Administration tab.  
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4. Click Password Policy. The Password Security Settings dialog box appears. 

 

5. Select the Admin must reset their password after first login check box. Administrators are prompted to 

change their password when they log in to the Site. 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 
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When a password is reset, the Server verifies the new password against complexity criteria and password history, if 

those features are enabled. The administrator is not allowed to proceed with the session until a password is 

created and accepted by the system. If the password is not accepted by the system: 

 In HTTPS and SFTP, the authentication request will be denied.  

 In FTP, no further FTP commands will be accepted until the new password is provided and meets 

complexity and password history requirements, if those features are enabled. 

For PCI DSS-enabled Sites: 

 PCI DSS requirement 8.5.3 states that you should set first-time passwords to a unique value for each user 

and force users to change their password immediately after the first use.  

 A warning appears if you clear the Admin must reset their password after first login check box. If an 

administrator logs in using a temporary password, a warning appears to prompt the administrator to 

supply a new password.  

EXPIRING ADMINISTRATOR PASSWORDS 

The HS module allows you to expire administrator passwords. If you do not activate the module, this feature is 

disabled after the 30-day trial expires. 

If Expire Passwords is enabled and a user logs in with an administrator account with a temporary password, the 

Server prompts the user to supply a new password. Each day it also checks whether passwords are <n> days from 

expiration, and those passwords are flagged for reminders, if reminders are enabled. All reminder e-mail messages 

are sent immediately after flagging the accounts to be reminded.  

To expire administrator account passwords 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server you want to configure. 

3. In the right pane, click the Administration tab.  
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4. Click Password Policy. The Password Security Settings dialog box appears. 

 

5. To specify the number of days after which to disable or remove administrator accounts, select the Expire 

passwords check box, then type or use the arrows to specify the number of days. The default is 90 days.  

 

If you make any changes to the password settings, when you click Apply to push the changes to the 
Server, the counter is reset. For example, if you set it for 90 days, then go back 89 days later and 
specify a different dictionary file, when you click OK then Apply, the administrator accounts will not 
expire for 90 days. 
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6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 

LOCKING OUT AN ADMINISTRATOR ACCOUNT 

The Server can automatically lock out an administrator account after a specified number of incorrect login 

attempts over a specified time.  

On a High Security Site, if you clear the Lockout check box, increase the number of incorrect login attempts to 

more than 6 or set the attempt period to more than 5 minutes, a warning message appears. 

Instruct administrators regarding the timeout setting, after which they can try to log in again. If they are unable to 

wait for the lockout to timeout, use the procedure below to enable the account. 

To disable or remove an account after a defined number of incorrect login attempts  

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server you want to configure, then click the Administration tab. 

 

3. Click Account Policy. The Account Security Settings dialog box appears. 
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4. Select the Lockout admin accounts check box, then specify the length of time the account is to be locked 

out, the number of incorrect login attempts to count, and the period during which to count the attempts. 

5. Click OK to close the dialog box. 

6. Click Apply to save the changes on the Server. 

To enable an account that has been locked out 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server you want to configure, then click the Administration tab. 

3. Click Account Policy. The Administrator Account Security dialog box appears. 

4. Clear the Lockout check box.  

5. Click OK to close the dialog box. 

6. Click Apply to save the changes and enable the locked out account. 

7. To resume account security, click Account Policy. The Administrator Account Security dialog box appears. 

8. Select the Lockout check box.  

9. Click OK to close the dialog box. 

10. Click Apply to save the changes. 

REMOVING INACTIVE ADMINISTRATOR ACCOUNTS 

The HS module allows you to disable or remove user accounts; however, administrator accounts can only be 

removed, not disabled. Inactive accounts are removed every night at midnight, during Server Startup, and at each 

GetAllSites() response. If you do not activate the HS module, this feature is disabled after the 30-day trial period 

expires. 

For HS-enabled sites, the Server enables the option to disable or remove inactive accounts automatically, and warn 

if you attempt to disable that setting. The option to remove administrator accounts will be enabled by default, 

unless during the setup process you choose not to enable this option. The Server prompts administrators when 

they login advising them of the potential removal of their account if their login failed due to unknown login name. 

The removal of accounts is captured in the Auditing and Reporting database for reporting.  

If a user attempts to log in remotely to the Server with an administrator username that does not exist or an 

incorrect password, the Administrator displays a warning message. 

 

A change in any date-sensitive value resets the calculations. For example, if this feature was configured for 60 
days, and you change it to 90 days, the count resets to zero, so that any inactive account that has been inactive 
for 59 days and was set to be removed tomorrow, will now not be considered inactive until 90 days from today. 
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To specify automatic removal of inactive user accounts 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server you want to configure, then click the Administration tab.  

  

3. Click Account Policy. The Account Security Settings dialog box appears. 

 

4. Select the Remove admin accounts after check box, then specify the number of days of inactivity after 

which to remove the account.  
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5. Click OK to close the dialog box. 

6. Click Apply to save the changes on the Server. 

RESETTING THE EFT SERVER ADMINISTRATOR PASSWORD 

If you forget EFT Server's administrator password, you can reset it. However, using this procedure, you will lose all 

user- and group-specific settings. The user accounts and their folder structures will remain, but permissions and 

settings will be lost. 

 

Be sure to back up any other files in the Server installation folder that you will need, such as certificates. The 
easiest method is to back up the entire Server directory (by default, C:\Program Files\GlobalSCAPE\EFT). 

To reset the administrator username and password 

1. In the Windows Services dialog box, stop the Server service.  

2. Navigate to the folder where the Server is installed. (By default, C:\Program Files\GlobalSCAPE\EFT.)  

3. The user accounts and folder structures are stored in one or more files with an .aud extension. Copy these 

configuration files to a safe place for backup.  

4. Using the Windows Add/Remove Programs utility, uninstall the Server.  

5. Reinstall the Server. 

6. Create a new administrator username and password.  

7. Open the Administrator and login with your new username and password.  

8. Recreate your Site(s) with the EXACT same name(s) as you previously used. The Site name must match 

character for character.  

9. In the Windows Services dialog box, stop the GlobalSCAPE Server service.  

10. Copy the .aud files that you saved in step 3 and paste them into the folder where you have installed the 

Server. Click Yes when asked if you want to overwrite the existing .aud files.  

11. Restart the Server service and log in. The individual groups and user accounts should be preserved; 

however, you must reassign permissions and settings. 
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ERASING EFT SERVER CONFIGURATION 

If you want to completely remove the Server configuration (Servers, Sites, Settings Templates, and users), you can 

do so with the procedure below. 

To erase the Server configuration 

1. Stop the GlobalSCAPE Server service. 

2. Delete ftp.cfg and any ftp.bak files. (By default, the files are stored in C:\Documents and Settings\All 

Users\Application Data\GlobalSCAPE\EFT Server Enterprise or \EFT Server.) 

3. Start the GlobalSCAPE Server service.   

4. Launch the Administrator and log in with the username and password used during installation of the 

Server.  

5. Recreate your Sites, Settings Templates, and users (all are removed when you delete the ftp.cfg files). 

LOG SETTINGS 

To monitor the Server activity, you can reference the Server’s log files. The Server supports W3C, Microsoft IIS, and 

NCSA log file formats. Server events are logged to a file named [log file format]yymmdd.log , where YY, MM, and 

DD indicate the numeric year, month, and day respectively. Depending on the log file format selected, a 2-letter 

abbreviation is prepended to the filename, as described in the table below. For example, a log file in the Microsoft 

IIS format created on August 22, 2007 is named in070822.log.  

Log File Format Abbreviation Notes 

W3C  ex Times are specified in GMT.  

Microsoft IIS  in Time is recorded as local time. 

NCSA  nc Date, time, and Greenwich Mean Time (GMT) offset 

 

 

For information about the Database Audit Settings, refer to Auditing Database Errors and Logging.  

To specify log settings 

1. In the Administrator, connect to the Server and click the Server tab.  

2. In the left pane, click the Server. 

3. In the right pane, click the Logs tab. 

http://www.w3.org/TR/WD-logfile
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/be22e074-72f8-46da-bb7e-e27877c85bca.mspx?mfr=true
http://publib.boulder.ibm.com/tividd/td/ITWSA/ITWSA_info45/en_US/HTML/guide/c-logs.html#ncsa
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4. In the Folder in which to save log files box, type the path to the directory in which to save this Server's log 

files. To browse for a path, click the open icon .  

 

By default, log files are saved in the Server installation directory in the Log folder. 

5. In the Log file format list, click W3C Extended, Microsoft IIS, NCSA Common, or No Logging. 

 

Changing the log file format disconnects all active users. It is recommended to stop all Sites or wait 
until all users are inactive before changing the log file format. 
 
The W3C format records all times in GMT (Greenwich Mean Time). 

6. In the Log type list, click Standard or Verbose. (Verbose provides more details, but makes larger files.) 

7. In the Rotate Log File area, specify Never, Daily, Weekly, or Monthly. 

8. Click Apply to save the changes on the Server. 

9. Stop and restart the Server. 

 

Logs are not written to disk in real time. As events occur, the Server buffers those events in real time 
and then flushes (writes) them to file after either a) 60 lines are available or b) 32kb of log data is 
received in 1 second or less. 



Configuring EFT Server 

161 

AUDIT DATABASE SETTINGS 

When you run the Server Setup wizard, you are offered the opportunity to enable auditing and reporting and 

configure the connection information. If you chose to do that later or if you want to edit the database information, 

you can do so on the Logs tab in the Audit Database Settings area. 

To enable and configure auditing and reporting 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server you want to configure. 

3. In the right pane, click the Logs tab.  

 

4. In the Audit Database Settings area, select the Enable Auditing and Reporting check box to enable 

communication with the database; clear the check box to disable auditing and reporting. 

5. In the Database type area, select SQL Server or Oracle. (Oracle is available in EFT Server Enterprise only.) 

6. In the Database host address[\Instance Name] box, specify the host or database instance name of the 

database to which you want the Server to connect, or provide a DSN or DSN-less connection string. Refer 

to Establishing a System Data Source Name (DSN) or Using a DSN-Less Connection with ODBC 

Authentication, if you are using ODBC Authentication for your Site. 

7. In the Database name box, provide the name of the database or leave the box empty if you provided a 

connection string in the Database host address[\Instance Name] box. 

8. In the Database username box, provide the username needed to connect to the database or leave the 

box empty if you provided a connection string in the Database host address[\Instance Name] box. 
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9. In the Password box, provide the password to connect to the database or leave the box empty if you 

provided a connection string in the Database host address[\Instance Name] box. 

10. In the In case of database error area, specify whether you want to audit database errors to a folder: 

 If you do want to audit errors, or to stop it temporarily, click Stop auditing. 

 To Audit to folder, click the option, then specify the path to the folder in the box. 

11. In the Failure notification e-mail box, provide the e-mail address that you want to receive error 

notifications in case of database failure. When auditing is enable, this e-mail is sent any time that the 

Server cannot reach the database. 

12. If you make any changes to the database audit settings, click Apply to save the changes on the Server. 

13. To verify the connection information, click Test Connection. The status of the database connection 

appears above the Reconnect button. If the database is not connected, click Reconnect to reconnect to 

the database.  

 Test Connection - The Server attempts a connection using the supplied parameters without 

applying the changes. 

 Reconnect - The Server applies the settings (a prompt appears if you made changes and did not 

click Apply) and attempts to connect to ARM with the new settings. 

ADMINISTERING THE SERVER SERVICE 

The Server Service Settings dialog box is used to administer the GlobalSCAPE Server service, either locally or 

remotely. Using this dialog box, you can uninstall/install the service, stop/start the service, and specify the Server 

to administer. 

To administer the Server service 

1. In the Administrator, connect to the Server and click the Server tab. 

2. On the main menu, click Edit > Server Service Settings. The Server Service Settings dialog box appears. 

 

 To stop the service, click Stop service. (You can also stop the service on the Server's General tab.) 

 To start the service, click Start service. 



Configuring EFT Server 

163 

 To remove the service from the Windows Services dialog box, click Uninstall service. (The 

application is not removed from the computer; it is just not accessible in the Windows Services 

dialog box.) 

 To reinstall the service and make it accessible from the Windows Services dialog box, click Install 

service. 

 To administer a remote computer 

a. Click Uninstall service to make the Connection area available. 

b. Click Administer remote computer, then type the IP address of the remote computer, 

including the port if necessary. For example, type 192.168.20.47:1101. 

 To administer the local computer (if remote was previously selected) 

a. Click Uninstall service to make the Connection area available. 

b. Click Administer local computer, then type the IP address of the local computer, 

including the port if necessary. For example, type 192.168.20.47:1101. 

CONFIGURING SMTP SERVER SETTINGS 

The SMTP Server Settings on the Server's SMTP tab are complete automatically when define them in the Server 

Setup Wizard. You must configure the SMTP Server settings for the Server to send e-mail notifications when 

events occur, including the address for the outgoing mail server, an address for the Administrator, and other 

details described below. 

To configure the Server to send e-mail notifications 

1. Click the Server tab in the Administrator and select the Server that you want to configure. 

2. In the right pane, click the SMTP tab. 
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3. In the SMTP host address box, specify the address of the mail server the Server will use to send outgoing 

messages. 

4. In the Port box, specify the port number at which the mail server accepts messages. The standard is 25. 

5. In the From e-mail address box, type the "From" e-mail address that will appear in e-mail notifications 

sent by the Server. 

6. In the From name box, type the "From" name that will appear in e-mail notifications sent by the Server. 

"EFT Server" appears by default. 

7. Do one of the following: 

 If the Server can connect to the mail server without a login, clear the SMTP server requires 

authorization check box. 

 If the mail server requires a user name and password, select the SMTP server requires 

authorization check box, then provide the Username and Password needed to connect to the 

mail server. 

8. In the Address Book area, click Add to add names and e-mail addresses of recipients of the Server event 

notifications. Add only the addresses that you want to receive e-mail notifications. The e-mail addresses 

will be added automatically to the To box in the Send notification email Action in Event Rules.  

 To edit a name or address, click once to select the box, then click again to activate the box. 

9. Click Apply to save the settings on the Server. 
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AUTOMATICALLY UPDATING THE  
USER AUTHENTICATION DATABASE 

The Server can automatically check the user authentication database at regular intervals to make sure the user 

information is correct and current. This feature updates the Server only. You can also override the Server's refresh 

rate for each Site individually. 

Depending on the refresh settings, a user account might not immediately appear in the Administrator Interface 

when you create it. When a user account that has not yet appeared in the list attempts to log on, the Server will 

query the user authentication manager to determine if the user account is authorized to connect to the Server. 

Once the account has been verified, it will appear in the list. You can also manually refresh the Administrator to 

see any changes (View > Refresh Users Database).   

 

In the COM API, use ForceSynchronizeUserDatabase.  

To automatically update authentication information 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Server you want to configure. 

3. In the right pane, click the General tab. 
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4. In the Default user database refresh interval list, select how often you want the Server service to check 

for changes to the authentication database. If you do not want the service to check, click Never refresh 

user list automatically. 

 

When you click Refresh  in the Administrator (in the right pane, bottom toolbar), it only 
checks the Server service for updated user information. It does not check the authentication 
database. 

 

RENAMING, DELETING, AND MOVING A SERVER 

In the Administrator, you can rename and delete a Server, and move a Server to a different Server Group. When 

you delete a Server or Server group, you remove all of its login and configuration information. You can no longer 

connect to the Server if you delete it or its Server Group. 

To rename a Server 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane click the Server you want to rename. 

3. On the menu bar, click Configuration > Rename Selected (or press F2).  

 

 

4. Next to the Server's icon, type a different name. 

5. Press ENTER. 

To delete a Server 

 

When you delete a Server, you also delete all of its login information. You cannot undo this action. 

1. In the Administrator, click the Server tab. 

2. Do one of the following:  

 Right-click the Server you want to delete, then click Remove Server.  

 Click the Server you want to delete, then on the main menu, click File > Remove Server.  

3. Click Yes. 

To move a Server to a different Server Group 

1. In the Administrator, connect to the Server and click the Server tab. 

2. Right-click the Server you want to move, then click Change Server Group. The Change Server Group 

dialog box appears. 
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3. Do one of the following: 

 If the Server Group is defined, click the Select Group drop-down menu to select the Group.  

 If the Server Group is not defined: 

a. Click New Group. The Create New Group dialog box appears. 

 

 

b. Type a name for the new group, then click OK. The Change Server Group dialog box 

reappears. 

4. Click OK. 

CREATING, RENAMING, AND DELETING SERVER GROUPS 

Server Groups are used to organize Servers. The Default Server Group is created when you install the Server. You 

can rename this Server Group, create a new Server Group, and delete a Server Group (if you have more than one). 

To create a new Server Group 

1. In the Administrator, connect to the Server and click the Server tab 

2. Click File > New Server Group. The Create New Group dialog box appears. 

 

3. In the Group Name box, type a descriptive name for the Server Group. The name will appear in the tree 

and in reports and log files. 

4. Click OK. 

To rename a Server Group 

1. In the Administrator, connect to the Server and click the Server tab.  

2. In the left pane, click the Server Group you want to rename. 
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3. On the menu bar, click Configuration > Rename Selected (or press F2).  

 

 

4. Next to the Server Group's icon, type a different name. 

5. Press ENTER. 

To delete a Server Group 

You can only delete a Server Group if more than one is defined. 

1. In the Administrator, connect to the Server and click the Server tab 

2. Select the Server Group that you want to delete. 

3. Do one of the following: 

4. On the main menu, click File > Remove Server Group.  

 Right-click the Server Group, then click Remove Server Group. 

MONITORING USER CONNECTIONS ON THE SERVER 

The Server can monitor user's FTP/SFTP connections in real time, display the information in the Administrator, and 

record the activity to a log. 

To monitor a user connection 

1. In the Administrator, connect to the Server, and click the Status tab.  
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2. In the left pane, click the user connection that you want to monitor. 

 

 

3. In the right pane, on the bottom toolbar, click Monitor User .  

 In the left pane, the icon next to the user changes from a head  to an eye .  

 In the right pane, the connection activities are displayed.  

4. Click Log Scrollback (lines) to specify the number of lines the log records; click Auto Scroll to toggle 

automatic scrolling on or off. 

 

 

5. To stop logging the user's activities, click Stop Monitor. 

COPYING A SERVER CONFIGURATION TO SEVERAL COMPUTERS 

Copying or migrating the Server configuration might be necessary for several reasons, such as: 

 Moving a Proof of Concept (PoC) in your staging environment without wanting to recreate all the settings 

and configuration data.  

 Creating a standard configuration for installation on multiple computers. 

 Updating the Server software with a fresh install rather than patching.  

 

In EFT Server Enterprise edition, you can use the Migration wizard to backup and restore Server configuration. 
Refer to Backing Up or Restoring Server Configuration for details. 

 

  



EFT Server™ version 6 

170  

 

Installation and Deployment Considerations 

Consider the following before moving a configuration from the source to the target system: 

 Set the prototype Site's Home IP to All Incoming. It must not be bound to a specific IP address unless the 

system you are deploying to is bound to the same IP address. 

 Make sure the target system’s installation paths are the same as the installation path on the source 

computer. For example, suppose you installed the Server on drive C, then install it on drive C on the 

target, too. If the drive letters are different, change the drive letter on the target before installing the 

software. 

 Make sure the Server root and location of the .aud file (if you are using GlobalSCAPE’s authentication 

manager) on the target system are the same as on the source computer. The drive letters on the target 

system must match those on the source system for the Virtual File System (VFS) to be able to find the 

Server root (if they do not match, all permissions and groups will be lost). 

 Use the same administrator username and password when installing on the source and target systems. 

To set up the deployment configuration 

1. Install and activate the product on the source system. 

2. Configure the Sites, Users, Groups, file and folder permissions, Event Rules, Users, and so on.  

3. Exit the Administrator and stop the Server service in the Services dialog box (in the Windows control 

panel). 

4. Copy the following files from the Server installation directory to the target computer: 

 FTP.cfg 

 [Site].aud  

 All .bak and .update files 

 All certificates/keys/OpenPGP keys 

 Any custom reports (or all reports to make it easier) 

 All registry overrides (for special settings) 

 Web Transfer Client folder (to capture any customization) 

 PCI folder (PCI DSS Compliance report) 

 Ad Hoc folder (to capture any customization) 

5. Create the same physical folder structure on the target system as the folder structure created by the 

configuration of the source computer (C:\Inetpub).  

 

The easiest way to duplicate the physical folder structure is to copy the folder structure from the 
source to the target. 

6. Install and activate the product on the target system. 

7. Cancel the automatic setup wizard that appears the first time you run the Administrator. 

8. Close the Administrator interface and stop the Server service in the Services dialog box (in the Windows 

control panel). 
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9. Paste the files gathered from the source system into the Server installation folder on the target system. 

Only the FTP.cfg is overwritten, because you have not yet created any Sites, etc. on the target system. 

10. Restart the Server service and login using the Administrator. 

11. Double-check Server and Site configuration. The target system setup is now complete. 

EFT SERVER WEB SERVICES 

In EFT Server Enterprise edition, Web Services allows you to initiate the Server workflow from an external 

application such as an enterprise scheduler. The WebService interface follows the model of ASP.NET Web services, 

providing a page for the services definition document (WSDL) and an HTML form that can be used to test available 

service methods. Access to Web Services requires authentication with a COM-enabled Server Administrator 

account; without proper authentication and COM privileges, the Server returns a 401 Unauthorized HTTP 

error to the requestor.  

Refer to Enabling Web Services for the procedure for enabling Web Services on the Site. 

Requests to any /WebService URL is logged to the text log and ARM database just as any other HTTP request. A 

request that does not match the /WebService/InvokeEventRule URL or that does not include the required 

parameters, results in a 400 Bad Request HTTP error.  

The /WebService page displays a list of Web services available with the Server. This page is generated from an 

HTML page in the Server installation folder, in a subfolder called WebServices. 

By default, the following files are installed in C:\Program Files\GlobalSCAPE\EFT\EFTClient\WebServices: 

 \EFTWebServices_MAIN.html - Used to define the Web Services landing page; provides a link to 

InvokeEventRule.html. 

 \InvokeEventRule\EFTWebServices_InvokeEventRule.html - Used to define the Web interface from 

which you can remotely invoke Event Rules on the Server. 

 \InvokeEventRule\EFTWebServices.wsdl - Web Services Description Language (WSDL) configuration file. 

(For details of how WSDL files are used, refer to the World Wide Web Consortium documentation at 

http://www.w3.org/TR/wsdl.) 

 

The Server uses a template for the WSDL to construct the final WSDL. External tools can use the WSDL by 
pointing to the URL that deploys the WSDL file at  

http://localhost/WebService/InvokeEventRule?wsdl, where "localhost" is the IP address, computer name, or 
DNS name that points to the Server Service that is hosting the web service.  

HOW THE SERVER SUPPORTS WEB SERVICES 

The Server supports both POST and GET HTTP requests to “/WebService/InvokeEventRule” with two parameters 

“EventRuleName” and “EventParams” and triggers an Event Rule that is specified in the "EventName" as a 

synchronous operation. Web Services supports the REST invocation model, supporting both POST and GET 

methods for invocation. 

1. If an input is missing any of “EventRuleName” or “EventParams” it returns an HTTP 400 error. 

2. If both “EventRuleName” and “EventParams” are presented but: 

a. “EventRuleName” is wrong (no Event Rule exists with such name), it returns .xml with result code 

of -1. 

http://www.w3.org/TR/wsdl
http://en.wikipedia.org/wiki/Representational_State_Transfer
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b. “EventParams” are incorrect (wrong variable names, too many, too few), the Server looks for 

Rule variables in the input and replaces those values with found ones. All additional variables are 

ignored. If a Rule variable is not found in URL then it will be set to “N/A”. The result code in .xml 

will be the event execution result code.  

 

Requests to any /WebService URL is logged to the text log and ARM system just as any other HTTP request. 

HTTP GET 

The following is a sample HTTP GET request and response. Replace the placeholders with actual values. 

GET /WebService/InvokeEventRule?EventRuleName=string&EventParams=string HTTP/1.1 Host: 

localhost 

HTTP/1.1 200 OK Content-Type: text/xml; charset=utf-8 Content-Length: length <?xml 

version="1.0" encoding="utf-8"?> <int xmlns="http://mydomain/ ">int</int> 

HTTP POST  

The following is a sample HTTP POST request and response. Replace the placeholders with actual values. 

POST /WebService/InvokeEventRule HTTP/1.1 Host: localhost Content-Type: application/x-

www-form-urlencoded Content-Length: length E ventRuleName=string&EventParams=string  

HTTP/1.1 200 OK Content-Type: text/xml; charset=utf-8 Content-Length: length <?xml 

version="1.0" encoding="utf-8"?> <int xmlns="http://mudomain/ ">int</int> 
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HTML LISTING AND UPLOAD FORM 

EFT Server comes with a built-in upload form that uses the POST method. When HTTP or HTTPS transfers are 

enabled in the Administrator interface and your users have permission to upload to EFT Server using HTTP or 

HTTPS, they can upload files to their home directory via a Web browser using the HTML listing and upload form. 

The form automatically appears when you connect to the Server via a Web browser, with your home folder as the 

root.  

Limitations of the upload form include: 

 Inability to mass transfer files 

 Inability to rename or delete files 

 Inability to create folders 

 Minimum customization 

The size of file uploads is limited by the setting in the Settings Template or user account and the fact that you are 

using HTTP to upload files. Browser-based uploads are limited to a 2GB or less file size. 

 If the EFT Server URL is in the trusted list of the browser, a client-side script will check the file size. If the 

file is larger than the 2 GB limit, the browser will inform the user of the limit and block the upload. 

 If the EFT Server URL is NOT in the trusted list of the browser, EFT Server checks the size of the uploaded 

file and will close the connection if it exceeds the 2GB limit. The browser stops the transfer process upon 

the connection closing, and informs the user of the broken connection. (The over-size-limit error message 

sent by the server will not be received by the browser, just the information regarding the broken 

connection.) 

If the Web Transfer Client (WTC) is installed, enabled, and has licenses available, the WTC appears instead of the 

HTML listing and upload form. The WTC benefits include resume support, a transfer queue, sending multiple files 

concurrently (as opposed to sequentially), no file-size limit, drag -and -drop support, and integrity validation. 

To access the HTML listing and upload form 

1. In a Web browser, type or paste the URL for EFT Server. If you are using an HTTP or HTTPS port other than 

the default, you also have to provide the port number in the URL. (For example, type: 

http://10.0.0.124:8080/ 

The HTML listing and upload form appears. 
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 The orange toolbar provides options to create a New Folder, Rename a file, Upload a file, 

Change Password, Logout, or access the help file. 

 The blue toolbar provides options to delete a file , go up a folder , and go to your home 

folder . Next to the home folder icon, your location is listed. If only a forward slash appears, /, 

you are in the home folder.  

To upload a file 

1. Click Upload. The Upload bar appears. (To close the Upload bar, click Upload again.) 

 

2. Click Browse. A standard Open dialog box (depending on your operating system) opens to your My 

Documents folder. 

3. Click a file to upload to EFT Server, then click Upload. The file is uploaded to EFT Server and appears in the 

file listing. 

To download a file 

1. Click a file name/link. A standard File Download dialog box appears (depending on your operating 

system).  

 

2. Click Open to open the file (if you have the program necessary to view it), click Save to save the file to 

your hard drive or a network location, or click Cancel to cancel the download. 
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To rename a file or folder 

1. Select the check box next to the folder or filename, then click Rename. The Rename dialog box appears. 

2. Click in the New Name box, type a new name for the folder or file, then click OK. The folder or file is 

renamed. 

To delete a file 

1. Select the check box next to the filename, then click the delete icon . A confirmation message appears. 

2. Click OK to delete the file or Cancel to keep the file. 

To create a new folder 

1. Click New Folder. A dialog box appears in which you can type a name for the folder. 

2. Click OK. The folder appears in the tree. 

To change your password 

1. Click Change Password. The Change Password dialog box appears. 

2. In the Old Password box, type the password that you used to log in to the Web Transfer Client. 

3. In the New Password box, type a new password. 

4. In the Confirm Password box, type the new password again. 

5. Click Change Password to verify the new password or Cancel to keep your current password. 

 If the new and confirm passwords do not match, an error message appears. Click OK to try again. 

 If the new password is the same as any of your previous passwords (depending on password 

history settings), a message appears and the password is not changed. Click OK to try again. 

 If the new password is accepted, the Password Accepted message appears and you are logged 

out of the Server. Click OK to continue. 

6. The login dialog box appears. Type your new password, then click OK to log back in to the Server. 

To logout 

1. Click Logout. A message box appears explaining that you have been logged out of EFT Server, and reminds 

you that for extra security, you should close the browser. 

2. Click Exit. If a confirmation message appears, click OK. The browser closes. 

CONFIGURING THE WEB TRANSFER CLIENT ON THE SERVER 

The topics below provide guidance to system administrators for configuring and managing Web Transfer Client 

connections to the Server.  

ENABLING USER ACCESS TO THE WEB TRANSFER CLIENT 

Before users can log in to the Server using the Web Transfer Client (WTC), the Server administrator must configure 

the Server to allow connections from the Web Transfer Client. Active Directory domain users must have logon 

permission on the Server computer in order to log on to the Server through the WTC. This is accomplished by 

adding AD domain users to the "Allow log on locally" list on the Server computer.  
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If an AD domain user is not in this list, logging on to the Server through the WTC will fail and an error message 

appears informing the user that Local login access is required to log on to the Server. 

If a user has multiple sessions open and you want to make the licenses available to other users, stop and restart 

the Site. Stopping and restarting the Site resets the license count and disconnects everybody who is connected; 

users must reestablish their session. 

Web Transfer Client Requirements 

 Java 1.4.2 (J2SE) – JRE 1.6.0_05  

 Internet Explorer 6.0 and 7.0 (Win) with latest OS/browser patches  with JavaScript and cookies enabled  

 Turn off auto-ban flood sensitivity to allow users to connect successfully. 

 If you create an SSL certificate with a key length of 4096 bits or greater, the Web Transfer Client will not 

function properly due to its reliance on the Java runtime (JRE), which currently does not support key 

lengths of 4096 bits or greater.  

 In order for a user to be able to upload or download files or manage files in their home folder, the 

administrator must grant them permissions in the Virtual File System (VFS). 

To configure the Server to allow Web Transfer Client Connections 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user. 

3. In the right pane, click the Connections tab. 

 

4. In the Protocols area, select the Allow Web Transfer Client over HTTP/S check box. If this check box is not 

available, you have not activated the Web Transfer Client or the trial has expired. 
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HTTP or HTTPS must also be enabled. It is highly recommended that HTTPS be used if security is a 
concern. 

5. Click Apply. 

 

The Server allows users concurrent access to the Web Transfer Client up to the number of your available 
licenses. If a user attempts to access the client when the maximum number of licenses is in use, the upload 
form loads instead. Inform users that each refresh of the browser counts as one session, so do not click the 
browser's Refresh icon or F5. Click the Refresh icon in the WTC instead, which refreshes the display without 
requesting a new session. 

WEB TRANSFER CLIENT LICENSING 

With the Web Transfer Client (WTC), users can transfer folders, files, and groups of folders and files to and from 

their local filesystem to a remote filesystem. (Refer to The Web Transfer Client for details of using the WTC.) 

Use of the WTC requires the purchase of a license. Licenses for the WTC are for concurrent users; any number can 

have access, but only the number specified by the license can use the WTC concurrently. Session use is cookie 

based. If the license number is exceeded, the user is automatically directed to the HTML Upload Form page with an 

explanatory error message: "There are not enough available concurrent licenses to open the Web Transfer Client. 

Contact your Server administrator for help." You can edit the text that is displayed by editing the HTML file, 

NoAppletLicenses.htm, stored by default in C:\Program Files\GlobalSCAPE\EFT\EFTClient\, or hide the error 

message so that it does not appear (users would just be redirected to the HTML Upload form).  

The number of Web Client sessions includes the number of times a single user has refreshed the screen to open 

another session, not just the number of users who are connected. Each refresh of the browser counts as one 

session, so inform users not to click the browser's Refresh icon or F5. Instead, click the Refresh icon in the WTC, 

which refreshes the display without requesting a new session. 

The WTC is available for use during 30-day trials of the Server. The trial allows up to 5 concurrent sessions. After 

the trial has expired, a license must be purchased to resume use of the WTC. 

You can view the number of licenses available in the Administrator (on the main menu, click Help > About) and on 

the Status tab.  

To activate the Web Transfer Client 

1. In the Administrator, click Help > Activate Web Transfer Client. The Registration wizard appears. 

2. Follow the instructions in the wizard or refer to Activating the Software, if necessary. 

HIDING THE WEB TRANSFER CLIENT LICENSING MESSAGE 

If you do not want to show the error message, you can create or edit the referenced style sheet to hide the "error" 

class, as described in the procedure below.  

To hide the error message on the HTML Listing and Upload Form 

1. On the Server computer, create a text file using your favorite text editor. 
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2. Type or paste the following text into the text file:  

.error { 

visibility: hidden; 

display: none; 

} 

3. Name the file efthtmllisting.css and save the file in the EFTClient folder. By default, the path is: \Program 

Files\GlobalSCAPE\EFT\EFTClient. 

 

Users will still see the HTML Listing and Upload form when the WTC licenses are all used, but the error 

message will not appear.  

 

The style sheet, efthtmllisting.css, is the same one that you can create to change the default background, 
text, and so on. If you already have created efthtmllisting.css per the instructions in HTML Listing and Upload 
Form, simply add the above text to the style sheet. 

 

REBRANDING THE WEB TRANSFER CLIENT 

The Web Transfer Client can be easily customized to suit your needs. The appearance of the Web client is 

controlled by EFTStyles.css in the C:\Program Files\GlobalSCAPE\EFT Server Enterprise\Client\ or EFT 

Server\Client\directory. The image files in the directory can be substituted with your custom images.  

Before you make any changes, make a backup copy of the EFTStyles.css style sheet, EFTWebClient.htm, and the 

image files used in them.  

 

The EFTStyles.css style sheet also controls the appearance of the account management Web pages. Other 
style sheets in the EFTClient directory are used to control the appearance of the HTML Listing and Upload 
Form. 

For information about Web Transfer Client registry settings, refer to the GlobalSCAPE Knowledge Base, 

http://kb.globalscape.com. 

SESSION STATUS 

The Administrator Interface displays the number of session licenses currently in use and how many remain 

available. The number of Web Transfer Client sessions includes the number of times a single user has refreshed the 

screen to open another session, not just the number of users who are connected. Each refresh of the browser 

counts as one session, so inform users not to click the browser's Refresh icon or F5. Instead, click the Refresh icon 

in the WTC, which refreshes the display without requesting a new session. 

 Interrupted transfers are resumed automatically unless connectivity is lost and a timeout occurs. If the 

transfer fails, the incomplete download is overwritten when you retry. 

  

http://kb.globalscape.com/


Configuring EFT Server 

179 

 

 When the browser is closed, the session expires within 5 minutes. Sessions disconnect after 5 minutes of 

inactivity. Inactivity involves server-side activity such as transfers, browsing the remote pane, creation, 

deletion, or the renaming of remote files.   

o If a session times out, the browser must be refreshed to connect with a fresh session. If the 

session times out, you can still browse on the Local Filesystem (that is, on your computer), but 

you will not be able to do anything on the Remote Filesystem, such as rename files or folders, 

transfer files, etc.  

o The Web Transfer Client is licensed on a concurrent use basis. If the user logs into multiple 

browser windows, it will tie up a license seat for every browser instance that is logged in. 

You may want to inform your users not to use more seats than they need. 

To check Web Transfer Client status:  

1. In the Administrator, connect to the Server and click the Server tab. 

2. Click the Site you want to monitor, then click the Status tab. 

3. The number of Web Transfer Client sessions in use (active) and the number available (remaining) are 

displayed in the right pane. 

 

 

(The "Users Connected" field indicates users connected via FTP. Refer to Status Tab for more information.) 

 

In Internet Explorer, a message appears when the user has been disconnected from the Server. 
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WEB TRANSFER CLIENT MEMORY USE 

When a user connects to the Web Transfer Client (WTC), the Server downloads a jar file, various 

HTML/JavaScript/CSS files, and some images. When the browser launches the applet and files are being 

transferred, then the browser (through DHTML) and the Java Virtual Machine will also consume memory, and that 

memory will increase as more transfers are initiated. If you count the Java Virtual Machine (which becomes a child 

process for the Web browser) and WTC logic, then Internet Explorer consumes approximately 55MB. This is 

primarily because the Java Runtime Environment (JRE) is about 40MB, which must be loaded into browser memory 

to execute Java applications. But this is only in-memory utilization, NOT downloaded from the Server.  

 The WTC jar file is loaded once into the cache of the connecting browser, and is 462 KB.  

 The various HTML/JavaScript/CSS files that are deployed total 323 KB.  

 Images, some of which show up immediately and others of which are only loaded at certain times (like 

progress bars), total about 60 KB.  

Refer to Checking Java Runtime Versions for more information about the JRE. 

EDITING THE NUMBER OF FILES DISPLAYED 

By default, the Web Transfer Client (WTC) is designed to automatically filter the file list and display only the first 

499 files and folders. Once that limit is reached, the WTC will prompt the user to use the FILTER feature to find the 

files that they want. 

Limiting the file list to 499 files helps avoid performance issues when browsing folders that contain very large 

numbers of files and folders. Depending upon the size of the folder and the capabilities of the computer running 

the browser, performance of the system can degrade significantly. 

 

This procedure is for advanced users only. Incorrectly editing the registry can severely damage your system. 
You should always back up (export a copy of) the registry before you make any changes to it. Refer to 
Windows Registry Settings for details. 

To change the threshold at which this automatic filtering is enforced (i.e., the number of files and 
folders that can be displayed 

1. On the Server computer, download and extract the files from increase-wtc-filter-threshold.zip. The zip file 

contains these instructions, Calendar.js, and increase-wtc-filter-threshold.reg.  

2. Copy Calendar.js into a subfolder of the Server installation folder named Client. (e.g., C:\Program 

Files\GlobalSCAPE\EFT Server Enterprise\Client)  

3. Open your copy of Calendar.js in a text editor (such as Notepad).  

4. At the bottom of the file, edit the script that overrides the default behavior, shown below, to change the 

value of "5000" to the number that is appropriate for your file systems and browser computer 

performance capabilities.  

MAX_FILES_IN_PANE = 5000; 

(The Web Client default is 500; this setting is 10 times the default.)  

5. Open increase-wtc-filter-threshold.reg in a text editor.  

file:///D:/WorkFolder/Technical%20Writing/EFT%20Server/EFT6/Source/increase-wtc-filter-threshold.zip
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6. Modify the value of the path (to the right of the equals ("=") sign) so that it matches the physical path to 

the file Calendar.js that you saved in step #2, above. Be sure that all backslashes ("\") in the physical path 

reference are saved as two backslashes ("\\") in the file.  

7. Stop the GlobalSCAPE Server service.  

8. Double click increase-wtc-filter-threshold.reg that you edited to merge the value into the Server 

computer's registry.  

9. Start the GlobalSCAPE Server service.  

10. Validate the changes by opening a browser and navigating to the HTTP/S service of the Server and use the 

Web Transfer Client. 

CHANGING AN AD PASSWORD VIA THE WEB TRANSFER CLIENT 

Active Directory (AD) and LDAP Site users can change their AD password through the Web Transfer Client (WTC). 

(Refer to Changing Your Password in the Web Transfer Client for details of how to change the password.)  

When a user attempts to change the account password, the following errors are possible. You can customize the 

error messages creating text files with the following names and saving them in the EFT Server installation directory 

Client subdirectory (e.g., C:\Program Files\GlobalSCAPE\EFT Server Enterprise\Client): 

 Current password is entered incorrectly (PasswordChg_PasswordWrong.txt) 

 Network connection error (PasswordChg_NetworkProblem.txt) 

 User does not have permission by AD to change the password (PasswordChg_Permission.txt)  

 New password does not meet the AD complexity requirements (PasswordChg_PasswordComplexity.txt) 

 Current password is about to expire (PasswordChg_PwdWillExpire.txt) 

If the text files identified above do not exist when an error occurs, the default text provided within the Server is 

presented to the user. 

The location of these files can be modified by running the PasswordChg_MsgFileLocation.reg script, which is 

located in the EFT Server installation directory Client subdirectory. You must first edit the 

PasswordChg_MsgFileLocation.reg script to specify the new location. 

TURNING OFF THE CHANGE PASSWORD FEATURE FOR AD/LDAP USER ACCOUNTS 

The WTC NTAD/LDAP change password capability can be turned on/off through the PasswordChg_NTADLDAP 

registry key. This allows security conscious administrators to turn off this feature if necessary. By default, the 

password change ability is "off."  

Two registry scripts are provided to enable/disable the password change feature:  

 PasswordChg_NTADLDAP_On.reg  

 PasswordChg_NTADLDAP_Off.reg.  

These registry scripts are also located in the EFT Server installation directory/Client subdirectory. Simply double-

click the .reg file to turn on or turn off the feature. 
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USING THE CUSTOM USER DETAILS FIELDS IN HTTP HEADERS 

(You need a customized version of the Web Transfer Client, available from Professional Services to use this 

feature.) 

When a user attempts to connect to EFT Server, the connecting client sends a request to EFT Server, which reads 

the information in the HTTP or HTTPS header, then sends a response back to the client. You can configure a 

registry key on the EFT Server computer so that EFT Server reads the information in the authenticated user's User 

Account Details Custom Fields, and then adds that information to the HTTP/HTTPS response header.  

For example, when a user first connects to EFT Server through the Web Transfer Client, you might want a license to 

appear that they must accept to continue. The information that the user accepted the license would appear in the 

Custom Field in EFT Server and in a cookie on the client computer, so that the user would not be asked to accept 

the license on subsequent connections.  

To activate this feature, create the following key/DWORD value 

"HKEY_LOCAL_MACHINE\Software\GlobalSCAPE Inc.\EFT Server 

4.0\EFTClient\enable_x_headers"  

A value of 1 activates the key; 0 deactivates the key 

To create the key/DWORD value in a .reg file 

1. In a text editor, such as Notepad, type or paste the following text: 

Windows Registry Editor Version 5.00 

[HKEY_LOCAL_MACHINE\Software\GlobalSCAPE Inc.\EFT Server 4.0\EFTClient] 

"enable_x_headers"=dword:00000001 

2. Save the file with a .reg extension. 

3. Double-click the .reg file to insert it into the Registry.  

4. Restart the Server service. 

 If you receive an error, open the file to verify the information was typed correctly.  

 The .reg file can be transported to and used on other computers if you have more than one EFT 

Server. 

 

http://www.globalscape.com/support/professional_services.aspx
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STEP 3: CONFIGURING SITES 

AUTHENTICATION TYPES 

The Server supports the following database types for authenticating users: 

 GlobalSCAPE Authentication does not rely on outside sources for user information. All information in the 

database is: 

o Protected from the operating system  

o Contained within the .aud file located in the Server installation folder (e.g., C:\Documents and 

Settings\All Users\Application Data\GlobalSCAPE\EFT Server Enterprise)  

o Encrypted and can only be modified through the Administrator. 

 Windows Active Directory (NTLM/AD) Authentication. Using this method, the Server assigns permissions 

to users from the NT user database on the system that is running the Server. The Server queries the 

Primary Domain Controller (PDC) for your domain and adds all domain users to the Settings Template 

tree. 

 LDAP (Lightweight Directory Access Protocol) is a protocol for accessing information directories on an 

LDAP Server. 

 ODBC Authentication allows all users in an external ODBC database to have access to the Server. 

 

Once a Site has been created, you cannot change the authentication method. 

DEFINING CONNECTIONS TO THE SERVER 

A Site is similar to a virtual FTP server bound to one or more IP addresses. In the Server hierarchy, a Server consists 

of one or more physical hardware devices (servers) running the Server executable as a system service. Server 

Groups are at the top of the Server's setting hierarchy and allow you to group multiple Servers from a 

management or administrative perspective. Each Server service, running as a single service on a single hardware 

device, can support multiple Sites.  

You cannot run multiple Sites on the same IP address and port. Each Site requires an IP address and port 

combination that is not already claimed by other process or Site. To avoid conflicts, when the same protocol is 

used, each Site requires a distinct IP address (and same port), or the same IP address, but different ports. For 

example, use port 8080 for HTTP instead of 80, or 2121 for FTP instead of 21. You cannot have two Sites trying to 

use port 21 on the same IP address. The two Sites will conflict; the Site that starts first claims the contested port. 

The hardware in the Server's computer does not limit the number of Sites you can set up, at least regarding how 

many NICs (Network Interface Cards) you have. In Windows, you can assign any number of IP addresses to a single 

NIC. 
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In the above example, your internal users could connect to site 1A using the Site's internal IP address 

(192.168.20.134:21) while external users can access site 1C using the host address you designate, such as 

partners.globalscape.com, which resolves to a different IP address on the same port).  

Authentication Types 

Sites can each have a unique authentication provider type, the same authentication provider type, or even share 

the same authentication provider database. For example, Site 1A could use GlobalSCAPE Authentication, Site 1B 

could use Active Directory (AD), and Site 1C could share the AD database.  

 

The service runs under a user account, which must have full administrative rights to the folder in which you 
installed the Server. With administrative rights, the service can save all your settings. If the service does not 
have administrative rights, you lose settings and user accounts whenever you restart the Server service, and 
you need to reset permissions on the computer where the Server service is running. 

You will need the following information to create and configure a Site: 

 Site name, listening IP address, and administrator port 

 Root folder path 

 DMZ Gateway IP address and port, if used 

 SSL/SFTP keys/certificate/ciphers/version information 
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CREATING A SITE 

To create a Site 

1. The Site Setup wizard appears after you complete the Server Setup wizard; otherwise, in the 

Administrator, click Configuration > Create New Site, or right-click anywhere in the Server's tree, then 

click Create New Site.  

 

2. Do one of the following: 

a. To create a high-security Site that complies with PCI DSS, refer to Creating a High Security Site. 

b. To create a standard Site, click Default security settings. 

If PCI DSS compliance is not a requirement, you can use the default security level and manually configure 

advanced security options individually, as needed. 

3. Click Next. The Site Label and Listening IP page appears. 
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4. In the Site label box, type a name a distinguishing name for the Site. MySite appears by default, but 

you can change this to anything you want. 

5. In the Listening IP box, select a specific IP address or keep the (less secure) default of All Incoming if you 

are unsure of the IP addresses. You can specify specific IP addresses later.  

6. Click Next. The Site Root Folder page appears. 
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7. In the Site root box, click Browse to specify the root folder or keep the default displayed in the box. 

8. In the Additional folder options area, select the check boxes as needed: 

a. Select the Automatically create UNIX-style subfolders check box to create Usr, Pub, Bin, and 

Incoming folders with appropriate permissions under the Site's root folder. This is only necessary 

if you are trying to mimic a typical default *nix the Server setup. 

b. Select the Automatically create and assign home folders to newly created users to 

automatically create a user folder under \Site Root\Usr\ when a new user is added, named with 

their username. For example, username jbug might have the folder 

C:\InetPub\EFTRoot\MySite\Usr\jbug. 

 

You must specify home folders for users even if you plan using Active Directory (AD) authentication. 
If Automatically assign home folders to newly created users is enabled, EFT Server creates a virtual 
folder under the Site's physical root that points to the user's home folders assigned in AD. 

9. Click Next. The User Authentication Provider page appears.  
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10. In the Authentication provider list, specify the type of user authentication this Site is to use. (Click a link 

below to skip to that section.)  

 GlobalSCAPE EFT Server Authentication - Does not rely on outside sources for user information. 

All information in the authentication database is protected from the operating system, contained 

within the .aud file located in the Server installation folder (e.g.,  C:\Documents and Settings\All 

Users\Application Data\GlobalSCAPE\EFT Server Enterprise), and encrypted, and can only be 

modified through the Administrator 

 Windows Active Directory (AD) Authentication - Connects to an AD server for user information. 

 LDAP Authentication - Connects to an LDAP server for user information. 

 ODBC Authentication - Connects to an ODBC database for user information. 

For GlobalSCAPE EFT Server Authentication: 

a. Keep the default of GlobalSCAPE EFT Server Authentication. Click Next. The EFT Server 

Authentication page appears.  
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b. The default path to store the user database appears in the box. If you want to store the user database 

in a different location, type the path in the box or click the open icon to find and select or create a 

folder. 

Skip to configuring Perimeter Network Security. 

For Windows Active Directory Authentication 

a. In the Authentication type list, click Windows Active Directory Authentication.  

b. Click Next. The AD Authentication page appears. 
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c. In the Type area, click Active Directory or NTLM to match the authentication method used on 

the Server's domain.  

d. In the Domain area, do one of the following: 

 Click Default if you want to use the authentication database from the computer's 

current domain.  

 Click Specify, then in the box, provide the domain name that contains the 

authentication database. 

e. In the Group area, do one of the following: 

 To allow access to every user in the domain's database, click Everyone.  

 To allow access to only a specific AD Group, click Specify, then in the box, type the 

group name for users that will have access to the Server. 

f. To verify your settings, click Test. 

g. In the Use this user attribute as the logon name box, click the list to specify the attribute to use 

(NT 4 Account Name, Display Name, User Principal Name, Common Name). 

h. In the User list refresh interval box, click the list to select how often you want the Server to 

check the authentication database for new users (server specified, never, or from 5 minutes to 1 

day). 

i. Under When creating home folders for newly created users, click Create a virtual folder or 

Create a physical folder. If you click Create a virtual folder, the virtual folder will point to the 

user's home folder as defined in his/her AD profile. 
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Skip to configuring Perimeter Network Security. 

For LDAP Authentication 

a. In the Authentication type list, click LDAP Authentication, then click Next. The LDAP 

Authentication page appears. 

 

b. In the Server box, type the Server name or IP address. 

c. In the Port box, keep the default port 389 or specify a different port. 

d. In the Base DN box, type the base domain name for the LDAP user database. For example, type: 
dc=forest,dc=intranet,dc=gs  

e. In the User Filter box, type the search filter information. Refer to Advanced LDAP Filtering for a 

detailed explanation of LDAP filtering.  

f. In the Login Attribute box, type a comma-separated list of attributes to retrieve. For example, 

type: 
 

mail,e-mail,name,cn  

g. In the Authentication mode area, click one of the following binding methods to define how the 

client is authenticated: 

o Anonymous  

o Simple requires a username and password. Note that the username must follow the 

syntax for the LDAP server that includes the Common Name and the Domain 

Components of your LDAP server’s distinguished name. For example, the username 

might be the following: 

cn=Manager,dc=forest,dc=intranet,dc=gs 
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For details of creating complex LDAP filters, refer to Advanced LDAP Filtering. 

h. If you are using SSL, select the Bind Using SSL check box, then in the User list refresh interval list, 

click the list to select how often you want the Server to check the database for new users. 

 

The LDAP bind password is encrypted in the FTP.cfg file. 

i. Click Advanced. The LDAP Authentication Advanced Options dialog box appears. 

 

 

j. Specify advanced options based on your requirements. 

 Set timeout - Specify the connection/query timeout (in seconds). This option coupled 

with paging can help you avoid timeouts when querying against large directories.  

 Set search scope - This specifies the depth of the level to search for under BaseDN. 

o BASE - Only the requested object specified in BaseDN is searched. 

o OneLevel - All of the objects just below this object are searched.  

o Subtree - Searches for all the objects within the specified BaseDN object 

recursively. 

 Turn on referral chasing - If you have referral chasing on, the query returns information 

for objects that exist in the LDAP structure, but do not actually exist on the Server to 

which you are connected. The query displays bookmarks to entries that exist elsewhere 

in the network that the Server knows about.  

 Set LDAP Version - LDAP 2 is widely supported and adds anonymous binding and some 

filtering. LDAP 3 extends the features of LDAP 2 by adding paging (server side) and more 

complex filtering. 

 Use Server Page Control - Asks the Server to limit result sets (or pages) to 1000 at a time 

or the value specified under Override search page size, if checked. If Use server page 

control is not selected, client-side paging is used to mitigate timeouts when retrieving 

large directory listings. 

 Override search page size - Overrides the default page size (1000) for client or server-

side page limits. Making the value too large can cause timeouts. Setting the page size 

too small reduces the overall efficiency. 
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 Select attributes - Returns only the specified attributes for the user objects found as 

part of the search query. Specifying only necessary attributes will greatly increase the 

efficiency of your query (since the filtering occurs on the server side). 

k. Click OK to close the LDAP Authentication Advanced Options dialog box. 

l. To test your settings, click Test. The LDAP Query dialog box appears. 

 

 

For details of the LDAP Query dialog box, refer to Testing LDAP Authentication Settings. 

m. Click the X in the upper right corner to close the LDAP Query dialog box. 

n. Specify the path at which the Server will store additional user settings, if different than the 

default (e.g., C:\Documents and Settings\All Users\Application Data\GlobalSCAPE\EFT Server 

Enterprise). 

o. In the User list refresh interval box, specify the frequency at which the Server's user list should 

be refreshed. 

Skip to configuring Perimeter Network Security. 

For ODBC Authentication 

a. Click Next. The ODBC Authentication page appears. 
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b. In the Specify the data source box, type a connection string for the ODBC database. Refer to 

Using a DSN-Less Connection with ODBC Authentication for details of creating the connection 

string, if necessary.  

c. Select the Encrypt user passwords check box to encrypt passwords stored in the database. 

d. In the User list refresh interval list, click the list to specify how often you want the Server to 

check the database for new users.  

 

You change the refresh interval later in the Authentication Options dialog box. 

11. Click Next. The Perimeter Network Security page appears.  
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12. Specify whether to connect the Site to DMZ Gateway.  

 If you choose to connect to DMZ Gateway, specify its IP address and port, then click Test 

Connection. If the DMZ Gateway is properly configured, the test is successful. If the test is not 

successful, click I'm not using the DMZ Gateway - or I'll configure it later. 

 If you have not yet installed or configured DMZ Gateway Server, click I'm not using the DMZ 

Gateway - or I'll configure it later. 

13. Click Next. The Connection Protocols page appears. 
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14. Select one or more check boxes for the protocol(s) that this Site will use to connect to the Server and 

specify the port number for each protocol. The default ports appear in the boxes.  

 

By default, the FTP server in Microsoft IIS binds to port 21 on all IP addresses. If you want to run both 
the IIS FTP server and EFT Server, you need to disable socket pooling for the IIS FTP server.  

15. If you selected FTPS, HTTP, or AS2, define the allowed SSL versions and ciphers. Click SSL options, or skip 

this step and leave the defaults.  
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a. In the Allowed SSL versions list, keep the default of TLS 1.0 and SSL 3.0, or click Auto Negotiable. 

b. In the Allowed ciphers list, select the ciphers in the list or click Manually specify ciphers and provide 

the ciphers in the Command box. (Manually defining ciphers should only be done by advanced users.)  

 

Refer to Using Ciphers for SSL Connections with the Server for a detailed explanation of SSL 
versions and ciphers. If EFT Server is in FIPS mode, only FIPS-approved ciphers are available. 

16. If you selected FTPS, HTTP, or AS2, specify the SSL certificate to use for this Site. Click SSL certs. The SSL 

Certificate Options page appears. 
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 To create a certificate, click Create certificate and follow the prompts in the wizard. (Refer to 

Creating Certificates for details, if necessary.) 

 To use an existing certificate: 

a. In the Certificate box, type the path to the .crt file or click the open icon to find and 

select it. 

b. In the Private key box, type the path to the .key file or click the open icon to find and 

select it. 

c. In the Certificate passphrase and Confirm passphrase boxes, type and confirm the 

passphrase for the certificate pair. 

 

If you do not enable SSL, you will not be able to connect to the Server from a remote the 
Administrator. Refer to SSL Certificate-Based Login, Creating Certificates, Importing a 
Certificate into the Trusted Certificate Database, and Importing Certificates from Microsoft 
IIS 5 for information regarding certificates. If you are using Secure Ad Hoc Transfer, you 
need to configure remote access to the Server. 

17. Click Next to return to the Protocols page. 

18. If you chose SFTP, click SFTP options, and specify the algorithms this Site will use for SFTP. If FIPS mode is 

enabled on the Server for SFTP, only the FIPS-approved algorithms are available. 
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19. Click Next to return to the Protocols page. Click SFTP keys to configure an SFTP key pair. 
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20. Click Next to return to the Protocols page. If you chose AS2 over HTTP/S, click Configure. The AS2 Setup 

Wizard appears.  

 

a. Specify Your AS2 identifier. There is no standard for the AS2 Identifier. You can use your name, your 

company's name, or some other unique name. The Server validates the AS2 identifier to determine 

whether it is unique (not used by another partner on this the Server). If you type an ID that is not 

unique, the field resets to blank. 
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b. Click Next.  

 

c. Specify the AS2 certificate path for signing/encryption, populated by default with the SSL certificate 

paths (if present) for the Server SSL communications. Click the open icons to specify a certificate pair 

or click the blue create link to open the SSL certificate wizard to create a new certificate pair. (You 

can use the same SSL certificate that you are using for the Site.) 

d. Click Next, then click Finish. 

21. Click Next. The Site Setup Completed page appears. 
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22. You are offered the option of running the user creation wizard or quitting the Site Setup wizard and 

creating users later. Click an option, then click Finish.  

 If you chose Run New User Creation wizard, the User Creation wizard Welcome page appears. 

Continue to Creating User Accounts for the procedure. 

You can run the Site Setup wizard again at any time to create additional Sites.  

You can view and modify Site configuration in the Administrator, as described in this chapter.  
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THE SITE INTERFACE 

When you click a Site node on the Server tab, tabs appear in the right pane on which you can configure 

connections to the Sites.  

Refer to the topics below for details of each tab and to the topics in Configuring Sites for details of configuring 

connections to the Site. 

GENERAL TAB OF A SITE 

The General tab is used to change the Site's user authentication settings, view Site statistics, and stop/start the 

Site. 

 

Refer to the topics below for details. 

 Changing a Site's Root Folder 

 Changing the User Database Refresh Rate for a Site 

 Configuring Windows NT Authentication Options 

 Changing and Testing LDAP Authentication Options 

 Configuring ODBC Authentication Options 

 Starting and Stopping a Site 

 Viewing Site Statistics 
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CONNECTIONS TAB OF A SITE 

The Connections tab of a Site is used to specify listener settings, transport protocols, the SSL certificate for the 

Site, connection limits, the IP address access/ban list, Denial of Service (DoS) settings, and for enabling Web 

Services and/or the account management page. 

 

Refer to the topics below for more information. 

 Listener Settings 

 Network Usage Settings 

 Configuring FTP Transfers on the Site 

 Site-Level Blocking and Timeout Settings 

 Modifying Site Messages (FTP) 

 Multi-Part Transfers 

 SFTP 

 Configuring HTTP or HTTPS Transfers on the 

Site 

 Redirecting HTTP to HTTPS 

 SSL 

 Configuring the AS2 Module 

 Transfer and Connection Settings
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SECURITY TAB OF A SITE 

The Security tab of the Site node is used to specify password security, account security, and data security settings. 

 

Refer to the topics below for details. 

 Password Security Settings 

 Account Security Settings 

 Data Security Settings 

CHANGING A SITE'S ROOT FOLDER 

The Site root folder is specified when you create a new Site; however, you can later change a Site’s root folder.  

 

If you change a Site's root folder, all previously configured user and Group folder permissions related to that 
Site are deleted. You will have to redefine the permissions. 

To change the Site root folder 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the General tab. 
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4. In the Site root folder box, click the open icon  to specify a new Site root folder. (The path must be a 

physical folder, not a virtual folder.) No verification is performed to determine if you have typed a valid 

path, so using the open icon to browse for a path is recommended over typing the path. 

5. Click Apply to save the changes on the Server. 

 

Because of a limitation of the HTTP protocol, when a connection is established using HTTP, the client (e.g., a 
Web browser) shows the root folder, not the user's home folder.  

CHANGING THE USER DATABASE REFRESH RATE 

When you define the Server, you specify the refresh rate for all Sites that connect to that Server. You can override 

the refresh rate at the Site level. You can also manually refresh the Administrator to see any user account changes 

(View > Refresh Users Database).   

To change the refresh rate 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the General tab. 
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4. Next to the User auth manager box, click Configure. The dialog box that appears depends on the type of 

user authentication the Site is using, but each of them have the Enable Automatic Refresh every check 

box: 

 

5. Select the Enable Automatic Refresh every check box and specify the frequency with which to refresh the 

user list from the authentication database; clear the check box if you do not want the Site's user list to 

refresh automatically. 

6. Click OK, then click Apply to save the changes on the Server. 

WINDOWS ACTIVE DIRECTORY AUTHENTICATION 

The topics below provide information regarding defining and configuring a Site that uses AD or NTLM 

Authentication. 

CHANGING WINDOWS NT AUTHENTICATION OPTIONS 

You cannot change the authentication method after you have created a Site; however, if you need to change the 

authentication options, you can do so on the General tab of the Site.  

To edit the AD authentication options for a Site 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the General tab. 

4. Next to the User auth manager box, click Configure. The Windows NT Authentication Options dialog box 

appears. 
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5. To specify that the user list is to be updated automatically, select the Enable Automatic Refresh 

every check box, then specify how often you want the Server to check the authentication database for 

new users. Clear the check box if you do not want the Site's user list to refresh automatically 

6. When you create the Site, you specify either Active Directory or NTLM Authentication. If you need to 

change this, click the appropriate option to match the authentication method used on the Server's 

domain.  

7. In the Domain Context area, do one of the following: 

 Click Use default if you want to use the authentication database from the computer's current 

domain.  

 Click Custom, then in the Context box, provide the domain name that contains the 

authentication database. 

8. In the Allow access to the following group area, do one of the following: 

 To allow access to every user in the domain's database, click Everyone.  

 To allow access to only a specific AD Group, click Custom, then in the Group box, type the group 

name for users that will have access to the Server. 

9. In the Use this user attribute as the logon name box, click the list to specify the attribute to use (NT 4 

Account Name, Display Name, User Principal Name, Common Name). 

10. In the When creating home folders for newly added users area, specify whether you want the Site to 

Create a virtual folder pointing to the user's home folder as defined by AD or Create a physical folder 

under the site root folder using the user's login name. 

11. To verify your settings, click Test. 

12. Click OK to save the settings. 

13. Click Apply to save the changes on the Server. 
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LOCAL SECURITY POLICY SETTING WHEN USING ACTIVE DIRECTORY AUTHENTICATION 

To use NT/AD authentication, users need "Log On Locally" access (allows a user to log on as if they were at the 

computer's keyboard) to the Server computer on which EFT Server is installed, no matter which kind of computer it 

is or what role it plays on the network, including a domain controller. 

 

The Server service runs under a user account, which must have full administrative rights to the folder in which 
you install the Server. With administrative rights, the service can save all your settings. If the service does not 
have administrative rights, you will lose settings and user accounts whenever you restart the Server service, 
and you will need to reset permissions on the computer on which the Server service is running. 

GlobalSCAPE Customer Support recommends creating an AD account with adequate privileges to all of the 

resources (AD query, network shares) required for the Site. There is no set formula for the type of account needed, 

because network configurations vary. Some EFT Server customers might pull users across multiple domains and 

might want to restrict that access. Consult with your AD network administrator for assistance, if necessary. 

 

LDAP AUTHENTICATION 

The topics below provide information regarding defining and configuring a Site with LDAP Authentication.  

(Available in EFT Server Enterprise) 

UNDERSTANDING LDAP AUTHENTICATION 

EFT Server Enterprise supports using an LDAP (Lightweight Directory Access Protocol) database for authenticating 

users. LDAP is a protocol used for accessing information directories on an LDAP Server. A typical LDAP server is a 

simple network-accessible database in which user account lists are stored and includes information about those 

users and the privileges assigned to each user. LDAP support on the Server allows you to authenticate users 

through connection to LDAP servers such as Novell eDirectory server, OpenLDAP, Sun ONE Server, Microsoft’s 

Active Directory server, and Tivoli Access Manager.  

This help file is not intended as an LDAP tutorial. For information about LDAP, download the Microsoft white paper 

"Understanding LDAP" at http://download.microsoft.com/download/3/d/3/3d32b0cd-581c-4574-8a27-

67e89c206a54/uldap.doc.  

CONNECTING TO AN LDAP SERVER 

(Available in EFT Server Enterprise) When you create a Site that uses LDAP authentication, you will need to 

provide the following information: 

 IP address/Domain Name of the LDAP server 

 Port of the LDAP server. The default is port 389; port 636 for SSL connections. 

 Base DN base distinguished name that specifies the necessary domain components of the LDAP server. 

Some LDAP systems, such as Sun ONE Server and Microsoft’s Active Directory server, require the 

organizational unit ("ou") that houses the users on that LDAP server to be included in the BaseDN to allow 

users to authenticate successfully. The organizational unit is the parent object that contains the user 

objects. For example, if the classObject that holds user accounts is person, the hierarchical parent 

node/container could be the organizational unit people. If the organizational unit is required by your 

LDAP server, prepend it to the distinguished name. For example: 

o With Organizational Unit: 

http://download.microsoft.com/download/3/d/3/3d32b0cd-581c-4574-8a27-67e89c206a54/uldap.doc
http://download.microsoft.com/download/3/d/3/3d32b0cd-581c-4574-8a27-67e89c206a54/uldap.doc
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ou=people,dc=forest,dc=intranet,dc=gs 

o Without Organizational Unit: 

dc=forest,dc=intranet,dc=gs 

 User Filter that the Server uses to query the LDAP server for a list of users. The default setting is: 

objectClass=person  

This finds the LDAP entries that are part of the objectClass person; that is, it retrieves the users on 

the LDAP server that belong to the person ObjectClass. 

 Attribute that denotes user names in the LDAP database. This allows you to specify the attribute from the 

queried list of users that denotes user names. Commonly used attributes are cn or uid.  

 User Information defines how the client is authenticated. When you configure an LDAP Site, you are 

asked to choose one of the following binding methods: 

o Anonymous  

o Simple requires a username and password. Note that the username must follow the syntax for 

the LDAP server that includes the Common Name and the Domain Components of your LDAP 

server’s distinguished name. For example, the username might be the following: 

cn=Manager,dc=forest,dc=intranet,dc=gs 

 Advanced Options - You can specify SSL encryption and the frequency with which the user list is 

refreshed. 

 

When you use LDAP as the authentication method, the Server pulls the user account list and the 
authentication from the LDAP Server. Group lists, Group membership, VFS Groups, and VFS User permissions 
are handled by the Server and stored in the local AUD and CFG files. These permissions must be configured 
and maintained with the Administrator or through the COM interface.  

ADVANCED LDAP FILTERING 

(Available in EFT Server Enterprise) 

The Server’s LDAP authentication manager allows you to create complex filters for retrieving sub-sets of users 

across your LDAP directory, similar to retrieving users only in a specific group in Active Directory. The Server 

follows the filtering conventions outlined in http://www.faqs.org/rfcs/rfc2254.html.  

 

LDAP filtering is a complex task that requires an advanced understanding of LDAP. For detailed information, 
please refer to RFC 2252 - Lightweight Directory Access Protocol (v3): Attribute Syntax Definitions, RFC 2251 - 
Lightweight Directory Access Protocol (v3), and RFC 2254 - The String Representation of LDAP Search Filters. 
The operators used in the search filter (&, |, =, ~=, etc.) are defined in RFC 2254.  

When you Create a Site that Uses LDAP Authentication, you must specify the User Filter on the LDAP 

Authentications page of the wizard. You can also specify or edit the user filter in the LDAP Authentication Options 

dialog box. 

The default User Filter is (objectClass=person). This means that every single type person object will be 

returned in the search result, which may be highly inefficient if you want to authenticate only the users in your 

marketing department. Each entry in an LDAP tree consists of one or more attributes that define that entry. Each 

attribute has a name (attribute type) and is assigned one or more values. The entry itself is defined using a unique 

identifier, such as its Distinguished Name (dn), that is constructed from selected attributes in the entry followed by 

the parent’s dn, such as: cn=john smith,dc=example,dc=com. 

http://www.faqs.org/rfcs/rfc2254.html
http://www.faqs.org/rfcs/rfc2252.html
http://www.faqs.org/rfcs/rfc2251.html
http://www.faqs.org/rfcs/rfc2254.html
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Below is a sample entry, with its attributes and values: 

dn: cn=Jane Smith,dc=example,dc=com 

cn: Jane Smith 

givenName: Jane 

sn: Smith 

telephoneNumber: 555 1234 

telephoneNumber: 555 5678 

mail: jsmith@example.com 

manager: cn=Alma Mia,dc=example,dc=com 

objectClass: inetOrgPerson 

objectClass: organizationalPerson 

objectClass: person 

objectClass: top 

The User Filter field appends a filter to the LDAP search query so that only the entries that match the filter are 

retrieved. A default filter is provided that verifies the ObjectClass attribute of a particular entry is of type person. 

There can be many other types, such as printer. Suppose you only want to pull users from an Organization Unit 

(ou) container (similar to a group under AD) that is a couple of levels removed from the root Organization (o) 

container. In this case, simply applying a filter where (objectClass=person) pulls users from the entire 

organization, instead of just the desired OU. Pulling users from the desired OU is accomplished by defining a more 

complex filter, as described below.  

Below is an example of an LDAP directory with multiple ous under an o: 

[-] o=GlobalSCAPE 

[-] ou=ResearchAndDevelopment 

cn=jbond 

cn=jsmith 

[-] ou=HumanResources 

cn=jdoe 

[+] ou=Marketing 

[+] ou=PM 

Below are the entry properties for ResearchAndDevelopment and for one of the entries contained within that ou. 

For ResearchAndDevelopment:  

DN: ou=ResearchAndDevelopment,o=MyOrganization 

ObjectClass: Top 

ObjectClass: OrganizationalUnit 

ObjectClass: ndsLoginProperties 

ObjectClass: ndsContainerLoginProperties 

Ou: ResearchAndDevelopment 

And for jbond : 

DN: cn=jbond,ou=ResearchAndDevelopment,o=MyOrganization 

ObjectClass: Person 

ObjectClass: ndsLoginProperties 

ObjectClass: Top 

GroupMembership: cn=TestGroup,o=MyOrganization 

sn: bond 

cn: jbond 
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Suppose you want to pull all users of ObjectType = Person from the R&D and HR ous, but not any users from 

Marketing and PM. The filter would be: 

(&(objectClass=person)(|(ou:dn:=ResearchAndDevelopment)(ou:dn:=HumanResources))) 

The filter above is called an extensible match search because it specifies an attribute name: ou and the DN’s 

attributes should be considered as part of the entry. 

If ou:= rather than ou:dn:= had been used, no results would have been returned, because the 

ResearchAndDevelopment entry does not match the objectClass=person criteria and jbond 

(which does have an objectClass=person ) does not match the ou=ResearchAndDevelopment 

criteria EXCEPT for the fact that it does have ou=ResearchAndDevelopment as part of that entry's 

Distinguished Name (dn). Therefore ou:dn:=ResearchAndDevelopment DOES return jbond as one of the 

users in the search result.  

Below is a similar query, except that Mr. Bond is excluded using an exclusion filter and including everyone else 

under R&D and HR. 

(&(&(!(cn:dn:=jbond))(|(ou:dn:=ResearchAndDevelopment)(ou:dn:=HumanResources)))(obj

ectclass=Person)) 

Here is an example of pulling all users from all ous except those in the R&D and HR containers: 

(&(!(|(ou:dn:=ResearchAndDevelopment)(ou:dn:=HumanResources)))(objectClass=person)) 

The filter above includes all entries that have an ObjectClass attribute equal to person, but do not return any 

entries where ResearchAndDevelopment or HumanResources is specified as an ou attribute in the dn. 

Here is one last example that retrieves a user with an objectClass=person attribute and a g 

roupMembership attribute equal to cn=TestGroup,o=MyOrganization.  

(&(objectclass=Person)(groupMembership=cn=TestGroup,o= MyOrganization)) 

The use of value=value=value in the above example can be confusing. In this case the entire string that 

follows the first equal sign after groupMembership must match cn=TestGroup,o=MyOrganization, 

which is the case for the jbond entry. 

Once you have defined a filter, click Test to verify the results, before continuing with creating the Site or editing 

the LDAP authentication options. 

More examples: 

Search filter  Description 

(objectClass=*) All objects 

(&(objectCategory=person)(objectClass=user)(!cn=andy)) All user objects but "andy" 

(sn=sm*) 
All objects with a surname that starts 
with "sm" 

(&(objectCategory=person)(objectClass=contact)(|(sn=Smith)(sn=Johnson))) 
All contacts with a surname equal to 
"Smith" or "Johnson" 
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CHANGING AND TESTING LDAP AUTHENTICATION OPTIONS 

(Available in EFT Server Enterprise) 

The LDAP Authentication Options dialog box is used to edit and test the Server's connection to the LDAP server 

after you have configured LDAP Authentication. 

To edit or test LDAP authentication settings 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the General tab. 

4. Next to the User auth manager box, click Configure. The LDAP Authentication Options dialog box 

appears. 

 

5. To specify that the user list is to be updated automatically, select the Enable Automatic Refresh 

every check box, then specify how often you want the Server to check the authentication database for 

new users. Clear the check box if you do not want the Site's user list to refresh automatically. 

6. In the Server box, type the Server name or IP address. 

7. In the Port box, keep the default port 389 or specify a different port. 

8. In the Base DN box, type the base domain name for the LDAP user database. For example, type: 
dc=forest,dc=intranet,dc=gs  

9. In the User Filter box, type the search filter information. Refer to Advanced LDAP Filtering for a detailed 

explanation of LDAP filtering.  
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10. In the Attribute box, type a comma-separated list of attributes to retrieve. For example, type: 
 

mail,e-mail,name,cn  

11. In the User Information area, click one of the following binding methods to define how the client is 

authenticated: 

o Anonymous  

o Simple requires a username and password. Note that the username must follow the syntax for 

the LDAP server that includes the Common Name and the Domain Components of your LDAP 

server’s distinguished name. For example, the username might be the following: 

cn=Manager,dc=forest,dc=intranet,dc=gs 

 

 

For details of creating complex LDAP filters, refer to Advanced LDAP Filtering. 

12. If you are using SSL, select the Use SSL check box. 

 

The LDAP bind password is encrypted in the FTP.cfg file. 

13. To change the advanced options (SSL, timeout, scope, etc.), click Advanced and specify advanced options 

based on your requirements. 

 

 Set timeout - Specify the connection/query timeout (in seconds). This option coupled with 

paging can help you avoid timeouts when querying against large directories.  

 Set search scope - This specifies the depth of the level to search for under BaseDN. 

o BASE - Only the requested object specified in BaseDN is searched. 

o OneLevel - All of the objects just below this object are searched.  

o Subtree - Searches for all the objects within the specified BaseDN object recursively. 

 Turn on referral chasing - If you have referral chasing on, the query returns information for 

objects that exist in the LDAP structure, but do not actually exist on the Server to which you are 

connected. The query displays bookmarks to entries that exist elsewhere in the network that the 

Server knows about.  

 Set LDAP Version - LDAP 2 is widely supported and adds anonymous binding and some filtering. 

LDAP 3 extends the features of LDAP 2 by adding paging (server side) and more complex filtering. 
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 Use Server Page Control - Asks the Server to limit result sets (or pages) to 1000 at a time or the 

value specified under Override search page size, if checked. If Use server page control is not 

selected, client-side paging is used to mitigate timeouts when retrieving large directory listings. 

 Override search page size - Overrides the default page size (1000) for client or server-side page 

limits. Making the value too large can cause timeouts. Setting the page size too small reduces the 

overall efficiency. 

 Select attributes - Returns only the specified attributes for the user objects found as part of the 

search query. Specifying only necessary attributes will greatly increase the efficiency of your 

query (since the filtering occurs on the server side). 

 To test your settings, click Test. The LDAP Query dialog box appears. 

 

 

The query returns the following information: 

 LDAP settings used, which is helpful for troubleshooting 

 Success or failure of the connections, and failure reason 

 Success or failure of attempt to BIND using the credentials provided, and failure reason 

 Record set ("Query results") in comma delimited order 

 

"No Referrals: TRUE" indicates that Turn on referrals chasing is NOT selected.  

14. Click the X in the upper right corner to close the LDAP Query. 

 

If you need troubleshooting assistance, copy the text to the clipboard and provide this information to 
GlobalSCAPE technical support. 

15. Click OK to close the LDAP Authentications dialog box. 

16. Click Apply to save the changes on the Server. 
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ODBC AUTHENTICATION 

The topics below provide information regarding configuring a Site for ODBC Authentication. 

USING AN ODBC DATA SOURCE FOR USER AUTHENTICATION 

The Server allows you to use any ODBC-compatible database as a source for user authentication. You may add and 

remove users and set certain permissions using your existing database utility or through the Administrator. The 

Server uses ADO to communicate with the authentication databases using "generic" SQL statements.  

To use an external ODBC data source you must: 

 Create tables in an ODBC data source.  

 Establish a System Data Source Name (DSN) in the ODBC Source administration tool.  

 Configure EFT Server to use the System DSN.  

 install Microsoft Data Access Components (MDAC) 2.6 or higher.  

 

If you are using the Server on Windows XP, you do not need to install MDAC 2.6 or higher on your computer. 
For any other Windows operating system, you can download MDAC 2.6 or 2.7 from 
http://www.microsoft.com/data/download.htm. If you are using an Access database, you may also need to 
download a Jet driver. For information about Jet drivers, refer to Article ID: 282010 on the Microsoft Support 
pages: http://support.microsoft.com/kb/282010/en-us. For information about MDAC 2.6, refer to Article ID: 
271908 on the Microsoft Support pages: http://support.microsoft.com/kb/271908/en-us. 

CREATING TABLES FOR YOUR ODBC DATA SOURCE 

You must create two tables in the database for your data source. A SQL script is provided that will create the 

necessary tables.  

The ftpserver_users table lists the user accounts and permissions groups in the Site. A user account uses the 

information from all fields. A permission group uses only the ID, Name, and Description fields and is used only for 

organizational purposes, not as a user login. 

Field Name  Data Type  Field 
Size  

Description  

ID (Primary Key)  AutoNumber  Long 
Integer  

User ID  

Name  Text  50  Login name for this user  

Password  Text  200  Password for this user  

Description  Text  200  Description for this user 

Type  Number  Integer  0=Group, 1=User  

Password_Type  Number  Integer  Standard, OTP_MD4, OTP_MD5: Differentiates Regular vs. SKEY (OTP) 
password type. 0 = standard FTP password, 1=MD4 OTP, 2=MD5 OTP.  

MD_Iter  Number  Long 
Integer  

Current MDX iteration - used by OTP accounts only  

http://www.microsoft.com/data/download.htm
http://support.microsoft.com/kb/282010/en-us
http://support.microsoft.com/kb/271908/en-us
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Field Name  Data Type  Field 
Size  

Description  

OTP_Seed  Text  16  OTP Seed to be used for MDX Passwords - used by OTP accounts only.  

Anonymous  Number  Long 
Integer  

0=Normal Password, 1=Any password  

Anonymous_Email  Number  Long 
Integer  

0=Any anonymous password, 1=e-mail password required  

Fullname  Text  200  User's full name  

Email  Text  200  User's e-mail address  

Phone  Text  200  User's phone number  

Pager  Text  200  User's pager number  

Fax  Text  200  User's fax number  

Comments  Text  200  User comments  

Enabled  Number  Integer  0=Account disabled, 1=Account enabled  

HomeDirectory Text 512 Legacy field no longer used, but must be present in the database. 

SettingsLevel Text 200 Name of user's Settings Template. 

The ftpserver_ids organizes users into "groups" of permission levels. For each permission Group to which a user 

belongs there should be one entry in the table below. 

Field 
Name  

Data Type  Field 
Size  

Description  

ID  AutoNumber  Long 
Integer  

Unique ID for the record (key field).  

User_ID  Number  Long 
Integer  

This value refers to a user record in the ftpserver_users table. A corresponding 
(where ftpserver_ids.User_ID = ftpserver_users.ID) ftpserver_users record 
must exist with Type = 1.  

Group_ID  Number  Long 
Integer  

This value refers to the Settings Template that the User_ID user record belongs 
to. A corresponding (where ftpserver_ids.Group_ID = ftpserver_users.ID) 
ftpserver_users record must exist with Type = 0.  
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SCRIPT FOR CREATING NECESSARY ODBC TABLES 

The following SQL script creates the tables necessary to run on the Server: 

if exists (select * from sysobjects where id = object_id(N'[dbo].[ftpserver_ids]') 

and OBJECTPROPERTY(id, N'IsUserTable') = 1) 

drop table [dbo].[ftpserver_ids] 

GO 

if exists (select * from sysobjects where id = 

object_id(N'[dbo].[ftpserver_users]') and OBJECTPROPERTY(id, N'IsUserTable') = 1) 

drop table [dbo].[ftpserver_users] 

GO 

CREATE TABLE [dbo].[ftpserver_ids] ( 

[User_ID] [int] NULL , 

[Group_ID] [int] NULL 

) ON [PRIMARY] 

GO 

CREATE TABLE [dbo].[ftpserver_users] ( 

[ID] [int] IDENTITY (1, 1) NOT NULL , 

[name] [varchar] (50) NULL , 

[password] [varchar] (200) NULL , 

[description] [varchar] (200) NULL , 

[type] [int] NULL , 

[password_type] [int] NULL , 

[md_iter] [int] NULL , 

[otp_seed] [varchar] (16) NULL , 

[anonymous] [int] NULL , 

[anonymous_email] [int] NULL , 

[FullName] [varchar] (200) NULL , 

[Email] [varchar] (200) NULL , 

[Phone] [varchar] (200) NULL , 

[Pager] [varchar] (200) NULL , 

[Fax] [varchar] (200) NULL , 

[Comments] [varchar] (200) NULL , 

[Enabled] [int] NULL , 

[HomeDirectory] [varchar] (512) NULL , 

[SettingsLevel] [varchar] (200) NULL 

) ON [PRIMARY] 

GO 

ESTABLISHING A SYSTEM DATA SOURCE NAME (DSN) 

After you have created your database, you must associate it with your system by establishing a Data Source Name 

(DSN). A DSN is a data structure that contains the information about a database that an Open Database 

Connectivity (ODBC) driver needs to connect to it, such as the name, directory, and driver of the database, and the 

ID and password of the user. 

To use a DSN-less connection with ODBC authentication, refer to Using a DSN-Less Connection with ODBC 

Authentication. 
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To establish a system DSN 

1. In Windows, click Control Panel, Administrative Tools > Data Sources (ODBC). The ODBC Data Source 

Administrator appears.  

 

 

2. Click the System DSN tab. 
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3. Click Add. The Create New Data Source dialog box appears. 

 

 

4. Click the appropriate driver on the list. For example, to use a Microsoft Access database, click Driver do 

Microsoft Access (*.mdb). 

5. Click Finish. The ODBC Microsoft Access Setup dialog box appears. 

 

 

6. Type the Data Source Name and Description. The default DSN is GSFTP Server. 

7. In the Database area, click Select to specify the database file to use, then click OK. 

8. Click OK to close the ODBC Microsoft Access Setup dialog box and save the changes. 
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USING A DSN-LESS CONNECTION WITH ODBC AUTHENTICATION 

You can use a DSN-less connection to create an ODBC connection between the Server and the database, using a 

connection string. Connections made in this way are called DSN-less, because they do not require the system 

administrator to create an ODBC DSN. Rather than relying on information stored in a file or in the system registry, 

DSN-less connections specify the driver name, and all driver-specific information in the connection string. The 

connection strings described below combine all the information the Server needs to connect to the database. If 

you have several simultaneous database connections, a DSN-less connection may be slightly faster than a DSN 

connection; however, a DSN-less connection is hard-coded to use a certain driver, user identity, and network 

location, and needs to be updated when the database parameters change. It is recommended that you use a DSN 

whenever possible. 

 

MDAC version 2.7 or higher must be installed to use a DSN-less connection. 

To create a Site with a DSN-less connection  

1. Follow the procedure in Configuring ODBC Authentication Options. 

2. In the Authentication Provider Options dialog box, type the connection string per the guidelines below. 

 

 

To create the string for a DSN-less connection  

You must know the correct driver to use with your database. Create a connection string as described below and 

type it into the Authentication Provider Options dialog box. The connection string includes the name of the driver 

you need for your database, the location of your database, the name of your database, and, if necessary, a user 

name and password to access the database. Connection strings are lists of keywords and associated values; each 

keyword identifies a particular connection attribute.  

For local databases, the connection string must include:  

 Provider [Provider=] 

 Driver [DRIVER=] 

 Database path and name, including the file extension [Dbq=] 

 Username [Uid] and Password [Pwd] are required only if the database is password protected 

  



EFT Server™ version 6 

222  

For remote databases, your connection string must include: 

 Driver [DRIVER=] 

 Server [SERVER] 

 Database [DATABASE] 

 Username [UID] 

 Password [PWD] 

Examples  

 If you are pointing to an Access 2000 database on a local computer named Example that is in the xyz sub-

folder of your c drive, the connection string is: 

Provider=MSDASQL;Driver={Microsoft Access Driver 

(*.mdb)};Dbq=c:/xyz/Example.mdb;Uid=;Pwd=; 

 

With some installations, you may need to add a pointer to a Microsoft Access workgroup file as well 
as the username and password. A default installation of Access does not require this. 

 If you have a remote MYSQL database named Example your connection string is: 

Provider=MSDASQL;DRIVER={MySQL ODBC 3.51 

Driver};SERVER=10.10.10.1;DATABASE=Example;UID=myusername;PWD=mypassword;  

 

Do not put any line breaks in your connection strings. 

CHANGING ODBC AUTHENTICATION OPTIONS 

When you create a Site, you specify the user database authentication method. You cannot change the 

authentication method after you have created a Site, however, if you need to change the authentication options, 

you can do so from the Site Options tab. The options available in the Authentication Provider Options dialog box 

change depending on which authentication method the Site uses. 

To edit the authentication options for a Site 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the General tab.  

4. Next to the User auth manager box, click Configure. The Authentication Provider Options dialog box 

appears. 
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5. To specify that the user list is to be updated automatically, select the Enable Automatic Refresh 

every check box, then specify how often you want the Server to check the authentication database for 

new users. Clear the check box if you do not want the Site's user list to refresh automatically. (You can 

also manually refresh the Administrator to see any changes (View > Refresh Users Database).  

6. In the text box, edit the connection string, as needed. Refer to Using a DSN-Less Connection with ODBC 

Authentication for details of how to create a connection string depending on the type of database to 

which you are connecting. 

7. Click OK to close the dialog box. 

8. Click Apply to save the changes on the Server. 

STARTING OR STOPPING A SITE 

You might occasionally need to stop and restart a Site, such as when you create and assign a certificate to a Site or 

configure the DMZ Gateway to connect to a Site. 

To start or stop a Site 

1. In the Administrator, connect to the Server, then click the Server tab.  

2. In the left pane, click the Site that you want to start or stop. 

3. In the right pane, click the General tab. 

 

4. Do one of the following: 

 Click Stop. The Site status changes to Stopped. 

 Click Start. The Site Status changes to Started. 
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VIEWING SITE STATISTICS 

In the Administrator, you can view the status of the Site in real time, such as number of users connected, average 

speed, the number of active Web Transfer Clients sessions, and so on.  

To monitor current statistics on the Site 

1. In the Administrator, connect to the Server and click the Server tab.  

2. In the left pane, click the Site that you want to monitor. 

3. In the right pane, click the General tab.  

 

The Site's information appears in the Statistics area.  

 Site status: Displays "Running" or "Stopped". You can also stop and start the Site. 

 Start date/time: Displays the date and time that the Site was last started. 

 Last modified time: Displays the date and time that the Site was last modified. 

 Last modified by: Displays the username of the user who last modified the Site . 

 Users connected: Displays the number of users who are currently logged in to the Site . 

 Users defined: Displays the number of user accounts defined on the Site. 

 Web Client Sessions: Displays the number of sessions in use/available. 

 Active uploads: Displays the number of uploads in progress. 

 Active downloads: Displays the number downloads in progress. 

 Average speed: Displays the average transfer speed. 
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LISTENER SETTINGS 

The topics below provide the procedures for configuring listener settings and protocols for the Site. 

LISTENER SETTINGS 

FTP, HTTP, AS2, SFTP, and SSL connections are configured at the Site level and can be enabled or disabled at the 

Site or Settings Template, or per user. 

 

If the check box contains a gray check mark, the user or Settings Template is inheriting permission from the 
parent level. 

To enable a connection protocol on a Site 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Do one or more of the following: 

 To allow/disable FTP access, select/clear the FTP check box, then click FTP Config to configure 

FTP Settings. 
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 To allow/disable FTPS (SSL/TLS) access, select/clear the FTPS (SSL/TLS) check box, then click FTP 

Config to configure FTP Settings, and next to SSL certificate settings, click Configure to configure 

SSL certificate settings. 

 To allow/disable the SFTP access, select/clear the SFTP (SSH2) check box, then click SFTP Config 

to configure SFTP authentication options. 

 To allow/disable HTTP access, select/clear the HTTP check box. 

 To allow/disable HTTPS access, select/clear the HTTPS (SSL) check box, then, next to SSL 

Certificate settings, click Configure to configure SSL certificate settings. 

 To allow/disable AS2 access, select/clear the AS2 check box. (This check box is disabled if HTTP or 

HTTPS is disabled.) Click AS2 Config to configure AS2 connections to the Site, then, next to SSL 

certificate settings, click Configure to configure SSL certificate settings. 

 To allow/disable Web Services, select/clear the Enable Web Services check box. 

 To redirect all plaintext HTTP traffic to HTTPS, select the Redirect all plaintext HTTP traffic to 

HTTPS check box. (HTTPS must be selected first.) 

 To enable account management over HTTP or HTTPS, select the Enable account management 

over HTTP/S check box. The IP address for account management appears in the adjacent text 

box. It is not editable, but you can copy it to paste into e-mails. 

5. Click Apply to save the changes on the Server.  

 

CHANGING A SITE'S IP ADDRESS OR PORT 

A Site's IP address and port are specified when the Site is created. You can change the IP address and ports using 

the procedure below. 

To change the listening (incoming) IP address and/or port 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Connections tab. 
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4. In the Listening IP address list, click the IP address for the Site. The list displays only the IP addresses on 

the computer and All Incoming; you cannot type in an address. 

5. Specify the port number for each of the enabled protocols.  

6. Click Apply to save the changes on the Server. 

FTP 

The topics below provide the procedures for configuring FTP on the Site. To configure FTP for users and Settings 

Templates, refer to FTP Settings for Settings Templates and Users. 

FTP SETTINGS FOR THE SITE 

 

If you specify plain-text FTP for an HS-enabled Site, the Server prompts you to disable these unsecure 
protocols, or continue with reason.  

The FTP protocol is an interactive file-transfer mechanism that enables file transfers between Internet sites, or, 

more specifically, between two systems. It was created for transferring files independently of the operating system 

used, for example between a Macintosh and Windows PC. FTP’s more notable features include handling for 

specific error situations and ensuring that a file sent from point A to point B will get there reliably.  

The FTP protocol specification (RFC 959) was published many years ago when security was not a priority issue. As 

security became a concern, secure mechanisms such as SSL and TLS were adapted to help protect the FTP session 

from being intercepted or exploited. The Server provides security with FTPS (using SSL/TLS).  
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CONFIGURING FTP TRANSFERS ON THE SITE 

You can configure FTP connections to the Site on the Site's Connections tab. You can enable or disable FTP 

transfers at the Site, Setting Template, or per user.  

 

For information about how to configure your firewall to allow FTPS connections to the Server, refer to your 
firewall's user guide or knowledge base. 

To configure FTP transfers at the Site  

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Select the FTP, FTPS (SSL/TLS) - Explicit, or FTPS (SSL/TLS) - Implicit check box. 

5. Specify the port used for the connection (by default, 21 for plain FTP or 990 for FTPS Implicit). 

6. Click FTP/S Configure. The FTP Settings dialog box appears. 
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7. Configure one or more of the following options, as needed: 

 Allowing Site-to-Site Transfers (FXP) 

 Allowing or Disallowing Client Anti-Timeout Schemes (NOOP) 

 Allowing Multipart Transfers (COMB Command)  

 File Integrity Checking (XCRC) 

 Specifying a PASV IP or PASV Port Range 

 Connection Banner Message 

 User Limit Message 

 Exit Messages 

8. Click OK to close the dialog box. 

 Click Apply to save the changes on the Server. 

10. If you selected FTPS (SSL/TLS), assign an SSL certificate to use. 

SPECIFYING A PASV IP OR PASV PORT RANGE 

If the Server is behind a firewall or NAT device, you may need to specify the Server's IP address or range of ports 

used when issuing IP:PORT information to clients. If you specify a PASV (passive) mode port range, you must open 

the same range of ports on your firewall.   
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To specify a PASV connection through a range of ports 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Click FTP/S Config. The FTP Settings dialog box appears. 
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5. Select the Assign PASV mode IP address check box. 

6. In the IP box, specify the Site's IP address as it should be seen by those outside of your network. 

 

This usually applies to SSL sessions when the NAT or firewall device cannot see nor properly map the 
internal IP address to connect to the Server. This also applies if the NAT or firewall device is 
misconfigured. You should first try connecting to the Server with this box left as is.  

7. In the Port Range boxes, specify the range of ports the Server uses for PASV connections. 

 

Use this setting primarily to limit the amount of ports used for the data connection portion of the 
session, especially when the firewall or NAT device was configured to only allow traffic on certain 
ports.  

8. Click OK to close the dialog box. 

9. Click Apply to save the changes on the Server. 

 

If you specify a PASV mode port range, you must open the same range of ports on your firewall.  

 

ALLOWING SITE-TO-SITE TRANSFERS (FXP) 

Although site-to-site transfers (FXP command) can expedite what otherwise could be a slow transfer, many 

administrators consider site-to-site transfers a security risk, exposing servers to "port theft" or "FTP by proxy" 

attacks. Depending on how your servers are configured, you might want to block these types of transfers.  



EFT Server™ version 6 

232  

To allow or block Site-to-Site transfers 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Click FTP/S Config. The FTP Settings dialog box appears. 
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5. Do one of the following: 

 To allow transfers, select the Allow site-to-site transfers (FXP) check box. 

 To block transfers, clear the Allow site-to-site transfers (FXP) check box. 

6. Click OK to close the FTP Settings dialog box. 

7. Click Apply to save the changes on the Server. 

ALLOWING CLIENT ANTI-TIMEOUT SCHEMES (NOOP) ON THE SITE 

Many FTP clients send random commands such as REST 0, PWD, TYPE A, LIST, etc., to the FTP server to keep the 

session alive while the client is idle. Many FTP clients send a NOOP command to the Server during idle times to 

keep the connection alive. You can choose whether to allow the NOOP command. If you disallow the NOOP 

command, it will be considered an invalid command and treated according to your settings under Disconnect after 

<n> invalid commands.  

To allow or disallow the NOOP command 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure.  

3. In the right pane, click the Connections tab. 
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4. Click FTP/S Config. The FTP Settings dialog box appears. 
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5. Select the Allow FTP client anti-timeout schemes check box to allow the NOOP command or clear the 

check box to treat the NOOP command as an invalid command. (Selected by default.) 

 

If you are banning users who send excessive invalid commands while treating NOOP as an invalid 
command, then you will be banning users for sending the NOOP command. You may later allow the 
user to connect by removing their IP address from the Site's list in the IP Access tab. A gray check box 
in a user account indicates that the account is inheriting parameters from the Settings Template. 

6. Click OK to close the dialog box.  

7. Click Apply to save the changes on the Server. 

ALLOWING MULTIPART TRANSFERS (COMB COMMAND) ON THE SITE 

The Server supports multi-part transfers from advanced FTP clients such as CuteFTP Professional. The user must 

have appropriate privileges and be authorized to connect multiple times concurrently. The connecting client takes 

care of most details, including splitting the file apart, sending the multiple parts, and then requesting that the 

Server to join them again upon receipt. The COMB command joins the parts back together. The benefits of 

segmented (multi-part) and concurrent delivery for accelerated transfers include:  

 Accelerate throughput and maximize available bandwidth available to the client by allowing uploaded files 

to be split apart and transferred in multiple segments simultaneously. 

 Command can be toggled on or off. 

  

http://www.globalscape.com/cuteftppro/
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The COMB command is a proprietary command and is not defined nor endorsed by any FTP-related RFC; however, 

the command can be integrated with other servers using the following syntax:  

COMB <TF> <SF 1> ... <SF n>  

where  

<TF> is the path to target file, which will contain the combined data from the source parts. 

<SF #> are the source files (parts). 

Which means combine n source files (SF 1...n) into one file (TF). 

 If the target file already exists, then the Server appends source files to it. 

 The Server will delete all the source files once they are combined successfully. 

 All file names should be in quotation marks. 

To allow or block multipart transfers 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Click FTP/S Config. The FTP Settings dialog box appears. 
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5. Do one of the following: 

 To allow transfers, select the Allow multi-part transfers (COMB) check box. 

 To block transfers, clear the Allow multi-part transfers (COMB) check box. 

5. Click OK to close the FTP Settings dialog box. 

6. Click Apply to save the changes on the Server. 

FILE INTEGRITY CHECKING (XCRC) 

Although TCP/IP checks that all packets are received, malformed packets or other mishaps can occur, leading the 

client to believe that a transfer was successful when it was not.  

The Server's file integrity command is defined as XCRC. Once an XCRC-enabled client (such as CuteFTP) performs a 

transfer, it can request the Server to do a checksum calculation on the file. If it matches the checksum on the 

client, then the transfer is deemed successful. Performing XCRC checksum calculations is processor intensive; 

enable or disable the feature accordingly. 

 

XCRC applies to FTP only, not SFTP. Refer to File Integrity Checking in FTP and SFTP below for details of file 
integrity checking in SFTP. 
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XCRC is a proprietary command and is not defined nor endorsed by any FTP-related RFC. Competing servers who 

want to implement this command may do so using the syntax described below. 

XCRC <File Name>  

XCRC <File Name>, <EP>  

XCRC <File Name>, <SP>, <EP>  

SP = Starting Point in bytes (from where to start CRC calculating) 

EP = Ending Point in bytes (where to stop CRC calculating) 

FTP Client Log Example  

COMMAND:> XCRC "/Program Files/MSN Gaming Zone/Windows/chkrzm.exe" 0 42575  

 SP and EP are optional parameters. If not specified then it calculates the CRC for the whole file. If only EP 

is specified, then the CRC calculation starts from the beginning of the file to the EP. 

 This command can be used for a single file at a time. It does not allow file lists as parameters. 

 The standard CRC32 algorithm is used (for speed and efficiency). 

 A client can invoke this command for uploads, downloads, and single and Multi-Part Transfers. 

Server Reply Indicates 

250 <XCRC>  calculated CRC value 

450 Requested file action not taken file is busy 

550 Requested action not taken 
file is not found or has no read 
permission; or the SP or EP are not 
correct 

File Integrity Checking in FTP and SFTP 

FTP provides a very raw mechanism to transfer files – the data for a file is uploaded/downloaded as a stream of 

bits over a TCP/IP connection. There is no additional overhead on that operation, so it is fast; however, this also 

means that there are no intrinsic mechanisms for ensuring that the file got to the other end intact. That is why 

many servers, including EFT Server, support the XCRC command, an extension to the FTP protocol. The XCRC 

command performs a CRC32 checksum over the file (either the whole file, or a portion of the file if a byte range is 

specified on the command line). This gives a 32-bit value that the Server computes on the file, which can be 

compared to the 32-bit value computed on the client side. If both files are the same size and the CRC32 matches, 

then there is a very high probability that the files are identical and files were transferred correctly. 

In contrast, SFTP does add overhead to the transfer of files. As a file is transferred between client and server, it is 

broken up into smaller chunks called "packets." For example, suppose each packet is 32KB. The SFTP protocol does 

a checksum on each 32KB file as it is sent, and includes that checksum along with that packet. The receiver gets 

that packet and decrypts the data, and then verifies the checksum. The checksum itself is "stronger" than the 

CRC32 checksum. (Because SFTP uses a 128-bit or higher checksum, such as MD5 or SHA, and because this is done 

on each and every packet, there is a very granular integrity checking that is accomplished as part of the transfer.) 

Thus, the protocol itself is slower (because of the additional overhead), but the successful completion of a transfer 

means, de facto, that it has be transferred integrally and there is no need for an additional check. 

If want to verify integrity, then use SFTP protocol and it is built-in; or, use FTP and after a transfer issue the raw 

command "XCRC /path/to/file" and read the results, comparing to a locally calculated CRC32 on the client side. EFT 

Server also supports querying the CRC32 value over the HTTP/S protocol by issuing a "HEAD" request to the file. 

The result of a HEAD method invocation on the HTTP/S engine will result in a response that includes the "X-CRC" 
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header, which contains the CRC32 value of the file in question. This can be compared to the CRC32 computed over 

the local file, just like in the FTP case. 

To enable or disable the XCRC command 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Click FTP/S Config. The FTP Settings dialog box appears. 
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5. Do one of the following: 

 To allow transfers, select the Allow integrity checking (XCRC) check box. 

 To block transfers, clear the Allow integrity checking (XCRC) check box. 

5. Click OK to close the FTP Settings dialog box. 

6. Click Apply to save the changes on the Server. 

CONNECTION BANNER MESSAGE 

When a user first connects to the Site via FTP, but before the user logs on, the connection banner appears. You can 

display a message unique to a user in addition to or instead of the Site's FTP banner message. Users automatically 

inherit the default message applied to their Settings Template. 

You can use the variables %DATE% and %TIME% to display the date and time of the login. For example: 
 

EFT Server Login  

%DATE% %TIME% 

Other variables allowed in the banner message include %USER.FULLNAME%, %USER.LOGIN%, 

%USER.EMAIL%, %USER.FIRST_NAME%, and %USER.LAST_NAME%. 

To modify the connection banner 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 
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3. In the right pane, click the Connections tab. 

 

4. Click FTP/S Configure. The FTP Settings dialog box appears. 
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5. In the Connection (banner) message box, specify the text that you want to appear when the user 

connects. 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 

USER LIMIT MESSAGE 

You can configure a Site to allow only a specified number of maximum simultaneous connections. If you click this 

option, you can specify a message for users when the maximum simultaneous connections is exceeded. You can 

display a message unique to a user in addition to or instead of the Site's user-limit message. Users automatically 

inherit the default message applied to their Settings Template. 

To modify the maximum connections message 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Connections tab. 
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4. Click FTP/S Configure. The FTP Settings dialog box appears. 



EFT Server™ version 6 

244  

 

5. In the User limit reached message box, specify the message you want to display if the maximum 

simultaneous connections number is exceeded. 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 

QUIT SESSION MESSAGE 

The Server can send an exit message when the client closes the session gracefully by using the FTP QUIT command. 

You can display a message unique to a user in addition to or instead of the Site's FTP banner message. Users 

automatically inherit the default message applied to their Settings Template. 

To modify the Quit Session message 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Connections tab. 
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4. Click FTP/S Configure. The FTP Settings dialog box appears. 
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5. In the Quit session message box, specify the exit message to display. 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 

FTP STATUS AND ERROR CODES 

During FTP sessions, servers send and receive various numbered codes to/from FTP clients. Some codes represent 

errors; most others simply communicate the status of the connection. Below are brief explanations for the most 

common status and error codes. 

When determining a course of action, review the entire log; some codes are informational only, others indicate 

that you have entered the wrong information, and others indicate what information you need to provide before 

continuing with your file transfer. 

Code Description Possible Solutions: 

100 
Series  

The requested action was initiated; expect another reply before proceeding with a new 
command.  

110  Restart marker reply. (Informational) 

120  Service ready in nn minutes. (Informational) 

125  Data Connection already open, transfer starting. (Informational) 
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Code Description Possible Solutions: 

150  File status okay, about to open data connection. 
FTP uses two ports: 21 for sending commands, 
and 20 for sending data. A status code of 150 
indicates that the server is about to open a new 
connection on port 20 to send some data. 

(Informational) 

200 
Series  

The requested action has been successfully completed.  

200  Command okay. (Informational) 

202  Command not implemented, superfluous at this 
site. 

(Informational) 

211  System status or system help reply. (Informational) 

212  Directory status. (Informational) 

213 File status. (Informational) 

214  Help message. (Informational) 

215 NAME system type. (Where NAME is an official 
system name from the list in the Assigned 
Numbers document.) 

(Informational) 

220  Service ready for new user. (Informational) 

221  Service closing control connection. Logged out if 
appropriate. 

(Informational) 

225  Data connection open; no transfer in progress. (Informational) 

226 Closing data connection. Requested file action 
successful (for example; file transfer or file abort). 
The command opens a data connection on port 
20 to perform an action, such as transferring a 
file. This action successfully completes, and the 
data connection is closed. 

(Informational) 

227  Entering Passive Mode. (Informational) 

230  User logged in, proceed. This status code appears 
after the client sends the correct password. It 
indicates that the user has successfully logged on. 

(Informational) 

250  Requested file action okay, completed. (Informational) 

257  "PATHNAME" created. 

 

(Informational) 

300 
Series 

The command has been accepted, but the requested action is on hold, pending receipt of 
further information.  

331  User name okay, need password.  You see this status code after the client sends a 
user name, regardless of whether the user name 
that is provided is a valid account on the system. 

332  Need account for login. Provide login credentials 
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Code Description Possible Solutions: 

350  Requested file action pending further 
information. 

(Informational) 

400 
Series 

The command was not accepted and the requested action did not take place, but the error 
condition is temporary and the action may be requested again. 

421  Error 421 Service not available, closing control 
connection. 
Error 421 User limit reached 
Error 421 You are not authorized to make the 
connection 
Error 421 Max connections reached 
Error 421 Max connections exceeded 

Try logging in later. 

425  Cannot open data connection. Change from PASV to PORT mode, check your 
firewall settings, or try to connect via HTTP. 

426  Connection closed; transfer aborted. The 
command opens a data connection to perform an 
action, but that action is canceled, and the data 
connection is closed. 

Try logging back in. Contact your hosting provider 
to determine if you need to increase your hosting 
account. Try disabling the firewall on your PC to see 
if that solves the problem. If not, contact your 
hosting provider or ISP. 

450  Requested file action not taken. File unavailable 
(e.g., file busy). 

Try again later. 

451  Requested action aborted; local error in 
processing. 

Ensure command and parameters were typed 
correctly. 

452  Requested action not taken. Insufficient storage 
space in system. 

Ask FTP administrator to increase allotted storage 
space, or archive/delete remote files. 

500 
Series  

The command was not accepted and the requested action did not take place.  

500 Syntax error, command unrecognized, command 
line too long. 

Try switching to passive mode. 

501  Syntax error in parameters or arguments. Verify your input; i.e., make sure there are no 
erroneous characters, spaces, etc. 

502  Command not implemented. The server does not support this command. 

503  Bad sequence of commands. Verify command sequence. 

504  Command not implemented for that parameter. Ensure entered parameters are correct. 

530  User not logged in.  Ensure that you typed the correct user name and 
password combination. Some servers use this code 
instead of 421 when the user limit is reached 

532  Need account for storing files. Logged in user does not have permission to store 
files on remote server. 

550  Requested action not taken. File unavailable, not 
found, not accessible 

Verify that you are attempting to connect to the 
correct server/location. The administrator of the 
remote server must provide you with permission to 
connect via FTP. 
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Code Description Possible Solutions: 

552  Requested file action aborted. Exceeded storage 
allocation.  

More disk space is needed. Archive files on the 
remote server that you no longer need. 

553  Requested action not taken. File name not 
allowed. 

Change the file name or delete spaces/special 
characters in the file name. 

10,000 
series  

Common Winsock Error Codes (complete list of Winsock error codes) 

10054  Connection reset by peer. The connection was 
forcibly closed by the remote host. 

(Informational) 

10060  Cannot connect to remote server (Generally a 
time-out error). 

Try switching from PASV to PORT mode, or try 
increasing the time-out value. 

10061  Cannot connect to remote server. The connection 
is actively refused by the server. 

Try switching the connection port. 

10066  Directory not empty. The server will not delete 
this directory while there are files/folders in it. 

If you want to remove the directory, first archive or 
delete the files in it. 

10068  Too many users, server is full. Try logging in at another time. 

FTP COMMANDS SUPPORTED BY THE SERVER 

Below is the list of FTP commands that the Server supports and will give a known response to, followed by a few 

commands that it recognizes, but gives an error message of "202 Command not implemented, superfluous at this 

site." 

For more information about FTP commands, refer to RFC959 at http://faqs.org/rfcs/rfc959.html. 

Command Description 

ABOR Abort a file transfer 

ALLO Allocates sufficient storage space to receive a file 

ALLO size [R max-record-size] 

APPE Append data to the end of a file on the remote host 

APPE remote-filename 

AUTH Used to initiate an SSL encrypted session 

CCC (clear command channel for FTPS transfers) 

CDUP Change working directory to the parent of the current directory 

COMB Combines file segments into a single file on the server 

CWD Change working directory 

CWD remote-directory  

DELE Delete remote file 

FEAT List all FTP features that the server supports 

HELP Display a list of all available FTP commands 

LIST Send list of file names and details  

http://kb.globalscape.com/article.aspx?id=10140
http://faqs.org/rfcs/rfc959.html
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Command Description 

MDTM Display date/time file was modified, in the format YYYYMMDDhhmmss. YYYY is the four-digit 
year, MM is the month from 01 to 12, DD is the day of the month from 01 to 31, hh is the 
hours from 00 to 23, mm is the minutes from 00 to 59, and ss is the seconds from 00 to 59.  

MKD Create (make) a remote directory 

MLSD Display an abbreviated list of a remote directory's files and subdirectories 

MLST Display detailed file or directory information 

MODE  Sets the mode in which data is to be transferred to one of the following:  

S - Stream  

Z - Compressed  

The default mode is Stream. (only "s" or "z" are supported) 

NLST Send list of file names (no details) 

NOOP  Do nothing; often used to keep the session alive. 

OPTS  Used to specify optional parameters for the command that follows the OPTS command, if that 
command supports such optional parameters. (The commands "mslt" and "mode z level X," 
where x=1-9, are supported.) 

PASS Send password 

PASS <password> 

PASV Enter passive mode 

PBSZ If the Server receives this command, it sets it to 0. 

PORT Specifies the host and port to which the server should connect for the next file transfer. 

PROT  Used to set the protection level to be used for data transfers. PROT P is used to secure the 
data channel; PROT C is used to clear the data channel. 

PWD Display current directory (print working directory) 

QUIT Closes the connection and terminates the FTP session. 

REIN Reinitialize the connection and cancels the current user/password/account information 

REST Sets the point at which a file transfer should start 

REST position 

RETR Begins transmission of a file from the remote host. Must be preceded by either a PORT 
command or a PASV command to indicate where the server should send data.  

RETR remote-filename 

RMD Deletes the named directory on the remote host 

RMD remote-directory 

RNFR Rename from (followed by an RNTO command to specify the new name for the file) 

RNFR from-filename 

RNTO Rename to (after sending an RNFR command to specify the file to rename, this command is 
used to specify the new name for the file) 

RNTO to-filename 

SITE Site-specific commands 

SITE site-specific-command  
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Command Description 

SIZE Display size of a file 

SIZE remote-filename 

SSCN (extension for secure site-to-site transfers) 

STAT Display server status 

STAT [remote-filespec] 

STOR Begins transmission of a file to the remote site. Must be preceded by either a PORT command 
or a PASV command so that the server knows from where to accept data.  

STOR remote-filename 

STOU Begins transmission of a file to the remote site; the remote filename will be unique in the 
current directory.  

SYST Displays a string of "215 UNIX Type: L8" 

TYPE Sets the type of file to be transferred.  

TYPE type-character [second-type-character] 

"type-character" can be A (ASCII text) or I (image, binary data)  

The second-type-character specifies how the text should be interpreted. It can be N (Non-
print; not destined for printing. This is the default if second-type-character is omitted), T 
(Telnet format control <CR>, <FF>, etc.), or C (ASA Carriage Control). 

USER Send username 

USER username 

XCUP (same as CDUP) 

XCWD (same as CWD) 

XMKD (same as MKD) 

XNOP (same as NOOP) 

XPWD  (same as PWD) 

XRMD (same as RMD) 

XCRC Compute CRC32 checksum on specified file 

The following commands are recognized, but not supported: 

Command Description 

ACCT (Account) Send account information 

SMNT (Structure mount) Mount a different file system data structure without altering login or 
accounting information 

STRU (File Structure) Set file transfer structure 
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SSL 

The topics below provide information regarding using SSL with EFT Server.  

SSL OVERVIEW 

FTPS is an enhancement to standard FTP that uses standard FTP commands (and protocol) over secure sockets. 

FTPS adds SSL security in both the protocol and data channels. FTPS is also known as FTP-SSL and FTP-over-SSL. 

You might also see the term SSL used in conjunction with TLS. SSL has been merged with other protocols and 

authentication methods into a new protocol known as Transport Layer Security (TLS). The Server employs SSL/TLS 

to perform FTPS to keep your data secure. The Server uses OpenSSL 0.9.8a. 

Secure Socket Layer (SSL) is a protocol for encrypting and decrypting data across a secure connection from a client 

to a server with SSL capabilities. The server is responsible for sending the client a certificate and a public key for 

encryption. If the client trusts the Server's certificate, an SSL connection can be established. All data passing from 

one side to the other will be encrypted. Only the client and the Server will be able to decrypt the data.  

The Server supports SSL for client and server authentication, message integrity, and confidentiality. You can 

configure the Server's security features to verify users' identities, allows users to verify your identity, and to 

encrypt file transfers. The key to understanding how SSL works is to understand the elements that take part in the 

process. 

ELEMENTS THAT WORK TOGETHER TO ESTABLISH A SECURE SSL CONNECTION: 

 Client: The client needs to be an FTP client with SSL capabilities. 

 Certificate: Certificates are digital identification documents that allow both servers and clients to 

authenticate each other. A certificate file has a .crt extension. Server certificates contain information 

about your company and the organization that issued the certificate (such as Verisign or Thawte) while 

client certificates contain information about the user and the organization that signed the certificate. You 

can choose to either trust or distrust a certificate. In some cases, the client's certificate must be signed by 

the Server's certificate to open an SSL connection. 

 Session Key: The client and the Server use the session key to encrypt data. It is created by the client via 

the Server’s public key. 

 Public Key: The client encrypts a session key with the Server’s public key. It does not exist as a file, but is 

produced when a certificate and private key are created. 

 Private Key: The server's private key decrypts the client's session. The private key has a .key extension 

and is part of the public-private key pair. 

 Certificate Signing Request: A Certificate Signing Request (CSR) is a PKCS10 request, which is an unsigned 

copy of your certificate. A certificate signing request is generated each time a certificate is created. A 

certificate signing request has a .csr extension. This file is used when you need to have your certificate 

signed. Once the .csr file is signed, a new certificate is made and replaces the unsigned certificate.  

SSL must first be enabled at the Site and Server level, and then can be enabled in the Settings Template and per 

user. The Server provides administrators the ability to specify the symmetric key cipher(s) and the ordering of 

those ciphers for establishing SSL sessions. The Server validates inbound SSL sessions, and allows or denies 

connections based on specified or approved ciphers.  

The Server supports two levels of authentication with SSL: 

High - The server is configured so that it contains a certificate, but does not require a certificate from the FTP 

client. 
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Highest - The server is configured so that it provides a certificate and also requests a certificate from the client. 

The server compares the client certificate to a list contained in its Trusted Certificates database. The server either 

accepts or rejects the connection based upon a match. 

Refer to FIPS-Certified Library for SSL Connections for details of enabling the FIPS-certified library for SSL 

connections. 

Refer to Using Ciphers for SSL Connections with EFT Server for details of SSL ciphers in EFT Server. 

 

 

CREATING SSL CERTIFICATES 

A self-signed certificate contains a public key, information about the owner of the certificate, and the owner's 

signature. It has an associated private key, but it does not verify the origin of the certificate through a third-party 

certificate authority.  

To achieve the highest level of authentication between critical software components, do not use self-signed 

certificates, or use them selectively. 

A certificate on the client must be associated with the Server to initiate an SSL connection. When you are 

administering the Server on the local computer, you can create certificates using the Certificate Creation Wizard 

(Tools > Certificate Creation Wizard) or import your own. There are three types of files associated with an SSL 

certificate key pair: 

 Private key file (.key)- The private key should never be distributed to anyone. It is used to decrypt the 

session, which is encrypted by the public key. 

 Certificate request file (.csr) - Each time you create a certificate using the Server, a Certificate Signing 

Request file is also created. A Certificate Signing Request (CSR) is a PKCS10 request, which is an unsigned 

copy of your certificate. This file can be signed by the Server's Certificate Signing Utility or sent to an 

intermediate certificate authority, such as GeoTrust, for signing.  

 Certificate file (.crt) - This is a signed certificate, whether self-signed or signed by an intermediate 

certificate authority. 

For maximum compliance with security standards, you should use a trusted authority signed SSL certificate. You 

can import certificates or use this wizard to create your own. The private key (.key) and certificate request (.csr) 

files are created at the same time. You are prohibited from creating certificates for EFT Server while remotely 

administering EFT Server because this action can create a security breach. Any certificates you create remain on 

the computer on which you created them, unless you take special steps to deliver and associate these files with 

another computer. 

To create an SSL certificate 

1. In the Administrator, connect to the Server, click the Server tab, then do one of the following: 

 On the main menu, click Tools > Create SSL Certificate. 

 On the toolbar, click the New SSL Certificate icon . 

 On the keyboard, press ALT+T+C. 

The Create SSL Certificate wizard appears. 

http://www.verisign.com/
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2. In the Certificate name box, specify the name of the certificate that will be generated. 

3. In the Path box, specify the path to the folder in which the certificate is to be saved. The wizard saves the 

.key, .csr, and .crt files in this folder (e.g., C:\Documents and Settings\All Users\Application 

Data\Globalscape\EFT Server or \EFT Server Enterprise). 

 

If you are purchasing a signed certificate from a certificate authority (CA), you usually need to 
forward the contents to the CA. To do this, locate the .csr and open it in a text editor; then you can 
copy and paste the contents. 

4. In the Expiration Date box, specify the date on which the certificate will expire. 

5. In the Passphrase and Confirm passphrase boxes, type the passphrase used to encrypt the private key. 

The passphrase can be any combination of characters or spaces. Do not lose the passphrase; the 

certificate is useless without it. 

6. In the Key Length (in bits) box, specify the key length: 512, 1024, 2048, and 4096 bits. Smaller keys are 

faster, larger keys are more secure.  

 

If you create a certificate with a key length of 4096 bits or greater, the Web Transfer Client will not 
function properly due to its reliance on the Java runtime (JRE), which currently does not support key 
lengths of 4096 bits or greater.  

7. Click Next. The Certificate Information page appears.  

Each of the boxes must be completed before continuing. The information you provide is stored in the 

certificate. 

8. In the City/Town box, provide the name of your city, town, or other locality. 

9. In the State/Province box, provide the name of the state or province. 

10. In Organization box, provide the name of your organization, or any other designator. 

11. In the Common Name box, provide the common name or fully qualified domain name, such as 

www.globalscape.com. (Typically, the name or domain name associated with the Site.) 

12. In the E-Mail box, provide your e-mail address in the format username@domain.com. 

13. In the Unit box, type any other information about your organization, such as department name. 
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14. In the Country box, provide the 2-letter ISO country code using uppercase letters. 

15. Click Next. The Certificate Options page appears. 

 

16. If the Associate the certificate to the Site(s) specified below check box is cleared, the wizard saves only 

the certificate files in the folder you previously specified, but does not associate it with any Site. If the 

check box is selected, the wizard associates the certificate to the administration service or Site(s) you 

specify in the Apply certificate to box. 

17. In the Apply certificate to box, specify which components of the Server are affected (Administration 

Service, All Sites, or a specific Site). 

 

Associating a new certificate with a Site requires a restart of the Site, and any active users will be 
disconnected, so it is recommended that you associate certificates when Sites are inactive or 
stopped. 

18. If the Add this certificate to the Trusted Certificate list check box is selected, the wizard adds the 

certificate to the Trusted Certificates database. Use this feature if you are creating certificates for user 

distribution. You can limit the Server access to just the users that have the certificate. You can verify the 

addition to the Trusted Certificate database by clicking Tools > Certificate Manager or, on the toolbar, 

click the Certificate Manager icon . (Refer to The Certificate Manager for more information.) 

19. Click Finish.  

ASSIGNING A CERTIFICATE 

An SSL Certificate is necessary for FTPS, HTTPS, and AS2 connections. After you create or obtain an SSL certificate, 

you can assign the certificate to one or more Sites.  

To assign a certificate you have created or obtained to a Site 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Connections tab. 
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4. In the SSL certificate settings area, click Configure. The SSL Certificate Settings dialog box appears. 

 

 To create a certificate, click Create and follow the prompts in the wizard. (Refer to Creating 

Certificates for details, if necessary.) 

 To use an existing certificate: 

a. In the Certificate box, type the path to the .crt file or click the open icon  to find and 

select it. 

b. In the Private key box, type the path to the .key file or click the open icon  to find 

and select it. 
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c. In the Certificate passphrase and Confirm passphrase boxes, type and confirm the 

passphrase for the certificate pair. 

5. Select the Require SSL certificates from connected clients check box, if you want connecting clients to 

use an SSL certificate. 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 

SIGNING A CERTIFICATE 

The Server can sign certificate requests created by other clients. Typically, the client certificate request is signed 

with the certificate created for the Server. If a certificate from the FTP server's Trusted Certificates database is 

used to sign client certificates, then all certificates you sign are automatically trusted. 

 

The HS module checks the key length and expiration date only for the Server's SSL certificates (i.e. 
administration certificate and site certificates); client certificates (i.e. trusted certificates) are not checked. 

To sign a certificate request  

1. Obtain the Certificate Signing Request file (.csr). This can be done through e-mail or any other file delivery 

method. 

2. In the left pane, click the Server or a Site node. (If the Server Group node is selected, the certificate 

options are unavailable.) 

3. On the main menu, click Tools > Sign SSL Certificate, or click the Certificate Signing Utility icon . The 

Certificate Signing Utility dialog box appears. 

 

 

4. In the Client certificate request box, click the open icon  to browse for and specify the Certificate 

Signing Request (.csr) file that you want to sign. 
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5. In the Output path box, click the open icon  to browse for and specify the folder in which to save the 

signed certificate (.crt) file.  

6. In the Resulting certificate expiration date box, click the list to open a calendar in which to specify an 

expiration date. 

 

 Click the left- and right-facing arrows to scroll through the months. 

7. In the Signing certificate box, specify the certificate (.crt) that you want to use to sign the certificate 

request file (.csr). The signing certificate must be in your trusted certificate database in order for clients 

submitting the signed certificate to connect to the Site. 

8. In the Private key box, specify the private key file (.key) associated with the signing certificate. 

9. In the Passphrase box, provide the passphrase associated with the signing certificate. 

10. Click OK. The new certificate is saved in the folder you specified. 

11. Return the certificate file (.crt) to the user. 

THE CERTIFICATE MANAGER 

The Certificate Manager is used to manage the SSL certificates for a Site. 

 

The Certificate Manager browses your My Documents folder by default when you click Import or Export.  

 To view all of the certificates for a Site, click the Site list to select the Site. The certificates for the selected 

Site appear in the Trusted Certificates and Pending Certificates lists. 
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 To view the properties of a certificate, click the certificate in the list, then click Properties. The Certificate 

Contents dialog box appears, showing the Issuer and Subject information and the dates the certificate is 

valid. 

 

 

 To import certificates for a Site, refer to Importing a Certificate. 

 To export certificates from a Site, refer to Exporting a Certificate. 

 To remove a certificate from the Trusted Certificates or Pending Certificates list, click Remove. 

 To create a new certificate, refer to Creating Certificates. 

IMPORTING A CERTIFICATE 

 

If you attempt to import a certificate that has a key length of 512 bits or less on a HS-enabled Site, the Server 
prompts you that only strong keys should be used. You are offered the option of importing a key that has at 
least 1024 bits or continuing with reason. 

For expediency, you should save the certificates that you want to import into EFT Server in your My Documents 

folder. The Certificate Manager browses your My Documents folder by default when you click Import.  
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To import a certificate to a Site  

1. On the main menu, click Tools > Manage SSL Certificate. The Certificate Manager appears. 

 

 

2. In either the Trusted Certificates or Pending Certificates list, click Import.  

3. Browse to the folder that contains the client's certificate file and click the file. 

 

The Server can import a digital certificate from the following formats: PEM, Base64 Encoded X509, 
DER Encoded X509, PKCS#7, PKCS#12. 
The private key associated with the digital certificate must be in one of the following formats: PEM, 
DER, PKCS#8, PKCS#12.  

A Certificate Signing Request (.csr) is a PKCS10 request, which is an unsigned copy of your certificate. 

4. Click Open. The Server automatically determines the certificate format. If the Server is unable to 

determine the format, or if the import fails, you can manually convert a digital certificate to one of the 

above formats and import it. Consult the distributor/vendor of your certificate for details on this process. 

The certificate is added to the Trusted Certificates database. Clients submitting that certificate are now 

able to connect to the Server. 
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EXPORTING A CERTIFICATE 

For expediency, you should save the certificates that you want to export into EFT Server in your My Documents 

folder. The Certificate Manager browses your My Documents folder by default when you click Export.  

To export a certificate from the database  

1. On the main menu, click Tools > Manage SSL Certificate. The Certificate Manager dialog box appears. 

 

 

2. In either the Trusted Certificates or Pending Certificates list, click Export, and browse to the folder where 

you want to save the certificate file. 

3. Type a name for the certificate file, then click Save. 

IMPORTING CERTIFICATES FROM MICROSOFT IIS 5 

To use a certificate that you are using in IIS 5 you must: 

1. Add a Certificate Snap-in to your Microsoft Management Console (as described below) 

2. Export the certificate from IIS 5 (as described below) 

3. Import the certificate into the Server 
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To add the certificate snap-in 

1. On the computer containing the certificate you want, click Start > Run, then type mmc to open the 

Microsoft Management Console. 

 

2. On the Console menu, click File > Add/Remove Snap-in. The Add/Remove Snap-in dialog box appears. 

 

3. Click Add. The Add Standalone Snap-in dialog box appears. 
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4. In the Available standalone snap-ins list, click Certificates, then click Add. The Certificates snap-in dialog 

box appears. 

 

5. Click Computer account, then click Next. The Select Computer dialog box appears. 
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6. Click Local computer, then click Finish.  

7. Close the Add Standalone Snap-in dialog box. Certificates is added to the Add/Remove Snap-in dialog 

box. 

8. Click OK on the Add/Remove Snap-in dialog box. A Certificates node is added to the Console. 

 

To export the certificate from IIS 5 

1. Under the Tree tab in the Microsoft Management Console expand Certificates. 

2. Click the Personal folder and then the certificate you want to export. 

3. On the Action menu, click All Tasks > Export.  

4. Click Next, click Yes, export the private key, then click Next. 

5. Click Personal Information Exchange - PKCS #12 (.PFX) and then click Next. 

6. Enter the password you used when you created the certificate and click Next. This will create a .pfx file. 

To import the certificate into the Server/Site, refer to the topics below. 
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ENABLING FTPS AND HTTPS (SSL) AT THE SITE LEVEL 

Specify SSL versions and ciphers before enabling SSL connections. SSL must first be enabled on the Server and Site, 

then can be enabled in the Settings Template and user. 

If you require certificates from connecting clients before they can connect, then their certificate must be in the 

Trusted Certificates Database or signed by a certificate in the Trusted Certificate Database. 

To enable SSL 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, select the Site you want to configure. 

3. In the right pane, select the Connections tab. 

4. In the Listener Settings area, select the applicable check boxes (FTPS, HTTPS, and/or AS2). 

 

5. In the SSL certificate settings area, click Configure. The SSL Certificate Settings dialog box appears. 
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6. Do one of the following: 

 To create a certificate, click Create and follow the prompts in the wizard. (Refer to Creating 

Certificates for details, if necessary.) 

 To use an existing certificate: 

a. In the Certificate box, type the path to the .crt file or click the open icon  to find and 

select it. 

b. In the Private key box, type the path to the .key file or click the open icon  to find 

and select it. 

c. In the Certificate passphrase and Confirm passphrase boxes, type and confirm the 

passphrase for the certificate pair. 

7. Select the Require SSL certificates from connected clients check box, if you want connecting clients to 

use an SSL certificate. 

8. Click OK to close the dialog box. 

9. Click Apply to save the changes to the Server. 

DISABLING SSL CONNECTIONS 

You can disable SSL support for every user on the Server by disabling SSL support at the Site level or you can 

disable SSL for a specific user or Settings Template.  

To disable SSL connections to a Site 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Connections tab. 
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4. Select the FTP check box and specify the port, if different from the default shown. 

5. Clear BOTH the FTPS (SSL/TLS) - Explicit mode and FTPS (SSL/TLS) - Implicit mode check boxes. 

6. Click Apply to save the changes on the Server. 

 

If SSL connections are disabled at the Site level, they are also disabled for all Settings Templates and 
users on the Site. 

To disable SSL connections for a specific user or Settings Template 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user that you want to configure. 

3. In the right-hand pane, click the Connections tab. 
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4. Clear the FTPS (SSL/TLS) check box. (At least one protocol check box must be selected or inheriting the 

parent settings.) 

5. Click Apply to save the changes on the Server. 

SSL CERTIFICATE-BASED LOGIN 

The Server supports authentication using SSL certificates for FTPS, and HTTPS, and AS2 connections, rather than 

password-based login. This is similar to SFTP authentication in which a particular SFTP key is associated with a user 

account; when the user logs in and provides the key, as long as the keys match, they are allowed to proceed. 

Unlike SFTP, SSL offers the option to authenticate using both password and certificate rather one or the other.  

Normally, when a client supplies an SSL certificate for the SSL handshake (if requested by the Server), EFT Server 

determines whether that certificate is in the global trusted list. If the certificate is trusted, the Server completes 

the process of negotiating a shared secret and then moves on to the authentication stage, requesting a username 

followed by a password. If the user enters the wrong password (or no password at all), the authentication attempt 

fails, even though a certificate was found in the trusted store that matched the client’s certificate. 

 

EFT Server determines whether certificate keys used on the Server are current and reports the status in the 
Compliance Report. Refer to Possible Compliance Report Outcomes for more information. 
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With certificate-based authentication, the sequence of steps would be virtually the same. If certificate-based 

authentication is enabled, and after the client’s username has been provided, but prior to the Server requesting 

the user’s password, the Server verifies that the public-key of the provided certificate matches the certificate in 

the trusted store that is associated with (mapped to) this particular user’s account. If a match is made, that user is 

automatically authenticated for that session. If the protocol expects a username/password sequence, the Server 

always returns TRUE, regardless of the password supplied by the client (whether null or invalid pass). 

 

Compliance with PCI DSS requires that users change their password upon initial login. Because this login 
method does not use a password, it potentially violates the PCI DSS and is, therefore, not available with HS-
enabled Sites.  

To specify SSL certificate-based logins for the Site 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Next to SSL certificate settings, click Configure. The SSL Certificate Settings dialog box appears. 
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5. Do one of the following: 

 Create a certificate: 

a. Click Create. The Create SSL Certificate wizard appears. 

b. Follow the steps in Creating Certificates to create the SSL certificate for the Site. 

 Use an existing certificate: 

a. In the Certificate box, specify the SSL certificate that is required to connect to the Site. 

b. In the Private key box, specify the private key for the certificate. 

c. In the Passphrase and Confirm passphrase boxes, provide the password for the 

certificate. 

6. To require connecting clients to use the certificate, select the Require SSL certificates from connected 

clients check box. 

7. Click OK to save the changes. 

8. Click Apply to save the changes on the Server. 

To specify SSL certificate-based logins for the Settings Level or User 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user that you want to configure. 

3. In the right pane, click the Connections tab. 
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4. Select the FTPS (SSL/TLS) check box, if not inherited from the Site, then click SSL Auth. The SSL 

Authentication Options dialog box appears. 

 

5. In the SSL authentication options list, specify the authentication method: 

 Specified in Settings Template 

 Password only (the default) 

 SSL Certificate - If SSL Certificate is specified, the bottom box becomes available. Certificates that 

are defined on the Site appear in the box. Click the user certificate in the box.   

6. If you need to define a certificate, click Create Cert. The Create SSL Certificate wizard appears. 

7. To view or import certificates, click Cert. Manager. The Certificate Manager appears. 

8. Click OK to close the dialog box. 

9. Click Apply to save the changes on the Server. 
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EXPORTING A CERTIFICATE FROM PFX TO PEM 

For security, the Server does not allow you to use a certificate file with a .p* (e.g., pfx, p12) extension. The .p* 

extension indicates that it is a combined certificate that includes both the public and private keys, giving clients 

access to the private key. You can create certificate files using the Server's Certificate wizard. If you have a 

combined certificate from a third-party, use the procedure below to extract the public key. 

To export the certificates from PFX to PEM 

1. Download the precompiled Windows binary and Windows Installer for OpenSSL from 

http://www.slproweb.com/products/Win32OpenSSL.html. The OpenSSL distribution contains a number 

of utilities, including the main utility openssl.exe. By default, the utilities are installed in C:\Openssl\bin.  

2. Open a Windows command prompt and navigate to \Openssl\bin.  

3. Type openssl.exe and press ENTER. The OpenSSL prompt appears.  

4. Execute the following command: 

pkcs12 -in <cert.pfx> -out <cert.pem> -nodes 

where <cert.pfx> is the name of the PFX file (you might need to include the path and quotes), and 

<cert.pem> is the name of the file that OpenSSL is to generate (include the path if you want to save it in a 

location other than \Openssl\bin.) 

For example, type: 

pkcs12 -in "C:\Program Files\nsoftware\IPWorks EDI V7 AS2 

Connector\as2datacert.pfx" -out cert.pem -nodes 

5. The command converts the data in the <cert.pfx> file to PEM format in the <cert.pem> file. The PEM file 

contains all of the certificates that were in the PFX file: 

 Private key  

 Identity certificate  

 Root certificate  

 Intermediate certificate  

Each of the certificates (Private Key, Identity certificate, Root certificate, Intermediate certificate) is 

wrapped within headers, and these headers are part of the certificates. 

 

  

http://www.slproweb.com/products/Win32OpenSSL.html
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The PEM file looks similar to the following: 

 

6. Open the PEM file in a text editor (NotePad, EditPlus) and delete all but the last certificate section so that 

the file only contains the section that starts  

-----BEGIN CERTIFICATE----- 

and ends 

-----END CERTIFICATE----- 

7. Save the file with a .crt extension. The file is now ready to be used in the Server for the partner certificate. 

Refer to Knowledge Base article Q10401 - HOWTO: Using OpenSSL to Generate/Convert Keys and Certificates for 

more information regarding using the OpenSSL command-line tool to generate and convert private keys and public 

certificates. 

  

http://kb.globalscape.com/article.aspx?id=10401&query=certificate
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USING OPENSSL TO GENERATE/CONVERT KEYS AND CERTIFICATES 

The topics below provide the procedures for using OpenSSL to generate and convert keys and certificates for use in 

EFT Server. 

USING OPENSSL 

The Certificate Creation wizard guides you through the process of creating keys and certificates without using a 

command line. If you prefer to use a command line tool, the OpenSSL command-line tool can be used to generate 

and convert private keys and public certificates, including:  

 Creation of RSA, DH, and DSA key parameters 

 Creation of X.509 certificates, CSRs, and CRLs 

 Calculation of Message Digests 

 Encryption and Decryption with Ciphers 

 SSL/TLS Client and Server Tests 

 Handling of S/MIME signed or encrypted mail 

You can download the precompiled Windows binary and Windows Installer for OpenSSL from 

http://www.slproweb.com/products/Win32OpenSSL.html. The OpenSSL distribution contains a number of utilities, 

including the main utility openssl.exe. By default, the utilities are installed in C:\Openssl\bin. openssl.exe and 

associated utilities are used at a Windows command prompt.  

Some commands require specification of the OpenSSL configuration file openssl.cnf. By default, this file is installed 

in C:\Openssl\bin. Therefore, when required to specify the configuration filename, you would use the following 

path:  

 In version 0.9.8g the file is C:\OpenSSL\bin\openssl.cnf 

 In version 0.9.8h and later, the file is C:\OpenSSL\bin\openssl.cfg 

You can run the commands from any location by specifying the full path to the desired executable or by changing 

to the bin directory and using only the executable filenames.  

For example: 

>cd c:\temp  

>c:\Openssl\bin\openssl  

-OR- 

>cd c:\Openssl\bin  

>openssl.exe  

 

Refer to the procedures below for using OpenSSL to generate or convert private keys and public certificates for use 

with EFT Server. 

 Generating an Unencrypted Private Key and Self-Signed Public Certificate 

Use this procedure if you want to generate a public certificate and unencrypted key by hand instead of 

generating one from within EFT Server.  

http://www.slproweb.com/products/Win32OpenSSL.html
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 Generating an Encrypted Private Key and Self-Signed Public Certificate 

Use this procedure if you want to generate a public certificate and encrypted key by hand instead of 

generating one from within EFT Server.  

 Generating a PKCS#12 Private Key and Public Certificate 

Use this procedure if you want to generate a compatible PFX/P12 file (often confused with PFX) containing 

a public certificate and key.  

 Converting a PEM-Encoded PKCS#8 Format Encrypted Private Key to PKCS#8 Format 

Use this procedure when you already have a public certificate and PEM encoded PKCS#8 format encrypted 

private key file. You can determine the format by viewing the private key file in a text editor. If it contains 

the following line, then this procedure most likely applies: 

-----BEGIN ENCRYPTED PRIVATE KEY----- 

 Converting a Traditional PEM-Encoded Encrypted Private Key to PKCS#8 Format 

Use this procedure when you already have a public certificate and traditional PEM encoded encrypted 

private key file. You can determine the format by viewing the private key file in a text editor. If it contains 

the following line, then this procedure most likely applies: 

-----BEGIN RSA PRIVATE KEY----- 

Proc-Type: 4,ENCRYPTED 

 Converting an Incompatible PKCS#12 Format File to a Compatible PKCS#12 

Use this procedure when you want to convert an existing incompatible PKCS#12 format encrypted private 

key/public certificate file to a compatible PKCS#12 format file. 

GENERATING AN UNENCRYPTED PRIVATE KEY AND SELF-SIGNED PUBLIC CERTIFICATE 

This article discusses how to generate an unencrypted private key and public certificate pair that is suitable for use 

with HTTPS, FTPS, and the administrative port for EFT Server. (To generate an encrypted key/certificate pair, refer 

to Generating an Encrypted Private Key and Self-Signed Public Certificate.) 

General Information 

 When operating in a FIPS-approved mode, PKI key/certificates must be between 1024- bits and 4096-bits, 

inclusive.  

 The supported cipher combinations allowed for SSL negotiation are limited to: 

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 256 bit AES encryption, and SHA1 HMAC  

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 168 bit 3DES encryption, and SHA1 HMAC  

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 128 bit AES encryption, and SHA1 HMAC 

Each of the above combinations uses RSA key exchange; therefore, RSA-based key/certificates must be 

used. 
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Procedure 

These instructions assume you have downloaded and installed the Windows binary distribution of OpenSSL. Refer 

to Using OpenSSL for the basic instructions. 

1. Generate an RSA private key: 

>C:\Openssl\bin\openssl.exe genrsa -out <Key Filename> <Key Size> 

Where: 

 <Key Filename> is the desired filename for the private key file 

 <Key Size> is the desired key length of either 1024, 2048, or 4096 

For example, type: 

>C:\Openssl\bin\openssl.exe genrsa -out my_key.key 2048 

2. Generate a Certificate Signing Request: 

In version 0.9.8g: 

>C:\Openssl\bin\openssl.exe req -new -key <Key Filename> -out <Request 

Filename> -config C:\Openssl\bin\openssl.cnf 

-OR- 

In version 0.9.8h and later: 

>C:\Openssl\bin\openssl.exe req -new -key <Key Filename> -out <Request 

Filename> -config C:\Openssl\bin\openssl.cfg 

Where: 

 <Key Filename> is the input filename of the previously generated private key 

 <Request Filename> is the output filename of the certificate signing request 

For example, type: 

>C:\Openssl\bin\openssl.exe req -new -key my_key.key -out my_request.csr -

config C:\Openssl\bin\openssl.cnf 

3. Follow the on-screen prompts for the required certificate request information. 

4. Generate a self-signed public certificate based on the request 

>C:\Openssl\bin\openssl.exe x509 -req -days 3650 -in <Request Filename> -

signkey <Key Filename> -out <Certificate Filename> 

Where: 

 <Request Filename> is the input filename of the certificate signing request 

 <Key Filename> is the input filename of the previously generated private key 

 <Certificate Filename> is the output filename of the public certificate 

For example, type: 

>C:\Openssl\bin\openssl.exe x509 -req -days 3650 -in my_request.csr -signkey 

my_key.key -out my_cert.crt 

5. (Optional) You may now delete the request file, as it is no longer needed.  

The resulting private key file and public certificate file can now be used within EFT Server. 
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GENERATING AN ENCRYPTED PRIVATE KEY AND SELF-SIGNED PUBLIC CERTIFICATE 

This article discusses how to generate an encrypted private key and public certificate pair that is suitable for use 

with HTTPS, FTPS, and the administrative port for EFT Server. (To generate an unencrypted key/certificate pair, 

refer to Generating an Unencrypted Private Key and Self-Signed Public Certificate.) 

General Information 

 When operating in a FIPS-approved mode, PKI key/certificates must be between 1024- bits and 4096-bits, 

inclusive.  

 The supported cipher combinations allowed for SSL negotiation are limited to: 

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 256 bit AES encryption, and SHA1 HMAC  

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 168 bit 3DES encryption, and SHA1 HMAC  

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 128 bit AES encryption, and SHA1 HMAC 

Each of the above combinations uses RSA key exchange; therefore, RSA based key/certificates must be 

used. 

 In FIPS mode, the private key must use the PKCS#8 format and PKCS#12 compatible encryption of the 

private key, which allows the use of the necessary strong encryption algorithm of 3DES encryption and 

SHA1 hashing. 

Procedure 

These instructions assume you have downloaded and installed the Windows binary distribution of OpenSSL. Refer 

to Using OpenSSL for the general instructions 

1. Generate an unencrypted RSA private key: 

>C:\Openssl\bin\openssl.exe genrsa -out <Key Filename> <Key Size> 

Where: 

 <Key Filename> is the desired filename for the private key file 

 <Key Size> is the desired key length of either 1024, 2048, or 4096 

For example, type: 

>C:\Openssl\bin\openssl.exe genrsa -out my_key.key 2048 

2. Encrypted the unencrypted private key: 

>C:\Openssl\bin\openssl.exe pkcs8 -v1 PBE-SHA1-3DES -topk8 -in <Unencrypted 

Key Filename> -out <Encrypted Key Filename> 

Where: 

 <Unencrypted Key Filename> is the input filename of the previously generated 

unencrypted private key. 

 <Encrypted Key Filename> is the output filename of the encrypted private key 

For example, type: 

>C:\Openssl\bin\openssl.exe pkcs8 -v1 PBE-SHA1-3DES -topk8 -in my_key.key -

out my_encrypted_key.key 

3. Delete the unencrypted private key. 

4. Generate a Certificate Signing Request: 
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In version 0.9.8g: 

>C:\Openssl\bin\openssl.exe req -new -key <Encrypted Key Filename> -out 

<Request Filename> -config C:\Openssl\bin\openssl.cnf 

-OR- 

In version 0.9.8h and later: 

>C:\Openssl\bin\openssl.exe req -new -key <Encrypted Key Filename> -out 

<Request Filename> -config C:\Openssl\bin\openssl.cfg 

Where: 

 <Encrypted Key Filename> is the input filename of the encrypted private key 

 <Request Filename> is the output filename of the certificate signing request 

For example, type: 

>C:\Openssl\bin\openssl.exe req -new -key my_encrypted_key.key -out 

my_request.csr -config C:\Openssl\bin\openssl.cnf 

5. Follow the on-screen prompts for the required certificate request information. 

6. Generate a self-signed public certificate based on the request: 

>C:\Openssl\bin\openssl.exe x509 -req -days 3650 -in <Request Filename> -

signkey <Encrypted Key Filename> -out <Certificate Filename> 

Where: 

 <Request Filename> is the input filename of the certificate signing request 

 <Encrypted Key Filename> is the input filename of the encrypted private key 

 <Certificate Filename> is the output filename of the public certificate 

For example, type: 

>C:\Openssl\bin\openssl.exe x509 -req -days 3650 -in my_request.csr -signkey 

my_encrypted_key.key -out my_cert.crt 

7. (Optional) You may now delete the request file, as it is no longer needed.  

The resulting encrypted private key file and public certificate file can now be used with EFT Server. 

GENERATING A PKCS#12 PRIVATE KEY AND PUBLIC CERTIFICATE 

This article discusses how to generate a PKCS#12 private key and public certificate file that is suitable for use with 

HTTPS, FTPS, and the administrative port for EFT Server. (To convert an incompatible PKCS#12 format file, refer to 

Converting an Incompatible PKCS#12 Format File to a Compatible PKCS#12.) 

General Information 

 When operating in a FIPS-approved mode, PKI key/certificates must be between 1024- bits and 4096-bits, 

inclusive.  

 The supported cipher combinations allowed for SSL negotiation are limited to: 

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 256 bit AES encryption, and SHA1 HMAC  

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 168 bit 3DES encryption, and SHA1 HMAC  

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 128 bit AES encryption, and SHA1 HMAC 
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Each of the above combinations uses RSA key exchange; therefore, RSA based key/certificates must be 

used. 

 In FIPS Mode, the PKCS#12 format must use compatible encryption and hashing algorithms when 

encrypting the file. The necessary strong encryption will use 3DES and SHA1 encryption. 

Procedure 

These instructions assume you have downloaded and installed the Windows binary distribution of OpenSSL. Refer 

to Using OpenSSL for the general instructions 

1. Generate an RSA private key: 

>C:\Openssl\bin\openssl.exe genrsa -out <Key Filename> <Key Size> 

Where: 

 <Key Filename> is the desired filename for the private key file 

 <Key Size> is the desired key length of either 1024, 2048, or 4096 

For example, type: 

>C:\Openssl\bin\openssl.exe genrsa -out my_key.key 2048 

2. Generate a Certificate Signing Request: 

In version 0.9.8g: 

>C:\Openssl\bin\openssl.exe req -new -key <Key Filename> -out <Request 

Filename> -config C:\Openssl\bin\openssl.cnf 

-OR- 

In version 0.9.8h and later: 

>C:\Openssl\bin\openssl.exe req -new -key <Key Filename> -out <Request 

Filename> -config C:\Openssl\bin\openssl.cfg 

Where: 

 <Key Filename> is the input filename of the previously generated private key 

 <Request Filename> is the output filename of the certificate signing request 

For example, type: 

>C:\Openssl\bin\openssl.exe req -new -key my_key.key -out my_request.csr -

config C:\Openssl\bin\openssl.cnf 

3. Follow the on-screen prompts for the required certificate request information. 

4. Generate a self-signed public certificate based on the request 

>C:\Openssl\bin\openssl.exe x509 -req -days 3650 -in <Request Filename> -

signkey <Key Filename> -out <Certificate Filename> 

Where: 

 <Request Filename> is the input filename of the certificate signing request 

 <Key Filename> is the input filename of the previously generated private key 

 <Certificate Filename> is the output filename of the public certificate 

For example, type: 

>C:\Openssl\bin\openssl.exe x509 -req -days 3650 -in my_request.csr -signkey 

my_key.key -out my_cert.crt 
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5. Generate a PKCS#12 file: 

>C:\Openssl\bin\openssl.exe pkcs12 -keypbe PBE-SHA1-3DES -certpbe PBE-SHA1-

3DES -export -in <Public Certificate Filename> -inkey <Private Key Filename> 

-out <PKCS#12 Filename> -name "<Display Name>" 

Where: 

 <Public Certificate Filename> is the input filename of the public certificate, in PEM 

format 

 <Private Key Filename> is the input filename of the private key 

 <PKCS#12 Filename> is the output filename of the pkcs#12 format file 

 <Display Name> is the desired name that will sometimes be displayed in user interfaces. 

For example, type: 

>C:\Openssl\bin\openssl.exe pkcs12 -keypbe PBE-SHA1-3DES -certpbe PBE-SHA1-

3DES -export -in my_cert.crt -inkey my_key.key -out my_pkcs12.pfx -name "my-

name" 

6. (Optional) Delete unneeded files. At this point, you only need the PKCS#12 format file, so you can delete 

the certificate signing request (.csr) file, the private key (.key) file, and the public certificate (.crt) file.  

The resulting PKCS#12 format file may now be used with EFT Server. 

CONVERTING A PEM-ENCODED PKCS#8 FORMAT ENCRYPTED PRIVATE KEY TO PKCS#8 FORMAT 

This article discusses how to convert an existing PEM-encoded PKCS#8 format encrypted private key into the 

compatible PKCS#8 format for use with EFT Server. (To convert an existing traditional PEM-encoded encrypted 

private key into the compatible PKCS#8 format for use with EFT Server, refer to Converting a Traditional PEM-

Encoded Encrypted Private Key to PKCS#8 Format.) 

General Information 

 When operating in a FIPS-approved mode, PKI key/certificates must be between 1024- bits and 4096-bits, 

inclusive.  

 The supported cipher combinations allowed for SSL negotiation are limited to: 

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 256 bit AES encryption, and SHA1 HMAC  

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 168 bit 3DES encryption, and SHA1 HMAC  

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 128 bit AES encryption, and SHA1 HMAC 

Each of the above combinations uses RSA key exchange; therefore, RSA based key/certificates must be 

used. 

 In FIPS Mode, the private key must use the PKCS#8 format and PKCS#12 compatible encryption of the 

private key, which allows the use of the necessary strong encryption algorithm of 3DES encryption and 

SHA1 hashing. 

 Note that PEM encoded PKCS#8 format encrypted private key files will typically start with the line: 

-----BEGIN ENCRYPTED PRIVATE KEY----- 

 



Configuring Settings Templates and User Accounts 

281 

Procedure 

These instructions assume you have downloaded and installed the Windows binary distribution of OpenSSL. Refer 

to Using OpenSSL for the general instructions 

The private key you want to convert must already be an RSA private key and be between 1024 and 4096 bits in 

length, inclusive. It is only possible to convert the storage format for the private key. Changing the type of key and 

its length is not possible and requires generation of a new private key. 

1. Convert the existing PKCS#8 private key to an unencrypted PEM format. 

C:\Openssl\bin\openssl.exe pkcs8 -in <PKCS#8 Key Filename> -out <Unencrypted 

Key Filename> 

Where: 

 <PKCS#8 Key Filename> is the input filename of the incompatible PKCS#8 private key. 

 <Unencrypted Key Filename> is the output filename of the unencrypted private key in 

PEM format 

For example: 

C:\Openssl\bin\openssl.exe pkcs8 -in my_encrypted_key.key -out 

my_unencrypted_key.pem 

2. Convert the unencrypted key to a compatible pkcs8 format 

>C:\Openssl\bin\openssl.exe pkcs8 -v1 PBE-SHA1-3DES -topk8 -in <Unencrypted 

Key Filename> -out <Encrypted Key Filename> 

Where: 

 <Unencrypted Key Filename> is the input filename of the previously generated 

unencrypted private key. 

 <Encrypted Key Filename> is the output filename of the encrypted private key 

For example: 

>C:\Openssl\bin\openssl.exe pkcs8 -v1 PBE-SHA1-3DES -topk8 -in 

my_unencrypted_key.pem -out my_encrypted_key.key 

3. Delete the unencrypted private key. 

CONVERTING A TRADITIONAL PEM-ENCODED ENCRYPTED PRIVATE KEY TO PKCS#8 FORMAT 

This article discusses how to convert an existing traditional PEM-encoded encrypted private key into the 

compatible PKCS#8 format for use with EFT Server. (To convert an existing PEM-encoded PKCS#8 format encrypted 

private key, refer to Converting a PEM-Encoded PKCS#8 Format Encrypted Private Key to PKCS#8 Format.) 

General Information 

 When operating in a FIPS-approved mode, PKI key/certificates must be between 1024- bits and 4096-bits, 

inclusive.  

 The supported cipher combinations allowed for SSL negotiation are limited to: 

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 256 bit AES encryption, and SHA1 HMAC  

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 168 bit 3DES encryption, and SHA1 HMAC  

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 128 bit AES encryption, and SHA1 HMAC 
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Each of the above combinations uses RSA key exchange; therefore, RSA based key/certificates must be 

used. 

 In FIPS Mode, the private key must use the PKCS#8 format and PKCS#12 compatible encryption of the 

private key, which allows the use of the necessary strong encryption algorithm of 3DES encryption and 

SHA1 hashing. 

 Note that traditional PEM encoded encrypted private key files will typically start with the line: 

-----BEGIN RSA PRIVATE KEY----- 

Proc-Type: 4,ENCRYPTED 

Procedure 

These instructions assume you have downloaded and installed the Windows binary distribution of OpenSSL. Refer 

to Using OpenSSL for the general instructions 

The private key you want to convert must already be an RSA private key and be between 1024 and 4096 bits in 

length, inclusive. It is only possible to convert the storage format for the private key. Changing the type of key and 

its length is not possible and requires generation of a new private key. 

1. Convert the existing traditional PEM encoded encrypted private key to an unencrypted PEM format. 

C:\Openssl\bin\openssl.exe rsa -in <Traditional PEM Key Filename> -out 

<Unencrypted Key Filename> 

Where: 

 <Traditional PEM Key Filename> is the input filename of the incompatible traditional 

format PEM encoded private key. 

 <Unencrypted Key Filename> is the output filename of the unencrypted private key in 

PEM format 

For example, type: 

>C:\Openssl\bin\openssl.exe rsa -in my_key.key -out my_unencrypted_key.pem 

2. Convert the unencrypted key to a compatible pkcs8 format 

>C:\Openssl\bin\openssl.exe pkcs8 -v1 PBE-SHA1-3DES -topk8 -in <Unencrypted 

Key Filename> -out <Encrypted Key Filename> 

Where: 

 <Unencrypted Key Filename> is the input filename of the previously generated 

unencrypted private key. 

 <Encrypted Key Filename> is the output filename of the encrypted private key 

For example, type: 

>C:\Openssl\bin\openssl.exe pkcs8 -v1 PBE-SHA1-3DES -topk8 -in 

my_unencrypted_key.pem -out my_encrypted_key.key 

3. Delete the unencrypted private key. 

CONVERTING AN INCOMPATIBLE PKCS#12 FORMAT FILE TO A COMPATIBLE PKCS#12 

This article discusses how to convert an existing incompatible PKCS#12 format-encrypted private key/public 

certificate file to a compatible PKCS#12 format file. (To generate a PKCS#12 private key and public certificate file 

that is suitable for use with HTTPS, FTPS, and the administrative port for EFT Server, refer to Generating a PKCS#12 

Private Key and Public Certificate.) 
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General Information 

 When operating in a FIPS-approved mode, PKI key/certificates must be between 1024- bits and 4096-bits, 

inclusive.  

 The supported cipher combinations allowed for SSL negotiation are limited to: 

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 256 bit AES encryption, and SHA1 HMAC  

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 168 bit 3DES encryption, and SHA1 HMAC  

o SSLv3/TLSv1 - RSA Key Exchange, RSA Authentication, 128 bit AES encryption, and SHA1 HMAC 

Each of the above combinations uses RSA key exchange; therefore, RSA based key/certificates must be 

used. 

 In FIPS Mode, the PKCS#12 format must use compatible encryption and hashing algorithms when 

encrypting the file. The necessary strong encryption will use 3DES and SHA1 encryption. 

 PKCS#12 files often end with the prefix "p12" or "pfx." Note that "PFX" is an outdated format that is often 

confused with PKCS#12. 

Procedure 

These instructions assume you have downloaded and installed the Windows binary distribution of OpenSSL. Refer 

to Using OpenSSL for the general instructions 

The private key you want to convert must already be an RSA private key and be between 1024 and 4096 bits in 

length, inclusive. It is only possible to convert the storage format for the private key. Changing the type of key and 

its length is not possible and requires generation of a new private key. 

1. Extract the original private key and public certificate from the incompatible PKCS#12 format file into a 

traditional encrypted PEM format 

C:\Openssl\bin\openssl.exe pkcs12 -in <PKCS#12 Filename> -out <Encrypted PEM 

Filename> 

Where: 

 <PKCS#12 Filename> is the input filename of the incompatible PKCS#12 file. 

 <Encrypted PEM Filename> is the output filename in encrypted PEM format that will 

contain both the private key and the public certificate. 

For example: 

>C:\Openssl\bin\openssl.exe pkcs12 -in my_pkcs12.pfx -out 

my_encrypted_pem.pem 

2. Generate a compatible PKCS#12 file 

>C:\Openssl\bin\openssl.exe pkcs12 -keypbe PBE-SHA1-3DES -certpbe PBE-SHA1-

3DES -export -in <Encrypted PEM Filename> -out <PKCS#12 Filename> -name 

"<Display Name>" 

Where: 

 <Encrypted PEM Filename> the encrypted PEM format file generated above. 

 <PKCS#12 Filename> is the output filename of the pkcs#12 format file 

 <Display Name> is the desired name that will sometimes be displayed in user interfaces. 
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For example: 

>C:\Openssl\bin\openssl.exe pkcs12 -keypbe PBE-SHA1-3DES -certpbe PBE-SHA1-

3DES -export -in my_encrypted_pem.pem -out my_new_pkcs12.pfx -name "my-name" 

3. (Optional) Delete unneeded files. At this point, you can delete the temporary unencrypted PEM file. 

The resulting PKCS#12 format file may now be used with EFT Server. 

SFTP 

The topics below provide information regarding using SFTP with the Server.  

EFT SERVER SFTP KEY SUPPORT 

EFT Server supports the following for SFTP keys: 

 Importing multiple keys stored in a single key file 

 Authentication of multiple keys stored in a single key file 

 Association of one or more keys to a user account  

 Assignment of the same key (or keys) to more than one user account. 
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Below is an illustration of a basic SFTP transport and SFTP Public Key authentication sequence. 

 

During the client-server handshake, EFT Server gets the ultimate say in which encryption cipher will be used out of 

the list of ciphers offered by the client and supported by the server. For example, assume EFT Server has the 

following algorithm list: 

aes256-cbc,twofish256-cbc,twofish-cbc,aes128-cbc,twofish128-cbc,cast128-cbc 

And assume the client sends the following list: 

blowfish-cbc,aes128-cbc,twofish128-cbc,cast128-cbc,3des-cbc,arcfour 

Then the matching cipher will be aes128-cbc, because the server scans the client list from left to right and looks for 

the first matching algorithm on the server-side, from left to right. To force strong cipher usage, change EFT Server-

supported algorithms to a list that fits your security needs. 

Clients often present a single key file that has one or more public keys in it. Some servers read in the first key and 

ignore any other keys available in the file, which presents a problem if the public key associated with that user’s 

account is found further down in the public key file presented by the connecting user. It also presents a problem 

when the administrator attempts to import a bunch of keys all located in a single key file.  
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EFT Server evaluates where the delimiters are for each key and parses each key until no more keys are found. In 

the case of client authentication, once a match is made, there is no need to parse the file further (e.g., parse first 

one below, if no match, parse second one, etc., until it reaches the end of file).  

EFT Server maps the selected key (name) to the key assigned to that user, so that when an authentication attempt 

occurs, it is compared to each mapped key, rather than just a single key. The Server does not hide already selected 

keys for different users. That is, if you assign keya.pub to user jsmith, you can then go and assign that same 

keya.pub to bjones as well.  

When EFT Server imports a key file, each imported key is given the same name as chosen by the administrator 

upon importing the key. Same name keys are distinguished by their fingerprint and are displayed in the key 

manager. You can rename keys in the Key Manager. 

All user account names mapped to a particular key are displayed in the Assigned column in the Key Manager. 

Multiple user->key assignments are displayed in comma-delimited format in the Assigned column in ascending 

alpha order. By default, when first importing the key, there are no assigned users; assignment occurs in the user 

account's Security tab. You can assign the same key to multiple users, multiple keys to the same user, and multiple 

keys to multiple users. If any key in the provided key file matches one of the keys mapped to a user who is 

attempting to authenticate, the user is authenticated and no further parsing of the key file is done.  

Below is a sample .pub file containing multiple keys: 

-----BEGIN RSA PUBLIC KEY----- 

mcazCANrC+BCYIywA0I3TVmrv2FTMWo7bpB9rgJx7xGeAZ22JV4IMEI4eCkMor/B 

9ADRUDsYDOKA3yZav3Q4yvG8Z3T+hhqJ2hBob+bj8M4e08C3VwmVRz4j4Y+DnvJo 

HcKvvmRcd2GvWRN3Q3OQ+QePfaQnUkDxnEWd+mrX1kwGv96GPqmrFREjm0eT966B 

qhPtyRa/gNkyoOnXV4/wsXPQb78UnfrFiM0N2CV7v7yj9koaod7p5CCx4ciw4 

A5iEWdmInGcGHEgkP/LBuzOfwoXJWGCwttx0AP0FvZL3iplPmGnfKA== 

-----END RSA PUBLIC KEY----- 

-----BEGIN RSA PUBLIC KEY----- 

mRwnVp5OR7FkLOpXEtxE/JBTvhaLDLFGKPHWxS8c4LYIiPHs/Z5arkCsfZbtZNUD 

iPbj6QzjjNpAp1HvP0749+CTNTqFLnFAEj9d5YFxXLNWVjz8NwWwNSGH2hvuDOxR 

WsixMQg7esHepAvuiwFRyehmhS7wadpdoXxz3dMIFLovxdrhZKSGCOJIUZk5bIjk 

OtHn0RQwe8TXYPe3zJvK6s1ank6hPlyhLsqFhn7KueU75ABPV3U2SlboJUPy6DV+ 

Qk4/B1vcbn4s/Q8Wk1RGZJ5jrGvjT6GcSaQH7y7e4KLzLXlkiSuVFJAqr1nFYa9m 

-----END RSA PUBLIC KEY----- 

SSH KEYS - SECURITY BEST PRACTICES 

You should not use EFT Server's key pair in the client, because doing so would involve sending the client the public 

and private key, creating a potential security vulnerability. It is also an atypical way of setting up public key 

authentication for one or more clients. The common practice is to create the key pair in each client and then make 

the client’s public key available to the Server administrator, who in turn should import the client's public key into 

EFT Server's trusted list.  
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EFT SERVER AND SSH KEY FORMATS 

EFT Server imports the PEM format, also called the SECSH Public Key File Format. For example:  

---- BEGIN SSH2 PUBLIC KEY ---- 

Comment: "4096-bit RSA, converted from OpenSSH by dhopson@VMUbuntu-DSH" 

AAAAB3NzaC1yc2EAAAABIwAAAgEAwrr66r8n6B8Y0zMF3dOpXEapIQD9DiYQ6D6/zwor9o 

39jSkHNiMMER/GETBbzP83LOcekm02aRjo55ArO7gPPVvCXbrirJu9pkm4AC4BBre5xSLS 

7soyzwbigFruM8G63jSXqpHqJ/ooi168sKMC2b0Ncsi+JlTfNYlDXJVLKEeZgZOInQyMmt 

isaDTUQWTIv1snAizf4iIYENuAkGYGNCL77u5Y5VOu5eQipvFajTnps9QvUx/zdSFYn9e2 

sulWM3Bxc/S4IJ67JWHVRpfJxGi3hinRBH8WQdXuUwdJJTiJHKPyYrrM7Q6Xq4TOMFtcRu 

LDC6u3BXM1L0gBvHPNOnD5l2Lp5EjUkQ9CBf2j4A4gfH+iWQZyk08esAG/iwArAVxkl368 

+dkbMWOXL8BN4x5zYgdzoeypQZZ2RKH780MCTSo4WQ19DP8pw+9q3bSFC9H3xYAxrKAJNW 

jeTUJOTrTe+mWXXU770gYyQTxa2ycnYrlZucn1S3vsvn6eq7NZZ8NRbyv1n15Ocg+nHK4f 

uKOrwPhU3NbKQwtjb0Wsxx1gAmQqIOLTpAdsrAauPxC7TPYA5qQVCphvimKuhQM/1gMV22 

5JrnjspVlthCzuFYUjXOKC3wxz6FFEtwnXu3uC5bVVkmkNadJmD21gD23yk4BraGXVYpRM 

IB+X+OTUUI8= 

---- END SSH2 PUBLIC KEY ---- 

EFT Server looks for the BEGIN and END tags when importing.  

The other and very common format is the OpenSSH format. If you generated your key on a *nix box, it is most 

likely in this format. Here is the same public key in OpenSSH format:  

ssh-rsa  

AAAAB3NzaC1yc2EAAAABIwAAAgEAwrr66r8n6B8Y0zMF3dOpXEapIQD9DiYQ6D6/zwor9o 

39jSkHNiMMER/GETBbzP83LOcekm02aRjo55ArO7gPPVvCXbrirJu9pkm4AC4BBre5xSLS 

7soyzwbigFruM8G63jSXqpHqJ/ooi168sKMC2b0Ncsi+JlTfNYlDXJVLKEeZgZOInQyMmt 

isaDTUQWTIv1snAizf4iIYENuAkGYGNCL77u5Y5VOu5eQipvFajTnps9QvUx/zdSFYn9e2 

sulWM3Bxc/S4IJ67JWHVRpfJxGi3hinRBH8WQdXuUwdJJTiJHKPyYrrM7Q6Xq4TOMFtcRu 

LDC6u3BXM1L0gBvHPNOnD5l2Lp5EjUkQ9CBf2j4A4gfH+iWQZyk08esAG/iwArAVxkl368 

+dkbMWOXL8BN4x5zYgdzoeypQZZ2RKH780MCTSo4WQ19DP8pw+9q3bSFC9H3xYAxrKAJNW 

jeTUJOTrTe+mWXXU770gYyQTxa2ycnYrlZucn1S3vsvn6eq7NZZ8NRbyv1n15Ocg+nHK4f 

uKOrwPhU3NbKQwtjb0Wsxx1gAmQqIOLTpAdsrAauPxC7TPYA5qQVCphvimKuhQM/1gMV22 

5JrnjspVlthCzuFYUjXOKC3wxz6FFEtwnXu3uC5bVVkmkNadJmD21gD23yk4BraGXVYpRM 

IB+X+OTUUI8= dhopson@VMUbuntu-DSH 

To make a key 

1. To generate the key, on a Linux computer, type:  

ssh-keygen -t rsa 

2. To convert to PEM format, on a linux box, type (assuming your public key is id_rsa.pub):  

ssh-keygen -e -f id_rsa.pub > yourfilename.pub  

-i is the inverse of the -e switch  

I see the fingerprint in EFT Server. How do I see the fingerprint in Linux? 

Assuming your public key is id_rsa.pub, on a Linux computer, type: 

ssh-keygen -l -f id_rsa.pub  
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This will return three things:  

 the bit strength (4096 ) 

 the fingerprint (18:9f:7d:8f:e0:ab:13:56:b7:49:89:b3:07:93:9f:da ) 

 the filename (id_rsa.pub ) 

The string returned from this example public key is: 

4096 18:9f:7d:8f:e0:ab:13:56:b7:49:89:b3:07:93:9f:da id_rsa.pub 

Linux has standard folders/files for SSH:  

 The SSH files are stored in "~/.ssh"  

The tilde ~ is an alias for the user home folder, e.g., /home/<your username> 

 The public key filename is the private key filename with .pub as the extension. 

 Stored (known) server fingerprints are written to known_hosts  

This is used to detect "man in the middle" attacks. If the host fingerprint changes, SSH will report an error. 

 The file authorized_keys is used to store public keys  

This is used to allow the user to maintain a collection of identity keys in one place (easier to backup and 

restore). The authorized_keys file is a collection of public keys, created by simply echoing out (cat) 

the contents of a public key, appending it to the bottom of the existing authorized_keys file.  

 SSH keys must have 600 or more restrictive permissions in place  

If permissions are too open, SSH will report an error and refuse to run until you correct the security 

problem. 

CREATING AN SSH KEY PAIR 

In the Administrator, you can define an SSH key pair for the Server and connecting clients. A wizard walks you 

through each step to create and store the key pair files.  

To create a key pair 

1. In the Administrator, connect to the Server and click the Server tab. 

2. On the main menu, click Tools > Create SSH2 Key. 

The Create SSH2 Public/Private Keypair wizard appears. 
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3. Click either Server or Client, then click Next. The location and options page appears. 

 

4. Specify a name for the key pair. The default is "New Server Key" or "New Client Key," but you can name it 

anything. 

5. Specify a location to store the key pair (e.g., C:\Documents and Settings\Administrator\My Documents). 

6. Click Next. The password page of the wizard appears. 
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7. Provide and confirm the passphrase used to encrypt the private key. The passphrase cannot contain more 

than 256 characters, cannot contain only spaces and periods, and cannot contain the following characters:  

/ (forward slash) 

\ (back slash) 

[ (left bracket) 

] (right bracket) 

; (semicolon) 

:  (colon) 

|  (pipe) 

= (equal sign) 

,  (comma) 

+ (PLUS sign) 

? (question mark) 

< (left angle bracket) 

> (right angle bracket) 

{ (left curly brace) 

} (right curly brace 

8. Click Next. If you chose Server, the Site page appears. (Otherwise, skip this step.) 

 

9. Select the Use this key pair for server authentication check box if you need to use the key pair for Server 

authentication. 
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10. In the Apply to box, specify the Site to which the key pair applies. (This box is not available if the check 

box is not selected.) 

11. Click Finish. While the Server is creating the key, the Generating Key Pair message appears. 

 

 
 

then a confirmation message appears. 

12. The confirmation message displays the location and file names of the key pair files. Click Yes to continue 

or No if you do not want to add the public key to the SFTP key manager. 

13. If you click Yes, the Add key to storage dialog box appears. 

 

 

14. Provide a descriptive name for the public key, then click OK. The new key will now appear in the SSH Key 

Manager. 

VIEWING OR MODIFYING MESSAGE AUTHENTICATION CODES (MAC) SETTINGS 

Message Authentication Codes (MAC) are algorithms used to confirm data has not been altered between the client 

and server. Some cipher algorithms allow for variable sized keys, while others only allow a specific key size. The 

length of the key correlates with the strength of that algorithm; larger keys are harder to break than shorter keys.  

EFT Server supports the following encryption algorithms: 

 twofish-cbc (256 bits) 

 twofish128-cbc (128 bits) 

 blowfish-cbc (128 bits) 

 3des-cbc (192 bits) 

 arcfour (128 bits) 

 cast128-cbc (128 bits) 

 aes256-cbc (256 bits) 

 twofish256-cbc (256 bits) 

 aes128-cbc (128 bits) 

To select Message Authentication Codes (MAC) 

1. In the Administrator, connect to the Server and click the Server tab.  

2. In the left pane, select the Site you want to configure. 

3. In the right pane, select the Connections tab. 
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4. Click SFTP Config. The SFTP Settings dialog box appears. 

5. In the Allowed MACs list, clear or select the check boxes to specify which algorithms you want to use for 

message authentication.  

6. Click OK to close the dialog box. 

7. Click Apply. The Server tries each selected MAC with the client until an algorithm is agreed upon. 

CREATING SFTP ALGORITHMS  

To select encryption algorithms (ciphers)  

1. In the Administrator, connect to the Server and click the Server tab. (SFTP should be enabled.) 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, select the Connections tab. 
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4. Select the SFTP (SSH2) check box, then specify the port, if different than the default shown.  

5. Click SFTP Config. The SFTP Settings dialog box appears. 

6. In the Allowed ciphers list, clear or select the check boxes to specify which ciphers you want to allow for 

encrypting SFTP sessions.  

 Twofish - Twofish is an improved version of Blowfish. EFT Server recognizes Twofish encryption 

using 128 and 256 bit keys.  

 Blowfish - The Blowfish algorithm is a public-domain block cipher method using a 128-bit key. 

Blowfish was intended to be a replacement for 3DES. It provides good security.  

 Triple DES (3DES) - This algorithm uses a 24-bit "triple key" to encrypt data 3 times. The 24-bit 

key is split into 3 8-bit segments and each is used for encryption. Triple DES is fast, but not as 

strong as the other algorithms.  

 ARCFOUR - Arcfour is intended to be compatible with the RC4 cipher trademarked by RSA Data 

Security, makers of the famous OpenPGP program. It uses a 128-bit key and provides good 

security.  

 cbc - Cipher Block Chaining is an encryption technique used with block ciphers where the 

previous encrypted block is used as a basis for encrypting the next block, so that every block has 

to be in the correct order to be decrypted properly. 

 CAST128 - CAST block cipher using 128 bit keys.  
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 aes128 - Advanced Encryption Standard (AES) block cipher using 128 bit keys. 

7. Click OK to close the dialog box. 

8. Click Apply to save the changes on the Server. The Server tries each selected algorithm with the client 

until one is agreed upon. 

VIEWING, IMPORTING, RENAMING, AND DELETING CLIENT KEYS 

SFTP/SSH Keys defined for a Site appear in the SSH Key Manager. The Key Manager displays the key name, 

fingerprint, and username assigned.  

To view, import, rename, or delete keys  

1. In the Administrator, connect to the Server and click the Server tab. (SFTP should be enabled.) 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, select the Connections tab. 

4. Select the SFTP (SSH2) check box, then specify the port, if different than the default shown.  

5. Click SFTP Config. The SFTP Settings dialog box appears. 

6. Click Manage. The SSH Key Manager appears. 

 

 

 Name - displays the name of the key. When a key is imported, no assigned usernames are 

displayed.  

 Fingerprint - displays the fingerprint of the key. 

 Assigned - displays the username(s) assigned to the key. Multiple usernames are separated by 

commas. 

 

To assign one or more users to a key, refer to Enabling and Managing Connection Protocols. 

7. Do one of the following: 

 To sort keys, click the Name or the Fingerprint column. 

 To import keys, click Import, then browse for and select the key. You can import any .pub file 

accessible from the computer on which the Administrator is installed. 
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 To delete a key, click the key in the list, then click Delete. 

 To rename a key, click the key in the list, then click Rename, or press F2. 

8. Click Close to close the SSH Key Manager. 

9. Click OK to close the SFTP Settings dialog box. 

10. Click Apply to save the changes on the Server. 

MODIFYING THE SFTP IDENTIFICATION STRING (OPTIONAL) 

 

This procedure is for advanced users; in most cases, you will not need to use this procedure. 

When an SFTP (SSH) connection has been established, both the server and client must send an identification string. 

This identification string must be in the format: 

SSH-protoversion-softwareversion SP comments CR LF 

The Server hard codes SSH-2.0 into the format; you provide only the software version and, optionally, comments. 

The software box must consist of printable US-ASCII characters, with the exception of whitespace characters and 

the minus sign (-). 

To modify the SFTP identification string (optional)  

1. In the Administrator, connect to the Server and click the Server tab. (SFTP should be enabled.) 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, select the Connections tab. 

4. Select the SFTP (SSH2) check box, then specify the port, if different than the default shown.  

5. Click SFTP Config. The SFTP Settings dialog box appears. 

6. In the Optionally specify area, specify the software version and comments. 

7. Click OK to close the dialog box. 

8. Click Apply to save the changes on the Server. 

  

 

For more information about modifying the SFTP identification string, refer to 
http://www.ietf.org/rfc/rfc4253.txt section 4.2. 

CONFIGURING SFTP FOR A SITE 

When you enable SFTP for a Site, you must configure the SFTP settings. 

To configure SFTP for a Site 

1. Before you can enable and configure SFTP on the Site, you must create or import an SFTP key defined on 

the Site. 

2. In the Administrator, connect to the Server and click the Server tab. 

3. In the left pane, select the Site you want to configure. 

4. In the right pane, select the Connections tab. 

http://www.ietf.org/rfc/rfc4253.txt
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5. Select the SFTP (SSH2) check box, then specify the port number, if different than the default. 

6. Click SFTP Config. The SFTP Settings dialog box appears. 
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The key that you created when you defined the Site (if you enabled SFTP and created keys) appears in the 

SFTP settings dialog box. If you did not enable SFTP when you created the Site, the dialog box is empty. 

7. Do one of the following: 

 To create a key pair, click Create. The SSH2 Key Pair Generation Wizard appears. Refer to 

Creating an SSH Key Pair for instructions, if necessary. 

 To specify an existing key pair, click the open icon   then browse for and select a key pair 

(.pvk) file.  

 Click Export to extract and export the public key (.pub). A Save As dialog box appears in which 

you can specify a name and location for the .pub file. 

 Click Manage to view, import, rename, and/or delete keys. 

8. Specify the SFTP private key path, public key path, public key blob, allowed ciphers, allowed MACs, and 

SFTP identification string, as necessary. 

9. Click OK to close the dialog box. 

10. Click Apply to save the changes on the Server. 
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ENABLING SFTP FOR A SITE 

SFTP is configured at the Site level on the SFTP tab, and then enabled at the Site, Settings Template, and/or per 

user. 

To enable SFTP for a Site 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, select the Site you want to configure. 

3. In the right pane, select the Connections tab. 

4. Select the SFTP (SSH2) check box. If no SFTP key pair is assigned to the Site, a prompt appears.  

5. Do one of the following: 

 Click SFTP Keys. The SFTP Settings dialog box appears in which you can create, export, or manage 

keys. Refer to Configuring SFTP for a Site for instructions. 

 If you click Cancel, the check box is cleared.  

6. Specify the port, if different than the default shown.  

7. Click Apply to save the changes on the Server. 

8. To configure or change SFTP settings later, Refer to Configuring SFTP for a Site for details. 

SPECIFYING SFTP AUTHENTICATION OPTIONS 

SFTP is configured and enabled at the Site level. You can also disable and enable SFTP access at Settings Template 

and user level, and specify the SFTP authentication options for a Settings Template or specific user. 

Refer to Configuring SFTP Authentication Options for details. 

EXTRACTING THE PUBLIC SFTP KEY 

If you require clients to authenticate with a public key to access the Site, you need to provide them with the public 

key file (.pub). You can extract the public key from the SFTP key on the Connections tab of the Site.  

To configure SFTP for a Site 

1. Before you can enable and configure SFTP on the Site, you must create or import an SFTP key defined on 

the Site. 

2. In the Administrator, connect to the Server and click the Server tab. 

3. In the left pane, select the Site you want to configure. 

4. In the right pane, select the Connections tab. 
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5. Select the SFTP (SSH2) check box, then specify the port number, if different than the default. 

6. Click SFTP Config. The SFTP Settings dialog box appears. 
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The key that you created when you defined the Site (if you enabled SFTP and created keys) appears in the 

SFTP settings dialog box. If you did not enable SFTP when you created the Site, the dialog box is empty. 

7. Click Export to extract and export the public key (.pub). A Save As dialog box appears in which you can 

specify a name and location for the .pub file. 

8. Click OK to close the dialog box. 

9. Click Apply. 

HTTP AND HTTPS 

The topics below provide the procedures for using HTTP and HTTPS on the Site. 

HTTP AND HTTPS OVERVIEW 

 

If you specify HTTP for an HS-enabled Site, the Server prompts you to disable these unsecure protocols, or 
continue with reason. 

HTTP 

HTTP is the communication protocol for establishing a connection with a Web server and transmitting HTML pages 

to the client browser or any other files required by an HTTP client application.   
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HTTP is often referred to as a "stateless" protocol. The connection is maintained between client and server only for 

the immediate request, after which the connection is subsequently closed. Each time you need something from 

the Server, your client (browser) makes a connection, gets that file, and then the connection is closed. Since you do 

not connect and stay connected, the browser remembers your username and password for you, so it can send the 

authentication hash along with every new connection request.  

For example, when you type http://www.globalscape.com/eft/whatsnew.aspx in your browser's address bar and 

press ENTER, your browser uses HTTP as specified in the URL to send a command to the Server running at the host 

name www.globalscape.com with the HTTP command "GET /eft/whatsnew.aspx HTTP/1.1," and the 

Server replies with that file (the HTML that makes up the page). In that page, there are references to a number of 

files (e.g., images, CSS documents, flash files), and your browser makes a separate connection to get each one of 

those resources. 

HOW DOES HTTP SUPPORT IN THE SERVER DIFFER FROM A TYPICAL WEB SERVER?  

EFT Server is primarily a file transfer server, not a Web server. This means it is not meant to "serve up" Web pages 

such as a typical Web server does for connecting HTTP clients (such as your Web browser). However, there are 

provisions for transferring files in the HTTP protocol, which is a convenience when a connecting partner, customer, 

or employee does not have an FTP client installed, but does have an HTTP client or access to a Web page with 

HTTP PUT capabilities (usually an ActiveX control or Java applet).  

When EFT Server is configured to allow HTTP file transfers, any HTTP client will be able to PUT (upload) or GET 

(download) files to the Server, provided the client supports both of these HTTP commands. Most Web browsers 

only support the GET command or, if they support the PUT command, they provide no interface for browsing to 

the user's local file system to select and upload (PUT) files onto EFT Server. A few dedicated clients (such as 

CuteFTP Professional) and various thin clients (based on ActiveX controls or Java applets) support both PUT and 

GET capabilities, allowing these clients to transfer files to the Server in both directions. 

(For more information about standard HTTP/1.1 methods, refer to http://tools.ietf.org/html/rfc2616#section-

5.1.1.) 

In addition, EFT Server supports a subset of the WebDAV protocol, which is an extension to HTTP that adds more 

methods (refer to http://tools.ietf.org/html/rfc4918#section-9). Specifically, EFT Server supports "MKCOL" to 

create a folder, "MOVE" to move a file or folder, and "COPY" to copy a file or folder. 

HTTP LIMITATIONS IN THE SERVER 

 The Server allows you to customize messages sent by the Server upon connection, login, maximum 

connections reached, and disconnect (for FTP sessions). Due to the nature of the HTTP protocol, custom 

login messages are not displayed for connecting HTTP clients. 

 Another limitation of HTTP is that after a connection is established, the browser sees the Server's root 

folder instead of the user's home holder. A workaround is to setup a distinct Site for HTTP sessions. 

 Microsoft Internet Explorer browsers that have installed MS04-004 Cumulative Security Update for 

Internet Explorer (832894), no longer support URLs that contain username info, even though they are 

properly formed URLs. This problem is unique to Internet Explorer, and does not affect the other major 

browsers. For more information, refer to http://www.microsoft.com/technet/security/Bulletin/MS04-

004.asp.  

 If you create an Event Rule that sends a notification e-mail for each successful login event, an e-mail is 

sent every time a user connected through HTTP changes directories. This is a result of HTTP being a 

stateless protocol and can result in a large volume of notification e-mails even when performing typical 

directory browsing. 

http://tools.ietf.org/html/rfc2616#section-5.1.1
http://tools.ietf.org/html/rfc2616#section-5.1.1
http://tools.ietf.org/html/rfc4918#section-9
http://www.microsoft.com/technet/security/Bulletin/MS04-004.asp
http://www.microsoft.com/technet/security/Bulletin/MS04-004.asp
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HTTPS 

HTTPS is the protocol for accessing a secure Web server when authentication and encrypted communication is 

possible. Using HTTPS in the URL instead of HTTP directs the message to a secure port number rather than the 

default Web port number of 80. The default TCP/IP port of HTTPS is 443. The session is then managed by a security 

protocol. HTTPS encrypts the session data using the SSL (Secure Socket Layer) protocol ensuring reasonable 

protection from eavesdroppers and man-in-the-middle attacks.  

Secure Socket Layer (SSL) is a protocol for encrypting and decrypting data across a secure connection from a client 

to a server with SSL capabilities. The server is responsible for sending the client a certificate and a public key for 

encryption. If the client trusts the Server's certificate, an SSL connection can be established. All data passing from 

one side to the other will be encrypted. Only the client and the Server will be able to decrypt the data. The SSL 

protocol is the same protocol used in FTPS. 

The following elements work together to establish a secure HTTPS connection:  

Client: The client must have SSL capabilities. 

Certificate: Certificates are digital identification documents that allow both servers and clients to authenticate 

each other. A certificate file has a .crt extension. Server certificates contain information about your company and 

the organization that issued the certificate (such as Verisign or Thawte) while client certificates contain 

information about the user and the organization that signed the certificate. You can choose to either trust or 

distrust a certificate. In some cases, the client's certificate must be signed by the Server's certificate to establish an 

SSL connection. 

Session Key: The client and the Server use the session key to encrypt data. It is created by the client via the 

Server’s public key. 

Public Key: The client encrypts a session key with the Server’s public key. It does not exist as a file, but is produced 

when a certificate and private key are created. 

Private Key: The server's private key decrypts the client's session. The private key has a .key extension and is part 

of the public-private key pair. 

Certificate Signing Request: A Certificate Signing Request (CSR) is a PKCS10 request, which is an unsigned copy of 

your certificate. A certificate signing request is generated each time a certificate is created. A certificate signing 

request has a .csr extension. This file is used when you need to have your certificate signed. Once the Certificate 

Signing Request file is signed, a new certificate is made and can be used to replace the unsigned certificate. 

 

In Web pages that use HTTPS, the URL begins with https: rather than http:. HTTP clients should connect using 
standard requests (i.e., https://domain_name). You can configure the Server to provide connecting clients 
with a certificate, and can require that the client provide a certificate upon connection (to further validate the 
client's identity). 

REDIRECTING HTTP TO HTTPS 

The HS module allows you to redirect HTTP connections to HTTPS. If you do not activate the HS module, this 

feature is disabled after the 30-day trial expires. 

If you have configured HTTPS transfers on the Site, you can redirect HTTP to HTTPS at the Site level. Doing so 

disables HTTP transfers.  

The Server simply tells the connecting client that the resource was moved to the new HTTPS URL. The connecting 

client decides whether it will allow the redirect, because the new URL could be on a different server.  
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In general, the redirect process includes the following steps: 

1. Client sends a request to the HTTP port (by default, port 80). 

2. The Server redirects all plain HTTP requests to HTTPS (by default, port 80 to port 433). The Server replies 

to the client with 302 code (the requested resource resides temporarily under a different URL), and sends 

to the client the new URL where the resource is now located.  

3. The client now knows that the resource is not available at the old URL and knows the new URL. Client 

decides whether it wants to connect to the new URL and get this resource. 

Refer to RFC 2616, section 10, http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html, for more information 

about redirection on HTTP. 

The redirect HTTP to HTTPS option affects incoming AS2 requests through HTTP. If the connecting AS2 client does 

not allow redirection to a different port, the connection will fail.  

 

Even if Enable HTTP Transfers is selected at the user or Settings Template, HTTP transfers will be redirected 
to the HTTPS port (443 by default). 

To redirect HTTP to HTTPS 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Connections tab. 

 

http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html
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4. Select the Redirect HTTP to HTTPS check box.  

5. Click Apply to save the changes on the Server. 

CONFIGURING HTTP OR HTTPS TRANSFERS ON THE SITE 

You can enable or disable HTTP or HTTPS transfers at the Site, User Setting Level, or per user. 

To enable HTTP or HTTPS transfers at the Site level 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Select the HTTP or HTTPS (SSL) check box and specify the port. The default port numbers are 80 and 443. 

The Site's domain appears in the Domain box. (Note that Microsoft IIS also uses port 80 by default, so you 

will have to change one of them.) 

5. Specify whether to allow account management over HTTP/S and whether to redirect HTTP connections to 

HTTPS. 

6. Click Apply to save the changes on the Server. 
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LIST OF HTTP STATUS AND ERROR CODES 

During your HTTP sessions, you will receive various numbered codes from Web servers. Some codes represent 

errors; most others simply communicate the status of the connection. Below are brief explanations for the most 

common status and error codes. 

Code Description 

100 
Series 

Informational - These status codes indicate a provisional response. The client should be 
prepared to receive one or more 1xx responses before receiving a regular response. 

100 Continue. 

101 Switching protocols. 

200 
Series 

Success - This class of status codes indicates that the server successfully accepted the client 
request. 

200 
Okay - The client request has succeeded This status code indicates that the Web server has successfully 
processed the request 

201 Created. 

202 Accepted. 

203 Non-authoritative information. 

204 No content. 

205 Reset content. 

206 Partial content. 

300 
Series 

Redirection - The client browser must take more action to fulfill the request. For example, 
the browser may have to request a different page on the server or repeat the request by 
using a proxy server. 

302 Object moved. This error can occur when you have configured HTTP to HTTP redirection. 

304 
Not modified. The client requests a document that is already in its cache and the document has not 
been modified since it was cached. The client uses the cached copy of the document, instead of 
downloading it from the server 

307 Temporary redirect. 

400 
Series 

Client Error - An error occurs, and the client appears to be at fault. For example, the client 
may request a page that does not exist, or the client may not provide valid authentication 
information. 

400 Bad request. 

401 Access denied. 

401.1 
Logon failed. The logon attempt is unsuccessful, probably because of a user name or password that is 
not valid. 

401.2 Logon failed due to server configuration. 

401.3 
Unauthorized due to ACL on resource. This indicates a problem with NTFS permissions. This error may 
occur even if the permissions are correct for the file that you are trying to access. For example, you see 
this error if the IUSR account does not have access to the C:\Winnt\System32\Inetsrv directory. 

401.4 Authorization failed by filter. 

401.5 Authorization failed by ISAPI/CGI application. 
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Code Description 

401.7 Access denied by URL authorization policy on the Web server. This error code is specific to IIS 6.0. 

403 Forbidden. 

403.1 

Execute access forbidden. The following are two common causes of this error message: 

 You do not have enough Execute permissions. For example, you may receive this error message 
if you try to access an ASP page in a directory where permissions are set to None, or you try to 
execute a CGI script in a directory with Scripts Only permissions.  

 The script mapping for the file type that you are trying to execute is not set up to recognize the 
verb that you are using (for example, GET or POST). 

403.2 
Read access forbidden. Verify that you have Read access to the directory. Also, if you are using a default 
document, verify that the document exists. 

403.3 Write access forbidden. Verify that you have Write access to the directory 

403.4 SSL required. Use HTTPS instead of HTTP to access the page. 

403.5 SSL 128 required. 

403.6 IP address rejected. 

403.7 Client certificate required. You do not have a valid client certificate installed 

403.8 Site access denied. 

403.9 Too many users. The number of users who are connected to the server exceeds the connection limit. 

403.10 Invalid configuration. 

403.11 Password change. 

403.12 
Mapper denied access. The page that you want to access requires a client certificate, but the user ID 
that is mapped to your client certificate has been denied access to the file. 

403.13 Client certificate revoked. 

403.14 Directory listing denied. 

403.15 Client Access Licenses exceeded. 

403.16 Client certificate is untrusted or invalid. 

403.17 Client certificate has expired or is not yet valid. 

403.18 Cannot execute requested URL in the current application pool. This error code is specific to IIS 6.0. 

403.19 Cannot execute CGIs for the client in this application pool. This error code is specific to IIS 6.0. 

403.20 Passport logon failed. This error code is specific to IIS 6.0. 

404 Not found. This error may occur if the file that you are trying to access has been moved or deleted. 

404.0 File or directory not found. 

404.1 Web site not accessible on the requested port. 

404.2 Web service extension lockdown policy prevents this request. 

404.3 MIME map policy prevents this request. 

405 HTTP verb used to access this page is not allowed (method not allowed). 

406 Client browser does not accept the MIME type of the requested page. 

407 Proxy authentication required. 
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Code Description 

412 Precondition failed. 

413 Request entity too large. 

414 Request-URL too long. 

415 Unsupported media type. 

416 Requested range not satisfiable. 

417 Execution failed. 

423 Locked error. 

500 
Series 

Server Error - The server cannot complete the request because it encounters an error. 

500 Internal server error. You see this error message for a wide variety of server-side errors. 

500.12 

Application is busy restarting on the Web server. Indicates that you tried to load an ASP page while IIS 
was in the process of restarting the application. This message should disappear when you refresh the 
page. If you refresh the page and the message appears again, it may be caused by antivirus software 
that is scanning your configuration file. 

500.13 Web server is too busy. 

500.15 Direct requests for configuration are not allowed. 

500.16 UNC authorization credentials incorrect. This error code is specific to IIS 6.0. 

500.18 URL authorization store cannot be opened. This error code is specific to IIS 6.0. 

500.100 
Internal ASP error. You receive this error message when you try to load an ASP page that has errors in 
the code. 

501 Header values specify a configuration that is not implemented. 

502 
Bad Gateway. Web server received an invalid response while acting as a gateway or proxy. You receive 
this error message when you try to run a CGI script that does not return a valid set of HTTP headers. 

502.1 CGI application timeout. 

502.2 Error in CGI application. 

503 Service unavailable. This error code is specific to IIS 6.0. 

504 Gateway timeout. 

505 HTTP version not supported. 

ALLOWING AS2 CONNECTIONS TO A SITE 

AS2 connections must be configured on the Server before you can enable AS2 connections in the Site, Settings 

Template, or user account. 

 

AS2 is a separately licensed product. It is available during the trial period; however, when the Server trial 
expires, the AS2 module trial also expires. 

To allow AS2 connections to a Site 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure. 
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3. In the right pane, click the Connections tab. 

 

4. In the Listener Settings area, select the AS2 check box. 

5. Click AS2 Config. Refer to Enabling the AS2 Inbound Listener Service for details of AS2 configuration. 

6. Click Apply to save the changes on the Server. 

ENABLING THE ACCOUNT-MANAGEMENT PAGE 

 

Account management features only apply to Sites using GlobalSCAPE or ODBC authentication. This option is 
not available if other authentication types are used.  

The Server provides an HTTPS account management page on which users can reset their password, if so configured 

in the Administrator. (For details of the AS2 account management page, refer to AS2 Account Management Web 

Page.) 

The https:// page is hard-coded to /manageaccount with the default port of 443. If the Server HTTPS port is set to 

a different port, you must change the port number, and the user must provide the port number in the URL to log 

into the page (e.g., https://192.168.50.126/manageaccount:4433).  

Refer to Changing a Site's IP Address or Port for the procedure for changing the port number.  

It is strongly recommended that you enable the account management page over HTTPS (using the procedure 

below) so that your users will be able to change their passwords.  
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To enable the account management page 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure. 

3. In the right pane, click the Connections tab. 
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4. Select the HTTPS check box. 

5. Select the Enable account management page over HTTPS check box. The URL is displayed in the text box 

to the right (e.g., https://localhost/manageaccount). The URL is not editable, but you can select and copy 

it to provide to users. 

 

6. Click Apply to save the changes on the Server. 

ENABLING WEB SERVICES 

In EFT Server Enterprise, Web Services allows administrators to initiate the Server workflow from an external 

application such as an enterprise scheduler.  

To enable Web services 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure. 

3. In the right pane, click the Connections tab. 
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4. Select the Enable Web Services check box. 

5. Click Apply to save the changes on the Server. 

PASSWORD SECURITY SETTINGS 

The topics below provide the procedures for configuring the password rules for a Site. 

ALLOWING OR FORCING PASSWORD RESET AT THE SITE LEVEL 

The Server provides the option to force password reset. On HS-enabled Sites, users are forced to change their 

passwords on first use.  

You can enable the password reset page while disallowing general access to HTTP or HTTPS. When a new user logs 

in to the Server via the HTTP or HTTPS index page, the Server redirects the user to the reset page. After the user 

creates a new password, they are returned to the index page. 

 

Password initial reset, expiration, and account management features only apply to GlobalSCAPE and ODBC 
authentication Sites. These options are not available if other authentication types (AD, LDAP) are used.  
 
There is no way to ask FTP users to change their password prior to logging in. We must allow them to actually 
login (authenticate) but then prevent any further interaction with their session until they change their 
password.  
 
Refer to Using the PCI Module with the Secure Ad Hoc Transfer Module if you are using a High Security Site. 
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When a user logs in to the HTTPS index page and the Force reset check box is selected, the user is automatically 

redirected to the account-management page if: 

 The /manageaccount page is enabled and the user logs in with a temporary password. 

 The /manageaccount page and Redirect HTTP to HTTPS options are enabled, and the user logs in with a 

"temporary" password. 

 The user logs in with a temporary password to the FTP port or SFTP engine. (No commands are allowed 

other than exiting or changing the password until the password has been changed, and the user is 

prompted to change the password.) 

 An administrator logs in using a temporary password. A warning appears to prompt the administrator to 

supply a new password.  

To configure the Site to enforce password reset 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure. 

3. In the right pane, click the Security tab. 

 

4. Select the Allow users to reset their passwords check box.  

 If you want users to reset their password upon initial login, select the Force users to reset their 

passwords on initial login check box.  

 If you want to expire user passwords, configure password expiration options. 

5. Click Apply to save the changes on the Server. Users will be prompted to change their password when 

they log in to the Site. 
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ENFORCING COMPLEX PASSWORDS AT THE SITE LEVEL 

The HS module allows you to enforce the use of complex passwords. If you do not , this feature is disabled after 

the 30-day trial expires. 

 

PCI DSS requirement 8.5.10 states that you should require a minimum password length of at least seven 
characters. PCI DSS requirement 8.5.11 states that you should use passwords containing both numeric and 
alphabetic characters.  

When you create or update a user account, you can require the user to create strong (complex) passwords. 

Complex passwords are enabled by default when you create a  Site. A complex password must meet the following 

criteria: 

 Minimum length (from 6 to 99 characters).  

 Contain N or more characters from the user's account name  

 Not contain N or more repeating characters.  

 Not be comprised solely of a word in a dictionary file (forward or backwards) 

 Contain at least one character from each of the following categories. The number of characters can never 

be fewer than the number of chosen categories, but can be greater.  

o English uppercase characters (A - Z) 

o English lowercase characters (a - z) 

o Base 10 digits (0 - 9) 

o Non-alphanumeric (for example: !, $, #, or %) or Unicode characters  

 

Non-alphanumeric characters are not required by default; you must explicitly specify this 
option if you want to require it. For those who might be using a non-English language 
operating system, it is best to leave the Non alpha-numeric check box cleared because of 
characters that are not normally found on a standard keyboard. In this case, your users are 
free to use non-alphanumeric characters when they create their own password, you just 
would not require that they do, and the system will not include them when you 
automatically generate a complex password. 



Configuring Settings Templates and User Accounts 

315 

 

For example, suppose you specified that the password must: 

 contain at least 6 characters 

 contain uppercase letters 

 contain lowercase letters 

 contain numbers 

That means that the password must contain at least one uppercase character, at least one lowercase character, 

and at least one digit. So in this case, a password could be A5s3*v35, but not a5s3*v35, because you specified 

that a password should have at least one uppercase letter. 

 

When using EFT Server with the Secure Ad Hoc Transfer (SAT) module, if the password settings are set to use a 
minimum of more than 20 characters, the SAT temporary user creation will fail. If your Site's complex 
password settings require more than 20 characters, be sure to configure the Ad Hoc Settings Template to 
override the Site's password settings so that complex passwords for Ad Hoc users contain fewer than 20 
characters. 

To enforce complex passwords on user accounts 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure, then click the Security tab.  
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3. Select the Enforce strong (complex) passwords check box, then click Configure. The Password complexity 

settings dialog box appears. 
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4. Refer to the guidelines in the table below:  

Field  Default  Min/Max Values  

Minimum password length - Specify the minimum 
number of characters that must be in the password. 

8 6 - 99  

In the Character categories area, specify the type of 
characters that must be in the password:  

The password must contain characters from at least 
N of the following categories:  

 Uppercase  

 Lowercase  

 Numeric (0-9)  

 Non alpha-numeric (e.g., !, #, $, %) 

3  
categories 

2 categories, up to the 
maximum password length  

Must not contain N or more characters from the 
user name  

3 2 characters, up to 
maximum password length  

Must not contain N or more repeating characters.  3 2 characters, up to 
maximum password length  

Must not consist solely of a word in the following 
Dictionary file.  

(Click the ellipse icon  to select a file.) 

on n/a 

Must not be a dictionary word backwards  off n/a 

5. Click OK to save the settings or Cancel to keep existing settings. 

4. Click Apply to save the changes to the Server. 

EXPIRING PASSWORDS AT THE SITE LEVEL 

The HS module provides the option to expire passwords. If you do not activate the HS module, this feature is 

disabled after the 30-day trial expires. 

On HS-enabled Sites, users are forced to change their passwords on first use. Each day it also checks whether 

passwords are <n> days from expiration, and those passwords are flagged for reminders, if reminders are enabled. 

All reminder e-mail messages are sent immediately after flagging the accounts to be reminded.  

You can enable the password reset page while disallowing general access to HTTP or HTTPS. When a new user logs 

in to the Server via the HTTP or HTTPS index page, the Server redirects the user to the reset page. After the user 

creates a new password, they are returned to the index page. 

 

Password initial reset, expiration, and account management features only apply to GlobalSCAPE and ODBC 
authentication Sites. These options are not available if other authentication types (AD, LDAP, etc.) are used. 
Password security features all apply at the Server level, not to individual accounts. 
 
There is no way to ask FTP users to change their password prior to logging in. The Server allows them to 
authenticate, but then prevents any further interaction with their session until they change their password.  
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When a password is reset, the Server verifies the new password against complexity criteria and password history, if 

those features are enabled. Users are not allowed to proceed with their session until a password is created and 

accepted by the system. If the password is not accepted by the system: 

 In HTTPS and SFTP, the authentication request will be denied.  

 In FTP, no further FTP commands will be accepted until a new password is provided that meets 

complexity and password history requirements, if those features are enabled. 

For High Security Sites: 

 PCI DSS requirement 8.5.3 states that you should set first-time passwords to a unique value for each user 

and force users to change their password immediately after the first use.  

 PCI DSS requirement 8.5.9 states that users should change their passwords at least every 90 days.  

 PCI DSS requirement 8.5.8 states that you should generate unique passwords for each user. These 

requirements apply to both end users and administrators. 

 PCI DSS requirement 8.5.10 states that you should generate strong passwords. Manual entry of passwords 

is disallowed in the Create New User and Change Password dialog boxes; users and administrators are 

forced to generate complex passwords by clicking Generate, to avoid the possibility of reusing the same 

password. 

If a Site is running in High Security mode, the warnings appear in the following situations:  

 If you clear the Force users to reset their passwords on initial login or Admin must reset their password 

at next login check box. 

To configure the Site to expire passwords after a specific number of days 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure. 

3. In the right pane, click the Security tab. 
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4. The Password expiration options are only available if the Allow users to reset their passwords check box 

is selected. If necessary, select the check box.  

5. Next to Password expiration options, click Configure. The Password Expiration dialog box appears. 

 

6. Select the Expire passwords in <n> days check box and specify the number of days.  

 

For HS-enabled Sites, the number of days is set by default to 90 days. If you attempt to change it to 
fewer than 90 days, or if you clear the check box, a warning message appears. 

7. If you want users to be warned that their password is about to expire, select the Remind <n> days prior 

to expiration check box. 
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8. Do either or both of the following: 

 To send an e-mail when the password is about to expire, select the Send user an e-mail prior to 

expiration check box.  

 To send an e-mail when the password has expired, select the Send user an e-mail upon 

expiration check box.  

9. Click OK to close the dialog box. 

10. Click Apply to save the changes on the Server. 

11. Edit the Password Reset Messages, as desired.  

REMINDING USERS WHEN PASSWORD IS ABOUT TO EXPIRE AT THE SITE LEVEL 

The Server allows you to set a reminder to notify users of their pending password expiration up to 30 days prior to 

the password expiration date. You can set the reminder at the Site level for all accounts, at the Settings Template, 

or per user, from 0 (no reminder) to 30 days (5 is the default). The reminder can be in the form of a banner 

message or an e-mail or both. 

The e-mail reminder message contains an editable text file and accepts the Server variables (e.g., %days_left%), 

such as those used in Event Rule e-mail notifications.  

To remind users of expired passwords  

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure, then click the Security tab. 

3. Select the Allow users to reset their passwords check box.  

4. Next to Password Expiration Options, click Configure. The Password Expiration dialog box appears. 

 

5. Select the Expire check box, then specify the number of days after which to expire the password. 

6. Select the Remind check box, then specify the number of days prior to expiration to remind the user. 

7. Do either or both of the following: 

 To send an e-mail when the password is about to expire, select the Send user an e-mail prior to 

expiration check box.  

 To send an e-mail when the password has expired, select the Send user an e-mail upon 

expiration check box.  

8. Click OK to save the settings and close the dialog box. 



Configuring Settings Templates and User Accounts 

321 

9. Click Apply to save the changes on the Server. 

10. Edit the Password Reset Messages, as desired. 

 

For all protocols, if the user’s password is scheduled to expire, the e-mail reminder is enabled, and 
the user account has an e-mail addresses associated with it, an e-mail will be sent informing them of 
the pending expiration and provides instructions on how to change their password for one or 
possibly all protocols. A user who typically connects over FTP, may optionally login via HTTP/S to 
change the password.  

BANNING AN IP ADDRESS THAT USES AN INVALID ACCOUNT 

The Server can add an IP address to the Site’s IP ban list when a specified number of invalid login attempts occur 

over a specified period when a non-existing username was supplied. The offending IP address is added to the Site's 

IP ban list, which can be viewed and managed on the Site's Connections tab. 

To automatically ban an IP address that uses an invalid account 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site. 

3. In the right pane, click the Security tab. 

 

If the check box contains a gray check mark, the user or Settings Template is inheriting permission 
from the parent level. 

4. In the Password Security area, next to Invalid login options, click Configure. The Login Security Options 

dialog box appears. 

 

5. Select the Ban IP address check box, then specify the number of invalid login attempts and number of 

minutes during which to count the invalid logins of non-existent user accounts. 

6. Click OK to save the changes and close the dialog box.  

7. Click Apply to save the changes on the Server. 

USING LOGIN CREDENTIALS IN EVENT RULES 

User name and password variables are used by Event Rules to use a single Event Rule to support multiple users 

with a single copy/move action. This allows the Server to store user name and password variables in memory for 

the duration of a client session. You can enable or disable this feature at the Site level. The default is disabled. For 

more information on using this in an Event Rule, refer to Copy/Move File to Host Action.  



EFT Server™ version 6 

322  

To persist login credentials in memory for use in Event Rules 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Security tab.  

 

4. Select the Persist username and password credentials for use in Event Rule context variables check box. 

5. Click Apply to save the changes on the Server. 

 

Allowing user name and password replacement variables introduces a potential security 
vulnerability because it allows passwords to reside in memory on the Server. The risk is low, but 
should be avoided unless you require the variables for an Event Rule. 

PROHIBITING REUSE OF PASSWORDS ON THE SITE 

You can configure the Server to remember a user account's previous passwords and not allow a user to submit a 

new password that is the same as any of the last 4 to 99 prior passwords for that account. You can set this at the 

Site, Settings Template, and user accounts. 

On High-Security Sites, password history is enabled by default. If a user attempts to change a password to one of 

the specified number of passwords previously used for that account, the Server denies the password change 

request. The option is available at the Site, User Setting, and per user.  

EFT Server validates any password change attempt for reuse (no special casing), whether via COM or the 

Administrator, resulting in a prompt (in the Administrator) or an error code (COM). 
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The password history is reset when transitioning from a non-PCI state to a PCI state. For example, if you 
disable this option, click Apply, then re-enable the option, then click Apply again, the count is started over 
(the password history is discarded when the option is disabled.)  

To enable enforcement of password history 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Security tab. 

 

4. Select the Prohibit reuse of previous check box, then type the number of passwords to remember. 

 

The number of iterations does not include the current password. For example, if you set password 
history to 4, and a password change attempt is made, the Server first determines whether the new 
password matches the current password, then evaluates whether the new password matches any of 
the previous 4 passwords.  

5. Click Apply to save the changes on the Server. 

PASSWORD REUSE WARNINGS 

The following password-reuse violations cause warning messages to appear: 

 If a Site is running in PCI mode and you disable enforcing password history, a warning message appears. 

 If enforcing password history is enabled and a password change request is made by the end-user (either 

by a user-initiated password reset or a forced reset), and the new password is the same as any of the 

specified number of previous passwords, the Server rejects the password change attempt. If a password 

change attempt over HTTP/S fails due to reuse, a warning message appears. 
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 If a user logged in via FTP attempts to change the login password without being prompted (i.e., not a 

forced reset), and the password fails due to reuse, the Server rejects the password change, but the user 

may continue the FTP session. If the change attempt was due to a forced reset (i.e., require password 

change on initial login), the user will not be allowed to continue their session until a valid password is 

provided.  

 If a password change attempt over SFTP fails due to reuse, the Server rejects the change and prompts the 

user to resubmit a valid password. The user is allowed to continue their session until a valid password is 

provided.   

 If a password change attempt in the Administrator Login dialog box fails due to reuse, the Server rejects 

the change attempt, and a warning message appears. 

DISABLING OR LOCKING OUT AN ACCOUNT AT THE SITE LEVEL 

The Server can automatically disable or lockout user accounts after a specified number of bad password login 

attempts over a specified time. This feature can be enabled for a Site, Settings Template, and/or per user. Once an 

account is disabled, you can re-enable the account on the General tab of the user. 

 

The PCI DSS requires that you should limit repeated access attempts by locking out a user after not more than 
six attempts and that you should set the lockout duration to thirty minutes or until administrator enables the 
user account. If a Site is running in high-security mode, and you clear the Disable/Lockout check box or set 
the maximum login attempts to a value greater than 6, a warning appears. 

To disable or lockout an account after a defined number of incorrect login attempts 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure. 

3. In the right pane, click the Security tab. 
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4. In the Password Security area, next to Invalid login options, click Configure. The Login Security Options 

dialog box appears. 

 

5. Select the check box next to Lockout, then specify the following: 

 Whether to Disable or Lockout the account 

 Number of minutes to lock out the account 

 Number of invalid login attempts after which to disable or lock out the account 

 Number of minutes during which to count the invalid login attempts 

6. Click OK to save the changes and close the dialog box.  

7. Click Apply to save the changes on the Server. 
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AD PASSWORD EXPIRATION 

On NTAD/LDAP Sites, you can configure the Server through a registry key setting, to send an e-mail notifying users 

that their AD password is about to expire in <n> days. If the user's password expiration date matches any of the list 

of days in the registry key, a notification e-mail will be sent to the user’s e-mail address specified in the E-Mail 

address field of the user's AD account. This default setting sends e-mail notifications 30 days, 15 days, 10 days, 5 

days, and 1 day before the password expires. You can edit the number of days and frequency to send notifications.  

In the Client directory of the Server installation folder, the file PasswordChg_EmailInterval.reg provides a script to 

write the following key to the registry: 

[HKEY_LOCAL_MACHINE\SOFTWARE\GlobalSCAPE Inc.\EFT Server 4.0\EFTClient] 

"PasswordChg_EmailInterval"="30:15:10:5:1" 

The string value is in the format of d1:d2:d3 etc. For example, the 30, 15, 10, 5, 1 interval values will be 

represented by 30:15:10:5:1. It can also be a single value, such as 25, which would send only one e-mail 

notification on the 25th day before expiration. If the string value is empty, no notifications are sent. 

This feature can be turned off by running the PasswordChg_EmailInterval_None.reg script or setting the value of 

PasswordChg_EmailInterval to null (empty string). When the feature is turned off, notification e-mails are no 

longer sent to users when their passwords expire. (Both scripts are installed in the \Client directory). 

When the password has expired or if the password must be changed at the first login, the following message 

appears: 

Your password has expired. Please create a new password that meets AD complexity 

requirements. 

CHANGING AN AD PASSWORD VIA THE WEB TRANSFER CLIENT 

Active Directory (AD) and LDAP Site users can change their AD password through the Web Transfer Client (WTC). 

(Refer to Changing Your Password in the Web Transfer Client for details of how to change the password.)  

When a user attempts to change the account password, the following errors are possible. You can customize the 

error messages creating text files with the following names and saving them in the EFT Server installation directory 

Client subdirectory (e.g., C:\Program Files\GlobalSCAPE\EFT Server Enterprise\Client): 

 Current password is entered incorrectly (PasswordChg_PasswordWrong.txt) 

 Network connection error (PasswordChg_NetworkProblem.txt) 

 User does not have permission by AD to change the password (PasswordChg_Permission.txt)  

 New password does not meet the AD complexity requirements (PasswordChg_PasswordComplexity.txt) 

 Current password is about to expire (PasswordChg_PwdWillExpire.txt) 

If the text files identified above do not exist when an error occurs, the default text provided within the Server is 

presented to the user. 

The location of these files can be modified by running the PasswordChg_MsgFileLocation.reg script, which is 

located in the EFT Server installation directory Client subdirectory. You must first edit the 

PasswordChg_MsgFileLocation.reg script to specify the new location. 
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TURNING OFF THE CHANGE PASSWORD FEATURE FOR AD/LDAP USER ACCOUNTS 

The WTC NTAD/LDAP change password capability can be turned on/off through the PasswordChg_NTADLDAP 

registry key. This allows security conscious administrators to turn off this feature if necessary. By default, the 

password change ability is "off."  

Two registry scripts are provided to enable/disable the password change feature:  

 PasswordChg_NTADLDAP_On.reg  

 PasswordChg_NTADLDAP_Off.reg.  

These registry scripts are also located in the EFT Server installation directory/Client subdirectory. Simply double-

click the .reg file to turn on or turn off the feature. 

NETWORK USAGE SETTINGS 

The topics below provide the procedures for configuring network usage at the Site level. 

SETTING MAXIMUM TRANSFER SPEEDS FOR A SITE 

To configure maximum transfer speeds at the Site level 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Connections tab. 
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4. In the Network Usage and Security Settings area, next to Connection limits, click Configure. The 

Connection Limits dialog box appears. 

 

5. Select the Max transfer speed (KB/s) check box, then specify the maximum transfer speed for the Site. If 

the box is cleared, the maximum transfer speed is not specified at the Site level, but can be specified at 

the Settings Template or per user. 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 
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SETTING MAXIMUM CONCURRENT SOCKET CONNECTIONS TO A SITE 

You can set the maximum number of socket connections to the Server at the Site level. With multiple Sites, some 

Sites can allow more users than other Sites.  

The Max concurrent socket connections check box limits the amount of socket or low-level connections allowed 

by the Server. When this limit is reached, any subsequent connection attempt generates a socket or network error 

in the client. It reacts as if the Server is not available, because the Server refuses the connection entirely. For a 

Server configured as an anonymous FTP server, it is recommended to limit connections per user. In this case, the 

Server will allow the user to partially connect before being told that the Server is full or busy, which is a more 

graceful way of denying the connection.  

To restrict the number of socket connections  

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. In the Network Usage and Security Settings area, next to Connection limits, click Configure. The 

Connection Limits dialog box appears. 
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5. Select the Max concurrent socket connections check box, then specify the maximum number of users you 

want to allow at any given time. If the box is cleared, the Server does not restrict the number of users. 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 

SETTING MAXIMUM CONNECTIONS PER USER (SITE LEVEL) 

You can set the maximum number of simultaneous connections for a user at the Site, User Setting Level, or per 

user. 

 

The Site level sets the limit for all sub levels. For example, if the Site level Max connections per user is 5, and 
a user's Max connections per user is set to 10, the user can still only connect to the Server 5 times 
simultaneously. 

To set maximum connections per user at the Site level 

1. In the Administrator, connect to the Server and click the Server tab.  

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Connections tab. 
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4. In the Network Usage and Security Settings area, next to Connection limits, click Configure. The 

Connection Limits dialog box appears. 

 

5. Select the Max connections per user check box, then type or use the arrows to select a number. If the box 

is cleared, a user can create an unlimited number of concurrent connections to the Site (or according to 

the limits defined at the User or Settings Template).  

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 
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SETTING MAXIMUM CONNECTIONS PER IP ADDRESS FOR A SITE 

You can set the maximum number of simultaneous connections emanating from the same IP address at the Site, 

User Setting Level, and per user. 

 

The Site level sets the limits of the User and User Setting Levels.  

To set maximum connections per IP address for a Site  

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. In the Network Usage and Security Settings area, next to Connection limits, click Configure. The 

Connection Limits dialog box appears. 
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5. Select the Max connections from same IP check box and type the maximum number of simultaneous 

connections you want to allow from the same IP address. 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 

DISCONNECTING USERS AFTER A DEFINED NUMBER OF INVALID COMMANDS 

The Server can automatically disconnect and even ban the IP addresses of users who send an excessive number of 

invalid commands. 

To automatically disconnect users after a defined number of invalid commands 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Connections tab. 
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4. In the Network Usage and Security Settings area, next to Denial of Service settings, click Configure. The 

Anti-Flood/Hammer Settings dialog box appears. 

 

5. Select the Disconnect user after <n> consecutive invalid commands check box, then type the number of 

invalid commands allowed before you disconnect the user. You can automatically add the user's IP 

address to the Site's banned IP address list by selecting the Add IP address to ban list if excessive invalid 

commands received check box. You can later remove the ban on the user by removing their IP address 

from the list in the Site's IP Access/Ban List dialog box.  

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server.  
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FLOODING AND DENIAL OF SERVICE PREVENTION 

In a typical network connection, a computer “asks” a server to authenticate it, the server returns the 

authentication approval to the computer, the computer acknowledges this approval, and then the computer is 

allowed to connect to the server.  

In a denial of service (DoS) attack, a computer sends multiple authentication requests to the server. All requests 

have false return addresses, so the server can't find the computer when it tries to send the authentication 

approval. When the server closes the connection, the DoS attacker sends a new batch of forged requests, and the 

process begins again, causing the server to be unavailable for legitimate connections. 

A common method of blocking a DoS attack is to set up a filter on the network that looks for attacks by noticing 

patterns or identifiers contained in the information. If a pattern comes in frequently, the filter can be instructed to 

block messages containing that pattern, protecting the server from being overloaded by malicious attacks.  

Attacks can be divided into three types: 

 Connection-oriented attack – Attack that establishes numerous FTP connections to make the server 

inaccessible.  

 Command-oriented attack – Attack that establishes a set of connections that flood the server with “hard” 

commands (commands that require lots of server resources), trying to make the server inaccessible.  

 Combined attack – Attack that combines both above approaches—the most widespread type.  

EFT SERVER'S AUTO-BAN SYSTEM 

EFT Server’s auto-ban system is intended to prevent possible DoS attack attempts, by identifying possible attacks 

based on user activity density (occurrences per second). The algorithm in context of each attack type has different 

implementations. 

 For a Connection-oriented attack, the server has a map of IP addresses. Each IP address map node 

contains IP address fail points. Once the server accepts a connection, it finds the corresponding IP address 

node and increases fail points by connection weight value. If IP address fail points reach a fail points limit, 

EFT Server refuses the connection and bans the IP address. 

 A Command-oriented attack is similar to a connection-oriented attack, but instead of an IP address map, 

EFT server uses a Connection ID map. The moment a connection is established, EFT Server creates a 

connection node that contains fail points and an IP address. After each command, EFT Server increases 

connection fail points by command weight. If connection fail points reach a fail points limit, the 

connection is closed and the IP address is banned. 

By default, all IP addresses are granted access to EFT Server. EFT Server allows you to grant access to only one 

specific IP address or a range of IP addresses, or deny access to one specific IP address or a range of IP addresses. 

EFT Server can automatically disconnect and even ban the IP addresses of computers who send an excessive 

number of invalid commands. (Refer to Disconnecting Users after a Defined Number of Invalid Commands.) You 

can configure EFT Server to ban IP addresses automatically that may potentially be associated with a DoS (Denial of 

Service) attack. The Server monitors connection patterns, tracks each computer's activity density, and then bans IP 

addresses with unnaturally dense activity. When EFT Server bans an IP address, it can ban it permanently (add it to 

the IP Access Restrictions list) or temporarily for a certain period of time. 



EFT Server™ version 6 

336  

 

Banning an IP address temporarily protects EFT Server from attacks. If EFT Server is correct and a temporarily 

banned IP address was the source of an attack, EFT Server will not be harmed by the attempted attack. EFT 

Server's resources will remain free or minimally burdened, instead of being completely bogged down by the 

attacking IP address. If you select to ban IP addresses temporarily, the IP address's access to EFT Server is 

restricted for a minute or two, based on the EFT Server security setting you select using the Auto-Ban Reliability 

slider bar.  

Temporarily banning users means that if EFT Server identifies an ordinary but very active user as a threat, the user 

will soon be able to reconnect to the Site. When you ban IP addresses temporarily, the level of security you set for 

the slider indicates both the number of seconds the user can attempt to occupy all of EFT Server's resources before 

being banned and the number of seconds the user is banned. The higher the security, the less time before the user 

is banned and the longer the user remains banned. 

The reason for a temporary ban is that attack identification is not fool proof and there can always be a chance of a 

mistake. If EFT Server is allowed to decide which IP address to ban, we risk that some users will be banned by 

mistake when it might not be appropriate to ban that user permanently.  

If you elect to permanently ban the IP addresses of users whose activity fits the pattern of an attack, those users 

are immediately banned when they exceed the number of connections allowed for the security level (based on the 

slider setting). If EFT Server has banned a user to whom you want to allow access, you can remove it from the IP 

address ban list. 

With the slider, you can set the Auto-ban reliability (security level) or turn auto ban off. The default is Medium. 
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EFT Server has 5 predefined security levels that correlate to the slider values: Very Low, Low, Medium, High, and 

Very High. 

 

Flood Sensitivity rules are NOT applied to the HTTP nor HTTPS engines; they are an FTP and FTPS mechanism only. 

To activate auto-ban 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Connections tab. 
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4. In the Network Usage and Security Settings area, next to Denial of Service settings, click Configure. The 

Anti-Flood/Hammer Settings dialog box appears. 

 

5. In the Flood/hammer auto-ban sensitivity level area, specify a sensitivity level using the slider bar. 

 

If you set the slider to Off, Very Low, or Low on a High Security Site, a message appears to warn you 
that this setting violates PCI DSS requirement 2.2.3, and allows you to continue with reason or 
choose a different setting. 
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6. Click a ban period: 

 Ban IPs for time period proportional to sensitivity (higher = longer)  

 Ban IPs permanently (add to TCP/IP access restrictions list)  

7. Click OK to close the dialog box. 

8. Click Apply to save the changes on the Server. 

CONTROLLING ACCESS TO THE SITE BY IP ADDRESS 

By default, all IP addresses are granted access to EFT Server. EFT Server allows you to grant access to only one 

specific IP address or a range of IP addresses, or deny access to one specific address or a range of addresses. EFT 

Server can control TCP/IP access at the Server, Site, or Settings Template, or per user.  

To grant/deny access by IP Address on a Site 

1. In EFT Administrator, connect to EFT Server and click the Server tab. 

2. In the left pane, click the Site, then click the Connections tab.  

 

3. In the Network Usage and Security Settings area, next to IP access/ban list, click Configure. The IP 
Access/Ban List dialog box appears. 
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The table under Except those listed below displays IP addresses that are granted or denied access. 

 

If the Ban IP address after excessive invalid commands check box is selected on the Site's Login 
Security Options dialog box, and a user triggers this action, their IP address will appear in this list. If 
the invalid commands were not malicious and you do not want to ban the IP address, you can 
remove it from the list by clicking it, then clicking Remove. 

4. Click granted access or denied access, then click Add. The IP Mask dialog box appears. 

 

5. In the IP mask box, specify the IP address or range of IP addresses to deny or grant access to the Site. You 
can use wildcards to select ranges of IP addresses. 

6. Click OK to close the IP Mask dialog box. The IP address/mask appears in the exceptions list. 

7. Click Apply to save the changes on EFT Server. 

ACCOUNT SECURITY SETTINGS 

The topics below provide the procedures for configuring account security on the Site.  

AUTOMATICALLY CREATING A HOME FOLDER FOR NEW USERS (SITE) 

The Server can automatically create a home folder for new users, and grant full permissions to those users in their 

home folders. You can set this at the Site, Settings Template, and per user. Each level inherits its parent level, but 

you can override that setting. 

To automatically create home folders for new users on the Site 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure, then click the Security tab. 
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3. In the Account Security area, select the Automatically create a home folder for newly added users check 

box. 

4. To allow the users full permissions in their folders, select the Grant full permissions to users in their 

home folder check box. 

5. Click Apply to save the changes on the Server. 

REMOVING OR DISABLING INACTIVE USER ACCOUNTS 

EFT Server allows you to automatically disable or remove accounts that have been inactive for a period that you 

specify (1 to 365 days). You can account security on the Site, Settings Template, and per user. The removal of 

accounts is captured in the Auditing and Reporting database for reporting. 

 

Removing a user account deletes the account from the Authentication manager, but does not delete the user 
home folder or its contents. 

When a High Security Site is created in the Site Setup wizard, the option to remove inactive user and administrator 

accounts after 90 days is enabled by default. If during Site setup the Server detects that one or more administrator 

accounts already exist, and that the option to remove administrator accounts after 90 days is not enabled or set to 

a value greater than 90 days, you are prompted to enable or change that setting. 
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Removing inactive accounts takes place by use of an internal timer every night at midnight, at Server Startup, 
and each GetAllSites() response. 
Any transition from a non-PCI DSS compliant state to a PCI DSS compliant state, or a change in any date-
sensitive value, will reset all data value calculations. For example, if a Site is running in PCI DSS mode, and the 
administrator disables Remove inactive admin accounts after 90 days, clicks Apply, and then immediately 
decides to re-enable that option, the date values for all administrator accounts are reset from the time the 
option is enabled, even if the last login dates for those administrators was <n> days ago. The same reset also 
occurs if you change the password reset period from 30 days to 60 days; that is, the change itself prompts a 
reset of all the time-based values for that feature. 

To specify automatic removal or disabling of inactive user accounts on a Site 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure, then click the Security tab. 

 

3. In the Account Security area, select the Disable/Remove account after <n> days of inactivity check box. 

4. Click the list to specify Disable or Remove. 

5. Specify the number of days of inactivity after which the account is removed or disabled. You can specify 

from 1 to 365 days. 90 days is the default, per PCI DSS 8.5.5. 

6. Click Apply to save the changes on the Server. 
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On a High Security Site, if you do any of the following and then click Apply, the Server does not commit the change, 

and a warning message appears. 

 Disable the disable/remove inactive account option for administrators or regular users 

 Set the inactivity period to a value > 90 days of inactivity 

 Change the setting from "remove" to "disable"  

In the message that appears, you can discard the change or accept the non-compliant setting and provide a reason 

for using this setting (e.g., if you are using an alternate solution). If you accept the change and provide a reason, 

the warning and the reason that you provided appear in the PCI Compliance report. 

DATA SECURITY SETTINGS 

The topics below provide the procedures for configuring data security on the Site.  

BANNING UNWANTED FILE TYPES 

EFT Server can block the upload or download of certain files. You can specify which files to block using wildcards or 

exact file names.  

For example, to block a file called virus.wav, you can type any of the following: 

virus.wav  

(blocks the specific file) 

*.wav  

(blocks all wav files) 

*.wa?  

(blocks all files whose extension starts with wa) 

 

Take care when defining files to block using with wildcards so that you do not block files that you want to 
allow. 

To ban files 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Security tab.  
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4. In the Data Security area, next to Banned file types, click Configure. The Banned File Types dialog box 

appears. 

 

5. Select the Exclude the following files from the Site check box, then type the filename or wildcard 

representation (*.mp3 or *.mp?) for the file(s) you want to exclude from the Site. Separate multiple 

entries with commas. 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 
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SETTING OPENPGP SECURITY FOR THE SITE 

This procedure describes setting OpenPGP security for the Site. For details of OpenPGP, refer to The OpenPGP 

Module. 

To set OpenPGP security 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Security tab.  

 

4. In the Data Security area, next to OpenPGP Security, click Configure. The OpenPGP Security dialog box 

appears. 
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5. If an OpenPGP key pair is defined on the Server, click the Default Site key pair drop-down menu and click 

the key. Otherwise, click Create and follow the instructions in Creating Key Pairs for OpenPGP or click 

Manage and following the instructions in Importing and Exporting Key Pairs for OpenPGP. 

6. In the Private key passphrase box, provide the passphrase for the selected key. Select the Hide typing 

check box if you do not want the passphrase to be viewable. 

7. Select the Enable debug logging check box if you want to log errors, then click the drop-down menu to 

specify the level of logging: 0 (minimum logging), 1, or 2. 

8. In the Log file path box, specify where to save the log file. 

9. Click OK to save the changes. 

10. Click Apply to save the changes on the Server. 

SPECIFYING FILE DELETION OPTIONS 

EFT Server's HS module provides a data sanitation/data wiping option. If you do not activate the HS module, this 

feature is disabled after the 30-day trial expires. 

You can configure the Server to securely delete or purge a file by writing over the initial data using encrypted 

and/or pseudorandom data. A menu of purging methods is available; available options depend on the library used.  

 The 3-pass DoD method (based on the National Industrial Security Program manual DoD 5220.22-M  and 

the DSS Clearing and Sanitization Matrix) overwrites all addressable locations with a character and its 

complement, then a random character, and does this three times. 

 The pseudorandom data wiping method does the following: 

1. Initializes the wincrypt library 

2. Fills the file with randomly generated data from the wincrypt library 

3. Flushes the data to disk 

4. Deletes the file from file system calling the standard function DeleteFile() 

 

*.pgp files are automatically excluded from the wipe process. When wipe is enabled, ANY delete operation 
also includes the wipe (sanitization) process.  

You can specify which files the Server is to purge, including client-initiated delete commands, source files after 

successful OpenPGP encrypt operation, source file after move command across partition/drive, and others.  

http://www.fas.org/irp/offdocs/eo12829.htm
https://www.dss.mil/portal/portlets/AutonomyRetrieval/autosuggest.jsp?url=/usr/local/weblogic/bea92/portalContent//new_dss_internet/isp/odaa/documents/clear_n_san_matrix_06282007.pdf
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To specify a delete method 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure. 

3. In the right pane, click the Security tab. 

 

4. In the Data Security area, next to Secure data removal, click Configure. The Data Sanitation dialog box 

appears. 

 

5. In the Delete method box, click the list to specify one of the following methods: 

 Windows standard (fastest) 

 Pseudorandom data (medium) 

 3 pass DoD 5220.22-m (slow) 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 
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8. The following message appears when the purging mechanism is changed to anything other than the 

Windows standard delete method: 

"Sanitizing deleted disk sectors is a CPU- and disk-intensive operation and can be quite time consuming. Run 

performance monitors before and after making this change to determine whether hardware upgrades are 

necessary to maintain prior levels of performance." 

For further reference regarding data wiping, see the following articles:  

(These links are outside of GlobalSCAPE's domain and could change.) 

 Data remanence: http://en.wikipedia.org/wiki/Data_remanence,  

specifically the section titled "Standard Patterns for Purging": 

http://en.wikipedia.org/wiki/Data_remanence#Standard_patterns_for_purging 

 US DoD 5220.22-M Standard, defined in the US National Industrial Security Program Operating Manual of 

the US Department of Defense (January 

1995; chapter 8, section 3, 8-306. Maintenance): 

http://www.dtic.mil/whs/directives/corres/html/522022m.htm 

 "Secure Deletion of Data from Magnetic and Solid-State Memory": 

http://www.usenix.org/publications/library/proceedings/sec96/full_papers/gutmann/ 

  

http://en.wikipedia.org/wiki/Data_remanence
http://en.wikipedia.org/wiki/Data_remanence#Standard_patterns_for_purging
http://www.dtic.mil/whs/directives/corres/html/522022m.htm
http://www.usenix.org/publications/library/proceedings/sec96/full_papers/gutmann/
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STEP 4: CONFIGURING SETTINGS TEMPLATES  
AND USER ACCOUNTS 

The topics below provide information regarding creating and managing users and Settings Templates in the 

Administrator. 

THE SETTINGS TEMPLATES TABS 

The Settings Template tabs are used to specify connection settings that apply to all user accounts in the Setting 

Level. Settings on these tabs are inherited at the user account level; however, you can override these settings on 

the User tabs for a user account. 

GENERAL TAB OF THE SETTINGS TEMPLATE 

The General tab of a Settings Template node is used to enable the Settings Template, set the Settings Template as 

the default, specify the home folder and home folder options, and set a disk quota for each user's home folder. 

The settings apply to all users assigned to the Settings Template. To apply settings to a specific user, refer to 

General Tab of a User Node. 

 

Refer to the topics below for details of this tab. 

 Enabling or Disabling a Settings Template or User 

 Specifying a User's Home Folder 

 Configuring User Disk Quotas 
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CONNECTIONS TAB OF THE SETTINGS TEMPLATE 

The Connections tab of a Settings Template is used to enable the users in the Settings Template to connect over 

certain protocols, including using the Web Transfer Client for HTTP/S connections. These settings apply to all user 

accounts assigned to the selected Settings Template. To apply these settings to a specific user, refer to 

Connections Tab of a User Node. 

 

Refer to the topics below for details of this tab. 

 Enabling and Managing Connection Protocols 

 Enabling User Access to the Web Transfer Client 

 File Integrity Checking (XCRC) 

 Accelerating Transfers with MODE Z 

 Allowing or Disallowing the NOOP Command 

 Configuring the FTP Connection Banner in the Settings Template or User Account 

 Configuring SFTP Authentication Options for Settings Templates and Users 

 SSL Certificate-Based Login 

 Setting Maximum Transfers per Session for a User 

 Setting Maximum Transfer Size for Users 

 Disconnecting Users on Timeout 

 Setting Maximum Transfer Speeds for a User 

 Setting Maximum Connections for Users at the User Level 
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 Setting Maximum Connections per IP per User 

 Configuring User Disk Quotas 

SECURITY TAB OF THE SETTINGS TEMPLATE 

The Security tab is used to specify password and account security settings for all users assigned to the Settings 

template. 

 

Refer to the topics below for details of this tab. 

 Enforcing Strong (Complex) Passwords 

 Allowing Users to Change their Passwords 

 Expiring Passwords at the User Level 

 Expiring a User Account 

 Enforcing Password Reset at the User Level 

 Reminding Users when Password is About to Expire 

 Password Reuse (History) 

 Removing or Disabling Inactive User Accounts 

 Enabling or Disabling a User Setting Level or User 
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HOW SETTINGS TEMPLATES WORK 

Every client account or user must be a member of a Settings Template. Settings Templates exist within a Site. 

Settings Templates consist of a group of security and access-control settings used as a template. Each new user is 

assigned to a Settings Template whose settings determine how the Server resources may be used. One Settings 

Template might be quite restrictive, while another might allow more access to resources. For example, power 

users would be assigned to a Settings Template allowing greater flexibility in using the Server resources while guest 

users would be assigned to a more restrictive template where use of the Server resources is very limited. Settings 

Templates allow an administrator to make changes to the Settings Template that affect all users assigned to that 

template.  

The basic profile of individual users can also be changed (overriding the template). Users can also be moved 

between Settings Templates; users that are moved inherit the properties of the new Settings Template, but retain 

any modifications (overrides) made by the administrator.  

The Server installs with one Settings Template named Default Settings. Additional Settings Templates can be 

added to define access to the Server resources for various types of users. You cannot delete the Default Template 

when it is the only Settings Template.  

 

Settings Templates apply to the Server resources. Permissions assigned to Groups control access to folders on 
your system. 

CREATING SETTINGS TEMPLATES 

Settings Templates allow you to control the Server’s resources while still giving users the flexibility they need to 

transfer essential files. You can create one or more Settings Templates before or after creating users and assign 

users to the desired Settings Template. The Settings Template inherits the settings from the Site, but you can 

override the settings. 

To create a new Settings Template  

1. In the Administrator, connect to the Server and click the Server tab. 

2. Do one of the following: 

 Click a Site or any node below the Site, then on the main menu, click Configuration > New 

Settings Template.  

 Click the Settings Templates node, then, in the right pane, click New. 

 Right-click a Site or any node below the Site, then click New Settings Template.  

 Click a Site or any node below the Site, then press CTRL+L. 

The Create New Settings Template dialog box appears.  
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3. In the Site box, click the list to select a Site.  

4. In the User Settings Template box, type a name for the new Settings Template. For example, type WTC 

Users. 

5. Optionally, type a Description for the Settings Template. For example, type: Web Transfer Client 

users. 

6. Click OK. The new Settings Template appears under the User Settings Templates node. 

 

7. Click the new Settings Template, then click the General tab.  

 

8. The Settings Template is enabled by default. To disable it, clear the Enable this settings template check 

box. 

9. If this is to be the default Settings Template, click Set as default. The Settings Template name in the tree 

will become bolded. 
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10. In the Description box, the description you typed in the Create New Settings Template dialog box 

appears. If you did not type a description, you can type one here (optional). 

11. If you want to ensure that the Settings Template is not controlling the user's home folder, clear the ST 

Home folder check box. Refer to Specifying a User's Home Folder for details about specifying the home 

folder. This setting affects all users assigned to this Settings Template.  

12. If you want to set a disk quota for the users' home folders, select the Set a disk quota for each user's 

home folder check box, then type the limit in the Max disk space box. 

13. Click the Connections tab. For information about the settings on this tab, refer to the following topics: 

 Enabling and Managing Connection Protocols 

 Enable User Access to Web Transfer Client 

 Network Usage Options 

14. Click the Security tab. For information about the settings on this tab, refer to the following topics: 

 Specifying Invalid Login Options 

 Enforcing Strong (Complex) Passwords 

 Allowing Users to Change their Passwords 

 Enforcing Password Reset at the User Level 

 Expiring Passwords at the User Level 

 Password Reuse (History) 

 Removing or Disabling Inactive User Accounts 

15. Click Apply to save the changes on the Server. 

INHERITANCE 

The Settings Template inherits settings from the Site, and a user initially shares the settings of the Settings 

Template in which the account was created. Inherited settings are marked by gray check boxes. You can override 

inherited settings by clearing or selecting the check box. 

The check boxes toggle through three settings:  

 Inherited - A gray check box  means no changes have been made by the administrator to the settings 

inherited from the Settings Template or Site. This is a neutral indicator and simply means the setting is the 

same as the Settings Template or Site for that option. 

 Overridden, allowed - A black check mark  indicates that the administrator has overridden this 

inherited setting. A black check mark indicates that the setting is enabled for the Settings Template or 

user even if it is disabled in the Site or Settings Template. 

 Overridden, not allowed - A blank check box  means the administrator has overridden this inherited 

option. This setting does not apply to the Settings Template or user, even if it is enabled in the Site or 

Settings Template. 

You can change a user’s Settings Template by dragging and dropping the user into a different level, or using the 

procedure in Moving a User to a Different Settings Template. The account's inherited settings change to reflect the 

settings of its new Settings Template; however, if a user account contains modified (overridden) settings and is 

moved to a new Settings Template, those modifications remain in effect at the new Settings Template. 
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SPECIFYING THE SETTINGS TEMPLATE HOME FOLDER 

You can specify a home folder for the Settings Template, treat the Settings Template's home folder as the user's 

default root folder, and set a disk quota for each user's home folder in the Settings Template home folder. 

To specify the Settings Template home folder 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template that you want to configure. 

3. In the right pane, click the General tab. 

 

4. Select the ST home folder check box, then type the path to the home folder or click the open icon and 

browse to the folder. 

5. If you want the user's root to be the Settings Template home folder, select the Treat home folder as the 

user's default root folder check box. 

6. If you want to specify a disk quota for each user home folder in the Settings Template home folder, select 

the Set a disk quota for each user's home folder check box, then specify a value in MB in the Max disk 

space box. 

7. Click Apply to save the changes on the Server. 

ENABLING OR DISABLING A SETTINGS TEMPLATE 

When you disable a Settings Template, you disable any users in that Settings Template that are not enabled 

independently of the Settings Template. 

To enable or disable a Settings Template 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template that you want to enable/disable. 

3. In the right pane, click the General tab. 
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4. Do one of the following: 

 To disable the Settings Template account, clear the Enable this settings template check box. 

 To enable the Settings Template account, select the Enable this settings template check box.  

5. Click Apply to save the changes on the Server. In the left pane, a red "X" appears over the Settings 

Template icon that is disabled. 

THE USER TABS 

The tabs for a user account are used to specify connection settings that apply only to the selected user account. 

Settings on these tabs are inherited from the Settings Template, which inherits its settings from the Site; however, 

you can override these settings on the user tabs. 

GENERAL TAB OF A USER NODE 

The General tab of a user node is used to enable the user account, expire the account on a specific date, specify 

the home folder and home folder options, set a disk quota for the user's home folder, and viewing the user's 

statistics. The settings apply only to the selected user. To apply the settings to multiple users, refer to General Tab 

of a Settings Template. 
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Related Topics 

 Enabling or Disabling a Settings Template or User 

 Expiring a User Account 

 Specifying a User's Home Folder 

 Configuring User Information 

 Changing a User's Password 

 Setting the Home Folder for AD-Authenticated Users 

 Configuring User Disk Quotas 

 Viewing Statistics of a User Account 

 Forcibly Logging a User Off the Server 

CONNECTIONS TAB (USER NODE) 

The Connections tab of a user node is used to override the settings at the Settings Template, to connect over 

certain protocols, including using the Web Transfer Client for HTTP/S connections. You can also configure the 

user's settings for an AS2 partner account. You can configure the partner manually on this tab or using the AS2 

Configuration Wizard.  

These settings apply to the selected user. To apply these settings to a specific user, refer to Connections Tab 

(Settings Template). 
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Refer to the topics below for details of this tab. 

 Enabling and Managing Connection Protocols 

 Enabling User Access to the Web Transfer Client 

 File Integrity Checking (XCRC) 

 Accelerating Transfers with MODE Z 

 Allowing or Disallowing the NOOP Command 

 Configuring the FTP Login Banner for a User 

 Configuring SFTP Authentication Options for Settings Templates and Users 

 SSL Certificate-Based Login 

 Setting Maximum Transfers per Session for a User 

 Setting Maximum Transfer Size for Users 

 Disconnecting Users on Timeout 

 Setting Maximum Transfer Speeds for a User 

 Setting Maximum Connections for Users at the User Level 

 Setting Maximum Connections per IP per User 

 Configuring User Disk Quotas 

 Configuring AS2 Inbound Parameters 

 Configuring AS2 Outbound Parameters 
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SECURITY TAB (USER) 

The Security tab for a user account is used to specify password and account security settings and specify the user's 

Group memberships. These settings apply only to the selected user account. To apply these settings to all users in 

a Settings Template, refer to Security Tab of a Settings Template. 

 

Refer to the topics below for details of this tab. 

 Enforcing Strong (Complex) Passwords 

 Allowing Users to Change their Passwords 

 Expiring Passwords at the User Level 

 Disabling or Locking Out an Account after a Defined Number of Incorrect Login 

 Password Reuse (History) 

 Removing or Disabling Inactive User Accounts 

 Allowing the NOOP Command 

 Allowing the COMB Command 

 File Integrity Checking (XCRC) 

 Allowing the Mode Z Command 

 Enabling and Managing Connection Protocols 

 Enabling User Access to the Web Transfer Client 

 SSL Certificate-Based Login 

 Specifying a User's Permission Group 

 Adding or Removing Users to or from a Group 

 Viewing Group Membership 

 Creating Groups 
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ENABLING OR DISABLING A USER ACCOUNT 

When you disable a user account, the account and user folder are not removed, allowing you to easily enable or 

disable the account as needed. 

To enable or disable a user account 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user account that you want to enable/disable. 

3. In the right pane, click the General tab. 

 

4. Do one of the following: 

 To disable the user account, clear the Enable this user account check box. 

 To enable the user account, select the Enable this user account check box.  

5. Click Apply to save the changes on the Server. In the left pane, a red "X" appears over the user icon that is 

disabled. 
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CREATING USER ACCOUNTS 

This procedure provides instructions for creating a user account. For the procedure for creating an EFT Server 

administrator account, refer to Configuring Server Administrators. 

To create a user account 

1. After you have completed the Site Setup wizard, you can continue directly to the User Creation wizard. 

Otherwise, in the Administrator, connect to the Server and click the Server tab. 

2. Do one of the following: 

 On the main menu, click Configuration, then click New User.  

 Right-click the Server node or any node within it, then click New User. 

 On the toolbar, click the New user icon . 

The Create New User wizard appears.  

 

3. In the Username box, provide the logon name. All characters are supported except the asterisk (*) and 

the plus sign (+). 

4. (Optional) Click Details. The New User Account Details dialog box appears.  



EFT Server™ version 6 

362  

 

5. Provide the user account details (name, e-mail, phone, etc.), then click OK to return to the wizard. 

6. In the Password and Confirm password boxes, provide the account password or click Generate to 

generate a complex password. If you click Generate, the password appears in the box so that you can 

provide it to the user. 

7. In the Password Type drop-down list, click one of the following:  

 Standard - A plain text password is required.  

 Anonymous - Any password, including nothing, allows an anonymous connection.  

 Anonymous (Force e-mail) - Any well formed e-mail address is the password.  

 OTP S/KEY MD4 - Used for logging in to an OTP-enabled server. 

 OTP S/KEY MD5 - Used for logging in to an OTP-enabled server.  

 

PCI DSS requirement 8.5.8 states that you should not use group, shared, or generic accounts 
and passwords. To address this requirement, the Server hides the Anonymous password 
type for HS-enabled Sites anywhere that the password type is selectable. 

8. (Optional) In the E-mail address box, type the user's e-mail address, then select the E-mail login 

credentials to this user check box. Refer to E-mailing User Passwords for details, if necessary. 

 

PCI DSS requirement 8.5.7 states that you should communicate password procedures and policies to 
all users who have access. You can edit the default text of the e-mail that is sent when you create a 
new user (CredentialsTemplate.txt) to include your organization's password policies and 
procedures. This file is stored in the Server installation folder (by default, C:\Program 
Files\GlobalSCAPE\EFT.) 

9. Click Next. The Site, Settings Template, and Group page appears.  
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10. In the Site drop-down list, click the list to select the Site to which you want to add the user. If only one 

Site is defined, it is displayed in the list box. 

11. Click the Settings Template list and click the Settings Template to apply to the new user. All new users are 

automatically members of the Default Settings Template. You can move the user to a different template 

later if you have not yet defined a custom Settings Template. 

12. In the Home folder box, type or click the open icon  to browse for and select a path (from the relative 

Site root) to the user's home folder. The default path is in the Site root /Usr/%USER.LOGIN%. You can 

also add the variables %USER.FullName% and %USER.EMAIL% to the path. You cannot navigate up 

past the Site root.(No verification is performed to determine whether the path is valid.) 

 Clear the Make the home folder the default root folder for this user check box if you do not 

want the user to have a home folder. (It is selected by default.) 

 Select the Grant the user full permissions in their home folder check box if you want the user to 

have full permissions to their home folder. 

 

If you do not grant users full permissions to their home folders, they will inherit their 
Group's permissions. 

13. Next to Assign group membership, click Groups. The Group Membership dialog box appears.  
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14. Permission Groups are used in the Virtual Folder system to assign permissions to users. Each user is 

assigned to the All Users group. To assign the user to one or more other Groups, double-click the Group 

or click the Group and use the arrows to move the Group between the Member of and Not a member of 

boxes, then click OK.  

15. Click Next. The protocols page appears. 
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16. Select one or more check boxes next to the protocols on which the user is allowed to connect to the 

Server. (At least one check box must be selected.) The grayed out check boxes indicate inherited settings 

from the Settings Template and Site. Clear the check boxes next to the protocols on which the user is not 

allowed to connect to the Server. If the text is also grayed out (as is SFTP in the illustration above), the 

protocol has not been enabled for the Site and is not available. 

 If you selected SFTP, click SFTP Auth to configure SFTP authentication options for this user. 

 If you selected SSL, click SSL Auth to configure SSL authentication options for this user. 

17. Click Finished. The user account appears in the tree and is selected. 

18. To create more users, repeat the procedure above starting with step 2. 

EXPIRING A USER ACCOUNT 

You can specify a user account to expire on a specific date. Expired accounts are not removed from the Server; 

they can be enabled at any time. 

To disable a user on a specific date (account expiration) 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user account for which you want to set an expiration date. 

3. In the right pane, click the General tab. 

 

4. Select the Expire this account on check box, then click the list to select an expiration date.  

5. Click Apply to save the changes on the Server. On the specified date, a red "X" appears over the user icon 

in the left pane, and the User account is disabled. 
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To enable an expired account 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user account that you want to enable. 

3. In the right pane, click the General tab. 

4. Clear the Expire this account on check box and select the Enable this user account check box. 

5. Click Apply to save the changes on the Server. The red "X" disappears over the user icon in the left pane. 

CONFIGURING USER ACCOUNT DETAILS 

The account-specific details associated with a particular user, such as phone number, pager, and e-mail address, 

are configured on the Details tab of a selected user. Some of these fields (such as the e-mail address) can be used 

in other areas (such as the Event Rules) to notify the user of a completed transaction. 

To configure user information 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user you want to configure. 

3. In the right pane, click the General tab. 

 

4. Click Account Details. The User Account Details dialog box appears. 
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5. Complete the user information as needed. All boxes are optional; however, the Full Name and E-Mail 

boxes (along with the Server's address book) are used to populate the Select Names dialog box in Event 

Rule e-mail notifications. 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server.  

MOVING A USER TO A DIFFERENT SETTINGS TEMPLATE 

You can move a user to a different Settings Template. For example, if users in the Default Settings User Setting 

Level do not have access to the Web Transfer Client, and you want only a select group of users to have access to 

the Web Transfer Client, do the following: 

1. Create a new Settings Template and name it "Web Transfer Client."  

2. Enable the client for all users in that Settings Template.  

3. Move the users from the Default Settings Template to the Web Transfer Client template.  

You can move only one user at a time, using drag and drop or the procedure below. 

To move a user from one Settings Template to another 

1. In the Administrator, connect to the Server and click the Server tab. 

2. If it is not already created, create the new Settings Template. 

3. Expand the node that contains the user you want to move, then click the user. 

4. Do one of the following: 

 On the toolbar, click the Set Settings Template icon .  

 On the main menu, click Configuration > Set Settings Template.  

The Select Settings Template dialog box appears. 
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5. Click the list to specify to which Settings Template to move the user account. 

6. Click OK. The user account moves to the new Settings Template. 

SPECIFYING A USER'S HOME FOLDER 

You can specify the user's login folder at Settings Template or per user. This is typically set at the user level, but the 

Settings Template can override the user setting.  

When you create a Site and select the Auto assign home folders to newly created users check box, each user 

account that is created will have a home folder added as a subfolder of the home folder for the Settings Template 

to which the user is added. For example, if you add a user jsmith to the Settings Template "Power Users," and that 

Settings Template's home folder has a path of /Usr/Power Users/ in the VFS, then this new jsmith account will be 

generated with a home folder in the Server's VFS of /Usr/Power Users/jsmith. This is the default behavior when 

creating a user within the Administrator, however, you can override/change that behavior when the Site is 

created. If the user is created using the COM interface, or the user appears in the Server list as a result of Active 

Directory, LDAP, or ODBC querying the user account list in real time and finding out that it IS a valid user but not 

yet added to the Server, then a home folder is added as a subfolder of the home folder for the Settings Template 

to which the user is added.  

For Sites that use NTLM/AD authentication, if the user account has a Home Folder defined by the AD 

administrator, then the Server's VFS will not create a physical folder for the new user, but instead creates a virtual 

folder that points to the path specified in Active Directory for the home folder for that user (sometimes called a 

roaming profile). Therefore, if jsmith exists on the AD controller as a valid user with a home folder mapped to 

\\192.168.20.19\common_file_share\jsmith, then when jsmith becomes a new user on the Server (using the 

same path/User Setting Level from the above example), then jsmith will be assigned the home folder /usr/Power 

Users/jsmith, which is a virtual folder pointing to \\192.168.20.19\common_file_share\jsmith.  

To set a user's home folder 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user you want to configure. 

3. In the right pane, click the General tab. 
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4. Select the User home folder check box. The home folder box becomes editable. 

 

If you want to ensure that the Settings Template is not controlling the user's home folder, clear the 
User home folder check box in the Settings Template.  

5. Specify the path to the user's home folder. You can use variables in the path, such as 

 %USER.FULL_NAME%, %USER.LOGIN%, %USER.EMAIL%.  

Do one of the following: 

 Type the path to the folder. If you type or paste a path in the User home folder box, the Server 

does not verify that the folder exists. (Use UNC paths, not mapped drives.) 

 Click the open icon  next to the User home folder box. In the Browse VFS dialog box, click the 

folder in which you want the user's folder placed, then click OK. 

  Type a forward slash if you want the user's folder to be created at the root of the Server 

directory instead of the Usr directory. 

6. Do one of the following: 

 Select the Treat home folder as default root folder check box to make the home folder the 

user's root folder. If the check box is selected, the user cannot browse above their home 

directory.  

 Clear the Treat home folder as default root folder check box. When it is cleared, if you built the 

Site with the defaults, the user's root folder is /Usr/<username>. 

7. Click Apply to save the changes on the Server. 
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SETTING THE HOME FOLDER FOR AD-AUTHENTICATED USERS  

By default, the home folder for AD-authenticated users is /user/%username%. For some scenarios, you may 

want to create and assign each AD user a home folder that is actually a Virtual Folder pointing to a specified UNC 

path. You can do this by editing the user’s profile in AD as follows:  

1. Open a user's properties in your AD management tool, click the Profile tab, and look at the Home 

Folder section.  

2. Click Connect, select any appropriate drive letter, then in the To box provide the desired UNC path. The 

UNC path will be used when creating your new AD Authentication site. 

3. In the Server, when you create a new AD-authenticated Site, select the Automatically create and assign 

home folders to newly created users check box. If that option is enabled, the Home Folder setting for 

each AD user's properties will be requested from the network. If that value is set, then a new Virtual 

Folder will be created in the Server’s file system (the VFS) that points to that UNC path. When users log in 

through one of the available protocols, they interact with that UNC path that will be treated as their home 

folder.  

 

You should enable the option to Treat home folder as the user's default root folder on the Settings 

Template General tab to confine users to their home folder regardless of the NTFS permissions on the 

directories above, to simplify the client's interface, and facilitate the use of HTTP/S and the Web Transfer 

Client. 

 

Due to the lack of standardization among the various LDAP providers, this feature is not currently 
supported when using LDAP authentication.  
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IF USERS ARE UNABLE TO UPLOAD OR DOWNLOAD  
TO HOME DIRECTORY 

If users are unable to upload or download files to or from the home directory, first determine whether the 

problem is just for one or more certain users or all users. If no users can upload or download file, verify that the 

Server service has permissions to modify the network share directory. If the problem only occurs for one or more 

certain users, verify that the user or group has the appropriate permissions in the VFS for that directory. 

SETTING A USER DISK QUOTA 

Disk space management is an important aspect of server administration. Setting quotas allows you to specify the 

maximum amount of disk space available to each user in their home folder. The quota is set at the Settings 

Template and/or the user level.  

Max disk space sets the maximum disk space that users can consume in their home folders. The Server 

administrator can assign a maximum disk space for each user's home folder. As the user uploads and downloads, 

the Server measures the user's used disk space. Obviously, uploading files increases used disk space and deleting 

files decreases this number. If the used disk space equals the maximum disk space, the user has to delete files 

before any more files can be uploaded.  

 

Tip: Create a "User Quota Exceeded" Event Rule to let users know when they need to clean up their files to 
reduce their used disk space. 

An administrator can use Windows Explorer to add or delete files in a user's home folder, and the Server will 

update the user's used disk space. Additions and deletions to a user's folder that are performed outside of the 

Server are not prohibited, even when the total file size exceeds the maximum disk space allowed. However, 

exceeding the user's used disk space will cause the user to be prohibited from uploading until the used disk space 

is less than the maximum disk space. 

If users report that they are not able to upload files, check whether they have enough disk space available. If not, 

you or they will need to remove files from their home folder before they can upload any more files with the Server, 

or you might need to adjust their maximum disk space allowance. 

 

The Site level sets the limits of the user and Settings Template quotas.  

To set users' disk quotas 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user you want to configure. 

3. In the right pane, click the General tab. 
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4. Select the Set a disk quota for this user's default root folder check box and type the maximum number of 

megabytes (MB) the user may store in the home folder. The amount of disk quota currently in use 

appears as a percentage to the right of the Used disk space box. 

 

If you attempt to disable this feature on a High Security Site, a message appears to warn you that 
this setting violates PCI DSS requirement 2.2.3, and allows you to continue with reason, or disable 
the feature. 

5. Click Apply to save the changes on the Server. 

VIEWING USER STATISTICS 

In the Administrator, you can view the connection status of a user in real time, historical activity, and account 

administration activities.  

To view statistics of a user 

1. In the Administrator, connect to the Server and click the Server tab.  

2. In the left pane, click the user that you want to monitor. 

3. In the right pane, click the General tab.  
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The statistics for the selected user appear in the Statistics area.  

 Status: Displays "Connected" or "Not connected". You can also forcibly disconnect a user by 

clicking Kick User. 

 Last time connected: Displays the date and time that the user last connected to the Server. 

 Account created: Displays the date and time that the user account was created. 

 Last modified by: Displays the username of the administrator account that created the user 

account. 

 Last modified time: Displays the date and time that the user account was last modified. 

FORCIBLY LOGGING A USER OFF OF THE SERVER (KICK USER) 

An administrator with Server, Site, or Settings Template permission can manually disconnect a user from the 

Server in the Administrator. Doing so does not disable users, but only disconnects them from the Server. (Change 

Password Administrators do not have permission to kick users.)  

To disconnect a user 

 In the Administrator, connect to the Server, then do one of the following: 

o On the Server tab:  

a. In the left pane, click the user account. 

b. In the right pane, click the General tab, then click Kick User.  
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 On the Status tab: 

a. In the left pane, click the username. The user's statistics appear in the right pane. 

 

b. At the bottom of the right pane, click Kick User.  

All of the user's connections are disconnected from the Server and the Status displays "Not Connected." 
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PROTOCOLS 

The topics below provide the procedures for configuring protocols for Settings Templates and user accounts. 

FTP, HTTP, AS2, SFTP, and SSL connections are configured at the Site level and can be enabled or disabled at the 

Site or Settings Template, or per user. The port through which the user connects is determined at the Site level. 

 

If the check box contains a gray check mark, the user or Settings Template is inheriting permission from the 
parent level. 

To enable a connection protocol for a Settings Template or a user 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user that you want to configure. 

3. In the right pane, click the Connections tab. 

4. Do one or more of the following: 

 To allow/disable FTP access, select/clear the FTP check box.  

 To allow/disable FTPS (SSL/TLS) access, select/clear the FTPS (SSL/TLS) check box. Click FTP 

Config to configure FTP Settings and SSL Auth to configure SSL authentication options. 

 To allow/disable the SFTP access, select/clear the SFTP (SSH2) check box, then click SFTP Auth to 

configure SFTP authentication options. 

 To allow/disable HTTP access, select/clear the HTTP check box. 

 To allow/disable HTTPS access, select/clear the HTTPS (SSL) check box. Click SSL Auth to 

configure SSL authentication options. 

 To allow/disable AS2 access, select/clear the AS2 check box. (This check box is disabled if HTTP or 

HTTPS is disabled.) 

 To allow/disable use of the Web Transfer Client, select/clear the Allow Web Transfer Client 

(WTC) over HTTP/S check box. (HTTP and/or HTTPS must be enabled.) 

5. Click Apply to save the changes on the Server.  

FTP SETTINGS FOR SETTINGS TEMPLATES AND USERS 

When you configure FTP connections to the Site, the Settings Template and user accounts inherit the settings from 

the Site; however, you can override the settings for the Setting Template and for each user.  

To configure FTP transfers for Settings Templates or user accounts 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user account that you want to configure. 

3. In the right pane, click the Connections tab. 
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4. Select the FTP or FTPS (SSL/TLS) check box. 

5. Click FTP Config. The FTP Settings dialog box appears. (The FTP Settings dialog box for the Settings 

Template is shown below.) 

 

(The FTP Settings dialog box for user accounts does not have the User limit reached or Quit session 

message boxes. The messages are defined on the Site.) 

6. Configure one or more of the following options, as needed: 

 Allowing Site-to-Site Transfers (Users) 

 Allowing Multipart Transfers (COMB Command) for Users 

 Allowing the XCRC Command for Users 

 Allowing the ZLIB (Mode Z) Command 

 Configuring the FTP Connection Banner 
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7. Click OK to close the dialog box. 

8. Click Apply to save the changes on the Server. 

ALLOWING SITE-TO-SITE TRANSFERS (FXP) FOR USERS 

Although site-to-site transfers (FXP command) can expedite what otherwise could be a slow transfer, many 

administrators consider site-to-site transfers a security risk, exposing servers to "port theft" or "FTP by proxy" 

attacks. Depending on how your servers are configured, you might want to block these types of transfers.  

To allow or not allow Site-to-Site transfers 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user account that you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Click FTP/S Config. The FTP Settings dialog box appears. 
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5. Do one of the following: 

 To allow transfers, select the Allow site-to-site transfers (FXP) check box. 

 To block transfers, clear the Allow site-to-site transfers (FXP) check box. 

6. Click OK to close the FTP Settings dialog box. 

7. Click Apply to save the changes on the Server. 

ALLOWING MULTIPART TRANSFERS (COMB COMMAND) FOR USERS 

The Server supports multi-part transfers from advanced FTP clients such as CuteFTP Professional. The user must 

have appropriate privileges and be authorized to connect multiple times concurrently. The connecting client takes 

care of most details, including splitting the file apart, sending the multiple parts, and then requesting that the 

Server to join them again upon receipt. The COMB command joins the parts back together. The benefits of 

segmented (multi-part) and concurrent delivery for accelerated transfers include:  

 Accelerate throughput and maximize available bandwidth available to the client by allowing uploaded files 

to be split apart and transferred in multiple segments simultaneously. 

 Command can be toggled on or off. 

The COMB command is a proprietary command and is not defined nor endorsed by any FTP-related RFC; however, 

the command can be integrated with other servers using the following syntax:  

COMB <TF> <SF 1> ... <SF n>  

where  

<TF> is the path to target file, which will contain the combined data from the source parts. 

<SF #> are the source files (parts). 

Which means combine n source files (SF 1...n) into one file (TF). 

 If the target file already exists, then the Server appends source files to it. 

 The Server will delete all the source files once they are combined successfully. 

 All file names should be in quotation marks. 

http://www.globalscape.com/cuteftppro/
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To allow or disallow multipart transfers 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user account that you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Click FTP/S Config. The FTP Settings dialog box appears. 

 

5. Do one of the following: 

 To allow transfers, select the Allow multi-part transfers (COMB) check box. 

 To block transfers, clear the Allow multi-part transfers (COMB) check box. 

6. Click OK to close the FTP Settings dialog box. 

7. Click Apply to save the changes on the Server. 
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ALLOWING THE XCRC COMMAND FOR USERS 

Although site-to-site transfers can expedite what otherwise could be a slow transfer, many administrators consider 

Site-to-Site transfers a security risk, exposing servers to "port theft" or "FTP by proxy" attacks. Depending on how 

your servers are configured, you might want to block these types of transfers.  

Refer to File Integrity Checking (XCRC) for details of the XCRC command. 

To allow or not allow integrity checking 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user account that you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Click FTP/S Config. The FTP Settings dialog box appears. 
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5. Do one of the following: 

 To allow transfers, select the Allow integrity checking (XCRC) check box. 

 To block transfers, clear the Allow integrity checking (XCRC) check box. 

6. Click OK to close the FTP Settings dialog box. 

7. Click Apply to save the changes on the Server. 

ALLOWING THE MODE Z COMMAND FOR USERS 

Mode Z compression compresses files on the fly for file transfers, saving bandwidth and improving transfer times. 

The client must also support MODE Z to take advantage of this feature. If MODE Z is enabled, the Server will listen 

for MODE Z requests, then enable it for subsequent transfers from the client that requested it. 

To allow a client to use Mode Z compression 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user account that you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Click FTP/S Config. The FTP Settings dialog box appears. 
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5. Select the Allow MODE Z Compression check box. 

6. Click OK to close the FTP Settings dialog box. 

7. Click Apply to save the changes on the Server. 

CONFIGURING THE FTP CONNECTION BANNER FOR A USER 

The FTP login banner is configured for the Site and inherited by the Settings Templates and users. You can replace 

or add to the default message or not display a message at all for all users assigned to a Settings Template or for 

individual users.  

To configure the FTP login banner for a Settings Template or user 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user that you want to configure. 

3. In the right pane, click the Connections tab. 
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4. Select the FTP or FTPS (SSL/TLS) check box. 

5. Click FTP Config. The FTP Settings dialog box appears.  

 

6. In the FTP connection (banner) message area, click the list to specify whether to Replace default message 

defined on the Site, Use default message, Add to default message, or click None to not display a message. 

7. If you want to replace or add to the default message, provide the text in the text box.  

8. Click OK to close the dialog box. 

9. Click Apply to save the changes on the Server. 
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ALLOWING OR DISALLOWING CLIENT ANTI-TIMEOUT SCHEMES (NOOP) FOR USERS 

Many FTP clients send random commands such as REST 0, PWD, TYPE A, LIST, etc., to the FTP server to keep the 

session alive while the client is idle. Many FTP clients send a NOOP command to the Server during idle times to 

keep the connection alive. You can choose whether to allow the NOOP command. If you disallow the NOOP 

command, it will be considered an invalid command and treated according to your settings under Disconnect after 

<n> invalid commands.  

To allow or disallow the NOOP command 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user account that you want to configure.  

3. In the right pane, click the Connections tab. 

 

4. Click FTP/S Config. The FTP Settings dialog box appears. 
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5. Select the Allow client anti-timeout schemes check box to allow the NOOP command or clear the check 

box to treat the NOOP command as an invalid command. (Selected by default in the .) 

 

If you are banning users who send excessive invalid commands while treating NOOP as an invalid 
command, then you will be banning users for sending the NOOP command. You may later allow the 
user to connect by removing their IP address from the Site's list in the IP Access tab. A gray check box 
in a user account indicates that the account is inheriting parameters from the Settings Template. 

6. Click OK to close the dialog box.  

7. Click Apply to save the changes on the Server. 

CONFIGURING SFTP AUTHENTICATION OPTIONS  
FOR A SETTINGS TEMPLATE OR USER ACCOUNT 

You configure SFTP on the Site, then specify the SFTP authentication options for the Settings Template and user 

accounts. 

To specify SFTP authentication options 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user that you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. In the Protocols area, select the SFTP (SSH2) check box, then click SFTP Auth. The SFTP Authentication 

Options dialog box appears. 
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5. In the SFTP authentication options list, specify whether user are to connect using Password only, Public 

key only, or Public Key & Password. 

 

Compliance with PCI DSS requires that users change their password upon initial login. Because the 
Public key only method does not use a password, it potentially violates the PCI DSS and is, therefore, 
not available with HS-enabled Sites. You can, however, use the Public Key and Password method. 

6. If you chose Public key only or Public Key & Password, click Edit. The SFTP Public Key Select dialog box 

appears. 

 

The SFTP public keys that are defined for this Site appear in the List of keys. If no keys appear, click Key 

Manager to import keys.  

7. In the List of keys box, double-click the key(s) to use, or click each key, then click Add. The selected key(s) 

appear in the Keys valid for client list.  
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8. Click OK to close the SFTP Public Key Select dialog box. The selected key(s) appear in the Authentication 

key list. 

9. Click OK to close the SFTP Authentication Options dialog box. 

10. Click Apply to save the changes on the Server. 

CONFIGURING SSL FOR A SETTINGS TEMPLATE OR USER ACCOUNT 

SSL must first be enabled at the Site and Server level; then can be enabled for a Settings Template and users. 

If you require certificates from connecting clients before they can connect, then their certificate must be in the 

Trusted Certificates Database or signed by a certificate in the Trusted Certificate Database. 

To enable SSL 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, select the Settings Template or user account that you want to configure. 

3. In the right pane, select the Connections tab. 

 

4. In the Protocols area, select the applicable check boxes (FTPS, HTTPS, and/or AS2). 

5. Click SSL Auth. The SSL Authentication Options dialog box appears. 
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6. In the SSL authentication options list, specify the authentication method: 

 Specified in Settings Template (available for user accounts) 

 Password only 

 SSL Certificate - If SSL Certificate is specified, specify the user certificate in the second list that 

appears.   

 

Compliance with PCI DSS requires that users change their password upon initial login. 
Because this login method does not use a password, it potentially violates the PCI DSS and 
is, therefore, not available with HS-enabled Sites.  

7. Click OK to close the dialog box. 

8. Click Apply to save the changes to the Server. 

ENABLING HTTP CONNECTIONS FOR A SETTINGS TEMPLATE OR USER ACCOUNT 

HTTP connections can be enabled at the Site, Settings Template, or user account. Each level inherits the parent 

level settings, but you can override the setting. 

To enable HTTP connections for a Settings Template or user account 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user that you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. In the Protocols area, select the HTTP check box. 

5. Click Apply to save the changes on the Server. 
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ALLOWING WEB TRANSFER CLIENT ACCESS TO USERS 

Before users can log in to the Server using the Web Transfer Client (WTC), the Server administrator must configure 

the Server to allow connections from the Web Transfer Client. Refer to Enabling User Access to the Web Transfer 

Client for details. If access is allowed or denied at the Settings Template, the user accounts in the template inherit 

that setting, but you can override it on the user account. 

To allow user access to the Web Transfer Client at the Settings Template or user account 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. In the Protocols area, select the Allow Web Transfer Client (WTC) over HTTP/S check box. 

5. Click Apply to save the changes on the Server. 

ALLOWING AS2 CONNECTIONS (USER) 

AS2 connections must be configured on the Site before you can enable AS2 connections in the Settings Template 

or user account. 

To allow AS2 connections for Settings Templates or user accounts 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Settings Template or user account that you want to configure. 

3. In the right pane, click the Connections tab. 
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4. In the Protocols area, select the AS2 check box. 

5. Click AS2 Inbound to configure inbound connections; click AS2 Outbound to configure outbound 

connections. 

6. Click Apply to save the changes on the Server. 

NETWORK USAGE OPTIONS 

The topics below provide the procedures for setting network usage options for Settings Templates and user 

accounts. 

SETTING MAXIMUM TRANSFER SPEEDS FOR A USER 

You can control a user's maximum transfer speeds at the Site level, Settings Template, and per user.  

 

The Site level sets the limits of the user and Settings Templates.  

To configure maximum transfer speeds at the User and Settings Templates 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user or Settings Template that you want to configure. 

3. In the right pane, click the Connections tab. 
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4. Next to Connection limits, click Configure. The Connection Limits dialog box appears. 

 

5. Select the Max transfer speed check box and specify the maximum speed (in kilobytes per second) that 

the user is allowed. 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 

DISCONNECTING USERS ON TIMEOUT 

You can automatically disconnect users after a specified time of inactivity, set per user or at the Settings Template. 

The idle timeout setting applies across all connection protocols supported by the Server (FTP/S, SFTP, HTTP/S). If a 

session has been idle for more than the specified timeout, the user has to log back in.  

The Server also incorporates an internal timeout value that applies to administrator connections via the 

Administrator. If no activity (such as OnMouseClick) occurs for 15 minutes, the account is disconnected from the 

Server (HS-enabled sites only). A warning message and countdown timer appear after 10 minutes of inactivity. The 

timer resets if you click Continue; if no activity occurs, the timer expires, and the Administrator disconnects from 

the Server. Any non-committed changes are discarded. 
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To set a maximum idle limit for a user or Settings Template 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user account or Settings Level that you want to configure.  

3. In the right pane, click the Connections tab. 

 

4. In the Connection limits area, next to Connection limits, click Configure. The Connection Limits dialog 

box appears. 

 

5. Select the Connection timeout check box, then type or select the maximum allowable seconds of 

inactivity allowed before the user is disconnected. 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 
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SETTING MAXIMUM CONNECTIONS PER USER 

The maximum number of simultaneous connections for a User can be set at the Site, Settings Template, and User 

level. 

 

The Site level sets the limits of the User and Settings Templates. For example, if the Site level Max 
connections per user is set to five, and a user's User level Max connections per user is set to ten, the user can 
have a maximum of five simultaneous connections. 

To set maximum connections per user account at the user and Settings Template 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user or Settings Template you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Next to Connection limits, click Configure. The Connection Limits dialog box appears. 

 

5. Select the Max connections per user check box, then specify the maximum number of simultaneous 

connections to the Site for this user.  
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6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 

SETTING MAXIMUM CONNECTIONS PER IP PER USER 

You can set the maximum number of simultaneous connections emanating from a same IP address at the Site, 

Settings Template, and User level. 

 

The Site level sets the limits of the user and Settings Templates.  

To set maximum connections per user account at the user and Settings Template 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user or Settings Template you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Next to Connection limits, click Configure. The Connection Limits dialog box appears. 
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5. Select the Max connections from same IP check box, then specify the maximum number of simultaneous 

connections to the Site from the same IP address that is allowed. 

6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 

SETTING MAXIMUM TRANSFERS PER SESSION FOR A USER 

You can set a limit on the number of file transfers allowed per login session at the Settings Template or per user. 

To set the maximum allowed transfers per session  

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user or Settings Template you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Next to Transfer limits, click Configure. The Transfer Limits dialog box appears. 

 

5. Select the Uploads and/or Downloads per session check box and specify the maximum number of 

uploads/downloads the user may transfer during a session. 
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6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 

SETTING MAXIMUM TRANSFER SIZE FOR A USER 

The maximum transfer size limits the user to a specified number of upload or download kilobytes per session. FTP 

does not send information to EFT Server regarding the number of bytes that a user sends. A user can start a 

transfer of virtually any size; however, once the limit is reached, EFT Server will not transfer the rest of the file.  

To set the maximum upload size  

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user or Settings Template you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Next to Transfer limits, click Configure. The Transfer Limits dialog box appears. 

 

5. Select the Max Upload/Download Size check box and specify the maximum amount of data (in kilobytes) 

the user may transfer during a session. 
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6. Click OK to close the dialog box. 

7. Click Apply to save the changes on the Server. 

CONTROLLING USER ACCESS BY IP ADDRESS 

By default, all IP addresses are granted access to EFT Server. EFT Server allows you to grant access to only one 

specific IP address or a range of IP addresses, or deny access to one specific address or a range of addresses. EFT 

Server can control TCP/IP access at the Server, Site, or User Setting Level, or per user.  

To grant/deny access by IP Address for a Settings Template or user account 

1. In EFT Administrator, connect to EFT Server and click the Server tab. 

2. In the left pane, click the Settings Template, or user account, then click the Connections tab.  

 

3. In the Network Usage & Limits area, next to IP access/ban list, click Configure. The IP Access/Ban List 

dialog box appears. 
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The table under Except those listed below displays IP addresses that are granted or denied access. 

 

If the Ban IP address after excessive invalid commands check box is selected on the Site's Login 
Security Options dialog box, and a user triggers this action, their IP address will appear in this list. If 
the invalid commands were not malicious and you do not want to ban the IP address, you can 
remove it from the list by clicking it, then clicking Remove. 

4. Click granted access or denied access, then click Add. The IP Mask dialog box appears. 

 

5. In the IP mask box, specify the IP address or range of IP addresses to deny or grant access to the Site. You 

can use wildcards to select ranges of IP addresses. 

6. Click OK to close the IP Mask dialog box. The IP address/mask appears in the exceptions list. 

7. Click Apply to save the changes on EFT Server. 

PASSWORD AND ACCOUNT SECURITY OPTIONS 

E-MAILING USER PASSWORDS  

When you create or change a user account, you can e-mail the user's passwords in the New User Account Setup 

and Change User Password dialog boxes. 

 

SMTP must be configured on the Server. 

The e-mail consists of a basic message with dynamic tags for username and password. The e-mail text is defined at 

the Server level. Refer to Editing the User Login Credentials Message for details. 

To e-mail a user a password  

1. In the Change User Password dialog box or the New User Account Setup wizard, type the user's e-mail 

address, then select the E-mail login credentials check box. 

2. The Server sends the password to the user's e-mail address when you click OK in the Change User 

Password dialog box or Finish in the New User Account Setup wizard.  

CHANGING A USER’S PASSWORD 

You can change users' passwords from within the Administrator interface. When a new password is created, EFT 

Server determines whether the password meets complexity and reuse requirements.  

For HS-PCI-enabled Sites, you cannot manually create a password; the only option is to click Generate to create a 

unique, complex password. 

If enabled, users can change their passwords in the HTML Listing and Upload Form and the Web Transfer Client.. 
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To change a user's password 

1. In the Administrator, connect to EFT Server and click the Server tab. 

2. In the left pane, click the user you want to configure. 

3. In the right pane, click the General tab. 

4. Click Change Password. The Change User Account Password dialog box appears. 

 

5. Do one of the following: 

 In the New password and Confirm password boxes, type and confirm the password. (Not 

available for HS-PCI-enabled Sites.) 

 Click Generate. A complex password is generated and entered in the New password and Confirm 

password boxes. 

6. Click the Password type list to specify a type from the following: 

 Standard - A plain text password is required. 

 Anonymous - Any password, including nothing, allows an anonymous connection. 

 Anonymous (Force e-mail) - Any well-formed e-mail address is the password  

 OTP S/KEY MD4 - Used for logging in to an OTP-enabled server. 

 OTP S/KEY MD5 - Used for logging in to an OTP-enabled server.  

 

PCI DSS requirement 8.5.8 states that you should not use group, shared, or generic accounts 
and passwords. To address this requirement, EFT Server hides the Anonymous password 
type for HS-PCI-enabled Sites anywhere that the password type is selectable. 

7. To e-mail the user's password, type the e-mail address and select the E-mail login credentials check box. 

(SMTP must be configured on the Server.) 

8. Click OK. The Change User Account Password dialog box closes and the e-mail is sent, if configured. 

9. Click Apply to save the changes on EFT Server. 



EFT Server™ version 6 

400  

CHANGING AN AD PASSWORD VIA THE WEB TRANSFER CLIENT 

Active Directory (AD) and LDAP Site users can change their AD password through the Web Transfer Client (WTC). 

(Refer to Changing Your Password in the Web Transfer Client for details of how to change the password.)  

When a user attempts to change the account password, the following errors are possible. You can customize the 

error messages creating text files with the following names and saving them in the EFT Server installation directory 

Client subdirectory (e.g., C:\Program Files\GlobalSCAPE\EFT Server Enterprise\Client): 

 Current password is entered incorrectly (PasswordChg_PasswordWrong.txt) 

 Network connection error (PasswordChg_NetworkProblem.txt) 

 User does not have permission by AD to change the password (PasswordChg_Permission.txt)  

 New password does not meet the AD complexity requirements (PasswordChg_PasswordComplexity.txt) 

 Current password is about to expire (PasswordChg_PwdWillExpire.txt) 

If the text files identified above do not exist when an error occurs, the default text provided within the Server is 

presented to the user. 

The location of these files can be modified by running the PasswordChg_MsgFileLocation.reg script, which is 

located in the EFT Server installation directory Client subdirectory. You must first edit the 

PasswordChg_MsgFileLocation.reg script to specify the new location. 

TURNING OFF THE CHANGE PASSWORD FEATURE FOR AD/LDAP USER ACCOUNTS 

The WTC NTAD/LDAP change password capability can be turned on/off through the PasswordChg_NTADLDAP 

registry key. This allows security conscious administrators to turn off this feature if necessary. By default, the 

password change ability is "off."  

Two registry scripts are provided to enable/disable the password change feature:  

 PasswordChg_NTADLDAP_On.reg  

 PasswordChg_NTADLDAP_Off.reg.  

These registry scripts are also located in the EFT Server installation directory/Client subdirectory. Simply double-

click the .reg file to turn on or turn off the feature. 

AD PASSWORD EXPIRATION 

On NTAD/LDAP Sites, you can configure the Server through a registry key setting, to send an e-mail notifying users 

that their AD password is about to expire in <n> days. If the user's password expiration date matches any of the list 

of days in the registry key, a notification e-mail will be sent to the user’s e-mail address specified in the E-Mail 

address field of the user's AD account. This default setting sends e-mail notifications 30 days, 15 days, 10 days, 5 

days, and 1 day before the password expires. You can edit the number of days and frequency to send notifications.  

In the Client directory of the Server installation folder, the file PasswordChg_EmailInterval.reg provides a script to 

write the following key to the registry: 

[HKEY_LOCAL_MACHINE\SOFTWARE\GlobalSCAPE Inc.\EFT Server 4.0\EFTClient] 

"PasswordChg_EmailInterval"="30:15:10:5:1" 

The string value is in the format of d1:d2:d3 etc. For example, the 30, 15, 10, 5, 1 interval values will be 

represented by 30:15:10:5:1. It can also be a single value, such as 25, which would send only one e-mail 

notification on the 25th day before expiration. If the string value is empty, no notifications are sent. 
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This feature can be turned off by running the PasswordChg_EmailInterval_None.reg script or setting the value of 

PasswordChg_EmailInterval to null (empty string). When the feature is turned off, notification e-mails are no 

longer sent to users when their passwords expire. (Both scripts are installed in the \Client directory). 

When the password has expired or if the password must be changed at the first login, the following message 

appears: 

Your password has expired. Please create a new password that meets AD complexity 

requirements. 

EXPIRING PASSWORDS AT THE USER LEVEL 

The HS module provides a method for resetting the password via FTP and SFTP. If you do not activate the HS 

module, this feature is disabled after the 30-day trial period expires. 

On HS-enabled Sites, passwords are set by default to expire in 90 days. 

The Server checks all accounts for expired passwords daily at midnight, as well as at Server Startup and each 

GetAllSites() response. Each day it also checks whether passwords are <n> days from expiration, and those 

passwords are flagged for reminders, if reminders are enabled. All reminder e-mail messages are sent immediately 

after flagging the accounts to be reminded. 

If a user with an expired password logs in over FTP, the user is prompted that the password is expired and must be 

reset. Until the password is successfully changed, the Server will not process any commands other than changing 

the password or exiting. If a user with an expired password logs in over SFTP, the user is forced to reset the 

password before continuing with the login process. 

 

 

Password initial reset, expiration, and account management features only apply to GlobalSCAPE and ODBC 
authentication sites. These options are not available if other authentication types (AD, LDAP, etc.) are used. 
Password security features all apply to the Server, not to individual accounts. There is no way to ask FTP users 
to change their password prior to logging in. the Server must allow them to login (authenticate), but then 
prevents any further interaction with their session until they change their password. 

To expire a password after <n> days 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user or Settings Template you want to configure, then click the Security tab. 
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3. If Password expiration options is not available, select the Allow users to reset their passwords check box. 

4. Next to Password expiration options, click Configure. 

5. To expire the password after a certain number of days, select the Expire passwords in check box, then 

specify the number of days. 

6. Click Apply to save the changes on the Server. 

If reminders are enabled in the Administrator, users are prompted when their account passwords are about to 

expire and after the account is expired.  

The text of the password expired message, below, is stored by default in C:\Program 

Files\GlobalSCAPE\EFT\PasswordResetMsg.html. 

%full_name%, The password for account: %username% has expired. Please change your 

password at your earliest convenience. Instructions for changing your password via 

FTP, SFTP, and HTTP/S are provided below for your convenience: 1. Please enter the 

following URL into your browser: %reset_page% 2. Supply your current password when 

prompted 3. Enter your new password and confirm 4. If approved, exit the browser 

and login as normal. 

The text of the password expiration reminder message, below, is stored by default in C:\Program 

Files\GlobalSCAPE\EFT\PasswordResetReminderMsg.html. 

% full_name%, The password for account: %username% will expire in %days_left% days. 

Please change your password at your earliest convenience. Instructions for changing 

your password via FTP, SFTP, and HTTP/S are provided below for your convenience: 1. 

Please enter the following URL into your browser: %reset_page% 2. Supply your 

current password when prompted 3. Enter your new password and confirm 4. If 

approved, exit the browser and login as normal. 

 

You can edit the HTML file for the password messages; however, be sure not to change the variables, 
which are enclosed in percent signs (%text%). 

The account is not disabled; users with expired passwords may login if they provide their existing password and 

then the new password. Users are not allowed to proceed with their session until a password is created and 

accepted by the system.  

 In HTTP/S and SFTP, the authentication request will be denied.  
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 In FTP, no further FTP commands will be accepted until a new password is provided that meets any 

complexity and reuse requirements. 

If Expire password in N days is enabled, /manageaccount and the reset page are enabled, the password has 

expired, and the user logs in with an expired password, the Server automatically redirects the authenticated user 

to the reset page. (In HTTPS, the user is redirected to the rest page on the HTTPS port.)  

When resetting passwords, all password complexity requirements, reuse history, and cyclical password-use checks 

apply, if those settings are enabled in the Administrator. 

On an HS-enabled Site, a warning message appears in the following situations:  

 If the Expire passwords check box is selected, and the account management / reset page is enabled, and 

the password has expired, and the user logs in with an expired password. If the user logs in with an 

expired password to the FTP port, no commands are allowed other than exiting or changing the password 

until the password has been changed, a prompt appears to remind the user to change the password. 

 If the Expire passwords check box is selected and an administrator logs in using an expired password, a 

warning appears to prompt the administrator to supply a new password. 

 If the Expire passwords check box is selected and a user logs in to the HTTP/S index page when their 

password is <n> days from the expiration period (<n> being the value set in the Remind users box), a 

prompt appears to remind the user to change the password. 

 If you clear the Disallow password reuse check box or set the expiration value to a number > 90. 

 If you disable account management over HTTPS, and the Expire passwords after <n> days check boxes is 

enabled. 

 If you clear the Expire passwords after <n> days check box, users for whom HTTPs login is enabled can 

change passwords over a dedicated HTTP/S account management page located at /manageaccount, 

which is a reserved path name on the Server.  
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ENCRYPTING PASSWORDS 

EFT Server provides the following password-encryption features: 

 Use a two-way TwoFish encryption cipher on passphrases that must be reversible.  

 Use a one-way hash for passphrases that do not need to be reversible.   

 Encrypt all passwords used in the following areas: 

o ClientFTP.dll client authentication 

o Authmanager.dll for AD, ODBC, and LDAP authentication 

o PGP private key passphrases 

o ARM connection string password 

 

PCI DSS requirement 8.4 states that you should encrypt all passwords during transmission and storage on all 
system components. 

ENFORCING STRONG (COMPLEX) PASSWORDS 

The HS module allows you to enforce the use of complex passwords. If you do not activate the HS module, this 

feature is disabled after the 30-day trial expires. 

 

PCI DSS requirement 8.5.10 states that you should require a minimum password length of at least seven 
characters. PCI DSS requirement 8.5.11 states that you should use passwords containing both numeric and 
alphabetic characters.  

When you create or update a user account, you can require the user to create strong (complex) passwords. 

Complex passwords are enabled by default when you create a HS-enabled Site. A complex password must meet 

the following criteria: 

 Minimum length (from 6 to 99 characters).  

 Contain N or more characters from the user's account name  

 Not contain N or more repeating characters.  

 Not be comprised solely of a word in a dictionary file (forward or backwards) 

 Contain at least one character from each of the following categories. The number of characters can never 

be fewer than the number of chosen categories, but can be greater.  

o English uppercase characters (A - Z) 

o English lowercase characters (a - z) 

o Base 10 digits (0 - 9) 

o Non-alphanumeric (for example: !, $, #, or %) or Unicode characters  

 

Non-alphanumeric characters are not required by default; you must explicitly specify this option if you want to 
require it. For those who might be using a non-English language operating system, it is best to leave the Non 
alpha-numeric check box cleared because of characters that are not normally found on a standard keyboard. 
In this case, your users are free to use non-alphanumeric characters when they create their own password, you 
just would not require that they do, and the system will not include them when you automatically generate a 
complex password. 
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For example, suppose you specified that the password must: 

 contain at least 6 characters 

 contain uppercase letters 

 contain lowercase letters 

 contain numbers 

That means that the password must contain at least one uppercase character, at least one lowercase character, 

and at least one digit. So in this case, a password could be A5s3*v35, but not a5s3*v35, because you specified 

that a password should have at least one uppercase letter. 

 

When using the Server with the Secure Ad Hoc Transfer (SAT) module, if the password settings are set to use a 
minimum of more than 20 characters, the SAT temporary user creation will fail. If your Site's complex 
password settings require more than 20 characters, be sure to configure the Ad-Hoc Settings Template to 
override the Site's password settings so that complex passwords for Ad-Hoc users contain fewer than 20 
characters. 

To enforce complex passwords on user accounts 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user or Settings Template you want to configure, then click the Security tab.  
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3. Select the Enforce strong (complex) passwords check box, then click Configure. The Password complexity 

settings dialog box appears. 

 

If the check box and Configure button are grayed out, they are inheriting the setting from the Site or, 
for a user, the Settings Template.  

4. Specify the password complexity per the guidelines in the table below:  

Field  Default  Min/Max Values  

Minimum password length  8 6 - 99 

The password must contain characters from at 
least N of the following categories:  

 Uppercase  

 Lowercase  

 Numeric (0-9)  

 Non alpha-numeric (e.g., !, #, $, %)  

3 categories 2 categories, up to the 
maximum password length 

Must not contain N or more characters from the 
user name  

>3 2 characters, up to 
maximum password length 

Must not contain N or more repeating 
characters.  

3 2 characters, up to 
maximum password length 

Must not consist solely of a word in the following 
Dictionary file.  

(Click the ellipse icon  to select a file.) 

on n/a 

Must not be a dictionary word backwards  off n/a 

 

 

The dictionary file cannot exceed 10 MB. If you exceed the file size, the Event log will indicate that 
not all of the file could be loaded. If the dictionary file is not available, the Server operations will 
continue and a log error is written to the Event log. 

5. Click OK to save the settings or Cancel to keep existing settings. 
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6. Click Apply to save the changes to the Server. 

 

COM-created accounts are not subject to complexity requirements unless the 
CreateComplexPassword method is used. Refer to the GlobalSCAPE Server COM API user guide for 
details. 

ALLOWING OR FORCING PASSWORD RESET AT THE USER LEVEL 

The Server provides the option to force password reset. On HS-enabled Sites, users are forced to change their 

passwords on first use.  

You can enable the password reset page while disallowing general access to HTTP or HTTPS. When a new user logs 

in to the Server via the HTTP or HTTPS index page, the Server redirects the user to the reset page. After the user 

creates a new password, they are returned to the index page. 

 

Password initial reset, expiration, and account management features only apply to GlobalSCAPE and ODBC 
authentication Sites. These options are not available if other authentication types (AD, LDAP, etc.) are used. 
Password security features all apply at the Server level, not to individual accounts. 
There is no way to ask FTP users to change their password prior to logging in. The Server must allow them to 
login (authenticate), but then prevents any further interaction with their session until they change their 
password.  
Refer to Using the PCI Module with the Secure Ad Hoc Transfer Module if you are using a High Security Site. 

When a user logs in to the HTTPS index page and the Force reset check box is selected, the user is automatically 

redirected to the reset page if: 

 The /manageaccount page is enabled and the user logs in with a temporary password. 

 The /manageaccount page and Redirect HTTP to HTTPS options are enabled, and the user logs in with a 

"temporary" password. 

 The user logs in with a temporary password to the FTP port or SFTP engine. (No commands are allowed 

other than exiting or changing the password until the password has been changed, and the user is 

prompted to change the password.) 

 An administrator logs in using a temporary password. A warning appears to prompt the administrator to 

supply a new password.  

To configure user accounts to enforce password reset 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user or Settings Template you want to configure. 

3. In the right pane, click the Security tab. 
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4. Select the Allow users to reset their passwords check box.  

5. Select the Force users to reset their passwords on initial login check box.  

6. Configure password expiration and invalid login options, if desired. 

7. Click Apply to save the changes on the Server. 

When a password is reset, the Server verifies the new password against complexity criteria and password history, 
if those features are enabled. Users are not allowed to proceed with their session until a password is created and 
accepted by the system. If the password is not accepted by the system: 

 In HTTPS and SFTP, the authentication request will be denied.  

 In FTP, no further FTP commands will be accepted until the new password is provided and meets 

complexity  and password history requirements, if those features are enabled. 

For HS-enabled Sites: 

 PCI DSS requirement 8.5.3 states that you should set first-time passwords to a unique value for each user 

and force users to change their password immediately after the first use.  

 PCI requirement 8.5.9 states that users should change their passwords at least every 90 days.  

 PCI requirement 8.5.8 states that you should generate unique passwords for each user. These 

requirements apply to both end users and administrators. 

 PCI requirement 8.5.10 states that you should generate strong passwords. Manual entry of passwords is 

disallowed in the Create New User and Change Password dialog boxes; users and administrators are 

forced to generate complex passwords by clicking Generate, to avoid the possibility of reusing the same 

password. 

If a Site is running in PCI Compliance mode, warnings appear in the following situations:  

 If you clear the Force users to reset their passwords on initial login or Admin must reset their password 

at next login check box. 

 If you clear the Allow users to reset their password check box. 
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 If you disable account management over HTTPS, and the Force users to reset their passwords on initial 

login or Expire passwords after <n> days check boxes are enabled. 

 If you clear the Force users to reset their passwords on initial login or clear the Enable account 

management page over HTTPS check boxes.   

GETTING A LIST OF EXPIRED USER ACCOUNTS AND EXPIRATION DATES 

EFT Server Administrators may need to retrieve a list of expired user accounts and view the expiration date of user 

accounts. This functionality is not yet available in EFT Server or the Auditing and Reporting module. However, 

there are commands in the COM interface that can provide this information. 

For details of using COM, refer to GlobalSCAPE Server COM API. The details of how to get a list of expired accounts 

is below. 

The example below is for advanced users who can use the example as a guide to creating their own 
scripts. If you need assistance with creating custom scripts, please contact GlobalSCAPE Professional 

Services. 

DETERMINING THE EXPIRATION DATE FOR A USER ACCOUNT (GETEXPIRATIONDATE) 

Use the ICIClientSettings interface GetExpirationDate method to determine the expiration date for a particular 

user account; set it with SetExpirationDate. 

Signature: 

HRESULT GetExpirationdate ( 

[out] VARIANT *dDate,  

[out, retval] VARIANT_BOOL *pVal); 

dDate results in a string value, i.e. "4/29/05" 

Example: 

Dim strUser: strUser = "test" 

set oUserSettings = oSite.GetUserSettings(strUser) 

dtAccExpDate =  oUserSettings.GetExpirationDateAsVariant() 

WScript.Echo ("dtAccExpDate = "  & dtAccExpDate)  

 

 

 In many non-windows environments, “KMarsh” and “kmarsh” are two different usernames, and case 
matters. GetUserSettings is case insensitive (in versions 5.2.5 and later). That is, with this method, “KMarsh”, 
“KMARSH”, and “kmarsh” are all the same user account. 

 

  

http://www.globalscape.com/support/professional_services.aspx
http://www.globalscape.com/support/professional_services.aspx


EFT Server™ version 6 

410  

 

EXAMPLE SCRIPT 

The example VB script provided below retrieves user accounts and expiration dates and writes them to a Microsoft 

Excel spreadsheet. (Of course, Excel must be installed on the computer on which you are running the script.)  

To use the script 

1. Copy the script below into a VB script editor.  

2. In the section that contains the Server address and administrative login, provide your Server address and 

port and the administrator username and password. 

'Get Server address and administrative login 

   txtServer = "localhost" 

   txtPort =  "1100" 

   txtUserName = "root" 

   txtPassword = "root" 

3. Execute the .vbs file. 

-----------------------------------------------------------START------------------------------------------------------------------------------- 

' Declare variables 

Dim CRLF 

Dim EFTServer 

Dim Sites, Site, aUsers 

'Create the COM Object 

Set EFTServer = CreateObject("SFTPCOMInterface.CIServer") 

CRLF = (Chr(13)& Chr(10)) 

'Get Server address and administrative login 

   txtServer = "localhost" 

   txtPort =  "1100" 

   txtUserName = "root" 

   txtPassword = "root" 

'Connect to Server 

On Error Resume Next 

EFTServer.Connect txtServer, txtPort, txtUserName, txtPassword 

If Err.Number  0 Then 

   MsgBox "Error connecting to '" & txtServer & ":" & txtPort & "' -- " & 

err.Description & " [" & CStr(err.Number) & "]", vbInformation, "Error" 

   WScript.Quite(255) 

End If 

set Sites=EFTServer.Sites 

'Set Site to first ftp site in list on server 

set Site=Sites.Item(0) 

Dim objexcel 

Set objExcel = createobject("Excel.application")  

objexcel.Visible = True 

objexcel.Workbooks.add 

    

arUsers = Site.GetUsers() 

 For j = LBound(arUsers) to UBound(arUsers) 
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 'Name in first column 

 objExcel.Cells(j+1, 1).Value = arUsers(j) 

  

 Set oUserSettings = site.GetUserSettings(arUsers(j)) 

 'boolAccExp = oUserSettings.GetExpirationDate 

 dtAccExpDate =  oUserSettings.GetExpirationDateAsVariant() 

 If (dtAccExpDate = "12:00:00 AM") Then 

  objexcel.Cells(j+1, 2).Value = "not set to expire" 

   Else 

  objexcel.Cells(j+1, 2).Value = dtAccExpDate 

 End If 

  objexcel.Columns("A:A").EntireColumn.Autofit 

  objexcel.Columns("A:B").EntireColumn.Autofit 

 Next    

    

'Close COM connection 

EFTServer.Close 

' Release interfaces 

set oSettings = nothing 

set Site = nothing 

set Sites = nothing 

set EFTServer = nothing 

WScript.Quit(0) 

--------------------------------------END---------------------------------------------- 

REMINDING USERS WHEN PASSWORD IS ABOUT TO EXPIRE 

EFT Server allows you to set a reminder to notify users of their pending password expiration up to 30 days prior to 

the password expiration date. You can set the reminder at the Site level for all accounts, and at the Settings 

Template and User level, from 0 (no reminder) to 30 days (5 is the default). The reminder can be in the form of a 

banner message or an e-mail or both. 

To remind users of expired passwords  

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user or Settings Template you want to configure, then click the Security tab. 
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3. Select the Allow users to reset their passwords check box.  

4. Next to Password Expiration Options, click Configure. The Password Expiration dialog box appears. 

 

5. Select the Expire check box, then specify the number of days after which to expire the password. 

6. Select the Remind check box, then specify the number of days prior to expiration to remind the user. 

7. Do either or both of the following: 

 To send an e-mail when the password is about to expire, select the Send user an e-mail prior to 

expiration check box.  

 To send an e-mail when the password has expired, select the Send user an e-mail upon 

expiration check box.  

8. Click OK to save the settings and close the dialog box. 

9. Click Apply to save the changes on the Server. 

10. Edit the Password Reset Messages, as desired. 

 

For all protocols, if the user’s password is scheduled to expire, the e-mail reminder is enabled, and the user 
account has an e-mail addresses associated with it, an e-mail will be sent informing them of the pending 
expiration and provides instructions on how to change their password for one or possibly all protocols.  
A user who typically connects over FTP, may optionally login via HTTP/S to change the password.  
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PROHIBITING PASSWORD REUSE 

You can configure the Server to remember a user account's previous passwords and not allow a user to submit a 

new password that is the same as any of the last 4 to 99 prior passwords for that account. You can set this at the 

Site, Settings Template, and user accounts. 

On High-Security Sites, password history is enabled by default. If a user attempts to change a password to one of 

the specified number of passwords previously used for that account, the Server denies the password change 

request. The option is available at the Site, User Setting, and per user.  

EFT Server validates any password change attempt for reuse (no special casing), whether via COM or the 

Administrator, resulting in a prompt (in the Administrator) or an error code (COM). 

 

The password history is reset when transitioning from a non-PCI state to a PCI state. For example, if you 
disable this option, click Apply, then re-enable the option, then click Apply again, the count is started over 
(the password history is discarded when the option is disabled.)  

To enable enforcement of password history 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user or Settings Template you want to configure. 

3. In the right pane, click the Security tab. 

 

4. Select the Prohibit reuse of previous check box, then type the number of passwords to remember. 

 

The number of iterations does not include the current password. For example, if you set password 
history to 4, and a password change attempt is made, the Server first determines whether the new 
password matches the current password, then evaluates whether the new password matches any of 
the previous 4 passwords.  

5. Click Apply to save the changes on the Server. 
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PASSWORD REUSE WARNINGS 

The following password-reuse violations cause warning messages to appear: 

 If a Site is running in High-Security mode and you disable enforcing password history, a warning message 

appears. 

 If enforcing password history is enabled and a password change request is made by the end-user (either 

by a user-initiated password reset or a forced reset), and the new password is the same as any of the 

specified number of previous passwords, the Server rejects the password change attempt. If a password 

change attempt over HTTP/S fails due to reuse, a warning message appears. 

 If a user logged in via FTP attempts to change the login password without being prompted (i.e., not a 

forced reset), and the password fails due to reuse, the Server rejects the password change, but the user 

may continue the FTP session. If the change attempt was due to a forced reset (i.e., require password 

change on initial login), the user will not be allowed to continue their session until a valid password is 

provided.  

 If a password change attempt over SFTP fails due to reuse, the Server rejects the change and prompts the 

user to resubmit a valid password. The user is allowed to continue their session until a valid password is 

provided.   

 If a password change attempt in the Administrator Login dialog box fails due to reuse, the Server rejects 

the change attempt, and a warning message appears. 

 

SPECIFYING A USER'S PERMISSION GROUP 

When you define a user account, you assign it to one or more permission Groups. The Group to which a user 

belongs determines the user's folder permissions in the Virtual File System (unless you define the user's 

permissions independent of a Group). 

To change a user's Group assignments 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user that you want to configure. 

3. In the right pane, click the Security tab. 
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4. In the Account Security area, click Groups. The Groups dialog box appears. 

 

5. To add/remove the user to/from Groups, double-click a Group in the Member of or Not a member of 

lists, or click a Group and click the left- or right-facing arrows.  

6. Click Apply to save the changes on the Server.  
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REMOVING OR DISABLING INACTIVE USER ACCOUNTS 

The Server allows you to automatically disable or remove accounts that have been inactive for a period that you 

specify (1 to 365 days). The removal of accounts is captured in the Auditing and Reporting database for reporting. 

 

Removing a user account deletes the account from the Authentication manager, but does not delete the user 
home folder or its contents. 

When a High Security Site is created in the Site Setup wizard, the option to remove inactive user and administrator 

accounts after 90 days is enabled by default. If during Site setup, the Server detects that one or more administrator 

accounts already exist, and that the option to remove administrator accounts after 90 days is not enabled or set to 

a value greater than 90 days, you are prompted to enable or change that setting. 

If a Server administrator attempts to login from a remote system via the Administrator and the password was 

incorrect or the username does not exist (either because it never existed or because it was removed), when you 

click Apply, the Server does not commit the change, and a warning message appears. In the message that appears, 

you can accept the non-compliant setting and provide a reason for using this setting (e.g., if you are using an 

alternate solution), or discard the change. If you accept the change and provide a reason, a warning message and 

the reason that you provided appear in the PCI compliance report. 

 
Removing inactive accounts takes place by use of an internal timer every night at midnight, at Server Startup, 
and each GetAllSites() response. 
 
Any transition from a non-PCI DSS compliant state to a PCI DSS compliant state, or a change in any date-
sensitive value, will reset all data value calculations. For example, if a Site is running in PCI DSS mode, and the 
administrator disables Remove inactive admin accounts after 90 days, clicks Apply, and then immediately 
decides to re-enable that option, the date values for all administrator accounts are reset from the time the 
option is enabled, even if the last login dates for those administrators was <n> days ago. The same reset also 
occurs if you change the password reset period from 30 days to 60 days; that is, the change itself prompts a 
reset of all the time-based values for that feature. 

On a High Security Site, if you do any of the following and the click Apply, the Server does not commit the change, 

and a warning message appears. 

 Disable the disable/remove inactive account option for administrators or regular users 

 Set the inactivity period to a value > 90 days of inactivity 

 Change the setting from "remove" to "disable"  

In the message that appears, you can discard the change or accept the non-compliant setting and provide a reason 

for using this setting (e.g., if you are using an alternate solution). If you accept the change and provide a reason, 

the warning and the reason that you provided appear in the PCI Compliance report. 
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To specify automatic removal or disabling of inactive user accounts 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user or Settings Template you want to configure, then click the Security tab. 

 

 

If the check box contains a gray check mark, the user or Settings Template is inheriting permission 
from the parent level. 

3. In the Account Security area, select the Disable/Remove account after <n> days of inactivity check box, 
click the list to specify Disable or Remove, then specify the number of days. You can specify from 1 to 365 
days. 90 days is the default, per PCI DSS 8.5.5.  
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CONFIGURING GROUPS 

Permission Groups set user virtual file system (VFS) permissions to folders. Just as User Settings Templates control 

access to the Server resources such as bandwidth allowances and connectivity privileges, the Permission Groups 

control access to files and folders. The Server creates the following default Groups for every Site: Administrative, 

All Users, and Guests. You can create new Groups and/or modify the settings for the default Groups. Consider your 

security and access needs, configure Groups according to those needs, then add users to the Groups based on the 

permissions that you want to allow. The Groups node appears in the left pane under the Site node. You cannot 

move Groups between Sites. 

 

To view Group permissions 

 In the Administrator, connect to the Server and click the VFS tab. The Permissions appear in the right 

pane.  

Groups can provide the permissions shown below as implied by their name (i.e., the Upload file Permission allows 

users in the Group to upload files; the Delete folder permission allows users in the Group to delete files).  

 

 
 

The Inherit permissions from parent folder check box is not available when the parent folder is selected. 

The default Groups have the following permissions, but you can edit them to suit your needs: 

 Administrative - every permission 

 All Users - List file permission and Show in List folder permission 

 Guests - Download and List file permission and Show in List folder permission. 

Users' permissions are inherited from the Groups to which they belong. For example, if user jsmith is a member of 

the Accounting, All Users, and HR Groups, their permissions are combined, giving jsmith Delete, Append, Show in 

List, List, and Create permission.  

For details of how permissions work, refer to The Virtual File System (VFS). 
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CREATING PERMISSION GROUPS 

You can create a permission Group and add any users from the Site to a Group. You can then grant permission to 

folders by Groups rather than granting permissions to each individual user.  

To create a permission Group  

1. In the Administrator, connect to the Server and click the Server tab. 

2. Do one of the following: 

 Press CTRL+G. 

 Right-click in the left pane, then click New Permission Group. 

 On the main menu, click Configuration, then click New Permissions Group. 

 In the left pane, click the Groups node, then in the right pane, click New.  

 

The Create New Group dialog box appears. 

 

3. In the Site box, click the list to specify the Site for which you want to create the new Group (if it is 

different than the Site in which you clicked the Groups node). 

4. Type a name for the Group in the Group Name box. For example, type Password Admins. 
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5. Click OK. The new group appears under the specified Site in the Groups node. 

 

 

Refer to Adding or Removing Users to or from a Group and The Virtual File System for information about users' 

permissions in relation to their assigned Group(s). 

DELETING GROUPS 

Deleting a Group does not delete the users assigned to that Group. You cannot delete the All Users Group.  

To delete a group 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Group node. 

3. Do one of the following: 

 Expand the Group node, click the Group you want to delete, then click the Delete icon   or 

press Delete on the keyboard. 

 In the right pane, click the Group that you want to delete, then click Remove.  

 

A confirmation prompt appears. 

4. Click Yes. The users in the deleted Group retain membership in any other of their assigned Groups and the 

All Users Group. 
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VIEWING GROUP MEMBERSHIP 

The Server creates the following default permission groups for every Site: Administrative, All Users, and Guests. 

User accounts are assigned to the All Users Group automatically. You can create other Groups and add/remove 

users from Groups. You cannot delete the All Users Group.  

The procedure below describes how to view which users are assigned to a selected Group.  

To view group membership  

1. In the Administrator, connect to the Server and click the Server tab. 

2. Expand the Groups nodes, then click a Group. The Group Membership tab appears. 

 

 

 The Member of box displays the users assigned to the selected Group. 

 The Not a member of box displays the users not assigned to the selected Group. 
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ADDING OR REMOVING USERS TO OR FROM A GROUP 

When you create a user in the Create New User wizard, you are asked to add the user to a Group. You can later 

add/remove users to/from Groups on the Group Membership tab or the user's Security tab. You can add any user 

to any Group on the same Site. You cannot add users from one Site to a Group on another Site. 

 

If a user does not have individual permissions for a folder and is a member of more than one Group, the 
Server gives the user the least-restrictive access for the folder. You can individually modify user permissions 
and those modified permissions will outweigh all Group permissions. For example, if a user is a member of 
three Groups that all have upload permissions to a particular folder, but you have denied that specific user 
permission to upload to the folder, then the user cannot upload to the folder. 

To move users into or out of a group 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, expand the Groups node, then click the Group you want to configure.  

 

3. In the right pane, in the Group Membership tab, double-click the user or use the arrows to move the user 

into or out of the Group. (You can multi-select using SHIFT and CTRL.) 

4. Click Apply to save the changes on the Server. 
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THE VIRTUAL FILE SYSTEM 

The topics below provide information regarding the Virtual File System in the Server, which allows you to grant 

access to files and folders on your system based on user and Group permissions. 

INTRODUCTION TO THE VIRTUAL FILE SYSTEM (VFS)  

The Virtual File System (VFS) allows you to make files and folders available to users through the granting of 

permissions. 

User permissions are given priority. 

In the folder that the user wants to access, if the Server finds user-specific permissions that are not those from 

Groups, the Server does not look for any Group permissions. The Server gives priority to individually configured 

permissions. For example, suppose there is a user with the user name Bob. Bob is a member of two permission 

Groups that have download and list permissions only for Folder1. However, you have decided to give Bob full 

permissions for Folder1 without creating a new permission Group. Since the Server looks for these individual user 

permissions first, then Bob will have full permissions for Folder1 no matter how his Group membership is 

configured. This same rule implies that if Bob has individual permissions that only allow him to download files from 

that particular folder, it does not matter if he is a member of two Groups that have full permissions for the folder. 

Bob will only have permission to download files. 

If a user does not have individual permissions for a folder and is a member of more than one group, the server 

gives the user the least restrictive access for the folder. 

From their Groups, users receive all the permissions available for the folder. For example, suppose a user with the 

user name Jan is a member of two Groups, Group1 and Group2, that both have permissions for a particular folder, 

Folder2. If Group1 has download permission and Group2 has upload permission then Jan will have both upload 

and download permissions for Folder2. 

The All Users group is the same as any other group except that it can't be removed from the root folder 

permissions list.  

You can use the All Users Group to determine inherited permissions from the parent folder. If you change any 

inherited permissions for the All Users group, the server display a confirmation message to make sure you want to 

change the inherited permissions. 

On the VFS tab, you can specify which files and folders are available to users, and then specify Group and user 

permissions for the folders.  

The Virtual File System (VFS) allows you to create physical folders and virtual folders. 

 Physical folders are folders you create on the local hard drive from the Server.  

 Virtual folders refer (point) to existing folders on your computer or another system, similar to a Windows 

shortcut. Because a virtual folder name is only an alias for the real folder, when you create a virtual folder, 

you do not have to give it the same name as the folder it references. 

You make the files, physical folders, and virtual folders available to users by granting permissions based on their 

Group membership. VFS permissions are constructed to allow users the least restrictive access to folders.  

For example, suppose a user is a member of a Group that has read, upload, download, and delete permissions to a 

folder. Even if the user is a member of another Group that has only download permissions to the same folder, the 

user will be able to read, upload, download, and delete files from that folder. 
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MODIFYING VFS PERMISSION 

Any time a new folder is created, it inherits permissions from its parent folder. Using permission inheritance, 

administrators can make global access changes by simply changing group access in a parent folder.  

You can modify a folder's permissions even while it is inheriting permissions from a parent folder. 

To modify a permission  

1. In the Server Administrator, connect to the server, then click the VFS tab. 

2. In the left pane, click a folder in the VFS structure. 

 

3. In the right pane, click a Group or user, or click Add to add a user or Group to the selected folder. 

4. In the right pane, click the user or group for which you want to modify permissions. 

5. Select the Inherit permissions from parent folder check box and any other additional permissions. 

 

Modifying a permission affects all sub-folders containing the user or Group for which the Inherit 
permissions from parent folder check box is selected. 
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HOW VFS PERMISSIONS WORK 

When a user logs in to EFT Server's HTML Listing and Upload Form or the Web Transfer Client, the files and folders 

that the user is allowed to access depends on the permissions assigned on the VFS tab. The VFS tab allows you to 

enable or disable the following permissions for a group or a user.  

 

File Permissions - Used to specify file permissions for users or groups in the right pane. 

 Upload - Allows users to upload to their folder. By default, the Administrators group and the user folders 
each have Upload permission. (The All Users and Guest groups do not have this permission by default.)  

 Download - Allows users to download to their folder. By default, the Administrators group, the Guest 
group, and the user folders have Download permission. (The All Users group does not have this 
permission by default.)  

 Append - Allows users to add to files in the folder. By default, only the Administrators group has this 
permission. 

 Delete - Allows users to delete files from the folder. By default, only the Administrators group has this 
permission. 

 Rename - Allows users to rename files. By default, only the Administrators group has this permission. 

 List - Allows users to retrieve a directory listing (of files and folders) from the Server. If it is not selected, 
no files or folders are visible. By default, only the Administrators group has this permission. (Refer to the 
example below for more information.) 

Folder Permissions - Used to specify folder permissions for users or groups in the right pane. 

 Show in List - Allows users to view the folder when the parent directory's listing is retrieved. (Refer to the 
example below for more information.) 

 Delete - Allows users to delete folders. 

 Create - Allows users to create folders. 

Contents - Used to specify file and folder permissions for users or groups in the right pane. 

 Show hidden - Allows users to view hidden folders and files. 

 Show read only - Allows users to view read-only folders and files. 

Inherit permissions from parent folder - When you select this for any folder in the tree, the selected folder will 

inherit the permissions assigned to its parent folder. For example, if you specify that folder Usr is to inherit the 

permissions assigned to its parent folder, then Usr has the same permissions as the Site root folder. If you clear the 

check box, a message appears in which you can copy the parent folder's permissions and then edit them as needed 

or remove all inherited permissions. 

Enable Microsoft Encrypting File System for this folder - Allows you to right-click a folder in the left pane and 

encrypt the contents of the folder. Refer to Streaming Repository Encryption for details. 
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Example 

Within the VFS system, the List file permission and the Show in List folder permission can confuse users as to the 

intended operation of the server. At first glance, it would appear that List refers to the ability to see files in the 

directory and Show in List would refer to the ability to see folders in the directory, but this is incorrect.  

 The List file permission refers to the user’s ability to retrieve a directory listing from the Server. If this 
option is enabled, the user is able to see a list of files in the directory. If it is disabled, no files or 
directories will be visible. 

 The Show in List permission is a bit more complex in that the permission corresponds to whether or not 
the directory will show up when a directory listing is retrieved in the parent directory. The interaction 
between inheritance and this setting can therefore lead to a bit of confusion.  

Let’s use the following folder structure as an example: 

 

If you select user Alex and disable the Show in list permission for user Jane, then when user Jane navigates to the 

/Usr/ directory and retrieves a directory listing, the folder Alex will NOT appear in her directory listing. To 

complicate matters, however, Jane still has access to the folder and if someone tells her to manually navigate to 

that folder she will still be able to perform actions within the Alex folder (provided she has appropriate 

permissions). In this scenario, by default, when user Jane retrieves a directory listing from within the folder Alex, 

she will only see a list of files in the folder; she will not see any subfolders in the folder. Why? Because the 

subfolders,  incoming, outgoing, and shared, have all inherited the disabled Show in list setting!  

Summary: 

 The List permission applies to both files and folders in the current directory. 

 The Show in List permission applies to the visibility of the current folder in its parent directory. 

 Default inheritance rules will cause the subfolders of a Show in list-disabled folder to not display. 
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DISABLING INHERITANCE IN THE VFS 

You can override a user’s inherited settings by clearing the Inherit permissions from parent folder check box. If 

you later decide you want the folder to inherit permissions again, simply select the Inherit permissions from 

parent folder check box. 

The following procedure describes how to prevent a folder from inheriting its parent folder’s permissions and force 

a single modified folder to begin inheriting permissions to sub-folders.  

To reset all subfolders of a particular parent folder to inherit permissions from that parent, refer to Resetting VFS 

Folder Permissions.  

To stop or force a folder from inheriting permissions  

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the folder you want to configure. 

3. In the right pane, do one of the following: 

 To force the folder to inherit permissions from a parent folder, select the Inherit permissions 

from parent folder check box. 

 To stop the folder from inheriting permissions from a parent folder, clear the Inherit permissions 

from parent folder check box. A message appears. 

 

 

4. On the message that appears, click one of the following: 

 Copy - duplicates the permissions of the parent level. You may later edit the permissions. 

 Remove - deletes all inherited permissions. 

 Cancel - aborts the changes and closes the message. 

CREATING A NEW PHYSICAL FOLDER 

You can create a physical folder in the Virtual File System (VFS) of the Administrator.  

To create a new physical folder 

1. In the Administrator, connect to the Server and click the VFS tab. 

2. In the left pane, click the folder in which you want to create a subfolder, then do one of the following: 

 Right-click the folder, then click New Physical Folder.  

 On the toolbar, click the New Folder icon . 

 On the main menu, click Configuration > New Physical Folder.  
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The Create Folder dialog box appears. 

 

 

3. Type a name for the new folder, then click OK. The new folder appears in the tree. 

 

 

CHANGING THE NAME OF A PHYSICAL FOLDER 

You can change the name of a physical folder on the Server, but you cannot change the name of a virtual folder. 

To rename a physical folder 

1. In the Administrator, connect to the Server and click the VFS tab. 

2. In the left pane, right-click the folder you want to configure, then click Rename Folder. The folder name 

becomes selectable. 

 

 

3. Type the new name, then press ENTER. 

DELETING A PHYSICAL FOLDER 

When you delete a physical folder from within the Server, the folder is deleted from the Server AND your 

computer's hard drive. If you want to delete only the reference to the folder in the Server, refer to Deleting a 

Virtual Folder. 

To delete a physical folder 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, right-click the folder you want to delete, then click Delete Folder. A confirmation 

message appears. 
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3. Click Yes. 

CREATING A NEW VIRTUAL FOLDER 

Virtual folders reference physical folders on a computer's hard drive. Similar to a Windows shortcut, a virtual 

folder is only an alias for the real folder. When you create a virtual folder, you do not have to give it the same 

name as the folder it references. You cannot change the name of a virtual folder, but you can delete the virtual 

folder and then re-create it with a new name.  

1. In the Administrator, connect to the Server and click the VFS tab. 

2. In the left pane, click the folder in which you want to add a virtual subfolder, then do one of the following: 

 Right-click the folder, then click New Virtual Folder.  

 On the toolbar, click the New Virtual Folder icon . 

 On the main menu, click Configuration > New Virtual Folder.  

The New Virtual Folder dialog box appears. 

 

3. In the Alias box, type a name for the folder. 

4. In the Target box, specify the target folder by typing the path or click the open icon  and browse to the 

target folder. 

5. Click OK. The new virtual folder appears in the tree with the name that you typed in the Alias box, plus 

"Virtual" and the full path. 

 

 

DELETING A VIRTUAL FOLDER 

When you delete a virtual folder, you merely delete a pointer, not the actual folder it references.  

To delete a virtual folder 

1. In the Administrator, connect to the Server and click the Server tab. 
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2. In the left pane, right-click the folder you want to delete, then click Delete Folder. A confirmation 

message appears. 

3. Click Yes. 

SETTING VFS FOLDER PERMISSIONS 

You can set permissions for virtual folders by Group or per user. If you specify a home folder when you create a 

new user, the user has full permission on that folder. Refer to Introduction to the Virtual File System (VFS) for 

details of how virtual folder permissions work. 

To set folder permissions 

1. In the Administrator, connect to the Server and click the VFS tab. 

2. In the left pane, click the folder you want to configure. The right pane displays each of the users and 

Groups who have permissions on the selected folder. 

 

 

3. In the right pane, click the user or Group you want to modify or click Add to specify permissions for a user 

or Group on the folder. Refer to Adding a User or Group to VFS Permissions for the procedure for adding a 

user or Group. 

4. Select or clear the appropriate permission check boxes in the File Permissions (Upload, Download, 

Append, Delete, Rename, List), Folder Permissions (Show in list, Create, Delete), and Contents (Show 

hidden, Show read only) areas, or select the Inherit permissions from parent folder check box. 

5. (Optional; Available in EFT Server Enterprise) Select the Enable Microsoft Encrypting File System (EFS) for 

this folder check box. Refer to Streaming Repository Encryption for more information.  

6. Click Apply to save the changes on the Server. 

ADDING A USER OR GROUP TO VFS PERMISSIONS 

You can add a user or Group to existing Permissions on the VFS tab's Permission pane. 

To add user or group permissions 

1. In the Administrator, connect to the Server and click the VFS tab. 

2. In the left pane, click the folder you want to configure. The right pane displays each of the users and 

Groups who have permissions on the selected folder. 
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3. In the right pane, click the user or Group you want to modify or click Add to specify permissions for a user 

or Group on the folder that you clicked in the left pane. The Add User/Group dialog box appears. 

 

 

4. Do one of the following: 

 Groups that you have defined appear in the Groups box. (Default groups do not appear, because 

they are already defined in the Permissions pane.) Click the Groups list to specify a Group to add.  

 Users that you have defined appear in the Users box. Click the Users list to specify a user to add. 

5. In the Permissions area, click one of the permissions: 

 Administrator (full permissions) 

 Guest (read permissions) 

 None 

6. Click OK. The user or Group appears in the Permissions pane. 
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RESETTING VFS FOLDER PERMISSIONS 

When you reset VFS folder permissions on a parent folder, you force the subfolders to mirror the parent folder's 

permissions. This simplifies the permissions status of these folders, making them more predictable.  

 

Resetting folder permissions from a parent folder differs from manually changing the inheritance values of 
subfolders. In a subfolder, you have the option either to mirror the parent folder's permissions or to keep 
permissions for any new users and Groups you have added while also mirroring the permissions for all Groups 
in the parent folder. 

To reset folder permissions from a parent folder  

1. In the Administrator, connect to the Server and click the VFS tab. 

2. In the left pane, right-click the parent folder you want to configure, then click Reset Subfolders. 

3. Click OK. 

MAPPING A VIRTUAL FOLDER TO A NETWORK DRIVE 

To map a virtual folder to a network drive, you need to establish a separate Windows account for the EFT 

Server service, with full access to any folder you want to make available on the Server, and your account on the 

computer on which the Server is running must have full access to any folder you want to make available on the 

Server. 

To map to a network drive  

1. Create and assign a Windows account on the computer on which the EFT Server service is installed. 

 

This should not be the default (system) account. 

2. Assign restrictive file and folder permissions for this account. 

3. If you are mapping to a network drive in a workgroup, create a matching account on the target remote 

computer. Make certain it uses the SAME user name and password. Restrict permissions to this account 

to allow users access to only the folders they need. 

4. In the Administrator, connect to the server, then click the Server tab. 

5. Create a virtual folder for a folder on your networked drive. If you are remotely administering, or the drive 

is not mapped to your computer, make sure that you use a UNC path name. 

6. Assign permissions for users by clicking the VFS tab within the Server, clicking the folder in question, and 

then selecting or clearing the appropriate permission boxes. 

 

You need to have administrative rights to the system on which the service is running to create accounts.  
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STREAMING REPOSITORY ENCRYPTION 

(Available in EFT Server Enterprise) 

Files stored on the disk in the Server's Virtual File System can be transparently encrypted during read/write using 

Microsoft's Encrypting File System (EFS). Data is encrypted as it is written to disk, and decrypted prior to 

transmission. 

 

 If you turn on this feature, it is recommended that you set up appropriate back-up measures to protect 

your data. If you need to recover a private key to decrypt data, and that key is lost, you will not be able to 

recover the data that the key protects. Streaming repository encryption leverages Microsoft's Encrypting 

File System (EFS). If you need more information on setting up appropriate back-up procedures, refer to 

Best Practices for Configuration and Validation. 

 Streaming repository encryption is not available for systems running on FAT32 file systems. NTFS is 

required. 

 Streaming repository encryption is not available with NT authentication due to limitations of NT 

authentication. If you require this feature with an NT set up, LDAP authentication is recommended. 

 PCI DSS requirement 3.4.1 requires that logical access and decryption keys be managed independently for 

disk-level encryption. If you enable this feature for a PCI DSS-enabled Site, the Server prompts you to 

disable it, or continue with reason. 

 The PCI DSS requires that if disk encryption is used (rather than file- or column-level database encryption), 

logical access must be managed independently of native operating system access control mechanisms (for 

example, by not using local system or Active Directory accounts). Decryption keys must not be tied to user 

accounts. That does not mean EFS cannot be used at all, but rather that it cannot be used as the sole 

mechanism for repository encryption. For this reason, the Server will only warn, rather than fail, during an 

audit. 

To enable streaming repository encryption 

1. In the Administrator, connect to the Server and click the VFS tab. 

2. In the left pane, right-click the parent folder you want to configure, then click Encrypt Contents. 

 

3. If the folder you selected has subfolders, a confirmation message appears. 
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4. Specify whether to Apply changes to this folder only or Apply changes to this folder and all subfolders, 

then click OK. 

5. The folder and subfolders, if selected, display a red asterisk to indicate that the folder contents are 

encrypted. 

 

6. To remove encryption, right-click the encrypted folder and click Encrypt Contents to clear the check box. 

 

7. If the folder you selected has subfolders, a confirmation message appears. Specify whether to Apply 

changes to this folder only or Apply changes to this folder and all subfolders, then click OK. 

The asterisk is removed from the folder and subfolders, if selected. 
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COMMANDS 

The topics below provide the procedures for configuring and using Commands in EFT Server. 

INTRODUCTION TO COMMANDS 

EFT Server's Commands can execute programs, scripts, or batch files with or without command line arguments, 

providing administrators almost limitless extensibility. These Commands can be invoked directly by a user from 

their client (if permitted by the Server administrator) or as an automated action from the Server’s Event Rules.  

When the Event Rule is triggered, the Server executes the specified custom Command and attributes. To configure 

the Server to execute Commands, you first create the command, then add the command to an Event Rule. In the 

Administrator, the Commands appear in the tree in the left pane within the Site for which they are defined.  

With the Server tab selected, when you click the Commands node in the left pane, the Commands List appears in 

the right pane.  

 Click New to create a new Command. 

 Click a Command then click Edit to edit an existing Command. 

 Select a Command in the list, then click Remove to delete it. (A confirmation message appears.) 

THE CUSTOM COMMAND WIZARD 

The Custom Command wizard steps you through the process of creating a Command to tell the Server to execute 

programs, scripts, or batch files. 

The procedure below describes how to create a Command using the Custom Command Wizard. You can also 

create Commands manually and edit existing Commands using the instructions in Creating a Command. 

To create a command with the Custom Command wizard 

1. Do one of the following: 

 On the toolbar, click the New Command icon .  

 On the main menu, click Configuration > New Command.  

 In the left pane, right-click the Commands node, then click New Command. 

 Click the Commands node in the left pane, then, in the right pane, click New. 

 Press CTRL+M. 

The Custom Command Wizard appears.  
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2. In the Name box, type a descriptive name for the command. You will reference the Command name in 

Event Rules, so you should give the Command an intuitive name. For example, instead of Command 1, 

you might call it Run CScript. 

3. Provide a Description that will help you identify the command. 

4. Click Next. The path page appears. 

 

5. In the Path to executable box, browse to or type the path to the executable. For example, you can specify 

a program, a batch file, or a Windows scripting executable (e.g., cscript.exe or wscript.exe).  
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6. (Optional) Specify any required parameters. Alternately, you can specify the parameters when you add 

the Command to an Event Rule. If there are "standard" parameters that you will always use with the 

script, you can specify them here, then modify them or add additional parameters when you add the 

Command to an Event Rule. 

7. Click Finish. The Command is added to the Commands node for the Site and appears in the Commands 

List tab in the right pane. 

Refer to Editing a Command for the procedure for editing the Command, including defining parameters to 

pass to the Command, an invalid parameter count message, and FTP-specific commands. 

EDITING A COMMAND 

The procedure below describes how to edit a command that you can execute with an Event Rule. For a general 

introduction to Commands, refer to Introduction to the Server Commands. 

Create a command using the procedure below or use the Custom Command Wizard.  

To create a command  

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, expand the Site node for the Site that you want to configure, then click Commands. 



EFT Server™ version 6 

440  

3. In the right pane, click the Command that you want to edit. The Command Settings tab appears. 

 

 

4. The Command label box displays the name you gave the Command. You will reference the Command 

label in the Event Rule pane and Custom Command dialog box (in the Select Command drop-down 

menu), so you should give the Command an intuitive name. For example, instead of Command 1, you 

might call it Run CScript. 

5. The Command description box displays the description that you gave the Command. 

6. The Executable path box displays the path to the file that you want the Command to execute.. 

7. The Parameters box displays any parameters that the client must send. 

8. To create a log that you can use to troubleshoot the command in case of failure, select the Redirect 

output to a log file check box, then type the path to the log file or click the open icon to browse to and 

select the file. 

9. If you want the Server to return an error if the launched process fails to respond, select the Enable 

process timeout check box and specify the number of seconds the Server should wait before terminating 

the command. 

10. To specify FTP client settings, in the FTP Custom Command Specific area, click Configure. The FTP Custom 

Command Specific dialog box appears. 
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11. Select the Redirect command output to connecting client check box in the extremely rare case in which 

the command will be launched by a connecting FTP client (if configured to do so). If you select Redirect 

command output to connecting client, the result is sent to the connecting FTP client in a 220 message 

response. In the majority of cases, you should leave the check box cleared. 

12. If you want to force the FTP client to send a minimum number of parameters, select the Require a 

minimum of check box and specify the minimum number of parameters required.  

 To provide a message that users will receive when the parameter number is not met, next to 

Invalid parameter count message, click Configure. Provide the message, then click OK. 

 

 To specify the users and Groups that can execute the Command, next to User(s) or group(s) 

allowed to execute this custom command, click Configure. Double-click the users and/or groups, 

or use the arrows to move them between the Site users/groups list and the Permit execution 

list, then click OK. 

 

13. Click Apply to save the changes on the Server. 

CUSTOM COMMAND EXAMPLE 

The following example Command shows the configuration of a custom command from the perspective of both the 

Server and client. To follow the example exactly, you will need to download and install CuteFTP Professional, which 

is available as a free 30-day trial and can be downloaded from http://www.globalscape.com/downloads. However, 

any client that supports custom commands or raw FTP commands will work. 

http://www.globalscape.com/downloads/
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CREATING THE COMMAND 

This command copies the Server log files from the Logs folder to C:\Temp using the Windows xcopy command and 

CuteFTP Pro's command-line functions. 

To create a custom command 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, expand the Site node for the Site that you want to configure, then click Commands. 

3. In the right pane, click New. The Custom Command Wizard appears. 

4. Follow the instructions in The Custom Command Wizard to define the Command. 

EXECUTING THE COMMAND 

You can run the Command "on the fly," configure the Command in the FTP client (in this example, CuteFTP 

Professional), or insert the Command in an Event Rule. 

Using the Command "on the fly" in CuteFTP Pro 

1. Start CuteFTP Pro and connect to the Server. 

2. If not already displayed, open the Session Log pane. (On the main menu, click View > Show Panes > 

Individual Session Logs or press ALT+2.) 

3. Right-click a blank area of the Session Log, then click Input Raw FTP Command, or press CTRL+SHIFT+I. 

The Input FTP Command dialog box appears. 

 

 

4. In the Command box, type site, the name of the Command as defined in the Server and any required 

parameters. For this example, type: 
site xcopy "C:\InetPub\EFTRoot\MySite\Usr\jbug" "C:\Temp" 

5. Click OK. The Command executes. In this example, each of the files in the \Usr\jbug folder was copied to 

the \Temp folder. If you selected the Return output to client check box when you defined the Command 

in EFT Server (step 8 above), the Session Log displays the results of the Command. For example: 

COMMAND:> site xcopy "C:\InetPub\EFTRoot\MySite\Usr\jbug" "C:\Temp" 

220-C:\InetPub\EFTRoot\MySite\Usr\jbug\cftpsaiProperties.gif 

220-C:\InetPub\EFTRoot\MySite\Usr\jbug\EFTtaxonomy_filelist.xml 

220-C:\InetPub\EFTRoot\MySite\Usr\jbug\EFTtaxonomy_image001.png 

220-C:\InetPub\EFTRoot\MySite\Usr\jbug\inheritance.doc 

220-220-C:\InetPub\EFTRoot\MySite\Usr\jbug\Message3.gif 

220-C:\InetPub\EFTRoot\MySite\Usr\jbug\RE Certificate Chaining.htm 

220-C:\InetPub\EFTRoot\MySite\Usr\jbug\Root Migration Scripts.htm 

220-C:\InetPub\EFTRoot\MySite\Usr\jbug\Thumbs.db 

220-8 File(s) copied 

220-220- 

220 Command completed with code 0.  
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Configuring the Command in CuteFTP Pro 

1. Start CuteFTP Professional and connect to the Server. (Refer to the CuteFTP Pro help for details of how to 

connect to the Server.) 

2. On the main menu, click Tools > Custom Commands > Edit Custom Commands. The Custom Commands 

dialog box appears. 

 

You must be connected to an FTP server in order for the Commands option to be available. 

3. Click New then type a name for the command. For this example, type xcopy. 

4. Click the command in the tree, then click Edit or right-click the new command and click Properties. The 

Custom Command Properties dialog box appears. 

5. In the Label box, the name of the command appears. 

6. In the Command box, type: 
site xcopy "C:\InetPub\EFTRoot\MySite\Usr\jbug" "C:\Temp" /d 

 

Commands must start with site and then the command name you used in the Server, not the 

name you gave the command in CuteFTP. The /d parameter copies all new files in the specified 
folder.  

7. Optionally, specify any key or key combination for the Shortcut Key and any icon for the Toolbar Icon. 

8. Select the Place on the Custom Commands toolbar check box, then click OK to close the Custom 

Commands Properties dialog box. 

9. Click OK to close the Commands dialog box. Your custom command is now enabled and the icon, if 

specified, appears on the toolbar. (If the command is not displayed, click View > Toolbars > Custom 

Commands Bar.) 

10. Start CuteFTP Pro and connect to the Server. 

11. If it not already displayed, open the Session Log pane. (On the main menu, click View > Show Panes > 

Individual Session Logs or press ALT+2.)  

12. On the toolbar, click the Command icon that you just created.  

13. Monitor the output in the Session Log. You should receive various response messages indicating the 

progress of the archive. 
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EXECUTING THE COMMAND AUTOMATICALLY USING AN EVENT RULE 

If you want to copy the log file automatically every day, you can create a Scheduler (Timer) Event and insert the 

Execute command in folder Action. Using this method, you would have to define the parameters in the Custom 

Command dialog box from within the Event Rule. Refer to Using an Event Rule to Execute a Command for more 

information. 

Possible Error Situations 

 If you repeat the hard coded parameters in both the client and the Server, then the first parameter that 

the client sends will be used. For example, if SITE ZIP -c %at[archive name] %ff is configured in the client, 

and -c %1% %2% is configured in the Server, then the first parameter (-c) that the client sends will be used 

as %1% and the resulting string would be -c -c filename.ext. Therefore, it is important to 

educate the FTP user on the proper syntax and supply most of the hard-coded parameters on the Server 

side.  

 If you do not give the user permission to run the Command on the Permissions tab on the Server, they 

will receive a "Permission Denied" error.  

 Certain command line utilities that may show a Windows prompt or other dialog may not execute 

properly when called from the FTP Engine while it is running as a service. This is especially true when the 

service is being logged in from a Local System account.  

 The Server can return an error if the client provides the wrong number of parameters or invalid 

parameters.  

 To limit security vulnerabilities to the server, the server administrator should only allow limited access to 

commands that launch processes. 

 

Always use caution when giving program access to your system32 directory (especially an FTP 
server).  

VIEWING AND REMOVING COMMANDS 

Custom Commands defined on a Site appear in the left pane under the Commands node for the Site and in the 

right pane when the Commands node is selected. 

To view the Commands defined on a Site 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, expand the Site node for the Site that you want to configure, then click Commands. 

The Commands appear under the Commands node.  

 

 

The Commands List tab appears in the right pane. 
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On the Commands List tab, you can view and remove Commands, and add new Commands. 

To remove a command, do one of the following: 

 Click the Command in the Commands List, then click Remove. 

 In the left pane, click the Command, then press DELETE. 

 In the left pane, right-click the Command, then click Delete. 

ENABLING AND DISABLING COMMANDS 

You can enable and disable Commands as needed, without deleting them. 

To enable or disable a Command 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, expand the Site node for the Site that you want to configure, click Commands, then click 

a Command in the tree. The Command's definition appears in the right pane.  

When you create a new Command, the Enable this command check box is selected.  
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3. To disable the Command, clear the Enable this command check box. When the Command is disabled, an x 

within a red circle appears over the Command icon . 
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EVENT RULES 

The topics below provide the procedures for defining and using Event Rules in EFT Server. 

INTRODUCTION TO EVENT RULES 

Event Rules are based on a simple premise: an event occurs that triggers an action. Beyond that, you can specify 

conditions that must exist before an action is taken or that change the action that is taken. For example, suppose 

you have a folder in which customers can drop files. You can set up an Event Rule that monitors that folder, and 

when someone puts a file into that folder, the Server will encrypt that file, move it into another folder, perhaps a 

safer location, and then send e-mails to anyone you specify informing them that a file has been moved. You can 

also set up a rule that only moves particular files. For example, you can configure the rule to move only the files 

with "Important" in the name, or you can route particular files to different folders.  

Event Rules consist of triggering Events, any optional Conditions affecting the Event Rule, and the resulting 

Actions that are carried out. You can modify your rules any time in the Administrator. 

Sample Logic 

You can easily create complex programmatic events using the Server’s Event Rules. The Event Rule system contains 

objects that you simply click to add to the Rule builder, then click in the Rule to modify parameters and add 

variables. Below are some examples of logic you can create (in pseudo code).  

Always run an Action if an Event occurs:  

ON FILE UPLOAD  

{  

      PGP Encrypt %FS.FILE_PATH%  

}  

Conditionally run an Action if an Event occurs (IF-THEN statement):  

ON FILE UPLOAD  

{  

    if ( %FS.FILE_NAME% = "*.pgp" ) 

   {  

      PGP Decrypt %FS.FILE_PATH%  

   }  

}  

Multiple IF-THEN statements (if something, do this; if something else, do that)  

ON FILE UPLOAD  

{  

   if ( %FS.FILE_NAME% = "*.pgp" )  

   {  

      PGP Decrypt %FS.FILE_PATH%  

   }  

   if ( %FS.FILE_NAME% = "*.zip" )  

   {  

        UNZIP %FS.FILE_PATH% to "%FS.FILE_PATH%\%EVENT.DATE%_%EVENT.TIME%\"  

   }  

}  
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Else statements (if preceding condition is not met, do something)  

ON FILE UPLOAD  

{  

   if ( %FS.FILE_NAME% = "*.pgp" )  

   {  

      PGP Decrypt %FS.FILE_PATH%  

   }  

   if ( %FS.FILE_NAME% = "*.zip" )  

   {  

        UNZIP %FS.FILE_PATH% to "%FS.FILE_PATH%\%EVENT.DATE%_%EVENT.TIME%\"  

   } 

   else  

   {  

        MOVE %FS.FILE_PATH% to "%FS.FILE_PATH%\%EVENT.DATE%_%EVENT.TIME%\"  

   }  

}  

Run always action (action that will always run when the event occurs even if preceding IF-THEN-ELSE statements 

are true)  

ON FILE UPLOAD  

{  

   if ( %FS.FILE_NAME% = "*.pgp" )  

   {  

      PGP Decrypt %FS.FILE_PATH%  

   }  

   else  

   {  

        MOVE %FS.FILE_PATH% to "%FS.FILE_PATH%\%EVENT.DATE%_%EVENT.TIME%\"  

   } 

  MOVE "%FS.FILE_PATH%\%EVENT.DATE%_%EVENT.TIME%\*.*" to 

https://somehost/%USER.LOGON%/  

  SEND NOTIFICATION e-mail TO %user.e-mail%  

}  

 

Run the same action more than once:  

ON FILE UPLOAD 

{  

   SEND NOTIFICATION e-mail TO serveradmin@globalscape.com 

  SEND NOTIFICATION e-mail TO %user.e-mail%  

}  

 

Create compound conditional statements supporting AND and OR logical operators:  

ON FILE UPLOAD  

{  

    if ( %FS.FILE_NAME% = "*.pgp" ) || ( %FS.FILE_NAME% = "*.encrypted" ) 

   { 

      PGP Decrypt %FS.FILE_PATH%  

   }  

   else  

   {  

        MOVE %FS.FILE_PATH% to "%FS.FILE_PATH%\%EVENT.DATE%_%EVENT.TIME%\" 

   }  

  SEND NOTIFICATION e-mail TO %user.e-mail%  

}  
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It is possible to configure Event Rules that create infinitely recursive cycles. Since all Event Rules operate 
synchronously, a file upload event cannot be completed until all corresponding event actions are finished. This 
could lead to unpredictable server behavior due to conflicts with shared access to the same files or deleting 
open files. Be careful not to create circumstances where such recursive cycles might occur. For file upload 
events, recursive cycles are not typical. It is recommended that you move files on the same server using the 
filesystem - not FTP. 

EVENT RULE ORDER OF EXECUTION 

If you create more than one Event Rule for a single type of event, for example, Monitor Folder, the Server 

prioritizes the rules in the order they appear on the Event Rules list.  

To change the priority of a rule 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure, then click Event Rules. The Rules list appears in the 

right pane. 

3. In the right pane, select the Event Rule you want to move.  

4. To reorder the Event Rules, under Rule Priority, click Higher and Lower. 

 

 

The Rule list is grouped by Rule type. You can only prioritize the Rules within a Rule type. For example, you cannot 

move an On Folder Monitor rule above an On Scheduler (Timer) Event rule, but you can reprioritize the rules 

within the Rule type. 

One or more Event Rules may be triggered when conditions are met. For matching Event Rules, meaning those 

with duplicate event trigger definitions and conditions, but with different actions, the order of execution is 

sequential according to the sort order defined in the Administrator.  
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This sequential firing of duplicate Event Rules applies to almost all of the Server’s supported events; however, the 

Monitor Folder and Timer Event Rules are executed asynchronously. The triggering of those events occurs almost 

simultaneously and is controlled by the operating system, not by the Server. 

 

As mentioned above, matching Timer and Monitor Folder events are executed asynchronously; however, Monitor 

Folder "threads" are limited to three concurrent threads by default. This means that if you have 5 folder monitor 

Event Rules monitoring the same folder and a file is added to the monitored folder, only 3 of the 5 Rules will fire, 

as determined by the operating system. The 4th and then 5th Rule execute only when one or more of those three 

threads are done firing and executing any actions. 
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DEFINING EVENT RULES 

To define Event Rules in the Administrator, you begin with an event you want to use as a trigger for the Event Rule. 

The event could be when someone uploads a file, when a user quota is exceeded, or when a change is detected in 

a folder. Then you specify an Action to be taken when the event occurs. The Action could be sending an e-mail to 

someone, encrypting a file, moving a file, or all three together. Optionally, you can then define Conditions that 

must be met for the Action to be taken. You can even branch the Actions and define one Action to be taken if 

specified criteria are met. You do this using standard If>Else logic.  

To define an Event Rule  

1. In the Administrator, connect to the Server and click the Server tab. 

2. Do one of the following: 

 Right-click in the left pane, then click New Event Rule.  

 In the left pane, expand the Site you want to configure, then click Event Rules. In the right pane, 

click New. 

 On the main menu, click Configuration > New Event Rule. 
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The Create New Event Rule dialog box appears: 

 

 

3. In the Event Rule name box, type a descriptive name for the rule. This name will appear in the Event Rules 

node and in reports and logs 

4. In the Description box, provide any notes about the rule, such as "Automatic move and delete of 

accounting folder." You can edit these notes later in the Comment area for the Rule, if necessary. 

5. In the Select event trigger box, click the event you want to use as the basis of the Event Rule, such as 

Folder Monitor. For a description of the available event triggers, refer to List of Events. 

6. Click Create. The Create Event New Rule dialog box closes and the Conditions and Actions available for 

the Event Rule are displayed in the right pane. 
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7. Available Conditions for the specified event trigger display in the Conditions list. When applicable to the 

Event Rule, the Else option also appears. To add a Condition to the Rule, click the Condition, then click 

Add Condition, or double-click it. Conditions are optional.  

 

Not all Conditions that the Server supports are available for every event. To learn more about available 

Conditions, refer to Event Rule Conditions.  

8. Available Actions for the specified event trigger display in the Actions list. To add an Action to the Rule, 

click an Action, then click Add Action or double-click it. To learn more about Actions, refer to Event Rule 

Actions.  

9. In the Rule pane, click the blue and red text links to toggle behavior and specify executables, e-mail 

addresses, or file paths used in definition of the Event Rule. You can also reorder the sequence of the rule 

logic using the blue up/down arrows that display to the right of the action or condition, or by clicking the 

Action or Condition and dragging it to the new location.  

 

 

10. Click Apply to save the changes on the Server.  

 

The Server will not save the Rule unless it is adequately defined. Links displayed in the Rule box indicate 

that there are parameters that must be defined before you can save and apply the rule. 

11. After the Rule is defined, click the Event Rules node in the Server tree in the left pane. Each of the Rules 

defined on the Site appear in the right pane.  
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In the right pane, in the Rule List, click a Rule. The comments for the Rule appear beneath the Rule List in 

the Comment box and the definition of the Rule (the Conditions and Actions defined) appears in the Rule 

overview box.  

 To edit the notes in the Comment box, click in the box and type or paste the changes. 

 To manage the Rules (edit, delete, clone, reorder), click the controls on the right. Refer to 

Managing Event Rules for details. 

 

12. To remove a Rule, click to select it in the Event Rules node, then click  Remove at the bottom of the 

right pane or on the toolbar. A confirmation message appears. Click Yes to confirm or click No or Cancel 

to not delete the Rule. 

MANAGING EVENT RULES 

When you click the Event Rules node for a Site, the right pane provides controls for managing the Event Rules 

defined for that Site. Using this interface, you can do the following:  

Edit - You can fine tune your Rules by adding, editing, deleting, and rearranging Conditions and Actions.  

Delete - If an Event Rule is no longer needed and you are sure you will not need it again in the future, you can 

delete it. However, you can also disable the Rule so that, if you need the Rule again, you can simply enable it. 

Clone - You can create a copy of Rule and modify it to your needs. You can then rename the Rule. 

Prioritize - If you create more than one Rule for a single type of event, the Server prioritizes the rules in the order 

they appear on the Event Rules list. You can rearrange them using the Rule Priority buttons. 

Disable - If you want to disable a Rule temporarily without deleting it, you can disable it by clearing the Enable this 

rule check box. 
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To manage the Event Rules 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure, then click Event Rules. The list of configured Event 

Rules appears in the Event Rules node: 

 

 
 

and in the right pane:  

 

 

3. Click the Event Rule you want to change, then click a control (Edit, Delete, Clone). The right pane updates 

to display the details specific to that Event Rule. 

  

 

The red question mark icon indicates the event trigger; the blue question mark indicates a Condition, the 
green question mark is an Else Condition.  

To edit an Event Rule  

1. To add a Condition to a Rule, click a Condition from the Conditions list then click Add condition. The 

Condition appears in the Rule pane below the current highlighted insertion point. You can add multiple 

Conditions to a single line and create AND/OR criteria. 

2. To add an Action to a selected Condition, click it in the Actions list, then click Add action. The Action 

appears in the Rule pane below the highlighted Condition. 
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3. Configure the Condition or Action by clicking the underlined variables (red or blue underlined text) 

4. You can reorder Conditions and actions by dragging them where you want them, and using the up  and 

down  arrows. 

5. Click Apply to save the changes on the Server. 

To delete an Event Rule  

1. In the right pane, click Delete. A confirmation message appears. 

2. Click Yes. The rule is deleted from the Site. 

To clone an Event Rule 

1. In the right pane, click Clone. A clone of the Rule opens in the Event Rule editing pane and is added to the 

Rules list. 

2. Edit the copy of the Rule as needed, then click Apply to save the changes on the Server. Your new Rule 

appears in the Event Rules node with "Copy" appended to the name. 

3. To rename the Rule, in the left pane, right-click the Rule, then click Rename. 

To change the priority of a Rule  

1. In the right pane, click the Rule you want to move.  

2. Under Rule Priority, click Higher and Lower. 

Refer to Event Rule Order of Execution for more details of changing the priority of a Rule. 

To disable an Event Rule 

1. In the right pane, clear the Enable this rule check box. 

2. Click Apply to save the changes on the Server. 

To re-enable an Event Rule 

1. In the right pane, click the Enable this rule check box. 

2. Click Apply to save the changes on the Server. 

EVENT RULE EXAMPLES 

Below are examples of some common uses of Event Rules. 

SCHEDULER (TIMER) EVENT  

(Available in EFT Server Enterprise) The Scheduler (Timer) Event allows you to execute a specified Action (e.g. 

send an e-mail or a report) only one time or to recur at specified intervals. For example, you could schedule the 

Clean Up Action to occur on July 8 at midnight, or every Monday morning, or on the last Friday of every month at 2 

a.m.  

The PCI DSS requires that you should develop a data retention and disposal policy. With the Clean-up Action, you 

can configure the Server to clean up a specified folder at regularly scheduled intervals. If PCI mode was selected 

during Site setup, the Data Retention and Disposal dialog box appears in which you can create a Scheduler Timer 

Event with the Clean-up Action to delete files matching the expressions you specify. You can also choose to define 

it in the Administrator on existing Sites.  
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A recurring Timer does not stop recurring if the Rule Actions fail; it will recur as scheduled until you disable or 

delete the Rule. For example, suppose you want to download a file from a remote server, delete the file from the 

remote location after transfer, then send yourself an e-mail. If the file that you want to download is not yet in the 

remote directory, the Rule will fail for that particular instance of the Timer running, but it will run again at the next 

scheduled time (e.g., every four hours). In the case of Timer Rules, "Stop processing this rule" means "do not 

execute any further Actions with this Rule" (such as sending an e-mail), but it does NOT mean that the Timer will 

stop. For example, if you have defined the Rule to run every hour, the Timer Rule will fail when the file is not in the 

remote location, but the Timer Rule will run again the next hour, and the next hour, and so on, until you tell it to 

stop (by manually disabling it). 

 

You can use the Event Rule to execute a script that accesses a remote server, downloads a file, deletes the 
source file, and then disables the Rule (through COM), but the purpose of Event Rules is to not require a 
script. 

To define a Timer Rule to download a remote file 

1. Follow the procedure in Creating Event Rules. 

2. In the Create New Rule dialog box, click Scheduler (Timer) Event, then click OK. The new Rule appears in 

the Rule pane.  

3. The Rule is defined by default to trigger each hour starting on the date that you create the Rule. To 

change the start date, start time, recurrence pattern, and/or interval, in the Rule pane, click repeat each 

01:00:00. The Timer Event dialog box appears.  

 

 

4. Specify the start time, start date, and recurrence pattern (frequency). The following recurrence options 

are available: 

 Hourly - The timer is activated every <n> hours: <n> minutes: <n> seconds. 

 Daily - The timer is activated every <n> days, or every weekday. 

 Weekly - The timer recurs every <n> weeks on the weekday (Sunday - Saturday) that you specify. 

 Monthly - The timer recurs on day <n> of every <n> month(s) or the first, second, third, fourth, 

or last weekday (Sunday - Saturday) that you specify of every <n> month.  

 Yearly - The timer recurs every <month> <day> (e.g., September 30) or the first, second, third, 

fourth, or last weekday (Sunday - Saturday) that you specify of a specific month. 

 Once - The timer is activated only once on the Start date and Start time that you specify. 
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5. Click OK. The changes appear in the Rule pane. 

6. Specify the Action to occur when this Event is triggered. 

7. Click Run Now to test your Rule.  

 

When you create a Timer rule, the Run Now button appears at the bottom of the Rule pane. When 
you click Run Now, the Server executes any actions associated with the Event, and any Rule 
construction errors are identified. You cannot perform any other operations in the Administrator 
while the Server tests the Rule. Multiple synchronous Actions defined in the Rule, such as move, 
copy, or download, take longer to test than asynchronous operations such as e-mail notifications.  

8. If there are no errors, a confirmation message appears asking you to verify the expected outcome. Click 

Continue to execute the Rule or Cancel to refine the Rule. 

9. Click Apply to save the changes on the Server. 

MONITORING FOLDERS 

(Available in EFT Server Enterprise) Use a Folder Monitor rule to trigger when files are added to a folder using the 

network file system. When monitoring folders for files added to the server via the FTP/S and HTTP/S protocols, use 

File Uploaded, File Downloaded, and other File System events.   

 

When monitoring a folder, the Server watches for any file being added to, removed from, or renamed in the 
monitored folder. Moving a file, performing PGP operations, and other actions can trigger the Rule again, 
resulting in failures. This can be avoided by selecting the Stop processing this rule check box after if action 
failed then. 

To configure a Folder Monitor rule 

1. Follow the procedures in Creating Event Rules. 

2. In the Create New Rule dialog box, click Folder Monitor, then click OK. The new Rule appears in the Rule 

Builder. 

 

3. In the Rule pane, click [select]. The Monitor Folder dialog box appears. 

 

 

4. Click the open icon  to specify a folder to monitor. 

5. If you also want to monitor sub folders, select the Include sub-folders check box. 
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6. To monitor the status of the network connection and report failures, select the Check health of network 

share every <n> minutes check box, and specify an interval. An hour (60 minutes) is specified by default. 

When you select the check box, the following message appears: 

 

 

When the check box is selected, the Server periodically pings the folder specified to verify that it can 

communicate with the folder. When there is a loss of connection, the Server attempts to re-establish a 

link to the folder and triggers the Folder Monitor Failed event internally. If you want to receive e-mail 

failure notifications (or other Actions) when the Folder Monitor health check returns a connection failure, 

create an additional Event Rule using the Folder Monitor Failure Event, and add the Send notification e-

mail Action to it. 

7. Click OK.  

8. Specify an Action to occur when this Event is triggered: 

 To add an e-mail notification, refer to E-mail Notification Action. 

 To copy or move a file added to the monitored folder to another location, refer to Copy/Move 

File to Host Action.  

9. Click Apply to save the changes on the Server. 

USING AN EVENT RULE TO EXECUTE A COMMAND (RUN A PROCESS) 

You can configure the Server to run executables, batch files, and scripts automatically when specific events occur. 

The Server calls these Commands. When the Event Rule is triggered, the Server executes the specified custom 

command and attributes. 

To execute a Command from the Server’s Event Rule system 

1. Create a custom Command using the procedure in Creating a Command. 

2. Create a new Event Rule using the procedure in Creating Event Rules. 

3. (Optional) If you need to apply any conditional behavior, click it in the Conditions list. 

4. In the Actions list, double-click Execute command in folder. The Action is added to the Event in the Rule 

pane. 
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5. In the Rule pane, click one of the blue underlined text links. The Custom Command dialog box appears. 

 

 

 

Links in the Rule pane indicate parameters that have not yet been defined. They must be defined to 
save the Rule. 

6. In the Choose an existing or create a new one list, click the list to select the command. (If you did not 

create the Command in step 1, click New to create the Command now.) 

7. In Working directory box, type the path or click the open icon  to specify the folder in which the script 

or executable resides e.g., C:\EFTscripts; for mapped drives, use their UNC path.) 

8. (Optional) In the Parameters box, include any parameters for the command. For example, type the script 

name (argument 0) if running a script.  

 

You can also select the items in the Context variables list to add them as parameters. For example, 

suppose you want to run a script on a file that was uploaded and triggered the Event Rule. You would type 

the script name and the tag %FS.FILE.NAME%, as shown below:  

dosomethingwithfile.vbs -file %FS.FILE_NAME% 

 

Refer to Variables for details of available variables and how to use them. 

9. Click OK to save the Command. 

10. Add other Actions as needed, then click Apply to save the Event Rule. 
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CREATING WORKFLOWS FOR USE IN EVENT RULES 

(Requires the Advanced Workflow Engine module.) The procedure below provides general directions for creating 

an Advanced Workflow Action. For details of creating Advanced Workflows with the Advanced Workflow Engine, 

refer to the Advanced Workflow Engine User Guide, available as a PDF and online Help. 

Similar to Commands, Workflows are used in Event Rules as Actions or triggers. When you create a Workflow, the 

Advanced Workflow Engine creates a file with an extension of .aml and saves it in EFT Server's AWE folder (by 

default, C:\Program Files\GlobalSCAPE\EFT Server Enterprise\AWE). The filename is the name of the workflow, 

prepended with an underscore and the name of the Site. For example, if you create a Workflow called FTP on a 

Site called Boston, the Workflow's filename is Boston_FTP.aml.  

 

When a new Workflow is created, a message appears (prior to the Create a Workflow dialog box) informing 
you that the Advanced Workflow module is an optional module and that the 30-day trial begins when the first 
Workflow is created. 

To create a Workflow 

1. In EFT Administrator, connect to EFT Server and click the Server tab. 

2. In the left pane, click the Advanced Workflow node.  

3. In the right pane, the Advanced Workflow dialog box appears. 

 

4. In the right pane, click New. The Create a Workflow dialog box appears. 

 

5. In the What do you want to call this workflow box, specify a name for the Workflow. When you add the 
workflow to Event Rules, the name you specify here appears in the Rule. 

http://help.globalscape.com/help/guides/index.html
http://help.globalscape.com/help/eft6/mergedProjects/awe/index.htm#TOC_Advanced_Workflow.htm
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6. (Optional) Provide a description of the Workflow, then click OK. The Workflow Designer appears. 

 

7. The tree in the left pane lists the steps that you can add to the Workflow. The right pane displays the 
steps in the Workflow.  

8. Drag items from the Available Actions list to the Steps pane to create your Workflow.  

9. Use the Run icon on the Debug toolbar to test the steps. You can run it all at once, run only a selected 
step, or the whole Workflow starting with a step other than the first step. 

 

The Output pane displays the result of each step. For example: 

Executing line 5 

Starting Input Box with message "What is your name?"...  

Creating message box "What is your name?"... > 

Populating variable "theUserName"...  

Finished Input Box "What is your name?".  

The step was okay.  

10. After you have created your Workflow, click Update and Close. The Workflow appears in the Advanced 
Workflow node of the Site tree and is ready to be used in Event Rules. Refer to Execute Advanced 
Workflow Action for more information. 
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11. (Optional) In the Advanced Options area, select the Terminate the process check box and specify the 
number of seconds after which to terminate the Workflow if it fails to execute. 

12. (Optional) Specify the level of debug logging in the Debug log level box, None, Minimal, Normal, or 
Verbose (None is the default).  

 When you are logged in to the Server computer, you can click View log folder to view the logs 
created by this Workflow. 

 Your Workflow is now ready to insert into an Event Rule.  

 
 

FILE UPLOADED EVENT WITH USER DETAILS 

Suppose you want to be sent an e-mail each time any user uploads a file to the server, and you want to include 

information about the user account that uploaded the file.  

To define the Event Rule 

1. Create a File Uploaded Event Rule.  

2. Add an E-mail Notification Action.  

3. In the Message of the e-mail, add the desired user variables, such as %USER.LOGIN%, %USER.EMAIL%, 

and %USER.PHONE%. For example: 

 

4. Click Apply. 



EFT Server™ version 6 

464  

With this very simple Rule, an e-mail is sent whenever any user uploads a file to the Server. You can further 

customize the Rule to suit your needs: 

 If you only want to know when a specific user uploads a file, add the Condition "If Login name is" and 

select the username. 

 If you only want to know when someone in a specific Group uploads a file, add the Condition "If User is a 

member of" and select the Group. 

DEFINING THE E-MAIL WITH USER DETAILS 

The default e-mail body contains a table. If you can edit HTML and if the account that the e-mail is sent to accepts 

HTML e-mails, you can format the e-mail to suit your needs. Review your tags carefully, however, since no HTML 

code verification is performed by the Server. 

Using the example above, when a user with the username jbug uploads a file, the following e-mail might be 

sent: 

This message was sent to you automatically by EFT Server on the following event: File Uploaded. 

 

Server Local Time: 12/5/2007 14:00:00 

E-mail Address: jbug@mycompany.com 

Account Expiration Date: 12/1/2008 11:59:59 

File Name: file.txt 

Folder: C:\InetPub\EFTRoot\Standard\Usr\jbug 

 

USING A COMMAND IN AN EVENT RULE TO COPY FILES 

If you want to copy the Server's files to another location based on the date (e.g., all log files created on a specified 

date), you can create a custom Command that points to the Windows XCopy command. The executable is (by 

default) in c:\windows\system32\xcopy.exe. Numerous switches are available for this command. (You can see all 

of the options by typing xcopy /? at a command prompt.) You must type the source path and the destination 

path.  

You can add a switch, /d:mm-dd-yy, to copy files that were changed on or after a specified date. If no date is 

provided (just the /d with no date), it copies all source files that are newer than existing destination files. That is, 

it will not copy a file with the same name/same date or same name/older date. 

To define an Event Rule to copy files, assuming that the Server has permissions to access the files, you can create a 

Folder Monitor Rule and specify that if the Condition "If File Change does equal to added" exists, then execute the 

Command to xcopy the newer files to the destination location.  

To define an Event Rule to copy log files 

1. Create a custom command to execute the Windows XCopy command. The executable is (by default) in 

c:\windows\system32\xcopy.exe. 

2. Create a Folder Monitor or File Uploaded Event Rule.  

3. Add the Condition If File Change equal to operation, then click operation to change it to added. The 

Condition should now read If File Change does equal to added. 

4. Add the Execute command in folder Action to the Rule, then click select. The Command Configuration 

dialog box appears. 
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5. In the Choose an existing or create a new one box, click the XCopy Command that you defined in step 1. 

6. In the Working directory box, type the path or click the open icon  to specify the folder in which the 

script or custom command executable resides (C:\windows\system32\).  

7. In the Parameters box, type the source folder (the location of the log files), the destination folder (the 

location to which to copy the files), and any other xcopy parameters you need. For example, type: 
 

"C:\Program Files\GlobalSCAPE\EFT\Logs\*.log" "C:\Temp\" /d  

 

The parameters tell the xcopy command to copy all .log files in the EFT\Logs directory to C:\Temp. The 

parameter /d (with no date) copies all source files that are newer than destination files.   

8. Click OK to close the Command Configuration dialog box, then click Apply to save the Rule on the Server. 

The Rule is now defined to copy log files from the monitored folder (C:\Program Files\GlobalSCAPE\EFT\Logs) to 

the new location. (Note that they are copied, not moved.) 

 

You could also add an E-mail Notification Action to let you know when the Command is executed. 

 

Always use caution when giving program access to your system32 directory (especially an FTP server).  

COPYING OR MOVING A FILE TRIGGERED ON MONITOR FOLDER EVENT AND RENAMED 

You can configure an Event Rule triggered by a Folder Monitor event to copy or move files in the folder and save 

them with a different name. Refer to Copy/Move File to Host Action for details of defining an Event Rule using the 

Copy/Move file to host Action.  

IMPORTANT: If you want to move a modified (renamed) file, use the DST-based variables (e.g., 

%FS.DST_FILE_NAME%) because they contain the modified values. 
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For example, when you configure an Event Rule to copy/move a file that is triggered on a Monitor Folder event 

with a Condition of If file change does equal to rename, use the following variables: 

 %FS.DST_PATH% instead of %FS.PATH% 

 %FS.DST_FILE_NAME% instead of %FS.FILE_NAME%.  

If the file is renamed, the new name context is lost to FS.PATH and FS.FILE_NAME, which retain the old 

path/name, but the new path/name is passed to %FS.DST_PATH% and %FS.DST_FILE_NAME%.  

For example, suppose the monitored folder contained a file called Robert.txt and you rename the 

file Bob.txt. 

%FS.DST_FILE_NAME% contains the new value Bob.txt, but %FS.FILE_NAME% contains the old value 

Robert.txt.  

For details of the Copy/Move Action, refer to Copy or Move File to Host Action. 
 

PROXY SETTINGS 

You can connect to the Server through a proxy. DMZ Gateway can also be configured as an outbound proxy. There 

are several places in the Administrator in which you can configure proxy settings. Each of the configurations use 

the Proxy Settings dialog box. 

 

ROUTING OUTBOUND TRAFFIC THROUGH A PROXY 

Outbound connections that originate from the Server will route through normal network mechanisms to reach the 

destination; however, it is possible to configure the Server's Event Rules using the Copy/Move file to host Action 

to use a remote proxy.  

To configure an Event Rule to route outbound traffic through a proxy 

1. Create an Event Rule, such as a Scheduler (Timer) Event. 

2. Add the Copy/Move File to Host Action, and follow the procedures in Copy/Move File to Host Action to 

complete the Rule. 

For the procedure for using a SOCKS proxy server, refer to Using a SOCKS Proxy Server. 
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USING A SOCKS PROXY SERVER 

When you create an Event Rule that uses a Copy/Move File to Host Action, you can specify a SOCKS proxy server 

for the connection to the remote server. 

 

If you enable the use of DMZ Gateway as the proxy in the Proxy Settings dialog box, SOCKS options are 
disabled. The Server does not support the use of DMZ Gateway as a proxy and SOCKS settings in combination; 
however, the combination of FTP or HTTP proxy and SOCKS is allowed. 

To use a SOCKS proxy server 

1. Create an Event Rule with a Copy/Move File to Host Action. 

2. In the Event Rule Action, click %FS.PATH%. The Offload Action wizard appears. 

 

3. Click Socks. The SOCKS Settings dialog box appears.  
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4. Select the Use SOCKS settings check box to enable the Socks Type options. 

 

5. In the Socks Type area, specify a SOCKS server type of either SOCKS4 or SOCKS5.  

 When SOCKS4 is specified, Use authentication is disabled.  

 When SOCKS 5 is specified, Use authentication can be enabled, allowing you to provide a 

username and password for the SOCKS connection. If you selected SOCKS5 and the Use 

authentication check box, specify the Username and Password required to connect to the SOCKS 

server. 

6. Click OK to save the SOCKS options.  

7. Continue with the wizard to complete the File Offload Configuration. 
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TOO MANY CONNECTIONS PER SITE 

You can define an Event Rule to send you an e-mail when a user login fails because there are too many 

connections to a Site. If the Rule is triggered frequently, you might want to change the maximum concurrent 

socket connections setting for the Site and/or purchase more licenses for the Web Transfer Client. 

To define the Event Rule 

1. Define an Event Rule  using the User Login Failed event trigger. The event trigger appears in the Rule 

Builder. 

2. In the Conditions list, double-click if Event Reason (or click it, then click Add condition) to add it to the 

Rule. 

3. In the Rule Builder, click the linked text [specific reason]. The Event Reason dialog box appears. 

 

 

 

4. Click the Specify the event reason drop-down menu to specify a reason that will trigger the Event Rule: 

 Account Disabled 

 Invalid password 

 Protocol not supported 

 Restricted IP 

 Too many connections per IP 

 Too many connections per Site 

 Too many connections per user 

For this example, click Too many connections per Site. 

5. Click OK.  

6. In the Actions list, double-click Send notification email (or click it, then click Add action) to add it to the 

Rule. 

7. In the Rule pane, click the hyperlinked text [select] and configure an e-mail to send yourself a notification 

(or link to your defined e-mail template) then click OK.  

 

8. Click Apply to save the changes on the Server. 
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EVENT RULE CONDITIONS 

The topics below provide information regarding defining and using Event Rule Conditions. 

USING CONDITIONS 

Conditions allow you to more narrowly define the trigger for an Event Rule. Conditions are optional; you do not 

have to define a condition on an Event Rule to make it trigger an Action, but Conditions allow fine control over 

when an Action can take place. 

You can further fine-tune each event trigger to execute only if certain conditions are met. These optional 

conditions act like filters or compound IF statements so that IF a specific event occurs and IF a condition is met, 

then an action is executed. For example, an event trigger that is called whenever a file is uploaded can be fine-

tuned to trigger only if that file’s extension is .txt and nothing else.  

Refer to the List of Conditions for the Conditions supported by the Server. Conditions that require you to specify a 

value or parameter have further instructions with their description in the List of Conditions. 

 

Conditions are NOT REQUIRED for an Event Rule to work. In its base form, the event trigger itself is a sort of 
condition, therefore you can execute actions when/if an event triggers, without adding any additional 
conditions.  

 

CONDITION PLACEMENT 

Where Conditions are placed within the Rule pane when they are added depends on which item is selected in the 

Rule pane.  

 When the Event Rule Trigger (the very first item in the Rule pane) is selected and a Condition is added, 

the Condition is placed directly beneath the Event Rule Trigger. This is considered a "root" level condition. 

ON FILE UPLOAD  

{  

    if ( %FS.FILE_NAME% = "*.pgp" )  //a root level condition. No action 

added yet  

    {  

    }  

}  

 When an Action inside another Condition is the selected item and a new Condition is added, that new 

Condition is placed directly beneath the Action and to the left, or outside of the container Condition. 

Otherwise, it would become a nested Condition, which the Server does not support. 

ON FILE UPLOAD  

{  

    if ( %FS.FILE_NAME% = "*.pgp" )  

    {  

       PGP Decrypt %FS.FILE_PATH%  

    }  

if ( %FS.FILE_NAME% = "" ) //new condition added placed at root level  

{  

}  

}  
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 When an Action (that is not contained within a Condition) is the selected item, and a new Condition is 

added, the new Condition is placed immediately beneath that Action, at the same root level (see above 

example). 

 When a Condition is the currently selected item and another Condition is added, the new Condition is 

ANDed to the selected Condition. If the Condition being added is the same Condition as the one selected, 

the new Condition is ORed to the selected condition. Using this method, you can create compound 

Conditions. 

ON FILE UPLOAD  

{  

    if (%FS.FILE_NAME% = "*.pgp" ) AND (%FS.FILE_SIZE% <300,000b)  //a 

compound condition  

    {  

       PGP Decrypt %FS.FILE_PATH%  

    }  

} 
 

CHANGING CONDITION PLACEMENT 

Conditions can be moved using the up/down arrows next to the Condition or at the bottom of the dialog box, or by 

using copy/paste. When a Condition is moved, the Condition and any actions inside of that Condition also move. If 

a Condition has an else statement under it, the else statement is also moved. This is because the Condition, any 

actions inside that Condition, and any attached else clauses are considered a conditional block, and the entire 

block is moved.  

Example: 

Condition A  

Action 1  

Action 2 

Condition B  

Action 3 

Click the Condition A down arrow ONCE, and Condition A and its child Actions are moved as a block: 

Condition B  

Action 3 

Condition A  

Action 1  

Action 2 

This same behavior does not apply when the Condition being moved is part of a compound Condition. To move 

one of the Conditions inside of a compound Condition down (or up), and, therefore, outside of that conditional 

block, you need to click on one of the Condition’s up/down arrows:  

Condition C1 and C2  

Action 1 

Action 2 

Condition C3  

Action 3 

Now click on the down arrow to the right of C1: 

Condition C2  

Action 1  

Action 2 
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Condition C1  

Condition C3  

Action 3 

To move a compound Condition, you need to select the ENTIRE Condition by clicking the icon at the far left of the 

Condition: 

Condition C1 and C2  

Action 1  

Action 2 

Condition C3  

Action 3 

Click the icon then either drag the cursor down or click the blue down arrow  at the bottom of the dialog box 

(not the down arrow to the right of the condition). A page icon appears if you drag it to an applicable location.  

Condition C3  

Action 3 

Condition C1 and C2  

Action 1  

Action 2 

CONDITION EVALUATION 

Regardless of placement, ALL Conditions are evaluated, because all Conditions exist at the root level.  

For example:  

ON FILE UPLOAD 

{  

    if (%FS.FILE_NAME% = "*.pgp")  //if filename extension is PGP then decrypt it  

    {  

       PGP Decrypt %FS.FILE_PATH%  

    }  

    if (%FS.FILE_NAME% = "*.zip") //even if the prior condition was true, still 

evaluate this condition.  

    {  

        UNZIP %FS.FILE_PATH% to "%FS.FILE_PATH%\%EVENT.DATE%_%EVENT.TIME%\"  

    } 

} 

ADDING A CONDITION TO AN EVENT RULE 

When you create an Event Rule, you can apply one or more Conditions (e.g., file uploaded) to trigger an Action 

(e.g., send an e-mail). Conditions are optional; you do not have to add a Condition to an Event Rule to make it 

trigger an Action, but they allow fine control over when an Action can take place. 

To add a Condition to a Rule 

1. Create the rule. In the Conditions list, the Conditions available for the selected Event appear. When 

applicable to the rule, the Else option also appears. 
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2. Do one of the following: 

 Double-click a Condition in the list  

 Click the Condition, then click Add Condition. 

3. Complete the rule by adding one or more Actions, then click Apply to save the Rule. 

ELSE CLAUSES 

(Available in EFT Server Enterprise) The Else clause or statement is a type of Condition and appears in the 

Conditions list box when at least one Condition has been added to the Rule pane. The Else clause executes if the 

Condition preceding the Else statement is not met.  

This is your typical Else statement as part of an IF/THEN/ELSE block:  

If A Then  

{ Run B }  

Else > 

{ Run C }  

An else statement must always follow a Condition. Else statements cannot be moved around independently. If you 

want to move the else statement, you need to move the entire conditional block or delete the else statement and 

re-create it elsewhere. 

LOGICAL OPERATORS 

When a Condition is added to another compound conditional statement, the newly added Condition will be ANDed 

to the Condition already present:  

Example:  

If Filename = bob.txt  

Now add another Condition: 

If Filename = bob.txt and If Filesize < 100 MB  

When the second Condition being added is the SAME Condition type as the previous one, the newly added 

Condition will be ORed to the previous Condition. 

If Filesize < 200 MB  

Now add another same Condition:  

If Filesize < 200 MB or If Filesize > 500 MB  

If there are more than two Conditions already existing in a compound Conditional line, and another Condition is 

added (regardless of Condition type), the new Condition will use the same logical operators that are already 

present for that compound statement.  

If Filesize < 200 MB or If Filesize > 500 MB  



EFT Server™ version 6 

474  

Now add another same Condition:  

If Filesize < 200 MB or If Filesize < 400 MB or If FileName = rob.txt  

You can change the AND and OR operator values by clicking the and or the or hyperlink. Please note that logical 

operators separating conditional statements must be the SAME across the entire compound statement. You 

cannot mix and match AND and OR statements. When changing the logical operator for a compound conditional 

statement, ALL subsequent logical operators for that statement also change to match that operator. This is 

necessary to prevent problems with evaluation precedence, especially in conditional blocks with more than 2 

conditional expressions to evaluate. There are ways around this limitation, discussed in Evaluating Expressions.  

Example:  

If Filename = bob.txt 

Now add another Condition:  

If Filename = Bob.txt and If Filesize < 100 MB  

Now add another Condition:  

If Filename = Bob.txt and If Filesize <100 MB and If group is one of Admins  

Now click one of the AND hyperlinks to change it to OR. Resulting line:  

If Filename = Bob.txt OR If Filesize <100 MB OR If group is one of  Admins  

Example:  

If Filesize is < 200 MB  

Now add another condition:  

If Filesize < 200 MB or If Filesize > 500 MB  

Now click the OR hyperlinks to change it to AND. Resulting line:  

If Filesize < 200 MB and If Filesize > 500 MB  

Note that in the second example, the statement will never evaluate to true. It is your responsibility to change the 

comparison types (from > to something else) or the comparison values, or switch back to using the OR logical 

operator to avoid creating expressions that can never evaluate to true. 

EVALUATING EXPRESSIONS IN EVENT RULES 

EFT Server will always evaluate expressions from left to right, regardless of how many conditional checks there are 

within that same expression; however, there is one exception, described below.  

Certain Conditions are able to test multiple values, such as the If User is Member of condition or the If Filename is 

one of condition. These Conditions are evaluated first and independently, with the resulting atomic unit evaluated 

as part of the complete expression.   

For example, the If User is Member of Condition allows you to select from a list of Server Groups, therefore, the If 

User is member of expression is evaluated first, after which the rest of the expression is evaluated from left to 

right.  

 

THE COMPOUND CONDITIONAL STATEMENT 

If Filename = Bob.txt AND If User is Member of Admins, Users, Power Users  

If this expression were evaluated from left to right, the results would not match our expectations:  

If (((F and MA) or U) or PU)  
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Instead, the Server evaluates the conditional statement first as its own atomic unit and then evaluates the 

resulting expression from left to right:  

If (F and (MA or U or PU)) 

This allows you to create expressions that contain order-of-precedence grouping without having to use 

parenthesis. The evaluative OR statement is hidden inside the conditional statement, as long as that conditional 

statement can evaluate against multiple criteria.  

Only the following conditions can evaluate against multiple criteria (strings): 

 If User is Member of  

 If Login name  

 If Virtual Path 

 If Physical Path 

 If Physical Folder Name 

 If Physical Destination Path 

 If Physical Destination Folder Name 

 If Destination File Name 

 If Virtual Destination Path 

 If Filename 

To define multiple criteria for a Condition  

1. Double-click a Condition in the list to add it to the Rule Builder. (To learn more about available Conditions, 

refer to Conditions.) 

2. If you are adding an additional Condition, highlight the existing Condition in the Rule Builder, then in the 

Conditions list, double-click the Condition you want to add. The Condition appends to the existing one 

and adds a logical operand (AND/OR).  

 

 

3. Click the logical operand to change it.  

If you insert multiple Conditions, all of the logical operands must be the same for that line of Conditions. 

That is, you can have Condition 1 AND Condition 2 OR Condition 3. 

 

If you need to use more complex criteria using AND and OR, you can use wildcard logic to create any logic 
that wildcards support. For example, if you add the File Name condition to the Rule pane, you can then define 
the path mask using complex logic with wildcards. 

LIST OF CONDITIONS 

Conditions allow you narrow the trigger definition for an Event Rule. Conditions are optional; you do not have to 

define a Condition on an Event Rule to make it trigger an Action, but they do allow more control over when an 

Action can take place. 

Conditions are organized by type: 

 Connection Conditions - Event is triggered based on connection information such as remote IP or if user 

connected via the Web Transfer Client 

 Site Conditions - Event is triggered based on whether the Site is started or stopped. 

 File System Conditions - Event is triggered based on criteria such as file size or virtual path. 

 Server Conditions - Event is triggered based on criteria such as whether the Server is running or log name. 
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 User Conditions - Event is triggered based on criteria such as whether the user account has a particular 

protocol enabled or login name. 

 AS2-related Conditions - Event is triggered based on criteria such as protocol or AS2 ID. 

 Event Properties - Event is triggered based on a specific event reason. 

CONNECTION CONDITIONS 

 

You can apply these Conditions to Connection events, User events, and File system events. 

 if Remote IP - a connection is made from a remote IP address that matches/does not match an IP address 

or IP mask. Add the Condition to the Rule, then click the linked text. In the Edit Value dialog box, type a 

string and/or wildcards, then click OK to add the Condition to the event trigger. 

 if Local IP - a connection is made to a local IP address that matches/does not match an IP address or IP 

mask. Add the Condition to the Rule, then click the linked text. In the Edit Value dialog box, type a string 

and/or wildcards, then click OK to add the Condition to the event trigger. 

 if Local Port - a connection is made/not made on a port/range of ports. Add the Condition to the Rule, 

then click the linked text. In the Edit Value dialog box, type a string and/or wildcards, then click OK to add 

the Condition to the event trigger. 

 if Protocol - an FTP/SSL/SFTP/HTTP/HTTPS connection has been made, is being used, or is not being used. 

Add the Condition to the Rule, then click the linked text. The Select Connection Protocol dialog box 

appears. Click the drop-down list to select a protocol, then click OK to add the Condition to the event 

trigger. 

 if Using Web Transfer Client - the user connected/did not connect via the Web Transfer Client. Add the 

Condition to the Rule, then click the linked text to specify yes or no, then click OK to add the Condition to 

the event trigger. 

SITE CONDITIONS 

You can apply these Conditions only to Site events. 

 if Site running - The Site is started or stopped. Add the Condition to the Rule, then click the linked text to 

specify yes or no, then click OK to add the Condition to the event trigger. 
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FILE SYSTEM CONDITIONS 

 

You can apply these Conditions only to File system events and the Folder Monitor event. 

 if File Change - a file is/is not added, removed, or renamed. Add the Condition to the Rule, then click the 

linked text to specify added, removed, or rename, then click OK to add the Condition to the event trigger. 

 if Physical Path - the file or folder exists/does not exist at a physical location (the full folder path including 

the file name or wildcard). Add the Condition to the Rule, then click the linked text. The Choose Physical 

Path dialog box appears. Type or select a path, then click Add. To remove a path, in the right pane, click 

the path, then click Remove. Click OK to add the Condition to the event trigger. 

 if Physical Destination Path - the file or folder exists/does not exist at a physical location and/or wildcard. 

 if Virtual Path - the file or folder exists/does not exist at a virtual location and/or wildcard. Add the 

Condition to the Rule, then click the linked text. The Choose Virtual Path dialog box appears. Type or 

select a path, then click Add. To remove a path, in the right pane, click the path, then click Remove. Click 

OK to add the Condition to the event trigger. 

 if Virtual Destination Path - the file or folder exists/does not exist at a virtual location (the full folder path 

including the file name and/or wildcard). Add the Condition to the Rule, then click the linked text. The 

Choose Virtual Path dialog box appears. Type or select a path, then click Add. To remove a path, in the 

right pane, click the path, then click Remove. Click OK to add the Condition to the event trigger. 

 if Physical Folder Name - the file or folder exists/does not exist in a physical folder (the folder path or 

wildcard without a file name). Add the Condition to the Rule, then click the linked text. The Choose Folder 

Name dialog box appears. Type or select a name, then click Add. To remove a name, in the right pane, 

click the name, then click Remove. Click OK to add the Condition to the event trigger. 

 if Physical Destination Folder Name - the physical folder name matches/does not match a physical folder 

name and/or wildcard. Add the Condition to the Rule, then click the linked text. The Choose Folder Name 

dialog box appears. Type or select a name, then click Add. To remove a name, in the right pane, click the 

name, then click Remove. Click OK to add the Condition to the event trigger. 

 if File Name - the file name matches/does not match a string of characters and/or wildcard. Add the 

Condition to the Rule, then click the linked text. The Choose File Name dialog box appears. Type or select 

a name, then click Add. To remove a name, in the right pane, click the name, then click Remove. Click OK 

to add the Condition to the event trigger. 

 if Destination File Name - the destination file name matches/does not match a string of characters and/or 

wildcard. Add the Condition to the Rule, then click the linked text. The Choose File Name dialog box 

appears. Type or select a name, then click Add. To remove a name, in the right pane, click the name, then 

click Remove. Click OK to add the Condition to the event trigger. 
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 if File Size - the file size is/is not less than/equal to/greater than a specified number of bytes. Add the 

Condition to the Rule, then click the linked text. In the Edit Value dialog box, type a string and/or 

wildcards, then click OK to add the Condition to the event trigger. 

SERVER CONDITIONS 

 

You can apply these conditions only to Server events. 

 if Server Running - the Server service is currently running. Add the Condition to the Rule, then click the 

linked text to specify yes or no to add the Condition to the event trigger. 

 if Log Type - The log type is a specific type. In the Select Log Type dialog box, click the drop-down list to 

specify the type of log (W3C Extended Log File Format, Microsoft IIS Log File Format, NCSA Common Log 

File Format, or No Logging), then click OK to add the Condition to the event trigger. 

 if Log Location - The log location matches a specific path. Add the Condition to the Rule, then click the 

linked text. In the Edit Value dialog box, type a string and/or wildcards, then click OK to add the Condition 

to the event trigger. 

 if Node Name - The Server name matches/does not match a specific character string. Add the Condition 

to the Rule, then click the linked text. In the Edit Value dialog box, type a string and/or wildcards, then 

click OK to add the Condition to the event trigger. 

 if Old Log File Path - The old log file path matches a specific path. Add the Condition to the Rule, then click 

the linked text. In the Edit Value dialog box, type a string and/or wildcards, then click OK to add the 

Condition to the event trigger. 

 if New Log File Path - The new log file path matches a specific path. Add the Condition to the Rule, then 

click the linked text. In the Edit Value dialog box, type a string and/or wildcards, then click OK to add the 

Condition to the event trigger. 

 if Old Log File Name - The old log file name matches a specific name. Add the Condition to the Rule, then 

click the linked text. In the Edit Value dialog box, type a string and/or wildcards, then click OK to add the 

Condition to the event trigger. 

 if New Log File Name - The new log file name matches a specific name. Add the Condition to the Rule, 

then click the linked text. In the Edit Value dialog box, type a string and/or wildcards, then click OK to add 

the Condition to the event trigger. 
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USER CONDITIONS 

 

You can apply user conditions to User events and File system events. 

 if User - the user account belongs/does not belong to a specific Group or set of Groups. In the Condition, 

click the linked text. The Event Target Users and Groups dialog box appears. In the Specify target users 

and groups box, select the check box of the users/groups that will trigger the event, then click OK to add 

the Condition to the event trigger. 

 if Logon Name - the user's username matches/does not match a specific username. In the Condition, click 

the linked text. The Event Target Users and Groups dialog box appears. In the Specify target users and 

groups box, select the check box of the user account(s) that will trigger the event, then click OK to add the 

Condition to the event trigger. 

 if Logon Password - the user's password matches/does not match a specific word. In the Condition, click 

the linked text. The Choose Passwords dialog box appears. In the Specify comparison value box, specify 

all or part of the password that will trigger the event, then click Add. To remove values, click the value in 

the right pane, then click Remove. Click OK to add the Condition to the event trigger. 

 if Account Enabled - a user account is/is not enabled. Add the Condition to the Rule, then click the linked 

text to specify yes or no. 

 if Settings Template - the user belongs/does not belong to a Settings Template. In the Condition, click the 

linked text. The Select Settings Template dialog box appears. In the Select Settings Template list, specify 

the Settings Template that will trigger the event, then click OK to add the Condition to the event trigger. 

 if Full Name - a user's name matches/does not match/contains/does not contain a character string. Add 

the Condition to the Rule, then click the linked text. In the Edit Value dialog box, type a string and/or 

wildcards, then click OK to add the Condition to the event trigger. 
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 if Description - the user's description matches/does not match/contains/does not contain a character 

string. Add the Condition to the Rule, then click the linked text. In the Edit Value dialog box, type a string 

and/or wildcards, then click OK to add the Condition to the event trigger. 

 if Comment - the user's comment matches/does not match/contains/does not contain a character string. 

Add the Condition to the Rule, then click the linked text. In the Edit Value dialog box, type a string and/or 

wildcards, then click OK to add the Condition to the event trigger. 

 if EMail Address - the user's e-mail address matches/does not match/contains/does not contain a 

particular word. Add the Condition to the Rule, then click the linked text. In the Edit Value dialog box, 

type a string and/or wildcards, then click OK to add the Condition to the event trigger. 

 if Phone Number - the user's phone number matches/does not match/contains/does not contain a 

character string. Add the Condition to the Rule, then click the linked text. In the Edit Value dialog box, 

type a string and/or wildcards, then click OK to add the Condition to the event trigger. 

 if Pager Number - the user's pager number matches/does not match/contains/does not contain a 

character string. Add the Condition to the Rule, then click the linked text. In the Edit Value dialog box, 

type a string and/or wildcards, then click OK to add the Condition to the event trigger. 

 if Fax Number - the user's fax number matches/does not match/contains/does not contain a character 

string. Add the Condition to the Rule, then click the linked text. In the Edit Value dialog box, type a string 

and/or wildcards, then click OK to add the Condition to the event trigger. 

 if Home Folder - the location of a user's home folder matches/does not match a physical location. Add the 

Condition to the Rule, then click the linked text. In the Edit Value dialog box, type a string and/or 

wildcards, then click OK to add the Condition to the event trigger. 

 if Home Folder is root - the user's home folder is/is not their root directory. Add the Condition to the 

Rule, then click the linked text to specify yes or no to add the Condition to the event trigger. 

 if Quota Max - the user's account has a size limit less than/equal to/not less than/not equal to a size in 

Kilobytes. Add the Condition to the Rule, then click the linked text. In the Edit Value dialog box, type a 

string and/or wildcards, then click OK to add the Condition to the event trigger. 

 if Quota Used - the user's filled disk space is/is not less than/equal to/greater than an amount (in kb) of 

allowed disk space. Add the Condition to the Rule, then click the linked text. In the Edit Value dialog box, 

type a string and/or wildcards, then click OK to add the Condition to the event trigger. 

 if Invalid login attempts - the user's failed login attempts are/are not less than/equal to/greater than a 

number. Add the Condition to the Rule, then click the linked text. In the Edit Value dialog box, type a 

string and/or wildcards, then click OK to add the Condition to the event trigger. 

 if User can change password - the user has/does not have permission to change the login password. Add 

the Condition to the Rule, then click the linked text to specify yes or no to add the Condition to the event 

trigger. 

 if Home IP - the user's allowed IP address matches/does not match an IP address or set of IP addresses. 

Add the Condition to the Rule, then click the linked text. In the Edit Value dialog box, type a string and/or 

wildcards in the format *.*.*.*, then click OK to add the Condition to the event trigger. 

 if User can connect using SSL - the user has/does not have SSL enabled. Add the Condition to the Rule, 

then click the linked text to specify yes or no to add the Condition to the event trigger. 

 if User can connect using FTP - the user has/does not have FTP enabled. Add the Condition to the Rule, 

then click the linked text to specify yes or no to add the Condition to the event trigger. 
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 if User can connect using SFTP - the user has/does not have SFTP enabled. Add the Condition to the Rule, 

then click the linked text to specify yes or no to add the Condition to the event trigger. 

 If Account Locked Out - the user's account is/is not disabled. Add the Condition to the Rule, then click the 

linked text to specify yes or no to add the Condition to the event trigger. 

EVENT PROPERTIES 

You can apply Event Properties to the following event triggers: User Connect Failed, User Login Failed, User Logged 

Out, Download Failed, Upload Failed, Verified Upload Failed, Verified Download Failed. 

 if Event Reason - the event was triggered by one of the following reasons; available reasons depend on 

the event trigger. 

o A

o borted by user 

o Access denied 

o Account Disabled 

o Connection closed 

o File is banned 

o Invalid password 

o IP address was rejected 

o IP address was rejected and 

banned 

o Protocol not supported 

o Quota exceeded 

o Restricted IP 

o Too many connections per IP 

o Too many connections per Site 

o Too man

o y connections per user 

In the Condition, click the linked text. The Choose Event Reason dialog box appears. In the Event reason 

drop-down list, click a reason that will trigger the event, then click OK to add the Condition to the event 

trigger. 

EVENT RULE ACTIONS 

The topics below provide information regarding defining and using Event Rule Actions. 

Once an Event Rule is triggered, assuming all Conditions are met, the Server can launch one or more of the 

following user-definable Actions: 

 Execute command - The custom command in a specific location is triggered. 

 Execute Advanced Workflow - An Advanced Workflow is triggered. 

 Send notification e-mail - An e-mail message is sent to the address specified. 

 Copy/Move (push) File to Host Action - The designated file is automatically moved to another location. 

 Download (pull) File from Host Action - Downloads a specified file 

 OpenPGP encrypt/encrypt and sign/decrypt - The designated cryptographic action is performed on the 

file. 

 Cleanup in folder - Cleans up a specified folder 

 Generate Report Acton - A report is generated and e-mailed or saved to a file at a specific date and time. 
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 AS2 Send file to host - You can send files via AS2 to a partner that does not have inbound access defined 

in the Server’s account management system. For details of the AS2 Send file to host Action, refer to AS2-

Related Actions. 

 Backup Server Configuration Action - Automatically backs up Server configuration for use in disaster 

recovery or Server migration. 

 Stop processing more rules - No further rules are processed. 

For details of adding Actions to Rules, refer to the examples at the links above. 

WHICH ACTIONS ARE AVAILABLE WITH WHICH EVENT TRIGGERS? 

The tables below indicate which Actions are available with each type of event trigger. All event triggers can trigger 

the Execute Command Action, Execute Advanced Workflow Action (Enterprise only), and Send notification e-mail 

Action; however, other Actions are available only with applicable event triggers. For example, the User 

Disconnected event trigger has no reason to trigger the Cleanup Folder action. 

 

When the Server performs a copy/move Action, the folder from which the files are moved remains and is 
emptied, but not deleted.  
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Event 
Triggers 

Actions 

Execute 
command 
in folder  

Execute 
Advanced 
Workflow 

Send 
notification 

email  

Copy/move 
file to host  

OpenPGP 
Encrypt, 
Encrypt + 

Sign, 
Decrypt  

Cleanup 
folder  

Download 
file from 

host  

Generate 
Report 

AS2 
Send 
file to 
host  

Backup 

Server 

Config  

Stop 

processing 

more rules  

Scheduler 
(Timer*) 

X X X X X X X X X X X 

Folder Monitor  X X X X X   X X  X 

Folder Monitor 
Failed 

X X X   X     X 

File Uploaded X X X X X   X X  X 

File 
Downloaded 

X X X X     X   

Verified 
Upload 
Succeeded 

X X X X X   X X  X 

Verified 
Download 
Succeeded 

X X X X X   X X  X 

File Renamed X X X X X   X X  X 

File Moved  X X X X X   X X  X 

File Deleted  X X X X    X X  X 

Folder Created X X X X    X X  X 

Folder Deleted  X X X X    X X  X 

Folder 
Changed  

X X X X    X X  X 

Upload Failed  X X X X    X X  X 

Download 
Failed 

X X X X    X X  X 

Verified 
Upload Failed 

X X X X    X X  X 

Verified 
Download 
Failed 

X X X X    X X  X 

Before 
Download 

X X X X    X X  X 

Service 
Stopped 

X X X     X  X X 

Service Started X X X     X  X X 

Log Rotated X X X X X   X   X 

Site Stop X X X     X   X 

Site Started X X X     X   X 
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Event 
Triggers 

Actions 

Execute 
command 
in folder  

Execute 
Advanced 
Workflow 

Send 
notification 

email  

Copy/move 
file to host  

OpenPGP 
Encrypt, 
Encrypt + 

Sign, 
Decrypt  

Cleanup 
folder  

Download 
file from 

host  

Generate 
Report 

AS2 
Send 
file to 
host  

Backup 

Server 

Config  

Stop 

processing 

more rules  

User Account 
Disabled 

X X X     X   X 

User Quota 
Exceeded 

X X X X    X   X 

User Logged 
Out 

X X X X X   X   X 

User Logged In X X X X    X   X 

User Login 
Failed 

X X X     X   X 

User Password 
Changed 

X X X     X   X 

New User 
Created  

X X X     X   X 

User 
Connected 

X X X     X   X 

User Connect 
Failed 

X X X     X   X 

User 
Disconnected 

X X X     X   X 

AS2 Inbound 
Transaction 
Successful 

X X X     X   X 

AS2 Inbound 
Transaction 
Failed 

X X X     X   X 

AS2 
Outbound 
Transaction 
Successful 

X X X     X   X 

AS2 
Outbound 
Transaction 
Failed 

X X X     X   X 
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ADDING AN ACTION TO AN EVENT RULE 

After you have created an Event Rule and added one or more Conditions (optional) to the Rule, follow the 

procedure below to add one or more Actions to the Rule. 

To add an Action to a Rule 

1. In the right pane, in the Actions list, click an Action.  

 

 
 

The Action appears in the Event in the Rule pane. 

 

2. Select the linked text (blue or red) to specify parameters for the Action. For example, when you click the 

linked text in the Copy Action, the File Offload Configuration wizard appears. 
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EXECUTE ADVANCED WORKFLOW ACTION 

(Requires the Advanced Workflow Engine module.) Advanced Workflow Actions execute asynchronously, which 

means that the Server does not wait for a reply before returning control to the Event Rule thread, unless an "if 

failed" Action was specified, such as Stop Processing this Rule, in which case the Action waits for a return message 

indicating success or failure from the invoked process. 

To add a Workflow to an Event Rule 

1. Create the Workflow. 

2. Create an Event Rule. 

3. In the Actions list, click Execute Advanced Workflow Task. The Action is added to the Rule. 

 

4. In the Rule pane, click the Advanced Workflow Task link. The New Advanced Workflow dialog box 
appears. 

 

5. The defined Workflows appear in alphabetical order in the Choose a workflow to execute box. Click the 
down arrow and click a Workflow. The Advanced Workflow Task link in the Rule pane updates with the 
name of the Workflow. 

 

6. Add other Actions as needed, then click Apply to save the changes on the Server. 

SEND NOTIFICATION E-MAIL ACTION 

You can create an e-mail notification action for Event Rule and AS2 Transaction success/failure notifications. The 

default HTML text is shown in the dialog box below. To save time, you can create an e-mail notification template. 

 

On Sites using AD Authentication, the EFT Server must have "Log On as a domain user" permission in 
order for e-mail notifications to work. 

 To customize an Event Rule e-mail message  

1. Follow the procedure in Creating Event Rules to create a new Rule or select an existing Rule to which you 

want to add the Action. 
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If you want to copy the involved user when the event is triggered, the Rule must be based on a User 
Event.  

2. In the Actions list, double-click Send notification email or click it, then click Add Action. The Action is 

added to the rule as . 

3. Click the [select] link. The E-Mail Notification Message dialog box appears. The To box displays the first e-

mail address defined in the Server's address book on the SMTP tab. 

 

4. Do one or both of the following to specify recipients: 

 In the TO, CC, and BCC boxes, type the e-mail address of the intended recipients. 

 Click TO, CC, or BCC. The Select Names dialog box appears.  
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The Select Names dialog box is populated with names and e-mail addresses defined on the 

Server in the user details and SMTP tab.  

5. Select one or more recipients, then click CC, or BCC. (Press SHIFT (contiguous) or CTRL (non-contiguous) 

for multiple selections.)  

6. Click OK to save the changes. 

7. In the Subject box, type a descriptive "title" for the e-mail to indicate to the recipient the purpose of the 

e-mail. You can also add variables. For example, if you want to see the reason an Event was triggered 

without opening the e-mail, add the variable %EVENT.REASON% to the Subject line.  

For example, if you add the following text and variables to the Subject Line: 

EFT Server Notification: %EVENT.NAME%: %USER.LOGIN%, %EVENT.REASON% 

when username jbug uses the wrong password, an e-mail is sent with the following Subject line: 

GlobalSCAPE EFT Server Notification: User Login Failed: jbug, Invalid 

password 

 

Be aware that your recipient might get hundreds of e-mails every day, so "here's the info you 
wanted" might not be descriptive enough.  

8. In the Mail Body box, type the text of the e-mail, including any HTML formatting.  

 If the recipient's e-mail server does not accept HTML e-mail, the recipient will see the e-mail in 

plain text. However, if you want to send the e-mail as plain text, in the Mail Body box, delete all 

of the HTML tags.  

 You can define an e-mail template for common e-mails and provide a link to the template in the 

Mail Body area. 

9. In the Variables box, click a property that you want to insert in the e-mail message. The text surrounded 

by percent signs, the context variable, is inserted into the body of the e-mail, and will be replaced by EFT 

Server with specific information about the Event when the e-mail is sent. Review the available Variables 

when deciding which variables to add, because some variables cannot be used in e-mail notifications. 



Execute Advanced Workflow Action 

489 

 If you just want the information contained to the variable in your e-mail message, click the 

context variable in the right column of the Variables box. (For example, if you select 

%EVENT.TIME%  in the right column, the time will be displayed without a text label.) 

 If you want the information and a label, click the text in the left column of the Variables box. (For 

example, if you click Event Time, the label and the time appear in the e-mail). 

 

If the account to which the e-mail is sent accepts HTML e-mails, you can format the e-mail 
to suit your needs; you are only limited by your knowledge of HTML. Review your tags 
carefully, however, since no HTML code verification is performed. You can also create an 
HTML file to be your e-mail "template," then refer to the file as a link in the body of the Edit 
Mail Template dialog box. Refer to Creating an E-mail Notification Template for details. 

10. If this is a User event and you want to send a copy of the message to the involved user, select the CC Mail 

Notification to user check box.  

11. Click OK. 

12. Click Apply. 

COPY/MOVE (PUSH) FILE TO HOST ACTION 

(Available in EFT Server Enterprise) You can configure the Server to copy or move (also known as "offload") files to 

a specific location using a particular protocol whenever certain events occur, such as when a report is created. You 

must provide the Server with connection information (protocol and login details) and file information (source path 

and destination path). (Also refer to Download Action.) 

The Server attempts up to 100 connections to move the file when an offload Action is initiated. Users should 

consider configuring their client or receiving server to permit this number of connections. The Server can have up 

to 100 connections to each of 100 Sites at any one time. Further, if the connection attempt fails, there are no retry 

attempts. This is necessary because Event Rules are synchronous and must complete in a timely manner.  

 

If you create an Upload Rule that sends a file transfer activity report, the file transfer that triggered the Rule 
is not included in the report. 

The copy/move Action can be applied to all File System events, the User Events "Quota Exceeded," "User Login," 

"User Logout," and the Server Events "On Timer" and "On Rotate Log." The example below uses the On File Upload 

event.  

 

When you add a Copy/Move file to host or Download file from host Action to a Rule, the ClientFTP offload 
engine performs retries upon failures (network failures is the typical example) based upon the settings in the 
Advanced Options dialog box. Be aware that the Copy/Move file to host or Download file from host Action 
takes place synchronously; that is, the Server follows the logic of doing the transfer, including all retries, 
before moving on to the next Action, such as an e-mail notification. A long-running transfer that also retries 
numerous times with large delays will cause the Event Rule to take a long time to complete. 

 

 

If you are using Secure Ad Hoc Transfer, and if the Server and IIS are installed on the same computer, when 
creating the Event Rule for Upload notifications, create an additional Condition for "REMOTE IP does not 
match 127.0.0.1."  
The Rule’s Conditions should read:  
     If settings template is Ad-Hoc  

     AND If remote ip does not match <ip address of IIS server> 

     AND If remote ip does not match 127.0.0.1  
 
The second Condition should not be added if the Server and IIS are not installed on the same computer.  
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To configure the Server to copy/move files 

1. Follow the procedure in Creating Event Rules, or select the rule to which you want to add the Action. For 

example, create a Scheduler (Timer) Event. 

2. In the right pane, in the Actions list, click Copy/Move (push) file to host.  

 

 

3. In the Rule Builder, click Copy to toggle between Copy and Move to choose the Action you want for this 

Rule. 

4. In the Rule Builder, click one of the undefined parameters (e.g., '%FS.PATH%').  

 

 
 

The Offload Action Wizard appears.  
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5. On the Offload method box, specify a protocol type for the connection: Local (Local File or LAN), FTP 

(standard File Transfer Protocol), FTP SSL/TLS (AUTH TLS), FTP with SSL (Explicit encryption), FTP with SSL 

(Implicit encryption), SFTP using SSH2 (Secure Shell), HTTP (HyperText Transfer Protocol), HTTPS (Secure 

HTTP access).  

6. If you chose anything but Local do the following; if you chose Local, skip to step 11. 

a. In the Host address box, type the IP address.  

b. The Port number for the selected protocol changes automatically based on the offload method. 

Provide a different port number, if necessary. 

c. Provide the Username and Password needed to establish the connection.  

7. Select the Use connected client's login credentials to authenticate check box if you want to use the local 

system account to authenticate. 

8. If you chose SFTP: 

a. In the SFTP Public Key File Path box, type the path or click the open icon to browse to and select the 

path. 

b. In the SFTP Private Key File Path box, type the path or click the open icon to browse to and select the 

path. 

c. In the SFTP Key Passphrase box, provide the key's passphrase. 

9. If are connecting to a remote host through a SOCKS server, click SOCKS. 

 

a. Specify the Socks Type (SOCKS4 or SOCKS5). 

b. Specify the Host name and Port. 

c. If you specified SOCKS5 and the server requires authentication, select the Use Authentication check 

box, then provide a Username and Password. 

d. Click OK. 

10. If you are connecting to a remote host through a proxy, click Proxy.  
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a. Specify the Proxy type, Host name, Port, Username, and Password. 

 

Using the DMZ Gateway as proxy is available only in the Enterprise version of the Server. 

b. To specify an Authentication Type and login sequence, configure the Advanced settings.  

c. Specify one of the following Authentication Types:  

 USER user @site if your proxy server requires the USER command followed by your user 

name and the Site name to allow connection with a remote Site. You can change the @ 

symbol if a different separator is required by your proxy server. 

 SITE site if your proxy server requires the SITE command followed by the address of the 

remote FTP site to allow a connection. 

 USER with logon if your proxy server requires the USER command followed by a user 

name and password to allow connection with a remote Site. 

 USER/PASS/ACCT if your proxy server requires all three commands before allowing a 

connection to a remote Site. 

 OPEN site if your proxy server requires the OPEN command followed by the Site name 

before allowing connection to the Site. 

 Custom if your proxy server requires a login sequence different from those above. See 

To create a custom authentication method for a proxy server below for details of 

creating a login sequence. 

11. To specify transfer options and time stamps, click Advanced. The Advanced Options dialog box appears. 
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a. In the General transfer options area, you can provide more control over Max concurrent 

transfer threads, Connection timeout, Connection retry attempts, and Delay between retries. 

When files are being transferred with Event Rules (copy/move), if there are connection problems 

(e.g., the network is unavailable), the Server will attempt to establish a connection the number of 

times specified in Connection retry attempts. When the Server is able to re-establish the 

connection, it continues to transfer the file even if there are multiple interruptions.  

b. Select the Validate file integrity after transfer check box to specify that the Server should double 

check binary files to ensure the files downloaded completely and correctly. 

c. In the Data port mode box, click the drop-down list and select one of the following:  

 Auto - (selected by default) the Server initially makes connections in PASV mode. If the 

PASV connection fails, the Server attempts to connect in PORT mode automatically. 

 PASV - Helps avoid conflicts with security systems. PASV support is necessary for some 

firewalls and routers, because with PASV, the client opens the connection to an IP 

Address and port that the Server supplies. 

 PORT - Use PORT when connections or transfer attempts fail in PASV mode, or when 

you receive data socket errors. When a client connects using PORT, the Server opens a 

connection to an IP address and port that the client supplies. If you select Port, specify 

the Port range. 

d. In the ASCII transfer mode area, specify the file types that can be transferred. TXT, INF, HTML, 

and HTM are specified by default.  

e. In the Time stamps area, select one of the following: 

 Select the Preserve remote time stamp for downloaded files check box to keep a 

downloaded file's time stamp the same on the local computer as it is on the Server. 
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 Select the Preserve the local time stamp for uploaded files if the Server allows MDTM 

check box to keep an uploaded file's time stamp the same on the Server as it is on the 

local computer. 

f. Click OK. 

12. Click Next. The Source File Path page appears. 

 

13. In the Source path box, provide the path to the file(s) that you want to offload. (No validation is 

performed.) For example, type: 
/pub/usr/jsmith/file.txt or \\mydomain\common\jsmith\file.txt 

14. If you want to Delete source file after it has been offloaded, select the check box. 

15. Click Next. The Destination File Path page appears. 
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16. In the Destination path box, click the open icon  and specify the location in which to save the 

offloaded file. (No validation is performed.) 

 You can also specify variables, such as \pub\usr\%USER.LOGIN%\%FS.FILE.NAME%.  

 

In the Variables box, double-click the variable(s) that you want to add to the path. 

17. Click Finish then click Apply to save the changes on the Server and/or add other Actions and Conditions to 

the Rule. 

If you are copying or moving the file to another location, and the file upload is a regularly occurring event with a 

file of the same name, in the Offload Action wizard, add the variables %EVENT.DATESTAMP% and/or 

%EVENT.TIMESTAMP% to the path so that the date (YYYYMMDD) and/or time (HHMMSS) are added to the 

filename when it is moved/copied. Do not use %EVENT.TIME%, because the colon (e.g., 28 Aug 07 

10:01:56) makes it unsuitable for file naming. 

For example, in the Offload Action wizard, in the Destination path box, provide the path and variables. For 

example, type:  

C:\Documents and Settings\Administrator\My 

Documents\upload/%EVENT.DATESTAMP%_%EVENT.TIMESTAMP%_%FS.FILE_NAME%  

With this path and variables, when a file is uploaded to the monitored folder, the file is moved to \My 

Documents\upload and the date and time are prepended to the filename. For example, 

20080422_101212_mydailyprogress.doc. 
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To create a custom authentication method for a proxy server 

1. In the Advanced Proxy Settings dialog box, click Custom, then specify the login sequence in the text box 

using the following variables:  

 %host% - sends the host name you typed in the Proxy server options dialog box. 

 %user% - sends the user name you typed in the Proxy server options dialog box. 

 %pass% - sends the password you typed in the Proxy server options dialog box. 

 %port% - sends the port number you typed in the Proxy server options dialog box. 

 %fire_pass% - sends the password you typed in the Proxy server options dialog box as 

authentication for the firewall. 

 %fire_user% - sends the user name you typed in Proxy server options dialog box as 

authentication for firewall. 

2. Type each variable with percent signs before and after. 

3. Press ENTER to separate commands. 

4. Type any other commands and variables, separating commands with a line break (press ENTER). 

5. Click OK. 

 

Contact your system administrator for the proper Host name, Port, User name, Password, and proxy type, as 
well as any required advanced authentication methods. 

 

DOWNLOAD (PULL) FILE FROM HOST ACTION 

(Available in EFT Server Enterprise) You can configure a Server Event Rule to copy or download from a specific 

location to a specified local folder using a particular protocol when an event occurs. You must provide the Server 

with connection information (protocol and login details) and file information (source path and destination path). 

(Also refer to Upload (Copy/Move) Action.) 

 

The Download Action is available with all Events except Site Stopped and Service Stopped. 

To set up the Server to download files  

1. Follow the procedure in Creating Event Rules or select the rule to which you want to add the Action. 

2. In the Actions list, click Download (pull) file from host. The rule parameters are added to the rule in the 

Rule pane. 

3. Click one of the undefined parameters where the parameters are listed in the Rule pane. The Download 

Action wizard appears. 
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4. Click the list to specify a Download method for the connection: Local (Local File or LAN), FTP (standard 

File Transfer Protocol), FTP SSL/TLS (AUTH TLS), FTP with SSL (Explicit encryption), FTP with SSL (Implicit 

encryption), SFTP using SSH2 (Secure Shell), HTTP (HyperText Transfer Protocol), HTTPS (Secure HTTP 

access). 

5. If you chose anything but Local do the following; otherwise, skip to step 11. 

a. In the Host address box, type the IP or host address of the server to which you want to connect.  

b. The Port number for the selected protocol changes automatically based on the offload method. 

Provide a different port number, if necessary.  

c. In the Username and Password boxes, type the username and password used to authenticate.  

6. Select the Use connected client's login credentials to authenticate check box if you want to use the local 

system account to authenticate. 

7. If you chose SFTP: 

a. In the SFTP Public Key File Path box, type the path or click the open icon to browse to and select 

the path. 

b. In the SFTP Private Key File Path box, type the path or click the open icon to browse to and 

select the path. 

c. In the SFTP Key Passphrase box, provide the key's passphrase. 

8. If you connect to the Server through a Proxy server, click Proxy. 

9. If you connect to the Server through a Socks server, click Socks. 
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10. To configure advanced transfer options, click Advanced. The Advanced Options dialog box appears. 

a. In the General transfer options area, specify the following options: 

 Max concurrent transfer threads; 4 threads is the default 

 Connection timeout in seconds; 30 seconds is the default 

 Connection retry attempts; 30 retry attempts is the default 

 Delay between retries in seconds; 30 seconds is the default 

 Whether to Validate file integrity after transfer 

 Data port mode (Auto, Port, PASV) and the Port range 

b. In the ASCII transfer mode area, specify the types of files to transfer. TXT, INF, HTML, and HTM 

are specified by default. 

c. In the Time stamps area, specify whether to Preserve remote time stamp for downloaded files 

and Preserver local time stamp for uploaded files if the server allows MDTM. 

d. Click OK. 

11. Click Next. The Source File Path page appears. 

 

12. In the Source path box, provide the path to the file(s) that you want to download. For example, type: 
/pub/usr/jsmith/file.txt or \\mydomain\common\jsmith\file.txt 

13. If you want to Delete source file after it has been downloaded, select the check box. 

14. Click Next. The Destination File Folder page appears. 
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15. In the Destination folder box, click the open icon  and specify the location in which to save the 

downloaded file. You can insert variables by double-clicking them in the box below the Destination folder 

box. 

16. Click Finish, then click Apply to save the changes on the Server and/or add other Actions and Conditions 

to the Rule. 

OPENPGP ENCRYPTION/DECRYPTION 

You can configure the Server to use OpenPGP encryption for particular events. OpenPGP can be used with Server 

Events (the On Timer and On Rotate Log events), certain File System Events (File Upload, File Move, and File 

Rename), and a User Event (User Logout). To use this Action, the Site must be configured for OpenPGP and 

appropriate keys generated. 

The Server will not process files with the .pgp or .gpg extension for encrypt Actions. The Server will only process 

files with the .pgp or .gpg extension for decrypt Actions. 

 

This Action applies only to the On Timer, On Rotate Log, User Logout, and File Upload events. This example 
uses the On File Upload event.  

To set up the Server to use OpenPGP for particular Event Rules 

1. Follow the procedure in Creating Event Rules or select the rule to which you want to add the Action. 

2. In the right pane, in the Actions list, click OpenPGP Encrypt, Encrypt + Sign, Decrypt. The Action appears 

in the Event in the Rule  pane. 



EFT Server™ version 6 

 

500  

 

 

3. In the Rule pane, select either of the underlined elements (Encrypt or %FS.PATH%). The OpenPGP Action 

dialog box appears. 

 

 

4. In the Encrypt or decrypt options box, click the list to specify Encrypt or Decrypt.  

5. If you designated a default key for the Site, that key is displayed in the Encrypt or decrypt using (right) 

pane. If there is no default key, the right pane will be blank. Use the arrow icons to add or remove keys 

between the Your keyring pane and the Encrypt or decrypt using pane, or double-click the key in the list. 

6. Select the Enable compression check box, then click the down arrow to specify a level of compression, 

from 1 (least compression, fastest) to 9 (max compression, slowest). The default is 6 (medium 

compression, default). 

7. In the Signing options box, click the down arrow to specify an option: Output signature to target file 

(.pgp), Output signature to target file ASCII armored (*asc), Output signature to separate file (*.sig), 

Output signature to separate file ASCII armored (*.asc). 

8. In the Signing key box, click the down arrow to specify the signing key. 

9. In the Signing hash box, click the down arrow to specify a hash: Use default (MD5 or SHA-256), MD5, SHA-

1, RIPEMD160, SHA-256, SHA-384, or SA-1512. 
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10. In the File to process box, specify the file or folder to process. The default target file is selected.  

 Click a variable to add it to the File to process box or use actual file/folder names. Use the open 

icon  to browse to a file or folder.  

11. Click OK to close the dialog box and apply the parameters.  

12. Click Apply to save the changes on the Server. 

CLEAN-UP ACTION  

(Available in EFT Server Enterprise) You can configure an EFT Server Event Rule to clean up a specified folder at 

regularly scheduled intervals. You must provide EFT Server with connection information (protocol and login details) 

and file information (source path and destination path).  

The Clean up in Folder Action is available only with the On Timer Server event. At the interval that you specify, the 

Server compares the filter parameters of the Cleanup Action to the files in the designated folder, then determines 

the creation time of the file and deletes ("cleans up") files that match the cleanup parameters. For example, if you 

specify to cleanup files that are older than 7 days named dailyreport*.doc in the folder 

D:\WorkFolder\Sales\Daily Reports, any Microsoft Word files in that folder with dailyreport in the file name are 

deleted.  

 

To set up EFT Server to cleanup files  

1. Follow the procedure in Creating Event Rules to create a Scheduler (Timer) Event. The Event Rule appears 

in the Rule pane. 
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2. In the Actions list, double-click Cleanup in folder. The Action is added to the rule in the Rule pane.  

 

 

3. In the Rule pane, click the '[select]' link. The File Cleanup Action Parameters dialog box appears. 

 

 

4. In the Delete file(s) older than <n> box, specify the minimum age of a file to delete from the folder. The 

default is 7 days. 
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5. In the Folder box, click the open icon  to specify the folder that you want to clean up. 

6. To clean up subfolders in the specified folder, select the Include sub-folders check box. 

7. You can Include or Exclude specific files from the cleanup Action, and/or use wildcards for file types, 

partial names, and so on.  

8. Click OK to close the dialog box. 

9. Click Apply to save the changes on EFT Server. 

SENDING FILES TO AN AS2 PARTNER VIA EVENT RULES 

(Available in EFT Server Enterprise) You can send files via AS2 to a partner that does not have inbound access 

defined in the Server’s account management system by creating an Event Rule. If the AS2 partner has an outbound 

profile defined, you can select that profile when you define the send options.  

For example, you could define a Rule with a Timer event so that every Monday at 8 a.m., all files in a certain folder 

are sent to a partner that either already has a profile defined on the Server or that you will define "on the fly" in 

the AS2 Send File dialog box.  

The AS2 Send File to host Action can be used for Folder Monitor, Timer, and all file-based events. (Refer to AS2-

Related Actions for more information about the AS2 Send file to host Action.)  

To send files to AS2 partners 

1. Create a new Event Rule, such as a Scheduler (Timer) Event . (Refer to Creating Event Rules for details of 

creating Event Rules, if necessary.) 

2. Add the AS2 Send file to host Action to the Rule, then click one of the blue underlined text links. The AS2 

Send File dialog box appears. 
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3. In the File(s) to upload box, type the path or click the open icon  to specify the file to send to this 

partner. Include the entire path to the file. You can also use File System variables such as %FS.PATH% and 

wildcards. For example, to send all files in a folder, type the folder path and *.*. (The files will not be sent 

all at once; each file will have a unique message ID.)  

4. In the Partner Configuration area, specify the AS2 Partner profile using one of the following methods: 

 In the Partner profile box, select a defined  AS2 outbound partner profile. The fields in the AS2 

connection details area is completed automatically.  

 Provide the connection details in the AS2 connection details area. (Refer to AS2 Send File Dialog 

Box for details of each field.) 

 Click Setup Wizard to use the wizard to set up the profile. 

 

The Partner profile box is linked to the selected profile configuration. If you are using 
GlobalSCAPE authentication, if the profile is updated, the information in the AS2 Send File 
dialog box is updated also; if a referenced profile is deleted, disabled, or not allowed to use 
AS2, any Event Rule using the profile will fail. 
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If you use AD, LDAP, or ODBC authenticated accounts as AS2 partners, if the account in the 
external database is changed, deleted, or disabled, any Event Rule or Command that 
references the account will fail. For example, if an AD user SSmith is renamed SJones, you 
will have to manually update any Event Rule or Command to reflect the new name of the 
account. 

5. To test the configuration, click Test. 

6. To configure a proxy server for this partner, click Proxy. 

7. To clear all of the partner connection details and start over, click Clear All. 

8. Click OK to save the AS2 Partner profile in the Event Rule.  

9. Add other Conditions and/or Actions, as needed (e.g., add an e-mail notification). 

 

 

10. Click Apply to save the Event Rule on the server.  

BACKUP SERVER CONFIGURATION ACTION 

(Available in EFT Server Enterprise) A Backup Server Configuration Event Rule is defined and enabled by default to 

automatically back up the Server configuration on a recurring schedule. You can also run the wizard manually. For 

more information about the Migration wizard, refer to Backup Server Configuration Wizard. 

When you create your first Site, a new Timer Rule is created that runs the Backup Server Configuration Action 

once a day at midnight, using all defaults for naming and backup location (\backup\Server Configuration Backup 

[Month] [Day] [Year].bak). The default Rule includes a Cleanup Action to delete backup files (*.bak) older than 30 

days in that same folder. The Rule is created and enabled when EFT Server Enterprise is installed, but you can 

disable it and edit it as necessary. 

To create (or edit) the Backup Server Configuration Event Rule 

1. Create a Rule using the Timer, Service Stopped, or Service Started Events. 

2. If you are using the Timer Event, click the hyperlink to define the backup schedule. The Timer Event dialog 

box appears. Refer to Scheduler (Timer) Event for details, if necessary. 

3. Double-click the Backup Server Configuration Action or click it, then click Add. The Action is added to the 

Rule. 

4. Click the hyperlink in the Backup Server Configuration Action. The Open dialog box appears in which you 

can specify where to save the backup file. 

5. Select the folder in which to save the backup file, then click OK. 

6. (Optional) Add the Cleanup Action to removed old backups. Refer to Clean-Up Action for details, if 

necessary. The default Rule is configured to delete .bak files that are older than 30 days. You can delete 

backups manually, if desired. 

7. Add other Actions as needed, such as e-mail notifications. 

8. Click Apply to save the changes on the Server. 
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9. If you used the Timer Event, you can click Run Now to test the Rule. 

 

CREATING AN E-MAIL NOTIFICATION TEMPLATE 

The Conditions and Actions for every Event Rule you create, including e-mail notifications, is saved in the Server's 

configuration file. Each time the Administrator connects, it reads in the configuration file. Multiple Event Rules and 

e-mail notifications can grow the configuration file quite large. If you expect to have numerous e-mail notifications 

that are basically the same (e.g., you have default text that you always want to appear in the body of the e-mail), 

you can define the body of the e-mail in an HTML file, then reference it in the body of the Edit Mail Template 

dialog box. 

To create an e-mail notification template 

1. Create an HTML document that contains the text that will be the body of the e-mail notification. You can 

include any HTML tags and the Server variables. For example: 

<HTML> 

<BODY> 

<P>This message was sent to you automatically by GlobalSCAPE EFT Server on 

the following event: %EVENT.NAME%.</p> 

<HR> 

<P><B>Server Local Time:</B> %EVENT.TIME%</P> 

<P><B>Logon Name:</B> %USER.LOGIN%</P> 

<P><B>E-mail Address:</B> %USER.EMAIL%</P> 

<P><B>Home Folder:</B> %USER.HOME_FOLDER%</P> 

</BODY> 

</HTML> 

2. You could define the e-mail in an Edit Mail Template dialog box to easily add each of the variables that 

you want. Then copy and paste the body of the dialog box into a text file, and save it with an .htm 

extension. Be sure to include the opening and closing <html> and <body> tags. You can add your custom 

the Server administrator signature, your company's logo, any information that you need to pass on to the 

user, and so on. 

3. Save the file in a location that can be accessed by the Server. For example, name the file 

MailActionTemplate.htm, and save it in C:\Program Files\GlobalSCAPE\EFT. 

4. Define the Event Rule and add the e-mail notification, then open the Edit Mail Template dialog box. 

5. In the body of the e-mail, type file:// and the path to the e-mail template, then click OK. For 

example, type: 
 

file://C:\Program Files\GlobalSCAPE\EFT\MailActionTemplate.htm  
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6. Click OK to add the notification to the Event Rule. 

The referenced HTML file will appear in the body of the e-mail that is triggered by the Server. 

STOP PROCESSING 

The Stop Processing Action ends any further processing of the Event Rule.   

The example below shows three rules that are triggered with an On Upload event. The Stop Processing Action 

causes the other two processes in this example to stop: 

 

Based on these rules, all users except cserpent will have files encrypted and receive an e-mail notification when a 

file is uploaded.   
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A recurring Timer does not stop recurring if the Rule Actions fail; it will recur as scheduled until you disable or 
delete the Rule. In the case of Timer Rules, "Stop processing this rule" means "do not execute any further 
Actions with this Rule" (such as sending an e-mail), but it does NOT mean that the Timer will stop. For 
example, if you have defined the Rule to run every hour, an Action in the Rule could fail (such as downloading 
a file from a remote computer), but the Timer will run again the next hour, and the next hour, and so on, until 
you tell it to stop (by manually disabling it). 

GENERATE REPORT ACTION 

When the Auditing and Reporting module is activated, you can configure a Server Event Rule to generate a report, 

then e-mail it or save it to a file. If you add the Generate Report Action to a Rule, you must also tell the Server what 

to do with the report (save it or e-mail it or both). When a report is generated by the Generate Report Action, a 

temporary, enumerated copy of the report is created and stored locally in the Server installation folder. The 

temporary copy is deleted once the Event Rule context is out of scope.  

 

To facilitate compliance with PCI DSS requirement 10.6, the Server automatically generates a report of 
PCI/High Security-related configuration and functions. The report is converted to HTML and then e-mailed or 
saved to a file specified by the Server administrator.  
 
The automatic Generate Report Action never prompts for parameters because it will be run from the service 
on a timer, and thus does not allow interaction by a user. Reports that require parameters but do not have 
sufficient administrator-defined parameters will not run. 

Example of a Report Event: 

 

To create an Event Rule with the Generate Report Action 

1. Follow the procedure in Creating Event Rules to create a new rule, or select the rule to which you want to 

add the Action. 

2. In the Actions list, double-click Generate Report, or click it, then click Add Action. The Report Action 

dialog box appears. 
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3. In the Run the following report box, click the down arrow to select a report from the Reports directory. 

(Custom reports also appear in the list.) 

4. Click Custom range to specify a custom date range in the From and to boxes or click Report date range 

and click the drop-down list to specify one of the following options:  

 Include all dates starting from your earliest transaction, and ending with your latest 

transaction. If the selected dates include future transactions (e.g., if the ending date for the 

report is today's date), the future transactions will not appear in the report. 

 Month to date; Quarter to date; Year to date. Starting from the first day of this month, quarter, 

or year, and ending today. (Quarters begin January 1, April 1, July 1, and October 1.) 

 Current week; Current month (default); Current quarter; Current year. Starting from the first 

day of this week, month, quarter, or year, and ending with the last day of this week, month, 

quarter, or year. (Quarters begin January 1, April 1, July 1, and October 1.) 

 Last week; Last month; Last quarter; Last year. Starting from the first day of last week, month, 

quarter, or year, and ending with the last day of last week, month, quarter, or year. (Quarters 

begin January 1, April 1, July 1, and October 1.) 

 Last 30 days. Starting from 30 days ago, and ending with today's date. 

 Last 12 months. Starting 12 months ago from today’s date, and ending with today's date. For 

example, if today is July 2, 2007 and this date range is selected, the report would run from July 2, 

2006 through July 2, 2007. 

5. In the Report output format area, specify the format of the report output: HTML, PDF, or VP (report file). 
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6. In the Advanced Options area, specify parameters (separated by semicolons) for the report, which are 

evaluated from left to right. You can specify Event Rule variables. For example, if the report definition 

chosen in the Run the following report box requires two parameters for filename and username (in that 

order in the report definition), then the Optional parameters box can be populated with 

*.txt;myname to specify a filename parameter of *.txt and a username parameter of myname. 

7. In the Report Filters area, specify filters with AND or OR. 

8. To run the report in real time to verify that the Action was configured correctly, click Run and display 

report now (test).  

 

The report is created and stored in the Server installation directory. Once the date range has passed, the 

report is deleted. The variable %FS.REPORT_CONTENT% can be added to e-mail notifications. When 

%FS.REPORT_CONTENT% is added to the body of e-mail notifications, the content is displayed inline in the 

e-mail in HTML format, regardless of the format chosen in the Report Action dialog box. 

 

The variable %FS.REPORT_FILE% can be used in copy/move, PGP, and custom command actions that are 
executed synchronously (i.e., custom commands that have a failure event defined), but should not be used for 
Actions that are executed asynchronously (e.g., custom commands that do not have a failure event defined). 
Instead, use %FS.REPORT_CONTENT% for e-mail notifications, because this variable represents a copy of the 
contents of the file rather than a link to the file, which is only good so long as the file exists. For a complete 
list of the Server variables, refer to Variables. Do not use %FS.REPORT_FILE% in e-mail notifications. 

USING WILDCARDS WITH EVENT RULE ACTIONS 

The OpenPGP Action, the Copy/Move Action, and the File Name Conditions support the use of wildcards. This is 

useful for Event Rules that batch process groups of files. Standard Windows/DOS format wildcards are used, such 

as *.file extension, search term .???, search term ?.*, *.*, and so on. This functionality is particularly useful with the 

Timer event. 

Wildcards with OpenPGP 

In the OpenPGP Action configuration dialog, the File to Process field supports wildcards. Each matching file is acted 

upon according to the Action definition.  

Wildcards with Copy/Move 

In the Offload Action wizard, the Source path field on the Target File tab supports wildcards.  

When a wildcard is specified here, the Destination path field specifies the target folder to which each matching file 

is moved or copied. The files moved or copied into the destination file are given the same name as the files from 

the source. 

Example 

Source: 

c:\test\*.txt  

Destination:  

/%FS.FILENAME%  

Here, each "*.txt" file that is uploaded goes to "/", with a matching file name. Note that the destination file name 

is not overwritten. 
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Configuration Notes  

 If the source of an Action is specified as a wildcard without any path information, the path defaults to the 

folder with the Event Rule that triggered this Action (for example, there is a "%FS.PATH%" variable for an 

On Upload event.) If there is no folder like that available - for example, if the event is an On Timer event - 

the current working directory of the application is set as the source of the wildcard patterns. Typically, 

that is the installation directory of the application. 

 When you define a wildcard in the source path for a copy/move Action and the protocol type is set to 

Local (Local Files or LAN), the Server respects Windows path syntax: 

Source:  

c:\Work\Today\*.*  

Destination:  

g:\Backup\Work\Today\ 

You can also use \\Work, if appropriate.  

 The Destination Path (Upload event target file as:) ignores any path information you enter after the 

trailing backslash. So if you type: 

g:\Backup\Work\Today 

EFT Server disregards "Today" and executes the move/copy into: 

g:\Backup\Work\ 

 

 

Test an Event Rule using a wildcard before you deploy it to ensure it works as expected and does not cause 
any unwanted behavior. For example, if you do not define the source path appropriately when a wildcard is 
used, it is possible to set up an Action that moves all the files out of a user's c:\windows directory, which is 
most likely an undesired result. 

ACTION ORDER OF EXECUTION 

Almost all of the Server’s Event Rule Actions are executed synchronously (execute 1, wait until it finishes, execute 

2, wait until 2 finishes, execute 3 … etc.), as there may be more actions that follow that depend on the prior Action 

completing successfully. Each Action is completed before continuing to the next. 

This is not always the case for custom command actions. Command Actions execute asynchronously, which means 

that the Server does not wait for a reply before returning control to the Event Rule thread, unless an "if failed" 

Action was specified, such as Stop Processing this Rule, in which case the command Action waits for a return 

message indicating success or failure from the invoked process. 
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The Server executes the Event Rule according to whatever synchronicity applies to that Event Rule. For example: 

 Triggering a custom command is asynchronous unless the "If Failed" sequence has an Action defined for 

that command. 

 Move, copy, and download operations are synchronous. 

 PGP operations are synchronous and cause the Event dispatcher to wait until the operation is finished 

before moving on to the next Action/Condition. 

 E-mail notifications are synchronous up to the point of generating the contents of the e-mail and putting 

the data into a queue, but the Server has a separate thread that manages the e-mail notification queue to 

pick up ready messages and send them to the destination server. Therefore, e-mail notifications are 

roughly asynchronous. 

EVENTS 

The Server includes over 25 different event triggers, based on the following event types:  

 Operating System-related events, such as a folder’s contents changed or a recurring timer has executed 

 Transfer-related events, such as a file was uploaded or downloaded 

 Server- and Site-related events, such as server or Site stopped or started 

 User- and Connection-related events, such as a user logged in or out 

 AS2-related events, such as the transfer was successfully completed 

Operating System Events  

 Scheduler (Timer) Event - Execute a specified action one time or repeat at a specified interval.  

 Folder Monitor - Monitor a specified folder then execute an action whenever a change is detected. 

 Folder Monitor Failed - Monitor a specified folder then execute a specified action whenever a failure is 

detected. 

 

Use the File Upload system event to notify you when a file is uploaded to the Site. 
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File System Events  

 File Uploaded - If a file is uploaded to the Site. 

 File Downloaded - If a file is downloaded from the Site.  

 Verified Upload Succeeded - If integrity check of uploaded file succeeds when transferred using the Web 

Transfer Client.  

 Verified Download Succeeded - If integrity check of downloaded file succeeds when transferred using the 

Web Transfer Client.  

 File Renamed- If a file on the Site is renamed by a connected client. 

 File Moved - If a file is moved from one folder in the VFS to another by a connected client. 

 File Deleted- If a file is deleted from the Site by connected client. 

 Folder Created - If a folder is created on the Site by a connected client. 

 Folder Deleted - If a folder is deleted from the Site by a connected client. 

 Folder Changed - If a user navigates to a new folder on the Site. 

 Upload Failed - If an upload fails to transfer successfully. 

 Download Failed - If a download fails to successfully transfer. 

 Verified Upload Failed - If integrity check of uploaded file fails when transferred using the Web Transfer 

Client. 

 Verified Download Failed - If integrity check of downloaded file fails when transferred using the Web 

Transfer Client. 

 Before Download - If a download is requested, perform this first. 

Server Events  

 Service Stopped - When the Server service stops. 

 Service Started - When the Server service starts. 

 Log Rotated - When the current activity log closes and the Server opens a new log file. 

Site Events  

 Site Stop - When the Site stops. 

 Site Started - When the Site starts. 

User Events  

 User Account Disabled - If the user account is disabled by the administrator or by the Server. 

 User Quota Exceeded - If the user has taken too much disk space on the Server. 

 User Logged out - If the user closes a session gracefully. 

 User Logged in - If the user logs in to the Server. 

 User Login Failed - If the user attempts an incorrect username or password. 

 User Password Changed - If the user or administrator changes a user's password. 
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 New User Created - If a new user has been created. 

Connection Events  

 User Connected - When a user connects to the Site (this occurs before log in). 

 User Connect Failed - When a user attempts to connect and fails (this can occur before log in). 

 User Disconnected - When a user disconnects from the Site (this can occur before log in). 

AS2 Events 

 AS2 Inbound Transaction Succeeded - Triggers if the inbound transmission was successful, MDN was 

successfully sent, MICs all match, and no other errors occurred. 

 AS2 Inbound Transaction Failed - Triggers if the AS2 file upload failed for some reason, such as bad MIC, 

no permissions/access, duplicate message ID, or other AS2 transfer-related error. 

 AS2 Outbound Transaction Succeed - Triggers if the Server has offloaded a file to a remote partner, and 

that partner replied with a receipt asynchronously over HTTP/S, indicating that the transfer was 

successfully completed. 

 AS2 Outbound Transaction Failed - Triggers if the expected MDN receipt was not received in the 

expected time or the receipt signature or MIC failed. 
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VARIABLES 

The Server uses context variables to pull data from the database. The variable contains specific information about 

an event. You can use the variables below in Event Rules, e-mail notifications, and commands.  

 Connection Variables - IP address, port, etc. for connecting to the Server 

 Event Variables - Name, date, time, reason, etc. for Event trigger 

 File System Variables - File name, date, size, path, etc. that was transferred; also report name and content  

 

In Event Rules and commands with a defined path or filename, do not use variables that add invalid 
filename characters, such as a slash, colon, parenthesis, etc. See details in the note below. 

 Server Variables - Server status, logs, and computer name 

 Site Variables - Site URL and status 

 User Variables - User name, login information, etc. 

 AS2-Related Variables - Status of AS2 transfers (available only in AS2-related event triggers) 

How to use the Variables 

In the Variables box, click a property that you want to insert.  

 If you just want the information contained to the variable, click the context variable in the right column of 

the Variables box.  

 If you want the information and a label, click the text in the left column of the Variables box.  

For example, if you click Event Time in the left column the label "Event Time" and the time are displayed. If you 

select %EVENT.TIME% in the right column, the time will be displayed without a text label. 

 

For example, when you create an Event Rule, you can configure an e-mail to be sent when the Event occurs. In the 

Edit Mail Template dialog box, you can send the default e-mail or you can add one or more variables listed in the 

Variables box at the bottom of the e-mail. Each of the variables defined in the Server is described below; however, 

not all of the tags described below are available in the e-mail notification. In the e-mail notification, you can 

specify to display the text along with the value of the variable (e.g., File Creation Date: 8/28/2007), or just the 

value of the variable (e.g., 8/28/2007).  
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For example, suppose you configured this e-mail notification: 

 

If you then uploaded a file on August 28, 2007 at 10:01:56, the e-mail would appear similar to the following: 

This message was sent to you automatically by EFT Server on the following 

event: File Uploaded.  

Event Time: 28 Aug 07 10:01:56 

File Creation Date: 8/28/2007 

File Creation Time: 10:01:56 

Event Date Stamp: 20070828  

Event Time Stamp: 100156  
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In Event Rules and commands with a defined path or filename, do not use variables that add invalid filename 
characters, such as a slash, colon, parenthesis, etc. 

 

For example, you cannot use %FS.FILE_CREATE_DATE% and %FS.FILE_CREATE_TIME% for file 
naming, because the output of these variables is DD/MM/YYYY and HH:MM:SS and the forward slash (/) and 
colon (:) are not valid characters for filenames.  

 
In most cases, the file created date and time is the same as the event triggered time, therefore you can use 

%EVENT.DATESTAMP% (YYYYMMDD) and %EVENT.TIMESTAMP% (HHMMSS) when renaming files 

(because they do not use invalid characters), and %FS.FILE_CREATE_DATE% and 

%FS.FILE_CREATE_TIME% for e-mail notifications. 
 
For example, suppose an OnUpload Event Rule causes an Offload Action that moves myfile.txt to the 
following path: 
 

C:/Inetpub/EFTRoot/Site1/Usr/jsmith/ %EVENT.DATESTAMP%_%FS.FILE_NAME%  
 
The resulting path is: 
 

C:/Inetpub/EFTRoot/Site1/Usr/jsmith/ 20070728_myfile.txt  

CONNECTION VARIABLES 

Text Displayed Variable Description 

Remote IP  %CONNECTION.REMOTE_IP% Remote IP address used to connect 

Local IP  %CONNECTION.LOCAL_IP% Local IP address used to connect 

Local Port  %CONNECTION.LOCAL_PORT% Local port used to connect 

Protocol  %CONNECTION.PROTOCOL% Protocol used to connect 

Using Web Transfer 
Client  

%CONNECTION.USING_WEB_TRANSFER_CLIENT% Indicates whether the user connected via 
the Web Transfer client 
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EVENT VARIABLES 

Text 
Displayed 

Variable Description 

Event Time  %EVENT.TIME% Date and time that the Event was triggered, e.g., 28 Aug 07 
10:01:56  
(This variable is not suitable for file naming because of the colons; use 
%EVENT.DATESTAMP% and %EVENT.TIMESTAMP% instead.) 

Event Date %EVENT.DATESTAMP% Date that the Event was triggered, e.g., 20070828  
(suitable for file naming) 

Event 
Timestamp 

%EVENT.TIMESTAMP% Time that the Event was triggered, e.g., 100156  
(suitable for file naming) 

Event Name  %EVENT.NAME% Server-defined name for the Event (e.g., File Renamed) 

Event Reason  %EVENT.REASON% Action completed successfully or Action Failed 

Event Full 
Name  

%EVENT.EVENTNAME% User-defined name for the Event (e.g., My File Renamed Event Rule) 

FILE SYSTEM VARIABLES  

Text 
Displayed 

Variable Description 

Virtual Path  %FS.VIRTUAL_PATH% Original virtual location of the file 

Physical Path  %FS.PATH% Original physical location of the file 

Physical Folder 
Name  

%FS.FOLDER_NAME% Name of the physical folder 

File Name  %FS.FILE_NAME% Name of the file 

File Size  %FS.FILE_SIZE% Size of the file involved in the Event 

File Creation 
Date  

%FS.FILE_CREATE_DATE% Date the file was created, in the format YYYY/MM/DD, e.g., 
8/28/2007 (not suitable for file naming because of the slashes) 

File Creation 
Time  

%FS.FILE_CREATE_TIME% Time the file was created, in the format HH:MM:SS, e.g., 10:01:56 
(not suitable for file naming because of the colons) 

Virtual 
Destination 
Path  

%FS.DST_VIRTUAL_PATH% Virtual destination path of the file involved in the Event 

Physical 
Destination 
Path  

%FS.DST_PATH% Physical destination path of the file 

Physical 
Destination 
Folder Name 

%FS.DST_FOLDER_NAME% Physical destination folder 

Destination 
File Name  

%FS.DST_FILE_NAME% Destination file name  
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Text 
Displayed 

Variable Description 

Report 
Content 

%FS.REPORT_CONTENT% Content of the report generated by the Generate Report Action 

Report File 
Name 

%FS.REPORT_FILENAME% Location of generated report. This variable can be used in e-mail 
notifications to include a link to the new location for the file after a 
copy/move Action. 

Report Name %FS.REPORT_FILE% Name of the report generated by the Generate Report Action. This 
variable can be used in copy/move, PGP, and custom command 
actions that are executed synchronously (i.e., custom commands that 
have a failure event defined), but should not be used for custom 
command actions that are executed asynchronously (i.e., custom 
commands that do not have a failure event defined.)  

In some cases, it may be more appropriate to use 
%FS.REPORT_CONTENT% because this variable represents a copy of 
the contents of the file rather than a link to the file, which is only good 
so long as the file exists. For example, since the file will be deleted 
when the Server stops processing the Event Rule, do not use this 
variable in e-mail notifications; use %FS.REPORT_CONTENT% instead.  

SERVER VARIABLES  

Text 
Displayed 

Variable Description 

Server Running %SERVER.STATUS% 
Indicates whether the Server service was running when the Event 
was triggered. (Yes or No) 

Log Type %SERVER.LOG_TYPE% Either Standard or Verbose, per the setting on the Logs Tab 

Log Location %SERVER.LOG_LOCATION% Location of the log file 

Node Name %SERVER.NODE_NAME% Computer name on which the Server is running 

SITE VARIABLES  

Text Displayed Variable Description 

Account 
Management URL 

%SITE.ACCOUNT_MANAGEMENT_URL% 
Site account management URL,  
https://../manageaccount:<port> (if port is not equal 
to 443) 

Site Status %SITE.STATUS% 
Indicates whether the Site was running when the 
Event was triggered. (Yes or No) 

USER VARIABLES  

Text Displayed Variable Description 

Full Name  %USER.FULLNAME% 
Full name of the user, if defined on the User 
Account Details dialog box 

Logon Name %USER.LOGIN% Login username of the user 
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Text Displayed Variable Description 

Logon Password  %USER.PASSWORD% Login password of the user 

Groups  %USER.GROUPS% Groups in which the user is a member 

Account Enabled  %USER.ENABLED% 
Indicates whether the user account is 
enabled. (Yes or No) 

Settings Level  %USER.SETTINGS_LEVEL% Settings Template of the user 

Description  %USER.DESCRIPTION% 
Description of the user account, as defined 
on the General tab 

Comment  %USER_COMMENT% 
Text in the Comment box, if defined in the 
User Account Details dialog box 

E-mail Address  %USER.EMAIL% 
E-mail address of the user, if defined in the 
User Account Details dialog box 

Phone Number  %USER.PHONE% 
Phone number of the user, if defined in the 
User Account Details dialog box 

Pager Number  %USER.PAGER% 
Pager number of the user, if defined in the 
User Account Details dialog box 

Fax Number  %USER.FAX% 
Fax number of the user, if defined in the 
User Account Details dialog box 

Home Folder  %USER.HOME_FOLDER% User's home folder 

Home Folder is Root  %USER.HOME_IS_ROOT% 
Indicates whether the Treat Home Folder as 
Root check box is selected. (Yes or No) 

Quota Max  %USER.QUOTA_MAX% Max disk space specified for the user 

Quota Used  %USER.QUOTE_USED% Amount of disk space in use by the user 

Invalid login 
attempts  

%USER.INVALID_LOGINS% Number of invalid login attempts by the user 

User can change 
password  

%USER.CAN_CHANGE_PASSWORD% 
Indicates whether the user is allowed to 
change the login password (Yes or No) 

Home IP  %USER.HOME_IP IP address of the user 

User can connect 
using SSL  

%USER.ALLOW_SSL% 
Indicates whether user is allowed to connect 
using SSL (Yes or No) 

User can connect 
using FTP  

%USER.ALLOW_FTP% 
Indicates whether user is allowed to connect 
using FTP (Yes or No) 

User can connect 
using SFTP  

%USER.ALLOW_SFTP% 
Indicates whether user is allowed to connect 
using SFTP (Yes or No) 

Last Login Date %USER.LAST_LOGIN% Provides the date and time (in the default 
system locale) the user last logged in to the 
Server 

Password Expiration 
Date 

%USER.PASSWORD_EXPIRATION% Provides the date and time (in the default 
system locale when the user account is set to 
expire, or Never  
(See HS note, below.)  
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Text Displayed Variable Description 

User Must Change 
Password at Next 
Login 

%USER.RESET_PASSWORD_AT_FIRST_LOGIN% Indicates whether user is required to reset 
the account password at first log in (Yes or 
No). (See HS module note, below.) 

Account Expiration 
Date  

%USER.EXPIRATION_DATE% Indicates the date (in the default system 
locale) when the user account expired. Date , 

or Never  
(See HS module note, below.) 

Account Locked Out %USER.IS_LOCKED_OUT% Indicates whether user account is locked out. 
Yes or No (See HS module note, below.) 

 

 

If the HS module is disabled (not in Activated or Trial state), No or Never is displayed. 

AS2 VARIABLES 

Text 
Displayed 

Variable Value Contained in Variable 

AS2 Payload %AS2.PAYLOAD% Name of the file (or an array of file names if MA is 
used) being transferred over the AS2 session 

AS2 MDN %AS2.MDN% MDN 

AS2 Local MIC %AS2.LOCAL_MIC% Local AS2 message identification code (MIC) 

AS2 Remote MIC %AS2.REMOTE_MIC% Remote AS2 message identification code (MIC) 

AS2 Message ID %AS2.MESSAGE_ID% AS2 message identifier 

AS2 Host %AS2.HOST% Address of the host being sent to (outbound) or 
received from (inbound) 

AS2 Transaction 
Error 

%AS2.TRANSACTION_ERROR% Error (if any) in the AS2 transaction  

AS2 Transaction 
Result  

%AS2.TRANSACTION_RESULT%  Overall transaction result (In Progress, Failure, or 
Success) of the in-context AS2 transaction 

AS2 Transaction 
Verbose 

%AS2.TRANSACTION_VERBOSE% Verbose message for the AS2 transaction 

AS2 Direction %AS2.DIRECTION% Direction of the transfer 

AS2 Partner ID %AS2.PARTNER_ID% Transaction partner's AS2 ID 

AS2 EFT ID %AS2.EFT_ID% The Server ID used in this transfer 

AS2 Content Type %AS2.CONTENT_TYPE% Transfer's content type: Application,  EDIFACT, 
XML, Mutually defined EDI, Binary, Plaintext 
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EXECUTING EVENT RULES USING WEB SERVICES 

In EFT Server Enterprise edition, Web Services allows you to initiate the Server Event Rules via a Web browser.  

For more information about how the Server supports Web Services, refer to Web Services. 

 

The administrator account must have the COM administration privilege for access to any /WebService URL (or 
sub-URLs); without proper authentication and COM privileges, the Server returns a "401 Unauthorized" HTTP 
error. 

To execute an Event Rule using WebServices 

1. Open a Web browser and navigate to the Server URL appended with /WebService. The WebService 

page appears. 

2. Click InvokeEventRule. Another Web page, /WebService/InvokeEventRule, displays a form for invoking 

an Event Rule. 

3. In the EventName box, type the name of the EventRule.  

4. In the ContextValues box, type one or more variables, separated by semicolons. 

For example, in the EventName box, type the name of an Event Rule containing an Offload Action, and in 

the ContextValues box, specify %WS.DESTINATION_HOST% to return a name/value pair in the format 

WS.DESTINATION_HOST=a.b.c.d. 

5. Click Invoke. The Event Rule is executed.  

 

All WebService responses use the Site's domain name as the namespace for the WebService. 

After the Event Rule finishes dispatching, the Web service responds with an XML document that consists 

of a single "Result" element. The Result Code can be any one of the following: 

 0 indicates failure 

 1 indicates success 

 -1 indicates the Server could not find the Event Rule (e.g., the requested EventName does not 

exist or was not typed correctly) 
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THE OPENPGP MODULE 

The topics below provide information regarding using OpenPGP with EFT Server. 

OPENPGP AND THE SERVER 

EFT Server employs industry-standard OpenPGP (based on the open source implementation of Pretty Good 

Privacy) technology to safeguard data at rest. In contrast to symmetric encryption technologies that rely on a 

single password or shared secret for encryption and decryption, OpenPGP uses a public/private key pair and a 

password. Although widespread, dual-factor encryption technologies such as PGP are not universally employed 

throughout the industry, because of the complexities involved in key creation, management, and distribution, as 

well as the application of public-key infrastructure technologies. Another drawback is the fact that the entire file 

must be present for PGP encryption to work, resulting in a very brief period of time whereby data is stored "in the 

clear," until the encryption process is completed and the source (unprotected) file is deleted.  

 

EFT Server adheres to the OpenPGP standard and is RFC 2440 compliant. OpenPGP is a standard and has no 
version. Refer to RFC 2440 for details. 

How PGP Encrypt/Decrypt Works 

Below are illustrations of how PGP encryption and decryption works. 

Encryption: 

 

Decryption: 

 

In EFT Server, the OpenPGP data encryption (or decryption) process is directed by Event Rules that specify how 

data files are treated in a particular context. OpenPGP uses a public key and a private key to encrypt data and 

maintain security. These two components are considered a key pair and are associated with a particular Site. The 

http://www.ietf.org/rfc/rfc2440.txt
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key pair is stored on the OpenPGP Key Ring, which is the management tool for public keys and key pairs. The 

OpenPGP Key Ring contains all key information and allows import, export, creation, and deletion of keys.  

New key pairs are created using the OpenPGP Key Generation wizard. The wizard prompts you for key parameters 

and creation of a passphrase. Once the new key pair is generated, you must determine if the new key pair will be 

the default for the entire Site. Allowing assignment of a default key pair will automatically select this key when 

configuring an Event Rule using OpenPGP encryption.  

The example below shows how a trigger event (On Upload) is used to initiate OpenPGP encryption.  

 

In an Event Rule, when a selected even occurs (e.g., a file is uploaded to the server), if the specified Condition 

exists (e.g., user is member of group A), then the selected actions occur (e.g., encrypt the file).  

OpenPGP encryption is only available for certain events: 

 On Upload - when a file is uploaded to a location. 

 On Rotate Log - when a log file is closed out and a new log initiated. 

 On Timer - an event that occurs once or according to a schedule.  

Below is a simplified example of the file transfer process in which the Server uses OpenPGP to encrypt uploaded 

data and the off-load capabilities of the Server to move the file to another location. 

 

CREATING KEY PAIRS FOR OPENPGP 

You can create new key pairs for OpenPGP encryption using the OpenPGP Key Generation Wizard. The key pair 

file is saved in C:\Documents and Settings\All Users\Application Data\Globalscape\EFT Server Enterprise or \EFT 

Server. 

EFT Server can create the following types of keys for OpenPGP: 

 RSA: If you select RSA, the library generates the new standard RSA key pair format by default--keys 

that are compatible with newer OpenPGP clients. The new RSA key format supports features 

previously available only to DSS/DH keys. The new RSA key format enables you to have a primary key 

for signing and a subkey to encrypt data. In addition, the encryption key (the subkey) can be revoked 

or have a different expiration date as its primary key. A new subkey can always be added to a primary 

key and be used for encrypting data. New RSA keys are compatible with newer versions of OpenPGP. 

The library generates the new and improved RSA key format by default. These keys are not 

compatible with older PGP clients that are not compliant with RFC 2440 such as PGP 2.6.x.  
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 RSA Legacy: In EFT Server, the PGP library gives you the option to generate RSA Legacy keys that are 

compatible with older versions of OpenPGP. Old OpenPGP clients are compliant with RFC 1991 only, 

not RFC 2440.   

 

RSA Legacy keys created in EFT Server are compatible with CuteFTP, and any keys created in CuteFTP 

will work in EFT Server; however, new RSA keys created in EFT Server are not compatible with 

CuteFTP, because CuteFTP uses an older library.  

 

For information about Diffie-Hellman key exchange, refer to http://en.wikipedia.org/wiki/Diffie-
Hellman. 
 
For information about RSA, refer to http://en.wikipedia.org/wiki/RSA. 

To access the Key Ring Manager and use the OpenPGP Key Generation Wizard 

 

If you have made any configuration changes, click Apply and/or Refresh before creating the key pair; 
otherwise, key creation will fail. 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site you want to configure. 

3. In the right pane, click the Security tab. 

 

4. Next to OpenPGP Security, click Configure. The OpenPGP Security dialog box appears. 

http://en.wikipedia.org/wiki/Diffie-Hellman
http://en.wikipedia.org/wiki/Diffie-Hellman
http://en.wikipedia.org/wiki/RSA
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5. Click Create. The OpenPGP Key Generation Wizard appears. 
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6. Read the instructions on the welcome page, then click Next. The Parameters page appears. 

 

 

7. In the Full name box, provide your name or another contact's name. 

8. In the E-mail address box, provide an e-mail address. 

9. In the Key cipher box, click the list to specify a cipher to use: IDEA, 3-DES (the default), CAST5, AES128, 

AES192, AES256, or TWOFISH. 

10. In the Key type box, click Diffie-Hellman/DSS, RSA, or RSA legacy. 

11. Specify the Key length (1024, 2048, 3072, or 4096). Larger bit sizes increase security, but increase 

encryption time. 

12. Specify the Key expiration date, or never.  

13. Click Next. The passphrase page appears. 
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14. Type your passphrase in the Passphrase and Confirmation boxes. The passphrase is case sensitive and 

must contain a minimum of 8 characters. For better security, the passphrase should contain a mix of 

alphanumeric (both upper and lower case) and non-alphanumeric characters. Select the Hide typing 

check box to display asterisks instead of the passphrase. 

15. Click Next. The Site page appears. 

 

 

16. Clear the Use this key pair as default key pair for this Site check box if the key is for a client or you do not 

want this key pair to be the default for the Site. Otherwise, select the check box and click the list to 

specify the Site, if different than the one displayed in the box. 

17. Click Finish to generate the key pair. A message appears informing you that it might take several minutes 

to generate the key pair. 

18. Click OK to close the notification dialog box. A message appears indicating successful generation of the 

key and addition to the Server key ring. 

19. Click OK to close the notification dialog box.  

20. Click OK to close the OpenPGP Security dialog box. 

21. Click Apply to save the changes on the Server. 
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THE OPENPGP KEYRING MANAGER 

Use the OpenPGP Keyring manager to create, delete, import, and export OpenPGP key pairs. You can also view or 

change key pair path settings. 

To open the OpenPGP Keyring manager 

1. In the Administrator, connect to the Server. 

2. Do one of the following: 

 On the toolbar, click the Open OpenPGP Keyring icon . . 

 On the main menu, click Tools > Manage OpenPGP Keys. 

 On the Server tab, click the Site you want to configure, then in the right pane, click the Security 

tab. In the Data Security area, next to OpenPGP Security, click Configure. The OpenPGP Security 

dialog box appears. Click Manage. The OpenPGP Keyring manager appears.  

The OpenPGP Keyring manager appears. 

 

 

For each keyring, the OpenPGP Keyring manager displays its name, the date it was created, the expiration 

date, the size, a hexadecimal ID number, and a description. 

For instructions for each of the features of the OpenPGP Keyring manager, refer to the following topics: 

 Import and Export: Importing and Exporting Key Pairs for OpenPGP 

 New: Creating Key Pairs for OpenPGP 

 Remove: Deleting Key Pairs for OpenPGP 

 Settings: Viewing and Changing Key Pair Path Settings 

3. Click Close to close the dialog box. 
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DELETING KEY PAIRS FOR OPENPGP 

To delete a key pair 

1. Open the OpenPGP Keyring dialog box. 

 

 

2. Select the key pair that you want to delete, then click Remove. A confirmation message appears. 

3. Click Yes. 

4. Click Close to exit. 
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IMPORTING AND EXPORTING KEY PAIRS 

The OpenPGP KeyRing manager can be used to Import or Export keys. 

To import a key 

1. Open the OpenPGP Keyring dialog box. 

 

 

2. Click Import to begin the key import process. 

3. Click the file containing the key to be imported (*.asc) then click Open. The Import OpenPGP Key dialog 

box closes and the imported file is now included in the Key Ring list. 

To export a key 

1. Open the OpenPGP Keyring dialog box. 

2. Select the file to be exported, then click Export. The Save As dialog box appears. 
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3. Click the folder in which you want to save the new key file. 

 

Select the check box to include the private key in the export. Do not select the check box if you are 
exporting the key to provide to a client. (Do not share your private key.) 

4. Click Save to export the file. 

VIEWING AND CHANGING KEY PAIR PATH SETTINGS 

The default key pair path settings can be viewed and edited in the OpenPGP Settings dialog box.  

To view the OpenPGP Settings  

1. Open the OpenPGP Keyring dialog box. 
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2. Click the key you want to view, then click Settings. The OpenPGP Settings dialog box appears. 

 

 
 

The Public and Private keyring file paths appear. 

To change Key Path settings 

1. In the OpenPGP Settings dialog box (see above procedure), click the open icon . The Choose Public 

Keyring File dialog box appears. 

 

 

2. Click the key ring file to be changed, then click Open. 

 

When key paths are changed, the key list is automatically refreshed. 

3. Click OK to close the OpenPGP Settings dialog box, then click Close on the OpenPGP Keyring dialog box. 
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THE AS2 MODULE 

(Available in EFT Server Enterprise) The Server provides the option of transferring files over AS2 (Applicability 

Statement 2), used to exchange structured business data securely using the HTTP or HTTP/S protocol. The topics 

below provide an overview of AS2 and describe how to configure EFT Server's AS2 module. 

INTRODUCTION TO AS2  

(Available In EFT Server Enterprise) AS2 (Applicability Statement 2) is used to exchange structured business data 

securely using the HTTP or HTTP/S protocol. Any type of data can be exchanged using AS2, including traditional EDI 

messages, XML, flat files, spreadsheets, and CAD/CAM data. AS2 is not concerned with the content or validity of 

the data being sent, but only with the connection and the secure, reliable exchange of data. Data security is 

achieved using S/MIME through signing and/or encryption. 

AS2 offers distinct advantages over plain HTTP, including increased verification and security achieved with receipts 

and digital signatures. Its transactions and acknowledgements occur in real time, increasing the efficiency of 

document exchanges. AS2 is also referred to as EDIINT AS2 (EDI over the Internet AS2). Many organizations are 

migrating to this protocol to reduce costs, and requiring their trading partners to switch to the AS2 protocol. 

Sending encrypted payloads over HTTPS ensures that only the sender and receiver can view the data exchanged. 

The use of a hash algorithm ensures data integrity by detecting whether the document was altered during 

transmission.  

HTTP is used to send data to an AS2-ready server. Using extended header information in the HTTP request, the 

client outlines how the data should be handled and how EFT Server should respond to the client with a signed or 

unsigned receipt. (A receipt is an acknowledgment of an interchange that is NOT signed. A signed receipt is an 

acknowledgement of an interchange that IS signed.) 

EFT Server validates the integrity of the data once received and subsequently provides the requested 

acknowledgement or message disposition notification (MDN) to the client. Further validation is achieved by the 

client acknowledging the receipt from EFT Server. For technical details of AS2, refer to RFC 4130. 

The basic structure of an AS2 message can be compared to an envelope that contains a MIME-formatted message 

inside an HTTP message with AS2 headers. The MDN is returned in the HTTP response message body or in a new 

message to a URL for the original sender. This request/reply transactional interchange can provide secure, reliable, 

and authenticated transport for data using HTTP as a transfer protocol. The security protocols and structures used 

also support auditable records of these document data transmissions, acknowledgements, and authentication. In a 

secure message exchange, one organization sends a signed and encrypted message to another organization and 

requests a signed receipt, and later the receiving organization returns the signed receipt to the sending 

organization.  

Non-repudiation of receipt (NRR) is a legal event that occurs only when the original sender has verified the signed 

receipt returned from the recipient of the message, and has verified that the returned message integrity check 

(MIC) inside the MDN matches the previously recorded value for the original message. That is, the sender of the 

message obtains undeniable proof that the recipient received the message and that the message was not altered 

in transit. NRR is established when both the original message and the receipt use digital signatures. 

http://www.faqs.org/rfcs/rfc4130.html
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HOW THE SERVER SUPPORTS AS2 

EFT Server Enterprise edition incorporates a Drummond-certified  AS2 adapter to support inbound and outbound 

AS2 transfers. Drummond certified means that the Server's AS2 module has achieved interoperability with other 

Drummond-certified AS2 servers and clients.  

If you are transferring files using HTTP, the payload must be encrypted; if the payload is not encrypted, HTTPS 

must be used. This rule applies to both inbound and outbound transactions. Encrypting the payload and sending it 

over HTTPS provides additional protection from "man-in-the-middle" attacks. 

The Server supports inbound Multiple Attachments (MA) for processing a single message with multiple payloads. 

MA messages are treated the same as normal messages with the exception that multiple files are processed.  

What the Server's AS2 module does not do 

The Server does not support non-encrypted payloads over plaintext HTTP, asynchronous MDN deliveries via SMTP 

for outbound transactions (but does support inbound ones), EDI file content manipulation (translation, extraction, 

transformation, loading), or outbound Multiple Attachments (MA). The Server does not determine if the data sent 

or received is usable; it only transfers the data. The AS2 module is "push only"; that is, the Server does not request 

files. 

How the Server manages AS2 transmissions 

In receiver mode (inbound), the Server examines the header, then determines whether to process it as a normal 

file transfer, as an MDN, or as an AS2 transmission. If the file is an AS2 transmission, the Server sends a receipt and 

an HTTP response. 

 An On File Upload event occurs for each file uploaded in an MA transaction.  

 An AS2 Inbound Transaction Succeeded event occurs just once per transaction after all files are received 

and the MDN (if requested) is successfully sent. 

 An AS2 Inbound Transaction Failed event occurs if an AS2 file upload failed for any reason, such as bad 

MIC, no permissions/access, duplicate message ID, or other AS2 transfer-related error.  

In sender mode (outbound), the Server provides granular control over AS2 configuration, such as synchronous 

versus asynchronous receipts.  

 Outbound AS2 with synchronous MDN - the Server waits for the MDN to be returned before completing 

the transaction. 

 Outbound AS2 with asynchronous MDN - the Server does not wait for the MDN to be returned, but tells 

the remote server where to send the MDN. 

 EFT Server determines once every 60 minutes whether an asynchronous MDN is received. The transaction 

status is considered a failure if the MDN is not received within a specified duration. The default duration is 

7200 minutes (5 days), but you can change this setting on the AS2 Outbound tab, in the Asynchronous 

receipt timeout box. 

 An AS2 Outbound Transaction Succeeded event occurs after the Server has successfully offloaded a file to 

a remote partner and, if a receipt was requested, a valid receipt was received that indicates the transfer 

was successfully completed.  

 An AS2 Outbound Transaction Failed event occurs if the Server has failed to offload a file to a remote 

partner, an MDN receipt sent by the Server was not received in the specified duration, or the receipt 

signature or MIC failed.  

http://www.drummondgroup.com/
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The Server sends e-mails and executes commands only after the final transaction status (Failure or Success) is 

known. The success or failure to receive the MDN is stored in the database and can be viewed in reports and AS2 

Transactions node. 

How EFT Server determines failed AS2 transmissions 

AS2 transfers may have more than a simple success or failure outcome. For example, an outbound AS2 file transfer 

may succeed, but no MDN received from the remote host. This could be considered an outright failure in some 

cases. Another example of a failure is when a file is successfully sent, but the received MDN’s signature cannot be 

verified. Not all AS2 systems consider these partial failures an overall failure. For example, a remote host may 

accept an inbound file even though its signature was bad or had other issues, yet still accept the file.  

The Server accepts most AS2 transmissions, even if there is a MIC mismatch or the signature used to sign the 

payload was not found. However, the overall transaction is not considered a success unless every part of the 

transmission succeeds. That is, the Server's acceptance of the transmission does not mean that the transmission 

was successful.  

The Server's implementation of AS2 considers the following transmissions permanent failures: 

 An inbound unencrypted transmission over plaintext HTTP protocol 

 An upload attempt to a folder to which the user does not have write permission 

In each of these situations, the transmission is rejected automatically. An error is returned to the client, audited to 

the database, and can trigger an AS2 transaction failure event, if configured. 

Redirecting AS2 transfers from HTTP to HTTPS 

You can configure the Server to redirect HTTP connections to HTTPS. The redirect HTTP to HTTPS option affects 

incoming AS2 requests through HTTP. When you have configured redirection, the Server simply tells the 

connecting client that the resource was moved to the new HTTPS URL. The connecting client decides whether it 

will allow the redirect, because the new URL could be on different server. If the connecting AS2 client does not 

allow redirection to a different port, the connection will fail.  

INSTALLING AND ACTIVATING THE AS2 MODULE 

The AS2 module is installed when you install the Server and is available to evaluate during the Server trial; 

however, the AS2 module is disabled by default. The AS2 module requires a unique serial number for activation. If 

you have purchased a license for the module, you can provide the module's serial number in the Administrator 

after installation. When the Server trial expires, the AS2 module trial also expires.  

PREREQUISITES FOR USING THE AS2 MODULE 

 You must have more than the minimum required RAM if you are transferring large non-EDI files over 

AS2. Additional RAM could be required for high-density, non-EDI file transfers over the AS2 protocol. 

For example, on a Server with 2GB of system memory, the cumulative size of all files being sent or 

received from/to that AS2 client at one time must not exceed roughly 800MB. Each time a file transfer 

starts, the Server's AS2 module must reserve a slice of memory for that file. The reserved memory is not 

released until the transfer is complete. If the reserved memory is more than what is available, the 

operating system (Windows) resorts to using the hard disk cache, which is much slower than RAM and can 

drastically reduce the Server performance.  

 



EFT Server™ version 6 

 

538  

 You must have .NET installed and configured. During installation, EFT Server determines whether version 

2.0 or newer of the .NET framework is installed, and if not installed, prompts you to install it.  

o If a message appears that says Microsoft .NET framework is not properly installed, run the 

ASP.NET IIS Registration Tool, a utility that comes packaged with the .Net Framework, to register 

.NET with IIS. The file, by default stored in C:\WINDOWS\Microsoft.NET\Framework\<version>, 

is called aspnet_regiis.exe and you must pass in the "-i" parameter. 

To run the ASP.NET Registration Tool 

1. At command prompt, change to the directory that contains the executable. For 

example, type: 
 

cd C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727  

2. Type the following, then press ENTER: 
 

aspnet_regiis.exe -i  

 

ASP.NET is installed and registered. 

For more information about the ASP.NET IIS Registration Tool, refer to 

http://msdn2.microsoft.com/en-us/library/k6h9cz8h(VS.80).aspx.  

 You must have the Auditing and Reporting module installed. The installer updates the ARM database 

with AS2 tables; however, if you are using a SQL database, you will have to update your table 

schema manually. If the ARM database fails, AS2 functionality is not available. If ARM is not 

installed/configured, the AS2 module sees that as a database failure. If the database is unavailable, the 

current transaction will fail, but subsequent transactions will succeed (provided the database becomes 

available again).   

IF THE AS2 MODULE IS NOT ACTIVATED AND THE TRIAL HAS EXPIRED 

If the AS2 module is not activated, the following events occur when the AS2 module trial has expired: 

 All incoming AS2 connections are rejected and ARM audits the failure in the ARM database as "AS2 

evaluation license expired." 

 Any Event Rule that contains an AS2 Send File to host Action will not fire, the If Failed Action triggers, and 

ARM audits the outbound failure in the ARM database as "AS2 evaluation license expired."  

 All Enable AS2 over HTTP/S check boxes are grayed out (disabled) and cannot be selected or cleared. 

 The AS2 Inbound tab, AS2 Outbound tab, and AS2 Transactions node are replaced with a blank screen 

and the following text:  

The AS2 evaluation period has expired. Please contact your GlobalSCAPE account representative for an 

activation key. 

 The AS2 Send File to host Action is no longer available for Event Rules.  

When the GlobalSCAPE Server service starts, EFT Server determines whether the AS2 module evaluation has 

expired. If it has, the Server logs the following message to the Windows Application Event log: "the Server: AS2 

protocol module evaluation license expired." 

http://msdn2.microsoft.com/en-us/netframework/default.aspx
http://msdn2.microsoft.com/en-us/library/k6h9cz8h(VS.80).aspx
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CONFIGURING THE AS2 MODULE 

Configuring the AS2 module involves enabling AS2 on the Site as an allowed protocol, specifying the Server's AS2 

identifier and certificate path, and defining AS2 trading partners (user accounts).  

ENABLING THE AS2 INBOUND LISTENER SERVICE 

You can configure the Server as an AS2 Receiver by allowing incoming transactions over the AS2 protocol and 

providing your AS2 Identifier and encryption and signing certificates to your trading partners. Your trading partners 

need this information to be able to share files over AS2.  

When you configure a new Site, the Site Setup wizard provides options for configuring the protocol. After a Site is 

created, you can enable AS2 by selecting the AS2 check box on the Site's Connections tab. You can enable or 

disable AS2 for partner (user) accounts on the Settings Template or for a partner account, or by selecting AS2 in 

the New User Creation wizard on the protocol selection page when you create the partner account.  

To enable the AS2 inbound listener service, you will need to provide the following information: 

 AS2 identifier. There is no standard for the AS2 Identifier. You can use your name, your company's name, 

or some other unique name. The Server validates the AS2 identifier to determine whether it is unique (not 

used by another partner on this the Server). If you type an ID that is not unique, the field resets to blank. 

The Server's AS2 Identifier can be overridden per account (partner); however, if you change the Server's 

AS2 Identifier, partners will not be able to connect to you until they update the Server's AS2 identifier on 

their systems.  

 AS2 certificate path for signing/encryption, populated by default with the SSL certificate paths (if present) 

for the Server SSL communications. If the SSL certificate does not already exist, you can create one from 

within the AS2 Server Configuration dialog box. 

If you attempt to apply changes, navigate away from the Connections tab, or click OK in the Configuration 

dialog box when AS2 is enabled and no certificate path has been defined, the Server displays an error 

message. (You can click Cancel to close the dialog box without making changes.) 

 

EFT Server does not allow certificate files with a .p* (e.g., pfx, p12) extension. The .p* extension indicates that 
it is a combined certificate that includes both the public and private keys, giving clients access to the private 
key. As a security best practice, use separate public/private keys. Create your certificates using the Server's 
Certificate wizard or refer to Knowledge Base article Q10401 - HOWTO: Using OpenSSL to Generate/Convert 
Keys and Certificates for the procedure for using the OpenSSL command-line tool to generate and convert 
private keys and public certificates. 

To enable the AS2 inbound listener service 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the Site that you want to configure. 

3. In the right pane, click the Connections tab. 

http://kb.globalscape.com/article.aspx?id=10401&query=certificate
http://kb.globalscape.com/article.aspx?id=10401&query=certificate
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4. Select the AS2 check box, then click AS2 Config. (The check box is disabled if the HTTP or HTTPS check 

boxes are not selected.) The AS2 Setup Wizard appears.  

 

5. Read the Welcome page, then click Next. The AS2 identifier page appears. 
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6. In the Your AS2 Identifier box, type the name by which you are to be identified to trading partners, then 

click Next.  

There is no standard for the AS2 Identifier. You can use your name, your company's name, or some other 

unique name. The Server validates the AS2 identifier to determine whether it is unique (not used by 

another partner on this the Server). If you type an ID that is not unique, the field resets to blank. 

The Certificate page appears. 

 

7. Do one of the following: 

 If you do not yet have a certificate defined, click create. The Create certificate wizard appears. 

a. Follow the prompts in the wizard to create the certificate. 

b. Click Finish. The Certificate file path, Private key file path, and Private key Passphrase 

boxes are completed with the location and file names of the created certificate. (The 

passphrase box displays asterisks.) 
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 If you already have a certificate or want to specify a different certificate than the one displayed, 

specify its location and passphrase as described below: 

a. In the Certificate file path box, type the path or click the open icon   to select the file. 

b. In the Private key file path box, type the path or click the open icon   to select the 

file. 

c. In the Private key passphrase box, type the path or click the open icon   to select the 

file. 

 

The Server warns you if a file with extension .p* (e.g., pfx, p12) is specified. The .p* 
extension indicates a combined certificate that includes both the public and private 
keys, giving your users access to the private key. As a security best practice, use 
separate public/private keys.  

8. Click Next. The AS2 portal Web URL page appears.  

 

9. The AS2 portal Web URL can be provided to trading partners so that they can obtain the Server's AS2 

identifier and certificate public key to configure AS2 transfers with the Server.  

10. To save the URL to paste into your website or e-mail, click Copy to clipboard, then click Next. The final 

page of the wizard appears. 
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11. Review the Next steps, then click Finish to save the configuration and close the dialog box. 

12. Click Apply to save the changes on the Server. 

Refer to the topics below for more information regarding configuring AS2 partners and transfers. 

AS2 CERTIFICATES 

For security, the Server does not allow you to use a certificate file with a .p* (e.g., pfx, p12) extension. The .p* 

extension indicates that it is a combined certificate that includes both the public and private keys, giving clients 

access to the private key. You can create certificate files using the Server's Certificate wizard. If you have a 

combined certificate from a third party, use the procedure in Exporting a Certificate from PFX to PEM to extract 

the public key. 

When you import your partner's AS2 certificate (on the AS2 Inbound tab or in the configuration wizard), it must 

have a .pem, .cer, or .crt  extension. 

CONFIGURING AS2 PARTNERS 

The Server’s AS2 module allows you to setup AS2 partner profiles as user accounts. The profile includes all 

necessary information for AS2 connectivity, including a hot folder that can trigger an event when a file is added 

using the AS2 profile and send the data that was added. This partner-provisioning  orientation associates AS2 

transactions directly to a user profile, rather than to an event trigger for which you would have to specify the user 

as a Condition of an Event Rule. 

For these user (partner) accounts, the AS2 Outbound and AS2 Inbound tabs provide the ability to specify an AS2 

inbound and outbound policy (parameters) for the selected partner (user). Your trading partners must provide you 

with the public key of their certificate and their AS2 Identifier. 

You can create the accounts manually on the user account tabs or use the AS2 Partner Access wizard to define 

trading partners with detailed instructions. If you want to configure an AS2 trading partner manually, you first 

create or determine the Settings Template under which to define the account, create the user account (refer to 

Configuring Users and Settings Templates), then configure the AS2-specific parameters of the account. (Refer to 

the Related Topics below for the procedures.)  
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EDITING AS2 PARTNER PROFILES 

 If you use AD, LDAP, or ODBC authentication and using accounts as AS2 partners, if the account in the 

external database is changed, deleted, or disabled, any Event Rule or Command that references the 

account will fail. For example, if the AD account SSmith is renamed SJones, you will have to manually 

update any Event Rule or Command to reflect the new name of the account. 

 If you are using GlobalSCAPE authentication and change an account, the Event Rules and Commands that 

reference the account will also update; however, if you delete or disable the account, or disallow use of 

AS2 for the account, any Event Rule or Command that references the account will fail. In this case, you 

should disable or delete the Event Rule, or change the AS2 partner information to an existing/enabled 

account. 

CONFIGURING AS2 OUTBOUND PARTNERS USING THE WIZARD 

The Server provides an AS2 Partner Access wizard to assist you in configuring AS2 outbound connections. This 

wizard is accessible from the AS2 Outbound partner configuration tab and the AS2 Send File to host Action dialog 

box (in Event Rules). Once completed, the data in the wizard populates the relevant fields on the AS2 Outbound 

tab and the AS2 Send File to host Action dialog box. The procedure below describes how to use the wizard to 

configure outbound AS2 partners. You can also configure the account manually on the AS2 Outbound tabs for each 

partner. 

 

If you plan to execute a command  upon success or failure of AS2 transactions, define the command before 
configuring your partner access; or you can go back later and edit the AS2 partner manually after you have 
defined the command. 
 
If you plan to send a notification e-mail upon success or failure of AS2 transactions, you can Create an e-mail 
Notification Template to use in the e-mail Action. 

To configure outbound AS2 partners using the wizard 

1. In the Administrator, connect to the Server and click the Server tab. 

2. Do one of the following: 

 In the left pane, click the user account that you want to configure, then in the right pane, select 

the AS2 check box and then click AS2 Outbound. 

 In an Event Rule, after adding the AS2 send file to host action to a Rule, click select. The AS2 

Send File dialog box appears.   
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3. Click Setup Wizard. The AS2 Partner Outbound Wizard appears.  
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4. Click Next. The AS2 partner connection information page appears. 
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a. In the Partner host address or domain area specify the protocol to use (http:// or https://), IP 

address/domain name, and Port number used to connect to the AS2 partner. (Some large 

organizations post their AS2 connection information online, such as the Vendor Directory at 

http://www.ec-bp.biz/joomla/component/option,com_wrapper/Itemid,100/.)  

b. In the Remote path area, provide the path to the inbox or mailbox at the AS2 partner location. 

c. In the Username and Password boxes, provide the logon credentials. 

d. If you need to configure a proxy server, click Proxy and then refer to Configuring an AS2 

Outbound Proxy for the procedure, if necessary. 

5. Click Next. The AS2 certificates page appears. 

http://www.ec-bp.biz/joomla/component/option%2ccom_wrapper/Itemid%2c100/
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a. In the Your AS2 certificate public key box, the certificate that you specified when you created 

the Site appears. 

b. In the Your partner's AS2 certificate public key box, type the path or click the open icon to select 

your partner's public key file. 

6. Click Next. The AS2 identifier page appears. 
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a. In the Your AS2 ID (AS2-From) box, your globally defined ID appears. You can use the same ID 

you defined for EFT Server when you enabled the AS2 inbound listener or you can define a 

different ID for each partner.  

b. In the Your partner’s AS2 ID (AS2-To) box, specify this partner's ID (provided to you by the 

partner that you are defining).  

 

AS2-From and AS2-To form a pair for identifying the sending and receiving partnership. 
That is, they form a composite key for identifying the parties involved in the data exchange. 

c. (Optional) In the Message subject box, specify the text that is to appear in the subject line of AS2 

messages to/from this partner. 

d. In the Content type box, click the list to specify the type of messages to be sent to/from this 

partner. 

 Application 

 EDIFACT 

 XML 

 Mutually defined EDI 

 Binary (default)- e.g., executables, word processing files, database, spreadsheet, and 

multimedia files  

 Plaintext - e.g., text and HTML files 
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For information about the various content types, refer to RFC 2046 at 
http://www.ietf.org/rfc/rfc2046.txt. 

7. Click Next. The message and receipt options page appears. 

 

a. In the Message options area, select or clear the check boxes depending on whether the AS2 

message should be encrypted, signed, and/or compressed.  

b. In the Receipt options area, click the list to specify whether to send a Signed receipt (Message 

Disposition Notification (MDN)), an Unsigned receipt, or no receipt (None).  

 

The MDN serves as a receipt, guaranteeing the transaction was successful. The receipt can also 

be signed, and you can specify whether to return the receipt immediately (synchronous MDN) or 

later (asynchronous MDN) if the remote Server must post-process the message prior to 

acknowledging the received data. 

c. If you clicked Signed or Unsigned (not None), specify whether to send the receipt in the same 

session (synchronous) or independently of the session (asynchronous). 

8. Click Next. The message retry and timeout options page appears. 

http://www.ietf.org/rfc/rfc2046.txt
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 (Optional) EFT Server can attempt to resubmit failed messages in case of network outage or 

other temporary (transitive) errors. EFT Server will resend the same message, payload, and AS2 

Message ID. Specify the following retry and timeout values as needed: 

o Message send attempt timeout (seconds). The range is 0-600; 0 = no timeout; the 

default value = 60 seconds. 

o Message retry attempts. The range is 0-9999; (0 = no retry); the default value = 3 

retries. 

o Delay between retries (seconds). The range is 0-9999; (0 = no wait); the default value = 

30 seconds. 

o Asynchronous receipt timeout (minutes). The range is 0-999,999; (0 = no timeout); the 

default value = 7200 minutes (5 days). (This option does not appear if you specified 

synchronous on the previous page.) 

9. Click Next. The commands and notifications page appears. 

10. Click Next. The Test Connection page appears. 
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a. Click Test Connection. The AS2 Test Connection dialog box appears.  

 

b. EFT Server attempts to connect to the AS2 partner and send test data.  

 If the test fails, data appears in the AS2 connection log area that you can copy to the clipboard to 

be pasted in a text file or e-mail for troubleshooting. Click Close, then in the wizard click Back to 

adjust settings, if necessary.  
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 If the test is successful, click Close. 

11. Click Finish. The information provided in the wizard is updated in the account's AS2 Outbound tab. To 

make further adjustments to the partner's configuration, you can edit the AS2 Outbound tab directly. 

CONFIGURING AS2 INBOUND PARTNERS USING THE WIZARD 

The Server provides an AS2 Partner Access wizard to assist you in configuring AS2 inbound connections. This 

wizard is accessible from the AS2 Inbound partner configuration tab and the AS2 Send File to host Action dialog 

box (in Event Rules). Once completed, the data in the wizard populates the relevant fields on the AS2 Inbound tab 

and the AS2 Send File to host Action dialog box. The procedure below describes how to use the wizard to 

configure inbound AS2 partners. You can also configure the account manually on the AS2 Inbound tab for each 

partner. 

 

If you plan to execute a command  upon success or failure of AS2 transactions, define the command before 
configuring your partner access; or you can go back later and edit the AS2 partner manually after you have 
defined the command. 
 
If you plan to send a notification e-mail upon success or failure of AS2 transactions, you can Create an e-mail 
Notification Template to use in the e-mail Action. 

To configure inbound AS2 partners using the wizard 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user account that you want to configure.  

3. In the right pane, click the Connections tab. 

 

4. Select the AS2 check box and then click AS2 Inbound. 

5. Click Setup Wizard. The AS2 Partner Inbound Wizard appears.  
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6. Click Next. The AS2 certificates page appears. 
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a. In the Your AS2 certificate public key box, the certificate that you specified when you created the 

Site appears. 

b. In the Your partner's AS2 certificate public key box, type the path or click the open icon to select 

your partner's public key file. 

7. Click Next. The AS2 identifier page appears. 
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a. In the Your AS2 ID (AS2-To) box, your globally defined ID appears. You can use the same ID you 

defined for EFT Server when you enabled the AS2 inbound listener or you can define a different 

ID for each partner.  

b. In the Your partner’s AS2 ID (AS2-From) box, specify this partner's ID (provided to you by the 

partner that you are defining).  

 

AS2-From and AS2-To form a pair for identifying the sending and receiving partnership. 
That is, they form a composite key for identifying the parties involved in the data exchange. 

8. Click Next. The tolerance options page appears. 
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 (Optional) When a duplicate message ID is identical in all regards to a previous message, 

including a duplicate payload, EFT Server will ignore it and reject the transaction. You can tell EFT 

Server to accept or reject duplicate message IDs with unique contents, unique message IDs with 

duplicate contents, and mismatched AS2-From or AS2-To identifiers. For each option, the default 

is to reject the transaction. Specify whether to Accept or Reject messages in each of the 

following instances: 

o Duplicate Message ID (with different contents) 

o Duplicate content (with different Message ID) 

o Mismatch AS2-From identifier 

o Mismatch AS2-To identifier 

9. Click Next. The resend options page appears.  
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10. Specify whether EFT Server will attempt to resend failed asynchronous MDN in case of network outage or 

other temporary (transitive) errors.  

o Receipt (MDN) send timeout (seconds). Range: 0-600; (0 = no timeout); the default value = 60 

seconds 

o Receipt (MDN) retry. Range: 0-999; (0 = no retry); the default value = 3 retries. 

o Delay between retries (seconds). Range: 0-600; (0 = no wait); the default value = 30 seconds. 

11. Click Next. The commands and notifications page appears. 
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 (Optional) EFT Server can run predefined commands (such as launch a script) or send an e-mail 

notification upon successful or failed transactions (after all retries have been exhausted or failed 

to receive the MDN receipt after the specified wait time). Select one or more of the following 

check boxes, then click Edit to configure the e-mail notification  or specify the Command to use.  

o Send e-mail notification on transaction success 

o Send e-mail notification on transaction failure 

o Run command on transaction success 

o Run command on transaction failure 

 Refer to AS2 Transaction Success and Failure Notifications for more information. 

12. Click Next. The optional post receipts page appears. 
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 (Optional) In the Move received file(s) to folder box, specify a location to move received files, 

including local, shared, or UNC path names. (Leave blank to not move the file.) 

 In the Rename file(s) using mask box, provide a name for the file, if you want to change it. (The 

variable %FS.FILE_NAME% appears in the box by default.) 

 

You can keep the existing filename or use EFT Server’s extensive variable selection to rename the 

file, and add pre- or post-pending dates, times, and other information. For example, if you want 

to add the date and time to the filename, you would provide the following variables in the 

Rename file(s) using mask box: 
 

%FS.FILE_NAME%_%EVENT.DATESTAMP%_%EVENT.TIMESTAMP%  

13. Click Next. Configuration is complete. 
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14. Click Finish. Now that you have completed the AS2 inbound partner configuration wizard, you should 

contact your partner and ask them to connect and transfer a test file. Refer to Troubleshooting AS2 

Connections for details. 

The information provided in the wizard is updated in the account's AS2 Inbound tab. To make further adjustments 

to the partner's configuration, you can edit the AS2 Inbound tab directly. 

AS2 INBOUND PARAMETERS 

For AS2 inbound (receiver) connections for transactions over the HTTP and HTTPS ports, enable AS2 by selecting 

the AS2 check box on the Site's Connections tab. You can enable or disable AS2 for partner (user) accounts at the 

Settings Template or the user level, or by selecting AS2 in the New User Creation wizard on the protocol selection 

page when you create the partner account. The standard inheritance rules apply. (AS2 has to be enabled and 

configured at the Site level before you can enable it for a Settings Template or user account.) 

The parameters in the table below are available on the AS2 Inbound tab and can be configured manually or using 

the AS2 Partner Access Wizard. 

 Click Setup Wizard to Configure AS2 Inbound Partners Using the Wizard. 

 Click Clear All to reset all of the fields to default values. (A confirmation prompt appears.) 
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Parameter 
Required/ 
Optional 

Description 

Your certificate Required Displays the AS2 certificate public key path to be used for signing the MDN and for 
decryption, copied from the Site. (Can be on a drive or UNC path.) 

Partner certificate Required Specifies the AS2 certificate to be used for verifying signed messages. (Can be on a 
drive or UNC path.) 

Your AS2 identifier Required  Used to apply a unique AS2-To ID that the Server will accept from this partner’s 
inbound messages. Copied from the Site-wide the Server AS2 ID at the time the user 
is created, but NOT inherited or changed from that point forward unless the 
administrator makes explicit changes to the user settings. 

Partner AS2 identifier Required Used to identify the AS2-From ID for inbound messages emanating from his partner. 

Partner AS2 identifier 
mismatch policy 

Required Used to accept or reject AS2 transactions where the connecting partner’s AS2-From 
ID does not match the AS2 identifier defined for that partner. 

 Reject (default) - Disallow the transaction 

 Accept - Allow the transaction 

the Server AS2 identifier 
mismatch policy 

Required Used to accept or reject AS2 transactions where the connecting partner’s AS2-To ID 
does not match the Server AS2 identifier defined for that partner in that partner’s AS2 
Inbound tab. 

 Reject (default) - Disallow the transaction 

 Accept - Allow the transaction 

Duplicate Message ID 
with different contents 

Required Used to Accept or Reject AS2 transactions with duplicate Message IDs.  

 If an incoming request has the same Message ID and the same payload as a 
prior incoming message, the Server sends the exact same response from 
that prior transaction back to the client, and does not extract or process the 
payload (that is, discards the payload, does not save to file system, does not 
trigger Event Rules, etc.).  

 If an incoming request has the same Message ID, but the payload is 
different, the Server processes or discards the message based on the 
configuration provided by the user.  

Options include: 

 Reject (default) - Disallow the transaction 

 Accept - Allow the transaction 

Duplicate Contents with 
different Message ID 

Required Used to overwrite or reject AS2 transactions where the file is a duplicate of an existing 
file already residing in the upload directory. 

 Reject (default) - Disallow the transaction 

 Overwrite - Overwrite the existing file with the new version 

 Numerate - Add a unique number to the filename 

MDN send attempt 
timeout (seconds) 

Required Specifies the timeout period after which an asynchronous MDN send attempt shall be 
considered a failure if no response is received from the remote server. Range: 0-600, 
60 seconds is the default. 0 = no timeout. 

MDN send attempt 
retries 

Optional Number of time to attempt to send MDN. Range: 0 (no retry) to 999; 10 is the default. 

 

Retries do not include the initial attempt. That is, 10 retries means 10 in 
addition to the first attempt (11 total). 

 

MDN send attempt delay 
between retries 
(seconds) 

Optional Retry interval. Range: 0 (no wait) to - 600 seconds; 30 seconds is the default 

 

Failure only occurs after all attempts to send MDN have failed. Likewise, success 
is only after complete transaction has occurred (file received and MDN is sent). 

 

Transaction FAILED Optional Opens the Edit Mail Template in which you can specify an e-mail notification for 
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Parameter 
Required/ 
Optional 

Description 

notification e-mail* failed transaction. (Refer to e-mail Notification Action for details of defining an e-mail 
notification.) 

Transaction SUCCESS 
notification e-mail* 

Optional Opens the Edit Mail Template in which you can specify an e-mail notification for 
successful transaction. (Refer to e-mail Notification Action for details of defining an e-
mail notification.) 

Transaction FAILED send 
command* 

Optional Opens the Custom Command dialog box in which you can specify a Custom Command 
to occur upon failed send. (Refer to Creating a Command to create a command and 
refer to Using an Event Rule to Execute a Command (Run a Process) for details of 
using a Command.) 

Transaction SUCCESS run 
command* 

Optional Opens the Custom Command dialog box in which you can specify a Custom 
Command to occur upon successful run. (Refer to Creating a Command to create a 
command and refer to Using an Event Rule to Execute a Command (Run a Process) for 
details of using a Command.) 

Move received data to 
folder 

Optional Specify a folder in which to save received data. (Can be on a drive or UNC path.) 

Rename file(s) to Optional Appends filename to path using specified variables. Preserve filename if undefined. 

 

This parameter is the same as the Specify relative path and filename field in the 
Target File tab of the Offload Action wizard in the Server’s Copy/Move File to 
Host Action. 

 

* The Server sends e-mails and executes commands only after the final transaction status (Failure or Success) is 

known. 

AS2 OUTBOUND (SENDER) PARAMETERS 

For AS2 outbound (sender) connections for transactions over the HTTP and HTTPS ports, enable AS2 by selecting 

the AS2 check box on the Site's Connections tab. You can enable or disable AS2 at the Settings Template and/or 

the user level, or by selecting AS2 in the New User Creation wizard on the protocol selection page when you create 

the user. The standard inheritance rules apply. (AS2 has to be enabled and configured at the Site level before you 

can enable it for a Settings Template or user account.) 

The parameters in the table below are available on the AS2 Outbound tab and can be configured manually or using 

the AS2 Partner Access Wizard. 

 Click Setup Wizard to Configure AS2 Outbound Partners Using the Wizard. 

 Click Clear All to reset all of the fields to default values. (A confirmation prompt appears.) 

 Click Test to Test the connection to the partner. 

 Click Proxy to launch the Proxy Settings dialog box. You can use DMZ Gateway or an HTTP proxy. 
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Parameter 
Required/ 
Optional Description 

Monitored hot folder Optional Specifies the monitored folder for added files. If no folder is specified, no folder 
monitoring occurs; however, the partner profile can be invoked from the Event Rules. 
(Can be on a drive or UNC path.) 

File include mask Optional Used to include files based on their extension for sending to the destination to the 
partner’s remote AS2 host. For example, include only .txt files. Defaults to asterisk (*) to 
include all files. Blank also means include all files. Accepts wildcard masks; semicolon or 
comma delimited. 

File exclude mask Optional Used to exclude files based on their extension from sending to the destination to the 
partner’s remote AS2 host. For example, exclude .txt files. Defaults to blank, which means 
exclude no files. Accepts wildcard masks, semicolon or comma delimited. 

Delete source after 
successful offload 
(MDN received) 

Required Used to delete sources files after sending them to the destination, after the MDN is 
received and verified from the remote AS2 host. Selected by default. 

Host address Required AS2 Outbound host address. Requires protocol prefix in URL (http:// or https://). 
Specified in AS2 Partner Access wizard. 

Port Required AS2 Outbound port. Range is 1-65K; defaults to 80 if host address is preceded by http; 
443 if host address is preceded by https.  

Mailbox path Optional Relative path to the remote directory, such as, /partnerXYZ, /partners/mailboxes/xyz, or 
/192.168.20.16/path  

Username Optional  User login name 

Password Optional Password 

Message subject Optional AS2 message subject  

Content type Required AS2 content type. Options include: 

 Application for ANSI X12 (application/EDI-X12) 

 EDIFACT (application/EDIFACT) 

 XML 

 Mutually defined EDI (application/EDI-Consent) 

 Binary (default)- e.g., executables, word processing files, database, spreadsheet, 
and multimedia files  

 Plaintext - e.g., text, HTML, XML files 

 

For information about the various content types, refer to RFC 2046 at 
http://www.ietf.org/rfc/rfc2046.txt. 

 

Compress message Required When selected, specifies that the AS2 message should be compressed when sent. 
(Cleared by default.) 

Encrypt message Required When selected, specifies that outbound AS2 messages should be encrypted. (Selected by 
default.) 

Sign message Required When selected, specifies that outbound AS2 messages should be signed. (Selected by 
default.) 

Your certificate Required Displays the AS2 certificate public key path to use for signing, copied from the Site. (Can 
be on a drive or UNC path.) 

Partner certificate Required Specifies the AS2 certificate to use for encrypting outbound transactions and for 
validating signed MDN receipts. (Can be on a drive or UNC path.) 

Your AS2 identifier Required  Used to apply a unique AS2-From ID to outbound messages.  

Partner AS2 identifier Required Used to apply a unique AS2-To ID to outbound messages. 

http://www.ietf.org/rfc/rfc2046.txt
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Parameter 
Required/ 
Optional Description 

Receipt policy Required Used to request an MDN receipt. Options include: 

 Don’t request a receipt 

 Request a signed receipt (default) 

 Request an unsigned receipt 

Receipt delivery Required Specifies receipt delivery method 

 Synchronous (default) 

 Asynchronous (see Asynchronous receipt timeout, below) 

The following fields are used to determine whether a message send attempt has failed due to a timeout, error, or 
synchronous MDN receipt failure, or other error, after which the Server will attempt to resend the same message 
at regular intervals, if specified. Because the Server is sending the same content, it will resend the same message, 
payload, and AS2 Message ID.  

Parameter 
Required/ 
Optional Description 

Message send 
attempt timeout 
(seconds) 

Optional Specifies the timeout after which a message send attempt is considered a failure if no 
response or error is received from the remote server. Range: 0-600, 60 by default, 0 means 
no timeout 

Message send 
attempt retries 

Optional Number of times to reattempt to send the message. Range: 0 (no retry) to 999, 10 is the 
default. 

 

Retries do not include the initial attempt. That is, 10 retries means 10 in 
addition to the first attempt (11 total). 

 

Send attempt delay 
between retries  

Optional Interval between resend attempts. Range: 0 (no wait) to - 600 seconds; 30 seconds is the 
default 

Asynchronous 
receipt timeout  

Optional Specifies the timeout after which EFT Server determines whether an asynchronous receipt 
was received. Range: 0 (no timeout) to 999,999 minutes; 7200 minutes (5 days) is the 
default. 

 

If the MDN is received after the timeout expires, the MDN is discarded, the 
Server returns an HTTP error code to the sender, and triggers the transaction 
failure event, if defined. 

 

Transaction FAILED 
notification e-mail*  

Optional Opens the Edit Mail Template in which you can specify an e-mail notification for failed 
transaction. (Refer to e-mail Notification Action for details of defining an e-mail 
notification.) 

Transaction 
SUCCESS 
notification e-mail*  

Optional Opens the Edit Mail Template in which you can specify an e-mail notification for successful 
transaction. (Refer to e-mail Notification Action for details of defining an e-mail 
notification.) 

Transaction FAILED 
send command*  

Optional Opens the Custom Command dialog box in which you can specify a Custom Command to 
occur upon failed send. (Refer to Creating a Command to create a command and refer to 
Using an Event Rule to Execute a Command (Run a Process) for details of using a 
Command.) 

Transaction 
SUCCESS run 
command*  

Optional Opens the Custom Command dialog box in which you can specify a Custom Command to 
occur upon successful send. (Refer to Creating a Command to create a command and refer 
to Using an Event Rule to Execute a Command (Run a Process) for details of using a 
Command.) 

* The Server sends e-mails and executes commands only after the final transaction status (Failure or Success) is 

known. 
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CONFIGURING AN AS2 OUTBOUND PROXY 

If you need to configure a proxy server for outbound AS2 transmissions, the option is available on the AS2 

Outbound tab. 

To configure an outbound proxy 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user (trading partner) you want to configure. 

3. In the right pane, click the Connections tab. 

 

4. Click AS2 Outbound. The AS2 Outbound Settings dialog box appears. 
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5. Click Proxy. The Proxy Settings dialog box appears. 
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6. Select the Use proxy settings below when connecting to remote host check box. The Proxy type options 

become available. 

7. Click one of the following: 

 Use EFT Server's DMZ Gateway as the proxy to use DMZ Gateway 

 HTTP proxy to use another proxy via HTTP, and specify the Host name, Port, Username, and 

Password. 

8. Click OK to save the settings and return to the AS2 Outbound tab. 

9. Click Apply. 

INITIATING AS2 OUTBOUND TRANSACTIONS 

The Server’s AS2 module provides the ability to initiate outbound AS2 transactions as an AS2 client; that is, an AS2 

Sender. The Server provides two methods for initiating AS2 outbound transactions, described below: 

 Partner provisioning method. A Folder Monitor  event trigger mapped directly to a user account’s 

(trading partner's) AS2 profile can monitor a specified folder for files added and, when triggered, send 

those files to the specified partner AS2 profile. This event is neither visible nor editable in the Event Rules 

node. 

 Event Rules. The AS2 Send file to host Event Rule Action can be triggered using the Scheduler 

(Timer) event, Folder Monitor event, or any file-based event trigger. When triggered, the AS2 Send file to 

host Action uses the provided configuration data to send the context or manually specified file(s) to the 

specified partner AS2 profile. (Refer to Sending Files to an AS2 Partner via Event Rules for details.) 

To use the Partner Profile method 

1. In the Administrator, connect to the Server and click the Server tab. 

2. Configure a reusable AS2 partner profile. (Create a new user or modify an existing user account.)  

3. In the left pane, click the user (trading partner) you want to configure. 

4. In the right pane, click the Connections tab. 
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5. Click AS2 Outbound. The AS2 Outbound Settings dialog box appears. 

6. In the Monitored hot folder box, click the open icon  to specify a folder that is tied to that partner 

profile/user account (e.g., the user's Home folder). 
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7. Click OK to close the Browse for Folder dialog box. 

8. Click OK to close the AS2 Outbound Settings dialog box. 

9. Click Apply to save the changes on the Server. 

EFT Server verifies whether the selected folder exists and, if not, displays an error message. If a file is added to the 

hot folder, it is immediately sent to the predefined remote AS2 host and (optionally) deleted from the source 

location after a confirmed send (MDN received and verified). This method creates a hidden Folder Monitor Event 

Rule with an "If user is" Conditional statement that triggers an AS2 Send File to host Action when files are added to 

the folder. 
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MOVING FILES RECEIVED FROM AS2 PARTNERS 

You can configure AS2 inbound transfers to move and/or rename files after they are received. These settings, 

combined with setting Duplicate Contents with different Message ID to Reject will prevent received files of the 

same name and extension from being overwritten. 

To move received files 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user (trading partner) you want to configure. 

3. In the right pane, click the Connections tab. 
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4. Click AS2 Inbound. The AS2 Inbound Settings dialog box appears. 

 

5. To specify the folder in which to move all received files, in the Move received data to folder  box, click the 

open icon . The Browse for folder dialog box appears. 

6. Click a folder or click Make New Folder to create a new folder, then click OK. The folder path appears in 

the Move received data to folder box. 

7. Click OK to close the AS2 Inbound Settings dialog box. 

8. Click Apply to save the changes on the Server. 

RENAMING FILES RECEIVED FROM AS2 PARTNERS 

You can configure AS2 inbound transfers to move and/or rename files after they are received. These settings, 

combined with setting Duplicate Contents with different Message ID to Reject will prevent received files of the 

same name and extension from being overwritten. 

To rename received files 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, click the user (trading partner) you want to configure. 
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3. In the right pane, click the Connections tab. 

 

4. Click AS2 Inbound. The AS2 Inbound Settings dialog box appears. 
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5. In the Rename file(s) to box, click in the far right to activate the text box, then provide the characters 

and/or variables with which to change the name of received files. Use %EVENT.DATESTAMP% and 

%EVENT.TIMESTAMP% to add the date and time to the file name. Use %FS.FILE_NAME% for the 

name of the file. For example, if you type: 

%EVENT.DATESTAMP%_%EVENT.TIMESTAMP%_%FS.FILE_NAME% 

A file transferred as dailyprogress.doc  on May 3, 2008 at 10:56:26 would be renamed to 

05032008_105626_dailyprogress.doc. 

6. Click OK to close the AS2 Inbound Settings dialog box. 

7. Click Apply to save the changes on the Server. 
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AS2 ACCOUNT MANAGEMENT WEB PAGE 

The Server provides an AS2 Web page at the reserved path of /as2. On this page, partners can access the following 

information: 

 EFT Server’s public AS2 certificate key (https://localhost/as2/certificate)  

 The Site's AS2 Global Identifier (Refer to Enabling the AS2 Inbound Listener Service for details of 

specifying the AS2 ID.)  

 The destination folder (inbox/mailbox). (The destination folder is the partner's/user's Home Folder, 

configured on the General tab of the partner/user account.)  

 

USING THE AS2 WEB PAGE 

Your trading partners can access the Server's AS2 certificate from the AS2 Account Management page. Provide 

your trading partners with the URL of the page (https://localhost/as2), then instruct them as described below. 

(Instructions are also provided on the Web page.) 

To download the Server's AS2 certificate 

 Do one of the following: 

o Right-click the Download the Server AS2 certificate link, click Save Target As, specify a location 

for the certificate, then click Save. The file is saved as certificate.txt. To use the file for the 

Server, change the extension to .crt. 

o Click the Download link. The certificate contents display in the browser. 
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Copy and paste the contents of the page into your AS2 application's certificate box. (Include 

BEGIN CERTIFICATE and END CERTIFICATE.) 

To open the Destination mailbox 

 

If you select the Treat the home folder as the user's default root folder check box on the Settings 
Template or user level, the partner will be directed to their destination/home folder when they click the 
link on the AS2 Account Management page. If the check box is not selected, they will connect to the 
Site folder (e.g., C:\InetPub\EFTRoot\MySite), and they will have to browse to their home folder. 

 Click the mailbox path next to Destination folder (inbox).  

o If the Web Transfer Client is installed, licensed, and enabled, the Web Transfer Client appears: 

a. In the Remote Filesystem pane, double-click to open the Usr folder (if necessary), then 

click your home folder. 

b. In the Local Filesystem pane, browse for the file to upload, then double-click the file or 

click the right-facing arrow . 

o If the Web Transfer Client is not installed, licensed, or enabled, the HTML Upload form appears: 

a. Click your home folder, then click Upload. The upload bar appears. 

b. Click Browse to find the file to upload to the Server, then click Upload. 
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CUSTOMIZING THE AS2 ACCOUNT MANAGEMENT PAGE 

You can edit the page to provide detailed instructions to new partners, such as where to obtain an AS2 client. The 

Web page is a simple HTML page with a link to a CSS file installed in the Server installation folder (by default, 

as2page.html is in C:\Program Files\GlobalSCAPE\EFT\ and EFTStyles.css is in /EFTClient).  

To customize the AS2 Account Management Web page 

 

Do not attempt to edit the Web page if you are not familiar with editing HTML. 

Incorrectly editing or removing the CSS file will prevent the page from displaying as intended; 
incorrectly editing the HTML file can prevent it from displaying at all. EFTStyles.css affects other the 
Server HTML files that link to that style sheet. 

In the HTML file, avoid editing/removing the links and variables needed to display the information:  

 to display the global identifier <%AS2_IDENTIFIER%>  

 for the path to the Destination folder <a 
href="<%MAILBOX_PATH%>"><%MAILBOX_PATH%></a>  

 for downloading the AS2 certificate <a href="/as2/certificate">  

Test the system with the original files first, then make copies of them before attempting any 
customization. 

1. Make copies of EFTStyles.css and as2page.html.  

2. Keep the copies as back ups and edit the originals: 

 To edit the way the page is displayed (background color, header text, font face/color/size)  

o Edit EFTStyles.css using your favorite text editor.  

 To edit the contents of the page (banner graphic, text)  

o Edit as2page.html using your favorite text editor.  

EXAMPLES OF CSS FILE EDITING 

Cascading Style Sheets (CSS) are used to define the attributes of the tags in your HTML documents. Do not change 

the names of the CSS selectors because they are referenced in the HTML file. Also, do not remove or add curly 

brackets { } (also known as braces), which are used to enclose the properties of each selector. For detailed 

instructions for editing CSS files, refer to http://www.w3.org/MarkUp/Guide/Style. 

For example:  

 To change the colored background or the banner image, edit the body background-color 

property: 

body {  

background-image:url('/EFTClient/header.gif'); 

background-repeat:no-repeat; 

background-color:#6699cc; 

scrollbar-shadow-color:#ffffff; 

-moz-user-select:none 

} 

  

http://www.w3.org/MarkUp/Guide/Style
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 To change the font face, size, or color of the main heading ("EFT Server - AS2"), edit the properties 

(between the curly brackets) of h1. (To change the text content, edit the HTML file.) 

h1 { 

color: #191970; 

font-family: Arial, Verdana, sans-serif; 

font-weight: bold; 

font-size: 14pt; 

text-align: left; 

} 

 

You can view or choose a color number using the Color Picker in most graphic editors.  

The example below shows the color number of the currently selected color. 
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AS2 EVENTS, CONDITIONS, ACTIONS, AND VARIABLES 

The topics below provide information and procedures for defining Event Rules to automate AS2 transfer activities. 

For details of defining Event Rules, refer to Creating Event Rules. 

INTRODUCTION TO AS2 EVENTS, CONDITIONS, ACTIONS, AND VARIABLES 

AS2 transfers can have more than a simple success or failure outcome. For example, an outbound AS2 file transfer 

may succeed, but no MDN received from the remote host. This could be considered an outright failure in some 

cases. Another example may include a successful file send followed by MDN received, but the received MDN’s 

signature cannot be verified. Some AS2 systems do not consider these partial failures as an overall failure, but 

others will. For example, a remote host may accept an inbound file and create a log that its signature was bad or 

had other issues, yet still accept the file. Likewise, EFT Server by default accepts most AS2 transmissions, even if 

there is a MIC mismatch or the signature used to sign the payload was not found; however, the overall transaction 

is not considered a success unless every part of the transmission succeeds.  

EFT Server rejects inbound unencrypted transmissions over plaintext HTTP protocol, and an upload attempt to a 

folder to which the user has no write permissions. The Server considers these permanent failures.  

AS2-RELATED EVENTS 

The following AS2-related events are available in the Server's Event Rule system. (Available in EFT Server 

Enterprise) 

AS2 Inbound Transaction Succeeded - Triggers if the inbound transmission was successful, MDN was successfully 

sent, MICs all match, and no other errors occurred.  

AS2 Inbound Transaction Failed - Triggers if the AS2 file upload failed for some reason, such as bad MIC, no 

permissions/access, duplicate message ID, or other AS2 transfer-related error.  

AS2 Outbound Transaction Succeeded - Triggers if the Server has offloaded a file to a remote partner, and that 

partner replied with a receipt asynchronously over HTTP/S, indicating that the transfer was successfully completed. 

AS2 Outbound Transaction Failed - Triggers if the expected MDN receipt was not received in the expected time or 

the receipt signature or MIC failed.  

 

For details of defining Event Rules, refer to Creating Event Rules. 
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In AS2 Inbound Transaction Verified and AS2 Inbound Transaction Failed Events, the FS.FILE_NAME 
variable contains the name of the file uploaded (for a simple transaction) or an empty string (for an MA 
transaction). 

AS2-RELATED CONDITIONS 

AS2-related Conditions can be added to File Uploaded and AS2 events. (Available in EFT Server Enterprise) 

 

 If AS2 Content Type does/does not equal to [specific AS2 content type]. Tests whether the AS2 content 

matches the specified content type. (Can be applied to the File Uploaded, Upload Failed, and AS2 

events only.) 

1. Add the Condition to a Rule. 

2. In the Rule pane, click [specific AS2 content type]. The Select Content Type dialog box appears. 

3. Click the Select Content Type drop-down list to select a content type (X12, EDIFACT, XML, EDI 

Consent, Binary, Plaintext).  

4. Click OK.  

 If AS2 Partner ID does/does not equal to [specific AS2 Partner ID]. Tests whether the AS2 Partner ID 

matches the specified mask. (Can be applied to the File Uploaded, Upload Failed, and AS2 events only.) 

1. Add the Condition to a Rule.  

2. In the Rule pane, click [specific AS2 Partner ID]. The Select Value dialog box appears. 

3. Click the Select AS2 partner ID drop-down list to select a partner.  

4. Click OK.  

 If Protocol does/does not equal to [AS2]. Tests whether the protocol being used is AS2 (based on HTTP 

header info). After adding the Condition, click the link to specify the protocol. (Can be applied to the File 

Uploaded event only.) 

1. Add the Condition to a Rule. 

2. In the Rule pane, click [ftp/ssl/tls/sftp/http/https/as2]. The Select Connection Protocol dialog 

box appears. 

3. Click the Select Connection Protocol drop-down list to select AS2.  

4. Click OK.  
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AS2-RELATED ACTIONS 

(Available in EFT Server Enterprise) AS2 Send File to host Action for executing outbound AS2 send file transactions 

can be added to Event Rules. (Refer to Sending Files via AS2 Partner without Inbound Access for details of 

configuring this Action.) 

 

The AS2 Send File to host Action is a synchronous event even if asynchronous MDN receipts are requested. 
Synchronous means that the Event Rule executes Actions sequentially from top to bottom; when the Server 
encounters an AS2 outbound action, it performs the transfer, and then if MDN is synchronous, the Server 
waits for the result before moving to the next Action (with success/failure set appropriately). If MDN is 
asynchronous, the Server proceeds to the next Action based only on the HTTP result of the SEND operation, 
NOT the result of the asynchronous MDN receipt. 

The AS2 Send File to host Action is available for the following Events: 

 Folder Monitor 

 Timer 

 All file-based events 

When triggered, the AS2 Send File to host Action offloads one or more user-defined files and one or more context 

files. Depending on the AS2 Send File to host Action’s retry configuration, the Action fails if any error occurs when 

attempting to send the AS2 payload. Those errors may include any connection, authentication, transport, or 

navigation errors; receipting errors or failures; payload errors, including transfer errors or integrity mismatch 

errors or failures; server communicated errors; and unknown or undefined errors, such as: 

 No receipt was provided 

 The receipt was not signed 

 The MIC value returned did not match the original file/message MIC 

 The Server was unable to: 

o verify the receipt signature 

o establish a connection to the remote host  

o upload the file to the remote host  

o send an the receipt asynchronously 

o send the receipt synchronously 

  



EFT Server™ version 6 

 

582  

AS2-RELATED VARIABLES 

AS2-related event variables can help in diagnosing transmission results and for notification purposes. (Available in 

EFT Server Enterprise) 

The following AS2-related variables can be used in Event Rules, e-mail notifications, and Commands. 

Variable Value Contained in Variable 

%AS2.PAYLOAD% Name of the file (or an array of file names if MA is used) being transferred 
over the AS2 session 

%AS2.MDN% Message Disposition Notification 

%AS2.LOCAL_MIC% Local AS2 message identification code (MIC) 

%AS2.REMOTE_MIC% Remote AS2 message identification code (MIC) 

%AS2.MESSAGE_ID% AS2 message identifier 

%AS2.HOST% Address of the host being sent to (outbound) or received from (inbound) 

%AS2.TRANSACTION_ERROR% Error (if any) in the AS2 transaction  

%AS2.TRANSACTION_RESULT%  Overall transaction result (In Progress, Failure, or Success) of the in-
context AS2 transaction 

%AS2.TRANSACTION_VERBOSE% Verbose message for the AS2 transaction 

%AS2.DIRECTION% Direction of the transfer 

%AS2.PARTNER_ID% Transaction partner's AS2 ID 

%AS2.EFT_ID% The Server ID used in this transfer 

%AS2.CONTENT_TYPE% Transfer's content type: Application,  EDIFACT, XML, Mutually defined 
EDI, Binary, Plaintext 

SENDING FILES TO AN AS2 PARTNER VIA EVENT RULES 

(Available in EFT Server Enterprise) You can send files via AS2 to a partner that does not have inbound access 

defined in the Server’s account management system by creating an Event Rule. If the AS2 partner has an outbound 

profile defined, you can select that profile when you define the send options.  

For example, you could define a Rule with a Timer event so that every Monday at 8 a.m., all files in a certain folder 

are sent to a partner that either already has a profile defined on the Server or that you will define "on the fly" in 

the AS2 Send File dialog box.  

The AS2 Send File to host Action can be used for Folder Monitor, Timer, and all file-based events. (Refer to AS2-

Related Actions for more information about the AS2 Send file to host Action.)  

To send files to AS2 partners 

1. Create a new Event Rule, such as a Scheduler (Timer) Event . (Refer to Creating Event Rules for details of 

creating Event Rules, if necessary.) 

2. Add the AS2 Send file to host Action to the Rule, then click one of the blue underlined text links. The AS2 

Send File dialog box appears. 
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3. In the File(s) to upload box, type the path or click the open icon  to specify the file to send to this 

partner. Include the entire path to the file. You can also use File System variables such as %FS.PATH% and 

wildcards. For example, to send all files in a folder, type the folder path and *.*. (The files will not be sent 

all at once; each file will have a unique message ID.)  

4. In the Partner Configuration area, specify the AS2 Partner profile using one of the following methods: 

 In the Partner profile box, select a defined  AS2 outbound partner profile. The fields in the AS2 

connection details area is completed automatically.  

 Provide the connection details in the AS2 connection details area. (Refer to AS2 Send File Dialog 

Box for details of each field.) 

 Click Setup Wizard to use the wizard to set up the profile. 
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The Partner profile box is linked to the selected profile configuration. If you are using 
GlobalSCAPE authentication, if the profile is updated, the information in the AS2 Send File 
dialog box is updated also; if a referenced profile is deleted, disabled, or not allowed to use 
AS2, any Event Rule using the profile will fail. 
 
If you use AD, LDAP, or ODBC authenticated accounts as AS2 partners, if the account in the 
external database is changed, deleted, or disabled, any Event Rule or Command that 
references the account will fail. For example, if an AD user SSmith is renamed SJones, you 
will have to manually update any Event Rule or Command to reflect the new name of the 
account. 

5. To test the configuration, click Test. 

6. To configure a proxy server for this partner, click Proxy. 

7. To clear all of the partner connection details and start over, click Clear All. 

8. Click OK to save the AS2 Partner profile in the Event Rule.  

9. Add other Conditions and/or Actions, as needed (e.g., add an e-mail notification). 

 

10. Click Apply to save the Event Rule on the server.  

ROUTING AS2 TRAFFIC THROUGH DMZ GATEWAY 

You can use the AS2 Send file to host Action to configure Event Rules to cause AS2 traffic to route through the 

DMZ Gateway. You can use the AS2 Send File to host Action in the Folder Monitor, Timer, and all file-based Events. 

To route AS2 traffic through DMZ Gateway 

1. Create a new Event Rule, such as a File Uploaded event. (Refer to Creating Event Rules for details of 

creating Event Rules, if necessary.) 

2. Add the AS2 Send file to host Action to the Rule, then click the file or host link. The AS2 Send File dialog 

box appears.  

3. Define the trading partner options (in the AS2 Send File dialog box).  

4. Add the Copy/Move File to Host Action to the Rule. 

5. In the Rule Builder pane, click any one of the undefined parameters (e.g., %FS.PATH%).  

 

 
 

The Offload Action wizard appears.  
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6. On the Offload method box, specify a protocol type for the connection: Local (Local File or LAN), FTP 

(standard File Transfer Protocol), FTP SSL/TLS (AUTH TLS), FTP with SSL (Explicit encryption), FTP with SSL 

(Implicit encryption), SFTP using SSH2 (Secure Shell), HTTP (HyperText Transfer Protocol), HTTPS (Secure 

HTTP access).  

7. In the Host address box, type the IP address.  

8. The Port number for the selected protocol changes automatically based on the offload method. Provide a 

different port number, if necessary. 

9. Provide the Username and Password needed to establish the connection.  

10. Select the Use connected client's login credentials to authenticate check box if you want to use the local 

system account to authenticate. 

11. If you chose SFTP: 

a. In the SFTP Public Key File Path box, type the path or click the open icon to browse to and select 

the path. 

b. In the SFTP Private Key File Path box, type the path or click the open icon to browse to and 

select the path. 

c. In the SFTP Key Passphrase box, provide the key's passphrase. 
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12. Click Proxy. The Proxy Settings dialog box appears. 

 

 

a. Specify the Proxy type, Host name, Port, Username, and Password. 

 

Using the DMZ Gateway as proxy is available only in the Enterprise version of the Server. 

b. To specify an Authentication Type and login sequence, configure the Advanced settings.  

c. Specify one of the following Authentication Types:  

 USER user @site if your proxy server requires the USER command followed by your user 

name and the Site name to allow connection with a remote Site. You can change the @ 

symbol if a different separator is required by your proxy server. 

 SITE site if your proxy server requires the SITE command followed by the address of the 

remote FTP site to allow a connection. 

 USER with logon if your proxy server requires the USER command followed by a user 

name and password to allow connection with a remote Site. 

 USER/PASS/ACCT if your proxy server requires all three commands before allowing a 

connection to a remote Site. 

 OPEN site if your proxy server requires the OPEN command followed by the Site name 

before allowing connection to the Site. 

 Custom if your proxy server requires a login sequence different from those above. Refer 

to To create a custom authentication method for a proxy server for details of creating a 

login sequence. 

13. To specify transfer options and time stamps, click Advanced. The Advanced Options dialog box appears. 
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a. In the General transfer options area, you can provide more control over Max concurrent 

transfer threads, Connection timeout, Connection retry attempts, and Delay between retries. 

When files are being transferred with Event Rules (copy/move), if there are connection problems 

(e.g., the network is unavailable), the Server will attempt to establish a connection the number of 

times specified in Connection retry attempts. When the Server is able to re-establish the 

connection, it continues to transfer the file even if there are multiple interruptions.  

b. Select the Validate file integrity after transfer check box to specify that the Server should double 

check binary files to ensure the files downloaded completely and correctly. 

c. In the Data port mode box, click the drop-down list and select one of the following:  

 Auto - (selected by default) the Server initially makes connections in PASV mode. If the 

PASV connection fails, the Server attempts to connect in PORT mode automatically. 

 PASV - Helps avoid conflicts with security systems. PASV support is necessary for some 

firewalls and routers, because with PASV, the client opens the connection to an IP 

Address and port that the Server supplies. 

 PORT - Use PORT when connections or transfer attempts fail in PASV mode, or when 

you receive data socket errors.  

When a client connects using PORT, the Server opens a connection to an IP address and 

port that the client supplies. If you select Port, specify the Port range. 

d. In the ASCII transfer mode area, specify the file types that can be transferred. TXT, INF, HTML, 

and HTM are specified by default.  

e. In the Time stamps area, select one of the following: 

 Select the Preserve remote time stamp for downloaded files check box to keep a 

downloaded file's time stamp the same on the local computer as it is on the Server. 
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 Select the Preserve the local time stamp for uploaded files if the Server allows MDTM 

check box to keep an uploaded file's time stamp the same on the Server as it is on the 

local computer. 

f. Click OK. 

14. Click Next. The Source File Path page appears. 

 

15. In the Source path box, provide the path to the file(s) that you want to offload. For example, type: 
/pub/usr/jsmith/file.txt or \\mydomain\common\jsmith\file.txt 

16. If you want to Delete source file after it has been offloaded, select the check box. 

17. Click Next. The Destination File Path page appears. 
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18. In the Destination path box, click the open icon  and specify the location in which to save the 

offloaded file.  

 You can also specify variables, such as \pub\usr\%USER.LOGIN%\%FS.FILE.NAME%. In 

the Variables box, double-click the variable(s) that you want to add to the path. 

19. Click Finish then click Apply to save the changes on the Server and/or add other Actions and Conditions to 

the Rule. 

20. If you are copying or moving the file to another location, and the file upload is a regularly occurring event 

with a file of the same name, in the Offload Action wizard, add the variables %EVENT.DATESTAMP% 

and/or %EVENT.TIMESTAMP% to the path so that the date (YYYYMMDD) and/or time (HHMMSS) are 

added to the filename when it is moved/copied. Do not use %EVENT.TIME%, because the colon (e.g., 28 

Aug 07 10:01:56) makes it unsuitable for file naming. 

21. For example, in the Offload Action wizard, in the Destination path box, provide the path and variables. 

For example, type:  

C:\Documents and Settings\Administrator\My 

Documents\upload/%EVENT.DATESTAMP%_%EVENT.TIMESTAMP%_%FS.FILE_NAME%  

22. With this path and variables, when a file is uploaded to the monitored folder, the file is moved to \My 

Documents\upload and the date and time are prepended to the filename. For example, 

20080422_101212_mydailyprogress.doc. 

 



EFT Server™ version 6 

 

590  

TO CREATE A CUSTOM AUTHENTICATION METHOD FOR A PROXY SERVER 

 

Contact your system administrator for the proper Host name, Port, User name, Password, and proxy type, as 
well as any required advanced authentication methods. 

1. In the Proxy Settings dialog box (see step 12 above), click Advanced. The Advanced Proxy Settings dialog 

box appears. 

2. In the Advanced Proxy Settings dialog box, click Custom, then specify the login sequence in the text box 

using the following variables:  

 %host% - sends the host name you typed in the Proxy server options dialog box. 

 %user% - sends the user name you typed in the Proxy server options dialog box. 

 %pass% - sends the password you typed in the Proxy server options dialog box. 

 %port% - sends the port number you typed in the Proxy server options dialog box. 

 %fire_pass% - sends the password you typed in the Proxy server options dialog box as 

authentication for the firewall. 

 %fire_user% - sends the user name you typed in Proxy server options dialog box as 

authentication for firewall. 

3. Type each variable with percent signs before and after. 

4. Press ENTER to separate commands. 

5. Type any other commands and variables, separating commands with a line break (press ENTER). 

6. Click OK. 

7. Click Apply to save the Rule. 

AS2 SEND FILE DIALOG BOX 

The AS2 Send File dialog box can be used in Folder Monitor, Timer, and file-based Event Rules. The table below 

describes each field in the AS2 Send File dialog box. 

Field 
Required/ 
Optional 

Description 

File(s) to 
upload 

Optional Used to specify the file(s) to upload to the partner.  

Can be variables or paths. e.g. c:\temp\robert.txt or (if relative path) \rob.txt  

Defaults to %FS.FILE_NAME%; same as if blank. Accepts FS.FILE variables and path strings to 
drive or UNC paths or relative path where applicable (i.e., if using a Folder Monitor Rule). 

Partner 
profile 

Required Used to select a defined partner profile or left blank (the default) if the partner profile is not 
defined. If blank, complete the fields in the AS2 Partner profile area. 

Delete 
source 

Required Used to indicate whether to delete sources files after sending them to the destination, after 
the MDN is received and verified from the remote AS2 host. Select the check box to delete 
source files after the MDN is received and verified from the remote AS2 host. 

Host address Required AS2 outbound host address. Requires protocol prefix in URL (http:// or https://). Specified in 
AS2 Partner Access wizard. 

Port Required AS2 Outbound port. Range is 1-65K; defaults to 80 if host address is preceded by http; 443 if 
host address is preceded by https.  

Mailbox path Optional Relative path (similar to User Home Folder) 
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Field 
Required/ 
Optional 

Description 

Username Optional User login name 

Password Optional Password 

Message 
subject 

Optional AS2 message subject 

Content type Required AS2 content type. Options include: 

 Application for ANSI X12 (application/EDI-X12) 

 EDIFACT (application/EDIFACT) 

 Mutually defined EDI (application/EDI-Consent) 

 Binary (default) - e.g., executables, word processing files, database, spreadsheet, 
and multimedia files  

 Plaintext - e.g., text, HTML, XML files 

Compress 
message 

Required When selected, specifies that the AS2 message should be compressed when sent. (Cleared 
by default.) 

Encrypt 
message 

Required When selected, specifies that outbound AS2 messages should be encrypted. (Selected by 
default.) 

Sign message Required When selected, specifies that outbound AS2 messages should be signed. (Selected by 
default.) 

Your 
certificate 

Required Displays the AS2 certificate public key path to use for signing, copied from the Site. (Can be 
on a drive or UNC path.) 

Partner 
certificate 

Required Specifies the AS2 certificate to use for encrypting outbound transactions and for validating 
signed MDN receipts. (Can be on a drive or UNC path.) 

Your AS2 
identifier 

Required  Used to apply a unique AS2-From ID to outbound messages.  

Partner AS2 
identifier 

Required Used to apply a unique AS2-To ID to outbound messages. 

Receipt 
policy 

Required Used to request an MDN receipt. Options include: 

 Request a signed receipt (default) 

 Don’t request a receipt 

 Request an unsigned receipt 

Receipt 
delivery 

Required Specifies receipt delivery method 

 Synchronous (default) 

 Asynchronous 

The following fields are used to determine whether a message send attempt has failed due to a timeout, error, 
synchronous MDN receipt failure, or other error, after which the Server will attempt to resend the same message 
at regular intervals, if specified. 

Field 
Required/ 
Optional 

Description 

Message send attempt 
timeout (seconds) 

Optional Specifies the timeout after which a message send attempt is considered a failure if no 
response or errors are received from the remote server. Range: 0-600, 60 by default, 0 
means no timeout 
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Field 
Required/ 
Optional 

Description 

Message send attempt 
retries 

Optional Number of times to reattempt to send the message. Range: 0 (no retry) to 999, 10 is 
the default. 

 

Retries do not include the initial attempt. That is, 3 retries means 3 in addition to 
the first attempt (4 total). 

 

Send attempt delay 
between retries  

Optional 

 

Interval between resend attempts. Range: 0 (no wait) to - 600 seconds; 30 seconds is 
the default. 

Asynchronous receipt 
timeout  

Optional 

 

Specifies the timeout after which EFT Server determines whether an asynchronous 
receipt was received. Range: 0 (no timeout) to 999,999 minute; 7500 minutes is the 
default. 

AS2 TRANSACTION AUDITING AND MONITORING 

The topics below provide information about monitoring AS2 transfer activities. 

INTRODUCTION TO AS2 TRANSACTION AUDITING AND MONITORING 

The AS2 module provides the following tools to track, monitor, audit, and report on AS2 transactions: 

 AS2 Transactions node - A node on the Server’s Status tab displays a summary of recent AS2 transaction 

history. 

 Auditing and Reporting Module (ARM) reports  - Predefined AS2 reports provide a summary or details of 

AS2 transactions. You can also define custom reports.  

 AS2 Account Management Web page - A Web page at the reserved path of /as2 can provide access to the 

Server’s public AS2 certificate key and global AS2 identifier. 

AS2 INFORMATION IN THE DATABASE 

The Auditing and Reporting module (ARM) must be installed to use the AS2 module. If the ARM database fails, AS2 

functionality is not available. The Server installer updates the ARM database with AS2 tables; however, if you are 

using a SQL database, you will have to update your table schema manually. Refer to AS2 Auditing SchemaAS2 

Auditing Schema  for details of the table schema. 

The following information is audited to the ARM database and provided in AS2 reports and the AS2 Transactions 

node: 

 Date/Time 

 Raw HTTP Headers 

 File name  

 MDN  

 MIC 

 Content Type 

 Message-ID 

 Remote/Local File path (mailbox) 

 Remote/Local Host (hidden by default) 
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 Status: Success (S), Failure (F), or In Progress (IP) 

 Action: 

o Inbound Connection (S, F, IP) 

o Outbound Connection (S, F, IP) 

o Receive File (S, F, IP) 

o Send File (S, F, IP) 

o Send Receipt Asynchronous (S,F,IP) 

o Send Receipt Synchronous (S,F,IP)  

o Receive Receipt (S,F, IP) 

o Receipt Verification (S,F) 

 Direction: Inbound or Outbound 

 Partner AS2 ID 

 The Server AS2 ID 

 Error (only if Failure) occurred, the verbose error. Otherwise "None". 

AS2 SQL SCRIPT 

If you are not using the database included with the Server installer, refer to Installing and Configuring the 

Auditing and Reporting Module for the procedure for creating the Server database tables.  

The SQL script installed in C:\Documents and Settings\All Users\Application Data\Globalscape\EFT Server 

Enterprise\SQL Server or \EFT Server\SQL Server adds the necessary tables to a SQL database for monitoring AS2-

related transactions. 

AS2 TRANSACTION REPORTS 

The Auditing and Reporting module (ARM) gathers AS2 data and provides the data in the AS2 Transactions 

node and in predefined AS2 reports. You can also define your own custom reports.  

 AS2 Transactions (Summary) report - A transaction report that displays the same information as shown on 

the AS2 Transactions node. The report queries all AS2 transactions for the dates specified, grouped by 

site, sorted by date, and listed in reverse chronological order. You can add Report Filters for the following 

data: 

o StartTime 

o MessageID 

o FileName 

o TransactionID 

o FromAS2ID 

o ToAS2ID 

o TransactionStatus (rolled up transaction status) 

 Success  - File was received/sent MDN successfully received/sent 
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 Failure - Transaction failed to receive/send after all retries or MDN not received/sent 

after all retries 

 In Progress - Transaction started or is in progress (transferring or waiting for next retry 

or waiting for MDN, etc.) 

 AS2 Transactions (Detailed)   report - A verbose AS2 file transfer report that provides the information 

necessary for troubleshooting problem transactions. You can add Report Filters for the following data: 

o StartTime 

o MessageID 

o FileName 

o TransactionID 

o FromAS2ID 

o ToAS2ID 

o TransactionStatus 

o Sitename 

o Error (Displays None if there are no errors) 

AS2 TRANSACTIONS NODE 

EFT Server provides a sub-node on the Status tab that displays a history of AS2 transactions (retrieved from the 

Server’s ARM database).  

 

The AS2 Transactions node displays the history of AS2 inbound and outbound transfers, including the result from 

the MDN. For example, if a file transaction attempt fails 10 times in a row, but succeeds on the 11th attempt and 

the MDN is sent, the AS2 Transactions node reports the transaction as a success.  
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If all of the transaction’s file transfer retries fail, then the AS2 Transactions node reports the transaction as a 

failure. If retries are still occurring at the time the AS2 Transactions node is invoked, the transaction will be 

marked as In Progress. You can view details of each transaction by clicking its Status column. EFT Server will query 

and then display (in the default text editor) the details surrounding that transaction as obtained from the ARM 

database. 

When the AS2 Transactions node is selected, the last 7 days of transaction summaries are displayed in reverse 

chronological order. You can change the default of 7 days to display from 1 to 999,999 days of data. Click Refresh 

to display all transactions that may have occurred since the last opening or refresh of the AS2 Transactions node. 

The node displays the following information: 

 Message ID - From AS2 header 

 Date and Time  - Last recorded status for the transaction 

 File - Name of file transferred 

 

If multiple files are transferred, each file is on a separate row, but with the same Message ID. 

 File Path - Local inbox or outbox; this column is hidden  by default 

 Remote Host Address  - Host address of the sender (Inbound)/receiver (Outbound). This column is 

hidden by default. 

 Status - Contains a hyperlink that, when clicked, pulls the AS2 Detailed report for that transaction. The 

report displays transaction details, which is most helpful for in-progress or failed transactions. 

o Success  - Transaction completed and MDN successfully received/sent 

o Failure  - Transaction failed to send after all retries or MDN not received/sent 

o In Progress - Transaction started or in progress (transferring or waiting for next retry or waiting 

for MDN, etc.) 

 Direction - Inbound or Outbound  

 From - Server's AS2 ID or the Partner ID (depends on direction) 

 To - Server's AS2 ID or the Partner ID (depends on direction) 

The Resubmit icon , to the left of failed transactions, allows you to resubmit the file(s) and/or MDN(s). You can 

also resubmit a file, or group of files by multi-selecting failed transaction rows, then right-clicking and clicking 

Resubmit. If you resubmit a file that is a part of multi-file transaction, all of the files will be resubmitted. You can 

only resubmit failed transactions. You cannot resubmit in-progress or successful transactions. 

CUSTOMIZING THE DISPLAY 

You can customize the display of the AS Transactions node to suit your needs: 

 Choose the columns to display or hide by right-clicking on a column header, then selecting/clearing the 

column name in the submenu. 

 Sort by a specific column in ascending or descending order by clicking the column header.  

 Define filters to display or hide rows based on Status, Message-ID, or File Name. 

o To filter the display based on status, select or clear the Show successes, Show failures, and Show 

in progress check boxes, then click Refresh  
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o To filter the display based on the message-ID, in the Message-ID box, type the message ID, then 

click Refresh. 

o To filter the display based on the filename, type a name in the Filename box, then click Refresh. 

o To change the number of days of history to display, in the Pull records from last <n> days box, 

type the number of days, from 1 to 9999. 

 Refresh or clear the display by right-clicking an empty row, then clicking Refresh, or in the filter area, click 

Refresh. 

AS2 TRANSACTION SUCCESS AND FAILURE NOTIFICATION 

The Server can send an e-mail or execute a command to notify you of the success or failure of AS2 transactions. 

The e-mail or Command is triggered when all message send attempts have been attempted or the asynchronous 

MDN wait time has expired (if applicable).  

The e-mail notification and custom command are configured by clicking the applicable link in the AS2 Inbound and 

AS2 Outbound tabs or in the AS2 Partner Access wizard.  

 Clicking the Transaction FAILED/SUCCESS notification e-mail link, [Add], opens the Edit Mail Template  

dialog box.  

 Clicking the Transaction FAILED/SUCCESS send command link, [Add], opens the Custom Command dialog 

box. (You will have to define the custom command before using it in the notification.) 

Field  
Required/ 
Optional 

Description 

Transaction FAILED 
notification e-mail 

Optional  Opens the Edit Mail dialog box in which you can specify an e-mail notification for 
failed transaction.  

(Refer to E-mail Notification Action for details of defining an e-mail notification.)  

Transaction SUCCESS 
notification e-mail 

Optional Opens the Edit Mail dialog box in which you can specify an e-mail notification for 
successful transaction. 

(Refer to E-mail Notification Action for details of defining an e-mail notification.) 

Transaction FAILED send 
command 

Optional Opens the Custom Command dialog box in which you can specify a Custom Command 
to occur upon failed send. 

(Refer to Creating a Command to create a command and refer to Using an Event Rule 
to Execute a Command (Run a Process) for details of using a Command.) 

Transaction SUCCESS run 
command 

Optional Opens the Custom Command dialog box in which you can specify a Custom Command 
to occur upon successful run. 

(Refer to Creating a Command to create a command and refer to Using an Event Rule 
to Execute a Command (Run a Process) for details of using a Command.) 

TESTING THE AS2 OUTBOUND CONNECTION 

You can validate the AS2 partner configuration details by sending a test file to the remote partner. This provides 

immediate feedback as to whether an outbound connection was configured properly.  

On the AS2 Outbound tab or in the AS2 Send File to host Event Rule Action, click Test to send a test file to the AS2 

host specified. The AS2 Test Connection dialog box appears. 
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EFT Server attempts to send a test file using the parameters supplied, and displays a success or failure message 

along with the entire log. The test determines success of the following parameters: 

 Presence of certificates necessary to sign and/or verify signatures 

 Connection to the host and navigation to the correct path 

 Upload of the test file 

 Receipt and verification of the MDN receipt 

 Transaction completed 

A blue check indicates success; a red X indicates failure. The HTTP request and response headers are displayed in 

the AS2 connection log below the success/failure list. You can copy the log to a text file or e-mail for 

troubleshooting. 

If you click Close before the test is complete, the test ends and no results are displayed or saved. 

To copy the log for troubleshooting/e-mailing 

1. After the test complete, click Copy Log. The log is copied to Windows Clipboard. 

2. In the document or e-mail, click Paste. 

In the Auditing and Reporting database, the filenames are clearly test files (e.g., tes1.tmp) to indicate that an 

audited transaction is a test; however, test transactions are treated the same as any other AS2 transaction and 

appear in the database the same as any other AS2 transaction.  
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TROUBLESHOOTING AS2 CONNECTIONS 

The AS2 module provides monitoring tools that can assist you in troubleshooting AS2 connections to the Server. 

Below are some important things to consider when troubleshooting failed AS2 connections.  

 When you install the AS2 module, if you receive the error "Could not register AS2 component," this 

indicates an error in the ASP.net registration. Refer to AdHoc Properties Missing ASP.NET Tab for details 

of the ASP.NET IIS Registration Tool. The tool can be used to register the ASP.NET version. 

 Ensure that your partner-provided information (AS2 ID, certificates, host information) is accurate and that 

your provider has configured your account correctly on the remote server. 

 Provide your certificate file (public key) to your partner and obtain your partner’s public key (unless your 

partner will be sending you non-encrypted, non-signed messages that do not request an MDN). 

 Send a test file to your partner. The Test button on the AS2 Configuration wizard sends a test file to a 

defined AS2 partner to verify connection. The success or failure results are displayed in a prompt that 

contains each stage of the transfer. The stages include the presence of certificates necessary to sign 

and/or verify signatures, connection to the host and navigation to the correct path, upload of the test file, 

and receipt and verification of the MDN receipt. The complete HTTP sent and received headers are 

captured and displayed in a list box under the success/failure stages. You can select and copy the text of 

this log for analysis.  

 Contact your partner and ask them to connect and transfer a test file to the Server. If the test is not 

successful, examine reports and the AS2 Transactions node in the Server: 

o ARM report - AS2 Transactions (Detailed) - Review the report to determine why the problem 

transaction occurred. 

o AS2 Transactions node - Review the sub-node on the Status tab to view recent AS2 transactions 

(retrieved from the Server’s ARM database) to identify possible configuration errors. 

 If you receive an out-of-memory error, the computer on which the Server is installed does not have 

enough RAM for the size of files that you are sending/receiving. You must have more than the minimum 

required RAM if you are transferring large non-EDI files over AS2. The maximum concurrent send and 

receive file size limit is approximately 40% of the Server's RAM. For example, on a Server with 2GB of 

system memory, the cumulative size of all files being sent or received from/to that AS2 client at one time 

must not exceed roughly 800MB. Each time a file transfer starts, the Server's AS2 module must reserve a 

slice of memory for that file. The reserved memory is not released until the transfer is complete. If the 

reserved memory is more than what is available, the operating system (Windows) resorts to using the 

hard disk cache, which is much slower than RAM and can drastically reduce the Server performance.  
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AS2 AND THE AUDITING AND REPORTING MODULE 

You must have the Auditing and Reporting module installed to use the AS2 module. If the ARM database is not 

installed, configured properly, or fails, AS2 functionality is not available.  

If the ARM database fails: 

 For outbound transactions, the transaction is cancelled, and the Server sends e-mails, execute commands, 

and triggers events. (This includes any outbound transaction, whether initiated by AS2 Send File Action or 

by folder monitor specified in partner AS2 outbound tab.) 

 For inbound transaction, the Server replies to the partner with “500 Internal server error: database 

failure,” then sends e-mails, executes commands, and triggers events. 

RESUBMITTING AS2 TRANSMISSIONS 

In the AS2 Transaction node, the Resubmit icon   to the left of failed transactions allows you to resubmit the 

file(s) and/or MDN(s). You can only resubmit failed transmissions. You cannot resubmit in-progress or successful 

transmissions.  

 Outbound. If a failure was an outbound transaction (failed after all retries and the MDN was never 

received), you can attempt to send the same file again.  

 Inbound. When an inbound transaction fails, resubmit is allowed only when the failure was due to a 

failure in sending the receipt (MDN). (EFT Server cannot resubmit the file, because it did not send it to 

begin with.) The resubmit action attempts to resend the MDN receipt.   

To resubmit a failed transmission 

1. In the Administrator, connect to the Server, and click the Status tab.  

2. Expand the Server and Site nodes, then click the AS2 Transactions node. The Site's AS2 transactions 

appear in the right pane. 
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3. Click in the row of the failed transaction to select it, then click the Resubmit icon . A confirmation 

prompt appears. 

4. Click Yes. The transaction is resubmitted and appears in a new row. The resubmitted transaction 

populates a new row in the AS2 Transaction node with the new transaction and new message ID.  

 

There can be multiple rows (other transmissions) between the failed transmission and the 
resubmitted transmission. 
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AS2 ERROR WARNINGS AND PROMPTS 

The Server provides error warnings and prompts when you are configuring the AS2 module and when you are 

sending/receiving files using AS2. 

CONFIGURATION ERRORS 

EFT Server presents a prompt and disallows changes to AS2 configuration in the following instances: 

 Settings are enabled that require a partner AS2 certificate and no certificate has been defined for that 

partner 

 Settings are enabled that require the Server’s AS2 certificate and no certificate has been defined for the 

Server 

 Settings are enabled that require the partner’s or the Server’s identifier and no identifier has been 

defined for the partner or the Server 

 The chosen certificate is set to expire in 30 days or fewer 

 A certificate being imported is a combined certificate 

 You open the AS2 Send File dialog box and click OK or Apply without specifying a partner profile. 
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TRANSFER ERRORS 

The Server provides the following transfer error messages. When you receive one of these errors, you should 

examine your AS2 configuration and other Site/User settings. Certain messages are simply an indication that the 

configuration is working as designed. For example, if your AS2 outbound configuration has a filter mask to ban files 

with a .zip  extension or if the Site's configuration bans files of this type on the Server, you will receive a banned 

file message when a user attempts to send files of this type. 

Error Possible Cause/Solution 

A network error occurred Verify AS2 server address and port; ensure there is a connection 
between the two servers and nothing is blocking the 
connection; require SSL certificates from connected clients 
might be enabled; SSL negotiation failed; retry transfer 

Error decoding certificate AS2 module cannot decode the Server's or partner's certificate 

The receipt was unsigned and a signed 
receipt was expected 

Incorrect certificate used for the Server or partner certificate 

Incorrect AS2-From field Incorrect "Your AS2 identifier" 

Incorrect AS2-To field Incorrect "Partner AS2 identifier" 

Unable to authenticate signature: RSA 
Error: Inadequate amount of padding in 
encrypted message  

AS2 module cannot verify signature of signed incoming 
message; possible problem with identifiers; sender might be 
using incorrect identifier; AS2 MDN cannot be verified 

Timeout occurred while sending MDN Firewall blocking receipt send (MDN blocked) 

File already exists, Message with duplicate 
ID and different payload was received.  

(Tried to overwrite existing file and corresponding policy is set 
to Reject.) AS2 configuration does not allow overwriting files of 
same name; change AS2 configuration to Accept these files or 
move/rename files after they are received. 

Quota exceeded File is too large. User configuration does not accept files of this 
size; change user quota allowance or compress/split file. 

File is banned (Uploaded file meets Site’s "Ban" mask) Site configuration does 
not accept files of this type/name. Change Site's ban settings or 
let your partner know that files of that type cannot be uploaded 
to the Server. 

Use encryption or HTTPS (Tried to use "plain" AS2 without encryption.)  AS2 configuration 
must be set to use encrypted HTTP or HTTPS. Refer to 
Redirecting HTTP to HTTPS for details of redirection. 

Unable to decrypt message, RSA Error Inadequate amount of padding in encrypted message. AS2 
module cannot decrypt encrypted incoming message. 

HTTP error: 400 Bad Request 

 

One possible cause is receiver/sender has incorrect or missing 
certificate; Connection problem of some kind 

HTTP error: 401 Unauthorized  

 

Authentication failed for username/password; IP address is 
blocked 

HTTP error: 403 Forbidden 

 

Incorrect folder location, Mailbox path; do not have permission 
to remote folder/path; AS2 is not enabled/supported on 
receiving side 
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THE HIGH SECURITY MODULE 

 

The High Security (HS) module enforces a higher level of security, and monitors, reports, or warns when any of the 

high security settings are changed to a less secure mode. The HS module allows the Server to use FIPS-compliant 

protocols and ciphers, increase user account and password security, remove old data automatically, audit 

configuration changes, and maintain compliance with the Payment Card Industry Data Security Standard (PCI DSS), 

HIPPA, Sarbanes-Oxley, ISO 27000, and other security standards. 

Protects Data at Rest: The HS Module, in concert with DMZ Gateway, helps organizations comply with data 

storage requirements, including not storing data in the DMZ, using repository encryption, and securely sanitizing 

deleted data so that it cannot be reconstituted. Protecting customer data is a major aspect of complying with the 

PCI DSS and other standards.  

Protects Data in Transit: The HS module protects data in transit by enforcing the use of secure protocols, strong 

ciphers and encryption keys, and maintaining password policies that strictly follow PCI DSS guidelines. 

Controls Access to Data: The Server allows you "fine tune" user access to help you comply with security 

requirements, such as PCI DSS requirement 7 (Restrict access to cardholder data by business need-to-know) and 8 

(Assign a unique ID to each person with computer access). You can choose from multiple data sources including 

Active Directory, NTLM-, LDAP-, or ODBC-compatible database as a source for user authentication, or you can use 

the Server's built-in GlobalSCAPE authentication manager to isolate the Server users from your domain. The 

Auditing and Reporting Module (ARM) captures all of the Server activity in a fully relational database (the auditing 

database does not store cardholder data).  

Ongoing Auditing: Rather than commit changes immediately, the HS module warns you upon changing one or 

more settings that may cause the Server to fall out of compliance. The Server gives you the opportunity to undo 

your changes or continue with the change and provide justification or description of any compensating controls in 

place. Related settings are audited and reported on as a group (e.g., all of the SSL-related settings, or all user 

settings). For example, suppose on Monday you disable the account lockout settings for a user and specified your 

reason for allowing this non-compliant setting. Then on Wednesday, you change a complex password setting. The 

warning message displays both of these settings, as well as others for which you previously had provided 

justification for leaving as is. Before the Server commits the change, you must choose to either allow the change 

and specify a reason, or discard the changes for each of the non-compliant settings. (That is, the allow or discard 

flag is separate, but they are audited and reported on as a group.) This functionality is designed to remind you of 

the non-compliant settings and provide you the opportunity to bring them into compliance. 

FIPS-Compliant Protocols and Ciphers: The Federal Information Processing Standard (FIPS) Publication 140-2 

specifies the security requirements of cryptographic modules used to protect sensitive information. EFT Server 

supports operation with the FIPS 140-2 Validated GlobalSCAPE Cryptographic Module (GSCM) for inbound SSL/TLS 

and certificate generation. (Certificates created in prior versions of the EFT Server or EFT Server (imported 

certificates that were signed using non-FIPS compliant algorithms) will not work in EFT Server version 6 when using 

FIPS mode.) 

PCI DSS Compliance: The High Security (HS) module facilitates enforcing high security and compliance with the PCI 

DSS 1.2 specification, and provides an automated, preconfigured PCI DSS Compliance Report. 
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FEATURES OF THE HIGH SECURITY MODULE 

 The features of the HS module are listed below: 

 FIPS-Compliant Protocols and Ciphers 

 Automatically redirects HTTP to HTTPS  

 Expires password on certain date 

 Enables password expiration reminders (e-mail, banner) 

 Removes old data automatically (Data sanitization (wiping)) 

 Removes inactive accounts after <n> days 

 Hides or disables non-allowed ciphers, key lengths, anonymous accounts, etc. 

 Enforces password expiration and complexity (Administrator password complexity is part of EFT Server 

core) 

 Restricts inbound Internet traffic (Administrator interface connections) to IP addresses within the DMZ  

 Detects whether DMZ Gateway is present 

 Warns if unsecure protocols are in use 

 Warns if user disk quota is not set 

 Warns if secure remote administration not set 

 Warns if Encrypting File System (EFS) in use 

 Warns if weak  or SFTP keys are in use 

 Warns if weak SSL versions and ciphers are in use  

 Warns if DoS and flood settings are too low 

 Audits initialization of auditing and reporting system and Server configuration changes to database 

 Monitors settings and reports on violations 

 Produces automatic daily PCI DSS Compliance reports 
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THE PAYMENT CARD INDUSTRY (PCI)  
DATA SECURITY STANDARD (DSS) 

In 1999, Visa USA developed the Cardholder Information Security Program (CISP). The goal of this program was to 

assure cardholders that their account information was safe, regardless of where it was offered for payment. 

Originally intended to secure credit card transactions over the Internet, the CISP was expanded and mandated in 

June 2001 to apply to all payment channels, including retail (brick and mortar), mail/telephone order, and e-

commerce. To achieve CISP compliance, merchants and service providers must adhere to the Payment Card 

Industry (PCI) Data Security Standard (DSS). The PCI DSS, the result of collaboration between Visa and MasterCard, 

is designed to create common industry security requirements that incorporate the CISP requirements. Visa, 

MasterCard, American Express, Diner’s Club, Discover, and JCB USA have each endorsed the CISP and PCI DSS. If a 

member, merchant, or service provider does not comply with the security requirements or fails to rectify a security 

issue, they could face fines of up to US$500,000 per incident, or restrictions imposed by the credit card companies, 

including denying the member's, merchant's, or service provider's ability to accept or process credit card 

transactions.  

GlobalSCAPE is a Participating Organization of the PCI Security Standards Council  

As a council member, we can better help our customers bridge the gap between understanding and complying 

with PCI DSS requirements. We are excited to participate in this initiative and are eager to provide companies with 

the tools necessary to succeed in this area. As a Participating Organization, GlobalSCAPE: 

 Plays a direct role in the ongoing development of PCI standards 

 Attends PCI Security Standards Council Community Meetings 

 Stands for election on the Board of Advisors 

 Reviews in advance standards and supporting materials before release  

Who Must Comply with PCI? 

Any organization that stores, processes, or transmits Primary Account Number (PAN) data must comply with PCI 

DSS requirements. However, even organizations that do not store or transmit PAN data may decide to use the PCI 

DSS requirement document as an internal security best practice guideline by which they measure and implement 

their own data security standards.  

Refer to PCI DSS Requirements for information about specific PCI DSS requirements addressed in the Server. 

 For more information regarding PCI Security Standards, including downloading a PDF of the standard, visit 

https://www.pcisecuritystandards.org/index.htm.  

 For a list of terms and acronyms used in the standard, refer to 

https://www.pcisecuritystandards.org/tech/glossary.htm. 

  

https://www.pcisecuritystandards.org/index.htm
https://www.pcisecuritystandards.org/tech/glossary.htm
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PCI DSS REQUIREMENTS 

The topics below provide details of the PCI DSS requirements addressed with EFT Server. The topics below are 

organized similarly to the PCI DSS Security Audit Procedures document so that you can compare each requirement 

to the features in the Server that facilitate compliance. You can download the PCI DSS Security Audit Procedures 

from http://www.pcisecuritystandards.org/ 

HOW THE SERVER ADDRESSES PCI DSS REQUIREMENTS 

The High Security (HS) module facilitates enforcing high security and compliance with the PCI DSS 1.2 specification, 

which provides detailed security compliance guidelines that can be used to provide hardened security for the 

Server, no matter which rules or standards by which your organization is measured. The PCI DSS 

Requirements section provides an overview of each requirement and describes how the HS module helps comply 

with the requirement. 

COMPENSATING CONTROLS 

From the PCI DSS Security Auditing Procedures document:  

Compensating controls may be considered for most PCI DSS requirements when an entity cannot meet a 

technical specification of a requirement, but has sufficiently mitigated the associated risk.  

When the Server warns you of a non-compliant setting, if you do not choose a setting that satisfies the 

requirement, you must specify the compensating controls (hardware, software, or policy) you are using. The 

information that you provide will appear in the Compliance report, which you can provide to Qualified Security 

Assessors (QSAs) and Approved Scanning Vendors (ASVs), individuals who are certified by the PCI Security 

Standards Council as being qualified to validate compliance to the PCI DSS standards. 

THE PCI DSS COMPLIANCE REPORT  

The PCI DSS Compliance Report provides administrators and managers with a summary of the security controls at 

work on the Server, as well as areas where security could be further hardened. PCI DSS compliance is an ongoing 

process, not a "set-it-and-forget-it" project. Periodic self-assessment is an important part of identifying non-

compliance and identifying areas that need improvement, and can help save costs if an assessor is required for 

validation of PCI DSS compliance. 

The PCI DSS requires that you track and monitor all access to network resources and cardholder data (requirement 

10) and regularly test security systems and processes (requirement 11).  

The HS module, in conjunction with the Auditing and Reporting module (ARM), helps you maintain compliance by 

identifying areas that are out of compliance and automatically e-mailing you a daily PCI DSS Compliance 

report that includes all successes, warnings, failures, and compensating controls, based on multiple evaluation 

criteria.  

You can also run the PCI DSS Compliance report "on the fly" in the Administrator.  

PCI DSS REQUIREMENTS ADDRESSED 

The Server facilitates compliance with applicable PCI DSS requirements. The PCI DSS requirements related to 

physical security and cardholder database security are not applicable to the Server; however, you should place the 

Server computer in a secured area, such as a locked server room or network operations center. 

http://www.pcisecuritystandards.org/
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REQUIREMENT 1: INSTALL AND MAINTAIN A FIREWALL CONFIGURATION TO PROTECT 
CARDHOLDER DATA 

From the PCI DSS:  

Firewalls are computer devices that control computer traffic allowed between a company’s network 

(internal) and untrusted networks (external), as well as traffic into and out of more sensitive areas within a 

company’s internal trusted network. The cardholder data environment is an example of a more sensitive 

area within the trusted network of a company.  

A firewall examines all network traffic and blocks those transmissions that do not meet the specified 

security criteria.   

All systems must be protected from unauthorized access from untrusted networks, whether entering the 

system via the Internet as e-commerce, employees’ Internet access through desktop browsers, employees’ 

e-mail access, dedicated connection such as business to business connections, via wireless networks, or via 

other sources. Often, seemingly insignificant paths to and from untrusted networks can provide 

unprotected pathways into key systems. Firewalls are a key protection mechanism for any computer 

network.    

Although the Server is not a firewall, certain features of the Server can facilitate compliance with the sub 

requirements indicated below. 

PCI DSS Requirement How Requirement is Addressed with the Server 

1.1 Establish firewall and router configuration 
standards. 

Firewall and router configuration is independent of the Server. 
Reference the Test Procedures of the PCI DSS Security Audit 
Procedures for more information on firewall configuration 
requirements. 

1.2 Build a firewall configuration that restricts 
connections between untrusted networks and any 
system components in the cardholder data 
environment.  

The Server supplements your existing firewall IP address filters with an 
easy-to-use IP address filter page, letting you grant or deny access to 
specific IP addresses or ranges of IP addresses. 

1.3  Prohibit direct public access between the 
Internet and any system component in the 
cardholder data environment. 

Storing cardholder in the DMZ where it is publicly accessible or storing 
the data internally but allowing inbound connections between the 
perimeter and internal firewalls in a "west-to-east" fashion violates this 
security best practice. How can a company make its cardholder data 
available for business partners while protecting it from publicly 
accessible systems or networks? The Server’s optional DMZ Gateway 
Server module solves this problem through brokering of 
communications between the DMZ and the internal network.  

 1.3.1 Restricting inbound Internet traffic to 
internet protocol (IP) addresses within the 
DMZ (ingress filters)  

External to the Server 

 1.3.2 Not allowing internal addresses to pass 
from the Internet into the DMZ 

Configured at the firewall, router, or NAT. The Server never discloses 
your internal IP addressing scheme when external connections are 
made to it. 

 1.3.3 Implementing stateful inspection, also 
known as dynamic packet filtering (that is, 
only "established" connections are allowed 
into the network) 

External to the Server 

https://www.pcisecuritystandards.org/pdfs/pci_audit_procedures_v1-1.pdf
https://www.pcisecuritystandards.org/pdfs/pci_audit_procedures_v1-1.pdf
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PCI DSS Requirement How Requirement is Addressed with the Server 

 1.3.4 Perimeter Security  The DMZ Gateway greatly facilitates compliance with this requirement. 
DMZ Gateway can be deployed alongside the Server to provide 
increased security by eliminating the need to store data or authenticate 
users in the DMZ or open up inbound holes in your internal network 
firewall. 

 1.3.5 - 1.3.9 Specific firewall related 
requirements 

External to the Server 

1.4 Prohibit direct public access between external 
networks and any system component that stores 
cardholder data. 

The DMZ Gateway is designed to reside in the demilitarized zone to 
provide secure communications with the Server behind intranet 
firewalls without requiring any inbound firewall holes between the 
internal network and the DMZ. 

 1.4.1 Implement a DMZ to filter and screen all 
traffic to prohibit direct routes for inbound 
and outbound Internet traffic 

Use the DMZ Gateway to prevent any inbound connections from the 
DMZ to the internal network.  

 1.4.2 Restrict outbound traffic from payment 
card applications to IP addresses within the 
DMZ 

The DMZ Gateway can work as a reverse proxy as well. The Server’s file 
offload feature can use the DMZ Gateway as an outbound proxy.  

1.5 Implement IP address masquerading to 
prevent internal addresses from being translated 
and revealed on the Internet. Use technologies 
that implement RFC 1918 address space, such as 
port address translation (PAT) or network address 
translation (NAT) 

Configured with a NAT or similar device 

   

REQUIREMENT 2: DO NOT USE VENDOR-SUPPLIED DEFAULTS FOR SYSTEM PASSWORDS 
AND OTHER SECURITY PARAMETERS  

From the PCI DSS:  

Malicious individuals (external and internal to a company) often use vendor default passwords and other 

vendor default settings to compromise systems. These passwords and settings are well known by hacker 

communities and are easily determined via public information.  

PCI DSS Requirement How Requirement is Addressed with the Server 

2.1 Change Vendor Defaults EFT Server determines whether any default values are 
specified for Admin login port (1100), DMZ Gateway port 
(44500), FTP banner message, or SFTP banner message, and 
will prompt you to change them.  

 2.1.1 For wireless environments, change wireless vendor 
defaults, including but not limited to, wireless equivalent 
privacy (WEP) keys, default service set identifier (SSID) 
passwords, and SNMP community strings. Disable SSID 
broadcasts. Enable WiFi protected access (WPA and 
WPA2) technology for encryption and authentication 
when SPA-capable 

External to the Server 
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PCI DSS Requirement How Requirement is Addressed with the Server 

2.2 Develop configuration standards for all system 
components. Assure that these standards address all known 
security vulnerabilities and are consistent with industry-
accepted system hardening standards as defined, for example, 
by SysAdmin Audit Network Security Network (SANS), National 
Institute of Standards Technology (NIST), and Center for 
Internet Security (CIS).  

Refer to the specific sub-requirements below. 

 2.2.1 Implement only one primary function per server (for 
example, web servers, database servers, and DNS should 
be implemented on separate servers) 

External to the Server. The Server's only function is to 
transfer files securely. It is up to the administrator to 
segregate servers. 

 2.2.2 Disable all unnecessary and insecure services and 
protocols (services and protocols not directly needed to 
perform the devices’ specified function)  

The Server PCI DSS HS will determine and prompt you to 
disable any unsecure protocols such as plaintext FTP or 
HTTP. If you decide to continue using plaintext protocols, 
the Server will request that you provide ample justification 
including compensation controls used, per PCI DSS 
requirement 1.1.6. 

 2.2.3 Security parameters set to prevent misuse  The Server PCI DSS HS monitors, warns, or enforces 
multiple security parameters such as: 

 User login credentials not-persisted in memory 
beyond the absolute minimum time necessary 

 Flood and DoS prevention settings set too low 

 Disk quota not set or set too high 

 2.2.4 Remove all unnecessary functionality, such as scripts, 
drivers, features, subsystems, file systems, and 
unnecessary web servers. 

External to the Server 

2.3 Encrypt non-console administrative access The Server PCI DSS HS detects and warns on plaintext 
remote administration. During normal operations, the 
Server monitors the status of remote administration 
settings, including SSL parameters, warns if SSL is not 
enabled, and prompts you to disable remote 
administration, enable SSL, or continue as is with ample 
justification provided. 

2.4 Hosting providers must protect each entity's hosted 
environment data. These providers must meet specific 
requirements. 

The Server suite of software products is not a hosting 
provider. 
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REQUIREMENT 3: PROTECT STORED CARDHOLDER DATA 

From the PCI DSS: 

Protection methods such as encryption, truncation, masking, and hashing are critical components of 

cardholder data protection. If an intruder circumvents other network security controls and gains access to 

encrypted data, without the proper cryptographic keys, the data is unreadable and unusable to that 

person. Other effective methods of protecting stored data should be considered as potential risk mitigation 

opportunities. For example, methods for minimizing risk include not storing cardholder data unless 

absolutely necessary, truncating cardholder data if full PAN is not needed, and not sending PAN in 

unencrypted e-mails.    

PCI DSS Requirement How Requirement is Addressed with the Server 

3.1 Develop a data retention and disposal policy  You can configure the Server to remove files from a specified 
folder at regularly scheduled intervals with the Server's Clean-up 
Action. When the Server deletes a file, it can optionally securely 
delete or purge the file by writing over the initial data using 
encrypted and/or pseudorandom data.  

3.2 Do not store sensitive authentication data 
subsequent to authorization (even if encrypted). 
Sensitive authentication data includes the data as cited in 
requirements 3.2.1 through 3.2.3 (magnetic stripe data, 
validate codes (cv2), or PIN 

Your own internal policies dictate whether you are capturing 
sensitive data. This is different from PAN data, and pertains to 
card verification values (CVV, CV2, CVV2, etc.) and full magnetic 
stripe data.  

3.3 Mask PAN when displayed (the first six and last four 
digits are the maximum number of digits to be displayed. 

The Server has no means for rendering or displaying PAN or any 
other sort of data. 

3.4 Render PAN, at minimum, unreadable anywhere it is 
stored. 

Encrypt PAN or other sensitive data using the Server’s optional 
OpenPGP encryption module or 3rd-party disk encryption 
utilities. 

 3.4.1 Logical access and decryption keys disk must 
be managed independently for disk-level encryption 

This requirement precludes you from using Microsoft’s 
Encrypting File System (EFS) from within the Server (or 
externally) as a means for encrypting stored PAN data. The 
Server  will warn you if EFS is being used.  

3.5 Protect encryption keys Only sub-administrators who have been specifically granted 
access can create access, or manage PGP, SSL, and SFTP keys.  

3.6 Document and implement all key management 
processes and procedures 

External to the Server.  

 3.6.1 Generation of strong cryptographic keys The Server PCI DSS HS disallows 512 or lesser bit lengths in the 
certificate/key creation wizards for HS-enabled sites, and sets 
the default bit-length to 2048 bits for new keys. When importing 
SSL or SFTP keys, the Server will warn if a weak key is imported. 

 3.6.4 Key management, destruction, or revocation 
of old keys  

EFT Server determines whether certificate keys used on the 
Server are current. The PCI DSS HS module checks the key length 
and expiration date only for the Server's SSL certificates (i.e. 
administration certificate and site certificates); client certificates 
(i.e. trusted certificates) are not checked. 
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REQUIREMENT 4: ENCRYPT TRANSMISSION OF CARDHOLDER DATA ACROSS OPEN, 
PUBLIC NETWORKS  

From the PCI DSS: 

Sensitive information must be encrypted during transmission over networks that are easily accessed by 

malicious individuals. Misconfigured wireless networks and vulnerabilities in legacy encryption and 

authentication protocols can be continued targets of malicious individuals who exploit these vulnerabilities 

to gain privileged access to cardholder data environments.   

PCI DSS Requirement How Requirement is Addressed with the Server 

4.1 Use strong 
cryptographic ciphers for 
transport protocols 

The Server provides secure protocols such as secure sockets layer (SSL), transport layer 
security (TLS), and SFTP (SSH2) for data transmission. For HS-enabled sites, the PCI DSS HS 
limits SSL versions to v3 or higher, and ciphers  to minimum of 128 bits. The Server can also 
force secure data transmission by automatically redirecting  incoming HTTP traffic to HTTPS.  

4.2 Never send 
unencrypted PANs by e-
mail. 

It is up to the administrator to ensure that PAN data is not included in user-generated e-
mails sent by the Server. The Server system-generated messages have no way of including 
PAN data in the body of the e-mail message. 

REQUIREMENT 5: USE AND REGULARLY UPDATE ANTI-VIRUS SOFTWARE 

From the PCI DSS: 

Malicious software, commonly referred to as "malware"—including viruses, worms, and Trojans—enters 

the network during many business approved activities including employees’ e-mail and use of the Internet, 

mobile computers, and storage devices, resulting in the exploitation of system vulnerabilities. Anti-virus 

software must be used on all systems commonly affected by malware to protect systems from current and 

evolving malicious software threats. 

The Server does not specifically provide antivirus functions; you should continue to rely on your current antivirus 

implementation. You can also configure the Server to block specific files or file types from being transferred. 

PCI DSS Requirement How Requirement is Addressed with the Server 

5.1  Deploy anti-virus software on all 
systems commonly affected by viruses 
(particularly PCs and servers) 

Data uploaded to the Server can (and should) be scanned for viruses 
independently of the Server; however, the Server can block the upload or 
download of certain file types based on their extensions.  

5.2 Ensure that all anti-virus mechanisms are 
current, actively running, and capable of 
generating audit logs. 

External to the Server  
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REQUIREMENT 6: DEVELOP AND MAINTAIN SECURE SYSTEMS AND APPLICATIONS  

From the PCI DSS: 

Unscrupulous individuals use security vulnerabilities to gain privileged access to systems. Many of these 

vulnerabilities are fixed by vendor-provided security patches, which must be installed by the entities that 

manage the systems. All critical systems must have the most recently released, appropriate software 

patches to protect against exploitation and compromise of cardholder data by malicious individuals and 

malicious software. 

Requirement 6 deals mainly with applications developed by the end-user, such as web applications.  

PCI DSS Requirement How Requirement is Addressed with the Server 

6.1 Ensure that all system components 
and software have the latest vendor-
supplied security patches installed. 
Install relevant security patches within 
one month of release. 

The latest version of the Server is always available at 
http://www.globalscape.com/support/eft.aspx. 

6.2 Establish a process to identify newly 
discovered security vulnerabilities.  

GlobalSCAPE notifies its customers via e-mail if a security vulnerability or exploit 
patch is available for download. 

6.3 - 6.3.7 Develop software applications 
based on industry best practices and 
incorporate information security 
throughout the software development 
life cycle. 

This requirement and sub-requirements relate to policies and procedures for 
deploying applications and patches from testing through production. However, 
EFT Server meets the "incorporate information security" requirement by the use 
of PCI DSS security messages in our product (e.g. in accordance with PCI DSS, 
affecting authentication and password management, transport management, 
auditing, etc.). 

6.4 Follow change control procedures for 
all changes to system components. 

Depends on your company's policies. 

 6.4.4 Back-out procedures Always back-up the Server’s configuration data for disaster recovery and change-
control best practices. Refer to Backing Up or Restoring Server Configuration for 
details of using the Backup and Restore wizard. 

6.5 - 6.5.9 Develop all web applications 
based on secure coding guidelines, such 
as Open Web Application Security 
Project Guidelines. Review custom 
application code to identify coding 
vulnerabilities. Cover prevention of 
common coding vulnerabilities in 
software development processes. 

The Server is constantly evaluated and tested for security vulnerabilities and 
exploits. Any problems found are immediately remediated and communicated to 
our customers. 

 

  

http://www.globalscape.com/support/eft.aspx
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REQUIREMENT 7: RESTRICT ACCESS TO CARDHOLDER DATA BY BUSINESS NEED-TO-
KNOW 

From the PCI DSS: 

To ensure critical data can only be accessed by authorized personnel, systems and processes must be in 

place to limit access based on need to know and according to job responsibilities. 

PCI DSS Requirement How Requirement is Addressed with the Server 

7.1 Limit access to computing 
resources and cardholder 
information only to those 
individuals whose job requires such 
access. 

Each user account defined in the Server inherits settings from the Settings 
Template, or you can define settings specific to a user. Permission Groups set user 
virtual file system (VFS) permissions to folders. You can enable and disable user 
access to the Server resources by user, Group, Settings Template, Site, and Server. 
You can also grant or deny access by IP address. 

7.2 Establish a mechanism for 
systems with multiple users that 
restricts access based on a user’s 
need to know.  

The Server provides groups, virtual folders, and settings templates  for segregating 
and controlling user access. In addition, delegated administrators or help-desk 
users can be granted varying levels of control over server settings and resources. 

  REQUIREMENT 8: ASSIGN A UNIQUE ID TO EACH PERSON WITH COMPUTER ACCESS 

From the PCI DSS: 

Assigning a unique identification (ID) to each person with access ensures that each individual is uniquely 

accountable for his or her actions. When such accountability is in place, actions taken on critical data and 

systems are performed by, and can be traced to, known and authorized users.  

PCI DSS Requirement How Requirement is Addressed with the Server 

8.1 Identify all users with a unique user name before 
allowing them to access system components or 
cardholder data. 

Each user account defined in the Server has a unique username. 

8.2 In addition to assigning a unique ID, employ at least 
one of the following methods to authenticate users: 

 Password 

 Token devices (e.g., SecureID, certificates, 
public key) 

 Biometrics 

The Server supports standard passwords, one-time-passwords 
(OTPs), certificate, and public-key authentication mechanisms. 

8.3 Implement two-factor authentication for remote 
access to the network by employees, administrators, 
and third parties. Use technologies such as remote 
authentication and dial-in service (RADIUS) or terminal 
access controller access control system (TACACS) with 
tokens, or VPN (based on SSL/TLS or IPSEC) with 
individual certificates. 

In the Server, two-factor authentication can be achieved with SSL-
based logins for administrator sessions.  

8.4 Encrypt all passwords during transmission and 
storage on all system components. 

All user authentication passwords are stored as a one-way, non-
reversible hash. Authentication credentials for automated, 
outbound sessions are stored using strong encryption.  

8.5 Ensure proper user authentication and password 
management for non-consumer users and 
administrators on all system components. 

Refer to sub-requirements for specific implementation. 
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PCI DSS Requirement How Requirement is Addressed with the Server 

 8.5.1 Control addition, deletion, and modification 
of user IDs, credentials, and other identifier 
objects  

The Server allows privileged sub-administrators to add and remove 
users and set permissions using automated tools or via the 
Administrator interface. 

 8.5.2 Verify user identity before performing 
password resets  

The Server requires user authentication prior to a user-initiated 
password reset. Sub-administrators can reset user passwords 
manually, after they verify the identity of the user.  

 8.5.3 Requires users to reset their passwords to a 
unique value upon first use  

The Server PCI DSS HS can force users to change their passwords 
upon initial login.  

 8.5.4 Immediately revoke access for any 
terminated users  

When a Server account is disabled, expired, or removed, the user 
can no longer access the Server. The Server can also forcibly 
disconnect problem users. 

 8.5.5 Require that accounts be removed after 90 
days of inactivity 

The Server PCI DSS HS can disable or remove inactive users after a 
specified period of time (set to 90 by default). 

 8.5.6 Enable accounts used by vendors for remote 
maintenance only during the time period needed  

The Server can automatically expire an account on a specific date; 
however, it does not automatically enable accounts. If a user 
account needs to be enabled, for example, every Friday from noon 
to 1 p.m., the Server administrator must manually enable the 
account each time. 

 8.5.7 Communicate password procedures and 
policies to all users who have access to cardholder 
data 

When you create a new user, you have the option of e-mailing the 
user's credentials to an e-mail address that you specify. You can 
edit the default text of that e-mail (Credentials.txt) to include your 
organization's password policies and procedures. 

 8.5.8 Do not use generic (shared) 
accounts/passwords 

The Server disallows the "Anonymous" password type for HS-
enabled sites anywhere that the password type is selectable.  

 8.5.9 Change user passwords at least every 90 days The Server PCI DSS HS allows you to enforce automatic expiration 
of passwords for administrators and users. Users will be notified of 
pending expiration and are prompted to change their password 
once expired.  

 8.5.10 Require a minimum password length of at 
least seven characters 

The Server allows you enforce the generating of complex 
passwords using multiple criteria, including minimum length.  

 8.5.11 Use passwords containing both numeric and 
alphabetic characters 

The Server provides multiple password complexity settings 
including definition of alphanumeric sub-options, disallowing words 
contained in a dictionary file, using the username as a password, 
cyclical passwords, and more. 

 8.5.12 Cyclical passwords not allowed (up to 4 
previous passwords) 

The Server PCI DSS HS remembers password history and prevents 
the reuse of passwords for administrators and users. 

 8.5.13 Limit repeated access attempts The Server allows you to limit repeated access attempts by locking 
out a user or an administrator after <n> attempts within <n> 
minutes.  

 8.5.14 Set the lockout duration to thirty minutes or 
until administrator enables the user ID 

The Server allows you to specify a lockout duration of 30, 60, or 90 
minutes at the Server, Site, Settings Template, or per user. 

 8.5.15 Idle sessions should timeout and require 
login credentials to continue 

The Server has an idle timeout setting that applies across all 
connection protocols supported, for both users and administrators.  

 8.5.16 Authenticate all access to any database 
containing cardholder data. This includes access by 
applications, administrators, and all other users  

The Server provides multiple authentication options for accessing 
server resources, including AD/NTLM, LDAP, ODBC based, and the 
Server’s proprietary authentication manager.  
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REQUIREMENT 9: RESTRICT PHYSICAL ACCESS TO CARDHOLDER DATA  

From the PCI DSS: 

Any physical access to data or systems that house cardholder data provides the opportunity for individuals 

to access devices or data and to remove systems or hardcopies, and should be appropriately restricted.  

This requirement relates to restricting physical access to the computer room or data center, and destroying 

transportable media, which are a function of organizational security, not the Server.  

PCI DSS Requirement How Requirement is Addressed with the Server 

9.1 - 9.9 Use appropriate facility entry controls to limit 
and monitor physical access to systems that store, 
process, or transmit cardholder data. 

External to the Server 

9.10 - 9.10.1 Destroy media containing cardholder data 
when it is no longer needed for business or legal 
reasons as follows  

Primarily deals with physical media, except for sub-requirement 
9.10.2 

 9.10.2 Purge, degauss, shred, or otherwise destroy 
electronic media so that cardholder data cannot be 
reconstructed  

The Server includes a data-wiping algorithm for sanitizing deleted 
data on disk. This option is an approved compensating control as 
documented in PCI DSS Security Audit Procedures v1.1. 

REQUIREMENT 10: TRACK AND MONITOR ALL ACCESS TO NETWORK RESOURCES AND 
CARDHOLDER DATA 

From the PCI DSS: 

Logging mechanisms and the ability to track user activities are critical in preventing, detecting, or 

minimizing the impact of a data compromise. The presence of logs in all environments allows thorough 

tracking, alerting, and analysis when something does go wrong. Determining the cause of a compromise is 

very difficult without system activity logs. 

PCI DSS Requirement How Requirement is Addressed with the Server 

10.1 Establish a process for linking all 
access to system components to each 
individual user (audit trails). 

The Server's Auditing and Reporting Module (ARM) allows you to generate 
preconfigured reports of the Server activity. 

10.2  Implement automated audit trails for 
all system components to reconstruct the 
following events: 

ARM can generate preconfigured reports of all the Server activity. EFT 
Server determines whether the audit database is connected and properly 
configured. 

10.3 Record at least the following audit 
trial entries for all system components for 
each event: 

ARM scans each PCI DSS requirement addressed in the Server, and reports 
on the PCI DSS-compliance status of each (Pass, Fail, or Warning). The 
report  also provides a description of the requirement tested for each item. 
For failed requirements, the report presents a reason the non-compliant 
setting was used, if you provided one at the time that particular setting was 
disabled/changed.  

10.4 Synchronize critical system clocks and 
times 

External to the Server 

10.5 Secure audit trails so that they cannot 
be altered. 

The Server’s ARM reports are only available to users who can access the 
Server computer. External processes can be used to encrypt and/or record 
the hash values of logs for non-repudiation purposes. Access to the Server’s 
ARM reports can be optionally granted to sub-administrators. 

10.6 Review logs daily You can configure the Server to generate a daily PCI DSS compliance report 
on all related the Server settings and send it via e-mail to the appropriate 
recipient(s). 
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PCI DSS Requirement How Requirement is Addressed with the Server 

10.7 Retain audit history for at least one 
year, with a minimum of three months 
available for analysis. 

External to the Server 

REQUIREMENT 11: REGULARLY TEST SECURITY SYSTEMS AND PROCESSES  

From the PCI DSS: 

Vulnerabilities are being discovered continually by malicious individuals and researchers, and being 

introduced by new software. System components, processes, and custom software should be tested 

frequently to ensure security controls continue to reflect a changing environment. 

System, process, and software testing is not a feature of the Server; however you can use the daily compliance 

Report as a guide to determining where you might need to adjust settings to bring them into PCI DSS compliance. 

You can also use the guidelines provided in Best Practices for Configuration and Validation to assist you with 

periodic testing. 

PCI DSS Requirement How Requirement is Addressed with the Server 

11.1 - 11.5 Requirements relating to regular testing of 
security systems and processes. 

These requirements are external to the Server and are 
defined by your organizational policy. 

REQUIREMENT 12: MAINTAIN A POLICY THAT ADDRESSES INFORMATION SECURITY  

From the PCI DSS: 

A strong security policy sets the security tone for the whole company and informs employees what is 

expected of them. All employees should be aware of the sensitivity of data and their responsibilities for 

protecting it. For the purposes of this requirement, "employees" refers to full-time and part-time 

employees, temporary employees and personnel, and contractors and consultants who are "resident" on 

the company’s site.  

This is not a feature of the Server; however, you might consider using the Server as a component of your 

organization's security policy. The Server's ability to automatically generate and e-mail daily reports will help you 

stay on top of daily operations and security practices, from monitoring user connections, including failed 

connections, to changes in security settings. 

PCI DSS Requirement How Requirement is Addressed with the Server 

12.1 - 12.9 These requirements have to do with maintaining a 
policy that addresses information security 

These requirements are external to the Server and are 
defined by your organizational policy. 
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CREATING A HIGH SECURITY SITE 

You can create a Site with features that will help you comply with PCI DSS requirements--or if you just want a 

higher level of security with a Site that can monitor, report, and/or warn you when any of the high security settings 

are changed to a less secure mode. When you run the Server and Site creation wizards, you have the option to 

create a Site with or without high security features. If you choose to create a high security Site, the Site Setup 

wizard also determines the status of the Auditing and Reporting Module (ARM); if high security is enabled, but 

ARM is not, a warning message appears to inform you that you must enable ARM on the Server before creating the 

Site.  

For details of configuring Servers and Sites, and enabling ARM on the Server, refer to the following topics: 

 Server Setup Wizard 

 Configuring the Auditing and Reporting Module 

 Before creating a high security Site, review all of the topics in The High Security Module section. 

You will need the following information to create and configure a high security Site: 

 Site name, listening IP address, and administrator port (you should use a port other than the default of 

1100) 

 Site root folder path (location) 

 User authentication type (for HS-enabled Sites, only EFT Server authentication and ODBC authentication 

are available) 

 Connection information (host IP address, etc.)  

 DMZ Gateway IP address and port (you should use a port other than the default of 44500) 

 SSL keys/certificate/ciphers/version information 

 

Compliance with PCI DSS requires that users change their password upon initial login. Because the 
SSL certificate-based login and the SFTP Public key only login methods do not use a password, they 
potentially violate the PCI DSS and are, therefore, not available with HS-enabled Sites.  

 IP address and port for Auditing and Reporting database (ARM must be enabled for HS-enabled Sites) 

 If the SMTP server requires authentication, you will need to know the administrator e-mail address and 

SMTP server name, port, and login information (for e-mailing the compliance Report). 

 

If you use default values for administrator port (1100), DMZ Gateway port (44500), FTP banner 
message, or SFTP banner message, a warning appears in which you must change the value or provide 
a reason for using the default. The reason that you provide will appear in the Description field of the 
compliance report. 

The wizard performs several checks and asks you to provide information based on the results of those checks, 

including: 

 Is the HS module in the trial period? 

 If not in trial period, is the module activated? 

 Is ARM enabled? 

 Which authentication method are you using to authenticate users? 

 Is remote administration enabled? 

 Is SSL enabled for remote administration? 
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 Are password security options for delegated administration set? 

 Is the daily PCI DSS report enabled? 

 Is FTPS/HTTPS/SFTP enabled? 

 Is the default banner for SFTP used? 

The wizard is quite intuitive and provides instructions where necessary. The wizard pages change based on your 

selections. The procedure below walks you through the most common scenarios. 

 

Because the Server doesn't manage NT/LDAP accounts, when you create a High Security Site that uses 
LDAP or Windows Active Directory authentication, the following features are not available and not 
audited for the compliance Report: 

 Complex Passwords 

 Password History 

 Password Reset 

 Removing Inactive User Accounts 

 

To configure a high security Site 

1. Do one of the following: 

 After Server setup is complete, the Site Setup wizard appears.   

 In the Administrator, connect to the Server, and click Configuration > New Site.  

The Site Setup wizard Welcome page appears.  
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2. Click Strict security settings, then click Next. The Site name page appears. 

3. In the Site name box, type a name a unique name for the Site. The default name is MySite, but you 

change it to anything you want. The name you provide here will appear in the Server tree in the left pane 

of the Administrator and in reports and messages. 

4. In the Listening IP box, specify the IP address the Site should listen on, or leave the default of All 

Incoming.  

5. Click Next. The Site Root Folder page appears. 

6. In the Site root box, leave the default or click Browse to specify the root folder. 

7. In the Additional options area, select the check boxes as needed: 

 Select the Create UNIX-style subfolders check box to create Usr, Pub, Bin, and Incoming folders 

with appropriate permissions under the root folder. This is only necessary if you are trying to 

mimic a typical default *nix Server setup. 

 Select the Automatically assign home folders to newly created users t o automatically create a 

user folder under \Site Root\Usr\ when a new user is added. 

8. Click Next. The User Authentication page appears. 

9. In the Authentication type list, specify one of the following authentication methods that this Site will use 

to authenticate user connections: 

 GlobalSCAPE Server Authentication  

 Windows Active Directory Authentication - If you are using this method, also refer to Windows 

Active Directory Authentication. 

 LDAP Authentication - If you are using this method, also refer to LDAP Authentication. 

 ODBC authentication - If you are using ODBC authentication, also refer to ODBC Authentication.  

10. Click Next. The Server Authentication settings page appears.  

11. The default path to store the user database appears in the box. If you want to store the user database in a 

different location, click the Browse icon or type the path in the box. 

12. Click Next. The Perimeter Network Security page appears. 

13. Specify whether to connect the Site to the Server's DMZ Gateway.  

 If you choose not to connect to DMZ Gateway, click in the text box and provide a reason for not 

using DMZ Gateway. (The reason will appear in the Description box of the compliance report.) 

 If you choose to connect to DMZ Gateway, click Connect this Site to DMZ Gateway Server, 

specify its IP address and port, then click Test Connection. 

14. Click Next. If you specified a default port for DMZ Gateway, the Vendor Defaults page appears.  

15. Change the port number to a non-default number, or provide a reason for keeping the default port. (The 

reason will appear in the Description box of the compliance report.) 

16. Click Next. If the Server was configured with the default Administrator port of 1100, the Vendor Defaults 

page appears for you to change the Administrator port or provide justification for using the default.  

17. Click Next. The Data Retention and Disposal page appears. 

18. Do one of the following: 
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 Specify the file extensions to be deleted, the frequency, and the folder from which to delete 

them. 

 Click Don't set a data retention and disposal policy, then, in the text box, provide the 

justification and compensating control. (The reason will appear in the Description box of the 

compliance report.) Refer to Specifying File Deletion Options for more data wiping options. 

19. Click Next. The Administrator Account Password Security page appears. 

20. Keep the default of enabling the administrator account password security settings or click Continue 

without changing administrator account password security settings, then provide the justification and 

compensating control. (The reason will appear in the Description box of the compliance report.) 

21. Click Next. The Daily PCI DSS Audit Report page appears. 

22. Do one of the following: 

 Click Audit and send report daily, then provide the recipient's e-mail address. (The SMTP settings 

were configured during Server setup.) 

 Click Do not generate daily report and type a reason for not generating the report automatically. 

For example, you can generate the report on the fly in the Administrator. (The reason will appear 

in the Description box of the compliance report.) 

23. Click Next. The Data Sanitization page appears. 

24. Do one of the following: 

 Click Enable data wiping, then, in the Data sanitization method box, click which method  the 

Server is to use to wipe data.  

 Click Windows default (no wipe) and type a reason for not specifying a data sanitization method 

for the Server to use. For example, you might be using a third-party tool for sanitization. (The 

reason will appear in the Description box of the compliance report.) 

25. Click Next. The Connection Protocols page appears.  

26. Select one or more check boxes for the protocol(s) and specify the port numbers that this Site will use to 

connect to the Server. 

 

If you specify plain-text FTP or HTTP, after you click Next, the Server will prompt you to disable these 
unsecure protocols or continue and supply justification. 

 If you choose SSL, click SSL options and SSL certs for further configuration.  

o Click SSL options to define the allowed SSL versions and ciphers. 

 

Most Web browsers do not have TLS turned on by default, which causes things like 
redirecting to the account management page to fail, because the browser cannot 
make the SSL connection, and it returns an error. For this reason, default SSL 
security options for a High Security Site include SSL 3.0 in addition to TLS 1.0. 

o Click SSL certs to define the SSL certificate to use for this Site. 

 

If you do not enable SSL, you will not be able to connect to the Server from a 
remote the Administrator. Refer to Creating Certificates, Importing a Certificate 
into the Trusted Certificate Database, and Importing Certificates from Microsoft IIS 
5 for information regarding certificates. 
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Regarding SSL certificate-based login, compliance with PCI DSS requires that users 
change their password upon initial login. Because SSL certificate-based login does 
not use a password, it potentially violates the PCI DSS and is, therefore, not 
available with HS-enabled Sites.  

 If you choose SFTP, click SFTP options and SFTP keys for further configuration. The Server will 

automatically generate SFTP keys if SFTP is selected. 

 

Because the SFTP Public key only method does not use a password, it potentially violates 
the PCI DSS and is, therefore, not available with High Security Sites. You can, however, use 
the Public Key and Password method. 

 If you choose AS2 over HTTP/S, click Configure to specify your AS2 identifier and certificate 

information. 

27. Click Next. The Vendor Default page appears if the default SFTP banner message is used on the Server. 

28. Do one of the following: 

 Click Change SFTP message banner to, then provide the software version and, optionally, 

comments. 

 Click Continue without making any changes, then type the reason for keeping the default 

banner message.  

29. Click Next. The Site Setup Completed page appears. 

30. You are offered the option of continuing to the User Creation wizard or quitting the wizard. Click an 

option, then click Finish. If you chose Run New User Creation wizard, the User Creation wizard Welcome 

page appears.  

The HS-enabled Site appears in the tree on the Server tab.  

WARNINGS FOR PCI-DSS VIOLATIONS 

In the Server, when the Server warns you of a non-compliant setting, if you do not specify a setting that meets the 

PCI DSS requirement, you can specify the compensating controls (hardware, software, or policy) you are using to 

satisfy the requirement. The information that you provide in the warning message appears in the Compliance 

report, which you can provide to Qualified Security Assessors (QSAs) or Approved Scanning Vendors (ASVs), 

individuals who are certified by the PCI Security Standards Council as being qualified to validate compliance to the 

PCI DSS requirements. 

For High Security Sites, if you attempt to change a setting that would cause the Site, Settings Template, or a user 

account to no longer meet PCI DSS requirements, when you click Apply to save the changes on the Server, the 

Server does not commit the change, and a warning message appears that describes one or more violations, as 

shown below.  
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If you do not activate the HS module, this feature is disabled when the 30-day trial is expired. 

In the PCI DSS Violations dialog box, you can accept the non-compliant setting (Apply this change anyway) and 

provide a reason for accepting each setting (e.g., if you are using an alternate solution) or you can discard the 

change (Don't apply this change). If you accept the change and provide a reason, the warning and the reason that 

you provided appear in the Compliance report.  

 

 

ARM is used to store the PCI DSS violations. If ARM is disabled, the violations are still recorded; however, the 
justifications that you type when accept a non-compliant setting are not recorded in the database. You can 
still run the Compliance report, but the justifications that you provide will not appear in the report. 

If PCI DSS Violations are detected 

1. Click a violation in the list, then do one of the following for each of the violations listed: 

o If you want to correct the violation, click Don't apply this change, click Continue, correct the 

setting, then click Apply.  

o If you want to keep the non-compliant setting, click Apply this change anyway, then in the 

Provide justification and describe compensating control box, type the reason for keeping the 

non-compliant setting. The description will appear in the compliance report. 

2. Click Continue. You must address each violation in the list before you can click Continue.  

Reporting of failed items occurs at the highest level of failure only, except in the case of an explicit setting that 

violates compliance. For example: 

 If a Site failed compliance because Enforce strong (complex) passwords was disabled (check box cleared), 

the report is generated for the entire Site.  
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 If Enforce strong (complex) passwords was enabled for the Site, but was disabled for a Settings Template, 

the report is generated for the Settings Template.  

 If Enforce strong (complex) passwords was enabled at the Site and Settings Template, but disabled for 

some users, the Server reports for each of those users.  

 If Enforce strong (complex) passwords was disabled at the Site level, enabled at the User Setting Level, 

and disabled for a user, the warning appears for the Site violation and for the user account that is in 

violation. 

SECURITY AUDITING 

From the PCI DSS:  

For service providers required to undergo an annual onsite review, compliance validation must be 

performed on all system components where cardholder data is stored, processed, or transmitted, unless 

otherwise specified.   

Review the topics below for details of generating a daily compliance report to help you maintain security standards 

and compliance with the PCI DSS requirements. 

Compliance with the PCI DSS is an ongoing process, not a "set-it-and-forget-it" project. As part of maintaining 

compliance, you need to identify areas in which your organization is not in compliance. You can also use the PCI 

DSS compliance requirements to address key information security issues and risks, especially in relation to other 

relevant regulations (e.g., HIPAA, GLBA, state privacy/disclosure laws, CALEA). In addition to maintaining 

compliance, periodic self-assessment is an important tool for identifying areas that need improvement, and can 

help save costs if an assessor is required for validation of PCI DSS compliance.  
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THE PCI DSS COMPLIANCE REPORT 

Both trial and full versions of the HS module include the ability to audit the Server for compliance with the PCI DSS 

requirements. EFT Server's Auditing and Reporting module (ARM) scans all PCI DSS requirements addressed in the 

Server, and reports on the compliance status of each (Pass, Fail, or Warning). The report also provides a 

description of the requirement tested for each item. For failed requirements, the report presents a reason the 

non-compliant setting was used, if you provided one at the time that particular setting was disabled/changed.  

The ARM is used to store the PCI DSS violations. If the ARM is disabled, the violations are still recorded; however, 

the justifications that you type when you accept a non-compliant setting are not recorded in the database. You can 

still run the compliance report, but the justifications that you provide will not appear in the report. 

To generate the PCI DSS compliance report 

 To generate the report in real time, do one of the following:  

o On the main menu, click Report > PCI DSS HS Compliance Report. A report is generated for each 

HS-enabled Site. 

o In the Site's Event Rule node, click Report Event. In the right pane, click Run Now. The report is 

e-mailed to the e-mail address defined in the Rule. 

 To generate the report on a recurring schedule, define a Scheduler Timer Event Rule  with the Generate 

Report Action. In the Event Rule, you can define whether to e-mail the report and/or save the report to a 

file. A report is generated specific to the Site on which the Event Rule is configured. 

For a description of each PCI DSS requirement covered in the report, refer to Possible HS Compliance Report 

Outcomes. 

For details of creating and generating reports, refer to Auditing and Reporting Module (ARM). 

AUTOMATING THE PCI DSS COMPLIANCE REPORT 

When you create a High Security Site, the Server creates an Event Rule Generate Report Action that executes one 

of the Server’s Auditing and Reporting Module's (ARM) canned or customer created/modified reports, such as the 

PCI DSS Compliance Report, from the Timer, Monitor, File System, and other Events.  

 

The report is converted to HTML and then e-mailed or saved to a file specified by the Server administrator. 

You can edit the Rule or define your own and specify a predefined or custom date range (e.g., "last week"), report 

output format (e.g., PDF, HTML), optional parameters (which can take variables if applicable to the specified 

Action), and filters.  

Optionally, you can run the PCI DSS Compliance Report "on the fly" on the Administrator main menu. When the 

report is generated on the fly, the report audits "point-in-time" status rather than past status. If the HS module is 

not activated, the PC DSS Compliance Report is not available.  
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PCI DSS POSSIBLE COMPLIANCE REPORT OUTCOMES 

The PCI DSS Compliance Report displays the requirement name, status (PASSED, FAILED, WARNING), description of 

the requirement, notes that you typed in the Warning box (explanation, justification, or compensating control), 

report name, and date the report was generated, and description of the report. The report is organized by PCI DSS 

Section/Requirement, then by Status (Warnings followed by Errors), then by Scope (Site followed by Settings 

Template, followed by User), with data elements for the names of the items (Site, Settings Template, or User) 

sorted alphabetically.  

 

If the report is generated after the HS Module trial has expired, the report contains the following statement 

instead of the standard report: 

The HS Module has expired. Please contact your GlobalSCAPE sales representative or 

visit http://www.globalscape.com/eft for more details. 

The status of the PCI DSS requirements described below appears in the report: 

PCI DSS DATA IN THE DMZ 

EFT Server determines whether the DMZ Gateway is enabled, and whether a socket connection to the DMZ 

Gateway can be made. Possible outcomes include: 

Requirement Status Description 

PCI DSS 1.3.4 
Perimeter Security 

PASSED The Server's DMZ Gateway enabled and connected 

PCI DSS 1.3.4 
Perimeter Security 

WARNING The Server's DMZ Gateway IP and port defined; however the Server cannot 
connect to the DMZ Gateway  

PCI DSS 1.3.4 
Perimeter Security 

WARNING The Server's DMZ Gateway is disabled. If the Server is deployed in the DMZ, 
ensure that sensitive data is segregated from the DMZ or risk non-compliance 
with this requirement. 

DEFAULT VALUES 

EFT Server determines whether any default values are specified for Admin login port (1100), DMZ Gateway Server 

port (44500), FTP banner message, or SFTP banner message. Possible report outcomes include: 

Requirement Status Description 

PCI DSS 2.1 Change 
Vendor Defaults 

PASSED No the Server supplied default values are being used (ports and banner messages 
checked) 

PCI DSS 2.1 Change 
Vendor Defaults 

FAILED [Admin Login Port, DMZ Gateway Connection Port, Default FTP Banner Message, or 
Default SFTP Banner Message] is the same as the default supplied. You should 
change the default port to a value between 1024 and 65535. 

 

 

A separate failure description appears in the report for each setting that uses a default value. 



EFT Server™ version 6 

 

626  

DISABLING UNSECURE PROTOCOLS 

EFT Server determines whether any non-secure protocols are enabled at the Site Level, Settings Template, or user 

account and reports for each Site, Settings Template, or user account failed. Possible report outcomes include:  

Requirement Status Description 

PCI DSS 2.2.2 Disable all 
non-secure protocols 

PASSED Only secure protocols are being used for this Site. 

PCI DSS 2.2.2 Disable all 
non-secure protocols 

FAILED [FTP or HTTP] protocol is enabled for [Site, User Settings Level, or specific user 
name]. You should disable these protocols. Alternately, you must have ample 
justification and documentation per PCI 1.1.6 and 1.1.7 for continued use of non-
secure protocols. 

DISK QUOTA AND AUTO-BAN METER 

EFT Server determines whether disk quota is enabled, auto-ban meter is set to Off, Very Low, or Low, or the option 

to pass login credentials to Event Rules is enabled, and whether site-to-site transfers are enabled. Possible report 

outcomes include: 

Requirement Status Description 

PCI DSS 2.2.3 Configure security 
system parameters set to prevent 
misuse  

PASSED System security parameters are configured to prevent misuse. 

PCI DSS 2.2.3 Configure security 
system parameters set to prevent 
misuse  

WARNING  The option to pass user login credentials as an event rule variable 
(Site settings) should be disabled to comply with PCI 2.2.3 

PCI DSS 2.2.3 Configure security 
system parameters set to prevent 
misuse  

WARNING  Auto-ban connection flood sensitivity is too low. Please set to 
Medium, High, or Very High to better comply with this 
requirement.  

PCI DSS 2.2.3 Configure security 
system parameters set to prevent 
misuse  

WARNING  You have not specified a disk quota for a user or Settings Template. 
A malicious user could upload more data than available disk space, 
effectively disabling the Server.  

PCI DSS 2.2.3 Configure security 
system parameters set to prevent 
misuse  

WARNING  Anti-timeout blocking is currently disabled for [Site]. 

PCI DSS 2.2.3 Configure security 
system parameters set to prevent 
misuse  

WARNING Site-to-site transfers are currently allowed for [Site]. 

PCI DSS 2.2.3 Configure security 
system parameters set to prevent 
misuse  

WARNING NOOP FTP command is currently allowed for [Site]. 

ENCRYPT CONSOLE ACCESS 

EFT Server determines whether remote administration is enabled, and if so, if SSL is enabled. Possible report 

outcomes include: 

Requirement Status Description 

PCI DSS 2.3 Encrypt all non-console access PASSED  Non-console administrative access is securely configured. 

PCI DSS 2.3 Encrypt all non-console access FAILED  Remote administration is enabled without SSL turned on. 
Either enable SSL or disable remote access. 
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CARDHOLDER DATA STORAGE 

EFT Server determines whether any Clean-up Actions are defined, and warns if none is found. Possible report 

outcomes include: 

Requirement Status Description 

PCI DSS 3.1 Develop a data 
retention and disposal policy  

PASSED Does not appear in report if passed. 

PCI DSS 3.1 Develop a data 
retention and disposal policy  

WARNING  No disk quota is set for [Site]. Enable disk quotas to limit data storage 
amounts to what is required for business purposes according to your 
company's data retention policy. 

PCI DSS 3.1 Develop a data 
retention and disposal policy  

WARNING  No Clean-up Action was found. Define a Clean-up Action in a Scheduler 
(Timer) Event Rule to automate the disposal of deprecated data. 

ENCRYPTING FILE SYSTEM (EFS) FILE SHARING 

EFT Server determines whether the EFS option is enabled on the VFS root folder and physical virtual subfolders 

only (not on the files within those folders) and warns if EFS is enabled. Possible report outcomes include: 

Requirement Status Description 

PCI DSS 3.4.1 Logical access and 
decryption keys disk must be managed 
independently for disk-level encryption 

PASSED Encrypting File System (EFS) is not enabled through the 
Administrator. 

PCI DSS 3.4.1 Logical access and 
decryption keys disk must be managed 
independently for disk-level encryption 

WARNING  Encrypted File Store (EFS) is enabled in the Virtual File 
System. Make sure you are using an alternate disk or file 
encryption method as EFS encryption does not comply with 
PCI 3.4.1 

GENERATE STRONG KEYS 

EFT Server determines whether the primary SSL or SFTP key is using a 512-bits-or-fewer key length. Possible report 

outcomes include: 

Requirement Status Description 

PCI DSS 3.6.1 Generation 
of strong keys 

PASSED Strong server SSL/SFTP keys used. 

PCI DSS 3.6.1 Generation 
of strong keys 

WARNING Site [SSL|SFTP] certificate key has a length of 1024 bits. While 1024 bits is 
acceptable, 2048 or higher bit-length keys are recommended. 

PCI DSS 3.6.1 Generation 
of strong keys 

FAILED Server administration [SSL|SFTP] certificate key has a length of [n] bits. While 
1024 bits is acceptable, 2048 or higher bit-length keys are recommended. 
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KEY MANAGEMENT, DESTRUCTION, OR REVOCATION OF OLD KEYS 

EFT Server determines whether certificate keys used on the Server are current. The HS module checks the key 

length and expiration date only for the Server's SSL certificates (i.e. administration certificate and site certificates); 

client certificates (i.e. trusted certificates) are not checked. Possible report outcomes include: 

Requirement Status Description 

PCI DSS 3.6.4-5  Key management, 
destruction, or revocation of old keys  

PASSED All certificates are current. 

PCI DSS 3.6.4-5  Key management, 
destruction, or revocation of old keys  

WARNING One or more SSL certificates or SFTP keys have expired. You 
should remove that key from the key manager and replace it with 
a current version. 

USE STRONG CIPHERS AND PROTOCOL VERSIONS 

EFT Server determines whether any weak ciphers (<128 bit) or any version other than TLS or SSLv3 are enabled. 

Possible report outcomes include: 

Requirement Status Description 

PCI DSS 4.1 Use strong cryptographic 
ciphers for transport protocols 

PASSED Strong ciphers and protocols are being used. 

PCI DSS 4.1 Use strong cryptographic 
ciphers for transport protocols 

FAILED SSL cipher string was manually defined or unable to ascertain which 
ciphers were chosen. Please select SSL ciphers from the provided list 
(Security page in Server tab). 

PCI DSS 4.1 Use strong cryptographic 
ciphers for transport protocols 

FAILED One or more ciphers are less than 128 bit. Choose only 128-bit or 
higher ciphers for SSL and SFTP protocols. 

PCI DSS 4.1 Use strong cryptographic 
ciphers for transport protocols 

FAILED The SSL version is set to auto-negotiable or use SSLv2. You must set 
the protocol version to SSlv3 and/or TLS only per PCI 4.1 
requirements. 

LIMIT ACCESS TO COMPUTING RESOURCES 

EFT Server determines whether more than one administrator account has full control over EFT Server. Possible 

report outcomes include: 

Requirement Status Description 

PCI DSS 7.1  Limit access to computing 
resources only to those whose job 
requires such access  

PASSED Only one administrative account exists with full control over 
the Server 

PCI DSS 7.1  Limit access to computing 
resources only to those whose job 
requires such access  

WARNING There is more than one administrator with full control over the 
server. Ensure that only the minimum level of privileges 
necessary are granted to administrator accounts 
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PASSWORD AUDITING AND REPORTING 

EFT Server determines whether force password reset is enabled and audits the results.  

 

Because the Server does manage NT/LDAP accounts, when you create a High Security Site that uses LDAP or 
Windows Active Directory authentication, the Password Reset feature is not available and not audited for 
the HS Report. The report will indicate that the requirement has passed. 

Possible report outcomes include: 

Requirement Status Description 

PCI DSS 8.5.3 Users must reset their 
passwords upon first use   

PASSED Password expiration and forced reset is enabled 

PCI DSS 8.5.3 Users must reset their 
passwords upon first use   

FAILED  Password forced reset is disabled for [Site, User Settings 
Level, Delegated Administrator].  

REMOVING INACTIVE ACCOUNTS 

EFT Server determines whether the setting to remove user or administrator accounts after 90 days of inactivity 

option is disabled or set to a value > 90 days (at Admin, Site, Settings Template, user account). The Server reports 

on whether the user account option is set to Disable rather than Remove; and any removal of administrator or 

user accounts.  

 

Because the Server does manage NT/LDAP accounts, when you create a High Security Site that uses LDAP or 
Windows Active Directory authentication, the Removing Inactive User Accounts feature is not available and 
not audited for the HS Report. The report will indicate that the requirement has passed. 

Possible report outcomes include: 

Requirement Status Description 

PCI DSS 8.5.5 Remove inactive user 
accounts at least every 90 days  

PASSED Inactive accounts scheduled to be removed at least every 90 days. 

PCI DSS 8.5.5 Remove inactive user 
accounts at least every 90 days  

WARNING The option to disable or expire after <n> days of inactivity for [Site, 
Settings Template, user, or Administrators] is set to expire. For strict 
compliance, you should set that option to remove accounts rather 
than just expire those accounts.  

PCI DSS 8.5.5 Remove inactive user 
accounts at least every 90 days  

FAILED The option to remove or disable inactive accounts at least every 90 
days is currently disabled for [Site, Settings Template, user, or 
Administrators]. 

ANONYMOUS ACCOUNTS 

EFT Server determines whether any account has an anonymous password type. Possible report outcomes include: 

Requirement Status Description 

PCI DSS 8.5.8 Do not use generic 
(shared) accounts or passwords 

PASSED No anonymous accounts are present. 

PCI DSS 8.5.8 Do not use generic 
(shared) accounts or passwords 

FAILED The following account: [username] has an Anonymous type 
password. You should change this user's password to a normal or 
One Time Password type to be in compliance with section 8.5.8 of 
the PCI specification.  
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EXPIRING PASSWORDS 

EFT Server determines whether password expiration is enabled and audits the results.  

 

Because the Server does manage NT/LDAP accounts, when you create a HS-enabled Site that uses LDAP or 
Windows Active Directory authentication, the Password Reset feature is not available and not audited for 
the HS Report. The report will indicate that the requirement has passed. 

Possible report outcomes include: 

Requirement Status Description 

PCI DSS 8.5.9 Change user 
passwords at least every 90 days 

PASSED  Passwords are set to expire every <n> days. 

PCI DSS 8.5.9 Change user 
passwords at least every 90 days 

FAILED  Passwords are set to expire after a period of time greater than 90 
days (the maximum allowed) for %s, in violation of PCI 8.5.9 

PCI DSS 8.5.9 Change user 
passwords at least every 90 days 

FAILED  Passwords are not set to expire for [Site, User Settings Level, user, or 
Administrators]. 

MINIMUM PASSWORD LENGTH AND COMPLEXITY 

EFT Server determines whether complex password enforcement is enabled, records the value for the minimum 

password length used, and determines which password character sub-options are enabled.  

 

Because the Server does manage NT/LDAP accounts, when you create a HS-enabled Site that uses LDAP or 
Windows Active Directory authentication, the Complex Password  feature is not available and not audited for 
the HS Report. The report will indicate that the requirement has passed. 

Possible report outcomes include: 

Requirement Status Description 

PCI DSS 8.5.10-11 Require a 
minimum password length  

PASSED Password complexity is enabled and properly configured 

PCI DSS 8.5.10-11 Use 
alphanumeric passwords 

PASSED Password complexity is enabled and properly configured. 

PCI DSS 8.5.10-11 Use only 
strong passwords 

FAILED Enforce complex passwords is disabled for [Site, Settings Template, user, or 
Administrators]. You must enable complex passwords to meet these 
requirements. 

PCI DSS 8.5.10-11 Use only 
strong passwords 

FAILED Minimum password length is set to less than 7 at [Site, Settings Template, 
user, or Administrators]. Passwords must be 7 digits or greater to meet PCI 
8.5.10 and 8.5.11. 

PCI DSS 8.5.10-11 Use only 
strong passwords  

FAILED Require alpha chars and digits for passwords are not for [Site, Settings 
Template, user, or Administrators]. You must enable those options to 
comply with PCI 8.5.10 and 8.5.11. 
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PASSWORD REUSE  

EFT Server determines whether password history enforcement is enabled for the administrator, Site, Settings 

Template, or user account level.  

 

Because the Server does manage NT/LDAP accounts, when you create a High Security Site that uses LDAP or 
Windows Active Directory authentication, the Password History  feature is not available and not audited for 
the HS Report. The report will indicate that the requirement has passed. 

Possible report outcomes include: 

Requirement Status Description 

PCI DSS 8.5.12 Disallow reuse of 
previous passwords  

PASSED "Enforce password history" is enabled.  

PCI DSS 8.5.12 Disallow reuse of 
previous passwords  

FAILED "Enforce password history" is disabled for  [Site, Settings Template, user, 
or Administrators]. Enable this option to comply with this requirement. 

LOCKOUT DURATION 

EFT Server determines whether temporary lockout is enabled or set to a value > 6. Possible report outcomes 

include: 

Requirement Status Description 

PCI DSS 8.5.13 Limit repeated access 
attempts to no more than six  

PASSED Temporary lockout duration or account disable is set. 

PCI DSS 8.5.13 Limit repeated access 
attempts to no more than six  

FAILED Account lock occurs after <n> invalid attempts. Please set the 
value to between 1 and 6 to meet PCI DSS 8.5.13 requirements. 

PCI DSS 8.5.13 Limit repeated access 
attempts to no more than six  

FAILED Temporary account lockout or disable is disabled for accounts that 
fail repeated login attempts for Administrators.  

SESSION TIMEOUT 

EFT Server determines whether inactivity timeout is enabled, and if enabled, whether it is set to a value that 

exceeds 15 minutes. Possible report outcomes include: 

Requirement Status Description 

PCI DSS 8.5.15 Idle sessions should timeout 
and require login credentials to continue 

PASSED Inactivity timeout is enabled and properly configured. 

PCI DSS 8.5.15 Idle sessions should timeout 
and require login credentials to continue  

FAILED  Inactivity timeout not enabled or set to value exceeding 15 
minutes.  

DATA SANITIZATION 

EFT Server determines whether data sanitization is enabled, and if enabled. Possible report outcomes include: 

Requirement Status Description 

PCI DSS 9.10.2  Destroy electronic media so 
that cardholder data cannot be reconstructed.  

PASSED Data removal sanitization (wiping) is enabled. 

PCI DSS 9.10.2  Destroy electronic media so 
that cardholder data cannot be reconstructed.  

FAILED  Data sanitization is not enabled. Either enable wiping or 
make sure you have compensating controls in place to 
meet this requirement. 
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AUDIT DATABASE CONNECTION AND CONFIGURATION 

EFT Server determines whether the audit database is connected and properly configured. Possible report 

outcomes include: 

Requirement Status Description 

PCI DSS 10.2.3  Access to all audit trails   PASSED Server's Database Audit is connected. 

PCI DSS 10.2.3  Access to all audit trails   WARNING  Server's Database Audit is not connected or is not configured 
properly 

HS MODULE IN THE AUDITING DATABASE 

If you are not using the database included with the Server installer, refer to Configuring SQL Server as the 

Auditing Database for information about using an existing database. Administrators that prefer using command-

line tools can use oSQL to create the auditing database and tables. 

The file that contains the script for the PCI DSS tables, 0_table_EFT5_pci.sql is installed in a subfolder of the Server 

installation directory (e.g., C:\Documents and Settings\All Users\Application Data\GlobalSCAPE\EFT Server 

Enterprise\SQL Server). You do not have to create the tables manually. 

USING THE HS MODULE WITH THE  
SECURE AD HOC TRANSFER (SAT) MODULE 

Certain security features in the HS module (e.g., administrator password expiration and forced reset) are not 

compatible with the Secure Ad Hoc Transfer Module. If you are using the HS module and the SAT module with the 

Server, you should create a separate, non-PCI DSS Site that is used only for the Secure Ad Hoc Transfer module. 

Alternately, you can disable the features that are not compatible, but that would take the Site out of compliance 

with the PCI DSS.  

Administrator password expiration and forced reset are features that help your Site remain in compliance with the 

PCI DSS; however, those same features can cause problems with the SAT module. If the administrator password 

expires or changes, the value stored in the SAT module's configuration file is no longer valid. Since the value stored 

in the configuration file is not plaintext, you cannot change it by typing the new password in the file. 

The SAT module uses a temporary user account to upload files from the IIS computer to the temporary user's 

home directory on the Server. If the useProtocolForUpload value in the configuration file is set to anything 

other than -1 (file copy), the file cannot be uploaded to the temporary user account, because the password has not 

been reset on first logon, as required for PCI DSS compliance. When useProtocolForUpload is set to 

anything other than -1 (the default is 5), the force reset password feature should be disabled. 

The "force users to reset their password on initial login" option can be enabled on a High Security Site, if the 

useProtocolForUpload setting in the configuration file is set to -1 (which means File Copy). Since this is not 

the default option, a Server administrator must edit the file. Also, setting useProtocolForUpload to -1 (File 

Copy) is only a viable option if both the Server and IIS are installed on the same computer or the 

EFTRootFolderUNCPath value in the configuration file, which is blank by default, specifies a remote path on 

which the IIS computer can access the Server root folder.  
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The available settings for the useProtocolForUpload value are: 

-1 = File copy 

0 = FTP  

1 = FTPS_IMPLICIT 

2 = FTPS_EXPLICIT 

3 = SFTP2 

4 = HTTP 

5 = HTTPS 

6 = SOCKS4 

7 = SOCKS5 

8 = FTPS_AUTH_TLS 

The recommended configuration is to create a non-PCI Site for exclusive use by the SAT module and disable the 

password expiration and forced reset options. As always, if you have any questions or concerns regarding installing 

and configuring the Server for use with any of the modules, contact GlobalSCAPE Technical Support. 

ACTIVATING THE HS MODULE 

The HS module requires a separate license from the Server. A 30-day trial is available, and can start any time after 

the start of the Server trial.  

When the trial is expired, unless you activate the module, the following features are unavailable: 

 Ability to create a new High Security Site with the Site Setup wizard 

 Warning prompts when settings are changed that would violate PCI DSS compliance  

 Compliance Report (the report is still available, but the output is altered) 

 Expiration of passwords  

 Removal of inactive accounts  

 Enforcement of complex passwords  

 Account lockout  

 Session timeout  

 GUI control for HTTP>HTTPS  

 Data wiping  

If you activate the HS module after the trial has expired, the settings for the Server and any HS-specific 

configuration values are forced to reset.  

To activate the HS module 

1. In the Administrator, click Help > Enter HS module serial number. The Online Registration dialog box 

appears. 

2. Refer to Activating the Software for details. 

  

http://www.globalscape.com/support/techsupport.aspx
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THE AUDITING AND REPORTING MODULE 

The topics below provide the procedures for configuring and using the Auditing and Reporting module (ARM) with 

EFT Server. 

INTRODUCTION TO THE AUDITING AND REPORTING MODULE 

The Auditing and Reporting Module (ARM) captures the transactions passing through the Server and provides an 

interface in the Administrator where you can use preconfigured reports or create your own custom reports to 

query, filter, and view transaction data. Data is stored in a relational database and can be analyzed in real time.  

The ARM comes with a number of preconfigured reports to help you start analyzing data right away. The built-in 

reports were designed to respond to the most common data analysis requests.  

The module is normally installed and configured when you install EFT Server. If you did not install it when you 

installed EFT Server, you can run the installer again, choose Modify, and then select the Auditing and Reporting 

check box. (Leave the EFT Server and Admin Interface check boxes selected; clearing the check boxes will uninstall 

them.) 

THE AUDITING AND REPORTING MODULE INTERFACE 

The Report tab of the Administrator interface is the interface for the Auditing and Reporting module (ARM). 
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 When you click the Report tab in the left pane, the right pane displays the report controls. Click a report 

name in the tree to display the report's template in the right pane. 

 When you define a new report template, it appears in the Custom Reports node of the tree. 

 The top of the right pane displays the Report Filters options and the Report Date Range. Controls above 

the template are used to scroll through the pages of the report, adjust the zoom level, print the report, 

save the report to disk, create a new report template, and edit or customize the selected report. 

 Refer to Generating a Report, Managing Reports, and Custom Reports for details of running, managing, 

and defining reports. 

 Refer to Descriptions of Preconfigured Reports for descriptions of the report templates in the 

GlobalSCAPE Reports node of the tree. 

INSTALLING AND CONFIGURING THE AUDITING AND REPORTING 
MODULE 

  

Refer to Installing the Server, Administrator, and Modules for the procedure for installing ARM.  

Installation and configuration of the module consists of: 

1. Running the installer. The Auditing and Reporting module is normally installed and configured when you  

EFT Server. If you did not install it when you installed EFT Server, you can run the installer again, choose 

Modify, and then select the Auditing and Reporting check box. (Leave the EFT Server and Admin 

Interface check boxes selected; clearing the check boxes will uninstall them.) 

2. Pointing the Server to the database. 

3. Activating the software with a serial number that includes the ARM 

4. Enabling the Server to record data  

Refer to the following topic for more information about installing ARM: 

 For information about configuring an external SQL database to capture the auditing data, refer to 

Configuring SQL Server as the Auditing Database. This procedure is ONLY used if you did not configure 

ARM in the installer. All tables are installed regardless of version/features/modules (including the SAT 

module). 

 If you are upgrading from a previous version and are using an external database, you will have to update 

the table schema manually. This procedure is ONLY used if you did not configure ARM in the installer. All 

tables are installed regardless of version/features/modules (including the SAT module). 

 Refer to AS2 Information in the Database for details of AS2 tables. 

Next Step: Configuring the Auditing and Reporting Module 
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ACTIVATING THE AUDITING AND REPORTING MODULE  

The Auditing and Reporting Module (ARM) is an add-on to the Server that comes with a unique activation serial 

number. 

 If you have purchased the Server with ARM and have your serial number, follow the normal activation 

process. 

 If you are upgrading, follow the upgrade process.  

CONFIGURING THE ARM DATABASE IN SQL SERVER 

This procedure is used ONLY if you did not configure ARM in the installer. All tables are installed regardless of 

version/features/modules (including the SAT module). 

During installation, the installer places scripts in the Application Data folder under \EFT Server Enterprise\SQL 

Server. There are now several scripts (7 for SQL Server and 5 for Oracle) that must be run in order. The script 

names are prefixed with numbers in the order you should run them.  

 The OSQL utility allows you to enter Transact-SQL statements, system procedures, and script files for 

maintaining the database.  

 For additional information on the oSQL utility, including common script samples, refer to osql Utility. 

The instructions below use Microsoft SQL Server Management Studio Pro, but you can use Express or other 

methods.  

To configure SQL Server 

Reminder: The necessary scripts are installed in the Application Data folder under \EFT Server Enterprise\SQL 

Server during installation. 

1. Point the Server to the SQL Server. 

2. On SQL Server, launch Microsoft SQL Server Management Studio or equivalent, and provide your 

administrator login credentials when prompted. 

3. In the left pane, expand the Security node, right-click Logins, then click New Login. The New Login dialog 

box appears.  

 

 

4. Create a new user called eftuser and click SQL Server Authentication. 

 

If SQL Server Authentication is not available as a choice, verify that the SQL Server has been set up to 
support mixed mode. 

5. In the Password and Confirm password boxes, provide a complex password consisting of an alphanumeric 

and symbol mix of at least 8 characters. 

6. Select the Enforce Password Policy check box. 

7. Leave the Default database as master.  

http://msdn.microsoft.com/en-us/library/aa214012(SQL.80).aspx
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8. In Default language, click the list to select your language, if other than English, then click OK. 

 

 

9. In the left pane, right-click Databases, then click New Database. 

 

 

10. In the dialog box that appears, name the database eftdb. 

 

If you name the database something other than eftdb, be sure to use the name you chose 
throughout the procedure. 

11. In the Owner field, provide the login name you just created (eftuser).  

12. In the Database files table, change the Initial size value to 10 MB for the eftdb logical name (first 

row). Leave the eftdb_log row as is and click OK. 
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13. In the left pane under Databases, click the newly created eftdb database, then on the Query menu, 

click New Query. A blank screen appears in the right pane in which you can type in a SQL query. 

14. For each script (in the order specified by the file names): 

Reminder: The necessary scripts are installed in the Application Data folder under \EFT Server 

Enterprise\SQL Server during installation. 

a. Load/copy the entire script into management studio. 

b. Add the following lines to the top of the script: 

 USE EFTDB 

 GO 

c. Execute the script. 

A message appears indicating whether the query was able to complete successfully. 

15. Expand Databases, then eftdb, then Tables. Verify that the database has populated correctly. (The tables 

defined in the script should have been created.) 

Test your connection 

1. Create a test connection with your FTP client to EFT Server and upload and download a few files.  

2. Switch back to SQL Server and select the dbo.tbl_ProtocolCommands table under the eftdb database 

icon. It should return several rows with the commands issued by your client from the test connection. 

3. You can now pull reports directly from the Server against data audited to SQL Server.  

 

If you are running the Administrator, you must have an entry in that system's DNS for the name of the SQL 
Server, otherwise the Administrator will not be able to connect to the SQL Server when attempting to pull 
reports. 

USING OSQL TO CREATE THE SERVER DATABASE TABLES ON SQL SERVER 

Administrators that prefer using command-line tools can use oSQL to create the auditing database and tables. A 

brief overview is provided below. Detailed instructions are outside the scope of this documentation; refer to your 

SQL Server documentation. 
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Gather the following information prior to calling the oSQL command line tool: 

1. The SQL Server Host Name or address. 

2. The authentication scheme. You will need to know the authentication mechanism allowed on that SQL 

Server. It may be Windows Authentication only, Windows Authentication, or SQL Server Authentication. 

3. The allowed connection protocols. This can be Named Pipes, which is required for Windows 

Authentication, or TCP/IP, which is used by the SQL Server Authentication. 

4. The PORT, if TCP/IP. If TCP/IP is the connection of choice, you need to know the port on which the SQL 

Server is listening for connections. The default port is 1433. It also supports a way that a client can 

dynamically determine the port, but this requires that the SQL Server have UDP port 1434 accessible by 

remote computers. If this port is blocked by a firewall, you will NOT be able to use the "dynamically 

determine port" feature. Typically, SQL Server installations use the default port 1433 (TCP) for 

connections. 

Once you have acquired all of the above information, then you can construct the proper command line 
for "oSQL" to connect to the database.  

You must use this procedure for each of the scripts installed in the Application Data folder under \EFT Server 

Enterprise\SQL Server during installation. 

1. Open a command prompt. (Click Start > Run, type cmd, then press ENTER.) 

2. Type the following to place the sql file in the Reports folder (e.g., C:\Documents and Settings\All 

Users\Application Data\GlobalSCAPE\EFT Server Enterprise\Reports):  

[path to oSQL]\oSQL.exe -S [server address] -U [username] -P [password] -i 

"[c:\path\to\ARM_DBScript_1_1.sql]\ARM_DBScript_1_1.sql" 

For example, type: 

"C:\Program Files\Microsoft SQL Server\80\Tools\Binn\oSQL.exe" -S 

192.168.19.17 -U jbond -P asd123!f$s1 -i "C:\Documents and Settings\All 

Users\Application Data\GlobalSCAPE\EFT Server 

Enterprise\Reports\ARM_DBScript_1_1.sql"  

3. In the Administrator, connect to the Server and click the Server tab. 

4. In the left pane, click the Server you want to configure. 

5. In the right pane, click the Logs tab. 

6. Under Database Audit Settings, select the Enable Auditing and Reporting check box. 

7. In the Server Name box, type the Server name or IP address. 

8. Type the Database Name, a valid user name, and a password. 

9. To test the connection to the database, click Test Connection. 

 

Both the auditing component and the reporting component of the Server's ARM use ADO to communicate 
with the data source. The connection string (automatically configured if a database option is chosen during 
install) used to connect to the data source can be anything that ADO supports to open a connection. This can 
be a DSN or a DSN-less connection string. For more information on ADO connection strings, search the MSDN 
library at http://msdn2.microsoft.com/en-us/library/default.aspx; also refer to Microsoft support article 
193332:  
http://support.microsoft.com/?kbid=193332  (These links are outside of GlobalSCAPE's domain.)  

http://msdn2.microsoft.com/en-us/library/default.aspx
http://support.microsoft.com/?kbid=193332
http://support.microsoft.com/?kbid=193332
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ARM SCHEMA 

The tables created during installation are listed below. Because all of EFT Server's modules and features are 

available during the trial, all of the tables below are created, even if you do not activate that module/feature.  

 

tbl_Actions 

ActionID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_Actions PRIMARY KEY CLUSTERED,  

Time_stamp datetime NOT NULL ,  

SiteName varchar(50) NULL ,  

EventName varchar(50) NULL ,  

ActionType varchar(50) NULL ,  

Parameters varchar(1000) NULL ,  

IsFailedAction bit NULL ,  

ResultID numeric(18, 0) NOT NULL ,  

EventID numeric(18, 0) NOT NULL , 

TransactionID numeric(18, 0) NOT NULL REFERENCES tbl_Transactions(TransactionID) ON DELETE CASCADE,  

Details  varchar(1000) 

tbl_AdminActions 

ID numeric(18, 0) IDENTITY(1,1) NOT NULL, 

Timestamp datetime NULL, 

FunctionName varchar(200) NULL, 

Action varchar(200) NULL, 

AffectedArea varchar(200) NULL, 
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AffectedName varchar(200) NULL, 

ChangeOriginator varchar(200) NULL, 

TransactionID numeric(18, 0) NULL, 

SiteName varchar(300) NULL 

tbl_AdminCommands - (Not used in EFT Server version 6) 

AdminCommandID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_AdminCommands 

PRIMARY KEY CLUSTERED, 

Time_Stamp datetime NULL , 

TransactionID numeric(18, 0) , 

Login varchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 

Data varchar(7800) COLLATE SQL_Latin1_General_CP1_CI_AS NULL 

tbl_AS2Actions - Contains information about separate actions for each AS2 transaction: 

ActionID numeric(18, 0) identity 

TransactionID numeric(18, 0)  

ActionStatus numeric(18, 0)   

ActionType numeric(18, 0)   

ErrorCode varchar(1000) 

TimeStamp datetime 

FileID numeric(18, 0)  

tbl_AS2Files - Contains information about files transferred via AS2: 

FIleID numeric(18, 0) identity 

TransactionID numeric(18, 0)  

FileName varchar(300) 

ContentType varchar(50) 

LocalPath varchar(300) 

RemotePath varchar(300) 

tbl_AS2Transactions - Contains details of AS2 Transactions: 

TransactionID numeric(18, 0) identity 

MIC varchar(100) 

StartTime datetime 

CompleteTime datetime 

Direction numeric(18, 0)  

MDN text 

MDNSignatureType varchar(50)  
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MDNType numeric(18,0) 

LocalHost varchar(300)  

RemoteHost varchar(300)  

TransactionStatus numeric(18,0) 

SiteName varchar(300) 

FromAS2ID varchar(300) 

ToAS2ID varchar(300) 

ErrorCode varchar(1000) 

PayloadSignatureType varchar(50) 

PayloadEncryptionType varchar(50) 

PayloadHeaders text 

MDNAS2MessageID varchar(300) 

PayloadAS2MessageID varchar(300) 

MDNHTTPResponse text 

tbl_Authentications 

AuthenticationID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_Authentications PRIMARY 

KEY CLUSTERED,  

Time_stamp datetime NOT NULL ,  

RemoteIP varchar(15) NOT NULL ,  

RemotePort numeric(18, 0) NULL ,  

LocalIP varchar(15) NOT NULL ,  

LocalPort numeric(18, 0) NULL ,  

Protocol varchar(50) NULL ,  

SiteName varchar(50) NULL ,  

UserName varchar(50) NULL ,  

PasswordHash varchar(500) NULL ,  

SettingsLevels varchar(500) NULL ,  

ResultID numeric(18, 0) NOT NULL ,  

EventID numeric(18, 0) NOT NULL REFERENCES tbl_EventRules(EventID), 

TransactionID numeric(18, 0) NOT NULL References tbl_Transactions(TransactionID) ON DELETE CASCADE  

tbl_ClientOperations 

ClientOperationID numeric (18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_ClientOperations PRIMARY 

KEY CLUSTERED ,  

Time_stamp datetime NOT NULL ,  
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Protocol varchar(50) NULL ,  

RemoteAddress varchar(50) NULL ,  

RemotePort numeric (18, 0) NULL ,  

Username varchar(50) NULL ,  

RemotePath varchar(500) NULL ,  

LocalPath varchar(500) NULL ,  

Operation varchar(50) NULL ,  

BytesTransferred numeric (18, 0) NULL ,  

TransferTime numeric (18, 0) NULL ,  

ResultID numeric (18, 0) NOT NULL ,  

TransactionID numeric (18, 0) NOT NULL REFERENCES tbl_Transactions(TransactionID) ON DELETE CASCADE  

tbl_CustomCommands 

CustomCommandID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_CustomCommands 

PRIMARY KEY CLUSTERED,  

Time_stamp datetime NOT NULL ,  

SiteName varchar(50) NULL ,  

Command varchar(50) NULL ,  

CommandParameters varchar(1000) NULL ,  

ExecutionTime numeric(18, 0) NULL ,  

ResultID numeric(18, 0) NOT NULL ,  

TransactionID numeric(18, 0) NOT NULL REFERENCES tbl_Transactions(TransactionID) ON DELETE CASCADE  

tbl_EventRules 

EventID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_EventRules PRIMARY KEY CLUSTERED,  

Time_stamp datetime NOT NULL ,  

SiteName varchar(50) NULL ,  

EventName varchar(50) NULL ,  

EventType varchar(50) NULL ,  

ConditionValues varchar(1000) NULL ,  

ResultID numeric(18, 0) NOT NULL ,  

TransactionID numeric(18, 0) NOT NULL REFERENCES tbl_Transactions(TransactionID) ON DELETE CASCADE  
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tbl_Groups 

GroupID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_Groups PRIMARY KEY CLUSTERED,  

GroupName varchar(50) NULL ,  

AuthenticationID numeric(18, 0) NOT NULL REFERENCES tbl_Authentications(AuthenticationID) ON DELETE 

CASCADE  

tbl_PCIViolations 

PCIViolationID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_PCIViolations PRIMARY KEY 

CLUSTERED, 

Time_Stamp datetime NULL , 

ViolationID int NULL , 

SiteName varchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 

SettingsLevel varchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 

UserName varchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 

Admin varchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 

Reason varchar(500) COLLATE SQL_Latin1_General_CP1_CI_AS NULL 

tbl_ProtocolCommands 

ProtocolCommandID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_ProtocolCommands 

PRIMARY KEY CLUSTERED,  

Time_stamp datetime NOT NULL ,  

RemoteIP varchar(15) NULL ,  

RemotePort numeric (18,0) NULL ,  

LocalIP varchar(15) NULL ,  

LocalPort numeric (18,0) NULL ,  

Protocol varchar(50) NULL ,  

SiteName varchar(50) NULL ,  

Command varchar(10) NULL ,  

CommandParameters varchar(1000) NULL ,  

FileName varchar(500) NULL ,  

VirtualFolderName varchar(500) NULL ,  

PhysicalFolderName varchar(500) NULL ,  

FileSize numeric(18, 0) NULL ,  

TransferTime numeric(18, 0) NULL,  

BytesTransferred numeric(18, 0) NULL ,  

ResultID numeric(18, 0) NOT NULL ,  

TransactionID numeric(18, 0) NOT NULL REFERENCES tbl_Transactions(TransactionID) ON DELETE CASCADE  
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tbl_ResultCodes 

ResultID numeric(18, 0) NOT NULL CONSTRAINT PK_tbl_ResultCodes PRIMARY KEY CLUSTERED,  

Description varchar(100) NULL ,  

Category varchar(10) NULL  

tbl_SAT_Emails 

ID numeric(18, 0) IDENTITY (1, 1) NOT NULL , 

txid int NOT NULL , 

email varchar (80) COLLATE SQL_Latin1_General_CP1_CI_AS NOT NULL , 

emailType int NULL 

"emailType" is a "0" for TO:, "1" for CC: 

tbl_SAT_Files 

id numeric(18, 0) IDENTITY (1, 1) NOT NULL , 

txid int NOT NULL , 

filename varchar (255) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 

filesize bigint NULL 

tbl_SAT_Transactions - Audits transactions managed by the Secure Ad Hoc Transfer (SAT) module. 

ID numeric(18, 0) IDENTITY (1, 1) NOT NULL , 

time_stamp datetime NULL , 

fromEmail varchar(80) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 

subject varchar(255) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 

body varchar(5000) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 

tempUserName varchar(40) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 

siteName varchar(80) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 

expiryDays int NULL , 

tempPassword varchar(80) COLLATE SQL_Latin1_General_CP1_CI_AS NULL, 

transactionGUID uniqueidentifier NULL, 

reserved1 varchar(2000) NULL, 

reserved2 varchar(2000) NULL 

tbl_ServerInternalEvents 

ServerInternalEventID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_ServerInternalEvents 

PRIMARY KEY CLUSTERED, 

Time_Stamp datetime NULL , 

SiteName varchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 

SettingsLevel varchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 
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UserName varchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 

EventName varchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL , 

Parameters varchar(50) COLLATE SQL_Latin1_General_CP1_CI_AS NULL 

tbl_SocketConnections 

SocketID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_SocketConnections PRIMARY KEY 

CLUSTERED,  

Time_stamp datetime NOT NULL ,  

RemoteIP varchar(15) NULL ,  

RemotePort numeric (18,0) NULL ,  

LocalIP varchar(15) NULL ,  

LocalPort numeric(18, 0) NULL ,  

SiteName varchar(50) NULL ,  

ResultID numeric(18, 0) NOT NULL ,  

TransactionID numeric(18, 0) NOT NULL REFERENCES tbl_Transactions(TransactionID) ON DELETE CASCADE  

tbl_Transactions 

TransactionID numeric(18, 0) IDENTITY (1, 1) NOT NULL CONSTRAINT PK_tbl_Transactions PRIMARY KEY 

CLUSTERED ,  

ParentTransactionID numeric(18, 0) NULL REFERENCES tbl_Transactions(TransactionID),  

TransactionObject varchar(50) NOT NULL  

THE ARMIMPORTER TOOL 

The ARMImporter tool is a command-line utility that groups a batch of SQL files, parses the grouped files, and 

imports these file into the SQL server or ORACLE server. 

While the ARMImporter parses the SQL files, it generates .arm files. These .arm files are saved in a location (drive) 

specified when you run the ARMImporter. The .arm files can then be imported to the SQL server or ORACLE server. 

Files are grouped in an ascending order based on the timestamp.  

Grouping the Files 

The user selects the .sql files in the ascending order of their time stamp. For example, if there are files with time 

stamps of 2007 and 2008, then files with 2007 are grouped first, and then 2008. 

Files are grouped as Group1, Group2, and so on. The ARMImporter creates the groups based on the presence of 

@Identity_1 (temporary Id), which is the key to group the .sql files. If two files have the same ID, they are not 

placed in the same group. This temporary ID is replaced with a specific number at runtime. 

Parsing the Grouped Files 

All events that occur during the parsing of the grouped files are logged to a file.  

The following command at the command prompt parses the files and places those parsed files in a specified 

location: 
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ArmImporter –i <path where SQL files are stored> -o <path where arm files will be 

generated> -p  

For example: 

ARMImporter -i "H:\SQLFile_Parse\ARMImporter" –o "H:\SQLFile_Parse\ARMImporter –p  

Importing the Parsed Files 

The parsed files are imported into the SQL or ORACLE server. The file import generates log files that contain any 

error or warning information that you can use for troubleshooting if the import fails. 

SQL server: 

ARMImporter_SQL –U ad –P a –d <database name> –S <server-name\instance> -o <path 

for arm files> -I 

For example: 

ARMImporter_SQL –U admin –P a –d EFTDB –S 192.168.38.207\GlobalScape –o 

"H:\SQLFile_Parse\ARMImporter" –I 

ORACLE server: 

ARMImporter_ORACLE –U admin –P admin –S <server-name\instance> -o <path for arm 

files> -I 

For example: 

ARMImporter_ORACLE -U system -P admin -S localhost:1521/XE -i "D:\sql" -o "D:\arm" 

-I -l 

Parsing and Importing files in a Single Statement 

Instead of performing the parsing and importing operations individually, you can execute both operations at once 

using the following commands: 

SQL server: 

ARMImporter_SQL –U admin –P a –d EFTDB–S 192.168.38.207\GlobalScape –I 

"H:\SQLFile_Parse\ARMImporter" –o "H:\SQLFile_Parse\ARMImporter" –p –I 

ORACLE server: 

ARMImporter_ORACLE -U system -P admin -S localhost:1521/XE -i "D:\sql" -o "D:\arm" 

-p -I -l 

Advantage of Using this Tool 

The main advantage of this tool is that it groups the dispersed .sql files belonging to the same group into one 

single SQL file. The files are grouped based on the identity keys, which allow us to place a SQL query execution 

statement after an arbitrary number of lines. This also ensures that the oSQL tool or SQL*Plus tool is not 

overloaded with a huge amount of simultaneous SQL statements. 

USING THE ARMIMPORTER TOOL IN EVENT RULES 

To use the ARMImporter tool in Event Rules, follow the procedures below to create a batch file, create a custom 

Command that references the batch file, then create an Event Rule to execute the Command at a specified date 

and time. 
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CREATE A BATCH FILE 

Create a DOS batch file that contains the commands that you would normally type at a command line. You can 

then run the command using a custom Command. You can run and verify this batch file from the command line 

before creating the custom Command to call this batch file. Use the commands below depending on which Server 

you are using. 

SQL Server batch file example: 

ARMImporter_SQL –U admin –P a –d EFTDB–S 192.168.38.207\GlobalScape –I 

"H:\SQLFile_Parse\ARMImporter" –o "H:\SQLFile_Parse\ARMImporter" –p –I 

Oracle batch file example:   

ARMImporter_ORACLE_-U system -P admin -S localhost:1521/XE -i  "D:\Files"  -o 

"D:\Files"  -p -I –l 

CREATE A CUSTOM COMMAND 

Create a custom Command to execute the batch file automatically. 

1. In the Administrator, connect to the Server and click the Server tab. 

2. In the left pane, expand the Site node for the Site on which you want to create the Command, then click 

Commands. 

3. In the right pane, click Add. The Custom Command wizard appears. 

 

4. In the Command name box, provide a descriptive name for the Command. This name will appear under 

the Commands node of the tree and in Event Rules when you add the Action Execute command in folder. 

5. In the Description box, provide a brief explanation of the rule. (Optional) 

6. Click Next. 
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7. In the Exe path box, provide the location of the bat file that you created.  

8. Click Next.  

 

9. In the Parameters box, provide any switches that the Server must pass in when the command is executed. 

The following switches can be used with the ARMImporter utility: 

Switch Description 

-U User name for SQL login 

-P Password for SQL Login 

-d SQL Server Database name 

-S SQL or ORACLE server name/IP 

-i Source path for the *.sql files. 

-o Path where *.arm files will be generated. 
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Switch Description 

-p Parses .sql files. 

-I Imports the .arm files into the SQL or ORACLE server. This switch is case sensitive. 

-l (el) Enables the generation of log files during the file parsing phase. 

-h Provides more information about the tool. 

10. Click Finish. The Command appears in the Commands node and in the Command Settings tab. 
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CREATE AN EVENT RULE 

Create a Scheduler (Timer) Event Rule to schedule when the Command will execute the batch file. 

1. Refer to Scheduler (Timer) Event, if necessary. 

2. In the Actions list, double-click Execute Command in folder. 

 

 

3. In the Rule window, click the blue "select" link. The Custom Command dialog box appears. (Refer to 

Editing a Command if necessary.) 

4. In the Specify command working folder box, type or browse to the path to the ARMimporter.bat, then 

click OK.  

5. In the right pane, top-left corner, ensure the Enable this rule check box is selected. 

6. The Rule is defined by default to trigger each hour starting on the date you create the Rule. To change the 

start date, start time, recurrence pattern, and/or interval, in the Rule pane, click repeat each 01:00:00. 

The Timer Event dialog box appears.  

7. In the Recurrence pattern area, specify that the Rule is to run no more often than Daily. Weekly should 

be sufficient. 

8. Specify the Start time and Start date, then click OK. The frequency is updated in the Rule pane. 

9. Click Apply to save the Event Rule on the Server. The Event Rule is now ready to execute the command on 

a schedule that you specify. You can click Run Now to run the Rule immediately or to test the Rule. 
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AUDITING 

AUDITING DATABASE RECOVERY 

 

The SQL statements logged in the text file must be loaded into the database before any reports are run. 

If the Server is disconnected from the SQL database and is configured to save auditing information to 
the log file, do the following: 

1. Solve the connection problem. 

2. Repair the database, and insert the data from the text file into the SQL database. Be sure to insert the 

data only once, otherwise the auditing data will be corrupted. Refer to The ARMImporter Tool for 

assistance, if necessary. 

3. In the Administrator, connect to the Server and click the Server tab. 

4. In the left pane, click the Server that you want to configure. 

5. In the right pane, click the Logs tab.  

 

 

6. Under Database Audit Settings, click Test Connection to test the status of the database connection. (You 

must click Apply to apply any changes first.) 

7. To reconnect to the database, click Reconnect. 
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HOW THE SERVER HANDLES SQL DATA  

The server truncates data values within each audited event SQL transaction to ensure the data value fits within the 

corresponding database field.  

The special characters (as defined by the SQL interpreter) within each data value of an audit SQL event are escaped 

to ensure the data value is stored and retrieved properly from the database. The following special characters are 

escaped by the Server during generation of SQL statements prior to submission to the database engine: 

 Single quote - % 

 Open brace - [ 

 Percent - % 

 Underscore - _ 

AUDITING ADMINISTRATOR CHANGES TO THE ARM DATABASE 

(Available in EFT Server Enterprise) 

Administrators often need to know when and what changes were made to the Server and who made them. EFT 

Server Enterprise includes a mechanism for auditing and reporting administrator changes. 

Using ARM, the Server logs the following changes made to the Server to the ARM database (if ARM is enabled and 

active): 

 The Date the action occurred, in MM/DD/YYYY HH:MM:SS format.  

 The affected feature or Function.  (Refer to Functions Audited, below.) 

 The type of Action (created, added, removed, modified, enabled, disabled, started, and stopped). 

 The Affected Area (Server, Site, Settings Template, User Account, Event Rule, Command, Group, VFS, 

Report). 

 The name of the affected object, Affected Name (Server Name, Site Name, Settings Template Name, User 

or Admin Account Name, Event Rule Name, Command Name, Group Name, Folder Name, Report Name). 

 The name of the administrator that made the change, Change Originator. 

The data in the preconfigured report is arranged in columns, Date, Function, Action, Affected Area, Affected 

Name, and Change Originator, grouped by Site name, and sorted in reverse chronological order (newest change at 

the top). 

 

 

FUNCTIONS AUDITED 

When the following functions are created, added, removed, modified, enabled, disabled, started, or stopped, the 

action is logged to the database. Many possible actions are grouped together. For example, modifying SSL cipher 
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selection, changing SSL clear command channel values, or modifying SSL connection string all fall under "SSL 

settings." Also, intermediate states are not audited (e.g., a toggle was checked, but later unchecked, rendering the 

transaction moot). Instead, only committed states are captured (once the administrator applies changes). 

 SFTP protocol 

 SFTP settings 

 SFTP key 

 SFTP authentication 

settings 

 SSL protocol 

 SSL settings 

 SSL require client 

certificate 

 SSL certificate 

 SSL authentication 

settings 

 FIPS mode 

 HTTPS protocol 

 HTTPS settings 

 Web Transfer Client 

 AS2 protocol 

 AS2 settings 

 FTP protocol 

 FTP protocol settings 

 PASV port mode 

settings 

 Password 

 Password complexity 

 Password reset 

 Password expiration 

 Invalid login settings 

 Inactive account 

settings 

 Account expiration 

settings 

 Connection limits 

 Transfer limits 

 Disk limits 

 File type limits 

 IP address ban list  

 Group assignment 

 Group 

 Data sanitization 

(wiping) 

 Streaming repository 

encryption (EFS) 

 OpenPGP settings 

 Open PGP key 

 DMZ Gateway 

 DMZ Gateway settings 

 Authentication settings 

 Remote administration 

 Auditing settings 

 Log settings 

 SMTP settings 

 DoS prevention 

settings 

 Delegated 

Administrators 

 Server 

 Site 

 Settings Template 

 User Account 

 Real-time monitoring 

 User kicked 

 Web Services Interface 

 Site root folder 

 Site listening IP 

 Custom command 

 Event Rule 

 Physical folder 

 Virtual folder 

 Folder permissions 

 Administrator 

 Database refresh 

 Server service settings 
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PURGING DATA FROM THE DATABASE 

Use the procedure below to purge Server data from your SQL database. If the database is active, you should delete 

the records in small "chunks," perhaps 1000 at a time, so that you do not affect the responsiveness of the SQL 

server for new/ongoing transactions. If you run script after hours or on a test system, you can delete all of the 

records in larger chunks. 

To purge the data 

1. Download the SQL script PurgeEftData.txt. 

2. Open the script in a text editor and edit the following values:  

a. If the database name is not EFTDB, modify the following line with the name of the database: USE 

EFTDB. 

b. All records BEFORE the "DeleteTo" date are affected. In the "DeleteTo" variable: 
 

SELECT @DeleteTo = '1/1/2007', @DeleteScope = '1000'  

 

If you want all rows to be affected, edit the date and time to a time in the future. 

c. "DeleteScope" is the number of rows to be deleted and how quickly they are deleted.  

SELECT @DeleteTo = '1/1/2007', @DeleteScope = '1000'   

 In the "DeleteScope" variable, leave it as '1000' or change it to another static value or a 

percentage of rows to be deleted. 

Examples are commented in the top of the script and shown below. 

--SELECT @DeleteTo = '1/1/2006', @DeleteScope = '50%' 

--SELECT @DeleteTo = '1/1/2007', @DeleteScope = '1000' 

--SELECT @DeleteTo = '1/1/2007', @DeleteScope = '2000000000'  

3. Save the script as PurgeEftData.sql. 

4. After you have edited the script as needed, then you can craft the proper command line for "oSQL" to 

connect to the database:  

a. Open a command prompt. (Click Start > Run. Type cmd, then press ENTER.)  

b. Type the following to execute the sql file:  

[path to oSQL]\oSQL.exe -S [server address] -U [username] -P 

[password] -i "[c:\path\to\PurgeEftData.sql]\PurgeEftData.sql"  

For example, type:  

"C:\Program Files\Microsoft SQL Server\80\Tools\Binn\oSQL.exe" -S 

192.168.19.17 -U jbond -P asd123!f$s1 -i "C:\Program 

Files\GlobalSCAPE\EFT\Reports\PurgeEftData.sql"  

  

http://kb.globalscape.com/attachments/PurgeEftData.txt
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TRANSACTION INFORMATION 

The ARM captures transaction information from the Server and is available in the ARM database and reports. Refer 

to AS2 Information in the Database  for AS2-specific transaction information. 

Socket Connections 

 Time stamp 

 Remote IP 

 Remote Port 

 Local IP 

 Local Port 

 Site Name 

 Result 

Authentication Operations 

 Time stamp 

 Remote IP 

 Remote Port 

 Local IP 

 Local Port 

 Protocol 

 Site Name 

 User name 

 Password Hash 

 Settings Level Membership 

 Group Membership 

 Result 

Protocol Operations 

 Time stamp 

 Remote IP 

 Remote Port 

 Local IP 

 Local Port 

 Protocol 

 Site Name 

 Command / Operation 
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 Result 

 File Name 

 Virtual Folder Name 

 Physical Folder Name 

 Bytes Transferred 

Custom Commands 

 Time stamp 

 Site Name 

 Command Name 

 Command Parameters (delimited in a single field) 

 Execution time 

 Result 

Event Triggers 

 Time stamp 

 Site Name 

 Event Name 

 Event Type (file upload, monitor folder, etc.) 

 Matching Condition values, if there is a Condition on the event. For example, the filename that matches a 

virtual path mask Condition, or the folder that triggers a MONITOR FOLDER Event. 

 Result 

 Transaction ID (unique) 

Event Actions 

 Time stamp 

 Site Name 

 Event Name 

 Action Types such as move, copy, OpenPGP, and send e-mail. 

 Action Parameters - These parameters are runtime values passed to the action, not the replacement 

variables. 

 Failed Action Flag - This flag is captured if this action is the result of a FAILURE sequence on a prior action. 

 Action Result Code 

 Result  
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AUDITING AND REPORTING RESULT CODES 

The ARM captures the following transaction information from the Server, which appears in the ARM database and 

reports:  

Actions  

ResultID Description  Result Const  

0    If the event action is successfully executed  EAR_SUCCESS 

1    If the event action fails  EAR_FAIL  

2    If STOP Processing this rule is selected as action. EAR_STOP_RULE  

4 If STOP processing more rules is selected as action  EAR_STOP_ALL  

 

 

Stop processing this rule and Stop processing more rules can be combined, in which case the value is the sum 
of the two individual values, that is, 6.  

SocketConnection  

ResultID  Description  Result Const  

0     When socket successfully created  ER_NONE  

8     Per Site socket connection limit exceeded  ER_CONNECT_FAILED_TOO_MANY_CONNECTIONS_PER_SITE  

9     Max connections per IP address limit exceeded  ER_CONNECT_FAILED_TOO_MANY_CONNECTIONS_PER_IP  

10     The IP address is restricted in the IP address     

   access list  

ER_CONNECT_FAILED_RESTRICTED_IP  

11  The IP address is banned  ER_CONNECT_FAILED_BANNED_IP  

Authentications  

ResultID Description  Result Const 

0     Authentication successful LR_OK  

1     Incorrect password  LR_PASSWORD_NOT_ACCEPTED  

2     If user account is disabled  LR_ACCOUNT_DISABLED  

3     Max connections per Site limit exceeded  LR_TOO_MANY_CONNECTIONS_PER_SITE  

4     Max connections per user limit exceeded  LR_TOO_MANY_CONNECTIONS_PER_USER  

5     User level per IP address connection limit exceeded  LR_TOO_MANY_CONNECTIONS_PER_IP 

6     If given protocol is not supported  LR_PROTOCOL_NOT_SUPPORTED  

7     Connection on restricted IP address  LR_RESTRICTED_IP  

8  If service is unavailable  LR_SERVICE_UNAVAILABLE  

ClientOperations  

ResultID  Description  Result Const  

1     If copy/move/download operation is successful  TRUE  

0  If copy/move/download operation fails  FALSE  
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CustomCommands 

ResultID  Description  Result Const  

0     Command executed successfully  CER_OK  

1     Command executed with socket output  CER_SYNC  

2     Access is denied  CER_ACCESS_DENIED  

3     Command is not found  CER_COMMAND_NOT_FOUND  

4     Could not launch the selected process  CER_PROCESS_FAILED  

5     Command is disabled  CER_COMMAND_DISABLED  

6  Errors in parameters passed to the custom command  CER_ERROR_IN_PARAMS  

ProtocolCommands  

ProtocolCommands are the same as FTP result codes. Below is a short summary.  

ResultID  Description  

1xx  Expected another reply before proceeding with a new command  

2xx  Requested action completed successfully  

3xx  On hold pending receipt of further information  

4xx  Temporary failure  

5xx  Permanent failure  

 

AUDITING DATABASE ERRORS AND LOGGING 

EFT Server detects errors that occur while trying to connect to the ARM database and can detect errors returned 

from the database while attempting to perform transactions. If an error is detected while connecting to the 

database or when performing a transaction on the database (SQL INSERT, UPDATE, etc.) you can configure the 

Server to log the error to a file and to send a notification to a specified e-mail address.  

 

For details of the Log Settings area, refer to Log Settings. 

By default, database errors are logged to C:\Documents and Settings\All Users\Application 

Data\Globalscape\EFT Server Enterprise\SQL Server\Logs\ or EFT Server Enterprise\SQL Server\Logs\, in the 

format EFT_ARM_<YYYY_MM_DD_HH_MM_SS>.sql. You can specify a different path or choose not to log the 

errors to a file. 

EFT Server also generates a Windows Event Log entry when there is an ARM database error. The log entry indicates 

whether auditing has stopped or if the auditing data is being stored to a log file. 

If database access is lost because of a connection error or transaction error (INSERT or UPDATE), resumption of 

auditing to the database requires a restart of EFT Server or a RECONNECT request by the administrator. If EFT 

Server is configured to stop auditing, the administrator must repair the database, and then restart the Server or 

use RECONNECT to resume auditing to the database.  
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LOGGING TO A TEXT FILE 

In the In case of database error area of the Server's Logs tab, you can configure the Server to log the SQL 

statements to a text file. The Server continues to use the text file until either the Server is restarted or until a 

RECONNECT request is made by the administrator. The Server then notifies you by e-mail that the logging has been 

saved to the text file. You can then repair the database, resume auditing to the database, and load the recorded 

text file SQL statements into the database. To ensure the completeness of the audit data, the SQL statements in 

the text file must be loaded into the database before executing reports over the time that SQL transactions were 

logged to the text file. 

If you click Reconnect to resume auditing to the database, and the Server is recording auditing information to the 

text file, the Server continues to log the Server file transfers and/or user sessions that are in progress to that text 

file. New file transfers and new user sessions will continue to be logged in the database, but any in-process 

transfers/user sessions are logged to the text file to ensure that they can be inserted and linked appropriately in 

the database.  

REPORTING 

DESCRIPTIONS OF PRECONFIGURED REPORTS 

The ARM comes with a number of preconfigured reports that allow you to start analyzing data right away. The 

report templates are .xml files and are installed in C:\Documents and Settings\All Users\Application 

Data\GlobalSCAPE\EFT Server Enterprise\Reports or \EFT Server\Reports. If you plan to edit the default 

templates, it is a good idea to save a backup copy of them first. 

The preconfigured reports fall into the following categories: 

 Billing: ARM allows the Server administrators to more effectively bill their clients. Many EFT Server 

customers bill their customers for file transfer services and need to supply accurate reports to their 

customers and for their own invoicing purposes. These customers want to query and produce reports 

based on multiple criteria such as a specific client, a group of clients, or all clients, a particular date range, 

and a specific file or all files transferred for that user.  

 Non-repudiation: Many EFT Server customers need to audit transactions throughout their life cycle and 

need to determine whether a particular event occurred and when it occurred. This would include 

searching for all activity for a specific user for a specific date, or to locate a transaction within a date range 

for auditing purposes. Customers must be able to show conclusively whether something happened, when 

it happened, and who was responsible for making it happen. 

 Statistics: The need to gather statistical data that would allow the customer to take preventive measures 

(such as scale to meet increasing demand), to establish trends, create general usage reports for 

stakeholders, and to query and analyze trends and server usage (peak usage times, most active 

customers, etc.). 

 Technical troubleshooting: Granular auditing of all socket, protocol, authentication, and transaction 

information allows the administrator to quickly locate and solve problem scenarios. 

The preconfigured reports described below have been selected by users as the most often needed.  

Activity - All Groups (Detailed) - This report displays the various actions performed by all the groups, such as 

Administrator, All users, and Guests, and it displays Date/Time, Remote IP address, protocol, action, filename, 

folder, bytes transferred, and the result. 
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Activity - All Users (Summary) - This report displays the transfer activity (total number of uploads and downloads) 

for all users who logged on to the Server during the date range specified, grouped by username, subgrouped by 

date, sorted by username, then transfer direction, and date, in ascending order. 

Activity - All Users (Detailed) - This report displays all folder and file create and delete activity for all users who 

logged on to the Server during a particular period, grouped by username, and sorted in reverse chronological 

order. The report includes the time stamp, remote IP address of the user, protocol action, file name, folder, KB 

transferred, and the result. 

Activity - By File - This report displays all the activities related to a specified file, based on wildcard masks, grouped 

by Site name, subgrouped by matching filename, sorted in chronological order. The report displays the time stamp, 

user name, remote IP address, and protocol. To generate this report, you have to specify the report parameters, 

such as .txt to view only txt files or *.* to view all files. 

Activity - By Group (Detailed) - This report displays the folder and file create and delete activity during a specified 

period for a specific group, grouped by group name, and sorted by date in reverse chronological order. The report 

displays the remote IP address, protocol action, time stamp, file name, folder, bytes transferred, and result. When 

you click Show Report, the Report Parameters dialog box appears asking for the group name. 

Activity - By User (Detailed) - This report displays the folder and file create and delete activity during a specified 

period for a specific user, grouped by username, and sorted by date in reverse chronological order. When you click 

Show Report, the Report Parameters dialog box appears asking for the name of the user. 

Activity - By User (Detailed) - Group by Username/Action - This report displays the folder and file create and 

delete activity during a specified period for specific users, grouped by username, subgrouped by action, and sorted 

by date in reverse chronological order. That is, the report displays all files created under the Created Action and all 

files that are sent are displayed under the Sent Action. When you click Show Report, the Report Parameters dialog 

box appears asking for the name of the user.  

Activity - By User (Summary) - This report displays the transfer activity for specifics users, grouped by username, 

subgrouped by date, sorted by username, transfer direction, and date, in descending order.  

Activity-SAT by File (Detailed) - This report displays all Secure Ad Hoc Transfer module activity, grouped by file 

name, and sorted by date in reverse chronological order. 

Activity-SAT By Recipient (Detailed) - This report displays all Secure Ad Hoc Transfer module activity, grouped by 

recipient's e-mail address, and sorted by date in reverse chronological order. 

Activity-SAT by Sender (Detailed) - This report displays all Secure Ad Hoc Transfer module activity, grouped by 

sender's e-mail address, and sorted by date in reverse chronological order. 

Activity-SAT (Detailed) - This report displays activity for Secure Ad Hoc Transfer module activity, sorted by date in 

reverse chronological order. 

Activity-SAT (Summary) - This report displays all Secure Ad Hoc Transfer module activity, grouped by username, 

and sorted by date in reverse chronological order. 

Admin Actions - This report displays all EFT Server administrator activity for the specified range. Columns displayed 

in the report and available report filters include Date/Time (Timestamp), Function (e.g., User Account, Site, 

Database Refresh, SMTP Settings), Action (e.g., Created, Enabled, Disconnected, Modified, Started), Affected Area 

(e.g., User Account, Site, Server, Administration), Affected Name (username), ChangeOriginator (administrator 

username), SiteName (e.g., MySite). 

AS2 Transactions (Detailed) - A verbose AS2 file transfer report that provides the information necessary for 

troubleshooting problem transactions.   
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AS2 Transactions Overview - A transaction report that displays the same information as shown on the AS2 

Transactions node. The report queries all AS2 transactions for the dates specified, grouped by site, sorted by date, 

and listed in reverse chronological order.  

Event Rules - Actions (Summary) - This report summarizes all event rules with their corresponding actions, 

grouped by Site name, subgrouped by the user-defined event name, sorted by the unique event ID (not shown in 

report) in descending order. 

Event Rules - Activity (Detailed) - This report displays the event rule activity by user-defined even name, grouped 

by Site name, subgrouped by the event type, sorted by date in reverse chronological order. 

Event Rules - Activity (Summary) - This report summarizes the event rule activity by user-defined event name, 

grouped by Site name, sub-grouped by the event type, sorted by date in reverse chronological order. 

Event Rules - Inbound-Outbound By Date - This report details all offload and download actions, grouped by Site 

subgrouped by action, sorted by date in reverse chronological order. 

Event Rules - Inbound-Outbound By User - This report details all offload and download actions, grouped by Site 

name, then by remote host IP address, then by username, sorted in reverse chronological order. 

Executive Summary Report - A report that summarizes the following for the date period specified: 

 Average transfer speed 

 Total number of downloads, uploads 

 Total bytes transferred (inbound/outbound) 

 Top 5 users (by # of connections) 

 Top 5 users (by bytes transferred) 

 Most concurrent users at any given time 

Security - DoS -  Hammering Report - This report displays socket connections that did not have a corresponding 

authentication attempt. 

Security - Failed Logins - This report displays the number of users who could not connect to the Server. It displays 

the user name, remote IP address, protocol used, date, time, remote IP address, port number, and result. 

Traffic - Average Transfer Rates by User - This report displays the average transfer rate for specific users, grouped 

by username, subgrouped by date, sorted by username, transfer direction, and date, in descending order. 

Traffic - Connections Summary - This report details connections to the Server (IP address or user connections) and 

bytes transferred by date, grouped by Site name, sorted by date in reverse chronological order.  

Traffic - Datewise - Hourly Bytes Transferred - This report details the connections and bytes transferred sorted by 

date and hour, in chronological order. 

Traffic - Datewise-IP-wise bytes transferred - This report displays the connections established by remote IP 

addresses and total bytes transferred. 

Traffic - IPwise Connections (Summary) - This report displays the connections established by remote IP addresses 

and total bytes transferred. 

Traffic - Monthwise-IP-wise Bytes transferred - This report displays the connections established by various remote 

IP addresses on a monthly basis. It displays the Site name, month name, remote IP address, connections, and total 

bytes transferred. 
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Traffic - Most Active IPs - Connections - This report displays the most active IP addresses; that is, the IP addresses 

of the users who frequently log on to the Server. It displays the data transferred, Site name, remote IP address, 

and bytes transferred. This report can be used to determine Denial of Service (DoS) attacks against the Server. 

Traffic - Most Active IPs - Data Transferred - This report displays the IP addresses of users who log on to the Server 

frequently; the number of connections established by various users. It displays the information on the total bytes 

transferred, number of connections, remote IP address, and Site name. 

Traffic - Most Active Users - Connections - This report displays the connections established by the most active 

users. 

Traffic - Most Active Users - Data Transferred - This report displays the usernames of users who log on to the 

Server frequently; the number of connections established by various users, and number of bytes transferred.  

Traffic - Protocolwise Connections (Summary) - This report displays the connections established by various users 

and the protocol used by the users to transfer the data, that is, whether the users have used FTP protocol, HTTP, 

or any other protocol to upload or download the files. To view the report, you must enter the name of the protocol 

in the Enter Report Parameters dialog box that opens when you click Show Report. 

Traffic - Sitewise - Hourly by User - This report displays the total number of connection established by various 

users on a particular Site on hourly basis. 

Troubleshooting - Connection Errors - This report displays the number of connection errors occurred while 

connecting to a site, the date and time of the error, remote IP address, local port number, password, type of error, 

and so on. 

Troubleshooting - IP Address Activity (Detailed) - This report displays the details of the user, the date/Time on 

which the user logged on the Server; other details such as local port, socket result ID, protocol, password, physical 

folder name, virtual folder name, and so on are also displayed. To view this report, you must specify the IP address 

in the Enter Report Parameters dialog box that opens when you click Show Report. 

Troubleshooting - Operation Errors - This report displays protocol error codes and corresponding commands, 

sorted in reverse chronological order. The report includes the date and time the error occurred, remote IP address, 

protocol used, username, command, filename, virtual folder, and result (e.g., transfer completed).  

Troubleshooting - Event Rules Failures - This report display failures related to the Event Rules. 

GENERATING A REPORT 

The ARM comes with a number of preconfigured reports to help you start analyzing data right away. The built-in 

reports were designed to respond to the most common data analysis requests. Refer to Preconfigured Reports for 

a list of available reports. 

To generate a report 

1. In the Administrator, connect to the Server and the reports database, and click the Reports tab. 

2. In the left pane, click the desired report. 

3. In the right pane, specify any filters.  

4. Specify a date range from which you want pull data. 

5. Type the appropriate parameters/wildcards for the search if the following reports are used: 

 Activity By File - Type the file name. 

 Activity By Group - Type the group name. 
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 Troubleshooting IP address Activity - Type the IP address. 

6. Click Show Report. The ARM connects to the auditing database and displays the data in the right pane. 

 

ARM displays the first page of the report as soon as the data is ready, then continues to load additional 
pages. You can monitor the progress of loading by watching the current page/total pages indicator on the 
report filter bar.  
 

 
 
If you want to stop a report from loading, click another report in the left pane. 

 

  



EFT Server™ version 6 

 

666  

REPORT FILTERS  

You can filter the fields in a report based on various conditions to display only the data that meet the filtering 

criteria. 

The Report Filters area contains two sets of combo boxes, operands (AND, OR), and a text box. 

 

Use the second set of filters to further define the report using AND or OR.  

For example, suppose you want to filter an action report that shows each the files that were created by these 

actions: 

1. In the first combo box, click Action. 

2. In the second combo box, click = or Contains. 

3. Type created in the value text box. 

4. Click Show Report. 

MANAGING REPORTS 

The topics below provide information regarding managing the reports of the Server activity. 

SAVING A REPORT 

You can save reports to a file and export them in the following formats: plain HTML (.html), Report File (.vp), 

Portable Document Format (.pdf), or plain text (.txt).  

To export a report  

1. In the Administrator, connect to the Server and the reports database, and click the Reports tab. 

2. With the report displayed in the right pane, click Save As . 

3. In the Save as dialog box, specify the format and location to save the report. 

EXPORTING REPORTS IN XML FORMAT 

You can save the reports on your computer in the XML format and can send reports to anybody who wants to see 

the report.  
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To export the report 

1. In the Administrator, connect to the Server and click the Reports tab. 

2. In the left pane, click the desired report. 

3. On the main menu, click Reports > Export Report or right-click the report and click Export Report. The 

Save As dialog box appears. 

 

 

4. Specify a name and a location to save the report, then click Save. 

EXPORTING AND PUBLISHING REPORTS IN THE REPORT DESIGNER 

Instead of printing the report, you may want to export it into a file and distribute it electronically to your clients or 

coworkers. VSReport Designer supports several export formats, listed below:  

Format  Description  

Paged HTML  Creates one HTML file for each page in the report. The HTML pages contain links that let 
the user navigate the report.  

Drill-Down 
HTML  

Creates a single HTML file with sections that can be collapsed and expanded by the user 
by clicking on them.  

Plain MILT  Creates a single, plain HTML file.  

PDF  Creates a PDF file that can be viewed on any computer equipped with Adobe's Acrobat 
viewer or browser plug-ins.  

VSPrinter  Creates a file using the VSPrinter control's native format. The file can be loaded, viewed, 
and printed from a VSPrinter control within an application or Web page.  

Text  Creates a plain text file.  

To create an export file  

1. In the Administrator, connect to the Server and click the Reports tab. 

2. In the left pane, click the desired report. 

3. In the right pane, click Edit Report . The report opens in the Report Designer. 

4. In the left pane of the Report Designer, click the report that you want to export. 

5. On the File menu, click Export and use the File Save dialog box to select the type of file you want to 

create, its name, and location. 
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IMPORTING REPORTS 

You can add reports to the Server by importing the XML reports from the local drive to the Server.  

To import reports 

1. In the Administrator, connect to the Server and click the Reports tab. 

2. On the main menu, click Report > Import or right-click the Reports node and click Import from the 

shortcut menu. The Open dialog box appears. 

 

 

3. Click the XML file you want to import, then click Open. 

4. The report is added in the left pane under Reports. 

DELETING A REPORT 

You can delete any reports that you no longer use. 

To delete reports  

1. In the Administrator, connect to the Server and click the Reports tab. 

2. In the left pane, click the report, then do one of the following: 

 On the main menu, click Reports > Delete Report. 

 Right-click the report and click Delete Report.  

 Click Remove . 

A confirmation message appears.  

3. Click Yes to delete the report. The selected report is deleted. You cannot recover the report unless you 

previously exported and saved it. 
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SAVING REPORT OUTPUTS 

The report can be saved HTML, PDF, and XML.  

To save reports in different formats  

1. In the Administrator, connect to the Server and click the Reports tab. 

2. In the left pane, click the report, then do one of the following: 

 On the main menu, click Reports > Save Report Output As.  

 Right-click the report, then click Save Report Output As.  

The Save As dialog box appears. 

 

 

3. Navigate to the folder in which you want to save the report.  

4. In the File name box, type a name for the report.  

5. In the Save as type box, click the list to select a format, then click Save. 

RENAMING A REPORT 

You can rename the preconfigured reports and your custom reports. 

To rename a report 

1. In the Administrator, connect to the Server and click the Reports tab. 

2. Click Edit Report . 

 

The report designer appears.  
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3. In the left pane, click the report name to make it editable, type your changes, then press ENTER or click 

away from the edit box. 

4. On the toolbar, click the Save icon , then close the Report Designer.  

 

The new name does not immediately update in the Reports tree of the Administrator. If you double-
click the report in the tree, the name will update. 

CUSTOM REPORTS 

The topics below provide information regarding creating custom reports of the Server activity in the Administrator. 

THE VSREPORT DESIGNER 

Ad hoc querying, sorting, filtering, and reporting can be accomplished by editing one of the existing reports or 

creating a new report in the provided report editor. This tool can be launched from the Windows Start menu or 

from within the Administrator.  

The report editor tool bundled with ARM is a robust report designer licensed from Component One. During the 

Server evaluation period, VSReport Designer is available for use as a fully functional 30-day trial. A license for 

VSReport Designer is included with each purchase of ARM. After the 30-day trial, ARM must be activated along 

with the Server to continue using VSReport Designer. Most of the main functions of the report designer are 

described in this help file; however, the VSReport Designer has its own Help file, accessed by clicking help on the 

main menu or opening vsrpt8.chm in the Server installation folder (C:\Program Files\GlobalSCAPE\EFT). 
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In VSReport Designer, you can work on existing report templates, change field locations and properties, add 

various levels of grouping, sorting, etc. You can also create new reports and select ARM’s database tables from 

which to retrieve data fields or paste in SQL code for advanced queries of the data source, giving customers 

complete freedom in designing their report. Styles for the report (colors, fonts, background logo images, etc.) can 

all be manipulated from within the designer. You can also import report definitions from Microsoft Access files 

(MDB).  

 

Translation of Access reports requires that Microsoft Access is installed. Once the report is imported into the 
Designer, Access is no longer required. 

 

 

The main Designer dialog box includes the following:  

 Report list - The left pane of the Report Designer lists all report templates contained in the current report 

definition file. (A report can contain multiple report templates.) You can double-click a report name to 

preview or edit the report. You can also right-click in the list to rename, copy, and delete report 

templates. 

 Preview/Design pane - The right pane is the main working area of VSReport Designer. In preview mode, it 

displays the current report. In design mode, it shows the report's sections and fields and allows you to 

change the report definition.  

 Main Menu - The main menu is used to access submenus, load and save report definition files, import 

report definitions, and print reports. 

 

 

 Shortcut toolbar - Shortcuts are used to access the most common menu functions: new file, open, import, 

save, print, undo/redo, cut/copy/paste, create/delete report, and help.  

 

 

 View toolbar - The View toolbar allows you to easily switch between preview and design modes, activate 

the design grid, and display the property and grouping panes.  

 

 

 Toolbox - The Toolbox provides tools for creating report fields. This toolbar is enabled only in design 

mode.  
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 Formatting toolbar - The Formatting toolbar provides shortcuts to tools for aligning, sizing, and spacing 

report fields. This toolbar is enabled only in design mode. 

 

 

 Status bar - The Status bar at the bottom of the Report Designer displays information about what 

VSReport Designer is working on (e.g., loading, saving, printing, rendering, importing, etc). 

 

 

OPENING VSREPORT DESIGNER 

When you create a new report, you create it manually or use the Report Wizard. Both methods are provided in the 

VSReport Designer, as described below.  

To open VSReport Designer 

1. In the Administrator, connect to the Server, then do one of the following: 

 On the toolbar, click the click New Reports icon . 

 On the main menu, click Reports > New Report. 

 Click the Reports tab, then click the New Reports icon.  

The New Report dialog box appears.  
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2. Type a title for the new report, then click Create. The Report Designer appears.  

 

 

3. Do one of the following to create a report: 

 Manually define the report: click the Design icon , then continue with the instructions in 

Using Design Mode, Changing Field, Section, and Report Properties, Changing the Data Source, 

Adding, Editing, and Deleting Fields in the Report, and Grouping and Sorting Data.  

 Use the Report Wizard: Click File > New Report or click the New Report  icon on the toolbar.  

CREATING A REPORT WITH THE REPORT WIZARD 

The easiest way to start a new report is to use the Report Wizard. The Report Wizard will help you create a basic 

report, specify the data source, fields to include in the report, layout of the report, and styles or labels to use in the 

report. 

To use the Report Wizard  

1. In the Administrator, connect to the Server, then do one of the following: 

 On the toolbar, click the click New Reports icon . 

 On the main menu, click Reports > New Report. 

 Click the Reports tab, then click the New Reports icon on the bottom toolbar.  

The New Report dialog box appears.  
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2. Type a title for the new report, then click Create. The Report Designer appears.  

 

 

3. Click File > New Report or click the New Report icon on the toolbar. The New Report Wizard appears.  

 

 

4. Do one of the following: 

 In the ConnectionString box, type the string used to connect to the data source.  
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 Click  to define the connection string. The Data Link Properties dialog box appears.  

 

 

a. On the Provider tab, click Microsoft OLE DB Provider for SQL Server as the provider to 

connect to the SQL Server database, then click Next. 
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b. In Select or enter a server name, click the arrow to select a name or type the name of 

the Server.  

c. In Enter information to log on to the Server, click an authentication option to log on to 

the Server: 

 Use Windows NT Integrated security - Your computer automatically picks up 

the credentials from your computer and connects you to the database. 

 Use a specific user name and password - Specify the user name and the 

password to be used to log on to the Server. Select the Allow saving password 

check box to save the password in the connection string. 

 

Select the Blank password check box if the Server requires a blank 
password to log on the database server. Even if you do not type any 
password when you create a user account on a database server, you can 
select the Allow saving password check box. In this case, the Server takes a 
dummy password value and saves that value in the connection string. 
Selecting the Blank password check box disables the password field. 

d. Click one of the following: 

 Select the database on the Server, and then click a database in the list. 

 Attach a database file as a database name - Click the ellipsis icon  to 

browse for the SQL Server database file (*.mdf). The Select SQL Server 

Database File dialog box appears. Select a file, then click Open. The path to the 

file appears in the Using the filename box. 

5. Click OK in the Data Link Properties dialog box to return to the New Report Wizard. 

6. Click one of the following: 

 Table to select a database table, such as tbl_EventRules. 

 SQL Statement to write SQL queries, that is, SELECT Statements. For example, SELECT * FROM 

tbl_actions. 

7. Click Next. The fields that appear in the Available list depend on your selection in the previous step. For 

example, if you selected tbl_EventRules, the fields for Event Rules appear. 
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8. Double-click a field, click it and use the arrows, or drag and drop one or more field to the Groups list. 

Group fields define how the data is sorted and summarized. The information in the Detail list is grouped 

according to the group name. The Detail list displays the details for each group. Detail fields define the 

information you want to appear in the report. For example, if you move SiteName to the Groups list and 

Time_stamp, EventName, and so on to the Detail list, then the report displays the time stamp and events 

under the respective Sites, considering different Sites as different groups. 

 

You can also drag and drop the available fields into the Groups or Detail section. 

9. Click Next. The layout options appear. 
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10. Click a layout for the report. When you select a layout, a thumbnail preview appears on the left to give 

you an idea of how the layout will appear on the page. There are two groups of layouts. The first is for the 

reports with no groups defined and other is for the reports with group fields defined.  

 If you did not define the Group field, the following options are available: 

 Columnar 

 Tabular 

 Justified 

 Labels. The Labels layout option is used to print Avery-style labels, available in a variety 

of sizes, blank or preprinted. If you select this option, the next page offers options for 

the type of label for your report.  

o If you defined the Group field, the following options are available: 

 Stepped 

 Outline 

 Aligned 

11. If you selected any option other than Labels, click the report orientation from the following options. If you 

select the Labels option, the Orientation options are disabled. 

 Portrait 

 Landscape 

12. Select the Adjust fields to fit page check box to adjust fields in a way that they fit the page. 

13. Click Next. 

14. Do one of the following: 

 If you specified Labels, click a type of label in the Labels list, then specify the Units, Metric or 

English, and the paper type, Sheet Feed (single sheet) or Continuous (continuous paper). 
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 If you specified anything other than Labels, specify a style for the report title.  

 

 

15. Click Next. 

 

 

16. Type a title for the report. 

17. Do one of the following: 

 To view the report, click the Preview the report. 

 To modify the report in Design view, click the Modify the report's design. 

18. Click Finish. Your new report name appears in the left pane of the Report Designer. The right pane 

displays a preview of the report or the design view, depending on your selection in the previous step. 

19. Click Save to save the report. 

20. Click File > Close to close VSReport Designer. The report appears on the Reports tab. 

21. Use Design mode to add/remove fields, resize fields, add graphics, and so on. 
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CREATING A REPORT IN DESIGN MODE 

The New Report Wizard is used to specify a data source and basic framework for the report. To get exactly the 

report you want, you can adjust and enhance the data fields and layout. The Report Designer provides the options 

to modify the report to fit your needs. 

To use the Report Designer design mode 

1. In the Administrator, click the Reports tab, then do one of the following: 

 Click the report that you want to modify, then click Edit Report.  

 Create a new report. (Refer to Creating a Report with the Report Wizard for instructions.) 

The report appears in the Report Designer. 

2. The left pane of the Report Designer lists all report templates contained in the current report definition 

file. Click the report that you want to modify, then click the Design  icon on the View toolbar, or on 

the main menu, click View > Design. The right pane switches from Review mode to Design mode, and 

displays the controls and fields that make up the report. 
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THE REPORT SECTIONS 

The report is divided into sections, labeled Header, Page Header, Detail, and Page Footer, containing fields that 

hold the labels, variables, and expressions that you want in the generated report. The sections determine the 

appearance of the beginning and end of the report, and each page and group. The table below describes where 

each section appears in the report and the sort of data that typically appears in each section. 

Section  Appears  Typically Contains  

Page Header  Once per report  The report title and summary information for the whole report  

Page Header  Once per page  Labels that describe detail fields and/or page numbers  

Group Header  Once per group  Fields that identify the current group and possibly aggregate values for the 
group (e.g. total, percentage of the grand total)  

Detail  Once per record  Fields containing data from the source record set  

Group Footer  Once per group  Aggregate values for the group  

Page Footer  Once per page  Page number, page count, date printed, report name  

Report Footer  Once per report  Summary information for the entire report  

You cannot directly add and delete sections - the number of sections in a report determines the number of groups. 

Every report has exactly five fixed sections (Report Header/Footer, Page Header/Footer, and Detail) plus two 

sections per group (a Header and a Footer).  

To hide sections that you do not want to display  

1. Right-click the field, click Properties. The Field Properties dialog box appears. 

2. Change the property of Visible to False. 

To resize a section 

1. Click and hold the border of the section and drag it to the position where you want it.  

 

The rulers on the left and on top of the design dialog box show the size of each section (excluding the 

page margins). You cannot make the section smaller than the height and width required to contain the 

fields in it. To reduce the size of a section beyond that, move or resize the fields in the section first, then 

resize the section.  

2. Press and hold SHIFT, then click fields to toggle their selection status. 

3. Press and hold CTRL, then drag the cursor to copy a selection.  

4. Click on the corners of a field to resize it.  

5. Press TAB to move the selection to the next field.  

6. Press the arrow keys to move selected fields.  

7. Press DELETE to remove selected fields. 

 

If you make any mistakes while moving or editing the fields, click the Undo  and Redo  icons.  

When multiple fields are selected, you can use the buttons on the Format toolbar to align, resize, and space them. 

 

You can control the design grid using the Show Grid   and Snap To Grid   icons.  
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CHANGING FIELD, SECTION, AND REPORT PROPERTIES 

You can view and edit the properties of the objects inserted in a report. 

When one or more fields are selected, the Field Properties dialog box displays only the properties and values that 

all selected fields have in common and leaves the other properties blank.  

If no fields are selected and you click a section (or on the bar above a section), the selected section's properties are 

displayed.  

If you click the gray area in the background, the Report properties are displayed. 

To view and edit an object's properties 

 Double-click the object or select the object, then do one of the following: 

o Click Property Window. 

o Press F4 

o Right-click, then click Properties.  

The Field Properties dialog box appears. 

In the example below, the label in the Header section, Activity - All Group (Detailed), is selected. The Field 

Properties dialog box displays the properties of the selected field. 

 

In the Field Properties dialog box, you can change a property by changing its value. For example, you can change 

the text color by changing the ForeColor property. You can change the field's position and dimensions by typing 

new values for the Left, Top, Width, and Height properties. 
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The property dialog box expresses all measurements in twips (the native unit used by the ComponentOne report 

designer), but you can type in values in other units and they will be automatically converted into twips. For 

example, if you set the field's Height property to "0.5in," the property dialog box will convert it into 720 twips.  

CHANGING THE DATA SOURCE 

The data source is defined by the ConnectionString, RecordSource, and Filter properties. These regular report 

properties are set in the Property Window by clicking on the background area where there are no sections. The 

data source is defined when you use the New Report Wizard to create the report.  

To change the data source for a report  

1. View the report in Design mode .  

2. Click the DataSource icon . The Data Source tab of the New Report dialog box appears. 

 

 

3. Specify the ConnectionString and RecordSource properties, then click OK. 

ADDING, EDITING, AND DELETING FIELDS IN THE REPORT 

Use the ToolBox   to add fields to your report. 

VSReport Designer only has one type of field object; the icons in the Toolbox simply set the properties of the field 

to make it look and act in a certain way. Each icon creates a field and initializes the field's properties as follows: 

Icon Name Description 

 

Label field Creates a field that displays static text. 

 

Bound field Creates a field that is bound to the source recordset. When you click this button, a menu 
appears and you can select the recordset field. Bound Fields are not limited to displaying raw 
data from the database. You can edit their Text property and use any VBScript expression. 

 

Expression 
Field 

Creates a calculated field. When you click this button, the code editor dialog will appear so 
you can enter the VBScript expression whose value you want to display. 

 

Check box 
Field 

Creates a bound field that displays a Boolean value as a check box. By default, the check box 
displays a regular check mark. You can change it into a radio button or cross mark by changing 
the value of the field's Checkbox property after it has been created. 



EFT Server™ version 6 

 

684  

Icon Name Description 

 

Unbound 
Picture field 

Creates a field that displays a static picture, such as a logo. When you click this button, a dialog 
box will appear to prompt you for a picture file to insert in the report. A copy is made of the 
picture you select and is placed in the same directory as the report file. You must distribute 
this file with the application unless you embed the report file in the application. When you 
embed a report file in your application, any unbound picture files are embedded too. 

 

Bound 
Picture field 

Creates a field that displays a picture (or object) stored in the recordset. When you click this 
button, a menu appears so you can select a picture field in the source recordset (if there is 
one; not all recordsets contain this type of field). 

 

Line field Creates a line. Lines are often used as separators. 

 

Rectangle 
field 

Creates a rectangle. Rectangles are often used to highlight groups of fields or to create tables 
and grids. 

 

Subreport 
field 

Creates a field that displays another report. When you click this button, a menu appears and 
you can select other reports that are contained in the same report definition file. 

 

Page Break 
field 

Creates a field that inserts a page break. 

After you click any of these icons, drag the mouse over the report and the cursor will change into a crosshair. Click 

and drag to define a space that the new field will occupy, and then release the button to create the new field. If 

you change your mind, press ESC or click the arrow button to cancel the operation. 

You can also add fields by copying and pasting existing fields, or by holding down the control key and dragging a 

field or group of fields to a new position to create a copy. 

To add, edit, or delete fields in a report 

1. In the Report Designer, click View > Design or click the Design icon on the toolbar. The report opens 

in the design mode. 

2. Follow the procedures below depending on the fields that you want to add, edit, or delete. 

To draw a line 

 Click Line , then drag the cursor where you want to draw a line. 

To draw a rectangle 

 Click Rectangle , then drag the cursor where you want to draw a rectangle.  

To add or edit text 

1. Insert a rectangle, or double-click or right-click an existing rectangle, then click Properties. The Field 

Properties dialog box appears.  
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2. Scroll to Text in the Property column, click the Value column, then type the text; press ENTER. 

To add labels 

 Click Label , then drag the pointer to draw a box in the report at the place you want to add a label. 

Name the label, then specify its font, color, and other properties. You can click and drag the label to adjust 

its placement in the report. 

To add data fields 

 Click Data field , then draw a box on the report. Change the properties of the data field by right-

clicking it, then clicking Properties. 
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To create a VBScript expression 

1. Click Calculated field  on the toolbar. The VBScript Editor appears.  

 

 

2. Type the VBScript expression. For example, type: 

=count (Transaction ID)  

3. Click OK. 

4. Drag the pointer and place it under the respective field where you want the result to display. 

5. Click the Preview icon on the toolbar to view the result. 

To insert images 

1. Click Picture . The Open dialog box appears. 

2. Click an image, then click Open. 

3. Drag the cursor to draw a box where you want the image to appear. 

To delete fields 

 Click the field, then press DELETE. 

GROUPING AND SORTING DATA 

After designing the basic layout, you may decide to group the records by certain fields or other criteria to make the 

report easier to read. Grouping allows you to separate groups of records visually and display introductory and 

summary data for each group. The group break is based on a grouping expression. This expression is usually based 

on one or more recordset fields, but it can be as complex as you like.  

Groups are also used for sorting the data, even if you do not plan to show the Group Header and Footer sections. 

The bar across the top of each section (Page Header, Group Header, Detail) contains some useful tools and 

information about the section. 
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The indented box with a minus sign  or a plus sign  to the left of the section is used to collapse and expand 

the section. This feature is useful when you are designing the report to allow you to see a group's header and 

footer on the same screen without scrolling. Collapsing or expanding a section has no effect on how it is rendered 

in the report. 

 An indented circle  indicates that the section currently has zero height. You can drag the divider line 

down to increase the section's Height property.  

 The triangle  to the left of Group Header indicates the group's sorting order. You can click this icon to 

open the Sorting and Grouping dialog box.  

 The labels to the right of the icons are the section name and, for group headers, the value of the group's 

GroupBy property (in this example, Country). 

To add, edit, reorder, or delete groups in the report  

1. Click the Sorting and Grouping icon , click View > Grouping Window, or click the triangle  to the left 

of the group header. The Sorting and Grouping dialog box appears.  

2. Use this dialog box to create, edit, reorder, and delete groups. 

 

 

To create a new grouping condition 

1. In the Group On column, click an empty row and type a name. For complex grouping, type an expression 

instead of a simple field name. For example, you could use "Country" to group by country or 

"Left(Country, 1)" to group by country initial.  

2. In the Sort column, click the arrow to select the sort order you want to use for grouping the data 

(Ascending, Descending, or None).  

3. In the Header, Footer, and Keep Together columns, specify whether the new group will have visible 

Header and Footer sections, and whether the group should be rendered together (No, With first detail, or 

Whole Group) on a page. 

 

You cannot use memo or binary (object) fields for grouping and sorting. This is a limitation 
imposed by OLEDB. 
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4. After you enter some data for the first group, a new blank row is appended to the list, so you can keep 

creating new groups. If you add more groups, you can change their order by clicking on the left-most gray 

cell in the row and dragging the row to a new position. This will automatically adjust the position of the 

Group Header and Footer sections in the report. 

5. To delete a field in the group, select it, then press DELETE. 

6. Click OK. The changes appear in the Designer. 

 

  



The Auditing and Reporting Module 

689 

  





 

691 

THE WEB TRANSFER CLIENT 

The system administrator must configure client connections to the Server via the Web Transfer Client. For the 

procedures for installing, configuring, and providing user access to the Web Transfer Client, refer to Configuring 

the Web Transfer Client. 

The topics below provide information regarding configuring and using the Web Transfer Client interface to 

remotely connect to the Server. 

OVERVIEW OF THE WEB TRANSFER CLIENT 

EFT Server optionally includes the Web Transfer Client, which is a browser-based file transfer client that allows 

users to transfer files over HTTP or HTTPS using a Web browser to and from any the Server. The client deploys 

automatically if you have a license for the client and the client is enabled for the user in the Administrator.  

 The left pane displays files on the user's computer.  

 The right pane displays the files accessible to the user on the Server.  

 The bottom pane displays the items being transferred. 
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SYSTEM REQUIREMENTS FOR THE WEB TRANSFER CLIENT 

 Java 1.4.2 (J2SE) or better is required for the computer running the Web Transfer Client. You must accept 

a security prompt (click Yes) to enable the Java applet that drives the client application. 

o For optimal performance and capabilities, be sure you have the latest JRE. (Windows Vista does 

not support older versions of Java.) 

 The browser running the client must have JavaScript enabled. 

 The browser running the client must have cookies enabled. Note that cookies work on IP addresses or full 

domain names, not Localhost.  

 The Web Transfer Client has been tested for use with current versions of Internet Explorer, Firefox, Safari, 

and Chrome browsers. (As of this release, Internet Explorer 7, Firefox 3.0, Safari 3.1.1, and Chrome 

0.2.149.30)  

CHECKING JAVA RUNTIME VERSIONS 

Java Runtime Environment (JRE), installed on most computers to allow applications to run in Internet pages, must 

be installed on the computer on which the Web Transfer Client is used. You can download the current JRE version 

by testing your Java Virtual Machine (JVM) at http://www.java.com/en/download/installed.jsp.  

To view the Java runtime version your browser is using 

 Internet Explorer and Firefox - Click Tools > Sun Java Console. The plug-in version number displays at the 

top of the console. 

 

 

 Safari - Click Help > Installed Plugins. 

 Google Chrome - Plug-ins are enabled by default. If plug-ins are enabled and Google Chrome detects a 

missing plug-in for a web page, it'll prompt you to install the plug-in at the top of web page. 

http://www.java.com/en/download/installed.jsp
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CONNECTING TO AND LOGGING OFF OF THE WEB TRANSFER CLIENT 

Before users can log in to EFT Server using the Web Transfer Client, the EFT Server administrator must 

configure EFT Server to allow Web Transfer Client connections. EFT Server allows users concurrent access to the 

Web Transfer Client up to the number of available licenses. If a user attempts to access the client when the 

maximum number of licenses is in use, an HTML upload form loads instead. 

To connect to the Web Transfer Client 

1. Type in the URL provided to you by the EFT Server administrator, then press ENTER.  

2. If a login dialog box appears, type the username and password provided to you by the EFT Server 

administrator. You might have to type the domain in front of your username. For example, 

globalscape\WTCuser.  

 If each of the Web Transfer Client licenses is in use, you will see a message stating so, and will be 

redirected to the HTML Listing and Upload form, where you can still browse and upload files. 

 On Internet Explorer, a message might appear that says "Your security settings do not allow Web 

sites to use Active X controls installed on your computer." Close the popup bar. 

 If the correct version of Java is not installed, a message might appear asking you to install it. Click 

the link to install Java from the java.com download page. If you are unsure which version to 

install, or you do not have permission to install applications, contact your network administrator. 

 If you receive a message regarding the certificate, accept it. If you select the "always accept 

certificates from this publisher" check box, you will not have to accept the certificate every time 

you connect to the WTC. 

The folders and files in your local file system and remote filesystem appear in their respective panes. 

 

Each refresh of the browser counts as one session, so do not click the browser's Refresh icon or F5. Click the 
Refresh icon in the WTC instead, which refreshes the display without requesting a new session. 

To log off of the Web Transfer Client 

 Click Log Out. A confirmation message appears.  

Directory listings and other screens are often retained in the browser's history. If your directories contain sensitive 

data, such as customer information, you should delete temporary files/clear the browser's cache. 

When the browser is closed, the session expires within 5 minutes. The timeout is not user configurable. When your 

WTC session ends, the Queue pane is cleared automatically. That is, if you were to log back in immediately, the 

Queue pane would be empty. 

 To log back in, close the browser, then reopen the browser and connect to the server. 
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REMOTE FILESYSTEM 

The right pane displays the files on the Server you are connected to, the last time each file was modified, and the 

file's size.  

In the right pane, you can: 

 Create a new folder 

 Delete a file or folder 

 Rename a folder 

 Navigate within the filesystem 

 Navigate up a folder 

 Sort information by type, name, date modified, or bytes (click column header to sort by that category) 

 Filter  the pane to display only the files you want 
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LOCAL FILESYSTEM 

The left pane displays the files on your local computer, the last time each file was modified, and the file's size.  

In the left pane, you can: 

 Create a new folder 

 Delete a file or folder 

 Rename a folder 

 Navigate within the filesystem 

 Navigate up a folder 

 Sort information by type, name, date modified, or bytes (click column header to sort by that category) 

 Filter  the pane to display only the files you want  
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QUEUE PANE 

The bottom pane lists the transfers from the current session.  

In the bottom pane, you can view the following information about files transferred or pending transfer: 

 File name 

 Status of the transfer, such as Completed, Uploading, Downloading, Waiting, Failed, CRC Failure, or 

Cancelled 

 Whether file is an upload or download 

 The total size of the file 

 A progress indicator 

 The local path of the file 

 The remote path of the file 

 

TRANSFERRING FILES WITH THE WEB TRANSFER CLIENT 

With the Web Transfer Client, you can transfer files between your local computer and a remote filesystem to 

which you have the proper permissions. 

You can drag and drop multiple folders and files at once into the transfer queue. Each file is added to the queue, 

and then the Server transfers up to 5 files at a time (the default configuration for maximum concurrent transfers). 

Browsers use JavaScript interaction with the applet to constantly poll the status of all items in the queue, and then 

to update the browser window to display the different values. As the number of items in the queue gets very large, 

the browser has a hard time keeping up with all the activity (modifying and re-rendering the DOM, interacting with 

the GUI and the applet, and so on). Adding 100 files to the queue would be reasonable, but 1000 files would likely 

slow down the browser and the operating system. The actual limit to the number of files in the queue without 

bogging down the system depends on the browser, computer running the browser, and so on.  

To transfer files between filesystems 

1. Navigate to and open the folder to which you want to transfer the file. 

2. Navigate to the file that you want to transfer, then do one of the following: 

 To transfer from your local filesystem to the remote filesystem, click the Upload arrow . 

 To transfer from the remote filesystem to the local filesystem, click the Download arrow . 

The transfer progress appears in the bottom pane. 
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If the network is lost while the Web Transfer Client is transferring files, it waits for a timeout period (30 seconds) 

and then shows a red X for the transfer. The Status column in the Queue pane indicates that the transfer failed. If 

you want to attempt to transfer the file again, you must login again when the network is available. After the Web 

Transfer Client reconnects, it resumes the transfer from where it stopped.    

FILTERING THE FILESYSTEM LIST 

You can filter the display of the files and folders in the Local and Remote Filesystem panels to display only the files 

that you want, by name, file type, size, and/or date modified to limit the display to specific files and folders.  

By default, the WTC is designed to automatically filter the file list and display only the first 499 files and folders. 

Once that limit is reached, the WTC will prompt you to use filtering to find the files that you want. 

Limiting the file list to 499 files helps to avoid performance issues when browsing folders that contain very large 

numbers of files and folders. Depending upon the size of the folder and the capabilities of the computer running 

the browser, performance of the system can degrade significantly. 

On the EFT Server computer, EFT Server administrators can change the threshold at which this automatic filtering 

is enforced. For details, refer to the Knowledge Base article, http://kb.globalscape.com/article.aspx?id=10371, 

Automatic Filtering in the Web Transfer Client. (For advanced users only.) 

To filter the filesystem list 

1. Click the Filter link in the upper right corner of the filesystem pane. The Filter dialog box appears. 

 

2. In the Filter files or folders named box, type the name and/or type of file, or leave the default of *.* to 

filter all files. For example:  

 To display only text files, type *.txt.  

 To display any file called abc with any file extension, type abc.*. 

 To display any file that starts with abc, type abc*.txt. 

http://kb.globalscape.com/article.aspx?id=10371
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3. (Optional) In the Modified date area, click an option (on or before, on or after, between/and) and then 

specify to display only files that were modified on a particular date or date range. Do one of the following: 

 In the box next to the option you selected, type the date in the format MM/DD/YY. 

 Click the Calendar icon , then click a date on the calendar. Use the left- and right-facing 

arrows to scroll between months. 

 

 

 Click the Calendar icon , then click Today to use today's date. 

4. (Optional: If you want to specify the file size, you must specify a date or date range.) In the Size area, 

specify whether to display files that are at least or at most <n> KB. For example, if you specify at least 1 

KB, the client will display any files that are more than 1 KB, but not less; if you filter for files that are at 

most 1 KB, the client will display any files that are up to 1 KB, but not more.  

5. To apply the filter, click Filter, or click Cancel to close the dialog box. 

6. To clear your filter and show all files, click the Filter link, then in the Filter dialog box, click Clear, then click 

Filter. 
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MANAGING FOLDERS IN THE WEB TRANSFER CLIENT 

Using the Web Transfer Client (WTC) you can manage the files and folders both on your local system and on the 

remote system(s) to which you have access. The procedures below describe how to: 

 Create a new folder 

 Delete a file or folder 

 Rename a folder 

 Navigate within the local or remote filesystem 

 Navigate up a folder 

 Sort information by type, name, date modified, or bytes (click column header to sort by that category) 

To create a new folder 

1. In the upper-left corner of the pane, click the New Folder icon . A dialog box appears into which you 

can type a name for the folder. The default name is New Folder. 

2. Type a name for the folder, then click OK. The new folder appears in the pane in which it was created. 

To delete a folder 

1. In the upper-left corner of the pane, click the Delete Folder icon . A confirmation message appears. 

2. Click OK. The folder is removed. 

To rename a folder 

1. In the upper-left corner of the pane, click the Rename Folder icon . A dialog box appears into which 

you can type a name for the folder. The default name is New Folder. 

2. Type a name for the folder, then click OK. The new folder appears in the pane in which it was created. 

To navigate within the local or remote filesystem 

 In the text box at the top of the pane, type or browse for the location, then press enter.  

 

 

The files and folders for the location appear in the pane (if you have permission to access it). 

To move up one folder 

 In the upper-right corner of the filesystem pane, click the Up Folder icon . 
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To sort the files and folders within the local or remote filesystem 

 Click the column header of the column by which you want to sort the list.  

 

 

For example, to sort by file type, click the page icon in the far left column; to sort by date, click Modified. 

MANAGING THE QUEUE PANE IN THE WEB TRANSFER CLIENT 

The Queue pane lists the transfers from the current session. After you close the Web Transfer Client, the queue is 

cleared automatically. The procedures below describe how to: 

 Stop a transfer 

 Resume a transfer 

 Clear the queue 

To stop a transfer 

 In the upper-left area of the Client, click the Stop icon . 

To resume a transfer 

 To the right of the Status column, click the Resume Transfer icon . 

To clear the queue 

 Click the Remove Finished/Cancelled Items icon .  
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CHANGING THE DATE FORMAT 

The Web Transfer Client can display the date files were modified with the month first (MM/DD/YY) or the day first 

(DD/MM/YY). 

To change the format of how dates are displayed  

1. Click Settings . The Web Transfer Client - Settings dialog box appears. 

 

 

2. The Use MM/DD/YY date formatting check box is selected by default. Clear the check box if you want it 

to display the day/month/year (e.g., 28/05/2008) instead of month/day/year (e.g., 05/28/2008). 

3. Click Save to save changes or Cancel to keep existing settings. 

4. Refresh the display using the WTC's refresh icon . The refresh icon in the WTC refreshes the display 

without requesting a new session. Each refresh of the browser counts as one session, so do not use the 

browser's refresh icon or F5. 

XCRC INTEGRITY CHECKING IN THE WEB TRANSFER CLIENT 

The Web Transfer Client can validate the integrity of files transferred to and from the Server. Cyclical Redundancy 

Check (CRC32) is enabled on the Web Transfer Client by default. The EFT Server administrator must have enabled 

XCRC on the Site in its FTP configuration to take advantage of this feature. 

With CRC enabled, when the Web Transfer Client transfers a file to or from the Server, it automatically queries the 

Server for the CRC value of the file, then compares it to the CRC value for the local file. If they match, the transfer 

is reported as successful. If they do not match, the Queue pane reports "CRC Failure." The user can then retry the 

transfer, if necessary. The client does not automatically retry the transfer if they do not match. 

To disable CRC from the Web Transfer Client 

1. Click Settings . The Web Transfer Client - Settings dialog box appears. 

 

 

2. The Calculate CRC to verify integrity of transfers check box is selected by default. Clear the check box if 

you do not want to use CRC. 

3. Click Save to save changes or Cancel to keep existing settings. 
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CHANGING YOUR PASSWORD IN THE WEB TRANSFER CLIENT 

You can change the password you use to log in to the Web Transfer Client from within the Web Transfer Client. 

 

If the EFT Server administrator has configured complex password settings, the new password must meet the 
complex password settings (e.g., must not match the last <n> passwords, must contain a mixture of character 
types, etc.). 

To change your password 

1. Click Change Password . The Change Password dialog box appears. 

 

2. In the Old Password box, type the password that you used to log in to the Web Transfer Client. 

3. In the New Password box, type a new password. 

4. In the Confirm Password box, type the new password again. 

5. Click Change Password to verify the new password or Cancel to keep your current password. 

 If the new and confirm passwords do not match, an error message appears. Click OK to try again. 

 If the new password is the same as any of your previous passwords (depending on password 

history settings), a message appears and the password is not changed. Click OK to try again. 

 If the new password is accepted, the Password Accepted message appears and you are logged 

out of the Server. Click OK to continue. 

6. The login dialog box appears. Type your new password, then click OK to log back in to the Server. 
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ACCESSING THE SERVER THROUGH A PROXY   

The Web Transfer Client can connect to EFT Server through a proxy. If you are accessing the Server through a proxy 

server, the user must enter a username and password for the proxy server to allow the Web Transfer Client to 

negotiate the connection.  

To log into a proxy from the Web Transfer Client  

1. Click Proxy . The Web Transfer Client - Proxy Settings  dialog box appears. 

 

 

2. In the User Name box, type the username that you use to log into the proxy server. 

3. In the Password box, type the password that you use to log into the proxy server. 

2. The Remember my password box is selected by default. Clear the check box if you do not want the Web 

Transfer Client to remember your password for subsequent logins to the proxy. 

4. Click Accept to save the settings or click the X in the upper right corner to cancel. 

THE ADVANCED WORKFLOW ENGINE 

(Available in EFT Server Enterprise) With EFT Server's Event Rules, you can configure EFT Server to perform an 

action automatically when a specific event occurs. You can use Automated Workflows to design scripts, batch files, 

macros, or any other code-intensive process using an easy drag-and-drop interface. 

For more information about building and using the Advanced Workflow Engine, refer to the Advanced Workflow 

Engine User Guide PDF and online Help. 

THE DMZ GATEWAY 

GlobalSCAPE® DMZ Gateway is designed to reside in the demilitarized zone and provide secure communication 

with EFT Server behind intranet firewalls without requiring any inbound firewall holes between the internal 

network and the DMZ.  

 DMZ Gateway (single-Site) supports connections from EFT Server or EFT Server - Enterprise.  

 DMZ Gateway Enterprise (multi-Site) connects to EFT Server Enterprise only. DMZ Gateway Enterprise 

supports multiple simultaneously connected Sites. DMZ Gateway Enterprise can listen at the same IP 

address to one or more Sites on EFT Server, as long as the Sites that are connected each request a 

different port. If you want multiple Sites to use the same port, for example, if you want Site A listening on 

port 80 for plaintext HTTP connections and Site B listening on port 80 for WTC connections, then a 1-to-1 

mapping is required to avoid port conflicts. You can do this with DMZ Gateway Enterprise by creating one 

or more Profiles in DMZ Gateway that can each map to one or more Sites.  

For more information, refer to the DMZ Gateway User Guide PDF and online Help. 

http://help.globalscape.com/help/guides/Advanced_Workflow_Engine_6_User_Guide.pdf
http://help.globalscape.com/help/index.html
http://help.globalscape.com/help/guides/DMZ_Gateway_v2_User_Guide.pdf
http://help.globalscape.com/help/index.html
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THE SECURE AD HOC TRANSFER MODULE 

EFT Server's Secure Ad Hoc Transfer (SAT) module allows your internal users to send and receive large e-mail file 

attachments to recipients outside of your organization quickly, reliably, and securely, all without having to 

manually create or maintain FTP accounts on EFT Server. 

The SAT Module works in conjunction with EFT Server and allows users inside an enterprise to transfer files to and 

from recipients outside the organization with secure authentication, non-repudiation, and auditing capabilities. 

Version 1.5 added ASP.NET technology to overcome file size limits when uploading very large attachments. The 

Web page supports file attachments up to 2GB, which is a limit of HTTP.  

For more information, refer to the Secure Ad Hoc Transfer User Guide PDF and online Help. 

GLOBALSCAPE® SERVER COM API 

You can interact directly with EFT Server from your own custom applications using any COM-enabled programming 

language such as Visual Basic (VB), Java, or C++. You can create a script with the development IDE of your choice.  

To create a new script file, you must be familiar with programming concepts and should have experience with 

COM-enabled programming languages.  

For more information, refer to the GlobalSCAPE Server COM API User Guide PDF and online Help. 

http://help.globalscape.com/help/guides/SecureAdHocTransfer_v2_User_Guide.pdf
http://help.globalscape.com/help/index.html
http://help.globalscape.com/help/guides/GlobalSCAPE_Server_COM_API_v6_User_Guide.pdf
http://help.globalscape.com/help/index.html
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GETTING HELP 

For the most up-to-date information regarding this version of EFT Server and its modules; to view version history, 

updates, and activation instructions; to download a PDF of this user guide; and for other self-help resources, visit 

the Support Center. 

 

After release of the product, the online help is updated as errors and omissions are identified; therefore, you 
should visit the Support Center when the help file in the application does not answer your question. 

The following conventions are used in this user guide:  

 boldface text : Boldface type in text refers to interface buttons, hyperlinks, and filenames/paths. Boldface 

type also serves as emphasis to set apart main ideas.   

 italicized text:  Italicized text applies to new terms introduced for the first time. Italicized text can also 

serve as emphasis for key concepts.   

 unicode text:  Unicode text denotes exact code, literal commands, and user input.   

GLOBALSCAPE®  SUPPORT CENTER 

For fast answers to most questions, visit the GlobalSCAPE Help Center. Our Customer Service team can answer 

your questions about software activation and registration or help with order problems. If you need technical 

assistance with your software, please submit your question to the Technical Support team. 

GlobalSCAPE also offers numerous self-help resources: 

 The GlobalSCAPE User Forum is a great place to find information or seek help from the global community 

of GlobalSCAPE customers and product experts.  

 The GlobalSCAPE Knowledge Base (KB) is a dynamic compendium of information on our products.  

 Subscribe to the RSS feed to keep abreast of the latest KB articles. Copy and paste this URL 

http://kb.globalscape.com/rssfeed.aspx into your RSS feed reader. (See below for examples.) 

 Subscribe to GlobalSCAPE e-mail Announcements Sign up for the GlobalSCAPE Newsletter, press releases, 

product announcements, and other GlobalSCAPE news.  

 Recover a Lost Serial Number - If you know the e-mail address you used when you activated the software, 

we can send it to you at your new address.  

 Contact Customer Service by phone or e-mail.  

 Contact Sales by calling 1-800-290-5054 or 1-210-308-8267, or use the online submission form. Sales 

representatives are available 8:00 a.m. to 6:00 p.m. (US Central Time) Monday through Friday, excluding 

major US holidays.  

 Order Status - Complete the online e-mail form to request information about your order. 

 EFT Server support pages provide downloads, documentation, activation instructions, and the latest news 

regarding EFT Server. 

  

http://www.globalscape.com/support/
http://www.globalscape.com/support/
http://www.globalscape.com/support/
http://www.globalscape.com/support/techsupport.aspx
http://forums.globalscape.com/
http://kb.globalscape.com/rssfeed.aspx
http://www.globalscape.com/e/s.aspx
http://www.globalscape.com/support/lostserial.aspx
http://www.globalscape.com/support/customerservice.aspx
http://www.globalscape.com/support/sales.aspx
http://kb.globalscape.com/article.aspx?id=10296
http://www.globalscape.com/support/customerservice.aspx
http://www.globalscape.com/support/eft.aspx
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To add the GlobalSCAPE Knowledge Base RSS feed to your Google home page 

 

The procedures below are provided as an example; see your feed reader's online help for specific instructions. 

1. Sign in to your Google home page, then, in the upper right area of the page, click Add Stuff. 

2. At the top center of the page, to the right of Search Homepage Content, click Add by URL. The Add by 

URL form appears. 

3. In the text box, provide the URL of the RSS feed, http://kb.globalscape.com/rssfeed.aspx, then click Add. 

4. In the upper left corner, click Back to Homepage. The GlobalSCAPE RSS feed appears on your home page. 

 

 

To add the RSS feed to Microsoft Outlook 2007 

1. On the Tools menu, click Account Settings. 

2. On the RSS Feeds tab, click New. 

3. In the New RSS Feed dialog box, type or paste the URL of the RSS Feed. For example, 

http://kb.globalscape.com/rssfeed.aspx. 

4. Click Add. 

5. Click OK. 

 

Microsoft Office Online provides a tutorial on RSS feeds. 

FINDING INFORMATION IN THE HELP 

You can find information in the online/application Help in several ways. (This PDF is also searchable and contains 

working hyperlinks.) 

 Expanding text - When you click an expanding hotspot, more information is displayed immediately to the 

right of the hotspot (like this). To hide the text, click the hotspot again.  

 Hyperlinks - Clickable text that opens another topic or a Web page 

 Related Topics - Listed at the bottom of many topics, lists other topics relevant to the current topic 

 

Expanding glossary hotspots are Dynamic HTML effects that require Internet Explorer 5.0 or later. 
Dynamic HTML effects are not supported by some browsers. 

 Using Contents, Search, Favorites, Glossary, and Print: 

Tab/Button Description 

Contents Displays a logical organization of the help topics, similar to chapters in a book. Click a main heading 
(represented by a book icon) to display pages that link to topics, and click each sub heading (represented 
by a page icon) to display the corresponding topic in the right pane. 

http://office.microsoft.com/training/training.aspx?AssetID=RC102254891033&pid=CR100654581033
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Tab/Button Description 

Search  Allows you to locate words or phrases within the content of the topics. Type the word or phrase in the 
text box, press ENTER, then click the topic you want from the list of topics that appears. In the 
application's help, you can search using Boolean (OR, AND, and NOT) and wildcard expressions (*, ?). 
Wildcard searches are not available in Web Help. 

Favorites (This option is only available in the application's help, not online help.) Allows you to save a frequently 
viewed topic to the Favorites tab in the application's help. Click Add to add the topic you are viewing to 
the Favorites tab. To remove a topic, click the topic then click Remove. To display a topic, double-click it 
or click the topic, then click Display. 

Glossary  Displays a list of words, short phrases, and their definitions. When you select a term from the Term list, 
its corresponding definition is displayed in Definition. Many topics contain expanding text links of 
glossary terms that you can click to view its definition. 

Print Opens your computer's Print dialog box from which you can specify a printer to print the topic that is 
displayed in the right pane. In the application help, you have the option of printing the topic only, or the 
main heading topic and all subtopics in that heading. (Alternately, see the procedure below.)  

SEARCHING THE HELP FILE OR GLOBALSCAPE.COM 

When searching, try several different words for the same concept. For example, if you want help with using a script 

in an Event Rule, search for command, script, vb, batch, and so on. Also, we have attempted to provide intuitive 

names for the topic titles. The Table of Contents contains the topic titles of every topic in the user guide. So, in this 

example, if you are looking for a procedure on how to create a command, look for the topic Creating a Command.  

When you search globalscape.com, you are searching across all of GlobalSCAPE products, not just EFT Server. For 

targeted searches, try the application's help file first, then the online help file, then the Knowledge Base, then the 

user forum. If you still cannot find the answer to your question, contact GlobalSCAPE Technical Support. 

PRINTING A HELP TOPIC 

To print a Help topic 

1. Click Print Topic in the Navigation pane, or right-click in the topic (in the right pane), then click Print. The 

Print dialog box for your operating system appears. 

2. In the Print dialog box, click Print. The topic is printed to the specified printer. 

SHARING TOPIC LINKS 

In the online (HTML) help, the address bar displays the IP address (URL) of the help file, not the URL of the specific 

topic. If you right-click in the topic, then click Properties, you can copy of the URL of the topic. The URL displays 

only the topic, without the table of contents, which might be sufficient. The procedure below describes how to 

send a topic's URL with the table of contents displayed.  

To copy a topic URL that includes the table of contents 

1. Open the topic in your Web browser.  

2. Right-click within the topic (the right frame), then click Properties. 

3. Highlight the URL for the topic, right-click the selection, click Copy, and then close the Properties dialog 

box.  

http://help.globalscape.com/help/eft5/
http://kb.globalscape.com/
http://forums.globalscape.com/tt.aspx?forumid=6
http://www.globalscape.com/support/techsupport.aspx
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4. Right-click in the address bar of your browser, click Paste, and then press ENTER. The topic displays, but 

not the table of contents (TOC). 

5. If you want to see the topic AND the TOC, click Show. The URL will update in the address bar and the TOC 

will appear to the left of the topic. 

6. Copy the URL in the address bar (e.g., 

http://help.globalscape.com/help/eft5/index.htm#help/toc_getting_help.htm) and paste it into an e-mail.  
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USING THE KNOWLEDGE BASE 

GlobalSCAPE's Knowledge Base, http://kb.globalscape.com, provides information in HOW TOs, FAQs, and other 

types of articles. Many of the articles are created as a result of assisting customers with configuration and 

troubleshooting.  

 

Search Tips: 

 For the most comprehensive search for articles specific to the Server, type EFT Server, then click Go.  

 To narrow your search, in the Within drop-down menu, click EFT Server. 

 To only find certain types of articles (FAQ, HOWTO, INFO, etc.), in the Type drop-down menu, click an 

article type. 

 In the Search area, the options apply to where it searches, not the display of results. That is, if you search 

for EFT Server and then click Article ID, no results are returned, since Article IDs are numbers. If you 

want to search for an article ID, type the number in the For solutions containing box, click Article ID, then 

click Go.  

 To search for your keyword only in article titles, click Article Title Only.  

 To search only for articles going back a certain length of time (e.g., 3 days ago, last year), click the 

Maximum Age drop-down menu, then click the interval.  

 After your search results display, at the bottom left of the results page, you can click a drop-down menu 

to choose to display from 10 to 100 results per page, then click Update. 

  

http://kb.globalscape.com/
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REGISTRATIONS AND LICENSES 

 

SERVER LICENSE INFORMATION 

When you contact GlobalSCAPE Customer Support for assistance, you might be asked to provide your Server 

License Information. The Server License Information is displayed in the About dialog box. To avoid errors, you can 

copy and paste the registration information into the e-mail that you send to Support. 

 

To copy the license information to the clipboard 

1. On the main menu, click Help > About GlobalSCAPE EFT Server. The About dialog box appears. 

2. Click anywhere within the Server License Information box, then click Copy.  

3. A message appears, stating that the registration information was copied to the clipboard. Click OK.  

You can then paste that information into a text document or e-mail to send to support.  

http://www.globalscape.com/support/techsupport.aspx
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END-USER LICENSE AND SUPPORT AGREEMENT 

GlobalSCAPE, Inc. ("GlobalSCAPE") EFT Server™ version 6 License Agreement 

This Software is licensed, not sold. You may use this Software only as described in this agreement. 

If you do not agree to the terms of this agreement, do not install the Software or use any registration number that 

was provided with the Software. You may return the Software to the place of purchase for a refund if you have not 

used the registration serial number. 

1. SOFTWARE. The capitalized term "Software" refers to the object code for the computer program known as 

Enhanced File Transfer Server™ (hereafter referred to as "EFT Server"), any updates, supplemental code or 

programs provided to you by GlobalSCAPE with or in connection with the Server, such as the user guides, any 

components, any related media and printed materials, and any related "online" or electronic documentation. The 

Software includes two basic components, the Server Program and the Administrator Interface, and may include 

optional add-on modules. 

2. GRANT OF LICENSE. 

A. Evaluation License. If you acquired the license for any component of the Software on an evaluation or 

trial basis, you may use the Software without charge for the evaluation period. Your evaluation period 

begins on the day you install the Software. You must pay the license fee and activate your copy in the 

manner required below to continue to use the Software after the evaluation period. An evaluation license 

for the Software may not be transferred to any other person. 

B. Standard License. 

i) Server Program. You may use one copy of the Server Program on that number of server 

computers for which you have purchased a separate license as indicated on your invoice or sales 

receipt. 

ii) Administrator Interface. For so long as you are licensed to use the Server Program, you may 

copy, install and use the Administrator Interface on as many computers as you wish. 

iii) Optional Add-On Modules. 

a) Web Transfer Client. You may authorize that number of concurrent users of the Web 

Transfer Client for which you have paid a separate license fee as indicated on your invoice or 

sales receipt. If you wish to increase the number of concurrent users after your initial license 

purchase, you will be issued a new registration serial number upon payment of the 

additional license fee and will have to re-activate the Web Transfer Client; 

b) Secure Ad Hoc Transfer (hereafter referred to as "SAT") module. You may also purchase a 

separate license for the SAT module as indicated on your invoice or sales receipt. The SAT 

module is a Server Program. It is your duty to acquire, maintain and/or install, at your cost, 

the Software and Microsoft IIS and all necessary equipment and connectivity in conjunction 

with your purchase and use of the SAT module. Notwithstanding the restrictions in Section 7, 

you may modify the SAT module to customize the Web interface created through the SAT 

module to the Software, subject at all times to GlobalSCAPE’s rights set forth in Section 13. 

Upon modification, however, GlobalSCAPE shall have no further obligations under Section 8 

or any related M & S Plan in relation to the Secure SAT module. Such modification may only 

be used for your internal business purposes and may not be licensed or sublicensed to any 

third party. You may purchase additional copies of the SAT module for back-up or archival 

purposes, but such back-up or archival copy will not contain any modifications that you 

make to the SAT module. 

c) Advanced Workflow Module (AWE). Please refer to the . 
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d) Other Add-On Modules. Add-on modules other than the Web Transfer Client may be used on the 

number of computers for which you have purchased a separate license as indicated on your invoice 

or sales receipt. 

C. Standby and Developer Licenses. If you have purchased a license to use the Server Program or an add-

on module on a non-production basis, then you may use the Server Program or add-on module so licensed 

only as follows: 

 i) On a Standby server computer that is not processing inbound traffic or doing work of any kind 

except in the event that, and only for so long as, the primary production server with which it is 

associated is offline; or    

ii) On a Developer server computer used solely for testing or evaluation that does not process actual 

inbound traffic. 

D. Activation.  You must activate the evaluation or standard license for the Software by entering the 

evaluation or registration serial number as prompted by the Software and as otherwise instructed by 

GlobalSCAPE. Your failure to correctly follow activation procedures is a breach of this license. 

E. Term. The term of the license for any component of the Software is perpetual unless you purchased a 

limited term license as indicated on your invoice or sales receipt. 

3. RIGHT TO COPY OR BACKUP. You may make one copy of the Software or the installation media for the Software 

for back-up or archival purposes at no additional charge. 

4. UPGRADES. To use Software identified as an upgrade, you must first be licensed for the software identified by 

GlobalSCAPE as eligible for the upgrade. After upgrading, you may no longer use the software that formed the 

basis for your upgrade eligibility and the license for that software terminates. 

5. TRANSFER. You may not rent, lease, lend or sublicense the Software. You may, however, make a one-time 

permanent transfer of all of your license rights to the Software to another party, provided that: (a) the transfer 

must include all of the Software, including all component parts, programs, media, printed materials, all registration 

serial numbers, all modules you purchase in conjunction with the Software, and this license; (b) you do not retain 

any copies of the Software, full or partial, including copies stored on a computer or other storage device, and (c) 

the person to whom you transfer the Software agrees to be bound by the terms of this license. If you purchased 

the license for the Software on a multi-computer basis-that is, one registration serial number valid for the number 

of computers indicated on your invoice-you may permanently transfer your rights to one person only. 

6. INFORMATION COLLECTION AND PRIVACY. The Software includes a feature that assigns a unique identifier to 

your computer based on system information. The Software reports this identifier to GlobalSCAPE either when you 

install the Software, enter your evaluation serial number, or enter your registration serial number, or all of these. 

During the evaluation period, the Software will contact our registration and activation servers periodically to verify 

that the Software is still eligible for use on an evaluation basis. The Software may also identify and report to us 

your Windows language identifier setting, IP address, and the date and time of installation and/or activation. 

GlobalSCAPE uses this information to count installations, detect piracy of the Software, and develop rough 

statistical data regarding the geographic location of the Software users. GlobalSCAPE may tie this information to 

personally identifiable information it has about you. GlobalSCAPE may use any non-proprietary information you 

provide as part of obtaining support services for GlobalSCAPE's business purposes, including product support and 

development. 

7. RESTRICTIONS. You may not reduce the Software to human readable (or source code) form, reverse engineer, 

de-compile, disassemble, merge, adapt, or modify the Software, except and only to the extent that such activity is 

expressly permitted by applicable law notwithstanding this limitation. You may not use the Software to perform 

any unauthorized transfer of information, such as copying or transferring a file in violation of a copyright, or for 

any illegal purpose. 
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8. MAINTENANCE AND TECHNICAL SUPPORT SERVICES. If you purchased a maintenance and support plan ("M & S 

Plan"), GlobalSCAPE shall provide the support services at the level agreed by you and GlobalSCAPE and as defined 

in the GlobalSCAPE Maintenance and Support Guide accessible from http://www.globalscape.com/support/eft.asp 

(the "Guide") as of the date of your acceptance of this Agreement. The term of the M & S Plan may vary and is 

specified on your invoice. To be eligible for maintenance and technical support services, the Server program as 

well as all associated add-on modules must be covered by an active maintenance and support plan. 

9. PAYMENT TERMS. If GlobalSCAPE has agreed to invoice you for license fees or support services, invoices shall be 

transmitted on the date of issuance via electronic or postal mail to the primary or billing contact listed on your 

account. Unless otherwise agreed to in writing, full payment is due within thirty (30) days from invoice date. 

 Amounts not paid when due shall bear interest at 1.5% per month, or the highest non-usurious rate permitted 

under applicable law, whichever is less. If GlobalSCAPE is required to take legal action to collect any overdue 

amount, you shall also pay GlobalSCAPE's reasonable costs of collection, including reasonable attorney fees. 

10. SECURITY. The Software creates a means for others to gain access to your computer. Although we have taken 

reasonable measures to prevent unauthorized persons from gaining access to your computer via the Software, we 

cannot foresee or control the actions of third parties. Therefore, use of the Software will make you vulnerable to 

security breaches that you might not otherwise face and could result in the loss of your privacy or property. You 

agree that GlobalSCAPE is not liable to you for security breaches resulting from your use of the Software or 

otherwise. Use of secure passwords and keeping passwords confidential are not the responsibility of GlobalSCAPE 

or the Software. 

11. AUDIT. You agree that on GlobalSCAPE's request you will certify in writing your compliance with the terms of 

this agreement, including your use of the Software only on or in connection with the number of computers 

licensed. You further agree that GlobalSCAPE may during normal business hours and with reasonable prior notice, 

request and gain access to your premises for the limited purpose of conducting an inspection to determine and 

verify your compliance with this Agreement. The inspection will be conducted no more than once per year and in a 

manner not intended to disrupt your business and will be restricted in scope and duration to that reasonably 

necessary to achieve its purpose. 

12. TERMINATION. This agreement terminates if you fail to comply with its terms and conditions.  If your 

agreement terminates, you must destroy all copies of the Software. The termination of this agreement does not 

limit GlobalSCAPE's other rights it may have by law. 

13. INTELLECTUAL PROPERTY. You acknowledge that you have only the limited, non-exclusive right to use and 

copy the Software as expressly stated in this agreement and that GlobalSCAPE retains title to the Software and all 

other rights not expressly granted. You agree not to remove or modify any copyright, trademark, patent or other 

proprietary notices that appear, on, in or with the Software. The Software is protected by United States copyright, 

patent and trademark laws and international treaty provisions. 

14. EXPORT RESTRICTIONS. You may not export or re-export the Software in violation of the export laws of the 

United States, or the applicable laws of any other jurisdiction. Among other things, U.S. laws provide that the 

Software may not be exported or re-exported to certain countries that are embargoed or restricted, or to certain 

restricted persons. Embargoed and restricted countries currently include Cuba, Iran, Libya, North Korea, Syria and 

Sudan. THE SOFTWARE CONTAINS ENCRYPTION TECHNOLOGY THAT IS CONTROLLED FOR EXPORT BY THE U.S. 

GOVERNMENT UNDER THE EXPORT ADMINISTRATION ACT. In addition to other restrictions described in this 

section, you may not use the Software, or export the Software to any destination where you know or have reason 

to know that the Software may be used, in connection with the proliferation of nuclear, chemical or biological 

weapons or missiles. 

15. NO WARRANTIES. TO THE EXTENT PERMITTED BY APPLICABLE LAW, THE SOFTWARE AND ANY SUPPORT 

SERVICES ARE PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, 

WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE 

AND NONINFRINGEMENT. IF APPLICABLE LAW REQUIRES A WARRANTY, THE REQUIRED WARRANTY IS LIMITED TO 
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NINETY (90) DAYS FROM YOUR RECEIPT OF A COPY OF THE SOFTWARE. COMPUTER PROGRAMS ARE INHERENTLY 

COMPLEX, AND THE SOFTWARE MAY NOT BE FREE OF ERRORS. THE SOFTWARE IS PROVIDED WITH ALL FAULTS 

AND THE ENTIRE RISK AS TO SATISFACTORY QUALITY, PERFORMANCE, ACCURACY AND EFFORT IS WITH YOU. 

16. LIMITATION OF LIABILITY. GLOBALSCAPE IS NOT LIABLE TO YOU FOR ANY PUNITIVE, CONSEQUENTIAL, 

SPECIAL, INCIDENTAL, OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE DELIVERY, PERFORMANCE, OR 

USE OF THE SOFTWARE, EVEN IF GLOBALSCAPE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

 UNLESS APPLICABLE LAW PROVIDES OTHERWISE, GLOBALSCAPE'S LIABILITY FOR ANY CLAIM RELATED TO YOUR 

PURCHASE OF A LICENSE FOR OR USE OF THE SOFTWARE AND RELATED SUPPORT SERVICES, WHETHER IN 

CONTRACT, TORT, OR ANY OTHER THEORY OF LIABILITY WILL NOT EXCEED THE GREATER OF U.S. $5.00 OR THE 

FEES PAID BY YOU UNDER THIS AGREEMENT. 

17. U.S. GOVERNMENT. The Software is commercial computer software developed solely at private expense. The 

rights of civilian and non-civilian agencies of the U.S. Government to use, disclose and reproduce the Software are 

governed by the terms of this agreement. Publisher is GlobalSCAPE, Inc., 4500 Lockhill-Selma Road, Suite 150, San 

Antonio, TX  78249, USA. 

18. MISCELLANEOUS. This agreement is governed by the laws of the State of Texas, and the laws of the United 

States of America, as applicable. This agreement is not governed by the United Nations Convention on Contracts 

for the International Sale of Goods. You agree to submit to the jurisdiction of courts sitting in the State of Texas for 

all purposes. SOLE AND EXCLUSIVE VENUE FOR ANY DISPUTE ARISING UNDER OR RELATING TO THIS AGREEMENT 

SHALL BE IN A COURT SITTING IN BEXAR COUNTY, TEXAS. This agreement constitutes the complete and exclusive 

agreement between us, notwithstanding any provision in any purchase order or other written document, except 

for: (i) the definition of any evaluation period, limited license term, and fees and terms for maintenance or support 

services or additional software components that may appear on the GlobalSCAPE Web Site or other 

documentation provided to you, and (ii) the statement of the number of separate computers or concurrent users 

for which you have paid a license fee as described in Section 2, above.  
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Notwithstanding anything else in this agreement to the contrary, a license for the Software provided on a free, 

promotional or "not-for-resale" (NFR) basis may be used only for testing, demonstration or evaluation and may not 

be sold or transferred to another person in any manner. This agreement may only be modified by a written 

document signed by GlobalSCAPE.  No GlobalSCAPE dealer or distributor is authorized to change the terms of this 

agreement. If any provision of this agreement is held to be unenforceable, the remainder of the agreement shall 

not be affected, and the unenforceable provision shall be reformed to the extent necessary to make the provision 

enforceable. If you are located outside the United States, then the following provision applies: Les parties aux 

présentes confirment leur intention que cette convention ainsi que tous les documents afférents soient redigés 

dans la langue anglaise. (Translation: "The parties confirm that this agreement and all related documentation is 

and will be in the English language.") 

Should you have any questions concerning this agreement, or if you want to contact GlobalSCAPE for any reason, 

please contact GlobalSCAPE by mail at: 4500 Lockhill-Selma Road, Suite 150, San Antonio, TX  78249, USA, by 

telephone at: +1 (210) 308-8267, or by electronic mail at 

http://www.globalscape.com/support/customerservice.aspx. 

FREESEC LIBCRYPT LICENSE AGREEMENT 

This program includes FreeSec libcrypt which was used by GlobalSCAPE pursuant to the following license.  

Copyright (c) 1994 David Burren. All rights reserved.  

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 

following conditions are met:  

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following 

disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 

following disclaimer in the documentation and/or other materials provided with the distribution. 

3. Neither the name of the author nor the names of other contributors may be used to endorse or promote 

products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 

WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 

FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE 

FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 

BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 

LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 

SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.  

  

http://www.globalscape.com/support/customerservice.aspx


Registrations and Licenses 

717 

APACHE LICENSE AGREEMENT 

Version 2.0, January 2004  

http://www.apache.org/licenses/  

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION  

1. Definitions.  

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 

through 9 of this document.  

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.  

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are 

under common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or 

indirect, to cause the direction or management of such entity, whether by contract or otherwise, or (ii) ownership 

of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such entity.  

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.  

"Source" form shall mean the preferred form for making modifications, including but not limited to software 

source code, documentation source, and configuration files.  

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, 

including but not limited to compiled object code, generated documentation, and conversions to other media 

types.  

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as 

indicated by a copyright notice that is included in or attached to the work (an example is provided in the Appendix 

below).  

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the 

Work and for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, 

an original work of authorship. For the purposes of this License, Derivative Works shall not include works that 

remain separable from, or merely link (or bind by name) to the interfaces of, the Work and Derivative Works 

thereof.  

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications 

or additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in 

the Work by the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright 

owner. For the purposes of this definition, "submitted" means any form of electronic, verbal, or written 

communication sent to the Licensor or its representatives, including but not limited to communication on 

electronic mailing lists, source code control systems, and issue tracking systems that are managed by, or on behalf 

of, the Licensor for the purpose of discussing and improving the Work, but excluding communication that is 

conspicuously marked or otherwise designated in writing by the copyright owner as "Not a Contribution."  

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been 

received by Licensor and subsequently incorporated within the Work.  

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants 

to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, 

prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such 

Derivative Works in Source or Object form.  

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to 

You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) 
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patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such 

license applies only to those patent claims licensable by such Contributor that are necessarily infringed by their 

Contribution(s) alone or by combination of their Contribution(s) with the Work to which such Contribution(s) was 

submitted. If You institute patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) 

alleging that the Work or a Contribution incorporated within the Work constitutes direct or contributory patent 

infringement, then any patent licenses granted to You under this License for that Work shall terminate as of the 

date such litigation is filed.  

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any 

medium, with or without modifications, and in Source or Object form, provided that You meet the following 

conditions:  

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and  

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and  

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, 

trademark, and attribution notices from the Source form of the Work, excluding those notices that do not pertain 

to any part of the Derivative Works; and  

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You 

distribute must include a readable copy of the attribution notices contained within such NOTICE file, excluding 

those notices that do not pertain to any part of the Derivative Works, in at least one of the following places: within 

a NOTICE text file distributed as part of the Derivative Works; within the Source form or documentation, if 

provided along with the Derivative Works; or, within a display generated by the Derivative Works, if and wherever 

such third-party notices normally appear. The contents of the NOTICE file are for informational purposes only and 

do not modify the License. You may add Your own attribution notices within Derivative Works that You distribute, 

alongside or as an addendum to the NOTICE text from the Work, provided that such additional attribution notices 

cannot be construed as modifying the License.  

You may add Your own copyright statement to Your modifications and may provide additional or different license 

terms and conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works 

as a whole, provided Your use, reproduction, and distribution of the Work otherwise complies with the conditions 

stated in this License.  

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted for 

inclusion in the Work by You to the Licensor shall be under the terms and conditions of this License, without any 

additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or modify the terms of 

any separate license agreement you may have executed with Licensor regarding such Contributions.  

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or 

product names of the Licensor, except as required for reasonable and customary use in describing the origin of the 

Work and reproducing the content of the NOTICE file.  

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the Work 

(and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF 

ANY KIND, either express or implied, including, without limitation, any warranties or conditions of TITLE, NON-

INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for 

determining the appropriateness of using or redistributing the Work and assume any risks associated with Your 

exercise of permissions under this License.  

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract, or 

otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, 

shall any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or 

consequential damages of any character arising as a result of this License or out of the use or inability to use the 
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Work (including but not limited to damages for loss of goodwill, work stoppage, computer failure or malfunction, 

or any and all other commercial damages or losses), even if such Contributor has been advised of the possibility of 

such damages.  

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may 

choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations 

and/or rights consistent with this License. However, in accepting such obligations, You may act only on Your own 

behalf and on Your sole responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, 

defend, and hold each Contributor harmless for any liability incurred by, or claims asserted against, such 

Contributor by reason of your accepting any such warranty or additional liability.  

END OF TERMS AND CONDITIONS  
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END-USER LICENSE AGREEMENT FOR THE ADVANCED WORKFLOW 
MODULE (AWE) 

IMPORTANT-READ CAREFULLY: This Network Automation, Inc. End-User License Agreement ("EULA") is a legal 

agreement between you (either an individual or a single entity) and Network Automation, Inc and its suppliers and 

resellers for the Network Automation, Inc software product identified above, which includes computer software 

and may include associated media, printed materials and "online" or electronic documentation ("SOFTWARE 

PRODUCT"). By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound by the 

terms of this EULA. If you do not agree to the terms of this EULA, do not install or use the SOFTWARE PRODUCT. 

SOFTWARE PRODUCT LICENSE 

AWE is protected by copyright laws and international copyright treaties, as well as other intellectual property laws 

and treaties. The SOFTWARE PRODUCT is licensed, not sold. 

1. GRANT OF LICENSE. This EULA grants you the following rights: 

- Automation Software. You may install and use one copy of the SOFTWARE PRODUCT, or any prior version for the 

same operating system, on a single computer. Since the SOFTWARE PRODUCT is primarily used while machine is 

unattended -- you may *NOT* make a second copy for his or her exclusive use on a portable computer. Instead 

purchase a second license. 

- Storage/Network Use. You may also store or install a copy of the SOFTWARE PRODUCT on a storage device, such 

the printed copy of this EULA, and you may use each copy in the manner specified above. 

2. DESCRIPTION. As a network server, used only to install or run the SOFTWARE PRODUCT on your other 

computers over an internal network; however, you must acquire and dedicate a license for each separate 

computer on which the SOFTWARE PRODUCT is installed or run from the storage device A license for the 

SOFTWARE PRODUCT may not be shared or used concurrently on different computers. 

 - Not for Resale Software. If the SOFTWARE PRODUCT is labeled "Not for Resale" or "NFR," then, not withstanding 

other sections of this EULA, you may not resell, or otherwise transfer for value, the SOFTWARE PRODUCT. 

 - Limitations on Reverse Engineering, Decompilation, and Disassembly. 

You may not reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent 

that such activity is expressly permitted by applicable law not withstanding this limitation. 

- Separation of Components. The SOFTWARE PRODUCT is licensed as a single product. Its component parts may 

not be separated for use on more than one computer. 

- Rental. You may not rent, lease, or lend the SOFTWARE PRODUCT unless permission is expressly granted in 

writing by Network Automation, Inc. 

- Support Services. Network Automation, Inc may provide you with support services related to the ("Support 

SOFTWARE PRODUCT Services"). Use of Support Services is governed by the Network Automation, Inc policies and 

programs described in the user manual, in "online" documentation, and/or in other Network Automation, Inc - 

provided materials. Any supplemental software code provided to you as part of the Support Services shall be 

considered part of the SOFTWARE PRODUCT and subject to the terms and conditions of this EULA. With respect to 

technical information you provide to Network Automation, Inc. as part of the Support Services, Network 

Automation, Inc. may use such information for its business purposes, including for product support and 

development. 

- Software Transfer. You may permanently transfer all of your rights under this EULA, provided you retain no 

copies, you transfer all of the SOFTWARE PRODUCT (including all component parts, the media and printed 

materials, any upgrades, this EULA, and, if applicable, the License Certificate), and the recipient agrees to the terms 
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of this EULA. If the SOFTWARE PRODUCT is an upgrade, any transfer must include all prior versions of the 

SOFTWARE PRODUCT. 

- Termination. Without prejudice to any other rights, Network Automation, Inc. may terminate this EULA if you fail 

to comply with the terms and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE 

PRODUCT and all of its component parts. 

3. UPGRADES. If the SOFTWARE PRODUCT is labeled as an upgrade, you must be properly licensed to use a product 

identified by Network Automation, Inc as being eligible for the upgrade in order to use the SOFTWARE PRODUCT. A 

SOFTWARE PRODUCT labeled as an upgrade replaces and/or supplements the product that formed the basis for 

your eligibility for the upgrade. You may use the resulting upgraded product only in accordance with the terms of 

this EULA. If the SOFTWARE PRODUCT is an upgrade of a component of a package of software programs that you 

licensed as a single product, the SOFTWARE PRODUCT may be used and transferred only as part of that single 

product package and may not be separated for use on more than one computer. 

4. COPYRIGHT. All title and copyrights in and the SOFTWARE PRODUCT, (including but not limited to any images, 

photographs, animations, video, audio, music, text, and "applets" incorporated into the SOFTWARE PRODUCT), the 

accompanying printed materials, and any copies of the SOFTWARE PRODUCT are owned by Network Automation, 

Inc or its suppliers. The SOFTWARE PRODUCT is protected by copyright laws and international treaty provisions. 

Therefore, you must treat the SOFTWARE PRODUCT like any other copyrighted material except that you may install 

the SOFTWARE PRODUCT on a single computer provided you keep the original solely for backup or archival 

purposes. You may not copy the printed materials accompanying the SOFTWARE PRODUCT.. 

5. DUAL-MEDIA SOFTWARE. You may receive the SOFTWARE PRODUCT in more than one medium. Regardless of 

the type or size of medium you receive, you may use only one medium that is appropriate for your single 

computer. You may not use or install the other medium on another computer. You may not loan, rent, lease, or 

otherwise transfer the other medium to another user, except as part of the permanent transfer (as provided 

above) of the SOFTWARE PRODUCT. 

6. U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE PRODUCT and documentation are provided with 

RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in 

subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or 

subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as 

applicable. Manufacturer is Network Automation, Inc. /654 S. Western Ave. Los Angeles, CA 90005. 

MISCELLANEOUS 

If you acquired this product in the United States, this EULA is governed by the laws of the State of California. If you 

acquired this product in Canada, the laws of the Province of Ontario, Canada govern this EULA. Each of the parties 

hereto irrevocably attorns to the jurisdiction of the courts of the Province of Ontario and further agrees to 

commerce any litigation, which may arise hereunder in the courts located in the Judicial District of York, Province 

of Ontario. 

If this product was acquired outside the United States, then local law may apply. 

Should you have any questions concerning this EULA, or if you desire to contact Network Automation, Inc for any 

reason, please write us at: 

Network Automation, Inc. 

Sales Information 

654 S. Western Ave 

Los Angeles, CA. 

LIMITED WARRANTY 
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LIMITED WARRANTY. Network Automation, Inc warrants that (a) the SOFTWARE PRODUCT will perform 

substantially in accordance with the accompanying written materials for a period of thirty (30) days from the date 

of receipt, and (b) any Support Services provided by Network Automation, Inc shall be substantially as described in 

applicable written materials provided to you by Network Automation, Inc, and Network Automation, Inc support 

engineers will make commercially reasonable efforts to solve any problem issues. Some states and jurisdictions do 

not allow limitations on duration of an implied warranty, so the above limitation may not apply to you. To the 

extent allowed by applicable law, implied warranties on the SOFTWARE PRODUCT, if any, are limited to thirty (30) 

days. 

CUSTOMER REMEDIES. Network Automation, Inc's and its suppliers' entire liability and your exclusive remedy shall 

be, at Network Automation, Inc's option, either (a) return of the price paid, if any, or (b) repair or replacement of 

the SOFTWARE PRODUCT that does not meet Network Automation, Inc.'s Limited Warranty and which is returned 

to Network Automation, Inc with a copy of your receipt. This Limited Warranty is void if failure of the SOFTWARE 

PRODUCT has resulted from accident, abuse, or misapplication. Any replacement of the SOFTWARE PRODUCT will 

be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer. Outside the 

United States, neither these remedies nor any product support services offered by Network Automation, Inc are 

available without proof of purchase from an authorized international source. 

NO OTHER WARRANTIES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, Network Automation, Inc 

AND ITS SUPPLIERS DISCLAIM ALL OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESS OR IMPLIED, 

INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 

PURPOSE, TITLE, AND NON-INFRINGEMENT, WITH REGARD TO THE SOFTWARE PRODUCT, AND THE PROVISION OF 

OR FAILURE TO PROVIDE SUPPORT SERVICES. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU 

MAY HAVE OTHERS, WHICH VARY FROM STATE/JURISDICTION TO STATE/JURISDICTION. 

LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL 

Network Automation, Inc OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR 

CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS 

PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING 

OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE PRODUCT OR THE PROVISION OF OR FAILURE TO 

PROVIDE SUPPORT SERVICES, EVEN IF NETWORK AUTOMATION, INC HAS BEEN ADVISED OF THE POSSIBILITY OF 

SUCH DAMAGES. IN ANY CASE, Network Automation, Inc'S ENTIRE LIABILITY UNDER ANY PROVISION OF THIS EULA 

SHALL BE LIMITED TO THE GREATER OF THE AMOUNT ACTUALLY PAID BY YOU FOR THE SOFTWARE PRODUCT OR 

U.S.$5.00; PROVIDED, HOWEVER, IF YOU HAVE ENTERED INTO A NETWORK AUTOMATION, INC SUPPORT SERVICES 

AGREEMENT, NETWORK AUTOMATION, INC'S ENTIRE LIABILITY REGARDING SUPPORT SERVICES SHALL BE 

GOVERNED BY THE TERMS OF THAT AGREEMENT. BECAUSE SOME STATES AND JURISDICTIONS DO NOT ALLOW 

THE EXCLUSION OR LIMITATION OF LIABILITY, THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 

USE OF THIS PRODUCT FOR ANY PERIOD OF TIME CONSTITUTES YOUR ACCEPTANCE OF THIS AGREEMENT AND 

SUBJECTS YOU TO ITS CONTENTS. 

Copyright and Trademark Acknowledgements 

The AWE software, the contents of this documentation, the Network Automation, Inc. logo, and the AutoMate 

(white A with a blue circle around it) are trademarks of Network Automation, Inc. 

Windows, Windows 95, Windows ME, Windows 2000, Windows NT and Windows XP are trademarks of Microsoft 

Corporation. All other trademarks are property of their respective owners. 

All worldwide rights reserved. 
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GLOSSARY 

Action: Once an Event Rule is triggered and assuming all conditions are met, EFT Server launches one or more 

user-definable Actions, such as executing a command, sending an e-mail, offloading a file, or a 

combination of multiple actions. 

AD: Active Directory. A Microsoft implementation of LDAP directory services used to provide central 

authentication and authorization services for Windows-based computers. 

ADO: ActiveX Data Objects. A language-neutral object model that exposes data raised by an underlying OLE DB 

Provider. 

algorithm: List of well-defined instructions that tell a computer the procedure and order of steps to perform a 

specific task. 

ARM: Auditing and Reporting Module. Captures the transactions passing through EFT Server and provides an 

interface in EFT Administrator where you can use preconfigured or your own custom reports to query, 

filter, and view transaction data. 

AS2: Applicability Statement 2. A specification for data exchange, to perform the task of sending and receiving data 

via a secure connection. AS2 is also referred to as EDIINT AS2 or EDI over the Internet AS2. 

AS2 Identifier: Name by which trading partners identify themselves to each other when transferring files via the 

AS2 protocol. 

Asynchronous Receipt: A receipt returned to the sender on a different communication session than the sender's 

original message session. 

Base DN: Base Distinguished Name. Specifies the necessary domain components of the LDAP server. 

Certificate: Certificates are digital identification documents that allow both servers and clients to authenticate 

each other. A certificate file has a .crt extension. 

cipher: Algorithm for performing encryption. See SSL. 

cluster: Group of tightly coupled computers that work together closely so that they can be viewed as though they 

are a single computer. A failover cluster has redundant nodes that are used to provide service when 

system components fail. 

COM API: Component Object Model. A programmatic interface that allows you to control EFT Server from your 

own custom applications using any COM-enabled programming language. 

Commands: EFT Server's Commands can execute programs, scripts, or batch files with or without command line 

arguments, providing administrators almost limitless extensibility. These Commands can be invoked 

directly by a user from an FTP client (if permitted by the EFT Server administrator) or as an automated 

action from EFT Server’s Event Rules. 

compensating control: Compensating controls may be considered when an entity cannot meet a requirement 

explicitly as stated, due to legitimate technical or documented business constraints but has sufficiently 

mitigated the risk associated with the requirement through implementation of other controls. 

Compensating controls must 1) meet the intent and rigor of the original stated PCI DSS requirement; 2) 

repel a compromise attempt with similar force; 3) be "above and beyond" other PCI DSS requirements 

(not simply in compliance with other PCI DSS requirements); and 4) be commensurate with the additional 

risk imposed by not adhering to the PCI DSS requirement. 
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Condition: Allows you narrow the trigger definition for an Event Rule. Conditions are optional; you do not have to 

define a condition on an Event Rule to make it trigger an action, but they allow more control over when 

an Action can take place. 

Data remanence: Residual physical representation of data that has been in some way erased. 

DER: Distinguished Encoding Rules. A method for encoding a data object, such as an X.509 certificate, to be 

digitally signed or to have its signature verified. 

DMZ Gateway: Server designed to reside in the demilitarized zone to provide secured communications with EFT 

Server behind intranet firewalls without requiring any inbound firewall holes between the internal 

network and the DMZ. 

DOM: Document Object Model (DOM), is a programming interface specification being developed by the World 

Wide Web Consortium (W3C). It lets a programmer create and modify HTML pages and XML documents 

as full-fledged program objects. 

DSN: Data Source Name. Data structure that contains the information about a database that an Open Database 

Connectivity (ODBC) driver needs to connect to it. Included in the DSN is information such as the name, 

directory, and driver of the database, and the ID and password of the user. 

DSS: Data Security Standard. Represents a common set of industry tools and measurements to help ensure the 

safe handling of sensitive information and provides an actionable framework for developing a robust 

account data security process, including preventing, detecting, and reacting to security incidents. 

EC: Business-to-Business Electronic Commerce. 

EDI: Electronic Data Interchange. Transfer of data between companies using VANs or the Internet. An 

organization's EDI standard describes the mandatory information for a particular type of document, which 

information is optional, and the structure of the document. For example an architectural firm may require 

a particular file-naming convention. 

EFS File Sharing: Encrypting File System. A file system driver with filesystem-level encryption available in 

Microsoft's Windows 2000 and later operating systems. The technology transparently allows files to be 

encrypted on NTFS file systems to protect confidential data from attackers with physical access to the 

computer. EFS is susceptible to brute-force attacks against user account passwords. 

EFT: Enhanced File Transfer 

Event Rule: Used to specify an action to occur when an event takes place and/or a condition is present; e.g., send 

an e-mail when a file is uploaded. 

Folders: In EFT Administrator, you can define and manage physical folders and virtual folders. 

FTP: File Transfer Protocol. Protocol used for exchanging files over any network that supports TCP/IP (such as the 

Internet or an intranet). FTP servers by default listen on port 21 for incoming connections from FTP 

clients. 

FTPS: File Transfer Protocol Secure (commonly referred to as FTP/SSL). A method by which software can perform 

secure file transfers, involving the use of a SSL/TLS layer below the standard FTP protocol to encrypt the 

control and/or data channels. 

GeoTrust: Digital certificate provider, owned and operated by VeriSign. 

GLBA: Gramm-Leach-Bliley Act. GLBA compliance is mandatory for financial services companies; a policy must be in 

place to protect financial information from foreseeable threats in security and data integrity. 
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Group: Allows the administrator to define access permissions to files and folders. Just as User Setting Levels 

control access to EFT Server resources such as bandwidth allowances and connectivity privileges, Groups 

control access to folders. See virtual folders. 

HIPAA: Health Insurance Portability and Accountability Act. Enacted by the U.S. Congress in 1996; requires the 

establishment of national standards for electronic health care transactions; addresses the security and 

privacy of health data. 

HS: High Security - The HS-PCI module helps to create a high-security, hardened EFT Server that achieves or 

exceeds corporate and/or industry security best practices for data transfer and storage. 

HS-PCI Module: High Security Payment Card Industry Module. Add-on to EFT Server to add high security features 

and facilitate ongoing compliance with PCI DSS v1.1. 

HTML: HyperText Markup Language. Used to define the structure of a Web page. Compare to XML and XHTML. 

HTTP: Hypertext Transfer Protocol. An application protocol that runs on top of the TCP/IP suite of protocols used 

for Internet/intranet communications, typically over port 80. 

HTTPS: Secure HTTP connection. HTTP is used, but with TCP port 443 and an additional encryption/authentication 

layer between the HTTP and TCP. 

IETF: Internet Engineering Task Force. Develops and promotes Internet standards, cooperating closely with the 

W3C and ISO/IEC standard bodies; dealing in particular with standards of the TCP/IP and Internet protocol 

suite. 

IIS: Microsoft Internet Information Services. Provides Web infrastructure security. 

instance: An instance of the SQL Server 2000 database engine is one copy of the database software that operates 

as an operating system service. 

intermediate certificate authority: There are two types of Certificate authorities (CAs): Root CAs and Intermediate 

CAs. A certificate signed by a Root CA is implicitly trusted by most Web browsers. A certificate signed by 

an Intermediate CA may not be implicitly trusted by most Web browsers. Intermediate CA certificates are 

sometimes called "chained root certificates." An Intermediate CA signed certificate often costs 

significantly less than a Root CA signed certificate. 

ISA: Internet Security and Acceleration Server. Microsoft Proxy Server; Firewalling & Security product based on 

Microsoft Windows. 

IUSR: IUSR_<computername> is an IIS account for anonymous access to IIS. If a Web site is set to use anonymous 

authentication, the user is mapped to the IUSR_<computername> account. 

IWAM: Internet Server Web Application Manager. IWAM_<computername> is an IIS account for starting out-of-

process applications in IIS 6.0 isolation mode. 

LDAP: Lightweight Directory Access Protocol. An application protocol for querying and modifying directory services 

running over TCP/IP. 

LDAP Attribute: Denotes user names in the LDAP database. This allows you to specify the attribute from the 

queried list of users that denotes user names. Commonly used attributes are cn or uid. 

LDAP Base DN: Base Distinguished Name. Specifies necessary domain components of the LDAP server. Some LDAP 

systems, such as Sun ONE Server and Microsoft’s Active Directory server, require the organizational unit 

("ou") that houses the users on that LDAP server to be included in the BaseDN to allow users to 

successfully authenticate. The organizational unit is the parent object that contains the user objects. For 

example, if the classObject that holds user accounts is person, the hierarchical parent node/container 

could be the organizational unit people. If the organizational unit is required by your LDAP server, 

prepend it to the distinguished name. 
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LDAP Port: Port of the LDAP server. The default is port 389; port 636 for SSL connections. 

LDAP User Filter: EFT Server uses the User Filter to query the LDAP server for a list of users. The default setting is 

objectClass=person, which retrieves the users on the LDAP server that belong to the person ObjectClass. 

MA: Multiple Attachment. the ability to transfer multiple documents within a single AS2 message. 

MD5: A secure, one-way hash algorithm used in conjunction with digital signature allowed in AS2. SHA-1 is 

recommended. 

MDN: Message Disposition Notification. The Internet messaging format used to convey a receipt; MDN is used 

interchangeably with receipt. 

MFT: Managed File Transfer. Provides control over network file transfers, including securing the data by encrypting 

the transmission channel or the data itself, managing trading partners and the way they are 

authenticated, automating transfers to ensure that service level agreements are met, monitoring and 

reporting file transfer activity for accountability, and passing data through the DMZ to a backend server so 

that no sensitive data resides in the DMZ. 

MIC: The message integrity check (MIC), also called the message digest, is the digest output of the hash algorithm 

used by the digital signature. 

MIME: Multipurpose Internet Mail Extensions. A specification for formatting non-ASCII messages so that they can 

be sent over the Internet. S/MIME supports encrypted messages. 

Mode Z: Mode Z compression compresses files on the fly for file transfers, saving bandwidth and improving 

transfer times. 

MSDE: Microsoft SQL Server 2000 Desktop Engine, used by the Auditing and Reporting module. 

NCSA: National Center for Supercomputing Applications. 

NRR: Non-repudiation of receipt (NRR) is a legal event that occurs only when the original sender has verified the 

signed receipt returned from the recipient of the message, and has verified that the returned message 

integrity check (MIC) inside the MDN matches the previously recorded value for the original message. 

That is, the sender of the message obtains undeniable proof that the recipient received the message and 

that the message was not altered in transit. NRR is established when both the original message and the 

receipt use digital signatures. 

NTLM: NT Lan Manager. A challenge/response form of authentication that was the default network authentication 

protocol in Windows NT 4.0. 

ODBC: Open Database Connectivity. A standard database access method used to access any data from any 

application, regardless of which database management system (DBMS) is handling the data. 

OpenPGP: Uses public-key cryptography and includes a system that binds the public keys to a user name. 

OTP: One-Time Password. Intended to make it more difficult to gain unauthorized access. By constantly altering 

the password, as is done with a one-time password, this risk can be greatly reduced. 

PAN: Primary Account Number. A unique sequence of numbers assigned to a cardholder account that identifies 

the issuer and type of financial transaction card. 

PCI: Payment Card Industry. The PCI Security Standards Council is an open global forum for the ongoing 

development, enhancement, storage, dissemination, and implementation of security standards for 

account data protection. 

PCI DSS: Multifaceted security standard that includes requirements for security management, policies, procedures, 

network architecture, software design, and other critical protective measures. 
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PEM: Privacy Enhanced Mail. Base64 encoded DER certificate, enclosed between -----BEGIN CERTIFICATE----- and --

---END CERTIFICATE-----. 

PerfMon: Microsoft utility. Allows you to view a running count of anonymous and nonanonymous users as well as 

other IIS objects. 

Physical folder: Directory you create on your hard drive from within the EFT Server. 

PNC: Peer Notification Channel. The outbound-initiated two way socket connection used for communication, 

typically on port 44500 on the DMZ Server. 

POP3: Post Office Protocol version 3. Used to retrieve e-mail from a remote server ovr TCP/IP. Compare to SMTP. 

Private Key: The server's private key decrypts the client's session. The private key has a .key extension and is part 

of the public-private key pair. 

protocol: Special set of rules between a client program and a server program in a network. 

Public Key: A message encrypted with a recipient's public key cannot be decrypted by anyone except the recipient 

possessing the corresponding private key. See Private Key. 

Public Key Blob: A public key BLOB contains the public key in plaintext form. 

Receipt: The functional message that is sent from a receiver to a sender to acknowledge receipt of an EDI/EC 

interchange. This message may be either synchronous or asynchronous. 

root certificate: Unsigned public key certificate or a self-signed certificate; part of a public key infrastructure 

scheme. The most common commercial variety is based on the ITU-T X.509 standard, which normally 

includes a digital signature from a certificate authority (CA). 

S/MIME: Secured Multi Purpose Internet Mail Extensions. A format and protocol for adding cryptographic 

signature and/or encryption services to Internet MIME messages. 

SAM: Security Accounts Manager (Windows) 

SAM Account name: Active Directory schema attribute. The logon name used to support clients and servers 

running older versions of the operating system, such as Windows NT 4.0, Windows 95, Windows 98, and 

LAN Manager. This attribute must be less than 20 characters. 

SAN: Storage Area Network. An architecture to attach remote computer storage devices such as disk arrays, tape 

libraries and optical jukeboxes to servers in such a way that, to the operating system, the devices appear 

as locally attached devices. 

SB1386: California (USA) law regulating the privacy of personal information. 

Secure Ad Hoc Transfer module: Allows internal users to send and receive large e-mail file attachments to 

recipients outside of your organization quickly, reliably, and securely, all without having to manually 

create or maintain FTP accounts on EFT Server. 

Server: In EFT Administrator, a Server contains the settings for one or more EFT Servers, either locally or remotely. 

Server Group: In EFT Administrator, Server Groups are at the top of EFT Server's setting hierarchy and allow you to 

group multiple Servers. 

Session Key: The client and the server use the session key to encrypt data; created by the client via the server’s 

public key. See Public Key. 

SFTP: Secure File Transfer Protocol. A network protocol designed by the IETF to provide secure file transfer and 

manipulation facilities over the secure shell (SSH) protocol. 
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SHA-1: Secure, one-way Hash Algorithm used in conjunction with digital signature; the recommended algorithm 

for AS2. 

Signed Receipt: A receipt with a digital signature. 

Site: In EFT Administrator, a Site is similar to a virtual FTP server bound to one or more IP addresses. 

SMTP: Simple Mail Transfer Protocol. Simple text-based protocol used to send e-mail using TCP on port 25 (by 

default). (Compare to POP3.) 

SQL Server: SQL Server is a relational database management system (RDBMS) produced by Microsoft. 

SSL: Secure Sockets Layer, a protocol designed and implemented by Netscape Communications, provides for 

encryption of a session, authentication of a server, and optionally a client, and message authentication. 

Synchronous Receipt: A receipt returned to the sender during the same HTTP session as the sender's original 

message. 

TCP/IP: Transmission Control Protocol/Internet Protocol. Uses the client/server model of communication in which 

a computer user (a client) requests and is provided a service (such as sending a Web page) by another 

computer (a server) in the network. 

TLS: Transport Layer Security. SSL has been merged with other protocols and authentication methods into this new 

protocol. 

trading partner: Organizations that send or receive documents from each other. The trading partners agree on the 

specific information to be transmitted and how it should be used. 

UNC path: Uniform Naming Convention path. e.g., \\computername\sharedfolder\resource. 

URI: Uniform Resource Identifier. Generic term for all types of names and addresses that refer to objects on the 

World Wide Web. A URL is one kind of URI. 

URL: Uniform Resource Locator. An Internet address. See also URI. 

User Settings Template: Allows you to apply a setting configuration to an entire group of users. Every client 

account or user must be a member of a User Setting Level. User Setting Levels exist within a Site and 

consist of a group of settings used as a template. AKA Settings Level. 

VAN: Value Added Network. Private network provider that leases communication lines to its subscribers. In the 

healthcare industry, a VAN is referred to as a "Clearinghouse" and has additional legal restrictions that 

govern protected healthcare information. 

VFS: EFT Server's Virtual File System allows you to grant access to files and folders on your system based on user 

and Group permissions. See virtual folder. 

virtual folder: Similar to a shortcut, a virtual folder points to an existing folder on your computer or another 

system. 

VPN: Virtual Private Network. A communications network tunneled through another network and dedicated for a 

specific network. 

W3C: World Wide Web Consortium 

Web Transfer Client: Browser-based file transfer client that allows users to transfer files to/from an EFT Server 

using a connected Web browser. 

WSDL: Web Services Description Language. An XML format for describing network services as a set of endpoints 

operating on messages containing either document-oriented or procedure-oriented information. 



Glossary 

729 

XCRC: EFT Server's file integrity command. When an XCRC-enabled client performs a transfer, it can request EFT 

Server to do a checksum calculation on the file. If it matches the checksum on the client, then the transfer 

is deemed successful. 

XHTML: Extensible HyperText Markup Language. A combination of HTML and XML; similar to HTML, but with more 

restrictions on tags and format. 

XML: Extensible Markup Language. A general-purpose markup language used to store any amount of text/data 

enclosed by a user-defined start and end tag. Compare to HTML. 
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